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INTRODUCTION 

 

The WinGAP Computer Assisted Mass Appraisal system is the primary appraisal software used in the State of 

Georgia for property tax appraisal, utilized by 146 of the 159 counties in Georgia. Gap Group Inc, the owner of 

WinGAP software, is a Georgia based non-profit whose mission is to deliver cost effective and reliable appraisal 

software to Georgia’s tax assessor’s offices. WinGAP is used to appraise over three million tax parcels annually. 
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INTERFACE BASICS 

 

LOGGING IN TO WINGAP 

 

When WinGAP is first initialized, the user must log in with a User ID and Password that is managed by a WinGAP 
administrator, or select the Guest option, which does not require any ID or Password. Logging in as a User will 
allow all the rights associated with that User ID including all granted viewing and editing rights, while the Guest 
logon has restricted viewing rights and no editing rights. 

 

 

 

MAIN WINGAP SCREEN 

 

After logging in, the user is taken to the Main Screen. All WinGAP operations originate at this screen, which 
defaults to a graduated green color and is similar to the primary screen in most Windows applications. 

 



 
3 

 

 

MAIN WINDOW 

The main WinGAP screen is a green color when the user is in the default appraisal year. The screen is a red color 
when the user is in a previous appraisal year or logged in as Guest. It is a gold color when the user is in the Future 
year. The version of WinGAP will display in the center of the window, along with the appraisal year in use. If Logins 
are enabled, the Login ID of the user will display below the WinGAP version. 

 

 

 

TITLE BAR 

The Title Bar at the top of the screen contains the Name of the program (WinGAPSQL), the Version Number of 
WinGAP (in this case, 4.10.1), the Appraisal Database that is currently being used, and the login id of the user. On 
the far left of the Title Bar is an icon that can be clicked to produce a Menu where the user can resize the main 
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WinGAP screen or close the WinGAP application. On the far right of the Title Bar are the standard Windows 
buttons that can be used to Minimize, Maximize/Restore, and Close the Main WinGAP screen. 

 

MENU BAR 

 

The Menu Bar contains pull-down menu options that allow the user to perform different functions within WinGAP. 
These menus can be selected by either clicking on the menu word with the mouse (for instance by clicking the 
word "File"), or they can be selected with what is known as a “hot-key” combination. Hot key combinations are 
performed by holding down the Alt key and pressing the underlined letter for the menu item you want (for 
instance pressing ALT + F will pull down the File Menu).  

 

After a menu is activated, the user has several methods available in selecting the desired menu option. These 
methods are listed below and apply to all menus. 

 

• Pointing at the desired menu option with the mouse and single clicking the left mouse button. 

• Using the Up and Down directional arrow keys on the keyboard to navigate through the menu option and 
then press Enter when the desired option is highlighted. 

• Using a hotkey combination. Menu options that have hotkey combinations have them displayed to the 
right of the option. Hotkeys can initiate a menu options without first activating the menu. For example, 
CTRL + N would display the Owner screen without the File menu being displayed or dropped down. 

 

Each of these Menus will be discussed in more detail on the following pages. 

 

TOOL BAR 

 

The WinGAP Tool Bar contains Buttons that can be clicked on to perform various tasks in WinGAP. Many of these 
Forms can also be reached with the use of a “hot-key” combination. From left to right, clicking on the Buttons will 
produce the following items: 

 

• Owner Search Form (CTRL + O) 

• Multi-Owner Search Form (CTRL + M) 

• Real Property Index Form (CTRL + V) 

• Real Property Search Form (CTRL + R) 

• Personal Property Search Form (CTRL + SHIFT + P) 

• Prebill Mobile Home Search Form 

• Property Transfer Form (CTRL + T) 

• Timber Form 
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• Report Designer 

• Wild Search 

• Report Site 

 

STATUS BAR 

 

The WinGAP Status Bar is located at the bottom of the main WinGAP screen. It displays: 

 

• The County Name from the County Name field as entered in Tools > Preferences. 

• The database backend in parentheses. 

• The MSSQL server instance that WinGAP is connected to. 

• The System Date and Time. 

• The Build Number for this version of WinGAP. 

• Whether the INS (Insert), CAPS (Caps Lock), NUM (Num Lock), and SCROLL (Scroll Lock) keys are engaged 
on the keyboard. If engaged, they will display in GREEN. 

 

FILE MENU 

 

 

NEW OWNER 

The New Owner option on the File Menu is one of several places in WinGAP where a New Owner can be added. 
The user can click with the mouse to select this option and proceed to the New Owner Information Form or use a 
“hot-key” combination. In New Owner the “N” is underlined, so the user can use the key combination of Ctrl + N 
(hold down the Control key and simultaneously press the letter N) to produce the Owner Information Form. 
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See the Owner Information Form section of this manual for help specific to this Form. 

 

SELECT APPRAISAL YEAR 

The second option on the File Maintenance Menu produces the Select Appraisal Year Form, where the user can 
click on an item in the list to select the desired Appraisal Year. After selecting the Year, the Open Button should be 
clicked to select that year. The Open Button will not become available until an Appraisal Year is selected. The 
Cancel Button will cancel the selection. The Help Button can be clicked to produce a Help Form about this option. 
The “hot-key” combination of Ctrl + Y can also be used to produce the Select Appraisal Year Form. 
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NOTE: Any Appraisal Year that is selected other than the Default Startup as setup in Tools > Preferences will cause 
the main WinGAP screen to change from the default green color to a red color. This also occurs if logging in under 
the Guest profile. 
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NOTE: The Help Button can be clicked to produce a Help Form about this option, as seen below. Any Form in 
WinGAP that has a Help Button can be used to produce on-screen information about that feature in WinGAP. 
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LOGON AS A DIFFERENT USER  

Selecting this option on the File Maintenance Menu (or pressing the “hot-key” combination of Ctrl + L) produces 
the WinGAP Login Form. Accessing this Form is particularly useful when the current user is having a problem with 
WinGAP or the computer system and does not have “rights” to use all parts of WinGAP. A different individual, such 
as the System Administrator who has “full rights”, can logon as a different user on the current user's computer to 
resolve the problem. 

 

If a user attempts to access any appraisal year except the default year and the user's name is not found in the non-
default year's password list, the user will be logged into that year as a Guest. Also, logins with no Administrative 
rights will not be able to access the File Maintenance Menu. 

 

The Guest Button should be clicked to log in as a “Guest”, meaning that the user will only have rights to VIEW 
property information. Guests cannot add, edit, or delete any information in WinGAP. Logging in under Guest also 
blocks access to the Reports, Tools, and Add-Ons Menus, meaning that the user cannot print reports, access any 
schedule information, or have access to PT-61, GIS, or Timber information. Guests can print screens that have a 
Printer button, as well as any reports that are available by right clicking on the Printer button. 

 

In addition, Guests are not allowed access to the Transfer, Timber, Report Designer, and Wild Search modules of 
WinGAP. Guest logins will not be able to see the “tool tips” for any parcels under the ownership of an owner 
record with a Non-Disclosure flag. The following data is also masked under a Guest login if the parcel is receiving 
a Homestead Exemption and the owner is flagged for non-disclosure: 
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• All fields associated with a situs location 

• Latitude 

• Longitude 

• Land lot 

• Land district 

• GMD 

• Legal description 

• Subdivision name, lot, block, section, and phase 

 

The Guest Login is designed to be used primarily at computers accessed by the public. Login User IDs and 
Passwords in WinGAP are always entered in lower case. 

 

NOTE: Counties can also set up a Guest User in Password Administration to further control Guest access to 
WinGAP. The Password can be whatever the County chooses. 

 

IMPORT 

The Import option on the File Menu produces a Sub-Menu with four options. 

 

 

DNR DATA FILE 

New Georgia Department of Natural Resources boat data for the County can be imported into the County's 
existing DNR table by choosing this option. The user must have an ACTIVE Internet connection to import the DNR 
Data files. Also, WinZip and the WinZip Command Line Interface must be installed. The DNR Data File process 
consists of the following steps: 

• The user will be connected to ftp.wingap.com. 

• The dnrnew.zip file will be downloaded. 

• The dnrnew.dbf will be extracted from dnrnew.zip. 

• Three comparison reports can be printed. 

• The status of all previously unregistered boats will be set to New. 

• The boat records with a status of New will be merged from dnrnew.dbf to dnr.dbf. 

 

ftp://ftp.wingap.com/
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The Download Button on the DNR Import form should be clicked to proceed. If the user is not sure whether to 
proceed, either the OK or Cancel button can be clicked to return to the main WinGAP screen. Clicking the 
Download button will trigger the import process. 

NOTE: If the user/System Administrator is unable to download the DNR data using the procedures described 
below, the Manual Download checkbox can be used to download the data. This situation usually occurs when the 
Download button doesn’t work due to county side security blocks to FTP sites. Users can now manually download 
and continue with the import and report printing. For Manual Download help, contact your DOR LGS Agent, Gregg 
Reese, or Tracy Thomas. 

 

 

The user will see a “Logging On” message, followed by several other messages as the DNR file is downloaded. 
When the download in finished, the DNR Import form will display that the download has been completed 
successfully. If the download is not successful, for instance the user's Internet connection is not functioning, the 
user will receive an error message and the user can try again later to download the DNR file. If the download error 
persists, please visit live online support at www.wingap.com. 
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The user should now click the Extract Button on the DNR Import form to extract the DNR files. WinGAP will then 
unzip the new DNR file and a command line window will appear confirming this. Any key can be pressed at this 
point to close the command line window. 
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Once the command line window is closed the user will be prompted to wait for all the files to unzip before 
continuing.  

 

 

NOTE: a registration in dnrnew.dbf will not be flagged with a New status unless the registration is not present in 
the county's current dnr table. Previously, a status of New was assigned if the registration was not present OR if 
the registration numbers matched and the ownership in the dnrnew record was different than the ownership in 
the dnr file. A list of ownership differences can be run as part of the next step, Print Comp (Comparison) Reports.  

 

Once complete, the DNR Import Form will display that the Extraction process was successful. The next step is to 
Print Comparison Reports, which will print three reports. Clicking on the Print Comp Reports button will bring into 
focus the button containing the first report that will be printed. Clicking the button will produce a Print Preview of 
the Ownership & Address Comparison Report. 
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Once this report is printed or exported to a PDF or other format for future printing, the preview window should be 
closed, and the button that will print the next report will be available. Repeat the process for both the Ownership 
Differences Report and the Boats with New Registration Numbers Report. After printing or exporting all three 
reports, the final step in the DNR Import process is to Import the new DNR boat data into the County's existing 
DNR boat file. This is done by clicking the Import Button on the DNR Import Form. 

 

 

Clicking Okay on the prompt will append new boats to the county’s existing DNR boat file and produce a final 
report of these appended boats that can be printed or exported. Closing the report preview will return the user to 
the DNR Import window, where the user should see a message that the Import was successful. Clicking Cancel or 
OK will return the user to the main WinGAP screen. 
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ABOS MARINE PRICING FILES 

This option downloads the latest update to the ABOS boat valuation files. The user must have an ACTIVE Internet 
connection to import the ABOS files. Also, WinZip and the WinZip Command Line Interface must be installed. 
Clicking Begin Download will start the process. On a fast internet connection, the download should take less than a 
minute. 

 

 

Once the connection to the FTP site is established, the user will see several messages, such as “Connecting to FTP 
site”, “Logging On”, “Finding ABOS.Zip”, and “Downloading”. At the conclusion of the download, the user will 
receive the messages “File Downloaded”, “Disconnecting”, and “Done!”. A Command Line window will appear and 
the ABOS files will be automatically unzipped. At the conclusion of the unzipping process, the user can press any 
key. 
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NOTE: The user should make sure that the ABOS tables are unzipped in the command window, and a message will 
appear reminding the user of this. If the unzipping process is not successful, the user will not see the unzipped 
ABOS tables in the Command Window. If this happens, the user should contact a DOR Technical Support agent or 
use WinGAP’s Online Support for assistance. If the unzipping process was successful, the user should click OK on 
the message to begin the table upload process into WinGAP. 

 

 

When the upload process is finished, the user will be returned to the main WinGAP screen. The user should go to 
Tools > Preferences and make sure that the ABOS Year has been updated. 
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NADA MH PRICING FILES 

This option downloads the latest update to the NADA valuation files. The user must have an ACTIVE Internet 
connection to import the NADA files. Also, WinZip and the WinZip Command Line Interface must be installed. 
Clicking Begin Download will start the process. On a fast internet connection, the download should take less than a 
minute. 

NOTE: The NADA download should not take place until the Yearend Cleanup has been performed and the county 
has received notification by email of the NADA schedule upload. 
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Once the connection to the FTP site is established, the user will see several messages, such as “Connecting to FTP 
site”, “Logging On”, “Finding NADA.zip”, and “Downloading”. At the conclusion of the download, the user will 
receive the messages “File Downloaded”, “Disconnecting”, and “Done!”. A Command Line window will appear and 
the NADA files will be automatically unzipped. At the conclusion of the unzipping process, the user can press any 
key. 

 

 

NOTE: The user should make sure that the NADA tables are unzipped in the command window, and a message will 
appear reminding the user of this. If the unzipping process is not successful, the user will not see the unzipped 
NADA tables in the Command Window. If this happens, the user should contact a DOR Technical Support agent or 
use WinGAP’s Online Support for assistance. If the unzipping process was successful, the user should click OK on 
the message to begin the table upload process into WinGAP. 
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When the upload process is finished, the user will be returned to the main WinGAP screen. The user should go to 
Tools > Preferences and make sure that the NADA Year has been updated. 
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DORPU – ITS IMPORT 

This feature is for DOR Agents. It should not be used by the counties. 

 

 

EXPORT 

The Export option on the File Menu produces a Sub-Menu with many options. 
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DIGEST FILES 

Selecting the Digest Files option on the File > Export menu first produces the Digest Checklist message window. It is 
extremely important that all the items on this checklist are performed prior to the exporting of any digest data. If 
the user is not sure about this, the checklist can be viewed now by selecting the "Yes" option. 

 

 

Once the checklist has been viewed or the No button has been selected, the first screen that appears is called the 
Digest Export form. The Form has two defaults selected: All Tax Districts and Include Accounts under $7501 
(Personal Property). If these are not the correct options, the All Tax Districts checkbox can be unchecked and a 
single Tax District may be selected by clicking on the Tax District combo box at the top of the Form, or multiples 
may be selected by holding CTRL + Left Clicking on multiple Tax Districts. One of these options, either individual 
Tax Districts or all Tax Districts, MUST be selected for WinGAP to proceed. Also, If Personal Property Accounts 
under $7501 should NOT be included in the Digest Export, that checkbox should be unchecked as well.  

 

At the bottom of the Digest Export form are the fields Server Export and WS Export. These fields MUST have the 
correct export paths defined in them. If these fields are blank, do not run the Export process, and contact WinGAP 
Online Support for assistance with this issue. Normally these paths do *not* need to be changed; however, the 
fields are available for editing just in case. 

 

There are two unchecked, non-default options available for this process. The “Include Class/Strat Detailed XLS” will 
produce additional Excel spreadsheet for each class and strata combination that shows realkey, perskey, parcel 
number, acreage, and the owner’s name and address. The “TAB Delimited” check box will change the export .txt 
files from Fixed Length to TAB delimited format.  
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The user should click the Export button to begin the Export process. WinGAP will "export" the data and create the 
digest files in the appropriate WinGAP data directory. Various progress bars will appear as the files are created. If 
the Export process needs to be canceled after it has begun, the user can click the Stop Button near the bottom of 
the form. 
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At the conclusion of the Export process the Zip Files form will appear. All of the digest text files will be pre-selected 
and highlighted in blue. Unlike previous versions of WinGAP, it is no longer necessary for the user to select the 
files. Files that are not to be zipped can be unselected by holding the Ctrl key down and clicking on the file.  

NOTE: If the user accidentally deselects ALL of the files, they can be re-selected in one of three ways: 

• The user can click the Select All button to select all of the files in the list box.  

• The first file in the list can be selected by left clicking on it with the mouse, The user can then locate the 
last file in the list, hold the Shift key down, and then click on the last file with the left mouse button  

• The Ctrl Key can be held down and each individual file can be selected by clicking on it with the left mouse 
button.  

If an incorrect selection is made, the Select None button will deselect the files that have been selected. Once the 
desired file selection has been made, the user should click the Zip Files Button to zip the files.  

NOTE: Prior to zipping the files, the existing digest.zip file will be renamed to “digest_ + date of file + time of file + 
.zip”. The digest.zip file will continue to be the file that should be uploaded. 
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Once the files are "zipped", the Zip File creation message window will appear, and the user should note the 
location of the Zip file that was created. Clicking the OK Button on this message window will return the user to the 
Zip Files form, where clicking the Cancel button or the X button in the upper left of the window will close this form 
and produce the Upload Files to FTP Form. 

 

The Upload Files form should populate the location of the zipped file automatically, but if it does not, the user 
should click the Browse button to the right of the Select File field. This will produce the Open dialog box, which 
defaults to the Digest Folder that was created during the Digest Export process. The user should locate and then 
click on the digest.zip file to highlight it, then click the Open button. This will place the file along with its complete 
path in the Select File to Upload field on the Upload Files to FTP. 

 

Clicking the Begin Upload button will upload the zipped file to the County's folder on the WinGAP FTP site. Various 
messages will display as the file is uploaded, and when complete, the user will be informed if the upload was 
successful and returned to the Upload Files to FTP form. The Cancel button on this form can be clicked to return to 
the main WinGAP Screen. After the file is uploaded, the County should call or email their digest service bureau and 
inform them that the file has been uploaded. 
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NOTE: The Digest Export routine accommodates HB 380 which states that, when possible, a tax bill shall be sent to 
the owner as of Jan 1 and to the current owner. The Digest Export routine will search all New Owner and Future 
records for ownership changes, and when different from the Live Owner information, it will place the New Owner 
or Future Owner data in the d_real digest file. New Owner data will take precedent over Future Owner data. 

 

MANUFACTURED HOUSING DIGEST FILES 

Selecting this option produces the Manufactured Housing Export Form that allows the user to select Manufactured 
Housing data for either Prebilled, Non-Prebilled (Residential Improvement Mobile Homes), or all Manufactured 
Housing. The form defaults to Prebilled. One of these options MUST be selected. 

 

 

If the Prebilled option is selected, the user can proceed to the Tax District selections. If either the Non – Prebilled 
or All radio button option is selected, an additional set of checkboxes will appear. Here the user must choose 
either House Priced Manufactured Homes, MH Priced Manufactured Homes, or both. These selections will depend 
upon how the County prices their Non-Prebilled Manufactured Homes. The default is both. If one of the options is 
not needed, the checkmark can be removed by clicking in the appropriate checkbox. 
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The user can also select an individual Tax District by clicking on the Tax District combo box, or all Tax Districts by 
clicking the "All Tax Districts" checkbox (NOTE: one of the options, either an individual Tax District, or all Tax 
Districts MUST be selected for WinGAP to proceed).  

 

At the bottom of the Digest Export form are two fields, the Server Export and WS Export, that are very important. 
These fields MUST contain the paths to the data folders on the Server (or other designated computer) where the 
digest files will be exported prior to being uploaded. If these fields are blank, or the user is not sure the paths in 
them are correct, please contact one of the WinGAP agents or come out to Online Support for assistance. 

 

Once the radio button and combo box/checkbox options are selected and the Export paths are verified, the user 
can click the Export button on the form to begin the process. WinGAP will "export" the data and create the digest 
files in the appropriate WinGAP data folder. Various progress bars will appear as the files are created. Once the 
Export process begins, the Cancel Button is disabled and the user cannot abort the process. At the conclusion of 
the process, WinGAP will display a message showing the total number of Owners, Mobile Homes, Add-Ons, etc. 
that were exported. 
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After the user clicks the OK button on this message window, WinGAP will produce the Zip Files form. Here the user 
selects the files that are to be "zipped". Normally all the files in the list are selected. The selection of the files can 
be accomplished in one of three ways: 

• The user can click the Select All button to select all of the files in the list box.  

• The first file in the list can be selected by left clicking on it with the mouse, The user can then locate the 
last file in the list, hold the Shift key down, and then click on the last file with the left mouse button 

• The Ctrl Key can be held down and each individual file can be selected by clicking on it with the left mouse 
button. 

  

If an incorrect selection is made, the Select None button will deselect the files that have been selected. 
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Once this is done, the selected files turn blue and the user should click the Zip Files Button to zip the files.  

 

 

Once the files are "zipped", the Zip Files creation message window, below, will appear, and the user should note 
the location of the Manufactured Housing Zip file that was created. 
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Clicking OK on this window will return the user to the Manufactured Housing Zip Files form, where the Cancel 
button or the “X” button on the window can be clicked, producing the Upload Files to FTP Form. To upload the 
digest files, the user should click the button to the right of the Select File to upload field. This will produce the 
Open dialog box, which defaults to the Digest Folder that was created during the Digest Export process. The user 
should click on the mh_dig.zip file to highlight it, then click the Open button. This will place the file along with its 
complete path in the upload field. 

 

  

The user should then click the Begin Upload button, and the file will be uploaded to that County's folder on the 
WinGAP FTP site. Various messages will display as the file is uploaded. The user will be informed that the upload 
was successful and then will be returned to the Upload Files to FTP form.  

 

At the conclusion of the Manufactured Housing Digest Upload process, a message will display asking the user if the 
Manufactured Housing Year End value rollover should be performed. If this is the final Prebilled Manufactured 
Housing Digest Export for this year’s billing, then the user should answer Yes to this question and run YEC for 
Manufactured Housing. However, if this is not the final Manufactured Housing Digest Export that will be run, 
selecting No will return the user to the main WinGAP screen. This Rollover procedure can be run at another time 
with on the Tools > File Maintenance > Year End Cleanup menu by selecting the MH YEC option. 

 

 

The Manufactured Housing Year End value rollover process does the following: 

• Places the value that is found in one of the Mobile table value fields (Ovrvalue, Guidevalue, or Value, 
whichever takes precedence) into the Prev_box field. 

• Places the value found in the Addonval field in the Mobile table into the Prev_addon field. 

• Places the value in the Mavcurr field (if one exists) in the Mobile table into the Mavprev field. 

• Places the value in the Mav field in the Mobile table into Mavorig. 

• Sets the Returnmail field in the Mobile table to false (zero). 
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If the Manufactured Housing Year End Cleanup is to be performed now, clicking Yes produces the Year End 
Cleanup form for Manufactured Housing. To perform the Manufactured Housing YEC, the Do YEC button should be 
clicked to proceed. 

 

 

Various messages will display on the Year End Cleanup form as the records are processed, and at the conclusion of 
the process the user will receive a message indicating the Year End Cleanup is complete. The user should click OK, 
then Cancel on the YEC form, then Cancel on the Export form, returning the user to the main WinGAP screen. The 
MH YEC moves the current values into the previous value fields on the Mfg Housing screen. 

 

 

 

AUDIT DEPT DIGEST STUDY FILES (AFTER DIGEST IS FINAL) 

This option on the File > Export submenu will produce the Audit Department Digest Study Files export. This export 
is run after the Tax Digest is finalized. If the user attempts to run the Audit Dept Digest Study Files export BEFORE 
the Digest is final, or the most recent digest export was for selected tax district (s) only instead of a county-wide 
export, this message will appear: 
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Clicking OK on the Message will still create the Audit Department Digest Study Files, but it would be best if the user 
makes sure the Tax Digest is final before the above routine is run and the Files uploaded for the Audit Department. 

 

Once the Tax Digest is finalized, clicking the Audit Department Digest Study Files option displays various messages 
and then produces the Upload Files to FTP Form with the file path automatically populated. The user should click 
the Begin Upload button, and the file will be uploaded to that County's folder on the WinGAP FTP site.  

 

 

Various messages will display as the file is uploaded. The user will be informed that the upload was successful then 
will be returned to the Upload Files to FTP form. Clicking the Cancel Button on the form will launch the County's 
default email program. The user should click the Send Button on the email form to notify the Audit Department 
that the Audit Department digest files have been uploaded. Once this is done, the user will be returned to the 
main WinGAP Screen. 
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AUDIT DEPT SALES REPORT 

Selecting this option produces the DOAA County Sales Export form. This sales report is normally run in the spring of 
the year, and the county will be notified by DOAA when it’s time to run the report. The current year database is 
selected by default based on which year database you currently have open. The user should select the previous 
year’s database from the drop-down menu. If the county gives a developer’s discount/absorption rate **AND** 
uses one of the seven (7) land influences to apply the discount, the user will select the discount description using 
the influence combo box, as also shown in the image below. If the county does not offer this discount to 
developers, or it is applied in some way other than a land influence, simply check the appropriate box. 

 

 

Clicking Next will display various messages and then produce the Upload Files to FTP Form with the file path 
automatically populated. The user should click the Begin Upload button, and the file will be uploaded to that 
County's folder on the WinGAP FTP site. 

 

 

Various messages will display as the file is uploaded. The user will be informed that the upload was successful then 
will be returned to the Upload Files to FTP form. Clicking the Cancel Button on the form will return the user to the 
main WinGAP Screen. 

 

PERSONAL PROPERTY REPORTING FORMS 

There are two options on the Personal Property reporting Forms submenu. If the county does not send PT50 
reporting forms to owners with a sum of personal property account values under $7,501, the second option, Set 
No-PT50 Flags, should be selected first. This menu item sets a “No-PT50” flag to all such accounts, and they will not 
receive a PT50 personal property reporting form. 

NOTE: An owner might have multiple accounts that by themselves are under $7,501, but combined they add up to 
a total that is $7,501 or greater. In that case, the accounts would not have the “No-PT50” flag set, as that owner 
has a total account value over the taxable threshold. 
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Once the “No-PT50” flags are set, or if the County sends PT50 forms to all owners regardless of account value, the 
first option, Personal Property Reporting Forms, should be selected. Clicking the Export button begins the export 
process, where various messages are displayed. 

 

 

Once the export is complete, a message will appear with the path that the files have been exported to. 

 

 

After the user clicks the OK button on this message window, WinGAP will produce the Zip Files form. Here the user 
selects the files that are to be "zipped". Normally all the files in the list are selected. The selection of the files can 
be accomplished in one of three ways: 
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• The user can click the Select All button to select all of the files in the list box.  

• The first file in the list can be selected by left clicking on it with the mouse. The user can then locate the 
last file in the list, hold the Shift key down, and then click on the last file with the left mouse button to 
select all the files. 

• The Ctrl Key can be held down and each individual file can be selected by clicking on it with the left mouse 
button. 

  

If an incorrect selection is made, the Select None button will deselect the files that have been selected. 

  

Once this is done, the selected files turn blue and the user should click the Zip Files Button to zip the files.  

 

 

Once the files are "zipped", the Zip File creation message window will appear, and the user should note the 
location of the Zip file that was created. Clicking the OK Button on this message window will return the user to the 
Zip Files form, where clicking the Cancel button or the X button in the upper left of the window will close this form 
and produce the Upload Files to FTP Form. 
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The Upload Files form should populate the location of the zipped file automatically, but if it does not, the user 
should click the Browse button to the right of the Select File field. This will produce the Open dialog box, and the 
user should locate and then click on the pp_pt50.zip file to highlight it, then click the Open button. This will place 
the file along with its complete path in the Select File to Upload field on the Upload Files to FTP. 

 

 

Clicking the Begin Upload button will upload the zipped file to the County's folder on the WinGAP FTP site. Various 
messages will display as the file is uploaded, and when complete, the user will be informed if the upload was 
successful and returned to the Upload Files to FTP form. The Cancel button on this form can be clicked to return to 
the main WinGAP Screen. 

 

 

BACKUP CURRENT YEAR DATA LOCALLY 

NOTE: DO NOT use this Backup menu option to transfer files to the public. Confidential data has not been 
redacted. 

 

Selecting this option on the Export Menu produces the Database Backup form. 

 

This option allows the user to backup WinGAP current appraisal year data to another folder, zip the files, and then 
upload them to the FTP site. This backup process could be done for several reasons: 

• The user wants to make a backup of the data files prior to Online Support fixing a problem  

• The user wants to make a backup of the data before using SSMS or SQLMaster to run some tests on the 
data  

• The user wants to upload data to the WinGAP FTP site for use by a LGS support agent or for other 
purposes  
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In most cases, the defaults options should be chosen as the screen was likely configured when your application 
was installed. Notes on the options on the form are provided at the bottom of the form. The Appraisal Year that is 
to be backed up should be selected in the list box at the top of the form by highlighting the year in the list box and 
clicking in the Select checkbox. More than one year can be selected if desired. 

NOTE: The Backup process creates a folder called wingapsql_backup, which will be located in the root directory on 
the user’s local hard drive. The backup file (or files) is placed in this folder. 

NOTE: You must check the checkbox for COMPRESS if you wish to upload the backup to the ftp site. WinGAP will 
not permit you to upload an uncompressed “bak” file. 

 

Once all options are selected, the Backup button should be clicked. WinGAP will prompt the user, and Yes should 
be clicked to start the backup. Various messages will appear as the backup is processed. 
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At the conclusion of the Winzip process, the Upload Files to FTP window appears, which will allow the user to 
upload the backup to the County folder on the WinGAP FTP site.  

NOTE: If the user does not wish to upload the files, but merely make a backup, the Cancel button on the Upload 
window should be clicked to terminate the upload process. 

 

The Browse button to the right of the Select File to upload field should be clicked, and the user will be taken to the 
wingapsql_backup folder. The backup file to upload should be selected, and then the user should click the Open 
button. The user will be returned to the Upload form, where the Begin Upload button should be clicked, and the 
file will be uploaded to that County's folder on the WinGAP FTP site. Various messages will display as the file is 
uploaded. 
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At the conclusion of the upload process the user will be returned to the Upload Files to FTP form. The Cancel 
Button on the Upload Files to FTP form can be clicked to close the Upload window. A message will appear 
informing the user that the backup process has been completed. 

 

 

WEBSITE DATA 

This option on the Export sub-menu allows the user to export data from specified files and then upload the data to 
the county’s folder on the WinGAP FTP site. The data is available for use by the county’s website vendor(s). Clicking 
on the File > Export > Website Data menu option will produce several windows, one on top of the other, as 
routines are run and the data is zipped. 
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At the conclusion of the Winzip process, the file websitebackup.zip is created and the Upload Files to FTP window 
appears. The user should then click the Begin Upload button, and the file will be uploaded to that County's folder 
on the WinGAP FTP site. Various messages will display as the file is uploaded, such as the Uploading message. 

 

 

If the Website Data upload is successful, the user will receive a completion message. Clicking OK on this message 

will return the user to the main WinGAP screen. If the upload is not successful, for instance if the user's Internet 

connection is not functioning, the user will receive an error message and the user can try again later to upload the 

digest files. 

NOTE: It’s a good idea to manually purge the destination export folder from time to time. The export destination 
folder is <network location>\wingapsql\exports\qpublic\ - the entire contents of the ‘qpublic’ folder are zipped 
and included in the websitebackup.zip file. Over the years, without cleanup, the websitebackup.zip could contain 
many years of dated and old exports. 
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COVENANT REGISTRY 

This option on the Export menu creates a Covenant Registry, a file that contains information such as owners’ 
names and addresses, parcel numbers, total acres, and covenant acres for all of the County’s CUV and FLPA 
Covenants. The Covenant Registry is now required as part of the annual DOR Digest Submission process. When 
selected, a series of messages will appear and on completion the Upload Files to FTP window will appear with the 
file’s path already loaded. 

 

 

Clicking the Begin Upload button will upload the file to that County's folder on the WinGAP FTP site. Various 
messages will display as the file is uploaded. Once completed, the user will see an upload successful message. 

NOTE: This export is automatically included when the user runs the Digest Submission Reports. 

 

HOMESTEAD REGISTRY 

This option on the Export menu creates a Homestead Registry, a file that contains a listing of all of the County’s 
Homestead information, such as parcel numbers, homestead codes, tax districts, and ownership information. The 
Homestead Registry is not required as part of the annual Digest Submission process. When selected, a series of 
messages will appear and on completion the Upload Files to FTP window will appear with the file’s path already 
loaded. 

 

 

Clicking the Begin Upload button will upload the file to that County's folder on the WinGAP FTP site. Various 
messages will display as the file is uploaded. Once completed, the user will see an upload successful message. 

NOTE: This export is automatically included when the user runs the Digest Submission Reports. 

 

DATA FILES FOR PUBLIC 

WinGAP can create data files for public use that the Assessor’s Office can provide to anyone that requests them. 
These files are stripped of any confidential information, such as Social Security Numbers, cost data, and inventory 
information. Also, the NADA files and ABOS files are either omitted or cleaned of data. To create these files, the 
user should click on the Data Files for Public option and the Public Export data selection form will appear. 
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The default format is a fixed length .txt file, while clicking the CSV checkbox will produce a .csv instead. Clicking the 
Export button will cause a series of messages to appear and on completion there will be a message showing Export 
Done. 

 

 

The files can be found in the exports folder on the server. From here the user can zip whichever files are requested 
and copied to external media, such as a flash drive, CD, or DVD to give to a requesting individual. 

 

 

DOR CUV MARKET STUDY SALES LIST 

This option is a one-click operation that is run annually which creates various files that contain land information 
relating to sales of rural land. When the Department of Revenue requests the sales to perform their annual CUV 
and FLPA market study, selecting this option automatically processes and uploads the required sales in a few 
seconds. 

If you encounter any problems or have questions, do not hesitate to use online support or contact one of the DOR 
Tech Support agents. It is of utmost importance when you receive the email about creating this data that we 
obtain it as soon as possible. 
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EXPORT NEW OWNERS FOR VENDOR 

This option produces the New Owners list to send to a vendor. Selecting it will prompt a series of messages to 
display, and once the file has been created a message will appear with the path that the file was saved to. 

 

 

Clicking OK will open the Upload Files to FTP form with the file path already entered. Clicking the Begin Upload 
button will upload the file to that County's folder on the WinGAP FTP site. Various messages will display as the file 
is uploaded. Once completed, the user will see an upload successful message. Clicking Cancel or the “X” will return 
the user to the main WinGAP screen. 

 

 

 

EXPORT SALES FOR DOR 

The Export Sales for DOR option produces a sales list for the Department of Revenue QTP study. When the DOR 
requests this list, selecting this option will create an excel file to be uploaded to the County’s FTP site. When 
selected, a series of messages will display, and once the process is complete the Upload Files to FTP form will 
appear with the file path already entered. Clicking the Begin Upload button will upload the file to that County's 
folder on the WinGAP FTP site. Various messages will display as the file is uploaded. Once completed, the user will 
see an upload successful message. Clicking Cancel or the “X” will return the user to the main WinGAP screen. 
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LGS AUDIT EXPORT 

The LGS Audit Export is a complete digest record that is stylized after the Department of Audit sales report. This 
excel file is already generated as part of the Digest Files submission, and this is simply a way to generate this file 
without exporting the entire digest submission package. Clicking this option is a single step operation. 

 

DOR ITS EXPORT 

All of these selections are for DOR agents, and are not used by the Counties. 

 

LAUNCH REPORT SITE  

The Launch Report Site will open the user’s default web browser to the SQL Server Reporting Services web portal 
for the County Reports. A variety of reports are available here by default, and more can be designed and deployed 
using Visual Studio. 

 

 

UPLOAD FILES TO FTP 

The Upload Files form allows the user to place any file on the FTP site where they are available to vendors and 
other agencies. To select a file for upload, the user should click the Browse button to the right of the Select File 
field. This will produce the Open dialog box. The user should locate and then click on the file to highlight it, then 
click the Open button. This will place the file along with its complete path in the Select File to Upload field on the 
Upload Files to FTP. 
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Clicking the Begin Upload button will upload the zipped file to the County's folder on the WinGAP FTP site. Various 
messages will display as the file is uploaded, and when complete, the user will be informed if the upload was 
successful and returned to the Upload Files to FTP form. The Cancel button on this form can be clicked to return to 
the main WinGAP Screen. 

 

DOWNLOAD FROM FTP 

This selection opens the user’s default web browser to the county’s HTML interface of their FTP folder. This web 
URL is what should be given to vendors and agencies that are downloading files from your FTP site. 

 

 

PRINT SETUP 

The Print Setup option on the File Menu produces the Windows Print Setup Form where the user can change the 

properties for the default Windows printer, change the Paper Size, Source, and Orientation, or select another 

printer, if available, by clicking on the Printer Name combo box. 
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EXIT 

The Exit option on the File Menu, allows the user to exit WinGAP. The hot-key combination of Alt-F4 (Function Key 

F4) will also exit the program, as will clicking the “X” in the upper right-hand corner of the main WinGAP screen. 

 

 

SQL MENU 

The SQL Menu contains a variety of options used by System Administrators and WinGAP Support Agents to 
perform various procedures, functions, and data modifications within WinGAP. A user must have Admin rights in 
Password Administration in order to use any of the options on the SQL Menu. 
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SERVER MODE DIALOG 

The Server Mode Dialog form allows the System Administrator or WinGAP Support Agent to configure and edit the 
client application connection parameters and settings for connecting to the server’s MSSQL instance. These inputs 
are set by the WinGAP team when the program is installed on the computer, and generally should not be altered 
by the end user. If the county upgrades servers, the WinGAP team can use this option to update the setting as 
appropriate. 

 

 

UPLOAD DBF DATA 

This option produces the Manage Server Objects form. This form is used for converting old WinGAP V3 data into 
MSSQL, or WinGAP format. All former V3 counties are now converted to WinGAP and have been for some time. 
This menu item will remain in case a county needs to convert to SQL format some old V3 data that was not 
previously converted. 
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TRUNCATE LOG FILES 

This option produces a message that allows the user to shrink the log file of the current Appraisal Year. The specific 
log files truncated are the transaction logs. Transaction logs can get quite large over time, increasing file storage 
requirements for active data and backups alike. Truncating these logs can sometimes save a great deal of storage 
space. 

WARNING: Counties who leverage incremental backups should avoid using this truncate feature with clear and 
express guidance and permission from your database administrator (MIS/IT). 

 

 

Clicking Yes on the message will begin the process of shrinking the log file, and when finished, a message will 
appear informing the user that the process was successful. Clicking OK on this message will return the user to the 
WinGAP main screen. 

 

 

 

LAUNCH DEBUG VIEWER 

This option produces the Debug Viewer form. The Debug Viewer is used to “debug” a problem within WinGAP. This 
usually occurs when the code for a particular routine in WinGAP is not correct, or a file structure within WinGAP 
has not been updated. The Debug Viewer will display lines of running code within WinGAP, which can be reported 
by the System Admin or LGS Agent to the WinGAP Dev Team so they can find where the error is within either the 
program or the database and fix the problem. 
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VERIFY DATA FILES –  FULL 

The Verify Data Files – FULL option on the SQL menu allows the user to run the old fashioned, very comprehensive, 
very deliberate (slow) Strucfix. ALL users must be out of WinGAP before running this routine.  

 

 

Clicking OK produces a second warning message, as seen below. If the user is not sure this routine should be run, 
The No button should be clicked to abort this process.  
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If Yes is selected, various messages will appear as the Strucfix routine is run. 

 

 

At the conclusion of Strucfix, a “completed” message will be displayed. Clicking OK will complete the old Strucfix 
process and return the user to the WinGAP main background screen. 

 

 

 

CUSTOM QUERIES 

Clicking this option produces the Custom Queries form, where various SQL Queries can be written and executed. 
Often, counties have bulk processes they like to run for various tasks such as removing return values, updating 
floating homestead current values, importing bar code scanned returns, etc. With the assistance of a SQL Database 
expert, the Custom Queries form allows the entry of queries that perform easy point-and-click execution of 
complex scripts for bulk processes. 



 
51 

 

 

FOREIGN KEY CLEANUP 

This menu item is reserved for special, very complex and powerful scripts, and should never be executed by county 
users. 

 

 

CREATE TRIGGERS 

The Create Triggers menu item is used by Advanced WinGAP technical support personnel to recreate database 
triggers inside the WinGAP database. Prior to running the create triggers, Technical Support experts will first run 
the ‘delete triggers’ option. The triggers created here are the DEL triggers used inside WinGAP to populate the 
DEL_ tables when property items are deleted. 
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DELETE TRIGGERS 

Delete triggers will remove the triggers created by the previous menu item. Deletion of triggers is required before 
the create triggers menu can run. SQL will not overwrite an existing trigger – it needs to be “deleted” before it can 
then be “created”. 

 

 

CREATE REAPPRAISE SP  

This menu item will create reappraise stored procedures used by third-party vendors who connect and edit 
property items outside of WinGAP. These stored procedures are executed by the third-party vendors after they 
have updated a parcel to force it to be repriced so that values remain in sync when the WinGAP users access those 
parcels post third-party access. 

 

 

BACKUP SQL DATABASE  

This option allows the user to backup and zip any WinGAP appraisal year data to another folder. This backup 
process could be done for several reasons: 

• The user wants to make a backup of the data files prior to Online Support fixing a problem  

• The user wants to make a backup of the data before using SSMS or SQLMaster to run some tests on the 
data  

• The user wants to upload data to the WinGAP FTP site for use by a LGS support agent or for other 
purposes  

NOTE: DO NOT use this Backup menu option to transfer files to the public. Confidential data has not been 
redacted. Selecting this option on the Export Menu produces the Database Backup form. 
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In most cases, the defaults options should be chosen as the screen was likely configured when your application 
was installed. Notes on the options on the form are provided at the bottom of the form. The Appraisal Year that is 
to be backed up should be selected in the list box at the top of the form by highlighting the year in the list box and 
clicking in the Select checkbox. More than one year can be selected if desired. 

 

Once all options are selected, the Backup button should be clicked. WinGAP will prompt the user, and Yes should 
be clicked to start the backup. Various messages will appear as the backup is processed. 
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At the conclusion of the Winzip process, the user will be returned to the main WinGAP screen. 
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CHECK ALL STRUCTURES (STRUCFIX)  

When updating WinGAP versions, it might be necessary to update the file structure of the WinGAP databases, or 
“strucfix”, as instructed in the message on the WinGAP website, below. If it is required, the WinGAP update page 
will mention it. 

 

 

Clicking this option on the SQL menu produces several messages. The first message lets the user know that all 
other users must be out of WinGAP, and it also shows the last version that strucfix was run from. If the versions are 
the same, the user has already strucfixed with this version. OK should be clicked to proceed. 

 

 

Yes should be clicked on the next message to proceed with the strucfix process. If the strucfix process is up to date, 
the user should click No. Also, if there is a Future appraisal year in place, the message will remind the user that 
strucfix will run twice, once for the current year, and once for the future year. 
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Various messages will display as the strucfix process is run. The user should click OK on the strucfix completed 
message to return to the main WinGAP screen.  

NOTE: Running strucfix only updates the table structures in the appraisal year it is run. The user must switch to the 
other appraisal years by using the File > Select Appraisal Year option and then run strucfix in every appraisal year. 

 

 

PROPERTY MAINTENANCE MENU 

 

WILD SEARCH 

The Wild Search option on the Property Maintenance Menu produces the Wild Search Form, where information 
about certain types of property in WinGAP can be obtained without the user running SSMS or SQLMaster. 

NOTE: The Wild Search option on the Tools Menu is disabled if WinGAP is operating in Guest Mode. 

 



 
57 

The checkboxes along the top of the Wild Search Form allow the user to select the type of property to be Viewed 
or Edited. Viewing or Editing depends upon which one of the checkboxes at the bottom of the form is checked, 
View Only or Edit Mode. Only one type of property can be selected for viewing/editing at any point. 

For example, if the user wishes to view all the Residential Improvements with a Grade of 100 they would click the 
Res Imps checkbox, which will display all of the Residential Improvements on the Wild Search Form. Then, the user 
would click on the Field Query combo box on the upper left and select the Grade field, enter 1.00 in the Data field, 
and click the Filter button. The user can filter on up to four fields by also using the other combo boxes. 

 

 

The user can save the query results by clicking the Export to Excel button, which will send the entire dataset to a 
new Excel spreadsheet that the user can then edit and save, perform analysis on, etc. The Clear Query button will 
reset all the combo boxes and data fields. The Load Data button will reload the currently selected table’s unfiltered 
data. The Show All button will allow you to scroll through the entire table’s data set – normally your view is 
truncated to the top 100 records. 

 

Highlighting a record on the list and clicking the Open button on the bottom left of the form will open the record in 
either View Only or Edit Mode depending on which option is checked. No changes can be made in View Mode, and 
all the normally editable fields will be grayed out. 
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Users can enter more complicated SQL based queries on the Wild Search form by selecting the Use ADV Query 
button. This will disable and grey out the Field Query combo boxes and allow the user to enter the query in the 
SQL Where Clause box and activates the Select Saved Query combo box. 

NOTE: The Select Saved Query combo box is functional at the present time, however, saving queries to this list is 
not automatic and is intentionally an advanced function to keep the list trim and efficient. The tech support team 
can assist users with adding advanced queries to the combo box. 
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NOTE: Very complex queries built and used in the advanced query engine can, at times, become too complex for 
the Excel export engine. 

 

OWNER 

The Owner option on the Property Maintenance Menu produces a sub-menu with four options that allows the user 
to add a New Owner (the New option), Search for an Owner (the Search option), perform a search for property 
owned by more than one owner (the Multiple Owner Search option), or Transfer Property between Existing 
Owners or between an Existing Owner and a New Owner (the Property Transfer option). 
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NEW 

The "New" option is one of several places in WinGAP that can be selected to add a New Owner to the database. 
The user can click with the mouse to select this option and proceed to the Owner Information Form. The Ctrl + N 
"hot-key" combination can also be used to produce the New Owner form. 

 

 

See the Owner Information Form section of this manual for help specific to that Form. 

 

SEARCH 

Clicking on the "Search" option on the Owner sub-menu or pressing the hot-key combination of Ctrl + O will 
produce the Owner Search Form. Owners in WinGAP can be searched for by Name (the default search order), 
Parcel Number, or Owner Account Number (also known as the Ownkey). 
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See the Owner Search Form section of this manual for help specific to that Form. 

 

MULTIPLE OWNER SEARCH 

Clicking on the "Multiple Owner Search" option or pressing the hot-key combination of Ctrl + M will produce the 
Multiple Owner Search Form. 
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See the Multiple Owner Search Form section of this manual for help specific to that Form. 

 

PROPERTY TRANSFER 

The "Property Transfer" option or pressing the hot-key combination of Ctrl + T will produce the Property Transfer 
Form. This is one of six places in WinGAP where the user can transfer property. The other five are: 

 

• The Transfer Button on the Tool Bar 

• The Transfer Button on the Owner Information Form 

• The Transfer Button on the Real Property General Information Form 

• The Transfer Button on the Personal Property General Information Form 

• The Transfer Button on the Prebilled Manufactured Housing Form 
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See the Property Transfer Form section of this manual for help specific to that Form. 

 

REAL 

The Real option on the Property Maintenance Menu produces a sub-menu with three options. The Parcel 

Information option produces a Form that allows the user to Search for Real Property. The Sales option produces a 

Form that allows the user to Search for Sales Information associated with Real Property. The View Current Index 

option produces a listing of Real Property. 
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PARCEL INFORMATION 

The "Parcel Information" sub-menu option is one of two places in WinGAP that can be selected to produce the 
Real Property Search Form (the other is the Real Button on the Toolbar). The user can also use the Ctrl + R "hot-
key" combination to produce the Form. 

 

 

See the Real Property Search Form section of this manual for help specific to that Form. 

 

 

SALES 

The "Sales" option on the Real sub-menu will produce the Sales Search Form. The user can click with the mouse to 
select this option and proceed to the Sales Search Form. 
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The Sales Search Form is divided into several sections. At the top of the Form is the Search Field, where, depending 
upon the Search Order, the Sales owner's name, parcel number, or other criteria is keyed. Beneath the Search field 
is the Sales Information box where Sales records whose parcel numbers, owner's names, or other criteria that 
most closely match that keyed into the Search Field will be displayed. On the upper right of the Form is the Search 
Order section, where the default Search Order (Parcel Number) can be changed by clicking any of the other Radio 
Buttons. 

 

NOTE: only Parcels with sales will appear in the box. Parcels that do not have sales will not be shown. 

 

Beneath the Search Order section is the Number of Hits to Display field which contains the default number of Real 
Property records that will be displayed in the Real Property Information box. This default value can be temporarily 
changed, if necessary (and if Logins are enabled, set as a default for that user). 

 

The top blue panel beneath the Real Property Information box is the Multiple Owners memo field where the 
names of Multiple Owners of a parcel will be displayed if the Name Search Order is used. 
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Search Field 

 

NOTE: Before keying any search information in the Search Field, the user should be sure that the Cursor is at the 
far left of the field. Not doing this will in most cases produce incorrect information. 

 

 

Parcel Number Search 

 

What the user keys into the Search field is first determined by the Search Order. The default for the Sales Search 
Form is Parcel Number Order. If Parcel Number is selected as the Search Order, the Search field will contain 
"dashes" near the beginning of the field that represent the "breaks" in the Parcel Number between the Map 
Number and other segments of the Parcel Number. The number of "dashes" will depend upon the structure of the 
County's Parcel Number, as set up in the Parcel Number Template Field in Tools > Preferences. For example, the 
default WinGAP Parcel Number structure is XXXX-XXX-XXXX-XXX, with a "dash" between the Map, Block, Parcel, 
and Sub-Parcel numbers, for a total of three "dashes". These three "dashes" would appear toward the left end of 
the Search Field. The Parcel Number can be customized depending upon how a County wants to structure its 
Parcel Number. 

 

To locate Sales for Real Property by a specific Parcel Number, say G01 -00 -007 -, the entire Parcel Number can be 
keyed into the Search field, as shown below. The user must be careful while keying the Parcel Number that the 
dashes and any spaces in the Search Field are the same as in the Parcel Number. After clicking the Search Button 
the desired record should appear at the top of the Real Property BBrowser box, followed by other Real Property 
records in ascending Parcel Number order. Again, the number of records that display will depend upon the 
Number of Hits to Display value. If the Parcel Number has letters in it, the letter can be keyed in either upper or 
lower case; case does not matter in WinGAP. 
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Various short-cuts with Parcel Numbers can be used to find Sales for Real Property. For example, if the user wishes 
to see sales for all of the Real Property records on Map "J05", J05 can be keyed in the proper place in the Search 
Field. Clicking the Search Button will display all Real Property records with that Map Number in the County, up to 
the default Number of Hits to Display value, as shown on the next page. If there are more records on Map "J05" 
than those displayed in the Real Property bBrowser box, and the user wishes to see all of them, the default 
Number of Hits to Display value can be increased to a number suitable to display all of the Real Property records 
(the Search Button must be clicked again after changing the value). 
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The Lucky Button 

 

The Lucky Button, located to the right of the Search Button, allows the user to perform both a Sales Information 
search AND open the first record that meets the criteria keyed in the Search field. If the user places the mouse 
cursor on the Lucky Button, a "tool tip" will appear: 

 

 

 

 

For example, the user wants to look at all of the Sales records for Map/Parcel Number G01 -00 -002. After keying 
the parcel number in the Search field, the user can click the Lucky Button and be taken directly to the Sales 
Information record for that Map/Parcel. 
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When using the Lucky Button, the criteria keyed into the search field must exactly match that of the desired 
record. Otherwise, the user will be taken to the record that is closest to matching the criteria keyed into the Search 
field. 

 

Name Search 

 

The Search Order for Sales of Real Property records can be changed to Name Order by clicking on the Name radio 
button in the Search Order section of the Real Property Search Form. How the Name is keyed into the Search field 
will depend upon how the County manages the Name information in the Owner's database. Names in WinGAP can 
be keyed on the Owner Information Form in either the Last Name-First Name-Middle Initial fields, or in the 
Corporate Name field. An owner of Real Property cannot have names in both places. One County may prefer to 
reserve the Corporate Name field for Businesses and Corporations, and use the Last Name-First Name-Middle 
Initial fields for all other owners; another County may prefer to use the Corporate Name field for ALL owners; a 
third may prefer to use the Last Name-First Name-Middle Initial fields for ALL owners. It is entirely a local matter. 

 

If the user is looking for Sales for a Real Property owner's name that is located in the Last Name-First Name-Middle 
Initial fields, the name MUST be keyed as follows in this example: Smith, Candace; the comma is mandatory if the 
Last Name-First Name-Middle Initial fields are used. If the Real Property owner's name is found in the Corporate 
Name field, the name is keyed as it was entered in that field: Smith Candace; no comma is used in the Search field 
for a Corporate Name, unless the comma was keyed as part of the name. 

 

As mentioned earlier under Parcel Number Search, case does not matter in WinGAP. Information on the Owner 
Information Form can be entered in "proper" case, such as Smith Candace, in all capital letters, such as SMITH 
CANDACE, or in all lower case, such as smith candace. Again, it is entirely a local matter. When searching for Sales 
for Real Property, case also does not matter as far as how the Real Property owner's name is keyed in the Search 
Field: proper, upper, or lower case will all yield the same result. 

 

Once a Real Property owner's name is keyed in the Search Field, the user should click on the Search Button to the 
right of the field. If an entire name was keyed and found, the Real Property record(s) for that owner will display at 
the top of the Real Property BBrowser box, along with other Real Property records in descending alphabetical 
name order, as shown on the next page. If the keyed name is not found, Real Property records with the owner's 
name nearest to the name keyed will display in descending alphabetical order. The number of records that display 
will depend upon the Number of Hits to Display value. 
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Various short-cuts with the names of Real Property owners can be used to find Sales for owners of Real Property. 
For example, if the user wishes to see all of the owners with the Last Name of “Roberts” that own Real Property, 
the name roberts can be keyed in the Search Field. Clicking the Search Button will display all of the Real Property 
records with owners of the Last Name or Corporate Name of Smith in the County, as shown below. 
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Names keyed in the Last Name-First Name-Middle Initial fields will display ahead of names keyed in the Corporate 
Name field. Again, the number of records that display will depend upon the Number of Hits to Display value. If 
there are more Smiths than those displayed in the Real Property BBrowser box, and the user wishes to view all of 
the Smiths, the default Number of Hits to Display value can be increased to a number suitable to display all of the 
Smiths (the Search Button must be clicked again after changing the value). 

 

Another short-cut with Name Order searches is to key the beginning part of a Real Property owner's name in the 
Search Field to find matching owners of Real Property records. For example, the letters Bar can be keyed to display 
all Real Property records whose owner's Last Name or Corporate Name begins with the letters "Bar". 

 

 

Account Number Search 

 

The Search Order for Sales of Real Property records can be changed to Account Number Order by clicking on the 
Account # radio button in the Search Order section of the Personal Property Search Form. The Account Number for 
Real Property is the same as the WinGAP Realkey Number for Real Property. To locate Sales for Real Property by a 
specific Account Number, say "1030", the entire Account Number should be keyed into the Search field, as shown 
below. After clicking the Search Button, the desired record, if it has any sales, should appear at the top of the Real 
Property BBrowser box, followed by other Real Property records in ascending Account Number order. Again, the 
number of records that display will depend upon the Number of Hits to Display value. 
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Sales Search bBrowser box 

 

The information that is displayed in the Sales Search bBrowser box varies depending upon which Search Order is 
used. 

 

If the default Parcel Number search order is used, the following displays, from left to right: 

 

Parcel Number 

Total Acres 

Owner’s Name 

Legal Description 

Homestead Exemption Code 

House Number, Extension, Street Direction, Street Name, and Street Type (the Situs Address of the Parcel) 

Owner Account Number (the Ownkey) 

Real Property Account Number (the Realkey) 

 

If the Name search order is used, the following displays, from left to right: 

 

Owner’s Name 

Types of property for this owner, identified by the letters R (Real Property), P (Personal Property), or M (Prebilled 
Manufactured Home) 

Total Property Value 

Homestead Exemption Code 

Owner Account Number (the Ownkey) 

Real Property Account Number (the Realkey) 

 

 

If Account Number Search Order is used, the following displays, from left to right: 

 

Real Property Account Number (the Realkey) 

Parcel Number 

Digest Class 

Homestead Exemption Code 

Total Acres 

Legal Description 

Owner’s Name 

Owner Account Number (the Ownkey) 
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Additional information about this Real Property record can be displayed by clicking on a record in the bBrowser 
box. The information will display in the text box located on the bottom of the Sales Search Form. The information 
that is displayed will depend upon the search order used. 

 

 

 

The information that displays in the list box at the bottom of the Sales Search Form will also display in a "tool tip", 
which can be seen by clicking on any record in the list box. 
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Number of Hits to Display Field 

 

If Logins are enabled in Tools > Preferences, the Default Number of Hits to Display can be changed for each user in 
two different places. The first one is located in Tools > Password Administration (see the Tools > Password 
Administration section later in this manual for instructions). The second location where the default Number of Hits 
to Display can be changed is on any of the Search Forms. When the user clicks Cancel to leave the one of these 
Search Forms, AFTER changing the Default Number of Hits to Display value and performing a search using this new 
value, WinGAP will display the message shown below. 

 

 

 

If the new number, in this case 500, is to be the new default, the user should click the Yes Button (or hit Enter or 
Alt+Y) and the Number of Hits to Display for this user will be set as the default for that user in Tools > Password 
Administration, as the message below indicates. 
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If logins are not enabled, the default Number of Hits to Display on any Search Form in WinGAP is 200. If Logins are 
not enabled, each user in WinGAP can temporarily change the number of Owner records that will be displayed 
when searching on that particular Form, if desired, by clicking in the Number of Hits to Display field and keying the 
desired number. When the user leaves that Form, the default number will revert back to 200. 

 

Open and Cancel Buttons 

 

Once a Real Property record is located in the Real Property bBrowser box and highlighted, the user can proceed to 
the Sales Information Form for that record, as seen on the next page, by clicking the Open Button. (The Sales 
Information Form can also be opened by pressing Enter after selecting the desired record in the List Box, double-
clicking on the record, or pressing Alt+O). Sales information for this Real Property record can be viewed, edited, or 
deleted on the Sales Form. New Sales can be added by clicking on the New Button. The Cancel Button can be 
clicked (or Alt+C pressed) to return to the Sales Search Form. 
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VIEW CURRENT INDEX 

The "View Current Index" option on the Real sub-menu will produce the Real Property listing, indexed in Name 
order. The user can click with the mouse to select this option and proceed to the Real Property View Current Index 
Form. 

 

 

See the View Current Index Form section of this manual for help specific to that Form. 

 

 

 

PERSONAL 

The Personal option on the Property Maintenance Menu produces a sub-menu containing two options. 
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GENERAL INFORMATION 

Selecting this option produces the Personal Property Search Form that allows the user to search for Personal 
Property. 

 

 

See the Personal Property Search Form section of this manual for help specific to that Form. 

 

 

DNR REGISTRATION 

The DNR Registration option produces the DNR Boat Search/Add Form. This is an interactive interface that allows 
the user to reconcile boats in the newly downloaded Georgia Department of Natural Resources (DNR) boat 
database to the existing WinGAP boat database. Boats that are not currently on the Tax Digest can be added to: 

• An existing Owner’s Personal Property account 

• A new Personal Property account can be created for an existing owner 

• A New Owner/Account/Boat (all at the same time) can be created from this Form 
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The information on file about each Boat in the DNR list is displayed in the various fields on the DNR Form. The 
Form will display the first Boat Owner in the DNR database. The Next and Previous Buttons at the top of the Form 
can be clicked to scroll, one at a time, through the listing of Boats. A much quicker way to get to a specific Boat 
Owner is to key an Owner's Last Name, or part of the Last Name, into the Jump field and then click the Jump 
Button to move to the Owner with the Last Name that most closely matches the criteria keyed in the Jump field. 
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If this is not the correct owner, a listing of Boat Owners nearest to this Owner's Name can be displayed by clicking 
the List Button on the lower left of the Form. The list will display 50 boats, with the Owner's Name nearest that 
keyed in the Jump field displayed at the top of the list. The desired Owner and Boat can be clicked on in the list and 
that Owner and Boat's information will display on the DNR Form. The Close List Button beneath the listing should 
be clicked to close the Owner/Boat listing. 
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At this point the Status of the Boat will be displayed in the Status section of the Form. If the Boat is Active or 
Inactive, no action is necessary. If the New radio button is highlighted, the New Add Type section of the Form will 
be in focus and the user will need to make a decision about what to do with this Boat which is not currently on the 
County's Tax Digest. 
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There are four New Add Type options: 

• No Add 

• Add the Owner of the Boat as a New Owner, along with a New Account and a new Boat record 

• Add a New Account and the Boat record to an Existing Owner 

• Add the Boat record only to an Existing Owner and Account 

 

Prior to selecting any of these options, the user should determine which of these situations apply to this Boat. 
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No Add: If the No Add option is selected, it indicates that no decision has been made at this time as to the type of 
add to perform. If this item is selected, the user can select another boat to be added. The New Boat will remain an 
"orphan" until one of the other options is selected at a later date. 

 

Owner/Account/Boat: If the user selects the Owner/Account/Boat option in the New Add Type section, it 
indicates that a determination has been made that the Boat Owner does not exist anywhere in the WinGAP 
database. If this item is selected, the user should click the OK Button on the DNR Form, and the user will be asked 
how the Owner's name information will be handled. 

 

 

The Yes Button should be clicked if the County's Owner name information is to be displayed in the Corporate name 
field on the Owner Information Form (and stored in the Lastname field in the Owner table). The No Button should 
be clicked if the County's Owner Name information is displayed in the Last, First, and Middle name fields on the 
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Owner Information Form (and stored in the Lastname, Firstname, and Middle fields in the Owner database). 
Clicking either the Yes or No Button will create an Owner record in the Owner database, store the Owner name 
information accordingly, and take the user to the Personal Property General Information Form. 

NOTE: The use MUST select a Tax Digest on the DNR form before clicking the OK button on the DNR form as 
described above. Otherwise, a message will be presented prompting the user to select a Tax District. 

NOTE: The Apply button on the DNR form only saves the information on the DNR screen – it does not trigger the 
add property routine. Only the OK button triggers the adding of property, as determined by the selection in the 
New Add Type section on the DNR form. 

 

 

All the appropriate information for this Personal Property Account should be added on this Form. After clicking 
Apply to save the Account record, and while the user is still on this Form, the Edit Button next to the Boat Value 
field should be clicked to take the user to the Boats & Motors Form, below, where the Boat information for this 
Boat should be checked and updated as necessary. 
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Clicking OK on the Boats & Motors Form will return the user to the Personal Property General Information Form 
where OK can be clicked to return to the DNR Boat Form. The boat that was just added will now show in the Status 
section as Active. 

NOTE: Once on the Personal Property General Information Form, the Account and Boat MUST be added (it can be 
deleted after adding). For detailed information on using the Personal Property General Information Form, and the 
Boats & Motors Form, see the relevant sections of the Personal Property Manual. 

NOTE: it is not uncommon for the DNR database to list the boat type as “Other” – for counties who use ABOS 
pricing, a boat type of “other” is not compatible with ABOS and should be changed to the correct specific boat type 
before proceeding with the ABOS pricing engine. 
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Account/Boat: If the user selects the Account/Boat option in the New Add Type section, it indicates that a 
determination has been made that the Boat Owner has a record in the Owner database, but no Personal Property 
Accounts or Boat records. Selecting this option and then clicking the OK Button produces the Select Owner Form. 
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Owner Names are displayed in the list box on the top of the Form. The highlighted record will be the first Owner 
that has the last name of the Owner of the Boat that is about to be added. The user should scroll down the list 
until the correct Owner is found. The Owner's address information displays beneath the list box, and the user 
should make sure this is the correct Owner. If this is the correct Owner, the OK Button should be clicked to take 
the user to the Personal Property General Information Form. Once on the Personal Property General Information 
Form, the Account and Boat MUST be added (it can be deleted after adding, if necessary). 
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After clicking Apply to save the Account record, and while the user is still on this Form, the Edit Button next to the 
Boat Value field should be clicked to take the user to the Boats & Motors Form where the Boat information for this 
Boat should be checked and updated as necessary. One this is done, the user should click OK on the Boat form and 
then the Account form to return to the DNR form. 

 

Boat Only: If the Boat Only option in the New Add Type section is selected, it indicates that a determination has 
been made that the Boat Owner has a record in the Owner database and at least one Personal Property Account. 
Selecting this option and then clicking the OK Button produces the Select Personal Property Account Form. 
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The Boat Owner's Name will be displayed in the top list box on the Form, and the user should click on this record 
to highlight it. The Owner's address information will display beneath the list box and the Owner's existing Personal 
Property Accounts will display in the memo field on the bottom of the Select Owner Form. The user should make 
sure this is the correct Owner, then click on the Personal Property Account in the lower list box (if the Owner has 
more than one Account, the correct one should be selected). The OK Button should then be clicked to take the 
user to the Personal Property General Information Form. Once on the Personal Property General Information 
Form, the Boat MUST be added to the Account (it can be deleted after adding, if necessary). 

 

After clicking Apply to save the Account record, and while the user is still on this Form, the Edit Button next to the 
Boat Value field should be clicked to take the user to the Boats & Motors Form where the Boat information for this 
Boat should be checked and updated as necessary. One this is done, the user should click OK on the Boat form and 
then the Account form to return to the DNR form. 

 

Other Boats can now be processed as needed. When finished, the user can click the Cancel button to exit the DNR 
form. 
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MANUFACTURED HOUSING 

The Manufactured Housing option on the Property Maintenance Menu produces a sub-menu with a single option. 

 

 

PREBILL 

Selecting this option produces the PreBilled Manufactured Home Search Form that allows the user to search for 
Prebilled Manufactured Homes. 

 

 

See the PreBilled Manufactured Home Search Form section of this manual for help specific to that Form. 
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FUTURE YEAR 

The Future Year option on the Property Maintenance Menu takes the user into the WinGAP Future Module. The 
Future Year can also be accessed from the WinGAP Main screen by pressing Ctrl + F. 

 

 

The Future Year must exist for the screen above to appear. If the Future Year has not been created yet, the user 
will receive the message "Future year does not exist." Before any Future Year work can take place, a future folder 
must have been created by going to Tools > File Maintenance > Future Folder Tasks > Create Future Folder. The 
creation of a future folder should be done only by a WinGAP Administrator and is discussed later in this manual. If 
the county’s WinGAP administrator is not comfortable creating the future year, WinGAP technical experts are 
available online to assist. 

 

The WinGAP Future Year module is designed to allow the user to modify real and personal property characteristics 
with the intent of the changes being incorporated in the next year’s digest during Yearend Cleanup. All aspects of 
the property such as owner name, address, land, improvements, account items, etc. can be modified. New parcels 
or splits can be created. The next year’s digest data can be worked as the information is presented without having 
to wait until the current digest is closed out. 

 

NOTE: To return to the current Appraisal Year from the Future Year module, the user should use the File > Select 
Appraisal Year menu option and select the current Appraisal Year using the combo box on the Form. 
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APPEALS MENU 

The Appeals Menu is used to view and track Appeals through the Appeals process on Real and Personal Property 
Appeals, Manufactured Housing Appeals, and Motor Vehicle Appeals. Also, Motor Vehicle Appeals are added, 
edited, deleted, and tracked through the Appeals process from the Appeals Menu.  

NOTE: Real, Personal, and Manufactured Housing Appeals cannot be added at the Appeals Menu. These types of 
Appeals should be added on the Real Property General Information Form for Real Property, on the Personal 
Property General Information Form for Personal Property, and on the Manufactured Homes Form for 
Manufactured Housing. 

 

 

OPEN 

The Open option on the Appeals Menu is used to view, track, and maintain all Appeals. This option produces the 
Appeals Query Form, superimposed on top of a blank Appeals Form. Appeals can be looked up on the Query Form, 
and once the Appeal is selected there, the information is viewed, updated, or deleted on the Appeals Form. 
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A list of all appeals appears in the list box on the Appeals Query Form. The list is color coded for quick reference: 
Real Property Appeals are in blue, Personal Property Appeals are in yellow, Manufactured Housing Appeals are in 
green, and Motor Vehicle Appeals are in red. The listing of Appeals that displays on the screen can be narrowed by 
using any or all of the four query boxes on the upper left of the Query Form. The user can click on the combo box 
to select one of the items in the query field list, such as Last Name, and then key the query criteria into the field to 
the right of the combo box. The user then clicks the Query Button, and a list of all appeals meeting that criteria will 
display in the list box. 

 

The desired Appeal is selected by using the inside scroll bar to find the appeal, then clicking on the Appeal in the 
list box to highlight it. The user can then click on the View Button, which pulls the information for that Appeal into 
the Appeals Form and places the Appeals Form on top of the Query Form. The Appeals information can then be 
viewed, updated, or deleted as desired. 

NOTE: Any appeals that do not have an Appeal Type will appear in the list box with no color coding, they will 
appear white. This will usually apply to older Appeals before WinGAP required the appeal to have an Appeal Type. 
The County might want to edit these appeals and correct this. 

 

The user can return to the Appeals Query Form to search for another Appeal by either clicking the Search Button 
(to the right of the Corpname field) or clicking back on some visible part of the Query Form, underneath the 
Appeals Form. The previous query can be cleared by clicking the Clear Query Button. With all four Query fields 
blank, the user can click the Query Button and restore the entire list of Appeals for viewing if desired. 

 

When all Appeal viewing and editing is finished, the user can click the OK Button on the Appeals Form to save any 
changes and return to the main WinGAP screen. If no changes are made or saving changes is not desired, then the 
user may click the Cancel button. 

 

NOTE: The adding of a Real Property Appeal, and the discussion of the fields on the Appeals Form, will be covered 
in the Real Property General Information Form > Appeals section of this manual. The adding of a Motor Vehicle 
Appeal will be covered next. 
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ADD MOTOR VEHICLE 

The Add Motor Vehicle option is used to add Motor Vehicle Appeals. This option produces the Appeals Form for 
Motor Vehicles, below, where Appeals for Motor Vehicles are added. 

 

 

The Appeals Form will appear with all data entry fields "grayed out". The "New" Button MUST be clicked at this 
point to enable the fields and buttons. The user will be taken to the Appeal Year field. 

 

GENERAL INFORMATION 

 

 

Appeal Key: The Appeal Key is a unique number assigned by WinGAP when each appeal is added. This field is not 
accessible to the user. 

Appeal Year: The digest (appraisal) year the Appeal was filed for. The field defaults to the current appraisal year, 
which can be changed by the user. 
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Status: The current Status of the Appeal, such as Active. When first adding an appeal, the combo box selection 
defaults to Active; if it is necessary to change the Status at this point, the user can click on the combo box to 
display a list of the valid Status types, as seen below, or key the first letter of the Status description to select the 
Status. A Status must be selected initially and then maintained as the appeal progresses through the appeals 
process.  

Type: The Type of Appeal, which in this case is Motor Vehicle. The Type field defaults to Motor Vehicle and cannot 
be changed by the user. 

 

 

Listed below are the current Appeal Status options and the WinGAP codes associated with them: 

• 30 Day   - 2 

• Active   - A 

• Arb No Change  - O 

• Arbitration  - T 

• BOE   - B 

• BOE Expired  - E 

• BOE Final  - F 

• BOE No Change  - N 

• CHO   - H 

• CHO No Change  - P 

• Inactive   - I 

• Late Filed – Denied - L 

• Resolved  - R 

• Superior Court  - S 

• Waived   - D 

• Withdrawn  - W 
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P.I.N.: The Map and Parcel number field is disabled for Motor Vehicle Appeals and is not used. 

Appraiser: The Appraiser responsible for handling the Appeal. The user can click on the combo box to display a list 
of the all Appraisers that have Appeal edit rights. 

Acct #: The Acct # field is disabled for Motor Vehicle Appeals and is not used. 

Acres: The Acres field is disabled for Motor Vehicle Appeals and is not used. 

COID#: The COID# field is disabled for Motor Vehicle Appeals and is not used. 

Batch: If desired, a County defined number can be keyed in the Batch field that will allow the County to print 
Appeals for a specific grouping of Appeals. 

NOTE: The BOE, ARB, CHO, SUP checkboxes shown in the above image are discussed below. 

 

OWNER INFORMATION 

 

 

Last: The Last name field is the first of the Owner Information fields on the Appeal Form. This field is 20 characters 
wide and should contain the Last name of the Owner of the Motor Vehicle under Appeal, unless the County 
chooses to place its Owner names in the Corporate name field, in which case the Owner's name should be keyed in 
the Corporate name field and the Last name field left blank. If the Last name field is used, a comma should NOT be 
placed after the name. 

First: This field is also 20 characters wide and should contain the First name of the Owner, but only if there is a Last 
name entered. 

MI: The Owner's middle initial, if any, is keyed here if the Last and First name fields are used. 
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CorpName: If the County uses the Corporate Name field for Owner's names, then the name of the Owner of the 
Motor Vehicle under Appeal should be keyed here in the following format: Last Name followed by a space then the 
First Name followed by a space then the Middle Initial. 

Agent: The individual or company designated by the Motor Vehicle Owner to handle the Appeal. 

Address Fields: There are three fields where address information can be entered. Each field is 40 characters wide. 
The property location address is usually keyed in the first Address field. Additional Owners can also be keyed in this 
field. 

City: The Motor Vehicle Owner's City is keyed here. 

State: The Owner's State is keyed here. 

Zip: The Zip Code of the Owner is keyed in this field. 

Legal Description: The Description of the Motor Vehicle is keyed in this field. 

Home Phone: The Home Phone number of the Motor Vehicle Owner is keyed in this field. 

Work Phone: The Work Phone of the Owner is keyed in this field. 

Comments: Any Comments about the Appeal are keyed in this field. 

 

MOTOR VEHICLE INFORMATION 

 

 

Mfg: The Manufacturer of the Motor Vehicle. 

Model: The Model of the Motor Vehicle. 

VIN: The Vehicle Identification Number, or VIN, is keyed in this field. 

Decal: The Decal Number that was on the Motor Vehicle for the Appeal Year in question is keyed in this field. 

Decal Yr: The Decal Year for the Motor Vehicle for the Appeal Year in question is keyed in this field. 

Year Built: The Year the Motor Vehicle was manufactured. 

Tag No: The Tag Number is keyed in this field. 

Mileage: The Mileage of the Motor Vehicle at the time of the Appeal, if known, is keyed in this field. 

Condition: This Condition of the Motor Vehicle under Appeal, such as Good or Poor. The user can click on the 
combo box to display a list of the valid Condition types, or key the first letter of the Condition description to select 
the Condition. 

Photo: Right clicking this button opens a contextual menu that allows the user to select from several options. 
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Clicking the “Load Digital Photo” option will open a window where the user can navigate to a digital picture and 
load it to the WinGAPSQL folder on the server. A new folder will be created in the WinGAP photo folder on the 
server with the prefix “v” for vehicle followed by the appealkey assigned by WinGAP, and the photo will be named 
the same. This is the primary photo for the appeal. 

 

 

Selecting the Load Additional Photos option will open a new menu that will append more information to the 
photo. Typing in the field to the right of the Photo Name will add that information to the picture name, for 
instance “engine” would name the photo for a vehicle appeal with the appealkey 466354 “v466354_engine”. 
Selecting one of the checkboxes will quickly append that information to the photo so the user doesn’t have to type 
it themselves. The user will then navigate to where the picture is on their computer and WinGAP will copy it to the 
server and name it according to the above naming convention. 

 

Selecting “Delete Current Photo” will delete the primary digital photo, while selecting “Delete Additional Photos” 
will open the pictures folder for this record where the user can manually select which photos to delete.  

 

Documents: Right clicking this button opens a contextual menu that allows you to “Load Digital Documents”.  

 

 

Clicking the “Load Digital Documents” option will open up a window where the user can navigate to any file, such 
as a PDF of a sales record, and load it to the WinGAPSQL folder on the server. A new folder will be created in the 
WinGAP documents folder on the server with the prefix “v” for vehicle followed by the appealkey assigned by 
Wingap. 

 

 

 

 



 
99 

VALUES INFORMATION 

 

 

BOA FMV: The Board of Assessors Fair Market Value for the Motor Vehicle. 

30-Day: The value of the Motor Vehicle that the Board of Assessors sets after a review of the property when the 
appeal is initially filed. 

BOE: The value of the Motor Vehicle as determined by the Board of Equalization after they hear the Appeal. 

Arbitration: The Motor Vehicle Owner may opt to appeal to an arbitration board instead of the Board of 
Equalization. If that is true, the value resulting from the Arbitrator’s decision would be entered in the Arbitration 
field. NOTE: You cannot have both a BOE Value on the Appeals Form AND an Arbitration Value; it must be one or 
the other. 

Hearing Officer: The value assigned by the Hearing Officer that is ruling on the Appeal. This is not an option for a 
Motor Vehicle due to the stipulations of the Hearing Officer appeal route. The property must be over $1,000,000 in 
value. 

Superior Court: The value of the Motor Vehicle as determined by the Superior Court after the Appeal is heard in 
Court. 

Resolved: The value of the Motor Vehicle that is signed off on by the Owner. “Signed off on” also could be when 
the Owner no longer appeals. An example might be if the 21-day notice is mailed and the Owner does not appeal 
to the BOE, then the 21-day value should then be moved to resolved and the appeal status changed to resolved. 

Current: The Current Value of the Motor Vehicle based upon whatever stage the Appeal is in. For example, if the 
BOE decision has been made, the value handed down from the BOE should appear in Current and also in the BOE 
Value field. 

Return: The Return Value of the Motor Vehicle, as entered on the Appeal Form by the Owner of the Motor Vehicle. 

Asserted: The value of the Motor Vehicle as asserted by the Appellant. 

Appraised: The value of the Motor Vehicle as declared on a Certified Appraisal. 

VID: The Value in Dispute, which is the difference between the Current Value and the Return Value. 
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BOE, ARB, CHO, and SUP checkboxes: These checkboxes are used to designate if the Appellant requests Board of 
Equalization, Arbitration, County Hearing Office review, or wants to appeal directly to the Superior Court.  

No Show Checkboxes: Indicates if the Appellant failed to show for either the BOE, ARB, CHO, or Superior Court 
hearings of the Appeal. Each checkbox is to the right of the Value field for that applicable Appeal Status. 

Grounds for Appeal: These six checkboxes are used to select the reason(s) for the Appeal. 

10 Day ARB Receipt: Prints a letter showing that the request for Arbitration Appeal was received. 

10 Day ARB Appr’l Reject: Prints a letter showing the Certified Appraisal submitted for the Arbitration Appeal was 
rejected. 

Appraisal Acceptance Ltr: Prints a letter showing that the Appellant’s Appraisal Value was accepted. 

Appraisal Rejection Letter: Prints a letter showing that the Appellant’s Appraisal Value was rejected. 

SC Settlement Letter: Prints a letter notifying the Appellant of the date and time of the upcoming Superior Court 
Settlement conference. 

SC No Settlement: Prints a letter indicating that No Settlement could be reached during the Superior Court 
conference. 
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DATES INFORMATION 

 

 

Notice: The date of the Assessment Notice for the Motor Vehicle. 

Appealed: The date the Owner of the Motor Vehicle appealed the Motor Vehicle value. 

30 Day Notice: The date the 30 Day Notice was mailed. 

BOE: The date of the BOE hearing. 

Arbitration: The date of the Arbitration hearing. 

Hearing Officer: The date of the Hearing Officer hearing. 

Sup Court: The date of the Superior Court hearing. 

Resolved: The date the appeal was resolved. 

Decision: The decision date is a tracking mechanism that allows the County to track any ‘decision’ they see fit. 
There are no validation rules here. For example, the County might enter a court date in the Sup Court date field, 
and then enter the date they receive the judge’s decision in the Decision date field. This allows the tracking of 
more details in the Appeal process. 

Fwd/Cert Date: The date the county appeal administrator forwarded the appeal to the BOE for scheduling. 

Postmark: The date an appeal received by mail was postmarked. The law allows for mailed appeals to be received 
after the deadline so long as they were postmarked inside of that deadline. 

NOA Info Provided: The date the county provided information requested by the taxpayer under 45-5-306, such as 
a description of the methodology used by the board of tax assessors in setting the property's fair market value, all 
documents reviewed in making the assessment, the address and parcel identification number of all real property 
utilized as qualified comparable properties, and all factors considered in establishing the new assessment.  

BOE Info Provided: The date the county provided information requested by the taxpayer under 48-5-311, such as a 
list of witnesses, documents, or other written evidence to be presented at the hearing. 

Apr Recd: The Appraisal received date. The law stipulates that the Assessor’s Office only has a certain amount of 
time to respond once an appraisal is submitted by the appellant. 

Apr Decide: The date that the Assessor’s Office decided to either accept or reject the appellant’s submitted 
appraisal. 
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No Chg Ltr: The No Change Letter date fields to the right of the BOE, Arbitration, and Hearing Officer date fields 
allows the Assessor’s Office to track the dates they send the Appellant a notice that they are not changing the 
value from the originally appealed value. 

Conference: The date of the Superior Court Settlement conference. 

Conf Time: The time of the Superior Court Settlement conference. 

Temp Bill Amt: The Temporary Billing Amt field and Temp Bill Options button are not used for Motor Vehicle 
Appeals and are disabled. 

 

 

 

No SC Conf Agreement: A check in this box indicates that no agreement was reached at the Settlement Conference 
prior to a Superior Court appeal hearing. 

Evidence Presented: This checkbox allows the tracking of when Evidence was presented during the Appeal 
process, as it triggers events and rights regarding the Appeal. 

Interview Requested: This checkbox allows the tracking of when the Appellant requests an interview with the 
Assessor’s Office and the date of the request. There are time requirements for the Assessors’ Office in granting this 
interview. 

NOA Info Requested: A check in this box indicates that additional information about the Notice of Assessment was 
requested by the taxpayer or the taxpayer’s agent. There are time requirements for the Assessors’ Office in 
delivery of said information.  

BOE Info Requested: A check in this box indicates that additional information about the evidence to be presented 
at the board of equalization was requested by the taxpayer or the taxpayer’s agent. There are time requirements 
for the Assessors’ Office in delivery of said information. 
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After keying all the relevant data, the Apply Button can be clicked to save the information, remain on the Appeals 
Form, and view the information. Alternatively, the OK Button can be clicked to save the information and return to 
the main WinGAP screen. The Motor Vehicle Appeal can be viewed by clicking the Appeals > Open menu option, 
discussed above, or the Appeals > Edit/View Motor Vehicle menu options, discussed next. Motor Vehicles appear 
in red in the listing of active Appeals. 

 

 

EDIT/VIEW MOTOR VEHICLE  

Motor Vehicle Appeals can be viewed and edited using this option on the Appeals Menu. Clicking this option 
produces the Appeals Query Form, superimposed on top of a blank Appeals Form. Only Motor Vehicle Appeals 
display. The appeal can be looked up on the Query Form and once the Appeal is selected there, the information is 
viewed, updated, or deleted on the Appeals Form. 
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The desired Appeal is selected by first clicking on the Appeal in the list box to highlight it, then clicking on the View 
Button, which pulls the information for that Appeal into the Appeals Form and places the Appeals Form on top of 
the Query Form. The Appeals information can then be viewed, updated, or deleted as desired. 

 

 

The user can return to the Appeals Query Form to search for another Appeal by either clicking the Search Button 
(to the right of the Corpname field) or clicking back on some visible part of the Query Form underneath the 
Appeals Form. 
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STATUS ITEMS 

 

 

STATUS REPORT 

Clicking on the Status Report sub-menu option produces a report of all Active Appeals. The Appeals listing shows 
the Owner's Name, the Appeal Year, the Parcel Number or Personal Property Account, the Status of the Appeal, 
the Type of Appeal, and the Appeal Key. 
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STATUS COUNT 

Clicking on the Status Count sub-menu option produces the Appeal Count Form. The user should select the desired 
Appeal Year from the combo box, or click the All Years checkbox if Appeals for all years are desired. The Appeal 
Status is selected from the available list of Statuses in that combo box. 
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The Count Button should then be clicked to complete the Status Count. For the Appear Year(s) and Appeal Status 
selected by the user, the Appeal Count Form will display the total number of Appeals (the Count), the total value 
returned by the taxpayer, the total Current Value of the Appeals, and the Value in Dispute. The user can return to 
the main WinGAP screen by clicking the OK Button on the Appeal Count Form. 

 

 

APPEAL LIST BY STATUS CODE AND APPEAL YEAR 

Clicking on this item on the Status Items sub-menu produces a user controlled form. The user should select the 
desired Appeal Status from the combo box, key in the Appeal Year, then click the View Report button. 

 

 

The Appeal List based upon these criteria will appear showing the Appellant’s Name, Appeal Year, Parcel Number 
(Real Property) or Account Number (Personal Property), the Appeal Status, and the Property Type, Real or 
Personal. 
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APPEAL NO CHANGE STATUS 

This report shows appeals that have been sent a No Change Letter by the Assessor’s Office to track the dates they 
send the Appellant a notice that they are not changing the value from the originally appealed value, opening a 30 
day window within which the Appellant must notify the Assessor’s Office of their intent to continue the appeal. 
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APPEAL WITH ASSERTED VALUE/NO ACTION TAKEN YET 

This report details any appeal with an asserted value and a status code of 'ACTIVE' - any other status code implies 
some response/action has occurred. 

 

 

APPEAL NOTIFICATION – ADDITIONAL 180 DAYS GRANTED TO COUNTY 

This menu item generates a letter to be sent to appellants notifying them the county has received a 180 day 
extension to make a determination on the appeal and notify the taxpayer.  
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306C STATUS REPORT (30 DAYS) 

Parcels listed on this report have had a 30-day notice of assessment mailed (306C) and this report shows the 
number of days since the mailing of said notice to allow TAO to track when/if the appeal has been resolved due to 
no further action by the property owner. 
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BOE STATUS REPORT (180/360 DAYS) 

This menu item generates a report of all appeals to the BOE that tracks if the appellant has received either a 30-
day or no-change notice, and if not, the number of days left to reply to the appellant. 

 

 



 
112 

ARB STATUS REPORT (10 DAYS) 

This menu item generates a report of all appeals to Arbitration that tracks if the appellant has received either a 30-
day or no-change notice, and if not, the number of days left to reply to the appellant. 

 

 

 

CHO STATUS REPORT (90 DAYS) 

This menu item generates a report of all appeals to a Hearing Officer that tracks if the appellant has received either 
a 30-day or no-change notice, and if not, the number of days left to reply to the appellant. 

 

 

 



 
113 

CHO NOCHANGE STATUS REPORT (30 DAYS) 

This is a report of appeals to a Hearing Officer that have been mailed 30-day notices. The report shows the number 
of days since the mailing of the notice to allow TAO to track when/if the appeal has been resolved due to no 
further action by the property owner. 

 

 

APPRAISAL STATUS REPORT (45 DAYS)  

This report shows appeals that have submitted a certified appraisal, and the number of days left to respond with 
an acceptance or rejection letter before the appraisal automatically resolves to the appellant’s appraised value. 

 

 

ARRANGE ALL WINDOWS 

Sometimes the Appeal query windows will not align properly, such as one window opening off the screen. The 
cause of this is some random Windows event. This happens rarely, but if it does, the Arrange All Windows menu 
option snaps the windows back into view. If the appeals query windows are open, the “Arrange All Windows” will 
re-align the windows and cascade them. 
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REPORTS MENU 

The Reports Menu is used to print various reports used by the Assessor’s Office. The user also has access to a 
Report Designer Module within WinGAP to produce customized reports for local County purposes. 

 

 

ASSESSMENT NOTICE REPORTS  

 

 

ASSESSMENT NOTICES 

Selecting the Assessment Notices option first produces the NOA Checklist. It is extremely important that all the 
items on this checklist are performed prior to the exporting of any digest data. 

 

Assessment Notice Checklist 

1) If schedule changes have been made, run reappraise for the property type that is impacted by the 
schedule modification (Tools > Re-Appraise).  

2) Make changes to Conservation Use tables per current year table of values and run Conservation Use 
reappraise (Tools > Re-Appraise > Real Property).  

3) Run Data Edits (Tools > File Maintenance > Data Edits). NOTE: If you receive an error concerning Visual 
FoxPro Libraries, contact Tech Support for assistance.  
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4) Correct Issues noted in Data Edits Report  

5) Print a Consolidation Report (Reports > Administration > Consolidation Report > Digest) for current digest 
year and compare it to the previous digest year's report looking for obvious errors (compare R1 to R1, R3 
to R3, etc.)  

6) Make sure that parcels receiving notices are assigned Change of Assessment reasons.  

7) Set Assessment Change flags (Reports > Assessment Notices).  

8) Print a preliminary list of parcels receiving Change of Assessment notices for review. (Real Property COA 
List & Personal Property COA List)  

9) Print Assessment Notices after review is complete. 

 

Once these procedures are completed, the user can close the Checklist window and proceed to the Change of 
Assessment form. The printing of Assessment Notices is controlled from this Form. 

 

 

Mailing Date: The Date that the Notices will be mailed is keyed in this field. The date in the field defaults to the 
system date of the computer. 

Last Day for Appeal: The Last Day that the taxpayer can file an appeal either by mail or in person at the Assessor’s 
Office is keyed in this field. 
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Property Type: The Property Type radio button section of the Form has two types, Real and Personal. When the 
user tabs to the Property Type Section from the Last Day for Appeal field, the Property Type defaults to Real. The 
user must click on Real to set that selection, otherwise the selection can be changed to Personal by clicking with 
the mouse. Keying the tab key will take the user to the Print ALL Notices checkbox. 

Print ALL Notices: The Print ALL Notices check box is checked when the user wishes to print all notices of the 
designated Property Type. If notices within a specified range are to be printed, the Print All Notices box must be 
unchecked. Pressing the tab key will take the user to the Appeal Term section. 

Appeal Term: The Appeal Term radio button section of the Form defaults to 30 Days if the user tabs to the section 
from the Property Type Section. One of the two types of Appeal Terms must be selected by clicking with the 
mouse, and tab will take the user to the Primary Contact field. 

Primary Contact: The name of the Primary Contact for Assessment Notices is keyed in this field; otherwise, a name 
such as "Assessor’s Office" can be keyed. Regardless, some name MUST be keyed in the Primary Contact field 
before Assessment Notices can be printed. This information will be used in the absence of an Appraisers name on 
the parcel or account for which an assessment notice is being printed. 

Alternate Contact: The name of the Alternate Contact for Assessment Notices is keyed in this field; otherwise, a 
name such as "Assessors Office" can be keyed. Regardless, some name MUST be keyed in the Alternate Contact 
field before Assessment Notices can be printed. This name will be used in the absence of a Primary Contact on a 
parcel or account. 
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Block Size: The Block Size field and its companion Block field are used to control and simplify the printing of large 
numbers of Assessment Notices. The Block Size is the number of pages (each Assessment Notice is one page) 
included in the Block (or batch) of Notices. 

Block: The Block is the batch number of Notices to be printed.  

For example, the Block Size can be set at 20 and then the user can choose to preview/print/export Block 1, Block 4, 
or Block 10, whichever is desired, as indicated below. 

 

Block   Start Page  End Page 

1   1   19 

2   20   39 

3   40   59 

4   60   79 

5   80   99 

6   100   119 

7   120   139 

8   140   159 

9   160   179 

10   180   199 

 

Assessor’s Offices that need to print 1000s of Assessment Notices might set the Block Size to 1000 and then export 
the Notices in 1000-page blocks to PDF or XML, which could then either be printed in the Assessor’s Office or by a 
service provider. 

 

Use this contact information regardless of the contact information present on the property: If this box is 
checked, the Primary Contact and Alternate Contact entered in the fields above the checkbox will be used for the 
COA notices regardless of the selections on the Real and Personal Property General Information forms. Both the 
Primary and Alternate Contact fields must have an entry before the box can be checked. 

Sort Order: The Sort Order radio button section of the Form defaults to Zip Code if the user tabs to the section 
from the Secondary Contact field. One of the Sort Order types must be selected by clicking with the mouse, and 
tab will take the user to the Print Range section of the Form. The Sort Order that is selected will also control what 
is keyed into the Beginning and Ending Print Range fields. 

Print Range: The Print Range section of the Change of Assessment Form allows the user to choose a Beginning and 
Ending range for the Assessment Notices to be printed. 

• If Zip Code is selected as the Sort Order, a Beginning and Ending Zip Code range can be keyed into the two 
Print Range fields to limit the Assessment Notices that are printed to just those zip Codes. If ALL 
Assessment Notices in Zip Code order are desired, the user should leave the fields blank. 

• If Parcel Number is selected as the Sort Order, a Beginning and Ending Parcel Number range can be keyed 
into the two Print Range fields to limit the Assessment Notices that are printed to just those Parcel 
Numbers. If ALL Assessment Notices in Parcel Number order are desired, the user should leave the fields 
blank.  

• If Name is selected as the Sort Order, a Beginning and Ending Name range can be keyed into the two Print 
Range fields to limit the Assessment Notices that are printed to just those Names. If ALL Assessment 
Notices in Name order are desired, the user should leave the fields blank.  
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• If Account is selected as the Sort Order, a Beginning and Ending Account Number (Realkey) range can be 
keyed into the two Print Range fields to limit the Assessment Notices that are printed to just those 
Accounts. If ALL Assessment Notices in Account order are desired, the user should leave the fields blank. 

Count Notices: The Count Button in the Count Notices section of the Change of Assessment Form can be clicked to 
see how many Notices have been flagged for printing. A window will appear with the total number that have been 
flagged for the Property Type selected (Real/ Personal). The Count ignores any Range that has been entered. 

 

 

Print Preview: If the Print Preview box is checked and the user clicks the Print Notices button, a Print Preview 
window of the first Assessment Notice will appear. 

PDF: If the PDF box is checked, Assessment Notices will be exported in PDF format. 

XML: If the XML box is checked, Assessment Notices will be exported in XML format. 

Create Scripts: When printing very large reports (10,000+ pages, sometimes smaller) it is recommended to break 
that very large report into smaller reports. To attempt to standardize and automate that process, WinGAP employs 
the assistance of Microsoft Powershell Scripts. Checking this box will default the block size to 500 pages and will 
read the users selection of export type described below (PDF/XML) and create PowerShell scripts for the creation 
of the 500-page block sections of the large report.  

View: If the user wants to see a list of those Parcels/Accounts that have been flagged AND selected for printing, 
the View Button on the lower left of the Change of Assessment Form can be clicked to produce a list of all 
Assessment Notices that are about to be printed. 

Print Notices: Once the user has selected the criteria for printing the Assessment Notices, the Print Notices button 
can be clicked. If the user has selected the “Print ALL Notices” option on the Change of Assessment form, an alert 
message will appear. If the user wants to Print ALL Notices, Yes should be clicked (another “Are you sure?” 
message will appear in this case, and Yes should be selected to proceed); otherwise, No can be clicked to return to 
the Change of Assessment form where the user can de-select the “Print ALL Notices” option. 
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Once the Print Notices button has been clicked, and the user selects Yes to the messages that appear, other 
messages will appear as the notice processing occurs. What happens next depends upon the options selected at 
the bottom of the Change of Assessment form. 

 

If the Print Preview checkbox has been selected (this is the default for the Change of Assessment Form), a Print 
Preview will appear. The taxpayer's name, address, and property information print at the top of the Assessment 
Notice, with the required legal information in the middle of the Notice. A list of Assessment Reasons prints below 
the value section of the notices. This is followed by the Estimated Tax section which is printed at the bottom of the 
Notice. The Print Preview window controls at the top of the window (Menu or Tool Bar) can be used to print or 
Export the Assessment Notices. 

 

 

If the PDF box is checked, a PDF file containing the Assessment Notices is created, and the user will see a 
downloads menu where the Open button on the Notices PDF (called NOA_RP_Mass30.pdf in this example) can be 
clicked to Preview the PDF. The Save button can be clicked to Save the PDF file to a desired location or the Close 
button can be clicked to abort the process.  



 
121 

 

 

If the XML box on the Change of Assessment Notices form is checked, an XML file containing the Assessment 
Notices data is created, and this file is used in printing the Assessment Notices. SQLExpress cannot be used with 
the XML export process. 

 

If the Create Scripts box is checked, a batch file will be created. This batch file will assist the user in running the 
scripts. The user should note the location of the batch file and navigate there. Powershell is used to run the scripts 
and must be installed. For Powershell configuration: 

• Some systems require opening Powershell and setting execution policy to unrestricted 

• Set-execution policy unrestricted 

• Answer YES 

• Some systems further require adding the drive containing the SERVERSHAREPATH into the internet 
explorer LOCAL INTRANET zone as a trust location. 
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The NOA_PS.BAT file and the associated Powershell file(s) have been created to assist in printing the Notices. The 
NOA_PS.BAT file is executed (run) and each script file is run to create the individual PDF/XML files in the block size 
determined by the user’s choices previously discussed. Running the NOA_PS.BAT file will cause a Powershell 
window to appear. 

 

 

This process is creating the designated export file (in this example the selection was PDF). When the first block of 
500 pages has been exported successfully, you will see the PDF in the Windows Explorer window that 
automatically opened and contains all the scripts created. 

 

 

Also visible is an XLS file that is automatically created as part of the users NOA process. This is created by the 
system to generate an archive for reference purposes. 
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Allow the Powershell script to run and generate all the PDF/XML files. Each of the created files should be 
confirmed to have data included based on the file size (Around 3,330 KB per file in the example) by manually 
opening and viewing the file. 

 

Regardless of the method used to create the Notices of Assessment, the last message the user will see as part of 
the NOA creation process is a message is asking if the Assessment Notices that have just been printed should be 
appended into the Notices Archive. 

 

 

If the County wants to keep an archival file of all Assessment Notices that have been printed, the "Yes" button 
should be clicked, at which point the Notices will be appended and the user notified and returned to the Change of 
Assessment Form. Otherwise, the "No" button should be clicked, the Notices will not be appended, and the user 
will be returned to the Change of Assessment Form. 
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The Assessment Notices are archived into a table called Notices.dbf. This provides the user with a means of 
recovering information such as the date printed, values, etc., for any notice that has been printed. Also, when an 
appeal is added the notice date is pulled from this archived data. Currently, the only means of accessing data from 
the Notices.dbf is with SSMS or SQLMaster. 

 

After printing, the Assessment Notices can be reviewed for accuracy, folded, and placed in window envelopes for 
mailing. Alternatively, the county may contract with a vendor to have the notices printed and mailed for the 
county, so that the office staff does not have to manually print and stuff envelopes. 

 

SET FLAGS FOR ASSESSMENT NOTICES 

This option allows the user to set or remove the Assessment Notice Flag for each parcel (located in the logical field 
Realprop.Val_Chg) or Account (located in the logical field Personal.Notice). Selecting this option produces the Set 
Flags for COA Notices Form. 

 

 

When printing Assessment Notices, per SB346, the “Print ALL Notices” button should be selected for Real Property. 
However, Personal Property flags must be set manually. This can be done with the Set Flags for Assessment 
Notices option. The flagging procedure should be run before printing Notices or any of the COA lists. 

 

Setting Assessment Notice flags allows the user to select the parcels or accounts that Assessment Notices will be 
printed for. Only parcels or accounts that have the assessment flag set to "True" will have an Assessment Notice 
printed. The flagging and unflagging routines will only affect the records of the property type that has been 
selected in the Property Type radio button section located on the upper left of the form, either Real or Personal. 
WinGAP defaults to the Real property type. 

 

The first six checkboxes allow the user to flag parcels/accounts for certain conditions. The last checkbox allows the 
user to “unflag” all parcels/accounts before beginning the flagging process. Very often the user will click the 
"Unflag All Parcels" checkbox first, then click the "Set Flags" Button to the right of this item to set all the 
Assessment Notice flags to "False". 
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Any or all of the first six checkboxes can be selected at the same time. However, if the Unflag all Parcels checkbox 
is selected, the user should deselect any of the other checkboxes. 

• Flag for Any Value Change will set the assessment flag to "True" for all parcels that have a difference in 
value between the current and previous year except for parcels/accounts that have been assigned a 
digest classification of Exempt or Utility or any parcels/accounts that have an assessment reason code of 
NN (No Notice Needed). 

• Flag for Value Increase will set the assessment flag to "True" for parcels where the current value is 
greater than the previous value except for parcels/accounts that have been assigned a digest classification 
of Exempt or Utility or any parcels/accounts that have an assessment reason code of NN (No Notice 
Needed). 

• Flag for Asmt Reason will set the assessment flag to "True" for any parcel that has at least one 
Assessment Reason associated with it except for parcels/accounts that have been assigned a digest 
classification of Exempt or Utility or any parcels/accounts that have an assessment reason code of NN (No 
Notice Needed). 

• Flag for Return Values will set the assessment flag to "True" for any parcel where a Return Value has been 
entered except for parcels/accounts that have been assigned a digest classification of Exempt or Utility or 
any parcels/accounts that have an assessment reason code of NN (No Notice Needed). 

• Flag Op Utility Parcels will set the assessment flag to "True" for any parcel that has a Digest 
Classification/Stratification of Operating Utility (U2). 

• Flag for Specific Asmt Reason will allow the user to choose a specific Assessment Reason for setting flags. 
If this box is checked, a combo box will appear. The user can select any desired reason from the 
Assessment Reasons schedule to set a flag for this reason by clicking in the combo box and selecting that 
reason. 

• The Unflag All Parcels item will set the assessment notice flag to "False" for all parcels, in preparation for 
flagging parcels with a notice for a particular condition. Very often the user will click the “Unflag All 
Parcels” checkbox first, then click the “Set Flags” Button (it will become available after the user clicks in 
the checkbox) to the right of the item to set all of the Assessment Notice flags to "False”. 

• Flag All Taxable PP (> 7500 and NOT ‘E’ or ‘U’) is only available for Personal Property, and the checkbox 
to select this item will become available when the user clicks the Personal Property Type in the upper left 
of the form. This item will flag all taxable Personal Property accounts that are greater than $7500 
(Owner’s cumulative account (s) value) and do not have a Digest Code of Exempt or Public Utility, or 
accounts with a No-Notice reason assigned. 

 

Once all flags have been removed, the user can select any or all of the other checkboxes to use as the criteria for 
printing Assessment Notices. The Set Flags button to the right of each option should be clicked to set the flags for 
that item. The setting or removing of flags will apply to all Parcels/Accounts that meet the criteria for that option. 
Each time the user clicks a Set Flags button, a running count of records flagged will be displayed on the Total 
Records Flagged line. 

 

 

REAL PROPERTY COA LIST 

Selecting this option on the Assessment Notices Reports submenu produces a print preview of the Real Property 
Change of Assessment Listing. This report contains a list of all real property that has been flagged for an 
Assessment Notice. 
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PERSONAL PROPERTY COA LIST 

Selecting this option on the Assessment Notices Reports submenu produces a print preview of the Personal 
Property Change of Assessment Listing. This report contains a list of all personal property that has been flagged for 
an Assessment Notice. 
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FLPA ASSESSMENT NOTICES 

Clicking on this option on the Assessment Notices Reports submenu produces the print preview of the FLPA 
Notices that are to be printed. 
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REAL PROPERTY NO CHANGE – BULK 

Clicking on this option on the Assessment Notices Reports submenu produces a Reporting Services form where the 
user selects the following options for the Real Property No Change notices that are to be printed: 

• The Notice Date (cNoticeDate) 

• The Appeal Term cTerm) 

• The Assessment Reason for this group of notices (REASON) 

• The Digest Year (Digest Year) 

 

 

Once the user has keyed the desired data in the Date and Term fields and selected a Reason, the Digest Year field 
will default to the current Digest Year, 2020 in this example. All the user must do now is click the View Report 
button and the Real Property No Change notices will appear. 
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REAL 

 

 

POINT COST STUDY 

The Point Cost Study performs an analysis on FMV residential improved sales that have occurred one year 
removed from the present digest year. The primary product of the study is the Residential Improvement Point 
Cost. The resulting Residential Improvement Point Cost is the local index that is used to convert points to dollar 
values in the process of valuing residential improvements. The Residential Improvement Point Cost is entered into 
the schedules by going to Tools > Preferences and keying the value in the field, Residential, found in the 
Points/Base Cost section of the screen. The Reappraise sub-menu option for Residential Improvements (Tools > Re-
Appraise > Real Property) must be run to apply any new point cost to all residential improvements. 
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PRELIMINARY DIGEST 

Clicking on the Preliminary Digest option produces a reporting services form where the user selects the Tax 
District(s) for the desired Preliminary Digest. 

 

 

The user can select one or more Tax Districts by clicking in the appropriate checkbox, or select All Tax Districts by 
selecting that box. The View Report button on the right of the report form can be clicked to produce the desired 
Preliminary Digest. 

 

 

The Preliminary Tax Digest is a working or edit listing of all the Real Property in the County at the appraised 100% 
value. Property values are separated by types of property, such as Residential or Commercial Improvements, 
Accessory Improvements, and Land Value, stratified and totaled for each Parcel. The listing is in alphabetical order 
by Owner name. 



 
132 

 

 

 

PRC’S 

PRCs (Property Record Cards) can be selected for printing on a mass basis by clicking on this option. This produces 
a Select PRCs window. 

NOTE: The PRCs that are selected using this option are sent to the PRC Holding Bin for printing. Property Record 
Cards can also be printed one at a time from the Real, Personal, and Manufactured Homes General Information 
Forms, and from the PRC Holding Bin if the PRCs have been sent to the Holding Bin. 

 

 

The first task facing the user from the Select PRCs window is to select the manner by which the PRCs will be 
selected and sent to the Holding Bin. There are five selections available. 

• Digest Class 

• Name 
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• Neighborhood 

• Parcel Number 

• Subdivision 

An order is selected by clicking on the Select By combo box. 

 

 

Digest Class: If the Digest Class option is selected, the user will be asked to select a Digest Class. Once a Digest 
Class is selected, the OK Button is clicked to send the PRCs to the PRC Holding Bin. The user will receive a message 
that the PRCs were added to the Holding Bin and the number of PRCs that were sent will display on the Select PRCs 
window. 

 
 

Name: If the Name option in the Select by combo box is selected, the user will be presented with two fields where 
a Beginning and Ending Name, or part of a Name, such as the letters "A" and “B”, can be keyed. If all Names are 
desired the fields should be left blank. As under the Digest Class option, the OK Button is clicked to send PRCs to 
the PRC Holding Bin. The number of PRCs that were sent will display on the Select PRCs window under the “PRCs 
Selected” text. 
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Neighborhood: If the Neighborhood option in the Select by combo box is chosen, as seen below, the user will be 
presented with a second combo box where a Neighborhood can be selected. The Neighborhood option for printing 
PRCs can be used only if the Neighborhood schedule has been set up in Tools > Schedules/Tables > Neighborhoods, 
and parcels have been assigned to a Neighborhood on the Real Property General Information Form. Once a 
Neighborhood is selected from the Neighborhoods list, the OK Button is clicked to send the PRCs to the PRC 
Holding Bin. The number of PRCs that were sent will display on the Select PRCs window under the “PRCs Selected” 
text. 

 

 

Parcel Number: If the Parcel Number option in the Select by combo box is chosen the user will be presented with 
two fields where a Beginning and Ending Parcel Number, or part of a Parcel Number such as “001” and "002", can 
be keyed. If all Parcel Numbers are desired, the fields should be left blank. As under the Digest Class option, the OK 
Button is clicked to send the PRCs to the Holding Bin. The number of PRCs that were sent will display on the Select 
PRCs window under the “PRCs Selected” text. 
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Subdivision: If the Subdivision option in the Select by combo box is chosen, the user will be presented with a 
combo box where a Subdivision can be selected, as seen below. The Subdivision option for printing PRCs can be 
used only if the Subdivision schedule has been set up in Tools > Schedules/Tables > Subdivisions List, and every 
parcel has been assigned to a Subdivision on the Real Property General Information Form. Once a Subdivision is 
selected, the OK Button is clicked to send the PRCs to the PRC Holding Bin. The number of PRCs that were sent will 
display on the Select PRCs window under the “PRCs Selected” text. 

 

 

 

RETURN FORMS 

Real Property Return Forms can be printed by clicking on this option on the Reports > Real sub-menu. This 
produces a window that displays a listing of all Owners, in the default Name order. The list can be narrowed by 
keying the desired name in the single line edit Search Field, then clicking the Search button. 
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The Return Form for any owner can be printed by clicking on the desired record in the list box and then clicking the 
Preview Button, where it can be viewed and then printed. 
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The Return forms can be displayed in Parcel Number order by clicking in the Parcel checkbox and the list will 
automatically refresh to that order. Like with Name order, the list can be narrowed by keying part of the desired 
parcel number in the single line edit Search Field, then clicking the Search button. 
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If the user wishes to print a batch of Return Forms, first one is previewed and printed, then another is selected and 
printed, and so on. Once all the Return Forms are printed, the Done button is clicked to return to the WinGAP main 
screen. 

NOTE: Return Forms can also be printed from the Real Property General Information Form by right-clicking on the 
Printer button on the lower left of the Form and selecting Real Property Return Form on the menu that appears. 

 

 

APPEAL FORM (BLANK) 

A Blank Appeal Form that can be used by the taxpayer to file an appeal on their property can be printed by clicking 
on this option. This produces a Print Preview of the form, in PDF format. 

NOTE: An Appeal Form with all the preprinted information about the Owner and Property in question can be 
printed by going to the appropriate parcel, account, or prebilled manufactured house, right clicking on the printer 
button on the lower left of the screen, and selecting Appeal Form on the menu that appears. 
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SALES 

A report listing Sales for any year of sales can be printed by clicking on this option. This produces a Reporting 
Services screen where the user selects the Starting and Ending year for Sales Report. For example, the user desires 
a report for all sales for the year 2018. The user would key 2018 for the Starting Sale Year, and 2018 for the Ending 
Sale Year, then click View Report. A listing with all Sales for the Sale Year 2018 will appear. 
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The user can refine the Sales Report even more by keying an optional Parcel Number in that field. In this case, the 
user wants all Sales that occurred in Sale Year 2018 on Map E0004. The user would key 2018 in the two Sale Year 
fields, E0004 in the Parcel Number field, and click View Report. A Sales Report matching this criteria will appear. 

 

 

 

SALES QUESTIONNAIRE BULK 

A Sales Questionnaire Bulk can be printed for all sales in the current digest year by clicking on this option. This 
produces the Current Sales Questionnaire. 
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After the Sales Questionnaire is printed and the user closes the report form, a couple of messages will appear. The 
first message informs the user that there is one more step in the Sales Questionnaire printing process. 

 

 

The user should click OK on this message and the second message will appear asking if all of these sales should be 
flagged as Survey sent.  
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Clicking the Yes button will place a checkbox on the Sales Information form for all these sales in the Survey Sent 
checkbox; clicking the No button will not flag any of these sales. If the Yes option above was selected, WinGAP also 
places a message in the Comments field noting that a Sales Questionnaire was sent in Bulk for this sale. 

 

 

 

EXPIRED COVENANTS (HIST, PREV, CUV, FLPA)  

A listing of all Expired Covenants (Historical, Preferential, Conservation Use, and Forest Land Protection Act) can be 
printed with this option on the Reports > Real sub-menu. This produces a Print Preview of the report. Covenants 
that have already expired are highlighted in Red in the Expire Year column while covenants that will expire in the 
current Digest Year are listed in standard font. The county should print an Expiration Letter for each of the expiring 
covenants and send it to the property owner to inform them of the expiration of the covenant. For covenants that 
have already expired, the County should remove the covenant exemption before mailing Assessment Notices. 
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CUV REPORTS 

The CUV Reports option produces a submenu that allows the user to print a Conservation Use Approval Letter, a 
Conservation Use Value List, a CUV Expiration Letter, and CUV Applications grouped by Conservation Use Year. 

 

 

 

 

CUV APPROVAL LETTER 

The CUV Approval Letter option on the submenu will print a notice informing the taxpayer of CUV covenant 
approval. The letter will be printed for every parcel where the CUV covenant year equals the digest year. 
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CUV VALUE LIST 

The CUV Value List option on the sub-menu will print a listing of all parcels in a Conservation Use covenant. The list 
will be in Conservation Year then Map and Parcel Number order. 
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CUV EXPIRATION LETTER 

An Expiration Letter for every Conservation Use parcel that will expire at the end of its Covenant can be printed 
from this option on the CUV Reports submenu. Clicking on this option will produce a Reporting Services screen 
where the user selects the Starting Covenant Year for the report. After the user keys the year and clicks the View 
Report button, the first Expiration Letter will preview. The list will be in Map and Parcel Number order. 
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CUV APPLICATIONS – MASS (BY CCY) 

This option will print the Application and Questionnaire for all parcels in a Conservation Use covenant based on 
application year. The list will be in Map and Parcel Number order. 
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FLPA REPORTS 

 

 

 

FLPA APPROVAL LETTER 

The FLPA Approval Letter option on the FLPA sub-menu will print a notice informing the taxpayer of FLPA Covenant 
approval. The letter will be printed for every parcel where the FLPA covenant year equals the digest year or there 
is a New Owner change of assessment reason. 
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FLPA VALUE LIST 

The FLPA Value List option on the sub-menu will print a listing of all parcels that have a FLPA Covenant. The list will 
be in FLPA Year then Map and Parcel Number order. 
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MAP LIST 

A listing of all Parcels in Owner Name order can be printed by clicking on this option. 
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ACCESSORY LIST BY PIN 

A listing of all Accessories by type of Accessory and in Map order can be printed by clicking on this option. The list 
defaults to the Barn type of Accessory. Any type of Accessory that has the word barn in the description of the 
Accessory will display on the list. If the user wants to produce a report on other types of Accessories, the Name 
(Description) of that Accessory type can be keyed in the Desc field. For example, the user wants a report of all 
Chicken Coops in the County. The user should key “Chicken” in the Desc field then click the View Report button. 
The Reporting Services screen will refresh and the list of all the Chicken Coops will appear. 

 

 

 

NEW HOUSE REPORT 

A listing of all New Houses added in WinGAP can be printed using this option. Clicking it produces a Reporting 
Services screen where the user selects the Year Built for the Residential Improvements that will be listed on the 
report. The user should key the Year Built for the Residential Improvements that are desired and then click the 
View Report button. A listing of all Residential Improvements with that Year Built will appear in parcel number 
order. 
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RESIDENTIAL PPSF 

Clicking on this item produces a Reporting Services screen where the user selects the Start and End Dates for the 
report. The user can key the date in a format such as 01/01/2018, or click the Calendar button to select the dates. 
After selecting the Start and End Dates, the user also has three other options to select from. The Sale Reason and 
Occupancy options MUST be used to produce a report. The Show Data radio button selector allows the user to 
show the sales data on the report that is used in producing the line graph. The default is False, meaning no data is 
shown, but can be changed to True to show the data on the report. 

 

 

The Sale Reason List allows the user to further define the report by selecting a Sale Reason, such as Fair Market 
Value. Only Sales that have this Reason would be used in producing the report.  
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The Occupancy combo box is used to further define the report by selecting an Occupancy, such as One Family. 
Only Residential Improvements selected will be used in producing the report. 

 

 

After all selections are made, the user should click the View Report button to produce the report. If the user 
changes the default Show Data option from False to True, the Report will produce Summary data at the top of the 
report. The average points per square foot and the number of records found in the Saleinfo table for each quarter 
based on the starting and ending dates that were keyed will be displayed. 
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Page two and the remaining pages of the report will list all the Sale records used in calculating the PPSF number. 

 

 

 

PARCELS WITH SPECIFIC INFLUENCE(S)  

A listing of all parcels that have Land Influences can be printed using this option. It produces a Reporting Services 
screen where the user selects the Influence (INFL) for the report. There is also an option to display all Influences 
except those that are 0.00 and 1.00. If parcels that have the specified Influence with a factor of 0.00 and 1.00 are 
not wanted, the user should change the radio button to False. The user should click the arrow to the right of the 
INFL field to display a list of the Land Influences used by the County as set up in the Land Influences schedule 
located in Tools > Schedules/Tables > Land Influences. Any (or more than one) Influence can be selected by clicking 
in the appropriate checkbox. 

 

 

After selecting an Influence(s), the user should click the View Report button, and the report for all parcels with that 
Land Influence will appear. 
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PERMITS 

A listing of all Building Permits added in WinGAP for any desired digest year can be printed by clicking on this 
option. This will produce a Reporting Services screen where the user selects from a list of Permit options. The 
digest year shown in the ReportDB field defaults to the current digest year and can be changed if desired. Clicking 
the arrow to the right of the Select Permits to Print field produces a combo box list with several options: Permits 
for construction that have not been completed, Permits added Last Month, all Permits added during the year, and 
ALL Permits.  

 

 

After selecting one of the items in the list, the user should click the View Report button, and a report for all 
property (real, personal, and manufactured housing) that has a Building Permit that meets the criteria selected will 
appear. 
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The user can change the report to any of the other options in the Select Permits to Print field by selecting the 
desired item and then clicking the View Report button again. This list is for Permits for the digest year showing in 
the ReportDB field at the top of the Reporting Services form. If a report is desired for a different digest year, the 
user should key that year, for example ay2019, into the field, select one of the options in the Select Permits to 
Print combo box, and click View Reports to produce that list. 

 

 

 

PRINT SCHEDULES 

The last option on this sub-menu allows the user to print a variety of Real Property valuation schedules. Clicking on 
this option produces the Print Schedules Menu. 
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The schedule for any of the items listed on the Print Schedules Menu can be printed by clicking on that item. This 
will produce a Print Preview of the that schedule. 
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PERSONAL 

 

 

REPORTING FORMS 

The Reporting Forms menu item opens a selection window to print the annual personal property PT50 reporting 
forms to mail to taxpayers. 

 

 

Form Type: The Form Type section of the form lists the five types of reporting forms that can be printed. The 
default is Business and can be changed by the user if necessary by clicking on any of the other Form Types.  

Selection Order: The Selection Order radio button section of the form defaults to Name. Should another Selection 
Order be desired, the order must be selected by clicking with the mouse. The Sort Order that is selected will also 
control what is keyed into the Starting and Ending print range fields.  

Starting: If a Starting name (or Zip Code, or Account) for the printing of reporting forms is desired, the Name, or 
part of a name, or Zip Code, or Account, is keyed in this field. If the printing is to begin at the first Name, Zip Code, 
or Account, the field should be left blank.  

Ending: If an Ending name (or Zip Code, or Account) for the printing of reporting forms is desired, the Name, or 
part of a name, or Zip Code, or Account, is keyed in this field. If the printing is to end at the last Name, Zip Code, or 
Account, the field should be left blank.  
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Minimum Value to Print Forms: If the printing of the reporting forms is to exclude those below a certain value, 
such as the $7500 Personal Property Account Exemption, that value should be keyed in this field. The field should 
be left blank if all accounts, regardless of value, are to print. 

Direct to PDF: If left as the unchecked default, there will be a Print Preview that is generated in the user’s web 
browser. If checked, a download popup will appear for the user to immediately save the returns as a PDF to their 
computer. 

 

 

PRN: this format was created for backward compatibility for very old systems, it is likely obsolete now but remains 
in place just in case. 

 

 

 

Print Exempt Accounts: By default, PT50 return forms are not printed for exempted accounts. Selecting this will 
include them in the printed list of returns. 

Print NOPT50 Accounts: By default, personal property accounts that have the “No PT50” box checked on the 
Personal Property From are excluded from having a PT50 form printed. Selecting this box will include them in the 
printed list of returns. 

 

Once the user has selected all the criteria for printing the reporting forms, clicking the “Go” button will generate 
the reporting forms. 
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FREEPORT LIST 

This option generates a report of all accounts receiving Freeport exemption and defaults to the digest year 
currently open in WinGAP. While the default option is to view all freeport accounts, there is an option to view only 
late file accounts. 
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AUDIT VALUE RANGE COUNTS AND VALUES BY COMPANY 

This menu item generates a report of personal property audits performed by a vendor, broken down by account 
value range. The report defaults to the digest year currently open in WinGAP, but any year digest may be keyed in 
and have that data display by clicking the View Report button. The Audit Company Name has a drop-down menu 
with the names of audit companies used by the county. Selecting one then clicking the View Report button will 
generate the audit report. 

 

 

 

NAICS REPORT 

This report generates a breakdown of businesses based on the North American Industry Classification System 
(NAICS). Selecting True for “Expanded Details” adds the owners name and the business name to the report when 
the categories are expanded, while the default option of False yields a more compact report when expanded. 
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COUNT PP REPORTING FORMS 

The report generated by this option counts the total number of accounts by category, and how many would 
receive a reporting form based on an entered minimum account value. This value defaults to 5,000 but may be 
changed by the user. 
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DNR STATUS REPORT 

This report generates a list of Active, Inactive, and New boats from the DNR Data File Import. 

 

 

 

MANUFACTURED HOUSING 

 

 

 

PREBILL DIGEST 

A preliminary Tax Digest for Prebilled Manufactured Housing can be printed by clicking on this option, which will 
produce a Print Preview of the Preliminary Digest. The Preliminary Tax Digest for Prebilled Manufactured Homes is 
a working or edit listing of all the Prebilled Manufactured Homes in the County at the appraised 100% value. The 
Values for the Manufactured Home itself as well as any Add-Ons are listed separately and then totaled for each 
Manufactured Home. The listing is in alphabetical order by Owner name, and then Manufactured Home Account 
Number within each Owner.  
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PREBILL CONSOLIDATION 

A Prebilled Manufactured Housing Consolidation report can be printed by clicking on this option. The individual 
Manufactured Housing items for each Tax District can be viewed by clicking on the + (plus) sign to the left of 
“Taxable” or “Exempt”. 
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PRC MASS (BY ACCOUNT NUMBER RANGE) 

Manufactured Housing PRCs (Property Record Cards) can be selected for printing on a mass basis by clicking on this 

option on the Reports > Manufactured Housing sub-menu. This will produce a Reporting Services screen where 

the user keys the Starting and Ending Mobilekey for the PRCs that are desired. A Starting and Ending Mobilekey 

must be entered; the fields cannot be left blank. Once this is done, the user should click View Report and the PRCs 

will be displayed in Mobilekey order. 
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ANALYSIS 

The Analysis option on the Reports Menu produces a sub-menu with a variety of already created Sales Ratio 
reports. 

 

 

RES – ALL 

The Residential - All option on the Analysis sub-menu produces a Sales Ratio Study of all qualified Residential Sales 
that are dated one year prior to the digest year. Clicking on this option will produce the Advanced Ratio Analysis 
form where the Query Expression for this type of Sales Ratio report is already created. 
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A more detailed explanation of how the Advanced Ratio Analysis and Sale Ratio Analysis Forms are used to create 
Sales Ratio Studies, as well as an explanation for all the fields and checkboxes found on these Forms, can be found 
in this Manual under the section Statistics > Sales Ratio Analysis. 

 

RES – IMP 

The Residential - Improved option on the Analysis sub-menu produces a Sales Ratio Study of all qualified improved 
Residential Sales that are dated one year prior to the digest year. Clicking on this option will produce the Advanced 
Ratio Analysis form where the Query Expression for this type of Sales Ratio report is already created. 
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A more detailed explanation of how the Advanced Ratio Analysis and Sale Ratio Analysis Forms are used to create 
Sales Ratio Studies, as well as an explanation for all the fields and checkboxes found on these Forms, can be found 
in this Manual under the section Statistics > Sales Ratio Analysis. 

 

RES – VAC 

The Residential - Vacant option on the Analysis sub-menu produces a Sales Ratio Study of all qualified vacant 
Residential Sales that are dated one year prior to the digest year. Clicking on this option will produce the Advanced 
Ratio Analysis form where the Query Expression for this type of Sales Ratio report is already created. 

 

 

A more detailed explanation of how the Advanced Ratio Analysis and Sale Ratio Analysis Forms are used to create 
Sales Ratio Studies, as well as an explanation for all the fields and checkboxes found on these Forms, can be found 
in this Manual under the section Statistics > Sales Ratio Analysis. 

 

AGR – ALL 

The Agricultural - All option on the Analysis sub-menu produces a Sales Ratio Study of all qualified Agricultural 
Sales that are dated one year prior to the digest year. Clicking on this option will produce the Advanced Ratio 
Analysis form where the Query Expression for this type of Sales Ratio report is already created. 
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A more detailed explanation of how the Advanced Ratio Analysis and Sale Ratio Analysis Forms are used to create 
Sales Ratio Studies, as well as an explanation for all the fields and checkboxes found on these Forms, can be found 
in this Manual under the section Statistics > Sales Ratio Analysis. 

 

AGR – IMP 

The Agricultural - Improved option on the Analysis sub-menu produces a Sales Ratio Study of all qualified improved 
Agricultural Sales that are dated one year prior to the digest year. Clicking on this option will produce the 
Advanced Ratio Analysis form where the Query Expression for this type of Sales Ratio report is already created. 
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A more detailed explanation of how the Advanced Ratio Analysis and Sale Ratio Analysis Forms are used to create 
Sales Ratio Studies, as well as an explanation for all the fields and checkboxes found on these Forms, can be found 
in this Manual under the section Statistics > Sales Ratio Analysis. 

 

AGR – VAC 

The Agricultural - Vacant option on the Analysis sub-menu produces a Sales Ratio Study of all qualified vacant 
Agricultural Sales that are dated one year prior to the digest year. Clicking on this option will produce the 
Advanced Ratio Analysis form where the Query Expression for this type of Sales Ratio report is already created. 

 

 

A more detailed explanation of how the Advanced Ratio Analysis and Sale Ratio Analysis Forms are used to create 
Sales Ratio Studies, as well as an explanation for all the fields and checkboxes found on these Forms, can be found 
in this Manual under the section Statistics > Sales Ratio Analysis. 

 

 

COM – ALL 

The Commercial - All option on the Analysis sub-menu produces a Sales Ratio Study of all qualified Commercial 
Sales that are dated one year prior to the digest year. Clicking on this option will produce the Advanced Ratio 
Analysis form where the Query Expression for this type of Sales Ratio report is already created. 
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A more detailed explanation of how the Advanced Ratio Analysis and Sale Ratio Analysis Forms are used to create 
Sales Ratio Studies, as well as an explanation for all the fields and checkboxes found on these Forms, can be found 
in this Manual under the section Statistics > Sales Ratio Analysis. 

 

COM – IMP 

The Commercial - Improved option on the Analysis sub-menu produces a Sales Ratio Study of all qualified improved 
Commercial Sales that are dated one year prior to the digest year. Clicking on this option will produce the 
Advanced Ratio Analysis form where the Query Expression for this type of Sales Ratio report is already created. 
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A more detailed explanation of how the Advanced Ratio Analysis and Sale Ratio Analysis Forms are used to create 
Sales Ratio Studies, as well as an explanation for all the fields and checkboxes found on these Forms, can be found 
in this Manual under the section Statistics > Sales Ratio Analysis. 

 

COM – VAC 

The Commercial - Vacant option on the Analysis sub-menu produces a Sales Ratio Study of all qualified vacant 
Commercial Sales that are dated one year prior to the digest year. Clicking on this option will produce the 
Advanced Ratio Analysis form where the Query Expression for this type of Sales Ratio report is already created. 

 

 

A more detailed explanation of how the Advanced Ratio Analysis and Sale Ratio Analysis Forms are used to create 
Sales Ratio Studies, as well as an explanation for all the fields and checkboxes found on these Forms, can be found 
in this Manual under the section Statistics > Sales Ratio Analysis. 

 

 

IND - ALL 

The Industrial - All option on the Analysis sub-menu produces a Sales Ratio Study of all qualified Industrial Sales 
that are dated one year prior to the digest year. Clicking on this option will produce the Advanced Ratio Analysis 
form where the Query Expression for this type of Sales Ratio report is already created. 
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A more detailed explanation of how the Advanced Ratio Analysis and Sale Ratio Analysis Forms are used to create 
Sales Ratio Studies, as well as an explanation for all the fields and checkboxes found on these Forms, can be found 
in this Manual under the section Statistics > Sales Ratio Analysis. 

 

IND - IMP 

The Industrial - Improved option on the Analysis sub-menu produces a Sales Ratio Study of all qualified improved 
Industrial Sales that are dated one year prior to the digest year. Clicking on this option will produce the Advanced 
Ratio Analysis form where the Query Expression for this type of Sales Ratio report is already created. 
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A more detailed explanation of how the Advanced Ratio Analysis and Sale Ratio Analysis Forms are used to create 
Sales Ratio Studies, as well as an explanation for all the fields and checkboxes found on these Forms, can be found 
in this Manual under the section Statistics > Sales Ratio Analysis. 

 

IND – VAC 

The Industrial - Vacant option on the Analysis sub-menu produces a Sales Ratio Study of all qualified vacant 
Industrial Sales that are dated one year prior to the digest year. Clicking on this option will produce the Advanced 
Ratio Analysis form where the Query Expression for this type of Sales Ratio report is already created. 

 

 

A more detailed explanation of how the Advanced Ratio Analysis and Sale Ratio Analysis Forms are used to create 
Sales Ratio Studies, as well as an explanation for all the fields and checkboxes found on these Forms, can be found 
in this Manual under the section Statistics > Sales Ratio Analysis. 

 

 

CIA - ALL 

The Commercial/Industrial/Agricultural - All option on the Analysis sub-menu produces a Sales Ratio Study of all 
qualified Commercial, Industrial, and Agricultural Sales that are dated one year prior to the digest year. Clicking on 
this option will produce the Advanced Ratio Analysis form where the Query Expression for this type of Sales Ratio 
report is already created. 
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A more detailed explanation of how the Advanced Ratio Analysis and Sale Ratio Analysis Forms are used to create 
Sales Ratio Studies, as well as an explanation for all the fields and checkboxes found on these Forms, can be found 
in this Manual under the section Statistics > Sales Ratio Analysis. 

 

 

CIA - IMP 

The Commercial/Industrial/Agricultural - Improved option on the Analysis sub-menu produces a Sales Ratio Study 
of all qualified improved Commercial, Industrial, and Agricultural Sales that are dated one year prior to the digest 
year. Clicking on this option will produce the Advanced Ratio Analysis form where the Query Expression for this 
type of Sales Ratio report is already created. 
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A more detailed explanation of how the Advanced Ratio Analysis and Sale Ratio Analysis Forms are used to create 
Sales Ratio Studies, as well as an explanation for all the fields and checkboxes found on these Forms, can be found 
in this Manual under the section Statistics > Sales Ratio Analysis. 

 

 

CIA – VAC 

The Commercial/Industrial/Agricultural - Vacant option on the Analysis sub-menu produces a Sales Ratio Study of 
all qualified vacant Commercial, Industrial, and Agricultural Sales that are dated one year prior to the digest year. 
Clicking on this option will produce the Advanced Ratio Analysis form where the Query Expression for this type of 
Sales Ratio report is already created. 
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A more detailed explanation of how the Advanced Ratio Analysis and Sale Ratio Analysis Forms are used to create 
Sales Ratio Studies, as well as an explanation for all the fields and checkboxes found on these Forms, can be found 
in this Manual under the section Statistics > Sales Ratio Analysis. 

 

 

RACI – ALL 

The Residential/Agricultural/Commercial/Industrial - All option on the Analysis sub-menu produces a Sales Ratio 
Study of all qualified Residential, Agricultural, Commercial, and Industrial Sales that are dated one year prior to the 
digest year. Clicking on this option will produce the Advanced Ratio Analysis form where the Query Expression for 
this type of Sales Ratio report is already created. 



 
177 

 

 

A more detailed explanation of how the Advanced Ratio Analysis and Sale Ratio Analysis Forms are used to create 
Sales Ratio Studies, as well as an explanation for all the fields and checkboxes found on these Forms, can be found 
in this Manual under the section Statistics > Sales Ratio Analysis. 

 

 

RACI – IMP 

The Residential/Agricultural/Commercial/Industrial - Improved option on the Analysis sub-menu produces a Sales 
Ratio Study of all qualified improved Residential, Agricultural, Commercial, and Industrial Sales that are dated one 
year prior to the digest year. Clicking on this option will produce the Advanced Ratio Analysis form where the 
Query Expression for this type of Sales Ratio report is already created. 
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A more detailed explanation of how the Advanced Ratio Analysis and Sale Ratio Analysis Forms are used to create 
Sales Ratio Studies, as well as an explanation for all the fields and checkboxes found on these Forms, can be found 
in this Manual under the section Statistics > Sales Ratio Analysis. 

 

 

RACI VAC 

The Residential/Agricultural/Commercial/Industrial - Vacant option on the Analysis sub-menu produces a Sales 
Ratio Study of all qualified vacant Residential, Agricultural, Commercial, and Industrial Sales that are dated one 
year prior to the digest year. Clicking on this option will produce the Advanced Ratio Analysis form where the 
Query Expression for this type of Sales Ratio report is already created. 
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A more detailed explanation of how the Advanced Ratio Analysis and Sale Ratio Analysis Forms are used to create 
Sales Ratio Studies, as well as an explanation for all the fields and checkboxes found on these Forms, can be found 
in this Manual under the section Statistics > Sales Ratio Analysis. 

 

 

ADMINISTRATION 
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DIGEST SUBMISSION REPORTS 

IMPORTANT: Before running any Digest Submission reports, the Assessor’s office should ensure that all appeals 
that have been resolved have been marked as such in the current appraisal year. This applies to appeals from back 
years as well as current year appeals 

 

Clicking OK on the Digest Submission Reports option on the submenu produces the Select Previous Digest Year 
Form. The user should select the appropriate Previous Digest Year to be used in creating the Digest Submission 
Reports. 

 

 

After the Previous Digest Year is selected in the list box and the user clicks the Select button, a message will appear 
informing the user of the various actions WinGAP will perform in creating the Digest Submission Reports. The user 
should read the message and then click OK. 
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WinGAP will begin the processing of the Digest Submission reports, and the first of these reports, the Inflationary 
Growth by Tax District report, will appear.  

 

 

This report is superimposed over another message. 
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These files are part of the Digest Submission Report process and should be uploaded to the County’s folder on the 
WinGAP FTP site. Clicking Yes will begin the process of creating and uploading the 3 files mentioned in the 
message. If for some reason the user does not wish to upload the files at this time, a No response will clear the 
message. Various messages will appear as these 3 files are created and uploaded. 

 

 

A bar graph will appear and chart the progress of the upload of each file. Depending upon the size of the files and 
the speed of the County’s internet connection, the upload process could take anywhere from a few minutes to a 
half hour. 

 

 

After the files are uploaded, the bar graph will clear and the user will be returned to the WinGAP main screen. The 
files are now uploaded to the County’s folder on the FTP site. 

 

 

After the Inflationary Growth report appears and the files are uploaded, a Print Preview of the rest of the Digest 
Submission Reports will appear. These reports are required when submitting the Tax Digest to the Local 
Government Services Division. 

 

Cover Letter: The Digest Submission reports that are printed in WinGAP are preceded by a Cover Letter that must 
be filled out, signed, and delivered with the rest of the Digest Submission reports to the Digest Review office at the 
Local Government Services Division of the Georgia Department of Revenue. 
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Pending Appeals for Public Utilities: The first Digest Submission Report is the Pending Appeals for Public Utilities. 
This is a blank report that must be completed by the Appraiser. 
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Pending Appeals - Other Than Public Utilities: The next Digest Submission Report is the Pending Appeals - Other 
Than Public Utilities. Any appeals that are not settled regardless of the appeal year will be printed. Appeals with a 
status of Active, 30-Day, BOE, BOE Final, Arbitration or Superior Court will be printed. 

 

 

Inflationary Growth Report: The next Digest Submission Report is the Inflationary Growth report. 
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Notice of Assessment Reasons: The next Digest Submission Report is the Notice of Assessment Reasons report. 

 

 

Late Filing Freeport Accounts: The next Digest Submission Report is the Late Filing Freeport Accounts report. 
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FLPA Covenants: The FLPA Covenants report is next. This report will print a list of FLPA covenants entered within 
the current digest year.  

 

 

Average Property Values: The next Digest Submission Report is one that shows Average Property Values, with 
rounding. 

 

 

 

 

 

 



 
187 

Appeal Statistics: The next Digest Submission Report presents Appeal Statistics for the previous digest year. 

 

 

Enterprise Zone Certifications: The next Digest Submission Report covers Enterprise Zone Certifications. 

 

 

Appeal Status Certification: The next Digest Submission Report certifies the Appeal Status of the County. 
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Appeals Statistics: The final Digest Submission Report shows Appeal Statistics for the Current Digest Year. 

 

 

 

 

DATA REQUEST FORM 

Clicking this option produces a print preview of a standardized form that can be used to request information from 
the Tax Assessor’s Office. 
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AVERAGE PROPERTY VALUES 

This menu item produces a quick report of the average residential property value, rounded to the nearest $25,000. 

 

 

 

DELETED ITEMS 

This report displays all deleted items and records grouped by SQL table. Clicking the “+” beside a category name 
will expand the category to show the account number and the date deleted. 
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EXEMPT DIGEST – REAL AND PERSONAL 

This report lists all Exempt accounts in Name order. First, the user must decide which tax districts to include. 

 

 

After selecting the tax districts for the report, clicking the View Report button will display the Exempt Property 
Digest Report. 

 

 

 

CONSOLIDATIONS 

The Consolidation report is a tool that will provide the user with information concerning the counts and total 
assessments (40% values) of the digest class and strat combinations. The Consolidation Report is not the official 
consolidation report which is produced by the Tax Commissioner; it is to be used only in the Assessor’s Office as a 
tool in preparing the Tax Digest. The primary function of this report is to provide the user with summary 
information concerning the appraisals that have been made throughout the county. The user should compare the 
results of this report to those of previously printed reports such as last year’s report, a report prior to a schedule 
modification, etc., to locate grievous errors. Examples of such errors are: 

• Errant data entry resulting in a property component being grossly overvalued. This might result in a single 
residential improvement being valued at 100,000,000. A comparison of the R1’s would allow the user to 
identify that an error had been made 
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• Errant data entry on schedule values. Instead of keying a land value of 2,000 per acre for a rural land class, 
a value of 2.00 per acre was keyed. A comparison of the A5 values should bring this to the user’s 
attention. 

• Improperly keying Freeport inventory or not updating the Return Date could result in the value of the CP + 
IP class/strat combination being zero or extremely low. A comparison of these class/strats with last year’s 
would quickly show that an error had been made. 

Clicking on the Consolidation Report option produces the Select Consolidation Parameters form. 
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A Consolidation Report for each Tax District in the County can be produced by clicking on that item in the Tax 
District list box, and then clicking the Run Consolidation button. 

  

 

A Consolidation Report for selected Tax Districts can be produced by clicking on the first desired Tax District, 
holding the Ctrl Key down, clicking on the next Tax District (and so on), and then clicking Run Consolidation. 
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A Consolidation Report for all Tax Districts can be produced by clicking in the All Districts box on the form. All the 
Tax Districts are then selected, and the report can be run by clicking the Run Consolidation button. 

  

 

The Show Gross Freeport box will display the Gross Freeport value instead of the Net Freeport value impacting 
those Freeport account who filed late and are receiving a pro-rata exemption amount based upon the late filing. 
Some tax collection systems only have the ability to show the full Gross Freeport inventory. This check box allows 
WinGAP users to report Freeport using the gross amount to make reconciliation of consolidations with the Tax 
Commissioners office easier. 

NOTE: The 40% Values and Counts (total number of) for Motor Vehicles, Manufactured Homes, Timber (100% 
Values), and Heavy-Duty Equipment that are displayed in their respective columns on the Select Consolidation 
Parameters form should be entered in the Tax District schedule. It is not imperative that the values and counts on 
the right of the screen be entered before running a consolidation report. 

 

When the user clicks the Run Consolidation button, various messages will appear, and then the lower portion of 
the Select Consolidation Parameters form will be filled with the digest class/strat codes, counts, acres and 40% 
values.  
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The Print Consolidation button can then be clicked to generate a preview of the consolidation report. The report 
can be printed or exported to various formats. 

Important: If any messages are received when running the Consolidation Report, contact OLS (On Line Support) for 
assistance. For example, the preview does not display, or the user receives any other kind of error message. 
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During the Consolidation Report process a cons_value table is created which contains a complete itemization by 
parcel/account of all digest class/strat that comprise the consolidation report. With the assistance of a database 
management tool such as SSMS or SQLMaster, information can be obtained from this data when trying to balance 
the TAO report with the TCO report.  
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EXEMPTION CODES BY TAX TYPE 

This menu item opens a Reporting Services report that breaks down the number of exemptions per tax type, and 
the total value that is exempted from taxation. Clicking the Expand (“+”) button beside a category will further 
define the exemptions per tax type by the exemption code (such as S3, S5, etc.) and the exempted tax value per 
code inside that tax type. Finally, clicking the Expand button on an exemption code will show the parcel number, 
the account number, whether the exemption is from homestead or CUV, and the exemption amount from that 
specific parcel for that tax type. 

 

 

 

PREBILL MH CONSOLIDATIONS 

A Prebilled Manufactured Housing Consolidation report can be printed by clicking on this option. The individual 
Manufactured Housing items for each Tax District can be viewed by clicking on the + (plus) sign to the left of 
“Taxable” or “Exempt”. 



 
197 

 

 

 

RETURNED MAIL ITEMS (REAL AND PERSONAL) 

This option generates a report of all property that has the “Returned Mail” box checked on the record screen. 
Selecting True for the “Include PP_PORETURN” will also include records with the “P.O. Retn’d NOA” box checked 
on the record screen. 
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ACO SUMMARY BATCH REPORT 

This menu item generates a report that displays a summary of all ACO’s filtered by Control No, which is entered on 
the ACO screen. If the Control Number field is left blank on the report, it will display every ACO. 

 

 

Selecting False for the “Hide Reason” option will add comments from the Reason for Correction field on the ACO 
screen to the report. 
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ACO SHEET(S) BY BATCH NUMBER 

This menu item generates a detailed report of every ACO issued per Control Number, which is entered on the 
record’s ACO screen. The use of a batch’s Control Number is mandatory for this report. 

 

 

 

DIGEST REVIEW OVR COUNT 

This menu item generates a report that displays a count of properties by type with override values applied to 
them, and summarizes the percentage of the digest that currently has override values. 
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TIMBER 

 

 

HARVEST SUMMARY 

Summary dollar values for the amount of timber harvested in the County for any Harvest Year are obtained by 
clicking on the Harvest Summary option on the Timber Menu. This produces the Timber Report Form where the 
Harvest Year is entered. 

 

 

After keying the desired Harvest Year (the field defaults to the current appraisal year), and clicking the OK Button, 
the Harvest Summary Print Preview will appear. There is a column on the report are for each quarter of the year, 
along with a summary for the entire year. Totals for the various types of harvested timber are shown in each row. 
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HARVEST DETAILS 

A detailed listing for each land owner where timber was harvested in the County for any Harvest Year is obtained 
by clicking on the Harvest Details option on the Timber Menu. This produces the Timber Report Form where the 
Harvest Year is entered. 

 

 

After keying the desired Harvest Year (the field defaults to the current appraisal year) and clicking the OK Button, 
the detailed Harvest Summary Print Preview will appear. The final page of the report will show the Grand Totals for 
the year selected. 
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REPORT DESIGNER 

Selecting this option from the menu will start the Reporting Services application, Visual Studio. The user can also 
click the Report Designer button in the WinGAP Tool Bar. The Visual Studio Shell screen will then appear. 
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The creation and maintenance of reports is not covered in this manual. Please see the WinGAP Report Building 
Manual for these procedures. 

 

 

LAUNCH REPORT SITE  

The Launch Report Site option on the Reports Menu takes the user to the SQL Server Reporting Services Home 
Page. The SQL Server Reporting Services home page defaults to the County Reports page, which contains 
customized reports for the County. These reports can be modified or deleted by right clicking on the desired item. 
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The Home link on the above screen will take the user to another page where various reports and Data Sources 
used in WinGAP Reports can be created and managed. 

 

 

The WingapReports link on the far right takes the user to a page where all the reports that are currently deployed 
by the user within WinGAP can be managed. 

 

The management and use of these reporting services pages is not covered in this manual. Please see the 
WinGAP Report Building Manual for these procedures. 
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PRC BIN –  REAL 

The PRC Bin – Real (Property Record Card Bin - Real Property) is designed to facilitate the mass printing of Property 
Record Cards for Real Property. PRCs can be printed for one Parcel, selected Parcels, a range of Parcels, or all 
Parcels. Real Property PRCs are sent to the PRC Holding Bin from one of two places: 

• From the Reports > Real > Property Record Cards Selection screen discussed earlier in the Reports section 
of this manual. 

• By right clicking on the Printer Button on the Real Property General Information Form and selecting the 
PRC Holding Bin option on the Printer Button menu. 

 

Clicking on the Reports > PRC Bin - Real option will produce the PRC Holding Bin. 

 

 

The Holding Bin window will be empty if no PRCs have been sent to the Holding Bin. If PRCs have been sent to the 
Holding Bin, the accounts will be visible, the User ID that sent the record to the Bin will be displayed with the 
record, and a total count of records in the Bin will be displayed. 
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The PRC Holding Bin form has a combo box and several buttons and checkboxes that enables the user to control 
how the form operates. 

 

 

Sort Order: The user can click the Order Sent to PRC Bin combo box to change the order in which the PRCs were 
originally sent. For instance, the Holding Bin in the image on the next page shows two different orders. Some of 
these represent PRCs sent by Digest Class and some sent by Name, in the order they were sent to the Holding Bin. 
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This listing can be changed to any of the other options in the combo box. For example, Parcel Number Order can 
be selected by clicking that option in the combo box. 
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Delete Button: Once the user has selected (explained below) which PRCs are to be deleted from the Holding Bin, 
clicking the Delete Button will delete the selected items. 

 

Delete All Button: The user can delete all of the PRCs from the Holding Bin by clicking the Delete All button. No 
PRCs need to be selected to do this. 

 

Print Button: The PRCs can now be previewed, printed, and even saved to another format for printing later by 
clicking the Print button. But to print anything, the items must first be selected, and that is explained next. 

 

To select a single PRC for previewing, printing, or deleting from the Holding Bin, the single record is simply clicked 
on. A range of PRCs can be selected by clicking on the first item in the desired range, holding the Shift key down, 
and clicking on the last item in the range. A random selection of PRCs can be selected by clicking on the first item 
in the desired range, holding the Ctrl key down, and then clicking on the each of the other desired items in the 
random selection. Once the items are selected, the user can utilize the other controls on the PRC Holding Bin form 
to Preview and Print the PRCs or save them in a variety of formats to be printed later. 
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To Preview a PRC, the parcel item must first be selected in the list box. The user then clicks the Print button. The 
PRC will preview as shown below, where it can be printed or exported to another format such as a PDF or Excel 
file. 

 

 

Show Mine Only Checkbox: If this box is checked, the user login will control what PRCs show in the list box. Only 
the PRCs sent to the holding bin by the user that is logged in will display in the holding bin. If the box is unchecked, 
all PRCs sent to the holding bin will display. The box is unchecked by default. 

 

PDF Checkbox: After selecting the PRCs to be printed, if this box is checked and the user clicks the Print button, the 
Internet Explorer Download Manager window will appear where the user is asked what is to be done with the PRC 
PDF(s) that have been created. The user can open the PDF by selecting that option or click the Save button to save 
the PDF to a desired location. If the PDF box is unchecked, the PRCs are sent to a Reporting Services Print Preview. 
The box is unchecked by default. 

 

Cancel Button: At any time while on the PRC Holding Bin window, the Cancel Button can be clicked to exit the PRC 
selection and printing process. The PRCs that have been sent to the Holding Bin WILL REMAIN in the Holding Bin 
unless the user clicks the Delete All button prior to leaving. 
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PRC BIN –  MH 

The PRC Bin – MH (Property Record Card Bin – Prebilled Manufactured Housing) is designed to facilitate the mass 
printing of Property Record Cards for Prebilled Mobile Homes. PRCs can be printed for one Mobile Home, selected 
Mobile Homes, a range of Mobile Homes, or all Mobile Homes, just like with Real Property PRCs. Mobile Home 
PRCs are sent to the PRC Holding Bin from only one place: 

• By clicking in the PRC Bin checkbox on the Manufactured Housing General Information Form, then clicking 
the OK button on the form. 

 

 

If the user returns to the PRC Holding Bin for MHs, the Bin now contains the PRC that was just sent. The 
procedures for operating the PRC Holding Bin for Mobile Homes and printing PRCs are the same as were discussed 
above in the section on PRC Bin – Real. 
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STATISTICS MENU 

The Statistics Module in WinGAP is used to run Sales Analysis Studies, also known as Sales Ratio Studies. Sales 
Ratio Studies are designed to assist Assessors' Offices with the analysis of sales. With this tool the appraiser can 
determine if the valuation of properties within a particular class, neighborhood, building type, tract size, etc. is 
being performed properly. The appraiser can readily identify if the correct proper assessment level has been 
established. The degree of uniformity can also be identified along with any valuation bias. These Sales Ratio 
Studies can provide much needed insight into digest acceptance. 
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BASIC SELECTION 

The Basic Selection option presents the Ratio Analysis Criteria Form where the user can select from a variety of 
pre-defined fields to run the Ratio Study. 

 

 

SALES CRITERIA 

 

 

Ratio Studies can be run based upon a variety of Sales Criteria. The fields in the Sales Criteria section of the Basic 
Selection Form use the information keyed on the Sales Form when adding sales to Real Property. 
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Starting Date: The first field in the Sales Criteria section of the Form is where the Starting Date for sales to be used 
in the Ratio Study is keyed. The date keyed in this field is inclusive. For example, if the user wants a Study of all 
sales after January 1, 2019, then 01/02/2019 would be keyed in this field. The Starting Date field should be left 
blank if it is not to be used as a criterion in the Ratio Study. 

Ending Date: The next field is where the Ending Date for sales to be used in the Ratio Study is keyed in the same 
manner as the Starting Date. Like the Starting Date, the date keyed in the Ending Date field is inclusive. The Ending 
Date field should be left blank if it is not to be used as a criterion in the Ratio Study.  

State Study: The State Study checkbox field should be checked if the Ratio Study is to include only those sales that 
are marked "Y"(Yes) for State Audit Department use on the Sales Form. 

Class: Four checkboxes are available where the Sales Classification of the sale can be selected to further qualify the 
Ratio Study. Any or all of the checkboxes can be selected. If all the Class checkboxes are left blank, the Sales Class 
will be ignored in the selection of sales. 

Strat: Four checkboxes are available where the Sales Stratification of the sale can be selected to further qualify the 
Ratio Study. Any or all of the checkboxes can be selected. If all the Strat checkboxes are left blank, the Sales Strat 
will be ignored in the selection of sales. 

Reason: Four checkboxes and a Sales Reasons list box on the right of the Ratio Analysis Criteria form are available 
to set criteria for the Sale Reasons to be used for the Ratio Study. 

• If the ALT checkbox is checked, only Sales that have Sales Reasons designated as ALT (Arm’s Length 
Transaction) will be used, provided the sales meet the other criteria already keyed in the fields on the 
Ratio Analysis Criteria Form. When checked, all ALT reasons will automatically be highlighted in the 
Reasons list box. 

• If only the FM (Fair Market) checkbox is checked only sales with a Sales Reason of Fair Market will be 
used. 

• If only the LM (Land Market) checkbox is checked only sales with a Sales Reason of Land Market will be 
used.  

• If both the FM and LM checkboxes are checked only sales with a Sales Reason of Fair Market or Land 
Market will be used. The FM and/or LM checkboxes can also be used with any of the Sale Reasons in the 
Reasons list box to run a Ratio Study. Finally, the FM and LM checkboxes can be left blank and a specific 
reason or reasons in the list box can be used to run a Ratio Study for a specific type of Sale Reason. 

• The TIME checkbox is used to specify an annual percentage amount and sales will be time adjusted to 
January 1st of the digest year for the Starting Date specified on the form. Leaving this blank will not time 
adjust sales. 

The number of Reasons selected for the Basic Selection ratio study will display in blue. 

 

REAL PROPERTY CRITERIA 
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The criteria used to run a Ratio Study can be further narrowed by using a variety of Real Property Criteria. The 
fields in the Real Property Criteria section of the Ratio Analysis Criteria Form use information keyed on the Real 
Property General Information Form. 

 

Starting Map: The first field in the Real Property Criteria section of the Form is where a Starting Map/Parcel 
number for the Ratio Study can be keyed. The Map number keyed in this field is inclusive. The Starting Map field 
should be left blank if it is not to be used as a criterion in the Ratio Study. 

Ending Map: The next field is where the Ending Map for sales to be used in the Ratio Study is keyed in the same 
manner as the Starting Map number. Like the Starting Map number, the Map/Parcel number keyed in the Ending 
Date field is inclusive. The Ending Map field should be left blank if it is not to be used as a criterion in the Ratio 
Study. 

Property Class: The Property Class combo box can be used to select a specific Digest Classification for the Ratio 
Study. If all sales regardless of Digest Classification are desired in the Study, the field should be left blank. 

Property Strat: The Property Strat combo box can be used to select a specific Digest Stratification for the Ratio 
Study. If all sales regardless of Digest Stratification are desired in the Study, the field should be left blank. 

Starting Acres: A specific minimum size for the sales used in the Ratio Study can be selected by keying a Starting 
Acre level in this field. The field should be left blank to include all sales regardless of tract size. 

Ending Acres: A specific maximum size for the sales used in the Ratio Study can be selected by keying an Ending 
Acre level in this field. The field should be left blank to include all sales regardless of tract size. 

Starting Neighborhood/Tax District/Urban Land Schedule: The Ratio Study can be further qualified by using these 
combo boxes to select a specific Starting Neighborhood, Tax District, or Urban Land Schedule item. These fields 
should be left blank to include all sales regardless of the Starting Neighborhood, Tax District, or Subdivision. 

Ending Neighborhood/Tax District/Urban Land Schedule: The Ratio Study can be further qualified by using these 
combo boxes to select a specific Ending Neighborhood, Tax District, or Urban Land Schedule item. These fields 
should be left blank to include all sales regardless of the Ending Neighborhood, Tax District, or Urban Land 
Schedule item. 

Urban/Rural: These two checkboxes are used to designate what Land Type, if any, should be included in the Ratio 
Study. If neither of these boxes are checked, all Land Types will be included in the study. 

 

RESIDENTIAL IMPROVEMENT CRITERIA 

 

 

The criteria for Ratio Studies that include Residential Improvements can be further narrowed by using a variety of 
Residential Improvement Criteria. The fields in the Residential Improvement Criteria section of the Ratio Analysis 
Criteria Form use information keyed on the Residential Improvements Form. 
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Grade: The first two fields in the Residential Improvement Criteria section of the Form are where a Starting and 
Ending Grade for Residential Improvements can be keyed. Any Grade keyed in these fields is inclusive. The Grade 
fields should be left blank if they are not to be used as criteria in the Ratio Study. 

YR Built: The YR Built fields are where a Starting and Ending Year Built for Residential improvements can be keyed. 
Any Year Built keyed in these fields is inclusive. The Year Built fields should be left blank if they are not to be used 
as criteria in the Ratio Study. 

EFYR Built: The EFYR Built fields are where a Starting and Ending Effective Year Built for Residential Improvements 
can be keyed. Any Effective Year Built keyed in these fields is inclusive. The Effective Year Built fields should be left 
blank if they are not to be used as criteria in the Ratio Study. 

Heated Area: The Heated Area fields in the Residential Improvement Criteria section of the Form are where a 
Starting and Ending Heated Area for improvements can be keyed. Any Heated Area keyed in these fields is 
inclusive. The Heated Area fields should be left blank if they are not to be used as criteria in the Ratio Study. 

Exterior Wall: The Exterior Wall combo box can be used to select a specific type of Residential Improvement 
Exterior Wall for a Ratio Study. The Exterior Wall field should be left blank if it is not to be used as a criterion in the 
Ratio Study. 

Occupancy: The Occupancy combo box can be used to select a specific type of Residential Improvement 
Occupancy for a Ratio Study. The Occupancy field should be left blank if it is not to be used as a criterion in the 
Ratio Study. 

Observed Condition: The Observed Condition combo box can be used to select a specific type of Residential 
Improvement Observed Condition for a Ratio Study. The Observed Condition field should be left blank if it is not to 
be used as a criterion in the Ratio Study. 

 

COMMERCIAL IMPROVEMENT CRITERIA 

 

 

The criteria for Ratio Studies that include Commercial Improvements can be further narrowed by using a variety of 
Commercial Improvement Criteria. The fields in the Commercial Improvement Criteria section of the Ratio Analysis 
Criteria Form use the information keyed on the Commercial Improvements Form. 

 

Grade: The first two fields in the Commercial Improvement Criteria section of the Form are where a Starting and 
Ending Grade for Commercial Improvements can be keyed. Any Grade keyed in these fields is inclusive. The Grade 
fields should be left blank if they are not to be used as criteria in the Ratio Study. 

YR Built: The YR Built fields are where a Starting and Ending Year Built for Commercial Improvements can be 
keyed. Any Year Built keyed in these fields is inclusive. The Year Built fields should be left blank if they are not to be 
used as criteria in the Ratio Study. 

EFYR Built: The EFYR Built fields are where a Starting and Ending Effective Year Built for Commercial Improvements 
can be keyed. Any Effective Year Built keyed in these fields is inclusive. The Effective Year Built fields should be left 
blank if they are not to be used as criteria in the Ratio Study. 
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Used As: The Used As combo box can be used to select a specific type of Commercial Improvements Used As Code 
for a Ratio Study. The Used As field should be left blank if it is not to be used as a criterion in the Ratio Study. 

Built As: The Built As combo box can be used to select a specific type of Commercial Improvements Built As Code 
for a Ratio Study. The Built As field should be left blank if it is not to be used as a criterion in the Ratio Study. 

 

CHECKBOXES AND BUTTONS 

 

 

A variety of checkboxes can be used to further define the criteria for Ratio Studies, and a number of buttons 
control the use of the Ratio Criteria form. 

 

Clip Samples: The Clip Samples checkbox turns “sales clipping” on and off. If the box is checked (the default), sales 
with ratios below .10 and above .70 will not be used in the analysis. When no check is present in the box, no 
restrictions are imposed on ratios and all sales ratios will be included. 

Use MKTVAL: The Use MKTVAL checkbox uses the Fair Market Value of the sale as defined on the Sales 
Information form. When the Use MAV box is not checked, the Use MKTVAL box may be checked. The field on the 
Sales screen that would have a value keyed into it is the FMV field. 

 

With the Use MAV box not checked and the Use MKTVAL checked, the ratio generated on the parcel with the same 
set of circumstances as described in the Use MAV-VAL section would be: (130,000 * .40)/135,000 = .3851 

Use MAV: The Use MAV checkbox is used to define which value is used during the sales ratio analysis. If the Use 
MAV box is checked, moratorium values that are present on the parcels will be used. If Use MAV is not checked, 
FMV will be used in the study. If True Study is not checked, SB346 values will take precedent under all situations.  

Use MAV-VAL: When Use MAV is checked, the appraiser can also check the Use MAV-VAL box. With a check in the 
Use MAV-VAL box, values entered in the MAVVAL field on the sales screen will be used in the ratio analysis in lieu 
of the MAV value of the parcel. A value is typically entered in MAVVAL when a parcel sales and modifications 
affecting value are made after the sale and prior to the end of the year. The value keyed in the MAVVAL field 
would be the value at the time of the sale. 



 
217 

 

An example of such a situation would be the sale of a home that at the time of the sale was in poor condition. The 
sales price, say 40,000, and the value of the parcel from the Real Property Gen Info screen at the time of the sale, 
say 35,000, reflect the condition of the home. After the sale, the purchaser renovated the home bringing it back to 
a state that would be considered as average condition with a value of 75,000. The current value of 75,000 should 
not be used in the ratio study as it does not reflect the status of the property at the time of the sale. The value of 
35,000 that was present before the renovations, however, does reflect the appraised value at the point in time of 
the sale. Consequently, 35,000 would be keyed in the MAVVAL field on the sale screen. With the Use MAV and Use 
MAV-VAL boxes checked, the sales assessment ratio for the parcel would be calculated as follows: (35,000 * 
.40)/40,000 = .3500 instead of (75,000 * .4)/40,000 = .7500. 

True Study: The purpose of the True Study is to supply the appraiser with information as to how the actual 
appraisals compare to sales prices without the legislated SB346 value. Placing a check in the True Study box 
provides the appraiser with a means of running a sale ratio study using FMV or MAV in lieu of the SB346 value. 
Sales prices will be compared to either FMV or MAV depending on the presence of a check in the Use MAV box.  

DOAA: The DOAA checkbox allows the appraiser to emulate the ratio study analysis that is being performed by the 
Department of Audits & Accounting. The study will be generated based on a comparison of sales that occurred one 
year prior to the appraisal year to values also within that year. For example, when run from Appraisal Year 2020, 
sales that occurred in 2019 will be compared to the 2019 values. The 2019 values will be taken from the PT50R 
table which is created during the Yearend Cleanup process. The DOAA analysis does acknowledge checks placed in 
the Use MKTVAL or the Use MAV-VAL boxes. 

Use Future SP v Future CV: When this checkbox is checked, sales from the Future year that match the criteria on 
the Basic Selection form will be included in the Ratio Study and compared to the Future Current Value of the 
parcel. 

Use Future SP v Live CV: When this checkbox is checked, sales from the Future year that match the criteria on the 
Basic Selection form will be included in the Ratio Study and compared to the Current Digest Year (Live) Current 
Value of the parcel. 

 

After reviewing/changing any of the selection criteria for the Ratio Study, the Run button MUST be clicked to 
perform the Study. A horizontal green progress bar will appear as WinGAP analyses sales based upon the selection 
criteria and calculates the sales ratios and other statistics that make up the Ratio Study. The number of Sales 
records that are selected in the Ratio Study will display beneath the bar graphs. When this process is completed, 
WinGAP will produce the Sales Ratio Analysis Form. If no sales are found that meet the selection criteria, WinGAP 
will display the message "No records found - please expand your search", and the user should expand the sales 
criteria to locate the desired sales. 
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SALES RATIO ANALYSIS FORM 

Once the sales are analyzed and the sales ratios calculated, the Sales Ratio Analysis Form will appear superimposed 
over the Basic Selection Form. The Sales Ratio Analysis Form will display the sales ratios and other statistics and 
present the user with several options for printing the Ratio Study. The user can also look at a list of the sales that 
met the selection criteria and edit these sales if needed. 

 

 

Median LCI/Actual/UCI: The Median Actual Ratio is a measure of central tendency that indicates the midpoint of 
the array of the sales ratios. The Median Ratio is the statistic used to determine the level of assessment for the 
study. If the Median Ratio exceeds .44, the UCI (Upper Confidence Interval) Ratio can be used to see if digest 
acceptance is possible. The Upper Confidence Interval must be between .36 and .44 in this situation. The LCI 
(Lower Confidence Interval) is used in the same manner as the Upper Confidence Interval, except it will be used to 
determine digest acceptance if the Median Ratio is less than .36. 

Aggregate LCI/Actual/UCI: The Aggregate Actual Ratio is the weighted average of the sales. It is calculated by 
dividing the sum of the assessments by the sum of the sales prices. If the PRD (Price Related Differential) is outside 
of acceptable ranges and the Aggregate Ratio is used to determine the assessment level, the UCI (Upper 
Confidence Interval) Ratio must fall within a ratio range of .36 to .44 to allow for assessment level acceptance. If 
the PRD is out of range, the LCI (Lower Confidence Interval) is used in the same manner as the Upper Confidence 
Interval meaning that if the UCI is out of range, the LCI must fall within the acceptable range of .36 to .44 for 
assessment level acceptance. The table below provides an illustration of the use of the UCI and LCI. 
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LCI AGG UCI  

32 34 36 Pass (UCI falls within (overlaps) acceptable range) 

28 30 32 Fails 

26 32 38 Pass (UCI falls within (overlaps) acceptable range) 

 

COD: The COD, or Coefficient of Dispersion, measures the degree of uniformity in the study. The COD is calculated 
by first determining the absolute deviation from the median for each sale (Ratio - Median). The average of the 
deviations is then calculated. The average deviation is then divided by the median ratio to produce the COD. The 
COD should be less than .15 for residential property and less than .20 for agricultural, commercial, and industrial 
properties. 

PRD: The PRD, or Price Related Differential, is used to measure assessment bias in a ratio study. The PRD should 
fall between .95 and 1.10. It is calculated by dividing the mean ratio by the aggregate ratio. If the PRD is greater 
than 1.00, the lower priced properties generally have higher ratios than the higher priced properties. The study is 
exhibiting regressivity. If the PRD is less than 1.00, the higher priced properties are overvalued compared to the 
lower priced properties. The study exhibits progressivity 

Number of Samples: The number of Sales that met the selection criteria and are used in the Ratio Study. 

Lowest Ratio: The Lowest Ratio of any sale that meets the selection criteria and is used in the Ratio Study. 

Highest Ratio: The Highest Ratio of any sale that meets the selection criteria and is used in the Ratio Study. 

Min Sample Size: The smallest number of samples in a ratio study that will constitute a valid ratio study. The Min 
Sample Size is a function of the uniformity in the ratio study. A ratio study with greater uniformity has a lower Min 
Sample Size. 

Standard Deviation: The basic numeric measure of the extent of variation of the sample around the center 
(measure of central tendency). 

Report Title: The title of the Sales Ratio Report can be customized by using this 50-character field. If nothing is 
entered in the field, the Ratio Report will not have a title. 

Print Options: The Sales Ratio Study is printed by selecting one of the options in the Print Options radio button 
section of the Sales Ratio Analysis Form. A Summary report of only the Sales Ratios statistics, with no individual 
sales, can be printed by clicking the Summary radio button, then the Print button. This will send a screen image of 
the Sales Ratio Analysis Form to the default Windows printer. If a detailed listing of the sales that make up the 
Sales Ratio Study is desired, the Details radio button should be clicked followed by the Print button, which will 
produce a Print Preview of the Sales Ratio Analysis report. The user will be able to sort this report in any order by 
using the column headers of the report. 
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Print Order – Detailed Report: This feature has been disabled. Previous versions of WinGAP required the user to 
make a Print Order selection on the Sales Ratio Analysis Form. Sort order is now performed on the Sales Ratio 
Analysis report itself via interactive sorting at the column headers. 

View Array: A listing of all sales that meet the selection criteria can be viewed by clicking the View Array Button on 
the Sales Ratio Analysis Form. All the information about each sale that met the selection criteria will display in the 
default sales ratio order on the Sales Array list box. 
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A sale can be edited by clicking on the desired sale and then clicking the Edit Sale button. The sales array can also 
be opened as an Excel spreadsheet by clicking the Open with Excel button. Using Excel, the spreadsheet can be 
saved to another file name and manipulated by the user. The OK button should be clicked to leave the listing of 
sales and return to the Sales Ratio Analysis Form. 

100%: The ratio statistics that are displayed on the default Sales Ratio Analysis Form are based upon the 40% level 
of assessment. If the user wants to view these statistics at the 100% Fair Market Value of the property, the 100% 
Button should be clicked. Once clicked, the 100% Button will change to 40%. The 40% Button can be clicked to 
again display the ratios at the 40% assessment level. 

 

Once finished with the Sales Array form, the user can click the OK button to leave the listing of sales and return to 
the Sales Ratio Analysis Form. Exit can be clicked on that form to return to the Basic Selection Ratio Analysis 
Criteria form. Once all Basic Selection ratio study work is completed, the Exit button on the Ratio Analysis Criteria 
Form should be clicked to return to the main WinGAP screen. 

 

 

ADVANCED QUERY 

The Advanced Query option on the Sales Analysis Menu provides a flexible tool that the Assessor’s Office can 
utilize in the generation of customized ratio studies. The Advanced Query will allow the Assessor’s Office to 
incorporate any criteria that can be used in the analysis of sales into the sales analysis process. Selecting this 
option presents the Advanced Ratio Analysis Form. This Form will be used to construct what is called a Query 
Expression. The contents of the Query Expression will determine how the Sales Ratio Study will be run. 

 

 

To run ratio studies properly the user should have a basic understanding of the following: 

• The purpose of each of the six WinGAP database tables used in running a Sales Ratio Study. 

• The kind of data contained in the fields found in each of the six tables. 

• The operators available to construct the query statement. 
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THE SIX SALES RATIO ANALYSIS DATABASE TABLES 

WinGAP uses six Database tables to run Sales Ratio Studies. 

 

SALEINFO.DBF: This is the primary database table used in running ratios and contains sales information pertaining 
to parcels that are entered into WinGAP. Data such as grantee, grantor, deed book and page, sale price, sale class, 
sale strata, and sale reason code are contained in this table. 

ACESSORY.DBF: All the data about accessory buildings in the county is contained in the ACESSORY.DBF table. 
Information such as length, width, square feet, grade, and accessory improvement value is stored here. 

COMMIMP.DBF: The primary commercial improvement database, COMMIMP.DBF contains data for each 
commercial improvement such as digest class and strata, used as and built as codes, square footage, and total 
commercial improvement value. 

LANDSUBS.DBF: This database contains the land subrecords for all types of urban and rural land in WinGAP. 
Subrecord data such as front feet, acres, land type, subrecord influence, and subdivision code are contained in this 
table. 

REALPROP.DBF: Every parcel entered in WinGAP will have a record in this table. This table contains the parcel 
number, total current and previous parcel value, digest classification and stratification, taxing district, etc. 

REPROP.DBF: The primary residential improvement database table, REPROP.DBF contains information such as 
exterior wall type, square feet, total heated area, grade, heating type, plumbing, and total improvement value. 

 

DATA FIELDS 

Each of the six database tables used to run Sales Ratio Studies have a number of fields that contain specific kinds of 
data that can be used to qualify the Query Expression. The number, type, and purpose of each field varies from 
table to table. For instance, REALPROP.DBF would be used if the ratio study used parcel acreage as a qualifier; 
LANDSUBS.DBF would be used if land type was needed as a qualifier. REPROP.DBF would be used if grade or 
structure value for residential buildings was a qualifier; COMMIMP.DBF would be used if grade or structure value 
for commercial buildings was needed.  

 

OPERATORS 

Operators are used to compare field values in database tables with qualifying data and to link multiple expressions. 
Three types of operators are used in the Analysis module. 

• Relational operators such as = (equal to), > (greater than), < (less than), and <> (not equal to) are used to 
compare a field value with the qualifying data. 

• Mathematical operators such as + (plus), - (minus), * (multiply), and / (divide) are used to perform 
mathematical operations. 

• Logical operators such as AND and OR are used to combine one or more tables in a query statement. AND 
is used to join two or more logical expressions and generate a single result. For the result to be true, each 
of the logical expressions must be true. OR also joins two or more logical expressions, but only one of 
these must be true to obtain a single result. Also, parentheses are sometimes used to "group" expressions 
or parts of an expression.  
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The Query Expression is constructed using the following: 

• The six WinGAP database tables, which are pre-defined in the left memo field on the Advanced Query 
form. 

• At least two of the data fields in the tables (one, net_sp is pre-defined in the left memo field). 

• And at least two operators (one, AND, is pre-defined in the left memo field). 

Multiple tables, fields, and operators can be used to construct more complex Query Expressions and produce more 
defined Sales Ratio Studies. All ratio studies use the Saleinfo database table as it contains all the sales applicable to 
a particular parcel. 

 

At the bottom of the form are checkboxes similar to those found on the Basic Selection Ratio Analysis form, which 
allow the user to further define how the Sales Ratio Study is run. 

 

Use Saleinfo.mktval instead of Real Property Current Value: Placing a checkmark in this checkbox allows the use 
of the Fair Market Value as entered on the Sales Information Form instead of the Current Value as calculated by 
WinGAP. 

Use MAV: If the Use MAV box is checked, moratorium values that are present on the parcels will be used. If Use 
MAV is not checked, FMV will be used in the study. If True Study is not checked, SB346 values will take precedent 
under all situations.  

Use MAV-VAL: When Use MAV is checked, the appraiser can also check the Use MAV-VAL box. With a check in the 
Use MAV-VAL box, values entered in the MAVVAL field on the sales screen will be used in the ratio analysis in lieu 
of the MAV value of the parcel. A value is typically entered in MAVVAL when a parcel sales and modifications 
affecting value are made after the sale and prior to the end of the year. The value keyed in the MAVVAL field 
would be the value at the time of the sale.  

Clip Samples: The Clip Samples checkbox turns “sales clipping” on and off. If the box is checked (the default), sales 
with ratios below .10 and above .70 will not be used in the analysis. When no check is present in the box, no 
restrictions are imposed on ratios and all sales ratios will be included. 

True Study: The purpose of the True Study is to supply the appraiser with information as to how the actual 
appraisals compare to sales prices without the legislated SB346 value. Placing a check in the True Study box 
provides the appraiser with a means of running a sale ratio study using FMV or MAV in lieu of the SB346 value. 
Sales prices will be compared to either FMV or MAV depending on the presence of a check in the Use MAV box.  

DOAA: The DOAA checkbox allows the appraiser to emulate the ratio study analysis that is being performed by the 
Department of Audits & Accounting. The study will be generated based on a comparison of sales that occurred one 
year prior to the appraisal year to values also within that year. For example, when run from Appraisal Year 2020, 
sales that occurred in 2019 will be compared to the 2019 values. The 2019 values will be taken from the PT50R 
table which is created during the Yearend Cleanup process. The DOAA analysis does acknowledge checks placed in 
the Use MKTVAL or the Use MAV-VAL boxes. 

 

At the top right of the Advanced Query form is where the assembling of the actual query is performed. Much of 
the Advanced Query expression is already constructed for the user and displays in the left memo field on the form. 
The six WinGAP databases used for queries are displayed, along with one preset condition: net sales price greater 
than zero, and one operator, AND. The user has only to specify the additional conditions for the query and place 
them in the memo field on the right side of the form. 
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All queries the user keys in the right memo field will contain what are known as aliases. An alias is a letter or letters 
that identifies the table that the condition is using to obtain the desired information and generate the results. The 
aliases the Advanced Query form uses are as follows: 

• s – Saleinfo – Sales Information 

• r – Realprop – Parcel Information 

• a – Acessory – Accessory Improvement Information 

• c – Commimp – Commercial Improvement Information 

• l – Landsubs – Land Subrecord Information 

• rp – Reprop – Residential Improvement Information 

 

When the alias is keyed in the query memo field, it MUST be followed by a period or the query will not work and 
the user will receive an error message. 

 

Four Examples will be used below to illustrate how Advanced Queries are constructed. 

 

NOTE: Users can learn more about the WinGAP tables, fields, and operators, as well as how to construct queries, 
by attending the WinGAP Report Building class or consulting the WinGAP Report Building manual. 

 

EXAMPLE ONE: A STUDY OF ALL RESIDENTIAL SALES 

In this first example, the user wants to conduct a Sales Ratio Study for all Residential Sales. Sales records are found 
in the Saleinfo table, so the first step in finishing the query is to key the letter s in the query memo field, followed 
by a period. As mentioned above, the letter “s” is called an alias and is the alias for the Saleinfo table. 

 

Residential is the sale class of the sales we want. The sale class in the Saleinfo table is found in a field called 
“saleclass”. Residential sales are identified by the letter R (case does not matter in the query, it can be a lower-case 
r as well). The Saleclass field in the Saleinfo table is a Character field, so the letter R must be delimited by an 
apostrophe ‘ on each side of the R. Finally, since we want only Residential sales, the = Relational Operator will be 
used in the query as well. This is all the information we need to construct this query, and it looks like this:  

 

s.saleclass=’r’ 

 

When the user keys the above part of the query into memo field and clicks on the RUN Button, a “Please wait for 
this process” message will appear as the query information is analyzed, then the Sales Ratio Analysis form will 
appear. The number of records processed, the number of sales selected for the ratio study, and the number of 
Sales clipped, or excluded, will be displayed on the query form as well. 
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The Sales Ratio Analysis Form will display the sales ratios and other statistics and present the user with several 
options for printing the Ratio Study. The user can also look at a list of the sales that met the selection criteria and 
edit these sales if needed. The Sales Ratio Analysis Form was discussed under Basic Selection earlier in this manual, 
and the user can refer to those pages for more information if desired. 

 

EXAMPLE TWO: A STUDY OF ALL SALES FOR PARCELS THAT ARE UNDER A CONSERVATION USE OR 

PREFERENTIAL ASSESSMENT COVENANT 

To construct this query, here is the information we need: parcels that are under a Conservation Use or Preferential 
Assessment covenant will have a beginning covenant year keyed in either the Pref YR field or the CUV YR field on 
the Real Property General Information Form. These fields, Pcy for Pref Yr and Ccy for CUV YR, are found in the 
Realprop database table. The alias “r” is used for Realprop. 

 

To run a Sales Ratio Study for parcels that are currently under a covenant, and the appraisal year is 2020, the date 
keyed in either the Pref YR or CUV YR field needs to be no more than 10 years PRIOR to the current appraisal year 
(2013), which would be the year 2004. The year ‘2004’ is delimited because the Pcy and Ccy fields in Realprop are 
character fields. 

 

To use both that year and all years after 2004, the ">=" (greater than or equal to) operator should be used. 

 

The logical "or" operator will also be used in the expression to link the Pcy and Ccy fields. Whenever the “Or” 
operator is used, it is best to group the query with parentheses. 

 

This is all the information we need to construct this query. The final part of the query looks like this and is keyed in 
the query memo field on the form: 

 

(r.pcy >= ’2004’ or r.ccy >= ’2004’) 
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When the user keys the above part of the query into the memo field and clicks on the RUN Button, a “Please wait 
for this process” message will appear as the query information is analyzed, then the Sales Ratio Analysis form will 
appear. The number of records processed, the number of sales selected for the ratio study, and the number of 
Sales clipped, or excluded, will be displayed on the query form as well. 

 

 

The Sales Ratio Analysis Form will display the sales ratios and other statistics and present the user with several 
options for printing the Ratio Study. The user can also look at a list of the sales that met the selection criteria and 
edit these sales if needed. The Sales Ratio Analysis Form was discussed under Basic Selection earlier in this manual, 
and the user can refer to those pages for more information if desired. 

 

 

EXAMPLE THREE: A STUDY OF ALL SALES FOR HOUSES THAT HAVE A SQUARE FOOT VALUE LESS THAN 

$30/SQUARE FOOT 

Data on houses in WinGAP is found in the Reprop database table. We will need to use the alias “rp” for Reprop in 
the query statement. The $/square foot value of a house is calculated by taking the calculated value of the house, 
found in the Timp_val field, and dividing this value by the square footage of the house, found in the heatedarea 
field. The user will need to employ four operators in this Query Expression:  

• The relational ">" (greater than) operator. 

• The logical "and" operator. 

• The mathematical "/" (divide) operator. 

• The relational "<" (less than) operator. 
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Since division by zero is not allowed in any query expression, a condition must first be set to prevent the query 
expression from using any Heatedarea values of zero. This is done by clicking the ">" (greater than) operator and 
placing it after the Heatedarea field in the expression, followed by a "0" (zero). This condition must be linked with 
the expression that will produce only those houses with a $/square foot value less than $30. The logical "and" 
operator is used to link the expressions, followed by the Timp_val/Heatedarea calculation. 

 

The final step in building the expression is to limit it to those houses that have a value under $30 per square foot. 
This is done by keying the less than operator ("<"), then keying 30 after the less than operator. The final part of the 
query looks like this and is keyed in the query memo field on the form: 

 

rp.heatedarea >0 and rp.timp_val/rp.heatedarea < 30 

 

The user can now click the Run button to run the Sales Ratios Study for all sales for houses that have a square foot 
value less than $30 per square foot. Once the sales are analyzed and the sales ratios calculated, the Sales Ratio 
Analysis Form will appear. 

 

 

The Sales Ratio Analysis Form will display the sales ratios and other statistics and present the user with several 
options for printing the Ratio Study. The user can also look at a list of the sales that met the selection criteria and 
edit these sales if needed. The Sales Ratio Analysis Form was discussed under Basic Selection earlier in this manual, 
and the user can refer to those pages for more information if desired. 

 

 

EXAMPLE FOUR: A STUDY OF ALL SALES FOR HOUSES THAT HAVE A REPLACEMENT COST NEW VALUE 

GREATER THAN 100,000 

Since this example uses house data, the Reprop database table and the alias “rp” will be used. The replacement 
cost new value of a house is found in the RCN field. (NOTE: The County MUST have run Reappraise > Real Property 
> Residential Improvements at least once for this field to be populated with values). The user will only need to 
employ the relational ">" (greater than) operator in this query expression. 
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The sales ratio study example was for sales for all houses with an RCN value greater than $100,000. The user 
should key the greater than sign (">"), then key 100000 after the greater than operator. When the user has 
finished constructing the query expression, it should appear like the one below: 

rp.rcn>100000 

The user can now click the Run Button to run the Sales Ratios Study for all sales for houses with a replacement cost 
new greater than $100,000. Once the sales are analyzed and the sales ratios calculated, the Sales Ratio Analysis 
Form will appear. 

 

 

The Sales Ratio Analysis Form will display the sales ratios and other statistics and present the user with several 
options for printing the Ratio Study. The user can also look at a list of the sales that met the selection criteria and 
edit these sales if needed. The Sales Ratio Analysis Form was discussed under Basic Selection earlier in this manual, 
and the user can refer to those pages for more information if desired. 

 

 

 

NEIGHBORHOOD ANALYSIS  

The Neighborhood Analysis option on the Sales Analysis Menu provides a tool that the Assessors' Office can utilize 
in the generation of ratio studies based on Neighborhoods. (NOTE: For Neighborhood Analysis to function 
properly, the County must set up Neighborhoods in Tools > Schedules/Tables > Neighborhoods.) Clicking on this 
option will produce the Neighborhood Ratio Analysis Form. 
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Neighborhood List: The left side of the Form contains a list box of all the Neighborhoods in the County. When the 
Description box is checked, the Neighborhoods are arranged in alphabetical order. When the NH Code button is 
checked, the list is sorted by the Neighborhood Code. A Neighborhood is selected for use in the Ratio Study by 
clicking on it. The user can move around the list box to select Neighborhoods for inclusion in the Ratio Study by 
using the arrow keys, the page up and down keys, and the home and end keys on the keyboard. The user can also 
press the first letter in the name of a Neighborhood and go directly to the first Neighborhood that begins with that 
letter. The mouse can also be used to move around in the list box. 

Sales Criteria: Neighborhood Ratio Studies are run based upon a more limited set of Sales Criteria than Ratio 
Studies that are run using either the Basic Selection or Advanced Query methods. The fields on the Form use the 
information keyed on the Sales Form when adding sales to Real Property. 

Date Range Start: The Start field is where the Starting Date for sales to be used in the Ratio Study is keyed. The 
date keyed in this field is inclusive. For example, if the user wants a Study of all sales after January 1, 2019, then 
01/02/2019 would be keyed in this field. The Start date field should be left blank if it is not to be used as a criterion 
in the Ratio Study. 

Date Range End: The End field is where the Ending Date for sales to be used in the Ratio Study is keyed in the same 
manner as the Start date. Like the Start date, the date keyed in the End date field is inclusive. The End date field 
should be left blank if it is not to be used as a criterion in the Ratio Study. 
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Sale Class: Four checkboxes are available where the Sales Classification of the sale can be selected to further 
qualify the Ratio Study. Any or all of the checkboxes can be selected. If all the Class checkboxes are left blank, the 
Sales Class will be ignored in the selection of sales. 

Time: This optional checkbox is used to specify an annual percentage amount to time-adjust sales, and sales will be 
time adjusted to January 1st of the digest year for the Starting Date specified on the form. 

Sale Reasons: Two checkboxes and a combo box are available to set criteria for the Sale Reasons to be used for the 
Ratio Study. 

• If only the FM (Fair Market) checkbox is checked, and the combo box left blank, only sales with a Sales 
Reason of Fair Market will be used. 

• If only the LM (Land Market) checkbox is checked, and the combo box left blank, only sales with a Sales 
Reason of Land Market will be used. 

• If both the FM and LM checkboxes are checked, and the combo box left blank, only sales with a Sales 
Reason of Fair Market or Land Market will be used. The FM and/or LM checkboxes can also be used with 
any of the Sale Reasons in the combo box to run a Ratio Study. 

• Finally, the FM and LM checkboxes can be left blank and a specific reason or reasons in the Sales Reason 
combo box can be used to run a Ratio Study for a specific type of Sale Reason. 

Neighborhoods Selected: Beneath the Sales Reason section of the Form is a list box that will display all the 
Neighborhoods selected for the Ratio Study. Neighborhoods are placed in the list box by using the four arrow 
buttons located to the left of the Neighborhoods Selected list box. 

 

 

The top button, with two arrows on it pointing to the right, will place all the Neighborhoods in the Neighborhood 
list box on the left side of the Form into the Neighborhoods Selected list box. The next button, with one arrow 
pointing to the right, will place any selected Neighborhoods from the Neighborhood list box on the left of the Form 
into the Neighborhoods Selected list box. The third button, with one arrow pointing to the left, will remove any 
selected Neighborhoods from the Neighborhoods Selected list box on the right side of the Form. The bottom 
button, with two arrows in it pointing to the left, will remove all the Neighborhoods in the Neighborhood list in the 
Neighborhoods Selected list box. 

 

A single Neighborhood can be selected for inclusion in the Ratio Study by clicking on the desired item in the 
Neighborhood List Box. 
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A range of Neighborhoods can be selected for inclusion in the Ratio Study by clicking on the first item in the 
desired range, holding the Shift key down, and then clicking on the last item in the range.  
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The Button with one arrow pointing to the right would be clicked to send these Neighborhoods to the 
Neighborhoods Selected list box. 



 
233 

 

 

If the user wishes to select Neighborhoods that aren’t contiguous on the list, these can be selected by clicking on 
the first item, holding the Ctrl key down, and then clicking on each of the other desired items. 



 
234 

 

 

Clicking the Button with one arrow pointing to the right would send these Neighborhoods to the Neighborhoods 
Selected list box. 
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Once all the Neighborhoods to be included in the Ratio Study have been selected and the Starting and Ending Sales 
Dates, Sales Classes, and Sales Reasons have been selected on the Analysis form, the Run button on the lower right 
of the Neighborhood Ratio Analysis form should be clicked. After the records are processed, the Neighborhood 
Analysis Results form will appear, superimposed over the Neighborhood Ratio Analysis form. 

 

 

The Neighborhoods will be listed in Neighborhood Code order on the Results form, and Neighborhoods that have 
no Sales for the criteria entered will be highlighted in BLUE. Listed left to right on the Results Form are the 
following. The user can use the horizontal scroll bar at the bottom of the form to see all the columns. 

• The Record ID, as defined by WinGAP for that Neighborhood in the Neighborhood schedule. 

• The Neighborhood Code, as defined by WinGAP for that Neighborhood in the Neighborhood schedule. 

• The Neighborhood Description, as entered by the County in the Neighborhood Schedule. 

• The Median Actual Ratio. The Median Actual Ratio is a measure of central tendency that indicates the 
midpoint of the array of the sales ratios. The Median Ratio is the statistic used to determine the level of 
assessment for the study. 

• The Median Lower Confidence Interval. The Median Lower Confidence Interval is used to determine 
digest acceptance if the Median Actual Ratio is less than .36. 

• The Median Upper Confidence Interval. The Median Upper Confidence Interval is used to determine 
digest acceptance if the Median Actual Ratio is more than .44. 
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• The Aggregate Actual Ratio. The Aggregate Actual Ratio is the weighted average of the sales. It is 
calculated by dividing the sum of the assessments by the sum of the sales prices. 

• The Aggregate Lower Confidence Interval. If the PRD (Price Related Differential) is outside of acceptable 
ranges and the Aggregate Actual Ratio is used to determine the assessment level, the Aggregate Lower 
Confidence Interval must fall within a ratio range of .36 to .44, unless the Aggregate Upper Confidence 
Interval is within this same range. 

• The Aggregate Upper Confidence Interval. If the PRD is outside of acceptable ranges and the Aggregate 
Actual Ratio is used to determine the assessment level, the Aggregate UCI (Upper Confidence Interval) 
Ratio must fall within a ratio range of .36 to .44 to allow for assessment level acceptance. The table below 
provides an illustration of the use of the UCI and LCI. 

 

LCI AGG UCI  

32 34 36 Pass (UCI falls within (overlaps) acceptable range) 

28 30 32 Fails 

26 32 38 Pass (UCI falls within (overlaps) acceptable range) 

 

• The Coefficient of Dispersion. The COD, or Coefficient of Dispersion, measures the degree of uniformity in 
the study. The COD is calculated by first determining the absolute deviation from the median for each sale 
(Ratio - Median). The average of the deviations is then calculated. The average deviation is then divided 
by the median ratio to produce the COD. The COD should be less than .15 for residential property and less 
than .20 for agricultural, commercial, and industrial properties. 

• The Price Related Differential. The PRD, or Price Related Differential, is used to measure assessment bias 
in a ratio study. The PRD should fall between .95 and 1.10. It is calculated by dividing the mean ratio by 
the aggregate ratio. If the PRD is greater than 1.00, the lower priced properties generally have higher 
ratios than the higher priced properties. The study is exhibiting regressivity. If the PRD is less than 1.00, 
the higher priced properties are overvalued compared to the lower priced properties. The study exhibits 
progressivity. 

• The Number of Samples. The number of sales that are included in the Ratio Study for that Neighborhood. 

• The Lowest Ratio. The Lowest Ratio of any sale that meets the selection criteria and is used in the Ratio 
Study. 

• The Highest Ratio. The Highest Ratio of any sale that meets the selection criteria and is used in the Ratio 
Study. 

• The Minimum Sample Size. The smallest number of samples in a ratio study that will constitute a valid 
ratio study. The Min Sample Size is a function of the uniformity in the ratio study. A ratio study with 
greater uniformity has a lower Minimum Sample Size. 

• The Standard Deviation. The basic numeric measure of the extent of variation of the sample around the 
center (measure of central tendency). 

• The Neighborhood Adjustment Factor. The Neighborhood Adjustment Factor for that Neighborhood, as 
entered by the County in the Neighborhood Schedule. 

• The User ID of the person that is logged into WinGAP and ran this Ratio Study. 
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Print Button: The Print Button on the lower left of the Results form can be clicked to display a Print Preview of the 
Ratio Study. The default order on the report is Neighborhood Code. The sort order arrows on any of the column 
headings of the report can be clicked to order the report in a different order. 

 

 

Print With Sales: The Print with Sales Button on the lower left of the Results form can be clicked to display a Print 
Preview of the Neighborhood Ratio Study with sales. This report is also in Neighborhood Code order, and the order 
can be changed by clicking on the sort order arrows in any of the other column headings. The ratios for each 
Neighborhood are presented at the beginning of the sales list for that Neighborhood. 
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Without leaving this report preview, the user can also “hide the sales” on the report, if desired, by clicking in the 
True radio button neat the top of the report preview, then clicking the View Report button on the right. The report 
will refresh and present the Summary Report again. The user can return to the list with sales by clicking the False 
radio button and then click the View Report button again. 

 

Sales to Excel: The Sales to Excel Button can be clicked to display a Print Preview of the Neighborhood Ratio Study 
with sales, where the results can be exported to Excel as well as other file formats.  
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The report is exported by clicking the circled down arrow beside the save button and selecting the desired format 
for the exported report. In addition to Excel, the results can also be exported to a PDF file, to Microsoft Word, or to 
Microsoft PowerPoint.  

 

 

The plus sign next to each Neighborhood Code can be clicked to display the sales for that Neighborhood. 
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TOOLS MENU 

 

 

PASSWORD ADMINISTRATION  

Password Administration is used to set up WinGAP users and the respective “rights” that each user will have in the 
system. WinGAP CAN be operated without setting up users. However, it is recommended that users be set up and 
rights assigned, as this provides control and tracking within the Assessors' Office over who operates what parts of 
WinGAP and who makes changes to property data, as well as when these changes occur. 
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Selecting the Password Administration option on the Tools Menu produces the WinGAP User Administration Form. 
If any users exist, the first user in descending alphabetical order will appear on the Form, where that user's rights 
can be edited. New Users can be added, and other users can be selected for editing or deleting by clicking on the 
Users combo box. 

 

 

To set up a new user, the New Button should be clicked, and the system will request a User Login ID. The Login ID 
can be a maximum of 50 characters (lower case only), numbers, or symbols in any combination. After keying the 
Login ID, the next field is where the User Password is entered. The User Password can also be a maximum of 50 
characters, numbers, or symbols in any combination, but BOTH upper- and lower-case characters are accepted. 
The Password must be re-keyed in the Confirm Password box before it is accepted. 

 

Next is the User Default Search Hits field, which defines the number of records that will appear in any Search List 
Box. The default is 25 and can be changed to any number between 1 and 10,000, depending upon the preference 
of a particular User. 
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The Sketch with Keyboard checkbox sets up a default preference for sketching that can be associated with each 
user. Placing a checkmark in this box will default the Sketch screen to Sketch with Keyboard for this user; no 
checkmark will default the Sketch screen to drawing with the mouse.  

 

The Use Windows Picture Viewer provides the user with the ability to define which application will be used to 
open digital images (photos) that are assigned to parcels, improvements, sales, etc. If the box is checked, WinGAP 
will use the default Windows Picture Viewer which may be Paint, Windows Picture and Fax Viewer, etc. If the box 
is left unchecked, the WinGAP viewer will be used. If the WinGAP viewer is used, the resolution of the saved 
photos cannot be any greater than the Desktop resolution.  

 

Next, the Appr/Auditor Name field is used to assign Appraisers and Auditors to a list that will appear on various 
data entry Forms in WinGAP, such as the Real Property General Information Form, the Personal Property General 
Information Form, etc., where they can be assigned as the Primary Appraiser or Alternate Appraiser for a Real 
Property Parcel or Personal Property Account. Beneath this field are four checkboxes where, if checked, the 
Appraiser or Auditor Name, if used, will appear in the Appraiser list on the data entry Forms for those types of 
property. 

 

The DB Filter box allows the administrator to restrict what databases an individual login can access and is set per 
login. This field allows only one entry and works similar to a SQL “LIKE” statement. An entry of “AY20” would allow 
the user to see any databases that start with “AY20” in the database name, like AY2017, AY2021, etc. This way, if 
the county makes database copies to test schedule changes, they can name the databases with a different naming 
convention, such as “TEST_AY2020” to filter them out of the Select Year list for standard users since the database 
name doesn’t start with “AY20”. Leaving this field blank allows the user to see all databases. 
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The User Access Rights section of the User Administration Form contains a number of checkboxes where specific 
access rights to WinGAP are assigned for each user. The default setting for each user is Edit rights for all parts of 
WinGAP. These rights can be adjusted for each user by clicking in the appropriate checkbox to restrict a User's 
rights to certain parts of WinGAP. For example, a user could be given no (None) rights for some parts of WinGAP 
(Real Property, Land, Re-Appraise, etc.), view rights for other parts (Owner), and edit rights for all Personal 
Property. 

 

Important: If Guest rights for Owner are assigned to a user, the confidential information such as SSN, FEI, etc. 
will be masked when the user accesses the Owner screen. 

 

Once a User's Login ID, Password, Default Search Hits, and Rights are established, the record is saved by clicking on 
the Apply Button and remaining on the User Administration Form to set up other Users. The OK Button can be 
clicked to return to the main WinGAP screen. 

 

SCHEDULES/TABLES 
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RESIDENTIAL IMPROVEMENTS 

This option produces the Residential Schedules Form. The schedule items on the Residential Schedules Form are 
grouped into six types: 

• Base and Area Schedule Items, where the Base Area for Residential Improvements and associated factors 
are entered. 

• Maximum and Minimum Area Items, where the Maximum and Minimum Area are entered. 

• Heat Dollars and Heat Schedule Items, where the basic cost of Heat as well as Heating Types are entered. 

• Attic and Basement Types, Finish, and Quality Schedule Items, where those items are entered. 

• Component Schedule Items, where various structural components such as Exterior Wall and Plumbing are 
entered. 

• Preferences, where various background information about the Assessor’s Office, such as County Name, 
Point Costs, and Depreciation Years are entered. 

 

 

Any of the Residential Schedules can be accessed by clicking on the appropriate button on the Residential 
Schedules Form. Each of these Schedule items will be discussed in the order they appear on the Residential 
Schedules Form. 

 

NOTE: WinGAP is delivered to the County with default data already setup in many of the Residential Improvement 
schedules. It is the responsibility of each County to verify this schedule data and make adjustments for local 
conditions as needed. Changes to schedule data should always be supported by significant research at the local 
level. 

 



 
245 

BASE AND AREA SCHEDULE ITEMS 

BASE AREA 

The Base Area represents the square footage where no size adjustment is made. In other words, the area 
multiplier is 1.00 at this area level. It typically represents the standard house size for a county. As square footage 
decreases from the base area (the improvement becomes smaller), the cost per square foot increases. As 
residential improvements increase in size from the base area, the cost per square foot decreases. A base area can 
be determined by calculating the median size of houses that have sold. If the Base Area schedule is changed, other 
parameters such as min area, max area, etc. may also need modification to produce accurate values. 

 

 

The Base Area is edited by clicking in the Area field, keying in a new value, and clicking the OK button, which 
returns the user to the Residential Schedules Form. The Area field is the only field on the Base Area Form which is 
accessible to the user and whose value can be changed. Clicking OK returns the user to the main WinGAP screen. 
The Base Area should not be changed in a County without performing significant market studies to determine 
whether the Base Area should be increased or decreased. 
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BASE DOLLARS 

Base Dollars is the base dollar per square foot value for a Residential Improvement without any additions or 
adjustments. 

 

 

Base Dollars is edited by clicking in the $/Square Feet field, keying in a new value, and clicking "OK". This is the 
only field on the Base Dollars Form which is accessible to the user and whose value can be changed. Like all 
Schedule values in WinGAP, the Base Dollars should not be changed in a County without performing significant 
market studies to determine whether the Base Dollars should be increased or decreased. 

 

RESIDENTIAL AREA INCREMENTS 

Both the Increment Base and the Increment Factor menu options open the Residential Area Increments form. In 
previous versions of WinGAP, there was only a single Base and Factor increment, but the pricing mechanism has 
been overhauled to allow multiple points at which the county can apply inflections to the Area Multiplier. 

 

The Increment Factor and the Increment Base are used to calculate the Area Multiplier. The Area Multiplier is then 
applied to the Base Dollars producing an adjusted dollar per square foot value for the improvement. The Area 
Multiplier is rounded to two decimal places, and the formula is calculated as follows: 

 

AM = (((Base Area - Improvement Base Area)/Increment Base) * Increment Factor) + 1.000 

 



 
247 

 

 

The Increment Base is the square foot interval at which the price per square foot (hereafter called P/SF) will be 
changed by the Increment Factor. The Increment Factor is the rate at which the area multiplier is adjusted at each 
square foot interval as defined by the Increment Base. 

 

Multiple Increment Bases and Increment Factors can be set up to control how WinGAP makes size adjustments to 
residential improvements. Any Increment Base can be edited by clicking on the item in the list box, clicking in the 
field to be changed, and clicking either Apply or OK to save the change. Clicking New will add a line where the 
increments can be entered, while selecting a line and clicking Delete will remove the increment. Regardless of how 
many the County wants to use, the top entry must have an Area of 0 (zero). The Increment Base and Increment 
Factor for the top entry can be changed if necessary. The Increment Bases and Increment Factors should not be 
changed in a County without performing significant market studies to determine whether they should be modified. 

 

 

MIN/MAX AREA ITEMS 

MAXIMUM AREA 

The Maximum Area is the point where the base P/SF stops decreasing and levels off. A Residential Improvement 
with a total area greater than the Maximum Area will be valued at the P/SF generated at the Maximum Area. 
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The Maximum Area is edited by clicking in the Area field, keying in a new value, and clicking "OK". This is the only 
field on the Maximum Area Form which is accessible to the user and whose value can be changed. The Maximum 
Area value should not be changed in a County without performing significant market studies to determine whether 
the Maximum Area should be increased or decreased. 

 

MINIMUM AREA 

The Minimum Area is the point where the base P/SF stops increasing and levels off. A Residential Improvement 
with a total area less than the Minimum Area will be valued at the P/SF generated at the Minimum Area. 
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The Minimum Area is edited by clicking in the Area field, keying in a new value, and clicking "OK". This is the only 
field on the Minimum Area Form which is accessible to the user and whose value can be changed. The Minimum 
Area value should not be changed in a County without performing significant market studies to determine whether 
the Minimum Area should be increased or decreased. 

 

HEAT DOLLARS AND HEAT SCHEDULE ITEMS 

HEAT DOLLARS 

Heat Dollars is the basic cost of heat without any adjustment for heating type. Heat Dollars represents the base 
heat value, for example Central Heat, that other heating types are compared against. The dollar amount entered 
should represent the P/SF for the base heat at the Base Area adjusted by the Residential Improvement Point Cost 
(RIPC). 

 

 

For example, if it is determined that the base heat is Central Heat/Air with a cost of $5.00/SF at the Base Area and 
the RIPC is 150, then the following calculation would be made to determine the P/SF to enter for the Heat Dollars: 

 

5.00/(150/100) = 3.33 

 

The divisor of 100 in the above formula will be a constant regardless of the RIPC. The P/S/F value of 3.33 will then 
be keyed into the Heat Dollars field. 

 

Heat Dollars is edited by clicking in the $/Square Feet field, keying in a new value, and clicking "OK". This is the 
only field on the Heat Dollars Form which is accessible to the user and whose value can be changed. The Heat 
Dollars value should not be changed in a County without performing significant market studies to determine 
whether the Heat Dollars should be increased or decreased. 
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HEAT 

Heating types and their associated cost multipliers are stored in the Heat Schedule. These multipliers, or factors, 
are used to adjust heat points for the heat type found in the Residential Improvement.  

 

 

A new Heating type can be added by clicking the "New" button, keying in the Description and Cost Multiplier in 
their respective fields, and then clicking "Apply" or "OK". There is no limit to the number of Heating types that can 
be added to the schedule. The number in the Code field will be automatically assigned to the new Heating type 
item by WinGAP and is not accessible to the user. 

 

An existing Heating type can be edited by clicking on the desired type and editing the appropriate field(s). It is not 
possible to delete a Heating type through the WinGAP interface. 

 

All Cost Multiplier entries are a function of the Heat Dollars and the cost of the heating type being added/edited. 
The Heat Dollars represents the base heat value that other Heating types are compared against. For example, if the 
value of Heat Dollars is $3.33 and the cost for Central Heat is $2.00/SF, the cost multiplier for Central Heat would 
be calculated as follows, 2.00/3.33 = .60. The general formula for calculating such is: 

 

Cost Multiplier = ((heating type value per SF/(RIPC/100))/Heat Dollars) 

 

If the actual cost of the heating type is desired from a schedule entry, the formula to arrive at such is: 

 

Heating Type P/SF = Cost Multiplier * Heat Dollars * RIPC 
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ATTIC AND BASEMENT SCHEDULE ITEMS 

ATTIC TYPE 

The Attic Type schedule provides a listing of the current attic types and their associated price per square foot 
values. Attic types can be used in pricing the Residential Improvement. 

 

 

A new Attic Type can be added by clicking the "New" button, keying in the Description and $/Square Feet values in 
their respective fields, and then clicking "Apply" or "OK". There is no limit to the number of Attic types that can be 
added to the schedule. The number in the Code field will be automatically assigned to the new Attic type item by 
WinGAP and is not accessible to the user. An existing Attic type can be edited by clicking on the desired type and 
editing the appropriate field(s). Attic types cannot be deleted through the WinGAP interface. 

 

All $/Square Feet entries are dollar per square foot amounts. The Residential Improvement Point Cost (RIPC) 
divided by 100 is a multiplier that is used to index the value to a current cost status. For example, if the RIPC is 150 
and the Attic Type is Unfinished with a value of 1.00, the indexed value of the attic will be 1.00 * (150/100) or 
$1.50/sf. If an entry is to be made in the $/Square Feet field, the appraiser must adjust the value with the RIPC. 
The adjustment would be performed as follows: attic value per sf/(RIPC/100) 

  

NOTE: The third item in the Attic Type list, Unfinished, will be used as the base value for attics under the Square 
Foot method of valuation. 

 

ATTIC QUALITY 

Attic Quality cost multipliers, or factors, are used to adjust attic values for Quality when the Square Foot Method 
of valuing attics is used. The multipliers will be applied to the P/SF associated with the attic type assigned to a 
residential improvement. 
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A new Attic Quality can be added by clicking the "New" button, keying in the Description and the Cost Multiplier in 
their respective fields, and then clicking "Apply" or "OK". There is no limit to the number of Attic Quality types that 
can be added to the schedule. The number in the Code field will be automatically assigned to the new Attic Quality 
item by WinGAP and is not accessible to the user. An existing Attic Quality can be edited by clicking on the desired 
Quality and editing the appropriate field(s). Attic Qualities cannot be deleted through the WinGAP interface. 

 

 

ATTIC FINISH ADJUSTMENT 

The Attic Finish Adjustment schedule is used to add value to the base attic type of Unfinished when the Square 
Foot pricing option for attics is selected. The $/Square Feet field value is a function of the Residential Improvement 
Point Cost. If the Residential Improvement Point Cost is 150 and the Attic Finish Adjustment is 2.88, the actual $/sf 
addition to attic value is 2.88 * (150/100) or $4.32.  
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The Attic Finish Adjustment is edited by clicking in the $/Square Feet field, keying in a new value, and clicking 
"OK". This is the only field on the Attic Finish Adjustment Form which is accessible to the user and whose value can 
be changed. The Attic Finish Adjustment should not be changed in a County without performing significant market 
studies to determine whether the Adjustment should be increased or decreased. 

 

BASEMENT COVERAGE 

The Basement Coverage schedule provides a listing of the current basement types and their associated price per 
square foot values. Basement Coverage types can be used in pricing the Residential Improvement. 
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A new Basement Coverage type can be added by clicking the "New" button, keying in the Description and $/Square 
Feet value in their respective fields, and then clicking "Apply" or "OK". There is no limit to the number of Basement 
Coverages that can be added to the schedule. The number in the Code field will be automatically assigned to the 
new Basement Coverage item by WinGAP and is not accessible to the user. An existing Basement Coverage can be 
edited by clicking on the desired type and editing the $/Square Feet field. Basement Coverages cannot be deleted 
through the WinGAP interface. 

 

All $/Square Feet entries are dollar per square foot amounts. The Residential Improvement Point Cost (RIPC) 
divided by 100 is a multiplier that is used to index the value to a current cost status. For example, if the RIPC is 150 
and the Basement Coverage is Full with a value of 4.00, the indexed value of the attic will be 4.00 * (150/100) or 
$6.00/sf. If an entry is to be made in the $/Square Feet field, the appraiser must adjust the value with the RIPC. 
The adjustment would be performed as follows: 

 

basement value per sf/(RIPC/100) 

  

NOTE: The fourth item in the Basement Coverage list, Full, will be used as the base value for basements under the 
Square Foot method of valuation. 

 

BASEMENT FINISH 

Basement Finish cost multipliers, or factors, are used to adjust basement points based on the extent of finish 
when the Descriptive Method (none, unfinished, etc.) of valuing basements is used. 

 

 

A new Basement Finish type can be added by clicking the "New" button, keying in the Description and Cost 
Multiplier value in their respective fields, and then clicking "Apply" or "OK". There is no limit to the number of 
Basement Finish types that can be added to the schedule. The number in the Code field will be automatically 
assigned to the new Basement Finish item by WinGAP and is not accessible to the user. An existing Basement 
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Finish type can be edited by clicking on the desired type and editing the appropriate field(s). Basement Finish types 
cannot be deleted through the WinGAP interface. 

 

BASEMENT QUALITY 

Basement Quality cost multipliers, or factors, are used to adjust basement values for Quality when the Square Foot 
Method of valuing Basements is used. The multipliers will be applied to the P/SF associated with the basement 
type assigned to a residential improvement. 

 

 

A New Basement Quality can be added by clicking the "New" button, keying in the Description and the Cost 
Multiplier in their respective fields, and then clicking "Apply" or "OK". There is no limit to the number of Basement 
Quality types that can be added to the schedule. The number in the Code field will be automatically assigned to 
the new Basement Quality item by WinGAP and is not accessible to the user. An existing Basement Quality can be 
edited by clicking on the desired Quality and editing the appropriate field(s). Basement Qualities cannot be deleted 
through the WinGAP interface. 

 

 

BASEMENT FINISH ADJUSTMENT 

The Basement Finish Adjustment is used to add value to the base basement type, Full, when the Square Foot 
pricing option for basements is selected. The $/Square Feet field value is a function of the Residential 
Improvement Point Cost. If the Residential Improvement Point Cost is 100 and the Basement Finish Adjustment is 
.0635, the actual $/sf addition to basement value is .0635 * 100 or $6.35. 
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The field is edited by clicking in the $/Square Feet field, keying in a new value, and clicking "OK". This is the only 
field on the Basement Finish Adjustment Form which is accessible to the user and whose value can be changed. 
The Basement Finish Adjustment should not be changed in a County without performing significant market studies 
to determine whether the Adjustment should be increased or decreased. 

 

 

COMPONENT SCHEDULE ITEMS 

CEILING 

The Ceiling schedule provides a listing of the current Ceiling types and their associated dollar per square foot 
values. Ceiling types can be used in pricing the Residential Improvement. 
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A new Ceiling type can be added by clicking the "New" button, keying in the type in the Description field and the 
associated $/Square Foot value, and then clicking "Apply" or "OK". There is no limit to the number of Ceiling types 
that can be added to the schedule. The number in the Code field will be automatically assigned to the new Ceiling 
type item by WinGAP and is not accessible to the user. An existing Ceiling type can be edited by clicking on the 
desired type and editing the Description field. Ceiling types cannot be deleted through the WinGAP interface. 

 

EXTERIOR WALL 

The Exterior Walls schedule provides a listing of the current Exterior Wall types. Exterior Walls are used in pricing 
the Residential Improvement. Each Exterior Wall type has a cost multiplier, or factor, that is used to adjust the 
base points according to the type of Exterior Wall. The appraiser in each county must decide what Exterior Wall 
type(s) will be considered as the base. 
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A New Exterior Wall type can be added by clicking the "New" button, keying in the Description and the Cost 
Multiplier in their respective fields, and then clicking "Apply" or "OK". There is no limit to the number of Exterior 
Wall types that can be added to the schedule. The number in the Code field will be automatically assigned to the 
new Exterior Walls item by WinGAP and is not accessible to the user. 

 

The Cost Multiplier for an Exterior Wall type is determined by dividing the $/SF for the base house by the $/SF of a 
structure of equal area with an Exterior Wall type other than what has been determined to be associated with the 
base house. For example, if a masonry (brick) Exterior Wall home with 1500 square feet is determined to be the 
base and the base P/SF for that home is $50.00/SF and a Wood exterior Wall home of the same size has an 
associated cost of $45.00/SF, the Exterior Wall multiplier for the wood home would be: 45/50 = .90 

 

An existing Exterior Wall type can be edited by clicking on the desired item and editing the appropriate field(s). 
Exterior Wall types cannot be deleted through the WinGAP interface. Exterior Wall cost multipliers should not be 
changed in a County without performing significant market studies to determine whether the factor should be 
increased or decreased. 

 

 

MISCELLANEOUS ITEMS (FIREPLACE)  

The Miscellaneous Items (Fireplace) schedule provides a listing of the current Fireplace types as well as other 
miscellaneous Residential Improvement items, such as Spas and Hot Tubs, that the appraiser wishes to value using 
the Lump Sum method. The value in the Lump Sum/$ field is a function of the Residential Improvement Point Cost. 
If the Residential Improvement Point Cost is 100.00 and a One Story, One Box Constructed Fireplace is to be priced 
at $1000, the Lump Sum value is 10 ($1000/100.00). If the Residential Improvement Point Cost is 1.00 and a One 
Story, One Box Constructed Fireplace is to be priced at $1000, the Lump Sum value is 1000 ($1000/1.00). 
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A New Miscellaneous Items (Fireplace) type can be added by clicking the "New" button, keying in the Description 
and the Lump Sum $ in their respective fields, and then clicking "Apply" or "OK". There is no limit to the number of 
Miscellaneous Items (Fireplace) types that can be added to the schedule. The number in the Code field will be 
automatically assigned to the new Miscellaneous item by WinGAP and is not accessible to the user. 

 

An existing Miscellaneous items (Fireplace) type can be edited by clicking on the desired item and editing the 
appropriate field(s). Miscellaneous Items cannot be deleted through the WinGAP interface. Miscellaneous Items 
(Fireplace) Lump Sum values should not be changed in a County without performing significant market studies to 
determine whether the value should be increased or decreased. 

 

 

FLOOR CONSTRUCTION 

The Floor Construction schedule provides a listing of the current Floor Construction types and their associated 
price per square foot values. Floor Construction types can be used in pricing the Residential Improvement. 
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A new Floor Construction type can be added by clicking the "New" button, keying in the type in the Description 
field and the associated $/Square Foot value, and then clicking "Apply" or "OK". There is no limit to the number of 
Floor Construction types that can be added to the schedule. The number in the Code field will be automatically 
assigned to the new Floor Construction item by WinGAP and is not accessible to the user. An existing Floor 
Construction type can be edited by clicking on the desired type and editing the Description field. Floor 
Construction types cannot be deleted through the WinGAP interface. 

 

 

FLOOR FINISH 

The Floor Finish schedule provides a listing of the current Floor Finish types and their associated dollar per square 
foot values. Floor Finish types can be used in pricing the Residential Improvement. 
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A new Floor Finish type can be added by clicking the "New" button, keying in the type in the Description field and 
the associated $/Square Foot value, and then clicking "Apply" or "OK". There is no limit to the number of Floor 
Finish types that can be added to the schedule. The number in the Code field will be automatically assigned to the 
new Floor Finish item by WinGAP and is not accessible to the user. An existing Floor Finish type can be edited by 
clicking on the desired type and editing the Description field. Floor Finish types cannot be deleted through the 
WinGAP interface. 

 

 

FOUNDATION 

The Foundation schedule provides a listing of the current Foundation types and their associated dollar per square 
foot values. Foundation types can be used in pricing the Residential Improvement. 
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A new Foundation type can be added by clicking the "New" button, keying in the type in the Description field and 
the associated $/Square Foot value, and then clicking "Apply" or "OK". There is no limit to the number of 
Foundation types that can be added to the schedule. The number in the Code field will be automatically assigned 
to the new Foundation item by WinGAP and is not accessible to the user. An existing Foundation type can be 
edited by clicking on the desired type and editing the Description field. Foundation types cannot be deleted 
through the WinGAP interface. 

 

 

INTERIOR WALLS 

The Interior Walls schedule provides a listing of the current Interior Wall types and their associated dollar per 
square foot values. Interior Wall types can be used in pricing the Residential Improvement. 
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A new Interior Wall type can be added by clicking the "New" button, keying in the type in the Description field and 
the associated $/Square Foot value, and then clicking "Apply" or "OK". There is no limit to the number of Interior 
Wall types that can be added to the schedule. The number in the Code field will be automatically assigned to the 
new Interior Wall item by WinGAP and is not accessible to the user. An existing Interior Wall type can be edited by 
clicking on the desired type and editing the Description field. Interior Wall types cannot be deleted through the 
WinGAP interface. 

 

 

OBSERVED CONDITION 

The Observed Condition schedule provides a listing of available Observed Condition types. Observed Condition 
types are descriptive only and add no value to the Residential Improvement. Observed Condition types are hard 
coded within WinGAP and cannot be changed by the user. 
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OCCUPANCY 

The Occupancy schedule provides a listing of the current Occupancy types. Occupancy cost multipliers, or factors, 
can be used to adjust Residential Improvement values for types of Occupancy. 

 

 

A new Occupancy type can be added by clicking the "New" button, keying in the type in the Description field, and 
the multiplier in the Cost Multiplier field, and then clicking "Apply" or "OK". A maximum of 999 Occupancy types 
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can be added to the schedule. The number in the Code field will be automatically assigned to the new Occupancy 
item by WinGAP and is not accessible to the user. 

An existing Occupancy type, except for Mobile Home, can be edited by clicking on the desired type and editing the 
Description field. The position of the Mobile Home Occupancy within the list cannot be changed. It is used by 
WinGAP to as a flag to determine if access to Manufactured Housing should be provided for Residential 
Improvement/Non-Prebilled Manufactured Homes. Occupancy types cannot be deleted through WinGAP. 

 

 

PLUMBING 

The Plumbing schedule in WinGAP contains just two items, Standard Complement and Extra Fixtures. Generally, a 
Standard Complement represents one 3-fixture bath, kitchen fixtures, and washer hookup. A Standard 
Complement may be defined as any set of plumbing fixtures with the value contribution reflecting the definition. 
Any plumbing beyond the Standard Complement in the Residential Improvement is valued on a per fixture basis 
using the Extra Fixtures item. 

 

 

Plumbing is valued using the Lump Sum method based upon the Residential Improvement Point Cost. If the 
appraiser wishes to modify the value contribution of plumbing, the value of the plumbing item should be keyed in 
the Lump Sum $ field. New Plumbing items cannot be added, and existing items cannot be deleted. However, if 
desired, the Description of an item can be modified to better define the item. For example, Standard Complement 
might be changed to Std Comp – Kitchen + Bath. Plumbing Lump Sum values should not be changed in a County 
without performing significant market studies to determine whether the value should be increased or decreased. 
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ROOF SHAPE 

The Roof Shape schedule provides a listing of the current Roof Shape types and their associated dollar per square 
foot values. Roof Shape types can be used in pricing the Residential Improvement. 

 

 

A new Roof Shape type can be added by clicking the "New" button, keying in the type in the Description field and 
the associated $/Square Foot value, and then clicking "Apply" or "OK". There is no limit to the number of Roof 
Shape types that can be added to the schedule. The number in the Code field will be automatically assigned to the 
new Roof Shape item by WinGAP and is not accessible to the user. An existing Roof Shape type can be edited by 
clicking on the desired type and editing the Description field. Roof Shape types cannot be deleted through 
WinGAP. 

 

 

ROOFING 

The Roofing schedule provides a listing of the current Roofing types and their associated dollar per square foot 
values. Roofing types can be used in pricing the Residential Improvement. 



 
267 

 

 

A new Roofing type can be added by clicking the "New" button, keying in the type in the Description field and the 
associated $/Square Foot value, and then clicking "Apply" or "OK". There is no limit to the number of Roofing types 
that can be added to the schedule. The number in the Code field will be automatically assigned to the new Roofing 
item by WinGAP and is not accessible to the user. An existing Roofing type can be edited by clicking on the desired 
type and editing the Description field. Roofing types cannot be deleted through WinGAP. 

 

STORY HEIGHT 

The Story Height schedule provides a listing of the current Story Height types. Story Height types are descriptive 
only and add no value to the Residential Improvement. 
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A new Story Height type can be added by clicking the "New" button, keying in the type in the Description field, and 
then clicking "Apply" or "OK". There is no limit to the number of Story Height types that can be added to the 
schedule. The number in the Code field will be automatically assigned to the new Story Height item by WinGAP 
and is not accessible to the user. An existing Story Height type can be edited by clicking on the desired type and 
editing the Description field. Story Height types cannot be deleted through WinGAP. 

 

IMPROVEMENT LABELS 

Improvement Labels identify sketched and manually entered areas of a Residential Improvement and assist in the 
pricing of the Improvement. They are used in calculating the square footage (heated area) of the Improvement. 
The schedule can be customized to the County's needs by adding, changing, or deleting entries. 

 

The Improvement Labels Form displays the existing Residential Improvement Labels with the data entry fields for 
each Improvement Label item. The following information, from left to right, is displayed about each Improvement 
Label item: 

• Improvement Label 

• Improvement Label Description 

• Cost/SqFt 

• Cost Factor 

• Area Factor 

• Label Type 

• Building Type (Residential in this case) 

• Whether or not the Label is used as part of Basement Sketching (Y = Yes, N = No) 

 

Improvement Label schedule items are listed in Improvement Label alphabetical order. The user can press the 
Page Up, Page Down, or arrow keys to move up and down in the list box and locate an Improvement Label, or can 
click with the mouse on the vertical scroll bar and drag it up or down to find the item. Clicking on an Improvement 
Label item in the list box will display the data about that item in the data entry fields at the bottom of the Form. 
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Label: A four-character field (letters, number or symbols are acceptable) where the County-defined Improvement 
Label is keyed. An Improvement Label must be unique, cannot be duplicated, and should quickly identify the 
Improvement. For example, a Primary Improvement Label “1.0s” could be used to identify a One Story house, an 
Interior Improvement Label “2nd” could be used to identify the Second Story of a house, and the Appendage 
Improvement Label “OP” could be used to identify an Open Porch. The Improvement Label is displayed on the 
sketch screen and printed on the Property Record Card for each part of an Improvement that is sketched. It also 
displays on the Residential Improvements Form in the Edit Areas window regardless of whether the area is 
sketched or manually entered. 

Description: The Description or identifying name of the Improvement Label, such as “Open Porch”, is keyed into 
this 20-character wide field. 

Label Type: The type of Improvement Label is selected by clicking on the Label Type combo box. There are five 
available types: Addition, Appendage, Interior, Primary, and Upper. IMPORTANT: A Label Type MUST be selected 
for every Improvement Label. 

• The Addition Label is used for an Addition (heated area) to a Residential Improvement. Areas that are 
labeled as Additions will display as a double black dashed line on the sketch screen. 
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• The Appendage Label is used for appendages (non-heated area) to a Residential Improvement, such as 
porches, decks, and attached garages. Areas that are labeled as Appendages will display as a solid blue 
line on the sketch screen.  

• The Interior Label is used for "interior" parts of a Residential Improvement, such as a Second Story, that 
the appraiser wishes to price differently and label separately from the primary heated area of the 
Improvement. Interior Label areas will display as a green dashed line on the sketch screen. 

• The Primary Label is used for the primary heated area of the Residential Improvement, such as One Story, 
Two Story, etc. Areas that are labeled as Primary will display as a red solid line on the sketch screen. 

• The Upper Label functions in a similar manner as the Primary Label type. The exception being the fact 
that the area factor adjustment will be applied to the area of the polygon and the resulting square 
footage will be will be used in the determination of the area multiplier. The adjusted areas of Upper Label 
type polygons and Primary Label type polygons will be summed to generate the Total Base Area. The Total 
Base Area is then used in the determination of the area multiplier for the improvement. The main 
function of the Upper Label type is to allow the area of upper story levels to be included in the 
determination of the base dollar amount while providing a means of identifying as upper story levels. An 
existing label can be changed to the Upper Label type in the Improvement Labels schedule, reappraise 
run, and the values on the affected improvement will reflect the revised Area Multiplier. Upper Level 
areas will display as a broken violet line on the sketch screen. 

Cost/SQFT: The Cost/SQFT field contains the cost per square foot for Addition and Appendage Label types. The 
field is disabled for all other Label types. 

Cost Factor: The Cost Factor is used to adjust the value of Residential Improvements and is used with the Interior, 
Primary, and Upper types of Improvement Labels. The Cost Factor field will default to 1.00. These Cost Factors can 
be changed if desired by the appraiser to adjust and localize the pricing of Residential Improvements. NOTE: The 
Cost Factor field is not used with Appendage and Addition Label types and will also default to 1.00. 

Area Factor: The Area Factor is used to adjust the Heated Area of Residential Improvements and is used with the 
Interior, Primary, and Upper types of Improvement Labels. The Area Factor field will default to 1.00. These Area 
Factors can also be changed if desired by the appraiser to adjust and localize the calculating of the Heated Area of 
Residential Improvements. NOTE: The Area Factor field is not used with Appendage and Addition Label types and 
will also default to 1.00. 

Basement Area: This checkbox is used with a Basement Area Improvement Label and is designed to allow a 
Basement area to be sketched and that Basement area will automatically populate the Basement Area field on the 
Residential Improvements form. For this feature to function properly, three things must occur: 

• The Basement Area checkbox for that label must be checked. 

• On the Preferences form, the Sum Bsmt to Screen checkbox must be checked. 

• The Basement is sketched and labeled with the Basement Improvement Label that has the check in the 
Basement Area checkbox. 

 

A NEW Improvement Label can be added to the Improvement Labels schedule by: 

• Clicking the New button. 

• Clicking in the Label field (make sure the cursor is at the far left of the field) and keying the new 
Improvement Label. 

• Using the Tab key to go to the rest of the data entry fields where the new information can be keyed. 

• Clicking the Apply or OK Button to save the data. 
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Existing Improvement Labels can be edited by clicking on the desired item in the list. NOTE: If the Label is in use, 
the Label field is disabled and cannot be edited; if the Label is not in use, then the Label field is enabled and the 
Label can be changed. The user can click in any of the other data entry fields where the data can be edited, and 
any changes to data are saved by clicking the Apply or OK Button. 

 

An Improvement Label can be deleted from the schedule if it is NOT IN USE on any Residential Improvement. 
Labels that are in use will have the Delete button disabled. If the Label is not in use, the Delete button will be 
enabled for that Improvement Label, and the user may delete that item by clicking the Delete button. No message 
will appear, and the item will be deleted and removed from the list of Improvement Labels. 

 

Print List: In the lower right of the Improvement Labels form is the Print List button, where the user can print a list 
of Parcels that have Residential Improvements where the selected Improvement Label is found. For example, the 
user wants a list of all Residential Improvements that have a 2 Story Label. The user should select the 2 Story Label 
then click the Print List button, and the Print Preview for 2 Story Labels will appear. 

 

 

The list can be printed or just viewed. A different Label can be previewed by keying the desired Label in the “c 
Label” field at the top of the Reporting Services form and then clicking the View Report button. 
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PREFERENCES 

The final item on the Residential Schedules Menu provides access to the Preferences form, as seen below. The 
Preferences form is discussed in detail later in this manual. 

 

 

 

COMMERCIAL IMPROVEMENTS 

This option on the Tools> Schedules/Tables menu produces the Commercial Schedules Form. The schedule items 
on the Commercial Schedules Form are grouped into five types: 

• Structural Components, where square foot costs can be adjusted for building components such as 
exterior walls and ceilings. 

• Base and Extra Feature schedule items that assist with calculating the area and size of the Commercial 
Improvement and Extra Features associated with the Commercial Improvement. 

• Supplemental schedule items such as Area/Perimeter and Wall Height. 

• Improvement Labels for Commercial Improvements. 
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• Preferences, where various background information about the Assessor’s Office, such as County Name, 
Commercial Base and Point Costs, and Depreciation Years are entered. 

 

NOTE: WinGAP's Commercial Improvements schedules can be set up to use either the Segregated Cost Method or 
Calculator Cost Method of valuing Commercial Improvements, depending upon the preference of the appraiser.  

 

STRUCTURAL COMPONENTS 

NOTE: Before the Commercial Structural Components schedule, below, is built it is important that a county define 
the Commercial Building Types and set them up using the Building Types schedule found on the Commercial 
Improvements Menu. The Commercial Base schedule must also be set up before the Structural Components 
schedule is built. 

 

The first item on the Commercial Improvements Menu, Structural Elements, takes the user to the Commercial 
Structural Components Form, shown below. This Form is used to adjust Commercial Improvement square foot 
costs for building components (also called ADDS) such as floor covering or heating and air conditioning. For 
example, the County may want to add $2.00/square foot for carpet or $4.00/square foot for central heating and 
air conditioning. The cost may vary between different types of buildings. Consequently, each group of similar 
buildings MUST have a unique Building Type code for that category of buildings.  

 

Once the Building Types are defined and set up, the County can then set up the Commercial Base schedule and 
group commercial buildings within these broad Building Types to price them correctly, and THEN set up the 
Commercial Structural Components schedule to price the structural elements of the Commercial Improvement. 
The discussion that follows on building the Commercial Structural Components schedule assumes that the Building 
Types and Base schedule have already been set up in WinGAP. Building Types and the Commercial Base schedule 
are discussed in more detail later in this manual. 
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WinGAP is delivered to the County with a basic Commercial Structural Components schedule. Additions, deletions, 
and changes can be made on the Commercial Structural Components Form to better localize this schedule for the 
County. The Structural Components list box is on the left of the Form. Items in the list box are arranged in Building 
Type order, then alphabetically by Structural Element, and then alphabetically by the Description of the Structural 
Element. Clicking on an item in the list box will display the calculation data for that item in the fields on the right of 
the list box. 

 

Bldg Type: The Building Type that these Structural Components are assigned to. A Building Type is a homogeneous 
group of commercial buildings with similar characteristics. For example, all convenience stores might have a 
Building Type of 13. The Building Type ties the Structural Components back to the Commercial Base schedule. 
Building Type codes are county-defined, can be any 2-digit number, and are set up in the Building Types Schedule. 

Structural Element: The Description of the type of Structural Component, such as "Ceiling Finish" or "Floor 
Construction". 

Description: The specific type of, for example, Ceiling Finish, such as "Plaster". 

$/Sq Ft Adj: There are five fields available to enter dollars per square foot adjustments for the respective Quality 
Classes for each Structural Component. The fields default to zero dollars for each Quality Class and are used to 
adjust the Commercial Improvement square foot costs for each Structural Component item. Values in these fields 
can be negative and take value away as well as positive to add value to the item. The $/Sq Ft Adj for each item 
should not be changed in a County without performing significant market studies to determine whether this value 
should be increased or decreased. 

 

A new Structural Components item can be added to the schedule by clicking the New Button at the bottom of the 
Form. The Building Type field will default to the first Building Type, and the Structural Element field will default to 
the first type. The combo box for each field can be clicked to select the appropriate Building Type and Structural 
Element, then the Description for the new item is keyed into the Description field, and values can be keyed into 
the $/Sq Ft Adj fields to adjust the Commercial Improvement square foot costs for each Quality Class. The Apply or 
OK Buttons can be clicked to save the item to the schedule. 



 
275 

A Structural Components item can be deleted from the schedule by first clicking on the desired item in the list box, 
and then clicking the Delete Button at the bottom of the Form. The user should be certain that this Structural 
Components item is not used by any Commercial Improvements prior to clicking the Delete Button. 

 

The Printer Button at the bottom left of the Form will send an image of the Form to the default Windows printer. 
The complete Structural Components schedule can be printed by using the Reports Menu in the WinGAP tool bar 
and then selecting Real > Print Schedules > and selecting the Commercial Structural Elements item on the menu. 

 

BASE AND EXTRA FEATURE SCHEDULE ITEMS 

BASE SCHEDULE 

NOTE: Before the Commercial Base schedule is built it is important that a county define the Commercial Building 
Types and set them up using the Building Types schedule found on the Commercial Improvements Menu. 

 

Pricing data for various commercial buildings distinguished by Building Type are added and updated through this 
Item on the Commercial Improvements Menu. Building Types must have already been set up in WinGAP before 
building the Commercial Base schedule.  
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WinGAP is delivered to the County with a basic Commercial Base schedule already set up. The items in the list box 
at the top of the Commercial Base schedule Form are displayed in alphabetical order by Description. Clicking on an 
item in the list box will display the calculation data for that item in the fields beneath the list box.  

 

Used as Code: A unique identifying code for each commercial building. The Used as Code, which is county 
assigned, is designed to separate commercial buildings based on their current use. The Code can be any 
combination of four letters or numbers. An Edit button is located to the right of the Used as Code field. The button 
is placed there to prevent inadvertent changes to the Used as Code. If a Used as Code is to be modified, the user 
must click the Edit button to change the Used as Code. 

Description: A Description of the Used as Code, normally the building name, such as "Warehouse". 

Pricing Code: There is only one available Pricing Code, Square Foot. All commercial buildings are priced by the 
square foot. 

Bldg Type: The Building Type assigned to the selected commercial building. A Building Type is a homogeneous 
group of commercial buildings with similar characteristics. For example, all convenience stores might have a 
Building Type of 13. The Building Type ties the building back to the Commercial Structural Components schedule. 
Building Type codes are county-defined, can be any 2-digit number, and are set up in the Building Types schedule. 

Base Cost: Base Cost is the base dollars per square foot value for the selected commercial building. What is 
included in the Base Cost depends upon the appraisal method (Calculator vs Segregated Cost) used by the 
appraiser. For example, if the shell of a Convenience Store is to be priced at $20.00 a square foot, the Base Cost 
should be entered as 20.00. 

NAICS: A code conforming to the North American Industrial Coding System, which identifies the general use of the 
structure, may be entered in this field. 

 

There are five Commercial Construction Types, and each have two types of factors that can be used to modify the 
cost of a commercial building according to a specific Construction Type: 

• Cost Mult: The Construction Cost Multipliers are used to adjust cost for Construction Type. The 
appropriate modifier should be entered on the field corresponding to the Construction Type. 

• Life Exp: The Life Expectancy in years for the different Construction Types of Commercial Improvements. 
Life Expectancy values range from 5 to 75 and must be in increments of 5. The values of the Life 
Expectancy codes 1 – 5 should correspond with the Construction Cost Modifier with the same code (1-5). 

 

Construction Types 

WinGAP Code Description 

1 Heavy Structural Steel 

2 Reinforced Concrete 

3 Masonry Load Bearing Walls 

4 Wood/Steel Combustible 

5 Prefab Structural Steel 

  

A new item can be added to the Commercial Base Schedule with the following steps:  

• Clicking the New Button at the bottom of the Form. 

• Clicking the Edit button to the right of the Used as Code field, keying the new Used as Code into the field, 
then tabbing to the Description field. 

• Keying the Description for the new item into the Description field, then tabbing to the Pricing Method 
field. 
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• Tabbing from the SqFt Pricing Method to the Bldg Type field. 

• Clicking on the combo box for the Building Type to select the appropriate Building Type, then tabbing to 
the Base Cost field. 

• Keying a value into the Base Cost field, then tabbing to NAICS field. 

• Keying a number into the NAICS field if desired, then tabbing to the first Construction Type field. 

• Keying values into the Construction Cost Modifier and Life Expectancy fields. 

• Clicking the Apply or OK Button to save the new Base Schedule item. 

 

A Commercial Base schedule item is edited by clicking on the item in the list box, changing the information in the 
desired field(s), then clicking the Apply or OK Button. An item can be deleted from the schedule by first selecting 
the item in the list box and then clicking the Delete Button at the bottom of the Form. WinGAP will check to see if 
this item is used by any Commercial Improvement before the deletion will occur. If the Base Schedule item is used, 
the user will receive a message that the item cannot be deleted. The complete Base schedule can be printed by 
using the Reports Menu in the WinGAP tool bar and then Real > Print Schedules and selecting the Commercial Base 
item on the menu. 

 

 

EXTRA FEATURES 

Extra Features are items that are attached to or part of a Commercial Improvement but are not considered in the 
Base Cost. For example, a canopy, sprinkler system, overhead door, or loading dock would all be Extra Features. 
WinGAP is delivered to the County with a basic Extra Features schedule already set up. 

NOTE: The Extra Features schedule should be built prior to building the Lump Sum Extra features schedule. 

 

The items in the list box at the top of the Commercial Extra Features Schedule Form are displayed in alphabetical 
order by Description. Clicking on an item in the list box will display the calculation data for that item in the fields 
beneath the list box. 
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Comp #: The Component number is a unique four character identifying code for each type of Extra Feature. The 
code can be any combination of four letters or numbers. An Edit button is located to the right of the Comp # field. 
The button is placed there to prevent inadvertent changes to the component number. If a component number is to 
be modified, the user must first click the Edit button. 

NOTE: The Component # must be unique, and not used by any other Extra Feature item; WinGAP will prompt the 
user if the Comp # already exists in the schedule. 

NOTE: The Comp # cannot be changed if it used by any Extra Feature on a Commercial Improvement. 

Description: A Description of the Extra Feature, normally the name such as "Canopy". 

Pricing Method: There are three available Pricing Methods: Square Foot, Lump Sum, and Non-Value Item. 

• Extra Features that are priced by the Square Foot method will always have a Base Cost value in the Base 
Cost field. 

• Extra Features that are priced by the Lump Sum method will always have a Table Code reference in the 
Table Code field to link this item to a value calculation record in the Lump Sum Extra Features Table to 
properly price the item by the Lump Sum method. In this case, the Base Cost field is disabled and not 
used. Adding an Extra Feature priced by the Lump Sum is a slightly different process than a Sq Ft or Non-
Value item. 

• Extra Features that are descriptive in nature would use the Non-Value Item method. In this case, the Base 
Cost field is disabled and not used. 
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Base Cost: The Base Cost is the base dollars per square foot value for the selected Extra Feature item. The Base 
Cost is used with the Square Foot Pricing Method. The Base Cost can also be a negative number to subtract value 
from the Commercial Improvement based upon the criteria of the base building. 

No Depreciation: Extra Features receive their depreciation from the Calculated (or Override) Physical Depreciation 
of the Commercial Improvement they are attached to, not from the characteristics of the Extra Feature. If the 
County wishes that a particular type of Extra Feature remain at 100% Good and not depreciate, the No 
Depreciation check box should be checked. When this type of Extra Feature is added, its Calculated Physical 
Depreciation will be 1.00, regardless of the Calculated (or Override) Physical Depreciation of the Commercial 
Improvement. 

 

When adding a Lump Sum Extra Feature, the add and edit processes change slightly. To add a new item, after 
clicking New, the user should click the Edit button, key a Comp #, tab to the Description field and key a description 
for the item, tab to the Pricing Method and select Lump Sum as the Pricing Method, then click the Apply button. 

 

 

Table Code: The Table Code field will contain a Table Number that connects the Extra Features schedule item to a 
specific item in the Lump Side pricing tables so that Lump Sum items can be priced properly. Clicking the Table 
Code button will provide access to the Lump Sum Extra Features form. 
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NOTE: When the Lump Sum pricing method is used, the Table Code item used to price the Lump Side Extra Feature 
item can be added during the add process, or by using the separate Commercial Schedules Menu item called Lump 
Sum Extra Features. 

 

An item can be deleted from the Extra Features schedule by first selecting the item in the list box and then clicking 
the Delete Button at the bottom of the Form. WinGAP will check to see if this item is used by any Commercial 
Improvement before the deletion will occur. The complete Extra Features Schedule can be printed by using the 
Reports Menu in the WinGAP tool bar and then Real > Print Schedules and selecting the Commercial Extra Features 
item on the menu. 

 

 

LUMP SUM EXTRA FEATURES 

The Lump Sum Extra Features schedule is used to value Commercial Extra Features, such as Bathrooms or 
Sprinklers, that are priced by the Lump Sum or item method. A Lump Sum item in the Extra Features schedule will 
have a Table Code that will look up an entry in the Lump Sum Extra Features schedule and price the item 
accordingly. The Lump Sum Extra Features schedule can be built at the same time as the Extra Features schedule is 
built. 
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The Lump Sum Extra Features Schedule form displays the existing schedule items in the list box on the top of the 
form. The column headings refer to the Description of the Lump Sum Extra Features item (obtained from the 
Commercial Extra Features schedule), the Tableref code number, the Dimension1 and Dimension2 pointers, the 
Points (Unit Dollars divided by 100), and the Recno (Record Number) assigned to this item in the Lump Sum 
(Acc_Tbls) Table for this type of Extra Feature. The schedule is indexed in Description order. The calculation data 
for each item in the list box can be displayed in the fields on the bottom of the form by clicking on an item.  

 

Table Reference: The Table Reference code is a unique County-defined number. Letters or numbers can be used, 
such as 1-99, AA-ZZ, or 1A, 2C. If a numeric Table Reference is less than ten (10), it should be entered as 01 (a zero 
followed by a 1), 02, 03, etc. WinGAP will assign the Description of the item in the Extra Features schedule with 
this Table Reference to the Description of the Lump Sum Extra Features item. If the Table Reference of the Lump 
Sum Extra Feature does not exist in the Extra Features schedule, the Description of the Lump Sum Extra Feature 
will say "Not currently assigned". 

Dimension 1: Dimension 1 is used as a pointer in the table for locating the proper value. It can represent various 
characteristics of an Extra Feature such as fence height, grade code, code for type, area in the case of sprinklers, 
etc. The user is responsible for maintaining the definitions of these characteristics. The value must be numeric, and 
0 is acceptable. 

Dimension 2: The Dimension 2 value is used to further define the Extra Feature valuation and is used in 
conjunction with Dimension 1 to locate the proper value. The value must be numeric and 0 is acceptable. 

Unit Dollars: The actual dollar cost of the Lump Sum item. 
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A new item can be added to the Lump Sum schedule with the following steps:  

• Clicking the New Button at the bottom of the Form. 

• Entering the Table Reference # code, which is County-defined. 

• Keying the values for the Dimension 1, Dimension 2, and Unit Dollars fields.  

• Clicking the Apply or OK Buttons to save the item to the schedule. 

 

NOTE: when the user adds a new item to the Lump Sum schedule, the user should return to the Extra Features 

schedule and do the following: 

• Select the Extra Features item in the list box that will have that Table code assigned to it. 

• Click the Table Code button. 

• Select the item in the Lump Sum Extra Features schedule that is to be used by that Extra Feature. 

• Click the OK button to place the Table Reference code in Table Code field on the Extra Features form. 

• Click OK on the Extra Features form to save the assignment. 

 

 

Any item in the Lump Sum Extra Features schedule can be edited by clicking on the item in the list box, changing 
the information in the desired field(s), and clicking the Apply or OK Button. An item can be deleted from the 
schedule by first selecting the item in the list box and then clicking the Delete Button at the bottom of the Form.  
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NOTE: the user should be certain that this Lump Sum Extra Features schedule item is not used by any Extra 
Features on Commercial Improvements prior to clicking the Delete Button. The complete Lump Sum Extra Features 
Schedule can be printed by using the Reports Menu in the WinGAP tool bar and then Real > Print Schedules and 
selecting the Commercial Extra Features Lump Sum item on the menu. 

 

 

SUPPLEMENTAL SCHEDULE ITEMS 

AREA/PERIMETER 

The Area/Perimeter Table contains factors, or multipliers, that adjust the cost of a Commercial Improvement for 
shape. These multipliers are distinguished by Building Type and are added and updated through the 
Area/Perimeter option on the Commercial Improvements Menu. 

 

A basic Area/Perimeter Table is supplied with WinGAP. The Area/Perimeter Table Form displays the existing 
schedule items in the list box on the left side of the form. The column headings refer to the Area/Perimeter Ratio 
and the Multiplier. The schedule is indexed in Area/Perimeter Ratio order. The Building Type for the various 
Area/Perimeter Ratios and Multipliers can be selected by clicking on the Building Type combo box. The calculation 
data for each item in the list box can be displayed in the fields on the right side of the form by clicking on an item. 

 

 

Building Type: The Building Type for this Area/Perimeter schedule item. Building Types must be set up before 
Area/Perimeter items can be added to the schedule. The user selects the correct Building Type from the combo 
box, and tabs to the A/P Ratio field. 

A/P Ratio: The Area/Perimeter Ratio is the ratio of the area of the Commercial Improvement to the perimeter of 
the Commercial Improvement. For example, a Commercial Improvement has 10,000 square feet and a Perimeter 
of 400. The Area is divided by the Perimeter, in this example 10000/400, giving an Area/Perimeter Ratio of 25. 
Thus, 25 would be keyed in the Area/Perimeter field on the Area/Perimeter Table Form. 

Multiplier: Once the Area/Perimeter Ratio is determined, the Multiplier for that Area/Perimeter, which is a factor 
that adjusts for the shape of the Commercial Improvement, is keyed into the Multiplier field. 

 

A new item can be added to the Area/Perimeter Table by clicking the New Button at the bottom of the Form. The 
Building Type should be selected first, then the Area/Perimeter Ratio and Multiplier values can be keyed into their 
respective fields. The Apply or OK Buttons can be clicked to save the item to the schedule. An item can be deleted 
from the schedule by first selecting the item in the list box and then clicking the Delete Button at the bottom of the 
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Form. The user should be certain that this Area/Perimeter Table item is not used by any Commercial 
Improvements prior to clicking the Delete Button. The complete Area/Perimeter Schedule can be printed by using 
the Reports Menu in the WinGAP tool bar and then Real > Print Schedules and selecting the Commercial 
Area/Perimeter item on the menu. 

 

BUILDING TYPES 

Building Types categorize Commercial Improvements based on similarities in Construction Type and other 
components, such as Area/Perimeter and Wall Height. A Building Type is a homogeneous group of commercial 
buildings that will have the same pricing for additional items. The commercial buildings in these types do not have 
to be of the same use if the costs for the Commercial Structural Elements, such as heating and air conditioning, are 
similar. Since the cost for the Commercial Structural Elements may vary between different types of buildings, each 
group of similar buildings must have a unique code for that type of building. 

 

While the construction of this table is at the discretion of the appraiser, below is a suggested Building Type 
schedule. Once the Building Types are defined the county can set up the Commercial Base Schedule, the 
Commercial Structural Components Schedule, and the other Commercial Improvement Schedules to price 
Commercial Improvements correctly. 

• Apartments, Clubhouses, Motels 

• General Stores, General Retail, Convenience Stores 

• Garages, Warehouses, Airplane Hangers, Industrial Buildings 

• Office Buildings, Public Buildings, Schools 

• Churches, Theaters, Auditoriums 

• Sheds and Farm Buildings 

• Schools and Classrooms 

• Special Supplemental Cost 

• Miscellaneous 
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Additions, deletions, and changes can be made to better localize this schedule for the County. A maximum of 999 
Building Types can be added to the schedule, and there must be at least ONE Building Type in the schedule. A new 
item can be added to the Building Types Schedule by clicking the New Button at the bottom of the Form and filling 
in the Description field. No data entry is allowed in the Lump Sum $, $/Square Feet, and Cost Multiplier fields, as 
these fields on the Building Types Form do not affect value. The Apply or OK Buttons can be clicked to save the 
new item to the schedule. Building Types cannot be deleted through the WinGAP interface. The complete Building 
Types Schedule can be printed by using the Reports Menu in the WinGAP tool bar and then Real > Print Schedules 
and selecting the Building Types item on the menu. 

 

WALL HEIGHT 

The Wall Height Table contains factors or multipliers that allow for adjustments based on the height of the walls of 
a Commercial Improvement. These multipliers are distinguished by Building Type and are added and updated 
through the Wall Height option on the Commercial Improvements Menu. 

 

 

A basic Wall Height Table is supplied with WinGAP. The Wall Height Table form displays the existing schedule items 
in the list box on the left side of the form. The column headings refer to the Wall Height and the Factor or 
Multiplier. The schedule is indexed in Wall Height order. The Building Type for the various Wall Heights and 
Multipliers can be selected by clicking on the Building Type combo box. The calculation data for each item in the 
list box can be displayed in the fields on the right side of the form by clicking on an item. 

 

Building Type: The Building Type for this Wall Height schedule item. Building Types must be set up before Wall 
Height items can be added to the schedule. The user selects the correct Building Type from the combo box, and 
tabs to the Wall Height field. 

Wall Height: The Wall Height is just that, the Wall Height, in feet, of the Commercial Improvement. If the 
Improvement has more than one story, the Wall Heights for the stories are averaged. For example, a 5-story 
building that is 60 feet tall would have a Wall Height of 12 feet. 

Multiplier: The Multiplier is a factor that adjusts for the Wall Height of the Commercial Improvement. 

 

A new item can be added to the Wall Height Table by clicking the New Button at the bottom of the Form. The 
Building Type should be selected first, then the Wall Height and Multiplier values can be keyed into their 
respective fields. The Apply or OK Buttons can be clicked to save the item to the schedule. An item can be deleted 
from the schedule by first selecting the item in the list box and then clicking the Delete Button at the bottom of the 
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Form. The user should be certain that this Wall Height Table item is not used by any Commercial Improvements 
prior to clicking the Delete Button. The complete Wall Height Schedule can be printed by using the Reports Menu 
in the WinGAP tool bar and then Real > Print Schedules and selecting the Commercial Wall Height item on the 
menu. 

 

RANK 

The Commercial Rank Table contains factors or multipliers that allow for adjustments based on the quality classes 
of any Extra Features of a Commercial Improvement. These multipliers are added and updated through the Rank 
option on the Commercial Improvements Menu. 

 

 

A basic Rank Table is supplied with WinGAP. The Rank Table form displays the existing schedule items in the list 
box on the left side of the form. The column headings refer to the Rank, the Rank Description, and the Multiplier. 
The schedule is indexed in Rank order. WinGAP is supplied to the County with a listing of five (5) Ranks and 
Multipliers, ranging from Excellent with a Multiplier of 1.5 to Poor with a Multiplier of 0.5. 

 

Description: The Description of the Rank, such as Excellent or Low Cost. 

Rank: The Number of the Rank. 

Multiplier: The Multiplier is a factor that adjusts for the quality of the Extra Feature 

 

The calculation data for each item in the list box can be displayed in the fields on the right side of the form by 
clicking on an item. If desired, a “No Value” Rank can be added to the Commercial Rank schedule. This will allow 
Extra Features to be attached to a Commercial Improvement without a value being assigned to them. The 
Description of the Rank schedule item must contain the term “no value” and the Multiplier should be set to 0.00. 
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A Rank item can be edited by clicking on the item in the list box and changing the data in the desired field. A new 
Rank item can be added to the Rank Table by clicking the New Button at the bottom of the Form. The Description, 
Rank Number, and Multiplier values can be keyed into their respective fields. The Apply or OK Button can be 
clicked to save the item to the schedule. An item can be deleted from the Commercial Rank schedule by first 
selecting the item in the list box and then clicking the Delete Button at the bottom of the Form. WinGAP will check 
to see if this item is used by any Commercial Improvement before the deletion will occur. The complete Rank 
Schedule can be printed by using the Reports Menu in the WinGAP tool bar and then Real > Print Schedules and 
selecting the Commercial Rank item on the menu.  

 

 

IMPROVEMENT LABELS 

Improvement Labels identify sketched and manually entered areas of a Commercial Improvement and assist in the 
pricing of the Improvement. They are used in calculating the square footage (heated area) of the Improvement. 
The schedule can be customized to the County's needs by adding, changing, or deleting entries. 

 

The Improvement Labels Form displays the existing Residential Improvement Labels with the data entry fields for 
each Improvement Label item. The following information, from left to right, is displayed about each Improvement 
Label item: 

• Improvement Label 

• Improvement Label Description 

• Cost/SqFt 

• Cost Factor 

• Area Factor 

• Label Type 

• Building Type (always Commercial for Commercial Improvement Labels) 

• Whether or not the Label is used as part of Basement Sketching (always No for Commercial 
Improvements) 

 

Improvement Label schedule items are listed in Improvement Label alphabetical order. The user can press the 
Page Up, Page Down, or arrow keys to move up and down in the list box and locate an Improvement Label, or can 
click with the mouse on the vertical scroll bar and drag it up or down to find the item. Clicking on an Improvement 
Label item in the list box will display the data about that item in the data entry fields at the bottom of the Form. 
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Label: A four-character field (letters, number or symbols are acceptable) where the County-defined Improvement 
Label is keyed. An Improvement Label must be unique, cannot be duplicated, and should quickly identify the 
Improvement. For example, a Primary Improvement Label “1.0” could be used to identify the first floor of a 
commercial building, or the Appendage Improvement Label “CNP” could be used to identify a Canopy. The 
Improvement Label is displayed on the sketch screen and printed on the Property Record Card for each part of an 
Improvement that is sketched.  

Description: The Description or identifying name of the Improvement Label, such as “Canopy”, is keyed into this 
20-character wide field. 

Label Type: The type of Improvement Label is selected by clicking on the Label Type combo box. There are five 
available types: Addition, Appendage, Interior, Primary, and Upper. IMPORTANT: A Label Type MUST be selected 
for every Improvement Label. 

• The Addition Label is used for an Addition (heated area) to a Commercial Improvement. Areas that are 
labeled as Additions will display as a double black dashed line on the sketch screen. 

• The Appendage Label is used for appendages (non-heated area) to a Commercial Improvement, such as 
porches, decks, and attached garages. Areas that are labeled as Appendages will display as a solid blue 
line on the sketch screen.  
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• The Interior Label is used for "interior" parts of a Commercial Improvement, such as a Second Story, that 
the appraiser wishes to price differently and label separately from the primary heated area of the 
Improvement. Interior Label areas will display as a green dashed line on the sketch screen. 

• The Primary Label is used for the primary heated area of the Commercial Improvement, such as One 
Story, Two Story, etc. Areas that are labeled as Primary will display as a red solid line on the sketch screen. 

• The Upper Label functions in a similar manner as the Primary Label type. The exception being the fact 
that the area factor adjustment will be applied to the area of the polygon and the resulting square 
footage will be will be used in the determination of the area multiplier. The adjusted areas of Upper Label 
type polygons and Primary Label type polygons will be summed to generate the Total Base Area. The Total 
Base Area is then used in the determination of the area multiplier for the improvement. The main 
function of the Upper Label type is to allow the area of upper story levels to be included in the 
determination of the base dollar amount while providing a means of identifying them as upper story 
levels. An existing label can be changed to the Upper Label type in the Improvement Labels schedule, 
reappraise run, and the values on the affected improvement will reflect the revised Area Multiplier. Upper 
Level areas will display as a broken violet line on the sketch screen. 

Cost/SQFT: The Cost/SQFT field contains the cost per square foot for Addition and Appendage Label types. The 
field is disabled for all other Label types. 

Cost Factor: The Cost Factor is used to adjust the value of Commercial Improvements and is used with the Interior, 
Primary, and Upper types of Improvement Labels. The default WinGAP Cost Factor is 1.00 for a First Story Label, 
1.80 for a Two-Story Label, and 0.9 for a Second Story (Interior) Label. These Cost Factors can be changed if desired 
by the appraiser to adjust and localize the pricing of Commercial Improvements. NOTE: The Cost Factor field is not 
used with Appendage and Addition Label types and will also default to 1.00. 

 

Area Factor: The Area Factor is used to adjust the Heated Area of Commercial Improvements and is used with the 
Interior, Primary, and Upper types of Improvement Labels. The default WinGAP Area Factor default is 1.00 for a 
First Story Label, 2.00 for a Two-Story Label, and 1.00 for a Second Story (Interior) Label. These Area Factors can 
also be changed if desired by the appraiser to adjust and localize the calculating of the Heated Area of Commercial 
Improvements. NOTE: The Area Factor field is not used with Appendage and Addition Label types and will also 
default to 1.00. 

 

A NEW Improvement Label can be added to the Improvement Labels schedule by: 

• Clicking the New button. 

• Clicking in the Label field (make sure the cursor is at the far left of the field) and keying the new 
Improvement Label. 

• Using the Tab key to go to the rest of the data entry fields where the new information can be keyed. 

• Clicking the Apply or OK Button to save the data. 

 

Existing Improvement Labels can be edited by clicking on the desired item in the list. NOTE: If the Label is in use, 
the Label field is disabled and cannot be edited; if the Label is not in use, then the Label field is enabled and the 
Label can be changed. The user can click in any of the other data entry fields where the data can be edited, and 
any changes to data are saved by clicking the Apply or OK Button. 

 

An Improvement Label can be deleted from the schedule if it is NOT IN USE on any Commercial Improvement. 
Labels that are in use will have the Delete button disabled. If the Label is not in use, the Delete button will be 
enabled for that Improvement Label, and the user may delete that item by clicking the Delete button. No message 
will appear, and the item will be deleted and removed from the list of Improvement Labels. 
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Print List: In the lower right of the Improvement Labels form is the Print List button, where the user can print a list 
of Parcels that have Residential Improvements where the selected Improvement Label is found. For example, the 
user wants a list of all Residential Improvements that have a 2 Story Label. The user should select the 2 Story Label 
then click the Print List button, and the Print Preview for 2 Story Labels will appear. 

 

 

The list can be printed or just viewed. A different Label can be previewed by keying the desired Label in the “c 
Label” field at the top of the Reporting Services form and then clicking the View Report button. 

 

 

PREFERENCES 

The final item on the Commercial Schedules Menu provides access to the Preferences form. The Preferences form 
is discussed in detail later in this manual. 
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MANUFACTURED HOUSING IMPROVEMENTS 

This option produces the Manufactured Housing Schedules Form. The schedule items on the Manufactured 
Housing Schedules Form are grouped into two types: 

• Size and Area schedule items that assist with calculating the size and area of the Mobile Home. 

• Supplemental schedule items, most of which can be used to adjust the value of the Mobile Home, such as 
Condition and Exterior Walls.  

 

SIZE AND AREA SCHEDULE 

MFG/MODEL LISTING 

The Mfg/Model Listing contains a schedule of most types of Mobile Homes sold or found in the United States. The 
listing can be customized to the County's needs by adding, changing, or deleting entries. 
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The Mfg/Model Listing Form is divided into three sections: 

• The names of Manufacturers of Mobile Homes are displayed in the list box on the left of the Form. The 
user can quickly select a Manufacturer by first clicking in the list box, and then keying the first letter of the 
name of the Manufacturer, such as "R" as in Redman. If necessary, the arrow keys or Page Up or Page 
Down can then be used to move directly to the desired Manufacturer. 

• Once the Manufacturer is located, the user should click on the name, and the Models of Mobile Homes 
made by that Manufacturer will appear in the list box on the right side of the Form. 

• Clicking on a Model Name will then display the Manufacturer name and Model name in the bottom 
section of the Form, along with the Class, which is the Quality of Construction of the Mobile Home, and 
the Life, which is the Life Expectancy for that Mobile Home. Any of these items can be changed, if desired, 
by clicking on the appropriate field and changing the data. 

 

NOTE: For the data on the Mobile Home to display in the fields on the bottom of the Form, the user must click on 
the Manufacturer name in the left list box and then the desired Model name in the right list box. 
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A NEW Mobile Home can be added to the Mfg/Model Listing by clicking the New Button, keying the information in 
the Manufacturer and Model Fields, clicking on the Class and Life combo boxes to select the appropriate Class and 
Life, then clicking the Apply or OK Button. Life assignments usually correspond to the class in the following 
manner: 

 

EX 40 

VG 35 

GD 303 

AV 25 

FR 20 

PR 15 

 

A Mobile Home can be deleted from the Mfg/Model Listing by first selecting the Manufacturer and Model as 
described above, and then clicking the Delete Button. NOTE: WinGAP will check to see if this Manufacturer and 
Model of Mobile Home is used in the Mobile table. If this Manufacturer/Model is not used, it will be deleted from 
the schedule. If this Manufacturer and Model is in use, it will not be deleted and the user will receive the message 
that the "MFG & MODEL are used in your improvement file - delete failed". 

 

BASE RATES 

The Base Rate Table contains data that adjusts the value of Mobile Homes for size, based upon the Quality Class of 
the Mobile Home. The table can be customized to the County's needs by changing entries. 

 

 

First, the appropriate Quality Class of the Mobile Home should be selected on the Size Adjustment Table Form by 
clicking on the Quality Class combo box. The default is Average. The Size Adjustment data can then be changed by 
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clicking in the field corresponding to the Length and Width of the Single Wide or Double Wide Mobile Home. After 
changing the data, the Apply or OK Button can be clicked to save the change. 

 

ADD-ONS 

The Add-Ons schedule is used to price external additions, such as decks and porches. The listing can be customized 
to the County's needs by adding, changing, or deleting entries. NOTE: The Add-Ons schedule should be built prior 
to building the Lump Sum Add-Ons schedule. 

 

 

The Add-Ons Form is divided into two sections. Existing Add-On items are displayed in the list box on the top of the 
Form. Clicking on an item in the list box will display the calculation data about the item in the bottom section of 
the Form. 

 

Comp #: A County-assigned unique four-character identifying code for each type of Mobile Home Add-On. The 
code can be any combination of four letters or numbers. An Edit button is located to the right of the Comp # field. 
The button is placed there to prevent inadvertent changes to the component number. If a component number is to 
be modified, the user must first click the Edit button. 

Description: A Description of the Mobile Home Add-On, normally the name such as Patio, Deck, Open Porch, etc. 

Pricing Method: There are three available Pricing Methods: Lump Sum, Non-Value Item, and Square Foot. Most 
Add-Ons are priced by the Square Foot. Add-Ons priced using the Square Foot method will always have an entry in 
the Base Cost field, but no entry in the Table Code field. If the Lump Sum method is used, normally with items such 
as Fireplaces, there will always be an entry in the Table Code field to link this Add-On item to a record in the Lump 
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Sum Add-Ons Table. An entry in the Lumps Sum Add-Ons Table is required to properly price the item by the Lump 
Sum method. Lump Sum items will not have an entry in the Base Cost field. The Non-Value method is used for Add-
Ons that are descriptive in nature and have no value; these items will not have entries in either the Table Code or 
Base Cost fields. 

Base Cost: If the Add-On is priced by the Square Foot, such as a Porch or Patio, the Base Cost is the dollars per 
square foot value for the selected Add-on. 

No Depreciation: If an Add-On is to remain at 100% Good and not depreciate, the No Depreciation check box 
should be checked. When this type of Add-On is added, its Calculated Physical Depreciation will be 1.00 regardless 
of its Age. 

 

When adding a Lump Sum Add-On, the add and edit processes change slightly. After clicking New, the user should 
key a Comp # and Description, select Lump Sum as the Pricing Method, and click the Apply button. 

 

 

Table Code: The Table Code field will contain a Table Number that connects the Add-Ons schedule item to a 
specific item in the Lump Side pricing tables so that Lump Sum items can be priced properly. Clicking the Table 
Code button will provide access to the Lump Sum Add-Ons form. 
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NOTE: When the Lump Sum pricing method is used, the Table Code item used to price the Lump Side Add-Ons item 
can be added during the Add-Ons add process, or by using the separate Manufactured Housing Schedules Menu 
item called Lump Sum Add-Ons. 

 

Any item in the Add-Ons schedule can be edited by clicking on the item in the list box, changing the information in 
the desired field(s), and clicking the Apply or OK Buttons. NOTE: The Comp # cannot be changed if it is used by any 
Add-On on a Manufactured Housing Improvement. An item can be deleted from the Add-Ons schedule by first 
selecting the item in the list box and then clicking the Delete Button at the bottom of the Form. WinGAP will check 
to see if this item is used by any Manufactured Housing Improvement before the deletion will occur. The complete 
Add-Ons schedule can be printed by using the Reports Menu in the WinGAP tool bar and then Real > Print 
Schedules and selecting the Mfg Housing Add-ons item on the menu. 

 

 

LUMP SUM ADD-ONS 

The Lump Sum Add-Ons schedule is used to price external additions that are priced by the Lump Sum or item 
method. A Lump Sum item in the Add-Ons schedule will have a Table Code that will look up an entry in the Lump 
Sum Add-Ons schedule and price the item accordingly. 
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The Lump Sum Add-Ons Schedule form displays the existing schedule items in the list box on the top of the form. 
The column headings refer to the Description of the Lump Sum Add-Ons item (obtained from the Add-Ons 
schedule), the Tableref code number, the Dimension1 and Dimension2 pointers, the Points (Unit Dollars divided by 
100), and Recno (Record Number) assigned to this Lump Sum item in the Lump Sum (Acc_Tbls) table. The schedule 
is indexed in Description order. The calculation data for each item in the list box can be displayed in the fields on 
the bottom of the form by clicking on an item. 

 

Table Reference: The Table Reference code is a unique County-defined number. Letters or numbers can be used, 
such as 1-99, AA-ZZ, or 1A, 2C. If a numeric Table Reference is less than ten (10), it should be entered as 01 (a zero 
followed by a 1), 02, 03, etc. When adding an item to the Lump Sum Add-Ons schedule, this Table Reference must 
already exist in the Manufactured Housing Add-Ons schedule. WinGAP will assign the Description of the item in the 
Add-Ons schedule with this Table Reference to the Description of the Lump Sum Add-Ons item. If the Table 
Reference of the Lump Sum Add-On does not exist in the Add-Ons schedule, the Description of the Lump Sum Add-
On will say "Not currently assigned". 

Dimension 1: Dimension 1 is used as a pointer in the table for locating the proper value. It can represent various 
characteristics of an Add-On such as Fireplace size, Septic Tank capacity, Central Air BTU capacity, grade code, or 
code for type. The user is responsible for maintaining the definitions of these characteristics. The value must be 
numeric, and 0 is acceptable. 

Dimension 2: The Dimension 2 value is used to further define the valuation of the Lump Sum Add-On item and is 
used in conjunction with Dimension 1 to locate the proper value. The value must be numeric and 0 is acceptable. 

Unit Dollars: The actual dollar cost of the Lump Sum Add-On item. 
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A new item can be added to the Lump Sum Schedule by performing the following steps: 

• Clicking the New Button at the bottom of the Form. 

• Entering the Table Reference # code which is County-defined. 

• Keying the values for the Dimension 1, Dimension 2, and Unit Dollars fields. 

• Clicking the Apply or OK Button to save the item to the schedule. 

 

NOTE: when the user adds a new item to the Lump Sum schedule, the user should return to the Add-Ons 

schedule and do the following: 

• Select the Add-On item in the list box that will have that Table code assigned to it. 

• Click the Table Code button. 

• Select the item in the Lump Sum Add-Ons schedule that is to be used by that Add-On. 

• Click the OK button to place the Table Reference code in the Table Code field on the Add-Ons form. 

• Click OK on the Add-Ons form to save the assignment. 

 

An item can be deleted from the Lump Sum schedule by first selecting the item in the list box and then clicking the 
Delete Button at the bottom of the Form. NOTE: the user should be certain that this Lump Sum Add-On Schedule 
item is not used by any Add-Ons on Manufactured Housing prior to clicking the Delete Button. The complete Lump 
Sum Add-Ons Schedule can be printed by using the Reports Menu in the WinGAP tool bar and then Real > Print 
Schedules and selecting the Mfg Housing Lump Sum Add-ons item on the menu. 
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IMPROVEMENT LABELS 

NOTE: Improvement Labels for Manufactured Homes are descriptive only, and do not contribute to value or area. 

 

Improvement Labels identify sketched areas of a Manufactured Home. The schedule can be customized to the 
County's needs by adding, changing, or deleting entries. The Improvement Labels Form displays the existing 
Improvement Labels with the data entry fields for each Improvement Label item. The following information, from 
left to right, is displayed about each Improvement Label item: 

• Improvement Label 

• Improvement Label Description 

• Cost/SqFt 

• Cost Factor 

• Area Factor 

• Label Type 

• Building Type 

• Whether or not the Label is used as part of Basement Sketching (Always no for Mobile Homes) 

 

Improvement Label schedule items are listed in Improvement Label alphabetical order. The user can press the 
Page Up, Page Down, or arrow keys to move up and down in the list box and locate an Improvement Label, or can 
click with the mouse on the vertical scroll bar and drag it up or down to find the item. Clicking on an Improvement 
Label item in the list box will display the data about that item in the data entry fields at the bottom of the Form. 
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Label: A four-character field (letters, number or symbols are acceptable) where the County defined Improvement 
Label is keyed. An Improvement Label must be unique, cannot be duplicated, and should quickly identify the 
Improvement. For example, a Primary Improvement Label “1ST” could be used to identify a One Story 
Manufactured Home, and the Appendage Improvement Label “OP” could be used to identify an Open Porch. The 
Improvement Label is displayed on the sketch screen and printed on the Property Record Card for each part of an 
Improvement that is sketched. 

Description: The Description or identifying name, such as Deck, of the Improvement Label is keyed into this 20-
character wide field. 

Label Type: The type of Improvement Label is selected by clicking on the Label Type combo box. There are five 
available types: Addition, Appendage, Interior, Primary, and Upper. NOTE: A Label Type MUST be selected for 
every Improvement Label. 

• The Addition Label is used for an Addition to a Manufactured Home Improvement. Areas that are labeled 
as Additions will display as a double black dashed line on the sketch screen. 

• The Appendage Label is used for Appendages to a Manufactured Home, such as canopies and porches. 
Areas that are labeled as Appendages will display as a solid blue line on the sketch screen. 

• The Interior Label is used for "interior" parts of a Manufactured Home, such as a Second Story. Interior 
Label areas will display as a green dashed line on the sketch screen. 
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• The Primary Label is used for the primary heated area of the Manufactured Home, such as One Story, 
Two Story, etc. Areas that are labeled as Primary will display as a red solid line on the sketch screen. 

• The Upper Label functions in a similar manner as the Primary Label type. Upper-Level areas will display as 
a broken blue violet line on the sketch screen. 

Cost/SQFT: The Cost/SQFT field is not used for Manufactured Housing labels and will default to 0.00, 

Cost Factor: The Cost Factor is not used for Manufactured Housing labels and will default to 1.00. 

Area Factor: The Area Factor is not used for Manufactured Housing labels and will default to 1.00. 

 

A new Improvement Label can be added to the Improvement Labels schedule by: 

• Clicking the New button. 

• Clicking in the Label field (make sure the cursor is at the far left of the field) and keying the new 
Improvement Label. 

• Using the Tab key to go to the Label Description and keying the description. 

• Using the Tab key to go to the Label Type and selecting the type of label. 

• Clicking the Apply or OK Button to save the data. 

 

Existing Improvement Labels can be edited by clicking on the desired item in the list box and pressing the Tab key. 
This will take the user to the Label field, where the Label can be changed, or the user can again press the Tab key 
to move on to the other data entry fields where this data can be edited. The data is saved by clicking the Apply or 
OK Button. 

 

An Improvement Label can be deleted from the schedule if it is NOT IN USE on any Mobile Home. Labels that are in 
use will have the Delete button disabled. If the Label is not in use, the Delete button will be enabled for that 
Improvement Label, and the user may delete that item by clicking the Delete button. No message will appear, and 
the item will be deleted and removed from the list of Improvement Labels. 

 

Print List: In the lower right of the Improvement Labels form is the Print List button, where the user can print a list 
of Parcels that have Mobile Homes where the selected Improvement Label is found. For example, the user wants a 
list of all Mobile Homes that have the MM (Multi-Wide) Label. The user should select the MM Label item, then 
click the Print List button, and the Print Preview for MM Labels will appear. 
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The list can be printed or just viewed. A different Label can be previewed by keying the desired Label in the “c 
Label” field at the top of the Reporting Services form and then clicking the View Report button. 

 

 

SUPPLEMENTAL SCHEDULES 

CONDITION 

The Condition schedule is a listing of available Observed Condition types. Condition types are used in the 
adjustment of physical deprecation of the Mobile Home. Each Condition type has a multiplier or factor that is used 
to adjust the depreciation to the level of Observed Condition. The appraiser in each county must decide what 
Condition type will be considered as the base. 
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A New Condition type can be added by clicking the "New" button, keying in the Description and the Cost Multiplier 
in their respective fields, and then clicking "Apply" or "OK". There is no limit to the number of Condition types that 
can be added to the schedule. An existing Condition type can be edited by clicking on the desired item and editing 
the appropriate field(s). At the present time, it is not possible to delete a Condition type. Condition cost multipliers 
should not be changed in a County without performing significant market studies to determine whether the factor 
should be increased or decreased. 

 

EXTERIOR WALLS 

The Exterior Walls schedule provides a listing of the current Exterior Wall types. Exterior Walls are used in pricing 
the Mobile Home. Each Exterior Wall type has a $/Square Foot entry that is used to adjust the value of the Mobile 
Home according to the type of Exterior Wall. The appraiser in each county must decide what Exterior Wall type will 
be considered as the base type of Exterior Wall for the Mobile Home. 
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A New Exterior Wall type can be added by clicking the "New" button, keying in the Description and the $/Sq Ft 
Multiplier in their respective fields, and then clicking "Apply" or "OK". There is no limit to the number of Exterior 
Wall types that can be added to the schedule. An existing Exterior Wall type can be edited by clicking on the 
desired item and editing the appropriate field(s). Exterior Wall types cannot be deleted in WinGAP. Exterior Wall 
multipliers should not be changed in a County without performing significant market studies to determine whether 
the factor should be increased or decreased. 

 

FIREPLACE 

The Fireplace schedule provides a listing of the current Fireplace types as well as other miscellaneous Mobile 
Home items, such as Spas and Hot Tubs that the appraiser wishes to value using the Lump Sum method. The value 
in the Lump Sum $ field is the value of that type of Fireplace or miscellaneous item. For example, if a One Story, 
One Box Constructed Fireplace is to be priced at $1600, the Lump Sum $ value is $1600. 

 

 

A New Fireplace/Lump Sum Valuation item type can be added by clicking the "New" button, keying in the 
Description and the Lump Sum $ in their respective fields, and then clicking "Apply" or "OK". There is no limit to 
the number of Fireplace types that can be added to the schedule. An existing Fireplace type can be edited by 
clicking on the desired item and editing the appropriate field(s). Fireplace types cannot be deleted in WinGAP. 
Fireplace Lump Sum values should not be changed in a County without performing significant market studies to 
determine whether the value should be increased or decreased. 

 

FOUNDATION 

The Foundation schedule provides a listing of the current Foundation types and their associated $/square foot 
values. These $/square foot entries are used to adjust the Mobile Home value for the Foundation type found in the 
Mobile Home. 
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A new Foundation type can be added by clicking the "New" button, keying in the Description and the $/Square 
Feet value in their respective fields, and then clicking "Apply" or "OK". There is no limit to the number of 
Foundation types that can be added to the schedule. An existing Foundation type can be edited by clicking on the 
desired type and editing the appropriate field(s). Foundation types cannot be deleted in WinGAP. 

 

HEATING/AIR 

Heating/Air Conditioning types and their $/square foot entries are stored in the Heating/Air schedule. These 
$/square foot entries are used to adjust the Mobile Home value for the Heating/Air conditioning type found in the 
Mobile Home.  
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A new Heating type can be added by clicking the "New" button, keying in the Description and the $/Square Feet 
value in their respective fields, and then clicking "Apply" or "OK". There is no limit to the number of Heating types 
that can be added to the schedule. An existing Heating type can be edited by clicking on the desired type and 
editing the appropriate field(s). Heating types cannot be deleted in WinGAP. 

 

PLUMBING 

The Plumbing schedule provides a listing of the current Bathroom types that are valued using the Lump Sum 
method. Additional Plumbing Single Fixtures can also be priced using this method. The value in the Lump Sum $ 
field is the value for that type of Bathroom or Singe Fixture. For example, if a Full Bath is to be priced at $2000, the 
Lump Sum $ value is $2000. 

 

 

Since the Mobile Homes Form in WinGAP allows data entry in only the Full, Half, and Single Fixtures fields as far as 
Plumbing value is concerned, the user is not allowed to add New Plumbing types to the Plumbing schedule. The 
value in the Lump Sum $ field for the three Plumbing types - Full, Half, and Single Fixture - can be edited by clicking 
in this field on the Plumbing Form. It is recommended that the Full, Half, and Single Fixture Descriptions not be 
changed, nor should any of the Plumbing types be deleted. Plumbing Lump Sum values should not be changed in a 
County without performing significant market studies to determine whether the value should be increased or 
decreased. 

 

ROOFING 

Roofing types and their $/square foot entries are stored in the Roofing schedule. These $/square foot entries are 
used to adjust the Mobile Home value for the Roofing type found in the Mobile Home. 
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A new Roofing type can be added by clicking the "New" button, keying in the Description and the $/Square Feet 
value in their respective fields, and then clicking "Apply" or "OK". There is no limit to the number of Roofing types 
that can be added to the schedule. An existing Roofing type can be edited by clicking on the desired type and 
editing the appropriate field(s). Roofing types cannot be deleted in WinGAP. 

 

STORY HEIGHT 

The Story Height schedule provides a listing of the current Story Height types for Manufactured Housing. Story 
Height types are descriptive only and add no value to the Mobile Home. 
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A new Story Height type can be added by clicking the "New" button, keying in the type in the Description field, and 
then clicking "Apply" or "OK". There is no limit to the number of Story Height types that can be added to the 
schedule. NOTE: Only the 1, 1.5, and 2.0 Story Heights can be used on the Mobile Homes Form when adding or 
editing a Non-Prebilled or Prebilled Mobile Home. An existing Story Height type can be edited by clicking on the 
desired type and selecting the desired item. Story Height types cannot be deleted in WinGAP. 

 

QUALITY ADJUSTMENTS 

The Quality Adjustments schedule is a listing of available Quality types. Quality Adjustments are applied to the 
Supplemental Schedule items to make the prices commensurate with the quality of the manufactured home. Each 
Quality Adjustment type has a multiplier or factor that is used according to the Quality of Construction of the 
Mobile Home. The appraiser in each county must decide what Quality type will be considered as the base. 

 

 

No additional Quality Classes can be added to the above schedule. An existing Quality Adjustment type can be 
edited by clicking on the desired item and editing the appropriate field(s). Quality Adjustment types cannot be 
deleted in WinGAP. Quality Adjustment multipliers should not be changed in a County without performing 
significant market studies to determine whether the factor should be increased or decreased. 
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ACCESSORIES 

 

 

BUILDING SCHEDULE 

The Building schedule contains a listing of all types of Accessory Improvements found in the County. The listing can 
be customized to the County's needs by adding, changing, or deleting entries. WinGAP is delivered to the County 
with a basic Accessory Building schedule already set up. It is up to the County to modify this schedule for local use.  

NOTE: The Building schedule should be built prior to building the Lump Sum Accessory schedule. 

 

For each type of Accessory Improvement, from left to right, the list box displays: 

• The Description of the item. 

• The Comp # (Component Number). 

• The Method (Calculation Method). 

• The Table (used for Lump Sum items only). 

• The Cost (the Base Cost).  
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Clicking on an item in the list box will display the calculation data about the item in the Pricing Information section 
at the bottom of the Form. 

 

Description: A Description of the Accessory Improvement, normally the name such as Barn, Driveway, Utility 
Building, etc. 

Comp #: A County-assigned unique four-character identifying code for each type of Accessory Improvement. The 
code can be any combination of four letters or numbers. An Edit button is located to the right of the Comp # field. 
The button is placed there to prevent inadvertent changes to the component number. If a component number is to 
be modified, the user must first click the Edit button. NOTE: The Component # must be unique, and not used by 
any other Accessory type; WinGAP will prompt the user if the Comp # already exists in the schedule. 

Pricing Method: There are three available Pricing Methods: Lump Sum, Non-Value Item, and Square Foot. Most 
Accessory Improvements are priced by the square foot. 

• The Non-Value method is used for Accessory Improvements that are descriptive in nature and have no 
value; these items will not have entries in either the Table Code or Base Cost fields.  

• Accessory Improvements priced using the Square Foot method will always have an entry in the Base Cost 
field, but no entry in the Table Code field.  

• If the Lump Sum method is used, normally with items such as Driveways, Fences, or Grain Bins, there will 
always be an entry in the Table Code field to link this Accessory Improvement item to a record in the 
Lump Sum Table. The entry of the Table Code is necessary in order to properly price the item by the Lump 
Sum method. Lump Sum items will not have an entry in the Base Cost field. When adding a Lump Sum 
Accessory, the add and edit processes change slightly. After clicking New, the user should key a Comp # 
and Description, then select Lump Sum as the Pricing Method. At this point, the Apply button should be 
clicked. The Table Code button and field will appear. 

Base Cost: If the Accessory Improvement is priced by the Square Foot, such as a Barn or Swimming Pool, the Base 
Cost is the dollars per square foot value for the selected Accessory Improvement. 

No Depreciation: If the Accessory Improvement is to remain at 100% Good and not depreciate, the No 
Depreciation check box should be checked. When this Accessory Improvement is added, its Calculated Physical 
Depreciation will be 1.00, regardless of its Age. 

Table Code: This field only displays when an item is priced using the Lump Sum method. The Table Code field will 
contain a Table Number that connects the Accessory schedule item to a specific item in the Lump Side pricing 
tables so that Lump Sum items can be priced properly. Clicking the Table Code button will provide access to the 
Lump Sum Tables form. 
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NOTE: When the Lump Sum pricing method is used, the Table Code item used to price the Lump Side Accessory 
type can be added during the add process, or by using the separate Accessories schedules menu item called Lump 
Sum Tables. 
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Any item in the Accessory Building schedule can be edited by clicking on the item in the list box, changing the 
information in the desired field(s), and clicking the Apply or OK Button. NOTE: The Comp # cannot be changed if it 
used by any Accessory Improvement on a Parcel. An item can be deleted from Building schedule by first selecting 
the item in the list box and then clicking the Delete Button at the bottom of the Form. WinGAP will check to see if 
this Accessory Improvement is found on any parcel before the deletion will occur. The complete Building Schedule 
can be printed by using the Reports Menu in the WinGAP tool bar and then Real > Print Schedules and selecting 
the Accessory Building item on the menu.  

 

At the bottom left of the Accessories Building schedule Form is the Print List Button, which will print a parcel 
number listing showing where each accessory improvement is located. For example, the user desires a listing of all 
Barns with Lofts. The Barn with Loft item should be selected in the list box at the top of the Form. Clicking the Print 
List Button will produce a print preview of all the Barns with Lofts. 
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The list can be printed or just viewed. A different Label can be previewed by keying the desired Component 
Number in the COMP_NO field at the top of the Reporting Services form and then clicking the View Report button.  

 

 

SIZE ADJUSTMENT TABLE 

The Size Adjustment Table contains data that adjusts the value of Accessory Improvements for size. This table only 
applies to Accessory Improvements that are priced by the Square Foot method. The table can be customized to the 
County's needs by adding or changing entries. 
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A new entry to the table can be added with the following steps: 

• Click the New Button. 

• Key the square foot level that will define the lower level of the pricing range in the Square Feet From field. 

• Key the square foot level that will define the upper level of the pricing range in the Square Feet To field. 

• Enter the $/ SF amount for the range in the Dollars PSF field. 

• If the price range will be defined as the default size or base range for accessory valuation a check mark 
should be placed in the Base Size box. If the size range is not the base, the Base Size box should be left 
blank. NOTE: Only one size range can be defined as a Base Size. After the Base Size box is checked, it will 
be disabled for all other size ranges until the check mark is removed. 

• Click the Apply or OK Button to save the entry.  

 

A Size Adjustment entry can be changed by clicking in the list box on the appropriate item and then changing the 
desired data. After changing the data, the Apply or OK Button can be clicked to save the change. A Size Adjustment 
entry can be deleted by clicking in the list box on the appropriate item and then clicking the Delete Button. 
WinGAP will warn the user prior to deleting the item from the schedule. 

 

 

LUMP SUM TABLES 

The Lump Sum Table is used to price Accessory Buildings that are priced by the Lump Sum method. A Lump Sum 
item in the Accessory Building Schedule will have a Table Code that will look up an entry in the Lump Sum Schedule 
and price the item accordingly. 

NOTE: The Lump Sum Schedule should be built prior to adding any Accessory Buildings that are priced using this 
method. 
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The Lump Sum Schedule Form displays the existing schedule items. The column headings refer to the Description 
of the Lump Sum Accessory Improvement (obtained from the Accessory Base Schedule), the Tableref code 
number, the Dimension1 and Dimension pointers, the Points (Unit Dollars divided by 100), and the Recno (Record 
Number) assigned to this item in the Lump Sum (Acc_Tbls) table for this type of Lump Sum Accessory 
Improvement. The schedule is indexed in Description order. The calculation data for each item in the list box can 
be displayed in the fields on the bottom of the form by clicking on an item. 

 

Table Reference: The Table Reference code is a unique County-defined number. Letters or numbers can be used, 
such as 1-99, AA-ZZ, or 1A, 2C. If a numeric Table Reference is less than ten (10), it should be entered as 01 (a zero 
followed by a 1), 02, 03, etc. When adding an item to the Lump Sum Accessory schedule, this Table Reference must 
already exist in the Accessory Building Schedule. WinGAP will assign the Description of the item in the Accessory 
Building Schedule with this Table Reference to the Description of the Accessory Lump Sum item. If the Table 
Reference of the Lump Sum does not exist in the Accessory Building Schedule, the Description of the Lump Sum 
item will say "Not currently assigned". 

Dimension 1: Dimension 1 is used as a pointer in the table for locating the proper value. It can represent various 
characteristics of an Accessory Building such as Driveway width or length, Fence height, Grain Bin diameter, or 
code for type. The user is responsible for maintaining the definitions of these characteristics. The value must be 
numeric, and 0 is acceptable. 

Dimension 2: The Dimension 2 value is used to further define the Extra Feature valuation and is used in 
conjunction with Dimension 1 to locate the proper value. The value must be numeric and 0 is acceptable. 

Unit Dollars: The actual dollar cost of the Lump Sum item. 

 



 
316 

A new item can be added to the Lump Sum Schedule by clicking the New Button, entering the Table Reference # 
code which is County-defined, keying the values for the Dimension 1, Dimension 2, and Unit Dollars fields, and 
clicking the Apply or OK Buttons to save the item to the schedule. 

 

NOTE: when the user adds a new item to the Lump Sum schedule, the user should return to the Accessory 

Building schedule and do the following: 

• Select the Accessory Improvement item that will have that Table code assigned to it. 

• Click the Table Code button. 

• Select the item in the Lump Sum Accessory schedule that is to be used by that Accessory. 

• Click the OK button to place the Table Reference code in the Table Code field on the Accessory Building 
schedules form. 

• Click OK on the Accessory Building schedules form to save the assignment. 

 

 

An item can be deleted from the Lump Sum schedule by first selecting the item in the list box and then clicking the 
Delete Button at the bottom of the Form. The user should be certain that this Lump Sum Schedule item is not used 
by any Accessory Buildings prior to clicking the Delete Button. The complete Lump Sum Accessory Schedule can be 
printed by using the Reports Menu in the WinGAP tool bar and then Real > Print Schedules and selecting the 
Accessory Lump Sum item on the menu. 
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ACCESSIBILITY/DESIRABILITY 

The Accessibility/Desirability Table is used in conjunction with the Rural Land Schedule to adjust Rural Land Values 
for location (Accessibility), quality (Desirability), and size. One Accessibility/Desirability value or factor can be used 
per parcel. If the County's Rural Land Schedule uses an Acre Break, whole tract values are used for parcels at acre 
levels that are below the Rural Acre Break, and factors are used for parcels at acre levels that are equal to or 
greater than the Rural Acre Break. The Rural Acre Break is entered in WinGAP on the Preferences Form found in 
Tools > Preferences. Counties that do not utilize a Rural Land Break in the Rural Land Schedule typically use only 
factors to adjust Rural Land Values for location and quality. 

 

 

The Accessibility/Desirability Schedule Form is divided into two sections. At the upper left of the Form, the Acre 
Increment field will display the Accessibility/Desirability Acre Levels. The various Acre Levels in the 
Accessibility/Desirability Schedule can be displayed in one of two ways: the Acre Increment combo box can be 
clicked to display all of the Acre Levels at one time, or the left and right arrow buttons beneath the Acre Increment 
field can be clicked to scroll through the various Acre Levels. 
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Beneath the Acre Increment field is a large window that displays the values and factors that adjust the Rural Land 
Value at each Acre Level. The column headings A-E and row headings 1-9 are used to identify each 
Accessibility/Desirability Class, such as 1-A, 5-C, or 9-E. As each Acre Level is displayed in the Acre Increment field 
on the upper left of the Form, the Accessibility/ Desirability Class values or factors for that Acre Level will display in 
the window below. A Class value or factor is added or edited by clicking on the desired field and keying the new 
value/factor. 

 

An existing Acre Level can be edited by selecting an Acre Level in the Acre Increment field, clicking the Edit Acres 
Button to the right of the field, and keying the new Acre Level. If the factors/values require modification, the Tab 
key will take the user to the Class value/factor window where the new values or factors for each 
Accessibility/Desirability Class at that Acre Level can be keyed. The data is saved by clicking the Apply or OK Button.  

 

A new Acre Level can be added to the schedule by clicking the New Button, keying the new Acre Level in the field 
which will appear to the right of the Edit Acres Button, and then keying the values or factors for each 
Accessibility/Desirability Class in the appropriate field in the Class value/factor window. The Apply or OK Button 
should be clicked to save the data. An Accessibility/Desirability Acre Level can be deleted from the schedule by 
selecting an Acre Level in the Acre Increment field and clicking the Delete Button, which will delete the Acre Level 
from the schedule. 

 

NOTE: If an acre break greater than zero is keyed on the Preferences form, as stated above, the values in the table 
for acre increments less than the acre break will be tract values. However, to perform interpolation correctly, the 
user must enter in the Accessibility/Desirability Schedule an acre increment that is one hundredth of an acre less 
than the acre break and its associated tract values. For example, if an acre break of 30 acres is keyed in 
Preferences, there must be an acre entry of 29.99 in the Accessibility/Desirability table. There must also be an acre 
entry of .01 in the table so that interpolation will be performed correctly. 
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CONSERVATION USE LAND 

The Conservation Use Land option contains the Conservation Use Land Schedule for the County. This schedule is 
normally updated once a year using the Conservation Use values provided to the County by the Department of 
Revenue.  

 

 

The Conservation Use Land Schedule Form shows the per acre Conservation Use Land values for the two land 
types, Agricultural and Timberland, that make up the 1993 Style of Conservation Use. Both Land Types can have up 
to nine Productivity Ratings. The Conservation Use Land values provided to the County by the Department of 
Revenue are keyed into the appropriate Land Type and Productivity Ratings fields, in whole dollars. The Apply or 
OK Button should be clicked to save the data. 

 

 

FLPA SCHEDULES 

The FLPA (Forest Land Protection Act) Schedules option contains the FLPA Schedules for the County. This schedule 
is normally updated once a year using the FLPA values provided to the County by the Department of Revenue. 
Selecting this option will produce the FLPA Schedules sub-menu. 

 

 

The FLPA Land Schedule Form is accessed by clicking on this option on the sub-menu. The Schedule Form shows 
the per acre FLPA Land values for the single Land Type, Woodland. The Woodland Land Type can have up to nine 
Productivity Ratings. The FLPA values provided to the County by the Department of Revenue are keyed into the 
appropriate Productivity Ratings fields, in whole dollars. The Apply or OK Button should be clicked to save the data. 
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The second option on the FLPA Schedules sub-menu takes the user to the FLPA Index Form. The FLPA Index Form is 
delivered to the County with the initial FLPA Year Index already set up. 

 

 

A new FLPA Index item can be added to the schedule by clicking the New button, keying the Index Year and Index 
number for the new item into these fields, and clicking the Apply or OK Button. An FLPA Index item is edited by 
clicking on the item in the list box, changing the information in the desired field(s), and clicking the Apply or OK 
Button. An FLPA Index item can be deleted from the schedule by clicking on the item in the list box and clicking the 
Delete Button, which will delete the item from the schedule. 
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LAND CHARACTERISTICS 

The Land Characteristics item contains schedules that are purely descriptive in nature. The Land Characteristics 
menu item presents a sub-menu with ten descriptive items. 

 

 

DRAINAGE 

The first item on the Land Characteristics sub-menu is the Drainage schedule. It provides a listing of Drainage 
types. Drainage types are descriptive only, and do not affect the value of land. 

 

 

A new Drainage type can be added by clicking the "New" button, keying in the type in the Descrip field, and then 
clicking "Apply" or "OK". There is no limit to the number of Drainage types that can be added to the schedule. An 
existing Drainage type can be edited by clicking on the desired type and editing the Description field. Drainage 
types cannot be deleted in WinGAP. 
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ELECTRICITY 

The Electricity schedule provides a listing of Electricity types. Electricity types are descriptive only, and do not 
affect the value of land. 

 

 

A new Electricity type can be added by clicking the "New" button, keying in the type in the Descrip field, and then 
clicking "Apply" or "OK". There is no limit to the number of Electricity types that can be added to the schedule. An 
existing Electricity type can be edited by clicking on the desired type and editing the Description field. Electricity 
types cannot be deleted in WinGAP. 

 

GAS 

The Gas schedule provides a listing of Gas types. Gas types are descriptive only, and do not affect the value of land. 
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A new Gas type can be added by clicking the "New" button, keying in the type in the Descrip field, and then clicking 
"Apply" or "OK". There is no limit to the number of Gas types that can be added to the schedule. An existing Gas 
type can be edited by clicking on the desired type and editing the Description field. Gas types cannot be deleted in 
WinGAP. 

 

NEIGHBORHOOD 

The Neighborhood schedule provides a listing of Neighborhood types. Neighborhood types are descriptive only, 
and do not affect the value of land. The Neighborhood Land Characteristics schedule is not to be confused with the 
Neighborhoods Schedule, where adjustments to the value of Land and Improvements can be applied. 

 

 

A new Neighborhood type can be added by clicking the "New" button, keying in the type in the Descrip field, and 
then clicking "Apply" or "OK". There is no limit to the number of Neighborhood types that can be added to the 
schedule. An existing Neighborhood type can be edited by clicking on the desired type and editing the Description 
field. Neighborhood types cannot be deleted in WinGAP. 

 

ROAD CLASS 

The Road Class schedule provides a listing of Road Class types. Road Class types are descriptive only, and do not 
affect the value of land. 
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A new Road Class type can be added by clicking the "New" button, keying in the type in the Descrip field, and then 
clicking "Apply" or "OK". There is no limit to the number of Road Class types that can be added to the schedule. An 
existing Road Class type can be edited by clicking on the desired type and editing the Description field. Road Class 
types cannot be deleted in WinGAP. 

 

ROAD TYPE 

The Road Type schedule provides a listing of Road Types. Road Types are descriptive only, and do not affect the 
value of land. 

 

 



 
325 

A new Road Type can be added by clicking the "New" button, keying in the type in the Descrip field, and then 
clicking "Apply" or "OK". There is no limit to the number of Road Types that can be added to the schedule. An 
existing Road Type can be edited by clicking on the desired type and editing the Description field. Road Types 
cannot be deleted in WinGAP. 

 

SEWER 

The Sewer schedule provides a listing of Sewer types. Sewer types are descriptive only, and do not affect the value 
of land. 

 

 

A new Sewer type can be added by clicking the "New" button, keying in the type in the Descrip field, and then 
clicking "Apply" or "OK". There is no limit to the number of Sewer types that can be added to the schedule. An 
existing Sewer type can be edited by clicking on the desired type and editing the Description field. Sewer types 
cannot be deleted in WinGAP. 

 

 

TOPOGRAPHY 

The Topography schedule provides a listing of Topography types. Topography types are descriptive only, and do 
not affect the value of land. 



 
326 

 

 

A new Topography type can be added by clicking the "New" button, keying in the type in the Descrip field, and 
then clicking "Apply" or "OK". There is no limit to the number of Topography types that can be added to the 
schedule. An existing Topography type can be edited by clicking on the desired type and editing the Description 
field. Topography types cannot be deleted in WinGAP. 

 

WATER 

The Water schedule provides a listing of Water types. Water types are descriptive only, and do not affect the value 
of land. 
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A new Water type can be added by clicking the "New" button, keying in the type in the Descrip field, and then 
clicking "Apply" or "OK". There is no limit to the number of Water types that can be added to the schedule. An 
existing Water type can be edited by clicking on the desired type and editing the Description field. Water types 
cannot be deleted in WinGAP. 

 

ZONING 

The Zoning schedule provides a listing of Zoning types. Zoning types are descriptive only, and do not affect the 
value of land. 

 

 

A new Zoning type can be added by clicking the "New" button, keying in the type in the Descrip field, and then 
clicking "Apply" or "OK". There is no limit to the number of Zoning types that can be added to the schedule. An 
existing Zoning type can be edited by clicking on the desired type and editing the Description field. Zoning types 
cannot be deleted in WinGAP. 

 

 

LAND INFLUENCES 

The Land Influences schedule allows the County to define various types of Land Influences that can be applied on 
the parcel level to affect land values. The items in the Land Influences schedule can be accessed for each parcel in 
WinGAP on the upper right side of the Land Information Form at any time that either Urban or Rural Land is added 
or edited. Up to seven different Land Influences, each with a percentage adjustment, can be applied to a parcel. 
Note that the Influence adjustment is applied on the Land Information Form, not on the Land Influences Form; the 
items are purely descriptive on the Land Influences Form itself. 
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These Influences affect the value of the land for each parcel. They can be applied in either a compound 
(multiplicative) or additive manner, based upon how the County wishes to apply Land Influences to land value, and 
they must be either one or the other (cannot be both). The Land Influences combo box in Tools > Preferences is 
used to select either the Compound or Additive type of Land Influence, and the user should see that section of the 
manual for a more detailed discussion of how Land Influences are used to affect land value. 

 

Existing Land Influences are displayed in the list box on the left side of the Land Influences Form. A new Land 
Influence schedule item can be added by clicking the "New" button, keying in the type in the Description field, and 
then clicking "Apply" or "OK". There is no limit to the number of Land Influences that can be added to this 
schedule. However, there is a maximum of seven different Land Influences that can be applied at the parcel level. 
An existing Land Influence schedule item can be edited by clicking on the desired type and editing the Description 
field. Land Influence schedule items cannot be deleted in WinGAP if they are used on any parcel. 

 

RURAL LAND 

This option contains the Rural Land Schedule for the County. The schedule can be customized to the County's 
needs by adding or changing entries. 

 

The valuation of Rural Land involves setting up different Land Types and Productivity Ratings for each Land Type 
based upon the use of the land and the productivity rating of that land. The Rural Land Schedule can be used in 
conjunction with the Accessibility/Desirability Table to apply location and quality adjustments to each parcel and 
produce the best overall value for Rural Land. 
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The Rural Land Schedule Form is divided into two sections. Existing Land Types are displayed in the list box on the 
left side of the Form. The Rural Land Schedule defaults to the Open Land Land Type. Each Land Type can have up to 
nine Productivity Ratings. A new Land Type can be added to the schedule by clicking the New Button, keying the 
description of the Land Type in the Description field, then keying the value per acre, in whole dollars, for this Land 
Type in the Productivity Rating fields. As few as one or as many as nine of the Productivity Rating fields can be used 
for each Land Type. The Apply or OK Button should be clicked to save the data. 

 

A Land Type is edited by clicking on the Land Type item in the list box, changing the information in the desired 
field(s), and then clicking the Apply or OK Button. Rural Land Types cannot be deleted while in use. NOTE: The 
Influences Schedule can also be used to further adjust the value of Rural Land at the parcel level if desired. 

 

SUBDIVISIONS LIST 

The Subdivisions List allows the County to compile a listing of Subdivisions that can be accessed on the Real 
Property General Information Form. The Subdivisions schedule allows the county to identify the Subdivision that 
the parcel is located in. The items in this listing are descriptive only, and do not affect the value of the parcel. 
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Key/Code: A WinGAP assigned numeric Key or Code for each Subdivision. 

Subdivision Name: The County assigned name for the Subdivision. 

Subdivision Date: Subdivision Date is a date field containing the county-defined date when the Subdivision plat 
was recorded or the date the Subdivision was added to the system. 

Update Parcels checkbox: When checked, any updates to the Subdivision List will update the parcels currently 
using this Subdivision entry. The checkbox will notify the user how many parcels are currently assigned to this 
Subdivision. 

 

New Subdivisions can be added by clicking the New button, keying the information, and clicking Apply or OK. 
Existing Subdivisions can be edited by clicking on the desired Subdivision, changing the appropriate data, then 
clicking the Apply or OK Button. Subdivisions can be deleted by clicking on the desired Subdivision, then clicking 
the Delete Button. WinGAP will not allow the user to delete a Subdivision that is currently in use. 

 

TIMBER VALUES 

This menu item contains the schedule where County Timber Values are stored. These Timber Values are used in 
conjunction with the WinGAP Timber Tracking module, but only when the Owner Harvest option is used. The 
Timber Values schedule allows the user to set up all necessary Timber Values for different types of Timber. Values 
keyed into the schedule are supplied by the Department of Revenue on an annual basis in the form of the Owner 
Harvest Table of Values. The schedule can be customized to the County's needs by adding, changing, or deleting 
entries. If no Timber Values have been set up in the schedule, the Timber Values Form will be blank. 

 

 

To add Timber Values, the user should click the New Button and first key the Year in the Year field, then key the 
dollars per ton Timber Value for each Timber type. 

• SWPW: Softwood/Pulpwood 

• SWCS: Softwood/Chip and Saw 

• SWST: Softwood/Saw Timber 

• SWPL: Softwood/Poles 

• SWPO: Softwood/Posts 

• SWFC: Softwood/Fuel Wood - Chips 
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• HWPW: Hardwood/Pulpwood 

• HWST: Hardwood/Saw Timber 

• HWPW: Hardwood/Fuel Wood - Firewood 

 

Years and Timber Values can be added by clicking the New Button, keying the information, and clicking Apply or 
the OK Button.  

 

 

Timber Years and Values can be edited by clicking on the desired year in the Year combo box, changing the 
appropriate data, then clicking the Apply or OK Button. Timber Years and Values can be deleted by clicking on the 
desired year in the Year combo box, then clicking the Delete Button. 

 

 

URBAN LAND 

This option contains a listing of all the Subdivisions/Neighborhoods found in the County. The listing can be 
customized to the County's needs by adding, changing, or deleting schedule items. The valuation of Urban Land 
involves setting up Subdivisions and Neighborhoods within the County. The Subdivision/Neighborhood represents 
a group of parcels where the pricing method and unit cost are consistent throughout. The pricing method refers to 
the method of parcels valuation, i.e., front foot, acre, square foot, or by the lot. Unit cost is the value per unit that 
is assigned by the appraiser. 
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The Urban Land Schedule Form is divided into two sections. Existing Subdivisions/Neighborhoods are displayed on 
the top half of the Form. For each Subdivision, the Subdivision Name, Subdivision Code (assigned by WinGAP), 
Calculation Method, Unit Value, Excessive Units, Excessive Units Adjustment Factor, and the Depth Table are 
displayed. 

 

The Subdivision items in the list box are color coded for easy reference: 

• Yellow = Front Foot 

• Red = Acre 

• Blue = Square Foot 

• Green = Lot 

 

Clicking on an item in the list box will display the calculation data about that Subdivision in the Information and 
Valuation Method sections on the bottom half of the Urban Land Form. 

 

Name: A County-assigned Name for each Subdivision/Neighborhood. The Name can be up to thirty characters in 
length and can be any combination of letters, numbers, or characters. 
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Valuation Method: A Valuation Method must be assigned to every Subdivision. There are four available Valuation 
Methods for Urban Land: Front Foot, Acre, Square Foot, and Lot. The Valuation Method is selected by clicking the 
radio button for the desired method. If the Front Foot method is selected, the number 1 will appear in the 
Calculation Method column in the list box for that Subdivision; if the Acre method is selected, the number 2 will 
appear in the Calculation Method column; if the Square Foot method is selected, the number 3 will appear in the 
Calculation Method column; and if the Lot method is selected, the number 4 will appear in the Calculation Method 
column in the list box for that Subdivision. 

Unit Value: The Unit Value field represents the value per Front Foot, Acre, Square Foot, or Lot for that 
Subdivision/Neighborhood. 

Excessive Units: Excessive Units is normally used when the appraiser wants to reduce the value of land within the 
Subdivision when the land exceeds a certain size. For example, a Subdivision uses the Front Foot Valuation Method 
with a value of $24 per Front Foot. The appraiser determines that subrecords within this Subdivision that have 
Frontage greater than 200 feet should have the Front Foot value reduced by a factor of .85 due to their excessive 
size. 200 would be keyed in the Excessive Units field, and the adjustment of 0.85 would be keyed in the Excessive 
Adjustment Factor field. All four Valuation Methods can utilize the Excessive Units and Excessive Units Adjustment 
Factor as desired by the appraiser. 

Excessive Adj Factor: The Adjustment Factor for the Excessive Units Value. The Factor is usually less than 1.00. If a 
value is keyed in the Excessive Units field, an Adjustment Factor greater than zero must be keyed in this field. 

 

When any Subdivision/Neighborhood record uses the Front Foot Valuation Method, additional options will appear 
on the form. 

 

Default Depth: The Default Depth is the appraiser assigned Default Depth for this Subdivision/ Neighborhood. The 
available depths in the combo box are None, 100, 150, 200, 250, and 300. The Default Depth for the Subdivision 
will appear on the Urban Land section of the Land Information form when the subrecord for this Subdivision is 
added or edited. All Urban Land subrecords for this Subdivision should use this Default Depth. 

Sync Lots to Schedule: When the need arises to change a Subdivisions Default Depth, clicking this button will 
automatically apply the new Depth to all Subdivision records on the Land Information form that use this 
Subdivision schedule item. The message “Used on 0 lots” will change to the number that have been changed. 

 

A new Subdivision/Neighborhood can be added to the schedule by clicking the New Button, keying the information 
in the appropriate fields, and clicking the Apply or OK Button. A Subdivision/Neighborhood is edited by clicking on 
the item in the list box, changing the information in the desired field(s), and then clicking the Apply or OK Button. 

 

A Subdivision/ Neighborhood can be deleted from the schedule by clicking on the item in the list box and then 
clicking the Delete Button, which will delete the Subdivision/Neighborhood item from the schedule. If the 
Subdivision is in use, WinGAP will display the message "Subdivision Code is used in parcel records - you cannot 
delete a schedule item that is used by parcel records". 

 

NOTE: The Influences Schedule can also be used to further adjust the value of Urban Land at the parcel level if 
desired. 
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TAX CALCULATION TABLES 

The Tax Calculation Tables produces a menu where various schedules used for creating Consolidation Reports, 
Estimated Taxes, and other features in WinGAP are set up and maintained. 

 

 

 

TAX DISTRICTS 

The Tax Districts schedule on the Tax Calculation Tables menu allows the user to set up and maintain all necessary 
Tax Districts and their accompanying 40% Values for supplemental digest items such as Heavy Equipment, Motor 
Vehicles, and Mobile Homes, 100% values for Timber, and Freeport Percentages for eligible types of Personal 
Property. The schedule can be customized to the County's needs by adding, changing, or deleting entries. 

 

The Tax Districts Schedule form is divided into two sections. Existing Tax Districts are displayed at the top of the 
Form. Clicking on an item in the list box will display the data about the item in the form’s Values section. Dragging 
the bottom scroll bar in the list box to the right displays additional columns. For each Tax District item, from left to 
right, the following is displayed: 

• Record ID (assigned by WinGAP) 

• Tax District 

• Tax District Description 

• 40% Value for Heavy Equipment 

• 40% Value for Motor Vehicles 

• 40% Value for Mobile Homes 

• 100% Value for Timber 

• Whether the Tax District is considered to be Incorporated (I) or Unincorporated (U) 

• County Freeport Raw Material % 

• County Freeport Finished Goods % 

• County Freeport Out of State % 

• City Freeport Raw Material % 

• City Freeport Finished Goods % 

• City Freeport Out of State % 

• Heavy Equipment Count 

• Motor Vehicle Count 
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• Mobile Home Count 

• Timber Count 

• County Fulfilment Centers Freeport % 

• County Retail Level 2 Freeport % 

• City Fulfilment Centers Freeport % 

• City Retail Level 2 Freeport % 

 

 

A new Tax District and accompanying Values can be added to the Tax Districts schedule by clicking the New Button. 
The user will be taken to the Tax District field, where the next Tax District will be incremented by WinGAP and 
displayed in the field. The Tab key will take the user to the Description and Values fields where the new 
information can be keyed. A checkmark should be placed in the Incorporated Checkbox if the Tax District is an 
Incorporated area. The Apply or OK Button should be clicked to save the data. 

 

Existing Tax Districts and Values can be edited by clicking on the desired item in the list box and then pressing the 
Tab key. This will take the user to the Tax District data field, where the Tax District or Description can be changed, 
or on to the Values section where this data can be edited. The data is saved by clicking the Apply or OK Button. 

 

A Tax District can be deleted from the schedule by clicking on the desired item in the list box and then clicking the 
Delete key. The Tax District will be deleted from the schedule unless it is in use on any parcel. If the Tax District is 
currently in use, WinGAP will display the message "Tax District Code is used in parcel records - you cannot delete a 
tax district item that is used by parcel records". Clicking the OK Button on the message will return the user to the 
Tax Districts Schedule Form. 
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TAX TYPES 

The Tax Types menu produces the Tax Types Schedule form where the County’s various Tax Types are set up based 
upon the Taxing Entity required by the State and/or Local Taxing Authorities. The schedule can be customized to 
the County's needs by adding, changing, or deleting entries. 

 

The Tax Types form is divided into two sections. Existing Tax Types are displayed at the top of the Form. Clicking on 
an item in the list box will display the data about the item in the form’s Details section. For each Tax Type item, 
from left to right, the following is displayed: 

• Record ID (assigned by WinGAP) 

• Tax Type 

• Tax Type Description 

• Taxing Entity Abbreviation  

• Assessment Percentage (usually 40%) 

 

 

A new Tax Type can be added to the Tax Types schedule by clicking the New Button. The user will be taken to the 
Code field, where a County defined Tax Type code is keyed in the field. The Tab key will take the user to the 
Description field where the Description of the new Tax Type can be keyed. From there the Tab key will take the 
user to the Entity Type combo box, where one of the pre-defined Entity Types is selected for the new Tax Type. 
Tab will then take the user to the Assessment % field, where the default is .40. Some cities use Assessment rates 
other than 40%. The Apply or OK Button should be clicked to save the data. 

 

Existing Tax Types can be edited by clicking on the desired item in the list box and then pressing the Tab key. This 
will take the user to the Code data field, where the Code can be changed, or the user can go to any of the other 
fields where the data can be edited. The data is saved by clicking the Apply or OK Button. 
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A Tax Type cannot be deleted from the schedule if it is use: the Delete key will by disabled. If it is not in use, it can 
be deleted by clicking on that item in the list box and then clicking the Delete key. The message “Are you sure you 
want to delete this record?” will appear, and clicking the Yes Button on the message will delete this item; a No 
response will return the user to the Tax Types Schedule Form. 

 

EXEMPTION CODES 

The Exemption Codes menu produces the Tax Exemption Codes Schedule form where the County’s State and Local 
Exemption and Covenant Codes are set up. The schedule can be customized to the County's needs by adding, 
changing, or deleting entries. The Exemption Codes form is divided into two sections. Existing Exemption Codes are 
displayed at the top of the Form. Clicking on an item in the list box will display the data about the item in the 
form’s Details section. For each Exemption code item, from left to right, the following is displayed: 

• Record ID (assigned by WinGAP) 

• Exemption Code 

• Exemption Code Description 

• State Exemption Code Abbreviation  

• Whether the Exemption is a Covenant (C) or Homestead Exemption (H) 

• Exemption Order – not used 

• Local Alias Code for the Exemption 

 

 

A new Exemption Code can be added to the Schedule by clicking the New Button. The user will be taken to the 
Exemption Code field, where a County defined Exemption Code is keyed in the field. The Tab key will take the user 
to the Description field where the Description of the new Exemption or Covenant can be keyed. From there the 
Tab key will take the user to the State Code combo box, where one of the pre-defined Code Types is selected for 
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the new Code or Covenant. The State Code box is required for local homesteads for internal processes to function 
properly. If the local exemption being added is in lieu of other state exemptions, you must still select a valid state 
homestead code and simple mark the local exemption as IN-LIEU of State Exemptions on the Tax-Type Exemption 
configuration form. Tab will then take the user to the Covenant/HS (Homestead) combo box, where the applicable 
selection for the new Exemption or Covenant can be made. Next is the HS Code Sequence field, which is not 
currently used by WinGAP and should be left blank. The last field is the HS Code Alias field, where the local Alias, if 
applicable, can be keyed. The Apply or OK Button should be clicked to save the data. 

 

Existing Exemption Codes can be edited by clicking on the desired item in the list box and then pressing the Tab 
key. This will take the user to the Exemption Code field, where the Code can be changed, or the user can go any of 
the other fields where the data can be edited. The data is saved by clicking the Apply or OK Button. 

 

An Exemption Code can be deleted from the schedule by clicking on the desired item in the list box and then 
clicking the Delete key. The Exemption Code will be deleted from the schedule unless it is in use on any parcel. If 
the Exemption Code is currently in use, WinGAP will display the message "Exemption Code is used in parcel 
records - you cannot delete an Exemption Code item that is used by parcel records". Clicking the OK Button on the 
message will return the user to the Exemption Codes Schedule Form. 

 

OLD EXEMPTION CODES 

The fourth option on the Tax Calculations Tables menu contains the Old Exemption Codes Schedule. This Schedule 
contains the Homestead Exemptions that were used prior to 2012. This Schedule is kept in WinGAP should the 
County need to access very old data. 

 

The existing Old Exemption Codes and Amounts should not be edited or deleted. 

 

MILL RATES 

The Mill Rates menu item produces the Mill Rates Schedule form where the County’s Millage Rates are set up 
based upon the Taxing Entity required by the State and/or Local Taxing Authorities. The schedule can be 
customized to the County's needs by adding, changing, or deleting entries. 

 

The Mill Rates form is divided into two sections. Existing Millage Rates are displayed on the left side of the Form. 
Clicking on an item in the list box will display the data about the item in the fields section on the right side of the 
Form. For each Millage Rate item, from left to right, the following is displayed: 

• Record ID (assigned by WinGAP) 

• Tax District 

• Tax Type Code 

• Mills, shown in thousandths of a Mill 
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A new Millage Rate item can be added to the Mill Rates schedule by clicking the New Button. The user should then 
click on the Tax District combo box, where a County defined Tax District item (obtained from the Tax Districts 
schedule) is selected. The Tab key will take the user to the Tax Type combo box, where an existing Tax Type 
(obtained from the Tax Types schedule) should be selected. From there the Tab key will take the user to the Mill 
Rate field, where the Millage Rate for this item is keyed, expressed as Mills as the message in black indicates. The 
Apply or OK Button should be clicked to save the data. 

 

Existing Millage Rates can be edited by clicking on the desired item in the list box and then pressing the Tab key. 
This will take the user to the Tax District combo box, where the Tax District can be changed, or the user can go to 
any of the other fields where the data can be edited. The data is saved by clicking the Apply or OK Button. 

 

A Millage Rate can be deleted from the schedule by clicking on the desired item in the list box and then clicking the 
Delete key. The Mill Rate item will be deleted from the schedule unless it is in use on any parcel. If a Millage Rate is 
currently in use, WinGAP will display the message "Millage Rate is used in parcel records - you cannot delete a tax 
district item that is used by parcel records". Clicking the OK Button on the message will return the user to the Tax 
Mill Rates Schedule Form. 
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TAX TYPE EXEMPTION 

The Tax Type Exemptions menu option produces the Tax Type Exemption Schedule form where the Tax Type 
Exemptions are set up for each of the County’s Exemption Codes. The schedule can be customized to the County's 
needs by adding, changing, or deleting entries. 

 

The Tax Type Exemption form is divided into two sections. Existing Exemption Codes are displayed on the top of 
the Form. Clicking on an item in the list box will display the data about the item in the form’s fields and checkboxes 
section. For each Exemption code item, from left to right, the following is displayed: 

• Record ID (assigned by WinGAP) 

• Tax Type 

• Exemption Code 

• State Homestead Flag (age 65 and over) 

• In Lieu of (whether this Exemption Item is in Lieu of the State Exemption) 

• Homestead Freeze (Frozen Value) 

• Floating Homestead Exemption for House and Land 

• Unlimited Exemption 

• Maximum Exemption Acres 

• Maximum Exemption Amount 
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A NEW Tax Type Exemption can be added to the Schedule by clicking the New Button. The user should then click 
on the Tax Type combo box, where a County defined Tax Type should be selected. The Tab key will take the user to 
the HS (Homestead) Code combo box where the Homestead Exemption, either Local or State, can be selected. 
From there the Tab key will take the user to the Maximum Exemption Acres field, where, if the selected Exemption 
has a maximum number of Acres, that amount can be keyed. Tab will then take the user to the Maximum 
Exemption amount field, where, if the selected Exemption has a maximum amount, that value can be keyed. Tab 
will then take the user to the State Homestead 65 and over field, which should be checked if it applies to this 
Exemption. The same applies to the In Lieu of State Exemption, the Unlimited Exemption, the Frozen value, and 
the Float for House and Land, any of these that apply to this Homestead should be checked. 

 

Existing Tax Type Exemptions can be edited by clicking on the desired item in the list box and then pressing the Tab 
key. This will take the user to the Tax Type field, where this item can be changed, or the user can go to any of the 
other fields where the data can be edited. The data is saved by clicking the Apply or OK Button. 

 

A Tax Type Exemption item can be deleted from the schedule by clicking on the desired item in the list box and 
then clicking the Delete key. The Tax Type Exemption item will be deleted from the schedule unless it is in use on 
any parcel. If the Tax Type Exemption is currently in use, WinGAP will display the message "Tax Type Exemption 
Code is used in parcel records - you cannot delete a tax type item that is used by parcel records". Clicking the OK 
Button on the message will return the user to the Tax Type Exemption Schedule Form. 

 

FEES 

The Fees menu item produces the Tax Fees schedule form where Fee items are set up for County defined fees that 
are applied to real property parcels. The Fee item is added to the parcel on the Accessory Improvements form. The 
schedule can be customized to the County's needs by adding, changing, or deleting entries. 

 

The Fees form is divided into two sections. Existing Fee items are displayed on the top of the Form. Clicking on an 
item in the list box will display the data about the item in the form’s Details section. For each Fee item, from left to 
right, the following is displayed: 

• Record ID (assigned by WinGAP) 

• Tax District 

• Tax Type 

• Comp No (Component Number, and for Fee items, all are Component Number = LU, which is short for 
Lump Sum) 

• Amount 
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A new Fee item can be added to the Schedule by clicking the New Button. The user should then click on the Tax 
District combo box, where a County defined Tax District should be selected. The Tab key will take the user to the 
Tax Type combo box where a County defined Tax Type can be selected. From there the Tab key will take the user 
to the Fee Item combo box where a County defined Fee item (from the Accessory Improvements Base schedule) 
can be selected. Tab will then take the user to the Amount field, where the Fee amount for this Fee item can be 
keyed. 

 

Existing Fee items can be edited by clicking on the desired item in the list box and then pressing the Tab key. This 
will take the user to the Tax District field, where this item can be changed, or the user can go to any of the other 
fields where the data can be edited. The data is saved by clicking the Apply or OK Button. 

 

A Fee item can be deleted from the schedule by clicking on the desired item in the list box and then clicking the 
Delete key. The Fee item will be deleted from the schedule unless it is in use on any parcel. If the Fee item is 
currently in use, WinGAP will display the message "This Fee item is used in parcel records - you cannot delete a Fee 
item that is used by parcel records". Clicking the OK Button on the message will return the user to the Tax Fees 
schedule Form. 

 

SALE REASONS 

The Sales Reasons schedule allows the user to set up all Sale Reason Codes and Sale Reason descriptions for Sales. 
The schedule can be customized to the County's needs by adding, changing, or deleting entries. The Sale Reasons 
Schedule Form is composed of a list box where the existing Reasons are displayed with the data entry fields for 
each Reason item below the list box. For each item in the list box, from left to right, the Reason Code and the 
Reason are displayed. Reason items are listed in Code order. Clicking on a Reason item in the list box will display 
the data about that item in the data entry fields at the bottom of the form. 
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Code: A two-character field (letters, number or symbols are acceptable) that is County-defined to identify the 
Reason. A Reason Code must be unique and cannot be duplicated. The Codes FM (Fair Market) and LM (Land 
Market) are reserved for Sales Reasons. 

Reason: The Reason description is keyed into this 47-character wide field. 

Arm’s Length Transaction: This checkbox is used to designate sales that are considered by law to be an “Arm’s 
Length Transaction”, meaning a sale in which the buyer and seller acted independently without one party 
influencing the other. This is the only type of sale which can be used to obtain the SB346 designation on a parcel, if 
the sale price is less than the value the County Assessor’s Office has placed on the parcel. A Fair Market (FM) sale 
and a Fair Market - Vacant (LM) sale, also called a Land Market sale, are automatically considered to be Arm’s 
Length Transactions. The County can also apply the Arm’s Length Transaction status to other types of sales, such as 
Multiple Transactions, that would allow the property to be valued by SB346 standards. 
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A NEW Sale Reason can be added to the Sale Reasons schedule by clicking the New Button, keying the new Sale 
Reason Code, pressing the Tab key to go to the Reason field and keying the Sale Reason, clicking in the Arm’s 
Length Transaction checkbox if applicable for this Sale Reason, and clicking the Apply or OK Button to save the 
entry.  

 

Existing Sale Reasons can be edited by clicking on the desired item in the list box and then pressing the Tab key. 
This will take the user to the Code field, where the Code can be changed, or the user can again press the Tab key to 
move on to the Reason field where this data can be edited. The data is saved by clicking the Apply or OK Button. 

 

A Sale Reason can be deleted from the schedule by clicking on the desired item in the list box and then clicking the 
Delete key. A Confirm Delete window will appear where the message "Do you really want to delete this sale 
reason? This reason is used by 51050 Real Property sales." will be displayed. Any Sale Reason that is currently used 
by Sales on parcels should not be deleted. The "Yes" Button can be clicked to delete the Reason from the Schedule 
while hitting Enter or clicking the default "No" will retain the Reason. 
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ASSESSMENT REASONS 

The Assessment Reasons schedule allows the user to set up all Assessment Reason Codes and Assessment Reason 
descriptions that will be printed on Assessment Notices. The schedule can be customized to the County's needs by 
adding, changing, or deleting entries. 
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The Assessment Reasons Schedule Form is composed of a list box, where the existing Assessment Reasons are 
displayed, with the data entry fields for each Assessment Reason item below the list box. For each item in the list 
box, from left to right, the Assessment Reason Code, the Assessment Reason, and the Property Type (A for All 
Property Types, R for Real Property, P for Personal Property) are displayed. Assessment Reason items are listed in 
Code order. Clicking on an Assessment Reason item in the list box will display the data about that item in the data 
entry fields at the bottom of the Form. 

 

Code: A two-character field (letters, number or symbols are acceptable) that is County-defined to identify the 
Assessment Reason. An Assessment Reason Code must be unique and cannot be duplicated. The Codes FM (Fair 
Market) and LM (Land Market) are reserved for Sales Reasons. 

Reason: The Assessment Reason associated with the Code is keyed into this 50-character wide field. This Reason 
will be printed on the Assessment Notice. 

Property Type: Reasons can be further defined by the Type of Property. There are three available Property Types: 
All, Personal, and Real. The user can click on the combo box to select the type, or key the first letter (A, P, or R) to 
select the type. 

COA Type: Below the Property Type combo box on the bottom left side of the Assessment Reasons form is the 
COA Type (Change of Assessment Type) checkbox section. If the Property Type is Real or All, this checkbox section 
will be available (it is disabled for Personal Property). The user MUST define the Change of Assessment Type, either 
Inflationary, Real Growth, or Parcel Split/Combination for that Reason. The user will not be allowed to exit the 
form until a COA Type has been selected if the Property Type is Real or All. 

NOTE: See the section entitled "Change of Assessment Reasons and Growth", below, for a further discussion of 
how the Change of Assessment Type is applied to Assessment Reasons. 
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A NEW Assessment Reason can be added to the Assessment Reasons schedule by clicking the New Button, keying 
the new Assessment Reason Code, keying the Assessment Reason, selecting the desired Property Type, selecting 
the correct COA Type for the Assessment Reason (checkboxes available only for Real and All), and clicking the 
Apply or OK Button to save the entry. 

 

Existing Assessment Reasons can be edited by clicking on the desired item in the list box and then pressing the Tab 
key. This will take the user to the Code field, where the Code can be changed, or the user can again press the Tab 
key to move to the other Assessment Reason fields where this data can be edited. The data is saved by clicking the 
Apply or OK Button. 

 

An Assessment Reason can be deleted from the schedule by clicking on the desired item in the list box and then 
clicking the Delete key. A Confirm Delete window will appear where the message "Do you really want to delete this 
assessment reason? This reason is used by 12 Real Property parcels.” will be displayed. Any Assessment Reason 
that is currently used by on parcels should not be deleted. The "Yes" Button can be clicked to delete the 
Assessment Reason from the Schedule if desired; hitting Enter or clicking the default "No" will retain the 
Assessment Reason. 

 

 

CHANGE OF ASSESSMENT REASONS AND GROWTH 

To facilitate the determination, calculation, and reporting of growth for real property, the functionality of defining 
the type of growth associated with a COA (Change of Assessment) reason has been placed on the Reasons and 
Assessment Reasons screens. 
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The assignment of the COA Type is critical to the digest submission procedure due to the need to determine the 
amount of inflationary growth within an appraisal/digest year. The user should be careful in making the correct 
assignment due to the potential impact on digest submission. The COA Type assignment will be printed along with 
the COA reason as part of the Digest Submission Reports and reviewed for correctness by DOR personnel. Change 
Of Assessment reasons are assigned one of three COA types: Inflationary, Real Growth, or Parcel 
Split/Combination. 

 

An Inflationary assignment is made if the COA reason indicates that a change in value is due to reassessment. 
Reassessment can also be categorized as revaluation or reappraisal and associated with a change in property 
valuation schedules or a change to a parcel’s property characteristics. When assigned to a parcel, a reason with a 
COA Type of Inflationary will result in the change in value in its entirety or a portion of the value changed being 
placed in the inflationary growth field. 

 

Real Growth is assigned to a reason when the reason depicts a change in property value that is due to the addition 
or deletion of property components. Reasons that are not characteristic of a value change, such as an ownership 
change, should be assigned a Real Growth COA Type. Reasons with a Real Growth COA Type will not contribute to 
inflationary growth. 

 

The Parcel Split/Combination COA Type is assigned when the reason defines the fact that the parcel has been split 
or combined with a new parcel or the acreage or lot dimensions have been changed due to a survey or correction 
in a deed. A Parcel Split/Combination reason will not contribute to inflationary growth. 

 

The following table is provided to give the user some examples of reasons/value change situations and proper COA 
Type assignments. 

 

COA Reason COA Type 

Change in Ownership Real 

Parcel split Split/Combination 

Parcels combined Split/Combination 

Acreage/Land Dimension Change Split/Combination 

Improvement added Real 

Improvement deleted Real 

Addition to Existing Improvement Real 

Removal of Area from Existing Imp Real 

Improvement remodeled Real 

Improvement Characteristics Modified (grade, 
exterior walls, physical depreciation, obsolescence, 
% complete, etc.) 

Inflationary 

Reassessment/Revaluation Inflationary 

Zoning Change Inflationary 

Accessibility/desirability Change Inflationary 

Land Use Change Inflationary 
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Land Class Change Inflationary 

Covenant application accepted Real 

Covenant application denied Real 

Schedules Updated Inflationary 

 

When a COA Type is changed on the Assessment Reasons screen, WinGAP will sync the COA Type with reasons 
that have been assigned to a parcel. The user will not be required to modify each parcel to implement the change. 

 

ASSIGNING REASONS TO A PARCEL 

When parcels are assigned a reason with the Asmt Reason button, the COA Type from the Reasons table will be 
saved in the Asmtrsn.dbf along with the reason code and definition. 

 

 

If a Custom Reason is added, the user will be provided a form that will allow for the COA Type assignment. The 
user will need to check one of the three options before the reason will be accepted. 
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If the county has Auto Reasons turned on (Tools > Preferences), COA Types will be saved along with the Auto 
Reason. The COA Type assignments for the auto reasons have been made by DOR personnel and are as follows. 

 

Auto COA Reason COA Type 

Land Split into two or more parcels Split/Combination 

Parcel acreage changed Split/Combination 

New Property (real parcel) added Real 

Parcel deleted Real 

New Residential Improvement added Real 

Residential Improvement characteristics modified Inflationary 

Residential Improvement deleted Real 
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New Commercial Improvement added Real 

Commercial Improvement characteristics modified Inflationary 

Commercial Improvement deleted Real 

New Accessory Improvement added Real 

Accessory Improvement characteristics modified Inflationary 

Accessory Improvement deleted Real 

New Manufactured Housing Improvement added Real 

Manufactured Housing Improvement 
characteristics modified 

Inflationary 

Manufactured Housing Improvement deleted Real 

Ownership changed Real 

 

REAPPRAISE 

Any reason assigned during the reappraise process must be designated as an Inflationary COA Type. WinGAP will 
not allow the assignment of a reason if it is not inflationary in the reason table. Any custom reason added during 
reappraise will automatically be designated as Inflationary. 

 

PROCESSING COA TYPES AND GROWTH VALUES 

Before advertising millage rates and digest submission, the amount of inflationary growth for each parcel must be 
determined. The assignment of COA reasons and their associated COA Types during the data entry of information 
related to parcels and reappraising when schedules were updated comprise the first step in the process of 
determining growth amounts. The second and final step involves running a growth procedure to segregate real 
growth and inflationary growth. The procedure will check the COA reasons assigned to each parcel for their COA 
Type and process the change in value accordingly. 

 

A COA Type of Inflationary will result in the difference between current value and previous value being calculated 
as inflationary growth. New construction will be deducted from the inflationary growth. 

 

Real growth COA Types will result in no contribution to inflationary growth. The value difference between current 
and previous value will be considered as real growth. If an inflationary reason is also assigned to the parcel, a 
portion of the value difference may contribute to inflationary growth. 

 

In situations where a COA reason with a Split/Combination COA Type exists on a parcel, no inflationary growth will 
be calculated. In addition, parcels with a zero previous value will not be assigned any inflationary growth 
regardless of the COA Type. 

 

The Growth procedure can be run from within WinGAP after all users have closed WinGAP by going to the Tools > 
File Maintenance and selecting either Growth Calculations – Normal or Growth Calculations and LOCK. 
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The routine above will generate a Growth report with the inflationary growth segregated by tax districts. Also, if 
the county has homestead exemptions which utilize a base homestead value and a current homestead value, a 
reassessment exemption will be calculated and placed on the report. 

 

OVERRIDE REASONS 

The Override Reasons schedule allows the user to set up all Override Reason Codes and Override Reason 
descriptions that will be used when an Override Value is applied to a parcel. The schedule can be customized to 
the County's needs by adding, changing, or deleting entries. 

 

 

The Override Reasons schedule Form is composed of a list box where the existing Override Reasons are displayed 
with the data entry fields for each Override Reason item below the list box. For each item in the list box, from left 
to right, the Override Reason Code, the Override Reason, and the Property Type are displayed. Override Reason 
items are listed in Code order. Clicking on an Override Reason item in the list box will display the data about that 
item in the data entry fields at the bottom of the Form. 

 

Code: A two-character field (letters, number or symbols are acceptable) that is County-defined to identify the 
Override Reason. An Override Reason Code must be unique and cannot be duplicated. The Codes FM (Fair Market) 
and LM (Land Market) are reserved for Sales Reasons, and the Code “^^” is reserved for the A299C Auto-Reason 
used for Appeals of that nature. 

Reason: The Override Reason associated with the Code is keyed into this 50-character wide field. 

Property Type: Reasons can be further defined by the Type of Property. There are three available Property Types: 
All, Personal, and Real. The user can click on the combo box to select the type, or key the first letter (A, P, or R) to 
select the type. 
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A new Override Reason can be added to the Override Reasons schedule by clicking the New Button, keying the 
new Override Reason Code, keying the Override Reason, selecting the desired Property Type, and clicking the 
Apply or OK Button to save the entry. 

 

Existing Override Reasons can be edited by clicking on the desired item in the list box and then pressing the Tab 
key. This will take the user to the Code field where the Code can be changed, or the user can again press the Tab 
key to move to the other Override Reason fields where this data can be edited. The data is saved by clicking the 
Apply or OK Button. 

 

An Override Reason can be deleted from the schedule by clicking on the desired item in the list box and then 
clicking the Delete key. A Confirm Delete window will appear where the message "Do you really want to delete this 
override reason? This reason is used by 5 Real Property parcels.", as seen below, will be displayed. Any Override 
Reason that is currently used by parcels should not be deleted. The "Yes" Button can be clicked to delete the 
Override Reason from the Schedule if desired; hitting Enter or clicking the default "No" will retain the Override 
Reason. 

 

 

NEIGHBORHOODS 

The Neighborhoods schedule item is used to set up Neighborhoods and apply Neighborhood Adjustment Factors 
to modify property values due to a particular location within the County. These Neighborhood Adjustment Factors 
can increase or decrease Rural or Residential Land Values, Residential or Commercial Improvement Values, or 
Accessory Improvement values for a specific Neighborhood. The schedule can be customized to the County's needs 
by adding, changing, or deleting entries. 
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The Neighborhoods Form is composed of a list box where the existing Neighborhoods are displayed, with the data 
entry fields for each Neighborhood item below the list box. The following information, from left to right, is 
displayed about each Neighborhood item in the list box: Neighborhood Code, Neighborhood Description, Rural 
Land Adjustment Factor, Residential Land Adjustment Factor, Residential Improvements Adjustment Factor, 
Commercial Improvements Adjustment Factor, and Accessory Improvements Adjustment Factor. Neighborhood 
schedule items are listed in Neighborhood Code order. Clicking on a Neighborhood item in the list box will display 
the data about that item in the data entry fields at the bottom of the Form. 

 

Code: A five-character field (letters, numbers, or symbols are acceptable) that is County-defined to identify the 
Neighborhood. A Neighborhood Code must be unique and cannot be duplicated. An Edit button is located to the 
right of the Code field. The button is placed there to prevent inadvertent changes to the Neighborhood Code. If a 
Code number is to be modified, the user must first click the Edit button. NOTE: if the Neighborhood Code is in use 
on a parcel, the Edit button is disabled and the Code cannot be changed. 

Description: The Description or identifying name of the Neighborhood is keyed into this 50 character wide field. 

Rural Land: The first of the Adjustments fields is where the Rural Land Adjustment Factor is keyed. This Factor will 
modify calculated Rural Land values within a Neighborhood, but will not adjust override Rural Land values. The 
range is from 0.01 to 9.99. If no Adjustment Factor is to be applied for Rural Land for the Neighborhood, 1.00 
should be keyed. If 0.00 is keyed as the Adjustment Factor, WinGAP will change the 0.00 to 1.00 when the Apply or 
OK Button is clicked. 

Res Land: The Residential Land Adjustment Factor is keyed in this field. This Factor will modify calculated 
Residential Land values within a Neighborhood, but will not adjust override Residential Land values. The range is 



 
355 

from 0.01 to 9.99. If no Adjustment Factor is to be applied for Residential Land for the Neighborhood, 1.00 should 
be keyed. If 0.00 is keyed as the Adjustment Factor, WinGAP will change the 0.00 to 1.00 when the Apply or OK 
Button is clicked. 

Res Imp: The Residential Improvements Adjustment Factor is keyed in this field. This Factor will modify calculated 
Residential Improvement values within a Neighborhood, but will not adjust override Residential Improvement 
values. The range is from 0.01 to 9.99. If no Adjustment Factor is to be applied for Residential Improvements for 
the Neighborhood, 1.00 should be keyed. If 0.00 is keyed as the Adjustment Factor, WinGAP will change the 0.00 
to 1.00 when the Apply or OK Button is clicked. 

Com Imp: The Commercial Improvements Adjustment Factor is keyed in this field. This Factor will modify 
calculated Commercial Improvement values within a Neighborhood, but will not adjust override Commercial 
Improvement values. The range is from 0.01 to 9.99. If no Adjustment Factor is to be applied for Commercial 
Improvements for the Neighborhood, 1.00 should be keyed. If 0.00 is keyed as the Adjustment Factor, WinGAP will 
change the 0.00 to 1.00 when the Apply or OK Button is clicked. 

Accessory Imp: The Accessory Improvements Adjustment Factor is keyed in this field. This Factor will modify 
calculated Accessory Improvement values within a Neighborhood, but will not adjust override Accessory 
Improvement values. The range is from 0.01 to 9.99. If no Adjustment Factor is to be applied for Accessory 
Improvements for the Neighborhood, 1.00 should be keyed. If 0.00 is keyed as the Adjustment Factor, WinGAP will 
change the 0.00 to 1.00 when the Apply or OK Button is clicked. 

 

A new Neighborhood item can be added to the schedule by clicking the New Button at the bottom of the Form, 
clicking the Edit Button, keying a County-defined Neighborhood Code, keying the Description, keying values into 
the five Adjustments fields, and clicking the Apply or OK Button. 

 

Existing Neighborhoods can be edited by clicking on the desired item in the list box and then pressing the Tab key. 
This will take the user to the Edit button, which must be clicked to gain access to the Code field, if necessary. The 
user can again press the Tab key to move on to the other data entry fields where this data can be edited. The data 
is saved by clicking the Apply or OK Button. 

 

A Neighborhood can be deleted from the schedule by first clicking on the desired item in the list box and then 
clicking the Delete key. The Neighborhood will be deleted from the schedule unless it is in use on any parcel; if this 
is the case, WinGAP will display the message "Neighborhood Code is used in parcel records -you cannot delete a 
schedule item that is used by parcel records". Clicking the OK Button on the message will return the user to the 
Neighborhoods Form. 

 

STREET DIRECTORY 

The Street Directory schedule item is used to set up and maintain a listing of all of the streets and roads in the 
County. This schedule can then be accessed on the Real Property General Information form, the Personal Property 
General Information form, and the Prebilled Manufactured Housing form, and allow the County to set up and 
maintain all the streets on these properties in a uniform manner. 
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Any street on the Street Directory schedule form can be quickly located by clicking one of the 3-letter buttons at 
the top of the form. For example, the user can click the JKL button to reach streets that begin with the letter J. All 
the Js, Ks, and Ls, and the rest of the streets in the County, will display on the form. The number of Real property 
parcels, Personal property accounts, and Prebilled Manufactured Housing items that are located on this Street will 
display in the lower left of the form. 
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A new Street Directory item can be added to the schedule by clicking the New Button at the bottom of the Form, 
keying the Name of the Street into the Name field near the bottom of the form, and clicking the Apply or OK 
Button. NOTE: DO NOT enter the Street Direction, such as East, or the Street Type, such as RD, in this field. There 
are separate fields for the Street Direction and Street Type on the Property Information forms. 

 

Existing Street Names can be edited by clicking on the desired item in the list box and then clicking in the Name 
field where the Street Name can be edited. To the right of the Name field is a checkbox which can be used to 
automatically update the Property Information forms with any change made to the Street Name. The checkbox is 
checked by default. The text to the right of the checkbox field will tell the user how many Street Names will be 
changed when the user clicks Apply or OK. If the user does not wish to automatically update the Name field on the 
Property Information forms, the check should be removed from the checkbox by clicking in it. The change is saved 
by clicking the Apply or OK Button. 

 

A Neighborhood can be deleted from the schedule by first clicking on the desired item in the list box and then 
clicking the Delete button. The Street Name will be deleted from the schedule unless it is in use on any parcel, 
account, or prebilled mh. If this is the case, WinGAP will display the message "Street Name is in use on property - 
delete effort denied". Clicking the OK Button on the message will return the user to the Street Directory Form. 
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ZIP CODE DIRECTORY 

The Zip Code Directory provides a listing of all United States Post Office recognized Zip Codes in the United States. 
It is used to validate Zip Codes when they are entered on the Owner Information Form. The Zip Code Directory 
cannot be added to or modified on the Zip Code Form itself, it can only be added to on the Owner Form. 

 

The Zip Code Directory Form is comprised of a list where the Zip Code, City and State are displayed, left to right. 
Zip Code Directory items are listed in Zip Code order. The user should keep in mind that the Zip Code Directory is 
an extremely large table and moving through it can be very slow. 

 

 

When a user keys a Zip Code in the Zip field on the Owner Form and navigates to another field, WinGAP checks to 
see if the Zip Code exists in the Zip Code Directory. If it does, it will check to see if the City and State keyed by the 
user matches the City and/or State for that Zip Code in the Zip Code Directory. If the City and State match, the user 
proceeds to the next field. If the City and State do not match, the user will be prompted and asked if the City 
and/or State that was entered on the Owner Information Form should be changed. If the Zip Code does not exist in 
the Zip Code Directory, WinGAP will display the message "Your Zip code was not found in the zip code validation 
table. Would you like to update the zip code validation table?" The "Yes" Button can be clicked to add the new Zip 
Code to the Zip Code Directory, while hitting Enter or clicking the default "No" will not add the Zip Code.  

 

DISCOVERY SOURCES 

The Discovery Sources schedule is used with Personal Property to identify the "source" from which the Assessor’s 
Office first "discovered" or obtained information about the Personal Property Account. Information found in this 
schedule appears in the Discovery Source combo box on the Personal Property General Information Form, where 
the user can select the appropriate Discovery Source for the Account. The schedule can be customized to the 
County's needs by adding, changing, or deleting entries. 
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The Discovery Sources schedule form consists of just one data entry item, the Discovery Source. A list on the left 
side of the form displays the existing Discovery Source items. Items are displayed in alphabetical order in the box. 
Clicking on a Discovery Source in the box will display the description of that Discovery Source in the data entry field 
to the right of the list box. Discovery Source descriptions can be up to 30 characters in length. 

 

 

A new Discovery Source can be added to the schedule by clicking the New Button. The user will be taken to the 
Discovery Source field, where the new description can be entered. The Apply or OK Button should be clicked to 
save the data. 

 

Existing Discovery Sources can be edited by clicking on the desired item in the list box and then pressing the Tab 
key. This will take the user to the Discovery Source field, where the description can be changed. The data is saved 
by clicking the Apply or OK Button. The change to the Discovery Source description will be automatically applied to 
the Discovery Source description on any Personal Property Account that has this Discovery Source. 

 

A Discovery Source can be deleted from the schedule, if not in use on an account, by first clicking on the desired 
item in the list box and then clicking the Delete Button. The Discovery Source will be deleted from the schedule, 
returning the user to the Discovery Sources Form. If the Discovery Source item is in use on an Account, the user 
will receive the message “This discovery source is in use on PP Accounts – delete request denied”. 

 

PERMIT TYPES 

The Permit Types Schedule contains a listing of all Building Permit Types. One of these Permit Types can be 
selected whenever a Permit is added or edited on the Building Permits form, reached from the Real Property, 
Personal Property, or Prebilled Manufactured Housing General Information forms. The Permit Types schedule can 
be customized to the County's needs by adding, changing, or deleting entries. 
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The Permit Type Schedule form consists of just one data entry item, the Description of the Permit Type. A list box 
on the left of the form displays the existing Permit Types items. Permit Types are displayed in alphabetical order in 
the list box. Clicking on a Permit Type item in the list box will display that item in the Description data entry field to 
the right of the list box. Descriptions can be up to 30 characters in length. 

 

A new Permit Type can be added to the schedule by clicking the New Button. The user will be taken to the 
Description field, where the new Permit Type can be entered. The Apply or OK Button should be clicked to save the 
data. Existing Permit Types can be edited by clicking on the desired item in the list box and then pressing the Tab 
key. This will take the user to the Description field, where the information can be changed. 

 

At the bottom of the Permits form is a checkbox which can be used to automatically update the Permit Type field 
on any Permits with the change made to the Permit Type Description. The checkbox is checked by default. The text 
to the right of the checkbox field will tell the user how many Permits will be changed when the user clicks Apply or 
OK. If the user does not wish to automatically update the Permit Type Description on these Permits, the check 
should be removed from the checkbox by clicking in it. The change to the Permit Type Description is saved by 
clicking the Apply or OK Button. 

 

A Permit Type can be deleted from the schedule by first clicking on the desired item in the list box and then clicking 
the Delete Button. The Permit Type will be deleted from the schedule, returning the user to the Permit Types 
Form. When deleting a Permit Type that is used on a Permit, the user should be sure this should be done. 

 

BUSINESS LICENSE TYPES 

The Business License Types Schedule item on the Tools > Schedules/Tables Menu contains a listing of all Business 
License Types. One of these Types can be selected whenever a Business License is added or edited on the Business 
License form, reached from the Real or Personal Property General Information forms. Information found in this 
schedule appears in the Business License Types combo box on the Business License form, which is reached from 
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the Real or Personal Property General Information Forms. The schedule can be customized to the County's needs 
by adding, changing, or deleting entries. 

 

The Business License Types schedule form consists of just one data entry item, the Business License Type. A list on 
the left side of the form displays the existing Business License Type items. Items are displayed in Business Type key 
order. Clicking on a Business License Type in the box will display the description of that Business License Type in 
the data entry field to the right of the list box. Business License Type descriptions can be up to 30 characters in 
length. 

 

 

A new Business License Type can be added to the schedule by clicking the New Button. The user will be taken to 
the Business License Type field, where the new description can be entered. The Apply or OK Button should be 
clicked to save the data. 

 

Existing Business License Types can be edited by clicking on the desired item in the list box and then pressing the 
Tab key. This will take the user to the Business License Type field, where the description can be changed. The data 
is saved by clicking the Apply or OK Button. The change to the Business License Type description will be 
automatically applied to the Business License Type description on any Business License that has this Business 
License Type. 

 

A Business License Type can be deleted from the schedule, if not in use on any Business License, by first clicking on 
the desired item in the list box and then clicking the Delete Button. The Business License Type will be deleted from 
the schedule, returning the user to the Business License Type Form. If the Business License Type item is in use on 
any Business License, the user will receive the message “Delete request denied. Schedule items are used in 
Business License table”. 

 

 

CUSTOM FLAGS 

The Custom Flags schedule form contains a listing of all Custom Flag types. The Flags schedule is accessed on the 
Real Property General Information form. These Flags are typically used to handle various Administrative tasks 
regarding a Real Property parcel, such as checking the Homestead Application to make sure it is accurate and 
properly assigned on the parcel. 
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The Custom Flags form is composed of a list box where the existing Custom Flags are displayed, with the data entry 
fields for each Custom Flag item below the list box. The following information, from left to right, is displayed about 
each Custom Flag item in the list box: Custom Flag Code, the Flag Description, and the Property Type code, in this 
case R; at the present time, Custom Flags are available for Real Property only. Custom Flag schedule items are 
listed in Code order. Clicking on a Custom Flag item in the list box will display the data about that item in the data 
entry fields at the bottom of the Form. 

 

 

Code: A two-character field (letters, numbers, or symbols are acceptable) that is County-defined to identify the 
Custom Flag. A Custom Flag Code must be unique and cannot be duplicated. 

Reason Type: Only one type is available in this combo box field, Custom Flags. 

Reason: The Description of the Custom Flag is keyed into this 50-character wide field. 

Property Type: There are three available Property Types: All, Personal, and Real. The user can click on the combo 
box to select the type. Note: at the present time, Custom Flags are available for Real Property only. 

 

Displayed in the bottom center of the Custom Flags form is the Real Count of how many parcels a particular 
Custom Flag on found on. To the right of the Real Count number is the Purge From All Properties button, which will 
purge a selected Custom Flag from all parcels that have that Flag. 

 

A new Custom Flag item can be added to the schedule by clicking the New Button, keying a County-defined Code 
for the Custom Flag in the Code field, selecting the Property Type in the Property Type combo box field, and 
clicking the Apply or OK Button. 
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Existing Custom Flags can be edited by clicking on the desired item in the list box and then pressing the Tab key. 
This will take the user to the Code field, where it can be changed, if necessary. The user can again press the Tab 
key to move on to the other data entry fields where this data can be edited. The data is saved by clicking the Apply 
or OK Button. 

 

A Custom Flag can be deleted from the schedule by first clicking on the desired item in the list box and then 
clicking the Delete button. The Custom Flag will be deleted from the schedule unless it is in use on any parcel. If 
the Custom Flag is currently in use, WinGAP will display the message "Flag is in use -delete not allowed". Clicking 
the OK Button on the message will return the user to the Neighborhoods Form. 

 

 

 

INCOME MODELS 

The Income Models menu option presents a schedule that defines the models used in the pricing of Real Property 
with the Income Method of Valuation. The Income Models schedule must be set up prior to using the Income 
approach to value property. Clicking on the Income Models option will produce a notification if no Income Models 
exist. 

 

 

Clicking the OK button will take the user to the empty Define Income Models schedule. 
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The New button should be clicked to begin adding Income Models. 

 

If Income Models exist, clicking on the Income Models option on the Tools > Schedules/Tables Menu will produce 
the Income Models schedule. 
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SETTING UP INCOME MODELS 

The first step in setting up Income Models is to define the Model Type. There are four Income Models: 

• $/SF: If the income of the property is based on a dollars per square foot rate, then this Model Type option 
should be checked. Properties that would use this valuation option include warehouses and other large 
storage facilities. 

• $/Room: If the property's income is related to the number of rooms, then this Model Type option should 
be checked. Properties that would use this valuation option include offices and other similar types of 
commercial properties. 

• $/Bedroom: If the rental income of the property is based on based on the number of bedrooms, then this 
Model Type option should be checked. Apartment complexes would be an example of properties 
receiving income in this manner. 

• GRM: If the property is to be valued by a Gross Rent Multiplier, then this Model Type option should be 
checked. Any property type may be valued by a GRM. 
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Once the Model Type is selected, the Model Category should be selected if they are set up in the County’s 
schedules. Next is to fill in the Model Description field with an appropriate model name, such as the name of the 
complex or the development. Depending on the Model Type chosen, only certain fields on the Income Models 
Form will be available for data entry. The Model Description field is used with all Model Types. 

 

$/SF MODEL TYPE 

The fields available for the $/SF Model Type are as follows: 

Model Category: This is an optional item where individual models can be assigned to a broader category if they are 
set up in the county Income Categories schedule (discussed below in this manual), such as “Apartments” or 
“Offices”. 

Model Description: The description of the Income Model, such as Apartments. The description can be as detailed 
as will fit in the 38-character wide field. From the Model Description field the Tab key will take the user to the first 
of six Unit Description and Unit Rent fields. 

$/SF: The dollars per square foot rental rate for this property type. 

$/Room: Not available for this Model Type. 

GRM: Not available for this Model Type. 

Vacancy %: The standard percentage of vacancy for the property type. This should be entered as a whole number, 
not the decimal equivalent of the percentage. A 10% Vacancy Rate would be entered as 10, not .10. 

Expenses %: The standard allowable expense percentage for the property type. This should be entered as a whole 
number, not the decimal equivalent of the percentage. A 30% expense rate should be entered as 30, not .30. 

Cap Rate: The standard Capitalization Rate for the property type. The Cap Rate should be entered as two whole 
numbers followed by three decimals. A Cap Rate of .0825 should be entered as 8.25. 

Monthly Rate: If the $/SF rent is a monthly rate instead of an annual rate, this box should be checked. 

Comments: Comments about the Model Type and valuation method can be entered into this field. 
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$/ROOM MODEL TYPE 

The fields available for the $/Room Model Type are as follows: 

Model Category: This is an optional item where individual models can be assigned to a broader category if they are 
set up in the county schedules, such as “Apartments” or “Offices”. 

Model Description: The description of the Income Model, such as Apartments. The description can be as detailed 
as will fit in the 38-character wide field. From the Model Description field the Tab key will take the user to the first 
of six Unit Description and Unit Rent fields. 

$/SF: Not available for this Model Type. 

$/Room: The rent per room expressed as dollars per Room for this Model Type. 

GRM: Not available for this Model Type. 

Vacancy %: The standard percentage of vacancy for the property type. This should be entered as a whole number, 
not the decimal equivalent of the percentage. A 10% Vacancy Rate would be entered as 10, not .10. 
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Expenses %: The standard allowable expense percentage for the property type. This should be entered as a whole 
number, not the decimal equivalent of the percentage. A 30% expense rate should be entered as 30, not .30. 

Cap Rate: The standard Capitalization Rate for the property type. The Cap Rate should be entered as two whole 
numbers followed by three decimals. A Cap Rate of .0825 should be entered as 8.25. 

Monthly Rate: If the $/SF rent is a monthly rate instead of an annual rate, this box should be checked. 

Comments: Comments about the Model Type and valuation method can be entered into this field 

 

 

$/BEDROOM MODEL TYPE 

The fields available for the $/Bedroom Model Type are as follows: 

Model Category: This is an optional item where individual models can be assigned to a broader category if they are 
set up in the county schedules, such as “Apartments” or “Offices”. 

Model Description: The description of the Income Model, such as Apartments. The description can be as detailed 
as will fit in the 38-character wide field. From the Model Description field the Tab key will take the user to the first 
of six Unit Description and Unit Rent fields. 

Unit Description: A Description of each of the types of Units is keyed in these fields. 
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Unit Rent: The Unit Rent associated with each type of Unit is keyed into these fields. 

$/SF: Not available for this Model Type. 

$/Room: Not available for this Model Type. 

GRM: Not available for this Model Type. 

Vacancy %: The standard percentage of vacancy for the property type. This should be entered as a whole number, 
not the decimal equivalent of the percentage. A 10% Vacancy Rate would be entered as 10, not .10. 

Expenses %: The standard allowable expense percentage for the property type. This should be entered as a whole 
number, not the decimal equivalent of the percentage. A 30% expense rate should be entered as 30, not .30. 

Cap Rate: The standard Capitalization Rate for the property type. The Cap Rate should be entered as two whole 
numbers followed by three decimals. A Cap Rate of .0825 should be entered as 8.25. 

Monthly Rate: If the $/SF rent is a monthly rate instead of an annual rate, this box should be checked. 

Comments: Comments about the Model Type and valuation method can be entered into this field 
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GRM MODEL TYPE 

The fields available for the GRM Model Type are as follows: 

• Model Description: The description of the Income Model, such as Apartments. The description can be as 
detailed as will fit in the 38-character wide field. From the Model Description field the Tab key will take 
the user to the first of six Unit Description and Unit Rent fields. 

• $/SF: The dollars per square foot rental rate for this property type. 

• $/Room: The dollars per room for this Model Type. 

• GRM: The Gross Rent Multiplier for this Model Type. 

• Vacancy %: Not available for this Model Type. 

• Expenses %: Not available for this Model Type. 

• Cap Rate: Not available for this Model Type. 

• Monthly Rate: Not available for this Model Type. 

• Comments: Comments about the Model Type and valuation method can be entered into this field. 
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INCOME CATEGORIES 

Income Categories allow the county to group Income Models into similar categories, which can be useful for data 
auditing purposes. This form is composed of a list box where the existing Income Categories are displayed, and the 
data entry fields for each Custom Flag item below the list box. Clicking on an Income Category in the list box will 
display the data about that item in the data entry fields at the bottom of the Form. 

 

 

A new Income Category can be added to the schedule by clicking the New Button. The user will be taken to the 
Code field where a County-defined code can be entered, then the user can enter a description of the Income 
Category in the Description field. The Apply or OK Button should be clicked to save the data. 

 

Existing Income Categories can be edited by clicking on the desired item in the list box and then keying an updated 
description in the Description box. If the Code is to be changed, the user must click the Edit button beside the Code 
box before being able to access the field. The data is saved by clicking the Apply or OK Button. An existing Income 
Category can be deleted by clicking on the desired item in the list box and then clicking the Delete Button. 
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DEPRECIATION 

 

 

RESIDENTIAL TABLES 

This option produces the Residential Depreciation Table Form. The Form is divided into three sections: 

• A list box containing Depreciation Group items, each consisting of a Grade, Frame, and Age. 

• Depreciation Group data entry fields where the Grade and Age for each item are added or edited. 

• Depreciation Factors data entry fields for each Depreciation Group item where the Depreciation Factors 
for each level of Observed Condition are added or edited. 
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WinGAP is delivered to the County with a default set of Depreciation Group Grade-Frame-Age items and 
Depreciation Factors associated with each item. These can be modified by the County for local purposes if desired. 
As delivered, Depreciation Group items begin at Grade 60 and end at Grade 999. For each Depreciation Group 
item, the Frame is "A" for All types of Frames and cannot be changed. The Age for each Group begins at 1 and ends 
at 100. The Grade and Age for each Depreciation Group item can be edited in the Depreciation Group data entry 
fields; however, the Frame type cannot be changed. Each Depreciation Group item has a default set of 
Depreciation Factors, which are found in the Depreciation Factors section of the Form. For Residential 
Improvements, these Depreciation Factors are found in the five data entry fields associated with Observed 
Condition: "Ex:" for Excellent, "Gd:" for Good, "Av:" for Average, "Fr:" for Fair, and "Pr:" for Poor. These Factors can 
be modified by the County if desired. 

 

WinGAP uses the Grade, the Age or Effective Age, and the Observed Condition of the Residential Improvement to 
look up the Depreciation Factor in the Depreciation Table. If the County uses the default Residential Depreciation 
Table delivered with WinGAP, and the Grade for the Residential Improvement is found in the Depreciation Table, 
WinGAP subtracts the Year Built or Effective Year Built of the Residential Improvement from the Residential 
Depreciation Year (set up in Tools/Preferences) to determine the Age. WinGAP then uses the Observed Condition 
of the Residential Improvement to find the appropriate Depreciation Factor for that Grade and Age. (NOTE: If the 
Year Built or Effective Year Built is greater than or equal to the Depreciation Year, WinGAP uses an Age of 1). If the 
Grade is not found in the Depreciation Table, WinGAP drops back to the next Grade in the Depreciation Table 
BELOW the Grade of the Improvement, and then uses the Age and Observed Condition to select the Depreciation 
Factor. For example, the Residential Improvement has a Grade of 100. If 100 is not found in the Table, WinGAP 
would use the Depreciation Group of Grade 85, along with the Age and Observed Condition, to determine the 
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Depreciation Factor. If the County desires, more Depreciation Groups with associated Depreciation Factors can be 
added to the Table. For example, Depreciation Groups with Grades of 65, 70, 75, and 80 could be added between 
the existing default Depreciation Groups of Grade 60 and Grade 85. 

 

Existing Depreciation Group Grade-Frame-Age items can be edited by clicking on the appropriate item in the list 
box. The Grade and Age can be edited by clicking on the appropriate field in the Depreciation Group section of the 
Form. The Depreciation Factor for each Observed Condition can be edited by clicking on that data entry field in the 
Depreciation Factors section of the Form. 

 

A new Depreciation Group Grade-Frame-Age item can be added to the Table by clicking the New Button at the 
bottom of the Form. The Grade and Age would then be keyed in the Depreciation Group data entry fields, and the 
Depreciation Factors for this Grade and Age item would be keyed in the fields under each Observed Condition in 
the Depreciation Factors section of the Form. The data is saved by clicking the Apply Button. The New Button 
should again be clicked to add the rest of the Grade, Age, and Depreciation Factors associated with this 
Depreciation Group. 

 

Depreciation Group items can be deleted from the Table by first highlighting the Grade-Frame-Age item in the list 
box, and then clicking the Delete Button at the bottom of the Form, which will delete the item from the Table. 

 

 

COMMERCIAL TABLES 

Clicking on this option produces the Commercial Depreciation Table Form. The Form is divided into three sections:  

• A list box containing Depreciation Group items, each consisting of a Grade, Frame, and Age. 

• Depreciation Group data entry fields where the Grade and Age for each item are added or edited. 

• Depreciation Factors data entry fields for each Depreciation Group item where the Depreciation Factors 
for each year of Life Expectancy are added or edited. 
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WinGAP is delivered to the County with a default set of Commercial Depreciation Group Grade-Frame-Age items 
and Depreciation Factors associated with each item. These can be modified by the County for local purposes if 
desired. As delivered, Commercial Depreciation uses only one Depreciation Group with a Grade of 100. For each 
Depreciation Group item, the Frame is "A" for All types of Frames and cannot be changed. The Age for the 
Depreciation Group begins at 1 and ends at 100. The Grade and Age for each Depreciation Group item can be 
edited in the Depreciation Group data entry fields; however, the Frame type cannot be changed. Each 
Depreciation Group item has a default set of Depreciation Factors, which are found in the Depreciation Factors 
section of the Form. For Commercial Improvements, these Depreciation Factors are found in the data entry fields 
associated with Life Expectancy, which make up the second through fourth rows of the Depreciation Factors 
section of the Form. Each of these data entry fields is heading by a Life Expectancy year: "5" for Five Years, "10" for 
Ten Years, etc. These Factors can be modified by the County if desired. 

 

WinGAP uses a Grade of 100, the Age or Effective Age, and the Life Expectancy of the Commercial Improvement to 
look up the Depreciation Factor in the Depreciation Table. If the County uses the default Commercial Depreciation 
Table delivered with WinGAP, WinGAP subtracts the Year Built or Effective Year Built of the Commercial 
Improvement from the Commercial Depreciation Year (set up in Tools/Preferences) to determine the Age. WinGAP 
then uses the Life Expectancy of the Commercial Improvement (based upon the Construction Type) to find the 
appropriate Depreciation Factor for that Age. (NOTE: If the Year Built or Effective Year Built is greater than or equal 
to the Depreciation Year, WinGAP uses an Age of 1). 
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Existing Depreciation Group Grade-Frame-Age items can be edited by clicking on the appropriate item in the list 
box. The Grade and Age can be edited by clicking on the appropriate field in the Depreciation Group section of the 
Form. The Depreciation Factor for each Life Expectancy year can be edited by clicking on that data entry field in the 
Depreciation Factors section of the Form. 

 

A new Depreciation Group Grade-Frame-Age item can be added to the Table by clicking the New Button at the 
bottom of the Form. The Grade and Age would then be keyed in the Depreciation Group data entry fields, and the 
Depreciation Factors for this Grade and Age item would be keyed in the fields under each Life Expectancy year in 
the Depreciation Factors section of the Form. The data is saved by clicking the Apply Button. The New Button 
should again be clicked to add the rest of the Grade, Age, and Depreciation Factors associated with this 
Depreciation Group. 

 

Depreciation Group items can be deleted from the Table by first highlighting the Grade-Frame-Age item in the list 
box, and then clicking the Delete Button at the bottom of the Form, which will delete the item from the Table. 

 

 

ACCESSORY TABLES 

Clicking on this option produces the Accessory Depreciation Table Form. The Form is divided into three sections:  

• A list box containing Depreciation Group items, each consisting of a Grade, Frame, and Age. 

• Depreciation Group data entry fields where the Grade and Age for each item are added or edited.  

• Depreciation Factors data entry fields for each Depreciation Group item where the Depreciation Factors 
for each level of Observed Condition are added or edited. 
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WinGAP is delivered to the County with a default set of Depreciation Group Grade-Frame-Age items and 
Depreciation Factors associated with each item. These can be modified by the County for local purposes if desired. 
As delivered, Depreciation Group items begin at Grade 0 and end at Grade 999. For each Depreciation Group item, 
the Frame is "A" for All types of Frames and cannot be changed. The Age for each Group begins at 1 and ends at 
20. The Grade and Age for each Depreciation Group item can be edited in the Depreciation Group data entry fields; 
however, the Frame type cannot be changed. Each Depreciation Group item for Accessory Improvements uses the 
Depreciation Factor for Average Observed Condition. These Factors can be modified by the County if desired. 

 

WinGAP uses the Grade and the Age of the Accessory Improvement to look up the Depreciation Factor in the 
Depreciation Table. If the County uses the default Accessory Depreciation Table delivered with WinGAP, and the 
Grade for the Accessory Improvement is found in the Depreciation Table, WinGAP subtracts the Year Built of the 
Accessory Improvement from the Accessory Depreciation Year(set up in Tools/Preferences) to determine the Age. 
WinGAP then uses the Average Observed Condition to find the appropriate Depreciation Factor for that Grade and 
Age. (NOTE: If the Year Built is greater than or equal to the Depreciation Year, WinGAP uses an Age of 1). If the 
Grade is not found in the Depreciation Table, WinGAP drops back to the next Grade in the Depreciation Table 
BELOW the Grade of the Improvement, and then uses the Age to select the Depreciation Factor. For example, the 
Accessory Improvement has a Grade of 100. If 100 is not found in the Table, WinGAP would use the next 
Depreciation Group below Grade 100, which is 0 in the default Accessory Table, along with the Age, and select the 
Depreciation Factor for Average Observed Condition. If the County desires, more Depreciation Groups with 
associated Depreciation Factors for Average Observed Condition can be added to the Table.  
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Existing Depreciation Group Grade-Frame-Age items can be edited by clicking on the appropriate item in the list 
box. The Grade and Age can be edited by clicking on the appropriate field in the Depreciation Group section of the 
Form. The Depreciation Factor for Average Observed Condition can be edited by clicking on that data entry field in 
the Depreciation Factors section of the Form. 

 

A new Depreciation Group Grade-Frame-Age item can be added to the Table by clicking the New Button at the 
bottom of the Form. The Grade and Age would then be keyed in the Depreciation Group data entry fields, and the 
Depreciation Factor for this Grade and Age item would be keyed in the field under each Average Observed 
Condition in the Depreciation Factors section of the Form. The data is saved by clicking the Apply Button. The New 
Button should again be clicked to add the rest of the Grade, Age, and Depreciation Factors associated with this 
Depreciation Group. 

 

Depreciation Group items can be deleted from the Table by first highlighting the Grade-Frame-Age item in the list 
box, and then clicking the Delete Button at the bottom of the Form, which will delete the item from the Table. 

 

 

NON PREBILL MOBILE HOME TABLES 

Clicking on this option produces the Non Prebill Mobile Homes Depreciation Table Form. The Form is divided into 
three sections:  

• A list box containing Depreciation Group items, each consisting of a Grade, Frame, and Age. 

• Depreciation Group data entry fields where the Grade and Age for each item are added or edited.  

• Depreciation Factors data entry fields for each Depreciation Group item where the Depreciation Factors 
for each year of Life Expectancy are added or edited. 
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WinGAP is delivered to the County with a default set of Non Prebill Mobile Home Depreciation Group Grade-
Frame-Age items and Depreciation Factors associated with each item. These can be modified by the County for 
local purposes if desired. As delivered, Non Prebill Mobile Home Depreciation uses Depreciation Groups with a 
Grade of 000 - Grade is not used to calculate the Depreciation for a Non Prebill Mobile Home. For each 
Depreciation Group item, the Frame is "A" for All types of Frames and cannot be changed. The Age for the 
Depreciation Group begins at 0 and ends at 40. The Grade and Age for each Depreciation Group item can be edited 
in the Depreciation Group data entry fields; however, the Frame type cannot be changed. Each Depreciation Group 
item has a default set of Depreciation Factors, which are found in the Depreciation Factors section of the Form. For 
Non Prebill Mobile Homes, these Depreciation Factors are found in the data entry fields associated with Life 
Expectancy, which make up the second through fourth rows of the Depreciation Factors section of the Form. Non 
Prebill Mobile Home Depreciation Factors begin in the Life Expectancy year field of "15" and end in the Life 
Expectancy year field of "40". These Factors can be modified by the County if desired. 

 

WinGAP uses the Age or Effective Age and the Life Expectancy of the Non Prebill Mobile Home to look up the 
Depreciation Factor in the Depreciation Table. If the County uses the default Non Prebill Mobile Home 
Depreciation Table delivered with WinGAP, WinGAP subtracts the Year Built or Effective Year Built of the Non 
Prebill Mobile Home from the MFG Housing Depreciation Year (set up in Tools/Preferences) to determine the Age. 
WinGAP then uses the Life Expectancy of the Make and Model of the Non Prebill Mobile Home to find the 
appropriate Depreciation Factor for that Age. If the Year Built or Effective Year Built is greater than or equal to the 
Depreciation Year, WinGAP uses an Age of 1. 
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Existing Depreciation Group Grade-Frame-Age items can be edited by clicking on the appropriate item in the list 
box. The Grade and Age can be edited by clicking on the appropriate field in the Depreciation Group section of the 
Form. The Depreciation Factor for each Life Expectancy year can be edited by clicking on that data entry field in the 
Depreciation Factors section of the Form. 

 

A new Depreciation Group Grade-Frame-Age item can be added to the Table by clicking the New Button at the 
bottom of the Form. The Grade and Age would then be keyed in the Depreciation Group data entry fields, and the 
Depreciation Factors for this Grade and Age item would be keyed in the fields under each Life Expectancy year in 
the Depreciation Factors section of the Form. The data is saved by clicking the Apply Button. The New Button 
should again be clicked to add the rest of the Grade, Age, and Depreciation Factors associated with this 
Depreciation Group. 

 

Depreciation Group items can be deleted from the Table by first highlighting the Grade-Frame-Age item in the list 
box, and then clicking the Delete Button at the bottom of the Form, which will delete the item from the Table. 

 

 

PREBILL MOBILE HOME TABLES 

Clicking on this option produces the Prebill Mobile Homes Depreciation Table Form. The Form is divided into three 
sections:  

• A list box containing Depreciation Group items, each consisting of a Grade, Frame, and Age. 

• Depreciation Group data entry fields where the Grade and Age for each item are added or edited. 

• Depreciation Factors data entry fields for each Depreciation Group item where the Depreciation Factors 
for each year of Life Expectancy are added or edited. 
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WinGAP is delivered to the County with a default set of Prebill Mobile Home Depreciation Group Grade-Frame-Age 
items and Depreciation Factors associated with each item. These can be modified by the County for local purposes 
if desired. As delivered, Prebill Mobile Home Depreciation uses Depreciation Groups with a Grade of 000 - Grade is 
not used to calculate the Depreciation for a Prebill Mobile Home. For each Depreciation Group item, the Frame is 
"A" for All types of Frames and cannot be changed. The Age for the Depreciation Group begins at 0 and ends at 40. 
The Grade and Age for each Depreciation Group item can be edited in the Depreciation Group data entry fields; 
however, the Frame type cannot be changed. Each Depreciation Group item has a default set of Depreciation 
Factors, which are found in the Depreciation Factors section of the Form. For Prebill Mobile Homes, these 
Depreciation Factors are found in the data entry fields associated with Life Expectancy, which make up the second 
through fourth rows of the Depreciation Factors section of the Form. Prebill Mobile Home Depreciation Factors 
begin in the Life Expectancy year field of "15" and end in the Life Expectancy year field of "40". These Factors can 
be modified by the County if desired. 

 

WinGAP uses the Age or Effective Age and the Life Expectancy of the Prebill Mobile Home to look up the 
Depreciation Factor in the Depreciation Table. If the County uses the default Prebill Mobile Home Depreciation 
Table delivered with WinGAP, WinGAP subtracts the Year Built or Effective Year Built of the Prebill Mobile Home 
from the MFG Housing Depreciation Year (set up in Tools/Preferences) to determine the Age. WinGAP then uses 
the Life Expectancy of the Make and Model of the Prebill Mobile Home to find the appropriate Depreciation Factor 
for that Age. If the Year Built or Effective Year Built is greater than or equal to the Depreciation Year, WinGAP uses 
an Age of 1. 
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Existing Depreciation Group Grade-Frame-Age items can be edited by clicking on the appropriate item in the list 
box. The Grade and Age can be edited by clicking on the appropriate field in the Depreciation Group section of the 
Form. The Depreciation Factor for each Life Expectancy year can be edited by clicking on that data entry field in the 
Depreciation Factors section of the Form. 

 

A new Depreciation Group Grade-Frame-Age item can be added to the Table by clicking the New Button at the 
bottom of the Form. The Grade and Age would then be keyed in the Depreciation Group data entry fields, and the 
Depreciation Factors for this Grade and Age item would be keyed in the fields under each Life Expectancy year in 
the Depreciation Factors section of the Form. The data is saved by clicking the Apply Button. The New Button 
should again be clicked to add the rest of the Grade, Age, and Depreciation Factors associated with this 
Depreciation Group. 

 

Depreciation Group items can be deleted from the Table by first highlighting the Grade-Frame-Age item in the list 
box, and then clicking the Delete Button at the bottom of the Form, which will delete the item from the Table. 

 

 

APM TABLE 

This option is the first of four Personal Property Depreciation Tables. Clicking on this option produces the APM 
Depreciation Schedule Form. The Form consists of a list box comprised of existing APM items with data entry fields 
below the list box where the information about each APM Depreciation Schedule item is added or edited. 

 

 

APM Depreciation Factors are used to depreciate business machinery, equipment, furnishings, and fixtures using 
the cost approach as defined by the Appraisal Procedures Manual (APM) Method. WinGAP is delivered to the 
County with a default set of APM Depreciation Factors. These should only be modified by the County when the 
Department of Revenue Regulations are changed. 

 

Existing APM items are displayed in the list box on the top of the Form. Items are displayed in Item order, Group 
order within the Item, then Age order within the Group. For each type of APM item, from left to right, the Item 
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Number, the Group #, the Age, and the Depreciation Factor, also known as the Composite Multiplier, are 
displayed. Clicking on an item in the list box will display the data about that item in the data entry fields section 
beneath the list box. 

 

Item: The depreciation Item number is used by WinGAP and has no meaning to the user. 

Group: Depreciation Items are grouped according to the useful life of the equipment. Group 1 items have a 5-7 
year typical useful life, and include equipment such as Copiers, Construction Equipment, and Hand Tools. Group 2 
items, with a typical useful life of 8-12 years, include equipment such as Office Furniture, Sawmills, and Restaurant 
and Bar Equipment. Group 3 items, with a typical useful life of 13 or more years, include equipment such as 
Storage Tanks, Billboards, and Cold Storage Equipment. Group 4 items, with a typical useful life of 1-4 years, 
include equipment such as Computers, Printers, and Plotters. 

Age: The Age of the item.  

Depr: The Depreciation Factor, or Composite Multiplier, is the adjustment which will be applied to cost based on 
the Group and Age of the item. The result is the value of the item. 

 

A new APM item can be added to the schedule by clicking the New Button, keying the information in the 
appropriate fields, and clicking the Apply or OK Button. An APM Depreciation item is edited by clicking on the item 
in the list box, changing the information in the desired field(s), and then clicking the Apply or OK Button. An APM 
Depreciation item can be deleted from the Schedule by clicking on the item in the list box and clicking the Delete 
Button, which will delete the APM Depreciation item from the schedule. 

 

 

COST TABLE 

Clicking on this option produces the Cost Depreciation Schedule Form. The Form consists of a list box comprised of 
existing Cost Depreciation Schedule items with data entry fields below the list box where the information about 
each Cost Depreciation Schedule item is added or edited. 
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Cost Depreciation Factors are used to apply the traditional audit appraisal method of the cost approach to business 
machinery, equipment, furnishings, and fixtures. WinGAP is delivered to the County with a default set of Cost 
Depreciation Factors. These can be updated to reflect more current information obtained by the County for local 
purposes if desired. Existing Cost Depreciation items are displayed in the list box on the top of the Form. Items are 
displayed in Life order, then Age order within the Life. For each Cost Depreciation item, from left to right, the Life, 
the Age, and the Depreciation Factor are displayed. Clicking on an item in the list box will display the data about 
that item in the data entry fields section beneath the list box. 

 

Life: The typical Life Expectancy of the equipment, in years. 

Age: The Age of the equipment, in years. 

Depr: The Depreciation Factor is the adjustment which will be applied to the cost of the equipment based on its 
Life and Age. The result is the value of the equipment. 

 

A new Cost Depreciation item can be added to the schedule by clicking the New Button, keying the information in 
the appropriate fields, and clicking the Apply or OK Button. A Cost Depreciation item is edited by clicking on the 
item in the list box, changing the information in the desired field(s), and clicking the Apply or OK Button. A Cost 
Depreciation item can be deleted from the Schedule by clicking on the item in the list box and clicking the Delete 
Button, which will delete the Cost Depreciation item from the schedule. 

 

 

COST INDEX TABLE 

Clicking on this option produces the Cost Index Table Form, below. The Form consists of a large list box comprised 
of existing Cost Index items with data entry fields below the list box where the information about each Cost Index 
Table item is added or edited. 
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Cost Indexes are used in conjunction with the cost table to apply the traditional audit appraisal method to business 
machinery, equipment, furniture, and fixtures. WinGAP is delivered to the County with a default set of Cost 
Indexes. These must be updated annually by the County if they desire to use this feature of the software. Existing 
Cost Index items are displayed in the large list box that makes up most of the Form. Items are displayed 
alphabetically in Industry Type order, then in descending Index Year order within each Industry Type. For each Cost 
Index Table item, from left to right, the NAICS, the Industry Type, the Index Year, and the Index Value are 
displayed. Clicking on an item in the list box will display the data about that item in the data entry fields section 
beneath the list box. 

 

NAICS: The NAICS (North American Industrial Classification System) number for the Industry Type.  

Industry Type: The Valuation Schedule Industry Type. 
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Index Year: The Index Year is the year for the index  

Index Value: The Index Value is the cost index for the year. 

 

A new Cost Index Table item can be added to the schedule by clicking the New Button, keying the information in 
the appropriate fields, and clicking the Apply or OK Button. A Cost Index Table item is edited by clicking on the item 
in the list box, changing the information in the desired field(s), and then clicking the Apply or OK Button. A Cost 
Index Table item can be deleted from the Schedule by clicking on the item in the list box and clicking the Delete 
Button, which will delete the Cost Index item from the schedule. 

 

 

IRS CLASS 

Clicking on this option produces the IRS Classes Form. The Form consists of a list box comprised of existing IRS 
Class items with data entry fields below the list box where the information about each IRS Class item is added or 
edited. 

 

 

IRS Classes are used to group depreciable assets used in business activities based upon IRS publication 946 as 
required by the APM. This table is designed to help automate the data entry for known industry types. If this table 
is incomplete or blank the user will notice little difference in the operation of the software once the initial data 
entry for a particular business is completed. 

 

WinGAP is delivered to the County with a default schedule of IRS Classes. This schedule should only be modified if 
the Department of Revenue promulgates new regulations. Existing IRS Class items are displayed in the list box on 
the top of the Form. Items are displayed in IRS Class order. For each IRS Class item, from left to right, the IRS Class, 
the APM Depreciation Group, the Life Expectancy, and the Description are displayed. Clicking on an item in the list 
box will display the data about that item in the data entry fields section beneath the list box.  
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IRS Class: The IRS (Internal Revenue Service) Asset Class number for the asset.  

APM Group: The APM Group within which items are grouped according to the useful life of the equipment. Group 
1 items have a 5-7 year typical useful life, and include equipment such as Copiers, Construction Equipment, and 
Hand Tools. Group 2 items, with a typical useful life of 8-12 years, include equipment such as Office Furniture, 
Sawmills, and Restaurant and Bar Equipment. Group 3 items, with a typical useful life of 13 or more years, include 
equipment such as Storage Tanks, Billboards, and Cold Storage Equipment. Group 4 items, with a typical useful life 
of 1-4 years, include equipment such as Computers, Printers, and Plotters. 

Life: The Life Expectancy of the asset, based upon its typical useful life. 

Description: The Description of the asset. 

 

A new IRS Class item can be added to the schedule by clicking the New Button, keying the information in the 
appropriate fields, and clicking the Apply or OK Button. An IRS Class item is edited by clicking on the item in the list 
box, changing the information in the desired field(s), and then clicking the Apply or OK Button. An IRS Class item 
can be deleted from the Schedule by clicking on the item in the list box and clicking the Delete Button, which will 
delete the item from the schedule. 

 

 

FILE MAINTENANCE 
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DATA EDITS 

The Data Edits menu option provides the WinGAP Administrator with a means of checking data integrity prior to 
sending assessment notices, running digest exports, or at any time such a check is desired. Selecting the Data Edits 
option on the File Maintenance menu presents the user with the option of which edits to run. 

 

 

SELECTED DATA EDITS 

If the user wishes to run only selected edits the selection(s) are made by checking the box to the right of the edit 
that is to be performed. After the selections are made, the user should click the Run button in the lower right of 
the “selection” area. At the conclusion of the Selected Data Edits routine, the user will be presented a preview of 
the Data Edits report for the edits that were selected.  

 

ALL DATA EDITS 

If the user checks the All option, highlighted in yellow at the lower right of the list of Data Edit options, then clicks 
the Run button, each of the Data Edits will run and at the conclusion of the routine the user will be presented a 
preview of the Data Edits report. 

 

CHILDLESS EDITS 

Owners w/o Property – These are owners that have no real, personal or prebilled manufactured housing accounts 
assigned to them. There is no harm in leaving these records in WinGAP except for the confusion that may result 
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from having owner information that does not relate to any property type. Owners without property can be 
removed from the system by: 

a) Performing an Owner Search and locating the owner on the report. 

b) Confirm that the selected owner has no property assigned (check the Assessment Info and Value section 
of the screen for numbers and values greater than zero). 

c) If the non-existence of property is confirmed, click the Delete button. 

d) Key the password, which is delete, and click OK. 

e) Repeat steps a – d until all owners are removed. 

 

Parcel w/o property items – Parcels included in this section of the report have no property components such as 
land, residential improvements, commercial improvements, accessories, etc. assigned to them. These parcels 
should be reviewed and deleted if they were entered in error. The user should also check to see if the owner of a 
parcel without property has any more property assigned to him/her. If no other property has been assigned, the 
owner may also be deleted in the manner described above for “owners w/o property.” 

 

Residential improvements with manufactured housing occupancy and no manufactured home record – On rare 
occasions the user may receive the following error message when accessing residential improvements: 

 

 

Residential improvements that appear in this section of the Data Edits report will produce the above error 
message. If the manufactured home was deleted and the residential improvement was not removed but should 
have been, the user can correct the problem in the following manner: 

• Using the improvement key, proceed to the improvement (the improvement in question may not be 
the first residential improvement that appears). 

• Change the occupancy to an occupancy other than Manufactured Homes and delete the 
improvement or add the missing manufactured housing information. 

• If the improvement cannot be accessed, contact Tech Support. 
 

Commercial improvements with extra feature value but no extra features – These commercial improvements 
would be improvements that have an extra feature value in the commercial improvement record and 
consequently included in the commercial building value, but there are no extra features present. The user should 
confirm that the extra features should have been removed and when the commercial improvement is edited the 
extra feature value will be set to zero. If the extra features should be present, they will need to be added to the 
improvement. 
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Personal property accounts without property items - Accounts included in this section of the report have no 
property components such as inventory, machinery & equipment, boats, etc. assigned to them. These accounts 
should be reviewed and deleted if they were entered in error. The user should also check to see if the owner of an 
account without property has any more property assigned to him/her. If no other property has been assigned, the 
owner may also be deleted in the manner described above for “owners w/o property.” 

 

CURRENT VALUE CHECKS 

Parcels/Accounts where the sum of the items does not equal current value – On occasions, due to errors or 
aborts, a real property parcel or personal property account’s current value may not equal the sum of the property 
components. Such situations are listed within this section of the Data Edits report. The Data Edits routine corrects 
the current value by setting it to the sum of the property components, but the parcels/accounts are brought to the 
attention of the user. All edits are critical, but this edit is especially critical before the printing of Change of 
Assessment Notices. The current value is printed on the notice and it is imperative that it is correct. 

 

ORPHAN RECORD EDITS 

Orphaned records – Orphaned records are parcels that do not have an owner, residential improvements that do 
not have a parcel assigned to them, boats that do not have an account, etc. Orphaned records may occur because 
of errant data management routines, by issues within WinGAP, or hardware malfunction. Orphaned records should 
be a rarity. However, if any orphaned records should exist, Data Edits will report them and remove them from the 
system. 

 

ZERO VALUES CHECKS 

Property with zero value – The routine identifies all property (real, personal, prebilled, and non-prebilled 
manufactured housing) that has a zero value. A property is determined to have a zero value when both the 
calculated value and the override value are zero. In some cases, this could be legitimate. However, in most 
situations the zero value is a result of a data entry error. Some examples of data entry error are a grade of 0, 
obsolescence and depreciation factors of 0, etc. On some occasions, zero values could be the result of problems in 
schedules where the appraiser has entered a unit value or factor that results in a zero calculated value. Zero valued 
property components are ignored during the "zero-value" edit if the term "no value" (upper, lower, or proper case) 
appears anywhere in the Comments. 

 

MIN-MAX VALUES EDITS 

Properties that exceed user specified max and min values – This section of the Data Edits routine allows the user 
to specify a maximum legitimate value and a minimum legitimate value for each property type. The routine will 
then check for property that exceeds that maximum value and property that is greater than zero but is less than 
the minimum value. The goal is to identify properties that have extremely high values or extremely low values. 
These properties can then be reviewed for accuracy. 
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The % Filter check boxes set a minimum percentage change in value from the previous digest to show up on this 
list. The default is to view all properties that fall outside of the min/max range. If the User % box is checked, a 
percentage is entered in the field below the checkbox that establishes a minimum value change year over year 
before a property that falls outside the min/max range would appear on the edit list. 

 

The max and min values are saved in a table and presented to the user the next time the routine is run. If the edit 
is not desired, the user may key a zero in the min and max column field for the property item that is to be omitted. 

 

HOMESTEAD EDITS 

Homesteaded parcels without improvements – The parcels reported during this portion of Data Edits are those 
that have a homestead code other than S0 or blank but do not have a residential improvement. In some situations, 
a homestead may be assigned to a parcel with a commercial improvement or perhaps even an accessory 
improvement, but these are exceptions and will be reported as potential errors by the edit. 

 

Frozen and Removed Homesteads – Parcels will be checked for the removal of a homestead with no name change, 
and removal regardless of a name change. 

 

State Homestead Flag – A modification was made to the way the routine checks for the State Homestead flag in 
the exemption tables. If there are state homestead values and flags on a parcel and the local homestead code is 
not flagged as State Homestead, the State Code assigned to the local code is checked for a State Homestead flag. If 
the State Homestead flag is found, an error will no longer be reported. 

 

Various Other Homestead Edits – Homestead edits have been added that check for various scenarios related to 
State 65 and Over Homestead Exemptions. 

• The tax district/homestead exemption code combination not being found in the Homestead table. This 
will be regarded as an Invalid Tax District + Homestead Code. 
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• State Homestead value on a parcel that does not have a State 65 & Over Homestead code. 

• State Homestead flag on a Residential Improvement, Commercial Improvement, or Accessory when the 
parcel has a non-State Homestead code. 

• A State Homestead value of zero on a parcel with a State Homestead code. 

• A State Homestead code but no improvements flagged for State Homestead. 

• A parcel where the State Homestead value does not equal the sum of the parcel components (land and 
improvements) eligible for State Homestead. 

 

MISSING DIGEST CODES 

Properties with missing digest codes – Parcels and property items with missing or invalid digest codes are 
reported by this edit routine. The digest classification and digest stratification are checked independently and if 
either digest code is blank or invalid, the property will be listed. The routine does not check for an invalid mix of 
codes such as a digest class of Commercial (C) assigned to an improvement with Conservation Use (V) classed land 
or a Residential improvement ( R ) placed on Agricultural classed (A) land. 

 

CUV EDITS 

Conservation Use Covenant Issues – Parcels with Conservation Use covenants or parcels with data indicating a 
Conservation Use covenant are reviewed and the following issues are reported when found: 

• Conservation Use covenant has expired. 

• No current year Conservation Use value is present for the covenant. 

• The 3% annual limit for covenant value change has been exceeded. 

• The 34.39% term limit for covenant value change has been exceeded. 

• The existence of a covenant year but no other conservation use data. 

• Orphaned Conservation Use records. 

• Existence of Conservation Use history but no assignment of a Conservation Use Year. 

• Existence of a Conservation Use Year but an incorrect digest class (digest class must be a V, W or T). 

• Conservation Use value exceeds the Fair Market Value of parcels. 

• Sum of Conservation Use land value and Conservation Use accessory value does not equal the Unadjusted 
Conservation Use value. 

• A comparison with previous year conservation use data is performed if the user wishes to do so and the 
following issues are checked and listed: Ownership changes and Acreage modifications. 

• Compares the Conservation Use acres to the Market acres on a parcel and when the two are not equal, 
the parcel will be placed on the Data Edits report. 

• If an Accessory Improvement classified as Conservation Use is found on a non-Conservation user parcel, 
the Accessory Improvement will be listed on the Data Edits report. 
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PREF EDITS 

Preferential Covenant Issues - Parcels under a Preferential Covenant are reviewed and the following issues are 
reported when found: 

• An expired Preferential Covenant. 

• Existence of a Preferential Covenant but no Preferential land value. 

• Absence of a Preferential Year when a Preferential land value is present. 

• Sum of the value of accessories with a “P” digest class exceeds $100,000. 

• Existence of a Preferential accessory but no Preferential land value. 

• Checks for any changes in ownership of Preferential Covenants. 

• Improvements with a Preferential Digest Class will be checked to make sure they are located on Parcels 
that have a Preferential Covenant. 

 

FLPA EDITS 

Forest Land Protection Act Issues - Parcels under a FLPA Covenant are reviewed and the following issues are 
reported when found: 

• Expired or Expiring FLPA Covenants. 

• Digest Class = J But no FLPA Covenant Year. 

• Digest Class <> J but FLPA Covenant Year is Assigned. 

• FLPA Covenant with No 2008 Base Value. 

• FLPA Covenant with No Application Number. 

• FLPA Base Value <> Parcel Acres * 2008 Per Acre Value. 

• FLPA Covenant without a Covenant History Record. 

• FLPA Covenant Acres do not match Parcel Acres. 

• FLPA Covenant with No Current Covenant Value. 

• FLPA Covenant with No Unadjusted Covenant Value. 

• FLPA Covenant Beginning History Date does not match Covenant Year. 

• FLPA Covenant Original History Date does not match Covenant Year. 

• FLPA Covenant History Year is Zero. 

• FLPA Covenant History Value is Zero. 

• FLPA Covenant 3% Value Change Limit Exceeded. 

• FLPA History record but No Parent Parcel record. 

• FLPA audit file not found. 
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SB346 SALES EDITS 

NOTE: ALT = Arm’s Length Transaction 

SB346 Issues 

• Sales flagged for SB346 and the Net Sales Price > FMV. 

• Any sale with a sales reason which has been classified as an ALT, is one year removed from the digest 
year, the net sales price is less than the value of the parcel and have not been flagged as SB346 sales will 
be listed. 

• Sales flagged with an ALT reason that has been designated as a vacant land sale but a SB346 is present will 
be listed. 

• Negative SB346 values. 

• Parcels designated for SB346 with an ALT sale and a LM reason where the net sales price is greater than 
the land value will be listed. 

• SB346 values and no SB346 flag set for the parcel will be listed. 

• Parcels where the sum of the SB346 component values does not equal what is stored in the Totals fields 
will be listed. 

• If a SB346 flag is set on the parcel but no SB346 sale exists will be listed. 

• Presence of multiple SB346 sales on a single parcel. 

• SB346 sale but the parcel is not flagged for SB346 or has no SB346 values.  

• Any improvement with a year built that is one less than the digest year and the SB346 non-allocated value 
is zero. 

• Sales designated as vacant land with an ALT reason not flagged as vacant land. 

 

SB346 and CUV/FLPA situations 

• Parcels with a value in the SB346 Covenant fields but the digest class is not P, V, or J. 

• Sales where the net sales price is greater than the land value but the SB346 “new improvement” value is 
greater than zero. 

 

Other SB346 situations 

• An edit has been added that will check parcels with SB346 sales for situations where an improvement’s 
value with a year built one less than the digest year may have been allocated incorrectly. The message on 
the Data Edits report will be “Imp Value may have been allocated incorrectly”. Not all parcels with this 
message will have incorrect values but some may. 

• Sales designated as vacant ALT where land value is less than net sales price will be listed. 

 

ACO EDITS 

• ACO records where the Total Gross Change value field does not equal the sum of the individual Gross 
Change value fields. The situation is corrected by the edit. 

• ACO records where the Total Original Gross value field does not equal the sum of the individual Original 
Gross value fields. The situation is corrected by the edit. 
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• ACO records where the Total Final Gross value field does not equal the sum of the individual Final Gross 
value fields. The situation is corrected by the edit. 

 

POST YEC COVENANT EDITS 

NOTE: This should be run immediately after YEC. 

• Parcels with a covenant digest class in the newly created year but future parcel counterpart does not have 
a covenant. 

• Parcels with an expired covenant. 

• Previous year covenant value is zero. 

• Parcels with previous year covenants but the covenant is not present in the new current year. 

 

APPEALS EDITS 

Possible 299(c) Expiration – any parcels having a year in the 299 (c) field on the Real Property General Information 
form where that keyed year is 3 years old or older will be listed as a possible expiration item. 

 

Resolved 30-Day Appeals – any appeals with an Appeal Status of 30-Day and the 30-Day appeal date is more than 
30 days from the date Data Edits is run will be automatically resolved. This applies to Real, Personal, Prebilled 
Manufactured Housing, and Motor Vehicle appeals. 

 

MOBILE ASSESSOR 

Mobile assessor can only sync to a single digest year and cannot also update “future”. These data edits will list 

future improvements and/or parcels that were updated by Mobile assessor in the live year and those same items 

also appear in future. The report allows the WinGAP users the ability to also make the same edits/changes in 

future. 

 

FREEPORT EDITS 

Freeport Exemption Issues – Personal Property accounts with Freeport Exemption data are checked for the 
following: 

• A Gross Freeport Value that exceeds 0 and a Net Freeport Value that is equal to 0. 

• A Freeport Return Year that is not equal to the Digest Return Year. 

• Existence of a Freeport Value on the account and a Net Freeport Value equal to 0. 

• The FMV Freeport value is not equal to the Freeport value of the Inventory record. 

 

MANUFACTURED HOUSING EDITS 

Manufactured Housing Issues – The following checks are performed during the Data Edits routine on 
Manufactured Housing data: 

• Invalid class assignment to a manufactured housing record (EX, VG, GD, AV, FR and LC are the valid 
classes). 
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• Class assignment to a manufactured home does not match the class assignment in the Mfg/Model table. 

• Life expectancy assignments made to manufactured home records are compared to Life Expectancy for 
the Mfg/Model entry in the Manufactured Housing table and reported when the two are not the same. 

• Manufactured housing that has no box value will be listed. 

• Checks for invalid NADA widths in manufactured housing. 

 

NOA EDITS 

Change of Assessment Reason Edits – Real property and personal property accounts are checked for the following: 

• Existence of a notice flag and no COA reason. 

• Existence of a COA reason (excluding the reason code NN – No Notice) and no notice flag. 

• Real property and personal property accounts that have a value difference but no COA reason or the 
existence of a COA reason (excluding the reason code NN – No Notice) and the no notice flag is checked. 

 

LAND EDITS 

Land Type/Class Validation – Land Types and Classes are validated against the Rural Land schedule and reported 
when they are not found in the schedule table. 

 

Land Income Value Edits – New edits have been added that will: 

• check for zero land income value 

• check for situations where the income land value does not equal the market land value 

 

ACCESSORY EDITS 

Invalid Component Numbers– If an Accessory Improvement has a Component Number that does not exist in the 
Accessory Control schedule table, it will be reported. 

 

Conservation Use Accessory Comparison – If an Accessory Improvement classified as Conservation Use is found on 
a non – Conservation Use parcel, the Accessory Improvement will be reported. 

 

PERSONAL NO PT50 EDITS 

No PT50 Accounts – Accounts flagged for no printing of a PT50 with an owner account value greater than 7500 will 
be listed for confirmation of the flag. 

 

TAX DISTRICT CHECKS 

Invalid Tax Districts – Checks for invalid Tax Districts in Real and Personal Property and Prebilled Manufactured 
Housing. 
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SKETCH LABELS 

Sketch Edits – Labels assigned to sketch records will be checked for validity with regard to schedules. Also, 
mismatches between the label assigned to the sketch and the label stored in the Wgsketch table Implabel field will 
be reported. 

 

PROPERTY COMPONENTS 

Commercial Improvement Data Validation – Commercial Improvements will be checked for invalid or missing 
Used As/Build As codes, Wall Height, Construction Type, Life Expectancy, and Year Built/Effective Year Built data. 

 

LIST SB 346 SALES 

A report of all SB 346 sales from the prior appraisal year will be generated. 

 

 

DELETED ACCOUNTS 

All real property, personal property, and prebilled manufactured housing records that have been deleted in the 
current appraisal year will be displayed. 
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EST TAX EDITS 

• Real Property Parcels and Personal Property Accounts with no estimated tax details. 

• Real and Personal Property where some tax detail information is missing. 

• Real and Personal Property with no estimated tax master record. 

• Real and Personal Property with an estimated tax difference between the sum of the detail records and 
the master record estimated tax amount. 

• Real and Personal Property with duplicated master tax records. 

 

MAIL ADDRESSES 

• Add1 has # without trailing spaces pursuant to USPS regulations (213.2) 

• Add2 has # without trailing spaces pursuant to USPS regulations (213.2) 

• Add3 has # without trailing spaces pursuant to USPS regulations (213.2) 

• Mailing Address + DBA is six (6) lines long 

• Mailing Address is blank or missing 

 

DATA EDITS REPORT 

The Data Edits report can be printed by clicking the Print button located in the lower left corner of the Data Edits 
screen, which will generate a print preview. 
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The preview is a Reporting Services file with “drill down capabilities”. Clicking the “+” symbol on the left of the 
item shows the individual items for each type of data edit. 

 

 

ITEM: Description of the edit that produced an entry on the report. 

DEF: Definition of the edit. 

PKEY: Account # or item’s primary key. 

PKEY NAME: The field name of the primary key. 

PARCEL NO: Parcel identification number. 

FKEY: The key that ties the property item to its parent record. 

FKEY NAME: The field name that contains the foreign key (FKEY). 
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The report can be printed or exported to a PDF, Excel, or Word file. Exporting is done by clicking the button with 
the tool tip called “Export drop down menu”, then selecting the format from the 3 available choices. The report 
will be exported to the selected format and the user will be prompted with a message asking if the report should 
be opened or saved. 

 

 

GROWTH CALCULATIONS - NORMAL 

The Growth Calculations routine determines the amount of Inflationary Growth per parcel. Clicking this menu item 
will produce a print preview of the Inflationary/Real Growth Summary for each Tax District in the County. 

 

 

This procedure must be run prior to providing growth figures for millage rate determination and runs automatically 
when creating the Digest Submission Reports. The assignment of COA reasons and their associated COA Types 
during the data entry of information related to parcels and reappraising when schedules were updated comprised 
the first step in the process of determining growth amounts. The second step involves running the growth 
procedure to segregate real growth and inflationary growth. The procedure will check the COA reasons assigned to 
each parcel for their COA Type and process the change in value accordingly.  

 

• A COA Type of Inflationary will result in the difference between current value and previous value being 
calculated as inflationary growth. New construction will be deducted from the inflationary growth. 



 
401 

• Real growth COA Types will result in no contribution to inflationary growth. The value difference between 
current and previous value will be considered as real growth. If an inflationary reason is also assigned to 
the parcel, a portion of the value difference may contribute to inflationary growth. 

• In situations where a COA reason with a Split/Combination COA Type exists on a parcel, no inflationary 
growth will be calculated. In addition, parcels with a zero previous value will not be assigned any 
inflationary growth regardless of the COA Type. 

 

GROWTH CALCULATIONS AND LOCK 

Growth calculations will calculate estimates for inflationary and real growth pursuant to state law requirements for 
digest submission. These calculations are based on the property values at the split second in time when the menu 
is clicked.  

 

Some counties like to run and submit growth totals to the tax commissioner’s office before their work is 100% 
complete; they wish to be able to make small insignificant value changes and don’t want the growth estimates to 
change also. The growth calculations and lock menu will run a normal growth estimate as referenced in the 
section above, but it will also place a lock so that no additional growth estimates can be run unless the growth is 
unlocked. 

 

The lock placed by the lock menu will remain until Year End Cleanup, or the user unlocks growth using the menu 
item. 

 

UNLOCK GROWTH CALCULATIONS 

Unlocking growth removes the growth calculation lock described above and will allow live growth calculations 
again. 

 

USER LOG 

At times, it may become necessary to determine what user(s) may still be in WinGAP after the “Shutdown” 
message or a verbal “All Clear WinGAP” message has been sent and procedures still cannot be run due to users 
having files open. This menu item provides the WinGAP administrator a list of WinGAP users with their current 
“login” status. 

 

The user log consists of a grid with the logins creating the rows and columns to identify the user, computer name 
and dates/time of login/logout activity. Records appear in the User Log in Descending time and date order, with 
the most recent entries at the top. 
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Recid: The record number assigned by WinGAP for each entry in the User Log. 

LoginKey: The key is assigned by WinGAP to the user as they login. 

LoginId: The WinGAP user id that was used to access the data is recorded in this field. 

Comp_Name: The computer’s name where the user logged in is saved in this column. This should inform the 
administrator which computer needs to be shut down to free WinGAP for update or maintenance work. 

In_Date/In_Time: The date and time the user logged in will be recorded here. 

Out_Date/Out_Time: The date and time the user logged out of WinGAP is saved in this column. If the date and 
time are blank, this indicates that the user was aborted through an error message or is still logged into WinGAP. 

DateCheck/TimeCheck: The user login is checked every 30 seconds to monitor the status of the user. The last 
check is recorded in these columns. 

 

If the user has not logged out of WinGAP (Out_Date & Out Time are blank), the administrator should locate the 
user and ask them to log out so that maintenance on WinGAP may be performed. 

 

EDIT LOG 

The Edit Log keeps a record of virtually every user-initiated operation that changes a record in WinGAP. Any time a 
user accesses WinGAP and adds a record or makes a change to an existing record it is recorded in the Edit Log 
database. For example, a user adds a Boat to a Personal Property Account. The Edit Log would reflect that on a 
certain date, the Personal and Boat database files were modified by that user. If a parcel, personal property 
account, or prebilled mobile home is transferred from one owner to another, the term "Transfer" will appear in 
the filename column in the Edit Log. 

 

Each record on the Edit Log Form lists the File Name, PKey, ChgAppr ID (if no logins are used, it will say "Nologin"), 
Edit Date, Edit Time, After Edit (value after edit), Value Time (the time the value was changed), Before Edit (value 
before edit), and the Owner key for the record that was edited. Items in the Edit Log are listed in Date and Time 
order. The Edit Log database can be accessed from the Report Generator and activity reports printed if needed. 
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The Edit Log for each type of property in WinGAP can also be viewed by clicking the Edit History Button on the 
following Forms: Owner, Realprop, Residential Improvements, Accessories, Commercial Improvements, 
Commercial Extra Features, Personal, Machinery/Equipment/ Furnishings/Fixtures, Taxable Inventory, Freeport 
Inventory, Boats, Aircraft, Other, Mobile Homes, and Add-Ons. In these cases, the Edit Log will display entries as to 
when that parcel, improvement, account, etc. was added to or changed. 

 

Clicking the Field Edits button will reveal the specific changes that were made to the record. 
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When Year End Cleanup is run, the Edit Log in the new Appraisal Year is cleaned out. The entire Edit Log will 
remain in the previous Appraisal Year. 

 

PHOTO AUDIT 

The Photo Audit will open a window where a routine can be executed to display a list of all photos that have been 
added to either Residential or Commercial improvements. Clicking the Run Audit button for either the Residential 
or Commercial Improvements will display a “gathering data” popup as the process runs. 

 

Once complete, the audit results will display on the left side of the screen for Residential Improvements and on the 
right side of the screen for Commercial Improvements. The audit will list the improvement key, the realprop key, 
the parcel number, the picture’s complete file path, if the file exists at the designated file path, and if the account 
is flagged as having a photo. The list is in parcel number order. 



 
405 

 

Clicking the Print Results button will generate a report that can be printed directly or saved as a Word, Excel, PDF 
file, etc. 
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YEAR END CLEANUP 

After work on the County's tax digest has been finished for the year, the Year End Cleanup should be performed. 
NOTE: Before this procedure is run, a backup of the current Appraisal Year folder should be made and the files 
archived. 

 

 

Clicking on the Year End Cleanup option produces a submenu with two options, Real and Personal YEC and MH 
YEC. The Real and Personal option should be taken when the County is ready to setup the next digest year as the 
WinGAP Current Year. Generally, this will occur between August and October. The MH YEC is used when the 
Prebilled Mfg Housing digest work is concluded. The typical time frame for running MH YEC is January of the 
following year. 

 

REAL AND PERSONAL YEC 

When Real and Personal YEC is selected, the user will be informed of the actions that Year End Cleanup will 
perform. Though not required, it is recommended that all users exit WinGAP before Year End Cleanup is 
performed. 
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Year End Cleanup performs many different procedures which are highlighted below. Every specific task is not in the 
bullet list below as the bullet points are meant to indicate general processes and progress: 

• Create next year's data folder. 

• Blank out return values and assessment reasons. 

• Roll real property live data (values, flags, history, etc). 

• Roll personal property live data (values, flags, etc). 

• Purge all records marked for deletion. 

• Merge future digest into live digest. 

• Clean out the notices database. 

• Clean out editlog and view log. 

• Clean out new owner table. 

• Roll RapidSketch data forward. 

 

If the County uses the Future module, any Editlog records in the Future Year will be pulled into the new current 
year Editlog. If the County does not use the Future module, the Editlog will be empty. 

 

There are 4 user-selectable options for the Year End Cleanup process: 

Remove ALL SB346(saleprice = parcel value override): This refers to the SB346 requirement that property values 
shall not exceed the net sales price of an arm’s length transaction that occurred in the year prior to the digest. If 
this box is checked, all parcels flagged for SB346 value will have the flag removed and the value of the property will 
revert to MAV/FMV. The previous value will become the SB346 value. Any sales marked as SB346 sales will also be 
cleared of such flags. 

Remove ALL EXPIRED 299C Events: If this box is checked, parcels with expired 299C Appeals will have the 299C 
values removed, all property component values will be rolled back to their original pricing, and a removal 
assessment reason will be inserted. Only 299C events created by the official ‘299C Event’ checkbox on the appeal 
screen will be removed during year end cleanup. 

Sales Only Future: If the County creates a Future Year this check box determines what type of processing can occur 
in that Future Year. Left unchecked, the County may perform any tasks in the Future Year. If checked, the County is 
limited to transferring ownership, adding sales, and creating new parcels in the Future Year. 

New Digest Year Name: This field allows the user to change the default name for the new appraisal year folder. 
The field defaults to the current digest year plus one. This should NOT be changed unless a specific and well 
thought out plan exists to justify changing the digest year name. 

 

Finally, the yellow highlighted message concerning Future Pricing Schedules should also be noted. Schedules 
updated only in Future will need to be rekeyed in the new appraisal year. 

 

These procedures should be read carefully. If the user is unsure whether to perform these procedures, the Cancel 
Button should be clicked to return to the main WinGAP screen. Otherwise, the Cleanup Button should be clicked to 
begin Year End Cleanup. As this process goes forward, two bar graphs will display the progress, as seen on the next 
page. As each item in the list of procedures is finished, the item will turn blue. Depending upon the number of real 
property parcels, personal property accounts, improvements, sketches, etc., the process could last from less than a 
minute to a few minutes. 
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It is worth noting that the process does a BACKUP/RESTORE of the SQL database which ensures all existing VIEWS 
and STORED PROCEDURES will carry over from the previous digest database into the new digest database. When 
Year End Cleanup is finished the user will receive a “Triggers Created” message, where OK should be clicked. 
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Once complete, the user will receive a message that the Year End Cleanup has been completed. 

 

 

The next message that appears alerts the user that there are Data Edits available to assist with data cleanup, 
especially those regarding CUV and FLPA covenants. 

 

 

The final message the user will see as part of the Year End Cleanup process informs the user that any customized 
County reports that have been created in the previous appraisal year will need to be updated in the current, newly 
created appraisal year. Depending on the County’s configuration of reporting projects, updating the shared data 
source may range from very simple to somewhat involved. Due to the virtually unlimited options that each County 
has in how it can distribute and configure their report designers, the following holds true: the data source is 
originally defined in the report project. However, users can prevent their project from overwriting data sources 
upon deployment. It might be necessary to update your report designed project data source as well as the 
deployed data source from the report manager (http://<ServerName>/Reports/DataSources). 
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MH YEC 

The Manufactured Housing Year End value rollover process does the following: 

• Places the value that is found in one of the Mobile table value fields (Ovrvalue, Guidevalue, or Value, 
whichever takes precedence) into the Prev box field. 

• Places the value found in the Addonval field in the Mobile table into the Prev Addon field. 

• The total of the values in the Prev Box and Prev Addon fields will be placed in the Total Previous field. 

• Sets the Returnmail field in the Mobile table to false (zero). 

 

Clicking this menu item produces the Year End Cleanup form for Manufactured Housing. To perform the 
Manufactured Housing YEC, the Do YEC button should be clicked to proceed. 

 

 

Various messages will display on the Year End Cleanup form as the records are processed, and at the conclusion of 
the process the user will receive a message indicating the Year End Cleanup is complete. The user should click OK, 
then Cancel on the YEC form, then Cancel on the Export form, returning the user to the main WinGAP screen. 

 

FUTURE FOLDER TASKS 
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CREATE FUTURE DATABASE 

At times during a digest year, information will be provided that should not be part of the current digest but should 
be processed for the next year’s digest. To process this information, the user should make use of the Future Year 
capabilities that exist in WinGAP. 

 

For Example, on September 15, 2020 a county has completed a Yearend Cleanup for the 2020 digest and is now 
working on the 2021 digest. After January 1, 2021, the county may begin working deeds and creating property 
transfers and splits in the Future Year for transactions that have been recorded after January 1 and should not 
appear on the 2021 digest. Any new construction that is completed after January 1 and picked up in the field prior 
to the completion of the 2021 digest can be added through Future Year.  

 

Personal Property changes that are picked up during the return period and are not to appear on the 2021 digest 
can be taken care of in Future Year. 

 

To use the Future Module in WinGAP, a Future Folder must be created in the current Appraisal Year folder. This is 
done by clicking on the Create Future Database option. Creating a future year will also automatically perform the 
second menu item for sending live schedules into future. NOTE: It is advisable that no schedule changes be made 
when the Create Future Folder process is running. 

 

 

Clicking Yes will begin the process of creating the Future Folder. As this is done, various Bar Graphs and messages 
will appear as the Future Folder is created and the necessary files are copied to the Future Folder. 

 

 

At the conclusion of this process, WinGAP will produce the Schedules files message, where the OK Button should 
be clicked to send the Current Year Schedules tables to the Future Folder.  
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Once again various messages will be displayed as the Schedules tables are sent to the Future Year. 

 

 

At the conclusion of this process, the user will receive a completion message. Clicking OK will complete the Future 
Year setup process and return the user to the main WinGAP screen. 

 

 

If there were any data integrity issues or duplicated records in the schedules detected during syncing, you will 
receive a dialog alerting you to that and you should contact technical support for resolution. 

 

SEND/SYNC LIVE SCHEDULES TO FUTURE DATABASE 

This option will forward all schedules from the Current Year database to the Future Year database, allowing for 
value changes from schedule updates to be reflected uniformly in both the Current and Future Year databases. 
Clicking yes on the prompt will begin the process. 
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Once complete, the user will be notified that the schedules have been sent to the Future Year database. Parcel 
values will not be updated until a Reappraise process is ran. Clicking OK on this message will return the user to 
WinGAP. 

 

 

SYNC ALL COVENANTS (CUV/FLPA) HISTORY INTO FUTURE  

 

The final menu item in this grouping is Sync CUV/FLPA history into future. Parcels with covenants that were sent 
into future in the first half of the year will likely be missing the current year valuations created when users 
reappraise covenants in the live year. This menu item will sync the history into future, updating the future 
covenant so it will be correct moving forward.  
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ACCESSING FUTURE YEAR 

After the Future Folder creation process has been completed, the user may begin work in the Future Year module 
in the following manner: 

• Search for the parcel/account you wish to add/edit future information. 

• Click the Future button. 

• You will be prompted to create a future record. 
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The dark yellow color screen will let the user know they are in the future year. 

 

 

Once the user has created any future records, the Future Year may be accessed by selecting the Property Maint > 
Future Year menu item from the toolbar or by using the hotkey combination Ctrl+F. This will place WinGAP in the 
Future Year database, identified by the golden background. 
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BROADCAST SHUTDOWN MESSAGE 

When WinGAP is run on networks, occasionally it is necessary to have all users out of the program. Certain 
WinGAP maintenance functions such as program updates require exclusive use of the tables. The Broadcast 
Shutdown Message makes it easy for the WinGAP Systems Manager or WinGAP Technical Support agent to send a 
message to all WinGAP users that they need to exit WinGAP so these procedures can take place. Clicking the 
Broadcast Shutdown Message produces a notification informing the Systems Manager that the message has been 
sent over the network. 

 

 

Within 30 seconds of the Systems Manager sending the message, users on each computer on the network that are 
running WinGAP at the time the message is sent will receive a message to shut down WinGAP. 
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Until the user exits WinGAP, they will continue to receive this message every 30 seconds. The message is 
generated by a text file that the Systems Manager sends to each user’s computer. Once the system or program 
maintenance is finished, the Systems Manager can issue the Clear Shutdown Message from the menu to prevent 
the Shutdown Message from appearing. The users must be told verbally or by other means that WinGAP is once 
again available for use. 

 

CLEAR SHUTDOWN MESSAGE 

When the system or program maintenance that required users to exit WinGAP is completed, the WinGAP Systems 
Manager can delete the message text file that is sent to WinGAP users by clicking the Clear Shutdown Message 
menu option. Clicking this option will produce a notification on the Systems Manager's computer that the 
shutdown message has been cleared. 

 

 

WinGAP users must be told verbally or by other means that WinGAP is once again available for use. 

 

DOWNLOAD ABOS 

This option downloads the latest update to the ABOS boat valuation files. The user must have an ACTIVE Internet 
connection to import the ABOS files. Also, WinZip and the WinZip Command Line Interface must be installed. 
Clicking Begin Download will start the process. On a fast internet connection, the download should take less than a 
minute. 
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Once the connection to the FTP site is established, the user will see several messages, such as “Connecting to FTP 
site”, “Logging On”, “Finding ABOS.Zip”, and “Downloading”. At the conclusion of the download, the user will 
receive the messages “File Downloaded”, “Disconnecting”, and “Done!”. A Command Line window will appear and 
the ABOS files will be automatically unzipped. At the conclusion of the unzipping process, the user can press any 
key. 

 

 

NOTE: The user should make sure that the ABOS tables are unzipped in the command window, and a message will 
appear reminding the user of this. If the unzipping process is not successful, the user will not see the unzipped 
ABOS tables in the Command Window. If this happens, the user should contact a DOR Technical Support agent or 
use WinGAP’s Online Support for assistance. If the unzipping process was successful, the user should click OK on 
the message to begin the table upload process into WinGAP. 
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When the upload process is finished, the user will be returned to the main WinGAP screen. The user should go to 
Tools > Preferences and make sure that the ABOS Year has been updated. 
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DOWNLOAD NADA 

This option downloads the latest update to the NADA valuation files. The user must have an ACTIVE Internet 
connection to import the NADA files. Also, WinZip and the WinZip Command Line Interface must be installed. 
Clicking Begin Download will start the process. On a fast internet connection, the download should take less than a 
minute. 

Note: The NADA download should not take place until the Yearend Cleanup has been performed and the county 
has received notification by email of the NADA schedule upload. 

 

 

Once the connection to the FTP site is established, the user will see several messages, such as “Connecting to FTP 
site”, “Logging On”, “Finding NADA.zip”, and “Downloading”. At the conclusion of the download, the user will 
receive the messages “File Downloaded”, “Disconnecting”, and “Done!”. A Command Line window will appear and 
the NADA files will be automatically unzipped. At the conclusion of the unzipping process, the user can press any 
key. 
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NOTE: The user should make sure that the NADA zip file was unzipped in the command window, and a message 
will appear reminding the user of this. If the unzipping process is not successful, the user will not see the unzipped 
NADA tables in the Command Window. If this happens, the user should contact a DOR Technical Support agent or 
use WinGAP’s Online Support for assistance. If the unzipping process was successful, the user should click OK on 
the message to begin the NADA tables upload process into WinGAP. 

 

 

When the upload process is finished, the user will be returned to the main WinGAP screen. The user should go to 
Tools > Preferences and make sure that the NADA Year has been updated. 
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CONFIGURE GLOBAL PUSH 

Push Tech, when enabled on the Preferences form, will allow changes to property data to sync between appraisal 
years as defined on the Push Configuration form.  
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The County may establish up to five (5) separate digests to sync with edits. When a record already exists in the 
sync digest, only the fields edited will be synced. When the record does not exist at all in the sync digest, the user 
will be prompted and allowed to push the entire record into the sync year. There is also be a checkbox on the 
screen to allow disabling the sync for that single edit. Returning to the record screen will re-enable the sync 
feature. To fully enable Push-Tech the user should go to Preferences and check the enabling checkboxes, and then 
go to the Tools > File Maintenance > Configure Global Push and add the sync digests. 



 
424 

 

 

From this menu, the database(s) that will have information pushed to them from the currently active database 
should be entered here. For instance, if the AY2020 database is open and any edits should be pushed into the 
AY2021 database, the user would click New, key AY2021 in the DB 1 field, then click Apply or OK. 
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When a property record is opened, there will be a “Push Tech Enabled” check box highlighted in purple that is 
checked at the bottom of the property form. Any edits to this record will be pushed to the databases entered on 
the Push Configuration Form. Push Tech will sync edits for any screen this check box is on. The check box can be 
unchecked if the user does not want specific edits on that screen to be pushed. Returning to the screen will re-
check the box. 

 

 

 

CONFIGURE APPEALS PUSH 

Push Tech - Appeals, when enabled on the Preferences form, will allow the user to sync Appeals data between 
appraisal years as defined on the Push Configuration form.  
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The County may establish up to five (5) separate digests to sync with edits. When an Appeal record already exists 
in the sync digest, only the fields edited will be synced. When the Appeal record does not exist at all in the sync 
digest, the user will be prompted and allowed to push the entire record into the sync year. There is a checkbox on 
the screen to allow disabling the sync for that single edit. Returning to the Appeal screen will re-enable the sync 
feature. To fully enable Push-Tech the user should go to Preferences and check the enabling checkbox, and then go 
to the Tools > File Maintenance > Configure Appeals Push and add the sync digests. 



 
427 

 

 

From this menu, the database(s) that will have Appeal information pushed to them from the currently active 
database should be entered here. For instance, if the AY2020 database is open and any Appeals should be pushed 
into the AY2021 database, the user would click New, key AY2021 in the DB 1 field, then click Apply or OK. 
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When an Appeal is opened, there will be a “Push Tech Enabled” check box highlighted in purple that is checked at 
the bottom of the Appeals form. Any edits to this Appeal will be pushed to the databases entered in the Push 
Configuration - Appeals Form. The check box can be unchecked if the user does not want specific edits on that 
Appeal to be pushed. Returning to the screen will re-check the box. 

 

 

NOTE: Any 299c value allocations will NOT be pushed as part of the Push Tech process and must be keyed in any 
other digests manually. WinGAP will notify the user of this with a prompt. 
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CONFIGURE PUSH TECH EXCLUSIONS 

Here the County can define Tables and Fields, Screen Names, and User IDs that are to be excluded from all aspects 
of Push Tech, if either of the Push Tech checkboxes are checked on the Preferences form. 

 

To exclude a single field from pushing forward, it must be entered as TABLE.FIELD. For instance, to exclude the 
Zoning information from pushing, the user would enter REALPROP.ZONINGINFO and click the Include button. Any 
number of fields may be excluded this way. 
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To exclude an entire screen from pushing, simply select the screen(s) from the drop-down menu and click the 
Include button. Any number of screens may be excluded this way. 

 

 

To exclude a Login ID from pushing, simply select it from the drop-down menu and click the Include button. Any 
number of Login IDs may be excluded this way. 
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To remove an exclusion from any of the lists, select the exclusion then click the Remove button. When finished 
adding and removing exclusions from the list, clicking OK will return the user to WinGAP. 

 

BULK OWNER ADDRESS CHANGER 

The Bulk Owner Address Changer finds all owners who match exactly across all address lines and allow a bulk 
change to all matches. This tool is accessible from both the Tools > File Maint > Bulk Owner Address Changer menu 
option as well as the BAC button on the Owner Information screen. 

 

 

Clicking the Search for Owner button will open the Owner Search form, where an Owner may be searched for by 
Name, Parcel #, or Account #, then clicking Open to populate the Bulk Address Change form. 
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This will search for all Owners that have the identical information, but different ownkeys. The Owner records will 
display on the form along with the current Owner mailing address. 
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All the listed Owner records will have their information updated simultaneously when the new mailing address 
information is keyed on the right side of the screen. Checking the Include checkbox will also allow keying a new 
Owner name in the Last Name, First Name, and Middle fields. 
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BULK PARCEL/SUBDIVISION CREATOR 

The Bulk Parcel Creator was designed as a fast and efficient tool to produce a large number of parcels with a basic 
framework of information. The information included when using this tool is: 

• Realkey 

• Parcel Number 

• Alternate Parcel Number 

• Parent Parcel Number 

• Legal Description 

• Tax District 

• Total Acres 

• Subdivision Pricing Code 
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• Neighborhood Code 

• Street Name 

• Assessment Reason 

• Ownership  

• Sale Record 

• Digest Strata 

 

This tool is accessible from both the Tools > File Maintenance > Bulk Parcel/Subdivision Creator menu option as 
well as the BPC button on the Real Property General Information screen. 

 

If the BPC is opened from the Tools menu, it will be blank and the user will need to click the Search For parcel 
button, which will open the Real Property Search form where the parent parcel can be searched for. 
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The Bulk Parcel Creator can be opened directly from the parent parcel by clicking the BPC button. 

 

 

The Base Map, Legal Description, most recent Sale, and Owner information are automatically populated from the 
parent parcel. 
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Realkey: This is the realkey of the parent parcel. 

Base Map: This populates with the entire Parcel Number of the parent parcel. The user should shorten this field to 
just the base map information.  

Number to Create: The total number of new parcels to be created from the parent parcel. 

Space bet Base & Inc#: If the County uses spaces in its parcel number between the base map and the parcel 
increment, this is where the number of spaces is entered (ex. If map 100, parcel 001 is keyed as ‘100 001’ instead 
of ‘100001’, then select this option). 

Parcel Increment #: Where to start numbering the new parcels from (ex. If the parent parcel is 1, then 2 would be 
entered here to start incrementing the new parcels). 

Pad Length: The number of characters used for parcel numbers (ex. If parcels are numbered as 001, 002, etc., then 
the pad length would be 3). 

Pad With Spaces: If spaces are used to pad the parcel number, check this box (ex. If map 100, parcel 001 is keyed 
as ‘100 1’, then select this option). 

Pad With Zeros: If zeros are used to pad the parcel number, check this box (ex. If map 100, parcel 001 is keyed as 
‘100 001’, then select this option). 
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Parcel Suffix: If characters come after the parcel increment, enter them here (ex. If map 100, parcel 001 is keyed as 
‘100 1’, then select this option). 

Legal Desc Prefix: This is the first part of a phrase to be entered in the new parcels’ Legal Description (ex. If the 
Legal Description should say “Lot # XXX at Piedmont Heights”, the Prefix would be “Lot #”). 

Legal Desc Increment: This is the second part of a phrase to be entered in the new parcels’ Legal Description which 
describes where to start the increment for the Legal Description (ex. If the Legal Description should say “Lot # XXX 
at Piedmont Heights”, and the lot numbers should start at lot 5, the increment would be “5”). 

Same as Parcel Increment #: If the Lot # matches the Parcel Increment, checking this box will automatically match 
the Legal Desc Increment to the Parcel Increment #. 

Legal Desc Suffix: This is the third part of a phrase to be entered in the new parcels’ Legal Description (ex. If the 
Legal Description should say “Lot # XXX at Piedmont Heights”, the Suffix would be “at Piedmont Heights”). 

Include Parent Comments: Checking this box will add the parent parcel’s comments from the Realprop screen on 
the newly created parcels. 

Duplicate Parent Land: checking this box will replicate the source parcel’s land onto each bulk created parcel. This 
allows users to manually create multiple parcels and use the Parent’s land configuration as a template for each of 
the bulk parcels to be created. 

Street: The default Street field to be assigned to the newly created parcels. This can be edited later. This table can 
be accessed from the Tools > Schedules/Tables > Street Directory menu option. 

Acres: The default acreage to be assigned to the newly created parcels. This can be edited during the preview 
process. 

Subdiv Code: The Subdivision land value code to be assigned to the newly created parcels. This table can be 
accessed from Tools > Schedules/Tables > Urban land.  

Neighborhood: The Neighborhood code to be assigned to the newly created parcels. This table can be accessed 
from Tools > Schedules/Tables > Neighborhoods. 

Land Strata: The Strata of the newly created parcels can be selected from this drop-down menu. Options include 
Lot, Small Tract, and Large Tract. 

Asmt Reason: The default Assessment Reason to be assigned to the newly created parcels.  

 

After populating the fields with all the relevant information, it is highly advised to click the Preview button. This 
will generate a temporary table with the new parcel information available to review before creating them in the 
live database. From the preview screen, it is possible to edit the Parcel Number, Alternate Pin, Parent Pin, and each 
parcel’s Acres by double clicking the field to be edited and keying the new data. 
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If satisfied with the Preview results, clicking the Create Parcels button will quickly create all the parcels from the 
Preview. Upon completion, the user will receive a notification. 

 

 

The user can now open any of the created parcels to edit the individual parcel details. NOTE: The new property will 
show $0 value until a Reappraise is performed or the Land screen is opened and edited. 
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RECALL DELETED PROPERTY 

The Recall Deleted Property menu option allows the user to bring back a record that has been deleted in error. 
This can be performed from either the current year’s digest or from the prior year’s digest into the current digest. 
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The first step in using the Recall form is to select the type of property to be recalled from the list on the left of the 
menu. The three primary property types are Realprop, Mobile, and Personal. If an entire account was deleted, 
picking the appropriate property type from one of those three will recall the entire record, including owner 
information, sales information, and any subrecords such as boats or accessories associated with the account. If 
only a part of a record was deleted, for instance a house was deleted but the real parcel is still in WinGAP, the user 
would select that property type, in this example it would be Reprop. 

 

The second step in using the Recall form is to enter the Primary Key for the record that is to be recalled. For all Real 
Property that is the realkey, for mobile homes that is the mobilekey, and for Personal Property that is the perskey. 
These keys are also called the Account # in WinGAP. If the user does not know the Account # but does know the 
parcel number or other identifying information, they can search for the record in a prior year digest to locate the 
Account #. 

 

Finally, the user should decide if this deleted record(s) is to be recalled from the current digest or a prior digest. If 
the account was deleted in the current digest, leaving this box unchecked is correct. If the account was deleted in a 
prior digest but it is discovered that this should be in the current digest, then check the Recall from prior AY box 
and enter the digest year that the account was last active in the now active text box below the checkbox. 
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Once these steps are complete, clicking the Validate PKEY button will verify the parcel is able to be recalled. 

 

 

Clicking the Recall button will cause WinGAP to display some messages as it processes the record. When complete, 
the user will be shown a screen notifying the user that the Recall was successful. This screen notifies the user that 
it is important to visit the recalled record to verify the data recalled is correct. 
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SQL DATABASE UTILITY 

This menu option opens SQLMaster, a Relational Database Management System that is installed as part of the 
WinGAP installation process. This is the tool WinGAP uses to perform all the SQL CRUD functions (Create, Read, 
Update, Delete) when the user performs any of these functions in the WinGAP application. This could be 
considered an alternative to SSMS (SQL Server Management Studio), which is the Microsoft application that is also 
used for executing SQL commands. This application does require some initial setup, which can be done with the 
assistance of the Online Support Team. 

 

 

 

FTP UTILITY 

Wingap includes a non-licensed, extremely basic, ftp utility to provide some simple ftp capacity in dire cases. 
Commercially free ftp software is available and far superior, this tool, however, is provided if needed. 
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RE-APPRAISE 

When schedule changes have been made, running Reappraise for the property type that is impacted by the 
schedule modification will update the values for that property type. It is a good idea to run reappraise by each 
property type to ensure that all current values are calculated correctly. 
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REAL PROPERTY 

The Real Property option on the Reappraise sub-menu allows the Assessor’s Office to automatically recalculate 
property values for all Real Property in the County, or selected types of Real Property, due to changes in land 
tables, point cost, depreciation year, etc. Selecting this option takes the user to the Reappraise Form for Real 
Property. 

 

 

The Reappraise Form for Real Property consists of several combo boxes and check boxes where the user can select 
which type of Real Property is to be reappraised. 

 

Starting: The Starting combo box allows the user to choose a starting parcel number for those Real Properties that 
are to be reappraised. The Starting combo box defaults to the first parcel number in the County. The user can click 
on the combo box to select a different Starting parcel number if desired.  

Ending: The Ending combo box allows the user to choose an ending parcel number for those Real Properties that 
are to be reappraised. The Ending combo box defaults to the last parcel number in the County. The user can click 
on the combo box to select a different Ending parcel number If desired. 
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Neighborhood: The Neighborhood combo box allows the user to: 1) reappraise by the parcel number range 
selected previously; or 2) select a specific Neighborhood to reappraise, regardless of what the parcel number 
range is. If the Starting and Ending parcel numbers are to be used for the Reappraise process, the Reappraise by 
Parcel option should be selected in the Neighborhood combo box. 

 

 

If only one Neighborhood is to be reappraised, then the desired Neighborhood should be selected in the combo 
box. 
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Use ADV Query: This allows for Reappraise to be performed on a set of parcels selected by SQL query. When this 
box is checked, the Starting, Ending, and Neighborhood boxes become greyed out and the Advanced Query text 
box is activated. The first part of the SQL query is automatically generated, and the user only needs to enter the 
Where clause. 
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Asmt Reason button: The user can assign an Assessment Reason for this Reappraisal by clicking the Asmt Reason 
button. The Select Assessment Reasons form will appear and an Assessment Reason for this reappraisal can be 
chosen from those available in the list by highlighting the desired item and clicking the Include Button. If a special 
Assessment Reason for this reappraisal is desired, the user can key in the description of the reappraisal in the 
Custom Rsn field then click the Add Custom button on the upper right of the Select Assessment Reasons Form to 
assign this reason to the Reappraisal. This Assessment Reason will be included with any other Assessment Reasons 
already assigned to the parcels selected for reappraisal and this Assessment Reason will be printed on the 
Assessment Notice for each parcel. Once the Assessment Reason(s) for this reappraisal have been selected, the 
user can click the OK Button on the Select Assessment Reasons Form to return to the Reappraise Form. 

 

NOTE: Any Assessment Reason assigned during the reappraise process must be designated as an Inflationary COA 
Type. WinGAP will not allow the assignment of an Assessment Reason if it is not designated as Inflationary in the 
reason table. Any Custom Assessment Reason added during reappraise will automatically be designated as 
Inflationary. 
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NOTE: It is strongly recommended that at least one Assessment Reason be selected for any Re-Appraisal except 
Tax Calculations. If the user elects to Re-Appraise Real Property without assigning an Assessment Reason, a prompt 
will appear reminding the user of this. 
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The default No button can be clicked to Reappraise Real Property without assigning any Assessment Reasons. The 
Yes button can be clicked to return the user to the Reappraise Form, where the Asmt Reason button can be clicked 
to assign an Assessment Reason. 

 

Calculate Taxes: The Calculate Taxes checkbox should be checked when any of the tax calculation schedules are 
updated. The process will re-calculate taxes for each real property parcel. NOTE: the calculation of taxes for REAL 
property and PERSONAL property are separate events. 

Property Type: The Property Type checkbox section of the Form allows the user to select one or more types of 
Real Property to reappraise. Depending upon what property is to be reappraised, the user should click in the 
appropriate checkbox(s). 

Conservation Use and FLPA Use: Updated covenant values and indices can be applied to these types of covenants 
on real property using these check boxes. It is recommended that CUV and FLPA are run independently, i.e. only 
one checkbox at a time. Upon selection of a type of covenant to reappraise the user will also see *FORCE* 
checkboxes appear. WinGAP will calculate and apply the 3% statutory annual limit automatically once per digest 
year either when users run reappraise or when they manually edit/view the covenant screen. After the once per 
year auto calculations, if the user wishes to force the 3% limit calcs they must check the FORCE checkbox. 
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Appraiser Name: The Appraiser Name combo box allows the user to select an appraiser from a list of appraisers or 
key in another name to be assigned to parcels that are reappraised. The assignment of this name will result in the 
name being printed on the Assessment Notice as the primary contact. 

 

If the user is unsure whether to perform the Reappraise procedure, the Cancel button should be clicked on the 
Reappraise Form to return to the main WinGAP screen. Otherwise, the Reappraise button should be clicked to 
begin the reappraisal process. Various messages will display during the reappraise process. The reappraise process 
normally takes less than a minute to complete. 

 

 

When the reappraisal process is finished a message will appear informing the user the reappraise is complete. The 
OK button should be clicked on this message to return the user to the Reappraise Form, where other types of Real 
Property can be reappraised, or the Finished button on the Reappraise Form can be clicked to return the user to 
the main WinGAP screen. 
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PERSONAL PROPERTY 

The Personal Property option on the Reappraise sub-menu allows the Assessor’s Office to automatically recalculate 
machinery, equipment, furniture and fixtures cost item values for all Personal Property accounts. Selecting this 
option takes the user to the Reappraise Form for Personal Property. All Personal Property accounts are 
reappraised at the same time. 
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Asmt Reason button: The user can assign an Assessment Reason for this Reappraisal by clicking the Asmt Reason 
button. The Select Assessment Reasons form will appear and an Assessment Reason for this reappraisal can be 
chosen from those available in the list by highlighting the desired item and clicking the Include Button. If a special 
Assessment Reason for this reappraisal is desired, the user can key in the description of the reappraisal in the 
Custom Rsn field then click the Add Custom button on the upper right of the Select Assessment Reasons Form to 
assign this reason to the Reappraisal. This Assessment Reason will be included with any other Assessment Reasons 
already assigned to the accounts and this Assessment Reason will be printed on the Assessment Notice for each 
account. Once the Assessment Reason(s) for this reappraisal have been selected, the user can click the OK Button 
on the Select Assessment Reasons Form to return to the Reappraise Form. 

 

 

NOTE: It is strongly recommended that at least one Assessment Reason be selected for any Re-Appraisal except 
Tax Calculations. If the user elects to Re-Appraise Personal Property without assigning an Assessment Reason, a 
prompt will appear reminding the user of this. 
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The default No button can be clicked to Reappraise Personal Property without assigning any Assessment Reasons. 
The Yes button can be clicked to return the user to the Reappraise Form, where the Asmt Reason button can be 
clicked to assign an Assessment Reason. 

 

Calculate Taxes: The Calculate Taxes checkbox should be checked when any of the tax calculation schedules are 
updated. The process will re-calculate taxes for each personal property account. NOTE: the calculation of taxes for 
REAL property and PERSONAL property are separate events. 

Appraiser Name: The Appraiser Name combo box allows the user to select an appraiser from a list of appraisers or 
key in another name to be assigned to accounts that are reappraised. The assignment of this name will result in 
the name being printed on the Assessment Notice as the primary contact. 

Enterprise Zone: If checked, allows the County to reappraise only accounts that have an Enterprise Zone year and 
value on the Personal Property General Information form. 

 

If the user is unsure whether to perform the Reappraise procedure, the Cancel button should be clicked on the 
Reappraise Form to return to the main WinGAP screen. Otherwise, the Reappraise button should be clicked to 
begin the reappraisal process. Various messages will display during the reappraise process. The reappraise process 
normally takes less than a minute to complete. 

 

 

 

 

 

PREBILL MANUFACTURED HOUSING 

The Prebill Manufactured Housing option on the Reappraise sub-menu allows the Assessors' Office to 
automatically recalculate property values for all Prebilled Manufactured Homes in the County due to changes in 
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manufactured housing schedules. Selecting this option takes the user to the Reappraise Form for Prebilled 
Manufactured Homes. All Prebilled Manufactured Homes are reappraised at the same time. 

 

 

Appraiser Name: The Appraiser Name combo box allows the user to select an appraiser from a list of appraisers or 
key in another name to be assigned to Prebilled Manufactured Homes that are reappraised. The assignment of this 
name will result in the name being printed on the Assessment Notice as the primary contact. 

 

If the user is unsure whether to perform the Reappraise procedure, the Cancel button should be clicked on the 
Reappraise Form to return to the main WinGAP screen. Otherwise, the Reappraise button should be clicked to 
begin the reappraisal process. Various messages will display during the reappraise process. The reappraise process 
normally takes less than a minute to complete. 
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BOATS - ABOS 

The Boats - ABOS option on the Reappraise sub-menu allows the Assessors' Office to automatically recalculate 
values for all Boats in the County using the ABOS schedules. Selecting this option takes the user to the Reappraise 
Form for Boats. All Boats are reappraised at the same time. 
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Asmt Reason button: The user can assign an Assessment Reason for this Reappraisal by clicking the Asmt Reason 
button. The Select Assessment Reasons form will appear and an Assessment Reason for this reappraisal can be 
chosen from those available in the list by highlighting the desired item and clicking the Include Button. If a special 
Assessment Reason for this reappraisal is desired, the user can key in the description of the reappraisal in the 
Custom Rsn field then click the Add Custom button on the upper right of the Select Assessment Reasons Form to 
assign this reason to the Reappraisal. This Assessment Reason will be included with any other Assessment Reasons 
already assigned to the Boats and this Assessment Reason will be printed on the Assessment Notice for each Boat. 
Once the Assessment Reason(s) for this reappraisal have been selected, the user can click the OK Button on the 
Select Assessment Reasons Form to return to the Reappraise Form. 

 

 

NOTE: It is strongly recommended that at least one Assessment Reason be selected for any Re-Appraisal except 
Tax Calculations. If the user elects to Re-Appraise Real Property without assigning an Assessment Reason, a prompt 
will appear reminding the user of this. 
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The default No button can be clicked to Reappraise Real Property without assigning any Assessment Reasons. The 
Yes button can be clicked to return the user to the Reappraise Form, where the Asmt Reason button can be clicked 
to assign an Assessment Reason. 

 

Calculate Taxes: The Calculate Taxes checkbox should be checked when any of the tax calculation schedules are 
updated. The process will re-calculate taxes for each personal property parcel. NOTE: the calculation of taxes for 
REAL property and PERSONAL property are separate events. 

Appraiser Name: The Appraiser Name combo box allows the user to select an appraiser from a list of appraisers or 
key in another name to be assigned to Boats that are reappraised. The assignment of this name will result in the 
name being printed on the Assessment Notice as the primary contact. 

 

If the user is unsure whether to perform the Reappraise procedure, the Cancel button should be clicked on the 
Reappraise Form to return to the main WinGAP screen. Otherwise, the Reappraise button should be clicked to 
begin the reappraisal process. Various messages will display during the reappraise process. The reappraise process 
normally takes less than a minute to complete. 
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MFG HOUSING - NADA 

The Mfg Housing - NADA option on the Reappraise sub-menu allows the Assessors' Office to automatically 
recalculate all Manufactured Housing using the NADA schedules. Selecting this option takes the user to the NADA 
Reappraise Form. 

 

 

Both Prebilled and Non-Prebilled Mobile Homes can be reappraised on this form (Non-Prebilled Mobile Homes 
that have a checkmark in the House Pricing Checkbox will not be reappraised). If the user wants to change the 
pricing method to NADA for all Mobile Homes that have direct Manufacturer/Model matches in the NADA 
schedule, that checkbox should be clicked with the mouse. 

 

If the user is unsure whether to perform the Reappraise procedure, the Done button should be clicked to return to 
the main WinGAP screen. Otherwise, the Reappraise button should be clicked to begin the reappraisal process. 
Various messages will display during the reappraise process. Depending on the number of Prebilled or Non-
Prebilled Mobile Homes in the County, the process could last from less than a minute to a few minutes. 
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When the reappraisal process is finished, a message will be displayed, as seen below, informing the user that the 
reappraisal process is completed. The OK button should be clicked to return the user to the NADA Reappraise 
Form. 

 

 

The top list box on the NADA Reappraise Form will display Mobile Homes that do not have direct 
Manufacturer/Model matches in the NADA schedule. The bottom list box will display Mobile Homes that have 
direct Manufacturer/Model matches in the NADA schedule but have invalid length, widths, or year built according 
to the NADA schedule. 
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If any Mobile Homes appear in these list boxes during the reappraise process, these Mobile Homes did not have 
NADA matches and could not be reappraised. The user can print these lists by clicking the Print List button at the 
bottom left of each list box. 
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After printing the list, the user should click the Done button on the Reappraise form and then go to the Prebilled 
Mobile Home account (the Mobilekey), if the Prebill checkbox was checked, or the Residential Improvement 
account (the Realkey for that Improvement, and then the Mobilekey for that Mobile Home), if the Non-Prebill 
checkbox was checked, for all these Mobile Homes and make any necessary changes for these Mobile Homes. 
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PREFERENCES 

The Preferences Form is where various background information about the Assessor’s Office is entered, controls the 
network server paths, and is where many options for WinGAP are turned on/off. 
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COUNTY INFORMATION 

 

 

Co. Name/Num: The first of the fields in the County Information Section of the Preferences Form is where the 
County Name, such as Pickens, is keyed. It is not necessary to key "County" after the County Name. WinGAP will 
verify that the County Name is spelled properly. The Num field is assigned by WinGAP, is county specific, and is not 
accessible to the user. 

Address: Three fields are provided for keying the address of the Assessors' Office. This is the address that will show 
on various forms that are mailed to the taxpayer, such as PT-50 forms. 

City/State/Zip: Three fields are provided for keying the City, State, and Zip Code of the Assessors' Office. This is the 
City, State, and Zip Code that will show on various forms that are mailed to the taxpayer, such as PT-50 forms. 

Phone/Ext: The primary phone number, and phone extension, if used, of the Assessors' Office are keyed in these 
two fields. 

Fax: The fax number of the Assessors' Office is keyed in this field. 

Email: The email address of the Assessors' Office is keyed in this field. 

Web: If the Assessors' Office has a website, the URL (such as www.assessorsoffice.gov), is keyed in this field. The 
Real Property Website button, accessible via the Third-Party button on the Real Property General Information 
form, uses this field to direct WinGAP to the desired web URL. Typing qpublic.schneider in the web box will open 
the parcel on the county’s qPublic site if they subscribe to the service. 

 

POINT/BASE COSTS 
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Residential: The Residential Point Cost field contains the value which converts points generated by WinGAP for 
Residential Improvements into a dollar value for each Residential Improvement. For example, if a house has a total 
of 300 points and the point cost is 100.00, a house value of $30,000 would result from the calculation of 300 * 
100.00. Some counties set the Residential Point Cost to 1.00 and use actual dollars per square foot to arrive at the 
value for the Residential Improvement. This approach is more easily understood by some appraisers and taxpayers 
than the point system, though the value produced should be the same. The Residential Point Cost lets the county 
localize property values for Residential Improvements. Arriving at the point cost for a particular county requires a 
study of sales. Assistance with the study can be provided by DOR personnel. 

Commercial: The Commercial Point Cost field contains the value which converts points generated by WinGAP for 
Commercial and Industrial Improvements that are priced by the Lump Sum Method into a dollar value for each 
Commercial or Industrial Improvement. Some counties set the Commercial Point Cost to 1.00 and use actual 
dollars per square foot to arrive at the value for the Lump Sum Commercial and Industrial Improvement. This 
approach is more easily understood by some appraisers and taxpayers than the point system, though the value 
produced should be the same. The Commercial Point Cost lets the county localize property values for Commercial 
and Industrial Improvements. Arriving at the Commercial Point Cost for a particular county requires a study of 
sales and assistance with the study can be provided by DOR personnel. 

Commercial Base: The Commercial Base Cost field contains a dollar per square foot value that is used as the basis 
for the valuation of all commercial and industrial buildings and extra features that are priced by the Square Foot 
Method. The value of each building and extra feature is based on a percentage of the base cost. 

Accessory: The Accessory Point Cost field contains the value which converts points generated by WinGAP for 
Accessory Improvements into a dollar value for each Accessory Improvement. Some counties set the Accessory 
Point Cost to 1.00 and use actual dollars per square foot to arrive at the value for the Accessory Improvement. This 
approach is more easily understood by some appraisers and taxpayers than the point system, though the value 
produced should be the same. The Accessory Point Cost lets the county localize property values for Accessory 
Improvements. Arriving at the point cost for a particular county requires a study of sales. Assistance with the study 
can be provided by DOR personnel. 

 

DEPRECIATION YEARS 

 

 

Residential: The Residential Improvement Depreciation Year field contains the base year from which system 
generated depreciation is calculated. The age of a Residential Improvement is determined by subtracting the year 
built or effective year built from the depreciation year. This locks depreciation in until the county decides to 
change it. Any Residential Improvements with a year built greater than the depreciation year will be determined to 
have an effective age of one year. 
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Commercial: The Commercial Improvement Depreciation Year is the base year from which the system generated 
depreciation for Commercial and Industrial Improvements is calculated. The age of a Commercial or Industrial 
Improvement is determined by subtracting the year built or effective year built from the depreciation year. This 
locks depreciation in until the county decides to change it. Any Commercial structures with a year built greater 
than the depreciation year will be determined to have an effective age of one year. 

MFG Housing: The MFG Housing Depreciation Year is the base year from which the system generated depreciation 
for Manufactured Housing is calculated. The age of a Manufactured Home is determined by subtracting the year 
built or effective year built from the depreciation year. This locks depreciation in until the county decides to 
change it. Any Manufactured Home with a year built greater than the depreciation year will be determined to have 
an effective age of one year. 

Accessory: The Accessory Improvement Depreciation Year is the base year from which the system generated 
depreciation for Accessory Improvements is calculated. The age of an Accessory Improvement is determined by 
subtracting the year built from the depreciation year. This locks depreciation in until the county decides to change 
it. Any accessory buildings with a year built greater than the depreciation year will be determined to have an 
effective age of one year. 

 

 

LABEL AND TEMPLATE OPTIONS 

 

 

Special District Description: The Real and Personal Property General Information Forms contain a checkbox that 
can be used by the County to group tax bills for specific valuation and billing purposes. The County can use the 
Special District Description field on the Preferences Form to customize for local purposes the description that 
displays on the General Information Forms next to this field. 

Parcel Number Template: The County's Parcel Number structure is customized by utilizing the Parcel Number 
Template field. Most WinGAP counties use the default Template of XXXX-XXX-XXXX-XXX, where the first four Xs 
represent the Map Number, the next three Xs the Block Number, the next four Xs the Parcel Number, and the last 
three Xs the Sub Parcel Number. The field can accommodate a Parcel Number up to 30 characters in length, 
including the dashes. The "X" Template symbol will accept any character or number as part of the Parcel Number; 
if a County wanted to restrict the entire Parcel Number, or a portion of the Parcel Number to just numbers, the 
Template symbol of "9" would be used in place of the "X". 

Customize Lender Label: The Real Property General Information Form contains a Lender field that is used to group 
tax bills that are escrowed to a particular lending institution. The County can use the Customize Lender Label field 
on the Preferences Form to customize the description of this field. 

Customize Occupancy Label: The Residential Improvements Form contains a field where the type of Occupancy 
(One Family, Two Family, Manufactured Home, etc.) of the Improvement is specified. The County can use the 
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Customize Occupancy Label field on the Preferences Form to customize the description of the Occupancy field on 
the Residential Improvements Form. 

Customize Fireplace Label: The Residential Improvements Form contains a field where the type and number of 
Fireplaces found on the Improvement are specified. The County can use the Customize Fireplace Label field on the 
Preferences Form to customize the description of the Fireplace field on the Residential Improvements Form. 

Customize Heated Area Label: The Residential Improvements Form contains a field where the heated square 
footage of the Improvement is specified. The County can use the Customize Heated Area Label field on the 
Preferences Form to customize the description of the Heated Area field on the Residential Improvements Form. 

 

GENERAL SETTINGS PART 1 

 

 

Appraisal Year: The current Appraisal Year (or tax digest year) is keyed in this field. Other Appraisal Years can be 
selected for review by clicking on File > Select Appraisal Year on the WinGAP Tool Bar. 

Rural Acre Break: The Rural Acre Break is used to enter the acre level at which rural large tract valuation begins. 
From this acre level upward, values will be entered in the Accessibility/Desirability Table (found in Tools > 
Schedules/Tables > Accessibility/Desirability) as factors. All values in the Accessibility/Desirability Table below the 
acre level will be entered as tract values. If the Rural Acre Break is at the 30-acre level, it would be keyed in the 
Rural Acre Break field as 30.00. 

PU Eq Ratio %: The Public Utilities Equalization Ratio percentage field is used to adjust the value of public utility 
property. Public Utility property values should be entered at 100% and the property classed as Utility before the 
Equalization Ratio will be applied to adjust values accordingly. If the Public Utilities Equalization Ratio percentage 
for the County is 40, it would be keyed as 40.00. 

Return Deadline: A default deadline that will print on Personal Property reporting forms can be keyed in this field. 

Default Startup Directory: The default data directory or folder, such as AY2021, can be selected from the available 
data folders by clicking on the Default Startup Directory combo box. 

Guest Startup Directory: The guest startup directory is used when the Guest button is clicked on the Login screen. 
The selection of the guest startup directory is at the discretion of the Assessors. Many counties elect to maintain a 
Guest Startup Directory that corresponds to the last approved digest. This is done due to the view that current 
year information is work-in-progress and may provide misinformation to a Guest. 
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SERVER OPTIONS PART 1 

 

 

SQL Server Name: The Machine and Instance Name of the MSSQL Server name in the County.  

Server PT61 Path: The File Path to the PT61 folder from the Server’s perspective. MSSQL operates at a lower level 
than mapped drives. MSSQL cannot see mapped drives, so the physical disk path is needed here. Universal Naming 
Convention (UNC) will work but physical drive assignment is preferred for WinGAPSQL. 

Server Photo Path: The File Path to the Pictures folder from the Server’s perspective. 

Sketch Export Path: The File Path to the Sketch Export folder from the user’s Workstation perspective. 

Server Sketch Export Path: The File Path to the Server Sketch Export folder from the Server’s perspective. 

Server Share Path: The File Path to the Core Application Share on the Server from the user’s Workstation 
perspective. 

 

SERVER OPTIONS PART 2 

 

 

COC Deed Path (Char 100): The Deed Path is obtained from the Clerk of Superior Court in the County and is used 
to print the deed image for a sale using the button to the left of the deed information fields on the Sales 
Information form. The pathing should include everything except the actual book and page information (which is 
found on the Sales Information form). The existing formatting for the pathing and display of images assumes the 
following syntax: <COREPATH>\<Deed book zero padded on the left – 5 chars>\<Deed page zero padded on the 
left – 5 chars>.tif 

COC Plat Path (Char 100): The Plat Path is obtained from the Clerk of Superior Court in the County and is used to 
print the plat image for a sale using the button to the left of the plat information fields on the Sales Information 
form. The pathing should include everything except the actual book and page information (which is found on the 
Sales Information form). The existing formatting for the pathing and display of images assumes the following 
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syntax: <COREPATH>\<Deed book zero padded on the left – 5 chars>\<Deed page zero padded on the left – 5 
chars>.tif 

Rapid Sketch Path: This path defines the location of the RS (RapidSketch) folder, where RS images are stored for 
use by the RapidSketch sketching module. Each of the County’s appraisal years will have a folder in the RS folder 
and the RS images for that appraisal year will be in that folder. 

RPGI – Custom Reports: This feature allows up to three (3) “county reports” to be opened from the RPGI screen. 
The only requirement for these reports is the report must have a parameter named nRealkey (case-sensitive) 

Permit Staging Year: This field allow counties to control the ‘permit year’ used for importing permits using the 
Permit Staging module. The Permit Staging year will be reset to match the digest year during year end cleanup. The 
permit staging year will appear at the bottom left of the permit staging screen as a reminder. 

 

 

GENERAL SETTING PART 2 

 

 

ABOS Default: The default pricing method for Boats/Motors using the ABOS schedules can be set by selecting one 
of the three available options from this combo box (High, Low, or Retail). 

Land Influences: Adjustments to Land Values can be made on the Land Information Form in WinGAP. Up to seven 
adjustments to either Urban or Rural Land can be applied. The way these Land Influence adjustments are made is 
determined by the choice made on the Land Influences combo box on the Preferences Form. The two choices are 
Additive and Compound (also called multiplicative). 

• The default method for Land Influences in WinGAP, the formula for Compound application of Land 
Influences is as follows: Base Land * Influence1 * Influence2 * Influence3 * Influence4 * Influence5 * 
Influence6 * Influence7 * Neighborhood Influence. 

• The formula for Additive application of Land Influences is as follows: (Base Land + ([(1-Influence1) * Base 
Land] + [(1-Influence2) * Base Land] + [(1-Influence3) * Base Land] + [(1-Influence4) * Base Land] + [(1-
Influence5) * Base Land] + [(1-Influence6) * Base Land] + [(1-Influence70 * Base Land]) * Neighborhood 
Influence. 

In these formulas, Base Land is the value of the land resulting from the calculation of the land subrecords. In the 
case of Rural Land, the Base Land value would include the application of the Accessibility/Desirability factor. 

ABOS Year: The year that the ABOS Schedules currently in use by WinGAP were updated. 

NADA Year: The year that the NADA Schedules currently in use by WinGAP were updated. 
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OTHER OPTIONS SECTION 

 

Truncate Values: If a checkmark is placed in the Truncate Values checkbox and the Replacement Cost New – 
(minus) Depreciation (or RCN – Dep) is greater than 1000, all values will be truncated to the nearest $100. For 
example, a Residential Improvement that has a value of $126,767 will be truncated to $126,700. If the 
Replacement Cost New – Depreciation is less than 1000, all values will be truncated to the nearest $10, meaning 
$98 truncates to $90. Truncation is accomplished by dividing the RCN-Dep value by 100 and not rounding the 
result. The resulting quotient is then multiplied by 100. 
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Disable Logins: Placing a checkmark in the Disable Logins checkbox will disable logins and allow complete access to 
WinGAP to any user. Removing the checkmark will cause the WinGAP Login Form to appear each time that 
WinGAP is run, requiring each user to enter a Login ID and Password unless the Guest Button is clicked to gain 
limited access. 

bBrowser Cost Form: Changes the way the information is displayed on the Basic Cost Approach Form that is 
reached from the Personal Property General Information Form when the user clicks the MEFF button. When the 
bBrowser Cost Form checkbox is left unchecked, the Cost items are displayed in a normal list box; if checked, the 
Cost items are displayed in a bBrowser list box. 

 

Normal List Box bBrowser List Box 

 
 

 

Lock System: The Lock System checkbox is used to lock all other users except the system administrator or primary 
operator out of WinGAP. This is done at those times when access to WinGAP files must be restricted, such as 
Updating WinGAP or Year End Cleanup. 

Rnd Area Mult to 6 dec: If checked, the Round Area Multiplier to 6 Decimals checkbox will round the residential 
improvement area multiplier to 6 decimal places instead of 2. Checking the box will result in value changes for 
almost all Residential Improvements but will remove an anomaly in the Area Multiplier calculation that is present 
when the Area Multiplier is rounded to 2 decimal places. 

Auto Reasons (Real): Provides the user with the ability to turn on/off the automatic change of assessment reasons 
for Real Property. If the box is checked, auto-reasons will be applied.  

Auto Reasons (Personal): Provides the user with the ability to turn on/off the automatic change of assessment 
reasons for Personal Property. If the box is checked, auto-reasons will be applied. 

PT50R = LIVE DATA: Provides the user with the ability to select the year from which PT50 data is printed. If a check 
is placed in this checkbox, all PT50R's will be printed with data from the current digest year. If no checkmark is 
present, data on the PT50R will be printed from the pt50r.dbf which is populated with previous year’s data during 
Yearend Cleanup. 

COA Auto-Flag: If the COA Auto-Flag checkbox is checked, the user will not be prompted for flagging a real or 
personal account for a Change of Assessment notice. The flag will be automatically set if the value or ownership 
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changes. If the box is unchecked, the prompt for COA flag will appear on the Real or Personal Property Forms as in 
past versions of WinGAP. 

Hide Comments: If this box is checked, comments on the Real Property General Information Form and Personal 
Property General Information Form will be hidden from Guest logins. The comments will not be printed on the 
Property Record Card for Guests. Personal Property PRCs cannot be printed by Guests. The Comments will be 
redacted from the Public Export. 

Bsmt: Use Max/Min Area: Placing a checkmark in this checkbox provides the user with the capability of using the 
Residential Improvement Schedules Maximum and Minimum Areas in the calculation of the Area Multiplier for 
Basements. The Area Multiplier will be rounded to 6 decimals for Basements instead of 3 decimals when this 
calculation method is selected. Checking the box will result in value changes for all Residential Improvements that 
have Basements. 

Attic: Use Max/Min Area: Placing a checkmark in this checkbox provides the user with the capability of using the 
Residential Improvement Schedules Maximum and Minimum Areas in the calculation of the Area Multiplier for 
Attics. The Area Multiplier will be rounded to 6 decimals for Attics instead of 3 decimals when this calculation 
method is selected. Checking the box will result in value changes for all Residential Improvements that have Attics. 

Int Label in Base Heat: This checkbox provides the user with the capability of having Interior Labels contribute to 
the Base Heat Points for a Residential Improvement. Checking the box will result in the overall lowering of 
Residential Improvement values for any Residential Improvements that have Interior Labels. 

Show State Tax Levy: This checkbox allows the user to designate if they want the State tax entity of $0.00 tax due 
to show on the Assessment Notices and on the Estimated Taxes form on the Real and Personal Property General 
Information forms. Checking the box will show the State tax; if unchecked, it will not show. 

Basement 100% in Heated: This checkbox allows counties to exclude the area of a 100% finished basement from 
the improvement’s heated area. The default (the box is checked) will be to include the 100% basement area into 
heated area to match WinGAP’s historical usage. 

NOA Direct to PDF: This checkbox, which is checked by default, provides the user with the capability of having the 
Notice of Assessment for 30-day notices of assessment that are printed directly from the Real or Personal property 
account’s General information screen automatically generate the NOA in PDF format inside the account’s 
document folder. 

Push Tech: Push Tech, when enabled on the Preferences form, will allow WinGAP to sync property data between 
appraisal years as defined on the Push Configuration form. More information on this can be found in this manual 
under Tools > File Maintenance > Configure Global Push. 

Push Tech - Appeals: Push Tech - Appeals, when enabled on the Preferences form, will allow WinGAP to sync 
Appeals data between appraisal years as defined on the Push Configuration form. More information on this can be 
found in this manual under Tools > File Maintenance > Configure Appeals Push. 

Sketch Com Ex Features: This checkbox provides the County with the capability of having the sketched Commercial 
Extra Feature generate the value for the Extra Feature and display it on the Commercial Improvements form. The 
Extra Feature will not have to be added to the Extra Features table. A Commercial Improvement can have a mix of 
sketched Extra Features and non-sketched Extra Features if the non-sketched Extra Features are added to the Extra 
Features table. NOTE: If the County’s past practices have been to sketch the Extra Feature and enter the Extra 
Feature on the accessory screen also, you will need to remove/delete one of those items, either the sketched Extra 
Feature or the Extra Feature added to the Extra Features table (known as the Accessory table) to avoid double 
pricing/valuation. 

Enable Abatement Calcs: This checkbox, if checked, provides the County with the capability of entering an 
exemption percentage for any Real Property parcel or Personal Property account and their associated property 
items, and WinGAP will calculate the taxable value based on this exemption percentage. The Abatement checkbox 
must be checked on the Real Property or Personal Property General Information form for the Abatement Ex % field 
to appear. Any Overrides are excluded from the exemption percentage process and will remain exactly as they 
were before any abatement percentage is applied. When first applying an abatement percentage to a parcel or 
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account and then saving it (by the Apply or OK button), that percentage will be applied to all child items, and those 
items will be repriced (if not on Override) and the parcel’s Current Value will reflect the % added. To remove the 
Abatement on the parcel or account, uncheck the Abatement box and save the record. Values will revert to the 
normal FMV. 

Enable INEDIT feature: This checkbox provides the County with the capability to alert users when a property item 
is in use (open on another user’s computer) and will prevent simultaneous editing. The first user to open the item 
will get the lock, others will be alerted that the first user has that item open. When the first user closes the item, 
the INEDIT table record is removed and any other user is free to open/edit that particular property item. Tables 
that are open can be viewed and removed, if necessary, on the Tools > File Maintenance > IN-EDIT Admin form. 

ABOS as default: This checkbox allows the County to set the default pricing method to ABOS for any marine 
equipment that is added to WinGAP. 

Resize Photos: This checkbox provides the County with the option of resizing photos automatically when they are 
loaded (viewed) in WinGAP. It should be noted that resizing photos with this feature will remove some of the 
metadata and geo-tagging embedded in some digital photos. 

Sum Bsmt to Screen: This checkbox provides the County with the option of having sketched Basement areas flow 
to the Basement Area on the Residential Improvements form. The auto-sum basement area will only update the 
Basement Area field if the field value is zero prior to sketching. The sketched area appearing in the Basement Area 
field on the Residential Improvements form can be overridden by the user by keying a different area in the 
Basement field. 

Show v1 Sketch Checkbox: This checkbox is disabled, and this feature is no longer used. 

PT61 Efficiency Mode: This checkbox provides the county with what is called the PT61 Efficiency Mode, which will 
suppress most of the PT61 screen display and simply process the name change. The Efficiency Mode has more 
assumptions built in and was designed for a County where the sales entry, parcel processing, and appraisal 
procedures are more distributed between many people. Smaller counties will probably prefer to not use the 
Efficiency Mode so that each of the screens in the normal PT-61 process appear and allow data entry and 
comments on the applicable screens. PT61 Efficiency Mode is controlled by Admin Level users using this checkbox. 

Auto Close: This is a security feature available in WinGAP that will allow the application to auto-close if not used 
for a period of time (20/30/45/60 minutes) designated on the preferences screen. If a user leaves or gets called 
away from their desk, the application will automatically close after this set period of time preventing a passerby 
from making edits under their login name. 

 

Changes to the Preferences Form are saved by clicking the Close Button, which returns the user to the WinGAP 
Main screen. 

 

 

CHANGE BACKGROUND COLOR 

The color and pattern of the Main WinGAP screen can be modified by the user within certain boundaries. Clicking 
this menu option will produce the Change Windows Background form. The current default for the Main screen 
Background will display. 
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The default is a Dithered Green Bitmap. The user can change the default to any of the other radio button options 
shown on the background form. For example, the user could choose the Swimming Pool Bitmap for their 
background. 
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The user can also import a picture of their choosing to become the WinGAP background. The picture must be in 
Bitmap format. The user should select the User Bitmap radio button option, then click the Browse button to the 
right of the combo box. 

 

 

This will produce the Open dialogue box. The user should navigate to the location of the desired picture and click 
the Open button. 
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The Bitmap image will now be in the User Bitmap field on the Change Background form, and the user can click the 
Get File button. 
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This will immediately change the Background image to the selected Bitmap. The user should click the Close Button 
on the Change Window Background form to save the image, and the new WinGAP Background will now default to 
the selected image. 

 

 

 

REGISTER COM ASSEMBLIES (REQUIRES ADMIN)  

This menu will attempt to re-register some of the windows application files used by WinGAP and SQLMaster. These 
would normally only be run by advanced technical support. 
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ADD-ONS MENU 
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PT61 DOWNLOAD 

The PT61 Download process downloads the PT61s for the current week from the State Clerk of Court’s office and 
provides the user with the ability to manage the e-filed PT61 documents. This menu option is used to Download a 
zip file of an entire week of PT61s, Extract the text files from the zip file, Append text data into WinGAP PT61 
temporary data files, and Merge data from temporary files into working files. 

 

Prior to downloading PT61s, the following items must be adhered to: 

• WinZip and the WinZip Command Line application must be installed on the computer(s) that will be 
working with the PT61 download and extraction routines. WinZip must be installed into the C:\Program 
Files\WinZip folder which is the default installation folder for WinZip. 

• The computer that will be downloading the PT61 files must have an internet connection. 

• The correct county name must be entered in the County Name field found on the Preferences screen 
(Tools > Preferences). 

 

Users that will not be downloading and extracting the PT61 files but will be matching PT61’s with parcels and 
passing data into WinGAP do not require the installation of WinZip or the WinZip Command Line application on 
their machines. These computers also do not require any internet connection. 

 

The PT61 files and associated data will be maintained in a WinGAP subfolder named PT61. Four data files and four 
temporary files will be used to store and manipulate PT61 data. The four data files are: 

• PT61_filing.dbf 

• PT61_actor.dbf 

• PT61_prop.dbf 

• PT61_tax.dbf 

 

The temporary files are: 

• PT61_filing_temp.dbf 

• PT61_actor_temp.dbf 

• PT61_prop_temp.dbf 

• PT61_tax_temp.dbf 

 

In addition to the data and temporary files in the PT61 folder, the user will find a pt61.log file containing the 
following data for each Append and Merge: 

• Date of the appended PT61 text files 

• Date of the merged PT61 files 

 

The primary function of the pt61.log is to prevent the appending and merging of duplicate data. The date of the 
PT61 text files is checked against dates in the pt61.log and if the date is found, the process is terminated with a 
message informing the user that the files have already been merged. 
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Clicking the PT61 Download menu option from the Add-Ons menu opens the PT61 Download Form. 

 

 

Step 1: Download 

Clicking the Download button will retrieve the most current week’s PT61 file. PT61s should be downloaded weekly 
when notice of the Current Week’s release of PT61 data is received. If they are, this is all that is needed for the first 
step and the user may proceed to the Extract step. 

NOTE: The FTP checkbox, located at the top right of the PT61 Download screen is the default method for 
downloading PT-61 files and will connect the user to ftp://ftp.wingap.com. The FTP checkbox should remain 
checked unless the user has problems connecting to the file transfer site, in which case the box should be 
unchecked to connect the user to the www.wingap.net site for the downloading of the PT61 files. 

NOTE: If there is not a current week PT61 file for the county, the user will see a message that the county’s PT61.zip 
file was not found and will be disconnected from the FTP server. The user can verify this by visiting 
www.wingap.net and viewing the current week information. 
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If the user needs to download PT61s from a prior week, or if the computer that is performing the Extract, Pend, 
Merge process does not have access to the internet, the Archive button can be used to manually select a PT61 zip 
file to process in WinGAP. The first step will be to visit www.wingap.net and to click on the link on the left side of 
the page for the week that should be downloaded, then navigating to the County’s name and clicking the archived 
link to download the PT61 archive file. 

 

 

Clicking the Archive button on the PT61 Download form will open a dialogue box where the file that was just 
downloaded should be navigated to, and the file selected. The file will be named exactly like it was shown on the 
wingap.net archive page beside the County name. 
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Selecting the zip file and clicking Open on the dialogue box will prepare the Download module to extract that 
week’s files. The Download button will grey out and the file path of the zipped archive will be displayed below the 
Archive button. Form here, the user can proceed to the Extraction step. 

 

 

Step 2: Extract 

A pass phrase is no longer needed to extract PT-61 files. All the user must do is click the Extract Button.  
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A command prompt window will display that the correct PT-61file has been found and unzipped successfully, and 
the user can proceed to the Append step. 

 

 

If a different message appears, the PT61 files have not been extracted. The Messages might say that the download 
was corrupt or that the proper WinZip applications have not been installed. The user may attempt another 
download and extraction to see if that corrects the problem. If the user is unable to successfully extract the files, 
the County should seek assistance through the WinGAP OnLine Support web page or by emailing the DOR support 
agents. 

 

Step 3: Append 

The Append process places the data contained in the PT61 text files into a set of temporary files. Clicking the 
Append button will begin the process. At the conclusion of the process, the user is provided with the message 
“Append Completed!”, where the OK button can be clicked and the user can proceed to the Merge step. 



 
484 

 

 

If the PT61 files for this time period have already been Appended and Merged, the Append process is terminated 
with the following message informing the user that the files have already been merged. If this message is 
displayed, the user can proceed to the next step as this one has already been performed. 

 

 

Step 4: Merge 

The Merge process moves the data in the temporary files and places it in the live PT61 files. Before the move takes 
place, a check is made against entries in the pt61.log to ensure that sets of PT61 data are not duplicated. To begin 
the merging of data, the user should click the Merge button. 

 

 

If the PT61 text files have been previously merged, the user will receive a notification message after clicking 
Merge. The user should click OK. If the user is uncertain about the previous merge of the PT61 data, assistance 
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should be sought from WinGAP Online Support, your DOR support agent, or the WinGAP administrator in the 
Assessors’ office. 

 

 

After the merge is completed, the user can Print the PT61’s and begin the Matching process. 

 

Print PT61s 

The Print PT61s button found in the lower left of the Download screen provides the user with the ability to print 
PT61’s by date ranges. 

 

 

Clicking the Print PT61s button takes the user to the PY61 Print Selections form where the beginning and ending 
date for printing the PT61s can be defined. The date fields are for the date the PT61 files were added to WinGAP. 
The checkbox beside the fields is inactive and does not affect the search.  



 
486 

 

 

If Sales Surveys are to be sent to the purchasers, clicking the Print Surveys button will generate sales surveys that 
can be mailed and the user will be given the option to mark the sales as “Survey Sent”. 

 

 

To preview the PT61 forms, the user should click OK. The PT61s are previewed and printed in Deed Book/Deed 
Page order. The Cancel button should be clicked to close the window without printing anything. 
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PT61 MATCH 

The PT61 Match module can be accessed from the Add-Ons menu or from the PT61 Downloads form. The PT61 
Matching module coordinates the transfer of PT61 information to the correct parcel in WinGAP. Clicking on this 
option will open the PT61 Match form. 
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By default, the PT61 records to be worked are displayed in Buyer name order. Clicking on the Search Field combo 
box under the PT61 Search in the upper left of the form will allow the user to order the PT61s by Account Number, 
Buyer Name, Deed Book and Page, Parcel Number, PT61 Document Number, Sale Date, or Seller Name. Optionally, 
the user may filter the PT61s displayed by entering a search string in the Search Text box. Clicking the Search 
button will reorder the PT61s by the selected Search Field and apply any Search Text filter to the displayed results. 

 

After clicking on a record in the PT61 List, some identifying information for that PT61 will display below the List, 
where the Parcel Number or Account No field will have information that can be keyed in the Search Text field of 
the Real Property Search in the upper right of the form. The Search Field can be swapped between the Parcel 
Number and the Realkey as necessary depending on the identifying information from the PT61. If the property is to 
be a split, the parent parcel is selected. After keying in the Parcel Number or Realkey, clicking the Search button 
will jump to that record in the Real Property List. From here the user can verify the correct PT61 and matching Real 
Property account are selected. Clicking the Match button between the two lists will turn the PT61 Yellow and 
match the PT61 to the Parcel. 
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At any time if a parcel is incorrectly matched, the user can select the PT61 and click on the Un-Match button. If 
more parcels are to be matched, the user can repeat these steps for more PT61s. Once Matching is complete, 
clicking the Next button will open the Field Matching forms while clicking Close will leave the parcels Matched but 
not Field Matched, and the user can return to the Field Match process later. 

 

If the PT61 involves multiple parcels, check Multiple Parcel Transfer before clicking the Match button. For multiple 
parcel matching, once a multiple parcel transfer is matched, the user should click the Next button and perform the 
PT61 Field Matching for that record. When finished with the first Multiple Parcel Transfer, the user will be returned 
to the PT61 Match form where they can continue matching the parcels to the PT61 Multiple Parcel Transfer. When 
the last parcel to be transferred is being matched, the user should click the Final Parcel in Multi-Parcel Transfer 
checkbox. 
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PT61 FIELD MATCH 

The PT61 Field Matching form is a menu driven interface that transfers information from the PT61 into WinGAP’s 
Owner, Realprop, and Saleinfo screens. This form can be opened from the WinGAP toolbar under Add-Ons > PT61 
Field Match, or after performing account matching in the PT61 Match form by clicking the Next button once all 
PT61 matching is done. 

 

By default, the PT61s to be Field Matched are sorted in Buyer order. By clicking on the box in the upper right hand 
of the form, the user can select to sort the PT61s in several different sort orders. 

 

 

Clicking on the << and >> buttons beneath the selected sort order will navigate back and forth through the records 
to be Field Matched. The current parcel’s Parcel Number will be displayed at the top of the Form, and which record 
of how many are being processed will also display at the top of the form. 

 

 

There are three sets of checkboxes at the bottom of the form that will affect all three parts of the PT61 Field 
Matching process. 

 

 

Current/Future: This set of checkboxes determines whether the sale is to be processed in the current AY digest or 
the Future digest. If Future is checked and the record does not currently exist in the Future database, a prompt will 
alert the user and allow them to create the record in the Future year. 
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Transfer Entire Parcel/Split – New Parcel: This set of checkboxes determines whether the entire parcel is being 
transferred or if the sale is a split and a new parcel is to be created. 

Text to Upper Case/Text to Proper Case: This set of checkboxes will force the PT61 Field Values into either all caps 
or use proper capitalization and lower-case text. 

 

OWNER 

The Owner tab will transfer the new owner’s information from the PT61 into WinGAP’s Owner screen. The 
information that is copied over is the owner’s name and mailing address. 

 



 
492 

The field names in order are: 

• LASTNAME 

• FIRSTNAME 

• MIDDLE 

• ADDRESS1 

• ADDRESS2 

• CITY 

• STATE 

• ZIP 

 

There are several user selectable options that control how the new data is handled inside of Wingap. 

 

Select All: This box will check all the boxes beside the owner information from the PT61 Field Values to transfer 
into the Live Owner Field Values. 

Select None: This box will uncheck all the boxes beside the owner information from the PT61 Field Values. 

Combine PT61 Lastname, Firstname, Middle into WinGAP Corporate Name: This option controls whether the 
Owner information from the PT61 copies the Last, First, and Middle names of the new owner into the Last, First, 
and Middle Name fields in WinGAP, or if the new owner’s entire name will be combined into a single name and 
placed in the Corporate Name field. The user should select whichever naming convention is used by the county. 
This option is greyed out if the new owner information is a Corporation. 
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Overwrite current WinGAP owner with PT61 Owner: This option only appears when the current owner only has a 
single parcel assigned to their Owner record. If checked, any selected PT61 Field values will directly overwrite the 
Live Owner record instead of making a new Owner record. Either this or the ‘Transfer’ option must be selected. 
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‘Transfer’ to another owner via WinGAP transfer module: If checked, once the PT61 Field Matching form is 
complete and the Sale Info is processed, the Property Transfer form will open to handle updating the Owner 
information. Either this or the ‘Overwrite’ option must be selected. 

PT61 Address1 Mapping: This set of checkboxes determines which address line the PT61 Address Line 1 will be 
copied to on the WinGAP Owner record. When one of these options is checked, it will block that option from being 
checked for the PT61 Address2 Mapping. 

PT61 Address2 Mapping: This set of checkboxes determines which address line the PT61 Address Line 2 will be 
copied to on the WinGAP Owner record. When one of these options is checked, it will block that option from being 
checked for the PT61 Address1 Mapping. 

 

Once all the Owner Fields are matched, the user should click on the Real Property tab at the top of the form. 
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REAL PROPERTY 

The Real Property tab will transfer information about the real parcel’s property information from the PT61 into 
WinGAP’s Realprop screen, including the physical location, acreage, and land lot/dist information. 

 

 

The field names in order are: 

• APPRNAME 

• REALKEY 

• PARCEL_NO 

• HOUSE_NO 

• EXTENSION 

• STDIRECT 

• STREET_NAM 

• STTYPE 

• QUAD 

• UNIT 

• TOTALACRES 

• TAXDISTRIC 
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• LANDGMD 

• LANDDIST 

• LANDLOT 

• APPRAISER 

 

The user should check/uncheck any PT61 Field Values that are to be passed to WinGAP Real Property data, using 
the Select All/Select None buttons if appropriate. Once all the Realprop Fields are matched, the user should click 
on the Saleinfo tab at the top of the form. 

 

SALEINFO 

The Saleinfo tab will transfer information about the sale from the PT61 into WinGAP’s Saleinfo screen, such as sale 
price and date. 

 

 

The field names in order are: 

• PT61_NUM 

• DEED_BOOK 

• DEED_PAGE 
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• SALEDATE 

• SALEPRICE 

• RETT 

 

The user should check/uncheck any PT61 Field Values that are to be passed to the WinGAP Saleinfo screen, using 
the Select All/Select None buttons if appropriate. Once all the Saleinfo Fields are matched, the user should click 
the Apply button to process the PT61 data. NOTE: Clicking the Quit button will close the screen without any 
processing taking place. Also, all assignments will be lost for this PT61-Parcel match. After clicking the Apply 
button, the user will be taken step-by-step through the transferring of PT61 data into WinGAP. 

 

TRANSFER ENTIRE PARCEL 

If this option was selected during the PT61 Field Match, the Sales Information form will appear (if Future is checked 
on the Owner Field Match screen, the screen will be Yellow-Gold in color, as seen below). The user should select 
the sale reason and edit any sales information as necessary. Once finished, clicking Okay will take the user to the 
next step. 

 

 

If “Overwrite Current WinGAP owner” was checked on the PT61 Field Match form, the Owner Information will 
automatically be overwritten and there is no need for the user to edit the Owner record. If “’Transfer’ to another 
owner” was checked, the user is taken through the WinGAP transfer process where the Parcel can be transferred 
to an existing owner in WinGAP or a new owner can be created with the PT61 Owner data. 
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The user is then shown the Real Property record where they may edit the Parcel as necessary. 

 

 

SPLIT – NEW PARCEL 

If this option was selected during the PT61 Field Match, the user is taken to the parent parcel where Duplicate 
must be clicked (if Future is checked on the Owner Field Match screen, the screen will be Yellow-Gold in color). 
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Clicking the Duplicate button will prompt the user to confirm they wish to duplicate the property. 
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After confirming duplication, the Owner Search form will display. 

 

 

An existing owner can be selected from this search form if the new property is being transferred to an existing 
property owner in WinGAP. Alternatively, a new owner record can be established by clicking Cancel on the Owner 
Search form. 
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Any Owner information that had check boxes beside it on the PT61 menu is automatically transferred to the new 
owner screen. 

 

 

After assigning the Ownership information, a Parcel Number must be assigned to the split. 

 

 

Once the Parcel Number is keyed and the user clicks OK, WinGAP will begin the Duplication process. Several 
messages will appear as the system performs this task. 
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Once the Parcel is duplicated, the user will be asked if they would like to change the new account’s previous value 
to $0, and the user should click Yes. 

 

 

The new Parcel is then opened, and the user may enter any modifications to the record. NOTE: Do not add sale 
information at this time. 
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After edits to the Parcel are completed and the user clicks OK, the Sales Information form is opened and the sale 
information from the PT61 is populated. The user should select the sale reason and edit any sales information as 
necessary. 
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Once the sale information is keyed and the user clicks OK, they are notified the Parent Parcel will be opened. 

 

 

 

 

 

 

 

 

 

 

 



 
506 

The Parent Parcel is displayed in lime green so that the user is certain which record they are viewing. The parent 
parcel should be edited to reflect any new data after the split. 

 

 

If Multiple Parcel Transfer was checked on the PT61 Match form, the next parcel associated with the PT61 should 
be selected, the Match button clicked, and the Field Matching process performed again. When the last parcel 
associated with the Multiple Transfer has been selected, the Final Parcel in Multiple parcel transfer box should be 
checked. 

 

 

At the conclusion of the PT-61 Matching process, the user is returned to the PT-61 Owner Field Matching form if 
other PT61s have been matched and are ready for processing. If no other PT61s have been matched and are ready 
for processing, the user will be returned instead to the PT61 Match form. The PT-61s that have been matched will 
no longer be present on the left side of the form. At this point, other PT-61s can be matched, or the user can close 
the PT-61 Match Form by clicking the Close Button. 
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MASTER ADDRESS DATABASE  

This module is currently under development and not completely functional. 

 

PERMIT STAGING 

This option on the Add-Ons menu runs the Permit Staging module, which is still under development. 

 

TIMBER 

The Timber Tracking Module is used to track the sales of Timber that has been harvested in the County. Clicking on 
this sub-menu option produces the Timber Tracking module. This module can also be reached from the Timber 
button on the toolbar. NOTE: Timber sales can also be entered and edited for an individual parcel on the Real 
Property General Information form by clicking the Timber button on that form. 

 

 

The Timber Tracking Module contains eight different Forms that are selected by clicking on the Tab for that Form 
at the top of the Module. The module defaults to the Query Form. A listing of all existing Timber Sales displays in 
the list box at the bottom of the Query Form. Once a sale is selected there by clicking on that item in the list box, 
the Timber Sale information can be viewed, updated, or deleted on the other seven Timber Tracking Forms. 
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Query: The listing of Timber Sales that displays on this Form can be narrowed by using the four query boxes on the 
upper left of the Query Form. The user can click on the combo box to select one of the items in the query field list, 
such as Location Owner’s Name, and then key the query criteria, such as part of the last name, into the field to the 
right of the combo box. The user then clicks the Query Button and a list of all Timber Sales meeting that criteria will 
display. The desired Timber Sale is selected by clicking on the Sale in the list box to highlight it, then clicking on any 
of the other Form Tabs to view the Timber Sale information specific to that Form. The Timber Sale information can 
then be viewed, updated, or deleted as desired. 
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General: The General Form contains general information about the Timber Sale. The General Form shows the Tax 
District, Sale Type, Quarter of the Year the Timber was harvested, Sale Year, the Form Number on the State 
Tracking Form, and The Tracking Number assigned to the Timber Sale. 
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Landowner: Information about the Landowner is found in the Name, Address (3 lines), and City, State, Zip fields on 
this Form. 
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Purchaser: Information about the individual or company that purchased the Timber is found in the Name, Address 
(3 lines), and City, State, Zip fields on this Form. 
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Location: Information about the location where the Timber was harvested is found in the Location, County, City, 
Acres, Parcel Number, and Digest Name fields on this Form. Keying in a REALKEY will attach this harvest report 
record to the parcel for easy viewing from the Real Property General Information form. 
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Volumes: The Volumes in Tons for the Types of Timber harvested is found in the fields on this Form. 
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Tax Due: The Total Dollar Value (or Price Paid) and the Applicable Millage Rate is found in the appropriate fields on 
the Tax Due Form. WinGAP will calculate the Tax Due and calculate the value using the State Timber Table. If the 
State Calculated Value is to be used, a checkmark should be placed in the Use State Calculated Value checkbox. 
Use of the State Calculated Value also requires the Table of Owner Harvest Values for the applicable year to have 
been entered in the WinGAP Timber Values schedules via the Tools > Schedules/Tables menu. 
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Date: The Dates that the Timber was sold, received, and paid for is found in the fields on this Form. 
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283T Button: At the lower left of the Timber Tracking form is the 283T button. After selecting a Timber Sale in the 
Query list box, the 283T button can be clicked to produce the Report of Timber Sale of Harvest. The report lists all 
the information about the Timber Sale. 
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A new Timber Sale can be added by clicking the New Button. This will produce a blank General Form where the Tax 
District can be selected from the combo box, and the Sale Type and Quarter can be selected by clicking on the 
appropriate Radio Button. The Sale Year, Form Number, and Tracking Number information would then be keyed. 
Once the General Information is keyed, the Apply Button should be clicked, then the user should click on the 
Landowner Tab, which will produce a blank Landowner Form. After that information is keyed, Apply should again 
be clicked, then the next Tab, Purchaser, should be clicked, and the same procedures followed for the rest of the 
Timber Tracking Forms. NOTE: It is very important that the Apply Button is clicked on each Timber Tracking Form 
before leaving that Form, or else the information will not be saved. 

 

A Timber Sale can be deleted by first selecting the Timber Sale in the list box on the Query Form (the Sale Item will 
turn blue). The Delete Button should then be clicked, and the user will receive the message "Do you want to delete 
this timber harvest/sale record?" If the user has selected the correct Timber Sale to be deleted, then Yes should be 
clicked to delete the record; otherwise, No should be clicked to return to the Timber Tracking Module Query Form. 
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HELP MENU 

The Help Menu on the WinGAP Tool Bar is designed to provide the user with various types of assistance in the 
proper operation of WinGAP. NOTE: several of the options on the Help Menu will connect the user directly to the 
Internet. For these options to be used, the user's computer must have a modem or network connection, Internet 
access, and where applicable, an email account. 

 

 

 

CONTENTS 

The Contents option on the Help Menu displays WinGAP Help Topics about the various modules in WinGAP. 
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On the left side of the Help module is a table of contents. Clicking a topic will display the WinGAP Manual entry for 
that topic. It is possible to search for a topic by clicking in the “Type in the keyword to find” text box. Clicking the 
Hide button at the top of the Help module will hide the table of contents. 
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WINGAP ON THE WEB 

The WinGAP on the web option on the Help Menu will launch the user’s default web browser and take the user 
directly to the Home page on the WinGAP website (www.wingap.com). Using the links on the left side of the page, 
the user can get updates, reach Online Support, contact Board Members and WinGAP Support Agents, and read 
about the latest developments with WinGAP, the GAP Group, and other items of interest. 

 

 

WINGAP VERSION CHANGES 

Clicking on the WinGAP Version Changes menu option will display a list of all changes that have been made 
recently to WinGAP. 
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CONTACT TECH SUPPORT 

The Contact Tech Support option launches the default email client program on the computer, producing a mail 
form populated with Tech Support’s email address. Here the user can type the question(s) they need answered 
and email directly to WinGAP Technical Support. 
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ONLINE SUPPORT 

Online support from Agents of the Department of Revenue's Division of Local Government Services can be 
obtained by clicking on the Online Support option on the Help Menu. This takes the user to the Online Support 
page on the WinGAP website. 

NOTE: If the user cannot access the Help > Online Support option because WinGAP will not operate, Online 
Support can also be reached by using either of these two options: 

• Type www.wingap.com/online_support.htm into the URL field of the web browser. 

• Go to www.wingap.com and click the Online Support link on the left of the page. 



 
523 

 

 

Please write your questions and/or issues fully in the box provided on the User Login Form. Be patient when 
contacting Online Support as there may be an extended wait at times. 

NOTE: While the primary purpose of Online Support is to solve problems with WinGAP, users can also use it to 
request customized reports or ask general operational questions about WinGAP.  

 

At the middle of the Online Support page is the User Login Form where the user that is requesting assistance MUST 
key in some important information: 

• The first name of the person contacting OLS in the Client Name field. 

• The County name in the Client County field. 

• If a specific OLS Agent is being contacted, their name goes in the “Name of OLS Agent” field. If no specific 
OLS Agent is being requested, “Any” goes in this box. NOTE: If requesting a specific Agent, contact them 
via email or phone prior to requesting them as they might not have an active connection to GoToAssist 
and may need to log on. 

• The user’s direct phone number should be entered in the Phone # field. 

• A full description of the problem the user is having should be keyed into the memo field at the bottom of 
the User Login Form. 

 



 
524 

Once the user has filled in these fields, the Click Here Button should be clicked to begin the Online Support session. 

 

 

After clicking the Click Here Button, the "Contacting Your Representative" screen will appear. 

 

 

A message will appear over the “Contacting your representative” screen informing the user that a connection is 
being attempted with WinGAP Online Support.  
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An initializing message will appear.  

 

 

Once the connection is accomplished, the screen sharing message will appear superimposed over the other 
windows on the user's computer. The "Yes" Button should be clicked to begin the session. The Gap Group, Inc. 
Chat Form will then appear. 
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The Online Support Agent and the user can exchange questions and answers by using this Chat Form. When the 
user wishes to talk to the Agent, the text is keyed into the small window at the bottom of the Chat Form. The Send 
Button should be clicked to send the message to the Agent. Both the Agent's and the user's messages will appear 
in the larger window on the Chat Form. 

 

At the conclusion of the Online Support session, the Agent will terminate the session, and the Online Support 
Evaluation Form will appear. The user can rate the Online Support experience using this Form. 

 

 

After the user clicks the Submit button on the Evaluation Form, the sign off screen will appear. The user can close 
this screen to end the Online Support session. 

 

 

ABOUT THIS APPLICATION  

The About This Application option produces the About WinGAP Form, which displays general information about 
WinGAP. The most important information on this form is the Version Number of WinGAP currently in use, such as 
WinGAP 4.10.1, Build 21. The version number can be important to WinGAP Tech Support as various features are 
added and bug fixes implemented in each version of WinGAP. The About WinGAP form also displays a map of 



 
527 

Georgia counties using WinGAP, shaded in green. Displayed on the right side of the About Form are the developers 
of WinGAP and the Current User of WinGAP (Login ID). 

 

Also displayed on the form is certain property information for the current appraisal year: 

• The number of Real Property Parcels. 

• The number of Personal Property Accounts. 

• The number of Prebilled Manufactured Homes. 

• The number of Non Prebilled Manufactured Homes. 

• The number of Taxable Real Properties. 

• The number of Exempt Real Properties. 

 

Finally, acknowledgement is given to third party products that are used in conjunction with WinGAP, such as NADA 
and ABOS. 
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NOTE: The user can hover their mouse over any of the counties on the map and the County name and Assessors’ 
Office phone number will be displayed on the left side of the gray area at the bottom of the form. This listing is still 
under development, however, and not all counties will display. 

 

 

OWNER SEARCH FORM 

The Owner Search Form is used to locate Owners of property. The Form can be reached by any one of several 
methods: 

• By clicking on the Owner Button on the WinGAP Toolbar. 

• By clicking on Property Maintenance on the WinGAP Menu Bar, then Owner, then Search. 

• By keying the "hot-key" combination of Ctrl + O. 

 

 

The Owner Search Form is divided into several sections. At the top of the Form is the Search Field, where, 
depending upon the Search Order, the property owner's name, parcel number, or account # (ownkey) is keyed. 
Beneath the Search Field is the Owner Information box where Owner records whose names, parcel numbers, or 
account # that most closely match that keyed into the Search Field will be displayed. On the upper right of the 
Form is the Search Order section, where the default Search Order (Name) can be changed by clicking any of the 
other Radio Buttons that are available. 
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Beneath the Search Order section is the Number of Hits to Display field which contains the default number of 
Owner records that will be displayed in the Owner Information box. The default value of 200 records can be 
temporarily changed, if necessary (and if Logins are enabled, set as a default for that user). 

 

The top blue panel beneath the Owner Information box is the Multiple Owners Memo field where the names of 
Multiple Owners of a parcel will be displayed. 

 

 

Beneath this panel is another memo field where the selected Owner’s address and property items will display. 
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The Help Button can be clicked to display Help Information about the Owner Search Form. The Open and Cancel 
Buttons allow the user to Open the desired Owner record or Cancel the search procedure. 

NOTE: Before keying any search information in the Search Field, the user should be sure that the Cursor is at the 
far left of the field. Not doing this will in most cases produce incorrect information. 

 

Name Search: What the user keys into the Search field is first determined by the Search Order. The default is 
Name Order. How the Name is keyed into the Search field will depend upon how the County manages the Name 
information in their database. Names in WinGAP can be keyed on the Owner Information Form in either the Last 
Name-First Name-Middle Initial fields, or in the Corporate Name field, but an Owner cannot have names in both 
places. One County may prefer to reserve the Corporate Name field for Businesses and Corporations and use the 
Last Name-First Name-Middle Initial fields for all other owners; another County may prefer to use the Corporate 
Name field for ALL owners; a third may prefer to use the Last Name-First Name-Middle Initial fields for ALL owners. 
It is entirely a local matter.  

 

If the user is looking for an Owner's Name that is in the Last Name-First Name-Middle Initial fields, the name MUST 
be keyed as follows: “Smith, John”. The comma is mandatory if the Last Name-First Name-Middle Initial fields are 
used. 
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If the Owner's Name is found in the Corporate Name field, the name is keyed as it was entered in that field: “Smith 
Betty”. No comma is used in the Search field for a Corporate Name unless the comma was keyed as part of the 
name, and it is strongly recommended that commas NOT be keyed in the Corporate Name field. 
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Information on the Owner Information Form can be entered in "proper" case, such as Smith Betty, or in all capital 
letters, such as SMITH BETTY. Or, the name smith betty can be keyed into the Search field in lower case. When 
searching for Owner Information, case does not matter for how the Owner's Name is keyed in the Search Field: 
proper, upper, or lower case will all yield the same result. 

 

Once an Owner's Name is keyed in the Search Field, the user should click on the Search Button to the right of the 
field (the "hot-key" combination of Alt+S can also be used). If an entire name was keyed and found, the Owner 
record(s) associated with it will display at the top of the Owner Information box, along with other Owner records in 
descending alphabetical order. If the keyed name is not found, Owner records with the name nearest to the name 
keyed will display in descending alphabetical order. The number of records that display will depend upon the 
Number of Hits to Display value. 

 

Various short-cuts with the names of Owners can be used to find Owners. For example, if the user wishes to see all 
Owners with the Last Name of Smith that own property, the name “Smith” can be keyed in the Search Field. 
Clicking the Search Button will display the Owner records with the Last Name or Corporate Name of Smith in the 
County. 
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Names keyed in the Last Name-First Name-Middle Initial fields will display ahead of names keyed in the Corporate 
Name field. If there are more Smiths than those displayed in the Owner Search box and the user wishes to view all 
of the Smiths, the default Number of Hits to Display value can be increased to a number suitable to display all of 
the Smiths (the Search Button must be clicked again after changing the value). 

 

Another short-cut with Name Order searches is to key the beginning part of an Owner's Name in the Search Field 
to find matching Owner records. For example, the letters “Bar” can be keyed to display all Owner records whose 
Last Name or Corporate Name begins with those letters. 

 

Finally, when in Name Search Order, the user can search from the beginning of the alphabet by clicking on the 
blank Search Field. 

 

Lucky Button: The Lucky Button, located to the right of the Search Button, allows the user to perform both a 
search AND open the first record that meets the criteria keyed in the Search field. If the user places the mouse 
cursor on the Lucky Button, a "tool tip" will appear: 
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For example, the user wants to look at the Owner record for “Ann Arnold”. After keying the name in the Search 
field, the user can click the Lucky Button and be taken directly to the Owner record for that name.  

 

 



 
535 

 

 

When using the Lucky Button, the criteria keyed into the search field must exactly match that of the desired 
record. Otherwise, the user will be taken to the record that is closest to matching the criteria keyed into the Search 
field. 

 

Parcel Number Search: If Parcel Number is selected as the Search Order, the Search Field will not be blank. 
Instead, it will contain "dashes" near the beginning of the field that represent the "breaks" in the Parcel Number 
between the Map Number and other segments of the Parcel Number. The number of "dashes" will depend upon 
the structure of the County's Parcel Number, as set up in the Parcel Number Template Field in Tools > Preferences. 
The default WinGAP Parcel Number structure is XXXX-XXX-XXXX-XXX, with a "dash" between the Map, Block, 
Parcel, and Sub-Parcel numbers, for a total of three "dashes". These three "dashes" would appear toward the left 
end of the Search Field. The Parcel Number can be customized depending upon how a County wants to structure 
its Parcel Number. 

 

To locate the Owner of a specific Parcel Number, for instance “G01 -00 -010 –“, the entire Parcel Number can be 
keyed into the Search field. The user must be careful while keying the Parcel Number that the dashes and any 
spaces in the Search Field are the same as in the Parcel Number. If the Parcel Number has letters in it, the letter 
can be keyed in either upper or lower case; as in Name Search Order, the case does not matter. After clicking the 
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Search Button, the desired record should appear at the top of the Owner Search box followed by other Owner 
records in ascending Parcel Number order. 

 

 

As with the name of an Owner, various short-cuts with Parcel Numbers can be used to find Owners. For example, if 
the user wishes to see all Owners on Map "J05", the number “j05” can be keyed in the proper place in the Search 
Field. Clicking the Search Button will display the Owner records with that Map Number in the County, up to the 
default Number of Hits to Display value. 
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If there are more Owners with the desired Map number than those displayed in the Owner Search box and the 
user wishes to see all of them, the default Number of Hits to Display value can be increased to a number suitable 
to display all of the Owner records (the Search Button must be clicked again after changing the value). 

 

Finally, when in Parcel Number Search Order, the user can search from the beginning of all Map/Parcel Numbers 
by clicking on the blank Search Field. 

 

Account Number Search: The Search Order for Owner records can be changed to Account Number Order by 
clicking on the Account # radio button in the Search Order section of the Owner Search Form. The Account 
Number for Owner records is the same as the WinGAP assigned Owner Key (Ownkey) number. To locate an Owner 
record by a specific Account Number, for example “1015”, the entire Account Number, “1015”, should be keyed 
into the Search field. After clicking the Search Button, the desired record should appear at the top of the Owner 
Search box followed by other Owner records in ascending Account Number order. 
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Finally, when in Account Number Search Order, the user can search from the beginning of all Account Numbers by 
clicking on the blank Search Field. 

 

Owner Search Box: The information that is displayed in the Owner Search box varies depending upon which 
Search Order is used. 

 

If the default Name search order is used, the following displays, from left to right: 

• Owner Name (lastname, firstname, middle). 

• Type of property, identified by the letters R (Real Property), P (Personal Property), or M (Prebilled 
Manufactured Home). 

• Total Property Value. 

• Owner Account Number. 

 

If Parcel Number search order is used, from left to right: 

• Parcel Number. 

• Realkey (real property account number). 

• Total Acres. 
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• Owner Name (lastname, firstname, middle). 

• Legal Description. 

• Property Situs Address (house number, extension, street direction, street name, street type). 

• Owner Account Number (ownkey). 

 

 If Account Number search order is used, from left to right: 

• Owner Account Number. 

• Owner Name. 

• Type of Property. 

• Total Property Value. 

 

Additional information about any Owner can be displayed by clicking on the record. The additional information will 
be displayed in the memo field located on the bottom of the Owner Search Form. The information that is displayed 
will depend upon the Search Order used and the type of property selected. 

 

 

The information that displays in the memo field at the bottom of the Owner Search Form will also display in a "tool 
tip", which can be seen by clicking on any record in the Owner Search box. 
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Number of Hits to Display: If Logins are enabled in Tools > Preferences, the Default Number of Hits to Display can 
be changed for each user in two different places. The first is located in Tools > Password Administration. The 
second location where the default Number of Hits to Display can be changed is on any of the Search Forms. When 
the user clicks Cancel to leave the one of these Search Forms, after changing the Default Number of Hits to Display 
value and performing a search using this new value, WinGAP will display the message asking the user if they want 
to replace their default number of search results to display. 

 

 

If the new number is to be the new default, the user should click the Yes Button and the Number of Hits to Display 
for this user will be set as the default for that user. 
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If logins are not enabled, the default Number of Hits to Display on any Search Form in WinGAP is 200. If Logins are 
not enabled, each user in WinGAP can temporarily change the number of Owner records that will be displayed 
when searching on that Form by clicking in the Number of Hits to Display field and keying the desired number. 
When the user leaves that Form, the default number will revert to 200. 

 

Open and Cancel Buttons: Once an Owner record is located in the Owner Search box and highlighted, the user can 
open the Owner Information Form for that record by clicking the Open Button. The Owner record can also be 
opened by pressing Enter when the desired record is highlighted in the Search box, double-clicking on the record, 
or pressing the hot-key combination of Alt+O. The Cancel Button can be clicked (or Alt+C pressed) to abort any 
searches and return to the Main WinGAP screen. 

 

 

 

MULTIPLE OWNER SEARCH FORM 

The Multiple Owner Search Form is used to locate property records that have multiple owners. The Form can be 
reached by one of three methods: 

• By clicking on the Multi-Owner Button on the WinGAP Toolbar. 

• By clicking on Property Maintenance on the WinGAP Menu Bar, then Owner, then Multi-Owner Search. 

• By pressing the “hot-key” combination of Ctrl + M. 
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Search Text: This field is where the desired Owner's name is keyed. 

Search All Owners: This option is checked by default. When checked, WinGAP will search the Last Name, First 
Name, and Middle Initial fields for Owners whose names match the name that is keyed in the Search Text field 
including names in the Multiple Owners field. If the box is not checked, only the Multiple Owners field is searched. 

Search Owner Comments: When checked, WinGAP will search the Comments field on the Owner Information form 
for text that matches the text keyed into the Search Text field. If the box is unchecked, the Comments field will not 
be searched. 

Search Owner Address1: When checked, WinGAP will search the Address1 field on the Owner Information form 
for text that matches the text keyed into the Search Text field. If the box is not checked, the Address1 field will not 
be searched. 

 

Beneath the Search Text Field is a box where Owner records with Multiple Owner names (and Owner names and / 
or Comments and the Address1 fields if the appropriate checkboxes are checked) that most closely match the 
name keyed into the Search Field will be displayed. 

 

The Help Button can be clicked to display Help Information about the Real Property Search Form. Finally, the Open 
and Cancel Buttons allow the user to Open the desired Owner record or Cancel the search procedure. 



 
543 

NOTE: Before keying any search information in the Search Text Field, the user should be sure that the Cursor is at 
the far left of the field. Not doing this will in most cases produce incorrect information. 

 

To locate the Owner record(s) for a specific Owner which is keyed into the Multiple Owner memo field on any 
Owner Information form, the name of the Multiple Owner is keyed into the Search Text Field on the Multiple 
Owner Search Form. The user should uncheck the Search All Owners box, then click the Search Button to the right 
of the field (the "hot-key" combination of Alt+S can also be used), and WinGAP will immediately display any Owner 
record that has that name in the Multiple Owner memo field. 

 

 

The Open Button can be clicked on the highlighted record to produce the Owner Information Form for this 
Multiple Owner. 
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If the user also wants the names of all Owners that meet the name criteria keyed for Multiple Owners, the Search 
All Owners checkbox should be checked. WinGAP will search the Last Name, First Name, Middle Initial, and 
Corporate Name fields for the name that is keyed in the Search Text field and display all Owner records as well as 
Multiple Owners that meet that criteria. 
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Multiple Owners are highlighted in red and are listed below the Owner’s record where they are found (there will 
be a duplicate Ownkey in the right column). The appropriate record can be highlighted in the Name box, and Open 
clicked (or Alt+O pressed) to proceed to the Owner Information Form. 
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To locate the Owner record(s) for specific Comments which have been keyed into the Comments memo field on 
any Owner Information form, part or all of the Comment text is keyed into the Search Text Field on the Multiple 
Owner Search Form. The user should uncheck the Search All Owners box, unless Owner records which have this 
Comment text in the Owner name are desired. Once the Comment is keyed, the user should click the Search 
Button to the right of the field, and WinGAP will immediately display any Owner record that has that Comment in 
the Comments memo field. 
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Owner Records that have the text that was keyed in the Search field and found in the Comments memo field on 
the Owner Information form are highlighted in yellow on the Search form, and have an Owner Type of C (for 
Comments). Owner records that have the Comments text in the Owner name are shown in white and have an 
Owner Type of N (for Name). 

 

To locate the Owner record(s) for a specific Owner Address that exists in the Line1 address field on the Owner 
Information form, part or all of the Address1 text is keyed into the Search Text Field on the Multiple Owner Search 
Form. The user should uncheck the Search All Owners box, unless Owner records which have this Address1 text in 
the Owner name are desired. Once the Address1 is keyed, the user should click the Search Button to the right of 
the field, and WinGAP will immediately display any Owner record that has that text in the Address1 field. 
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Owner Records that have the text that was keyed in the Search field and found in the Address1 field on the Owner 
Information form are highlighted in purple on the Search form, and have an Owner Type of A (for Address). If the 
Search All Owners box was checked, any records that have the searched text in the Owner name are shown in 
white and have an Owner Type of N (for Name). If the Search Owner Comments box was checked above, any 
records that have the searched text in the Comments memo field are shown in yellow and have an Owner Type of 
C (for Comments). 

 

The use of the multiple checkboxes on the Multiple Owners form can be useful in locating owners by using specific 
information that is keyed into the Search Text field. 
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REAL INDEX SEARCH FORM 

The Real Index Search Form is used to locate Real Property. The Form can be reached by one of three methods: 

• By clicking on the Real Index Button on the WinGAP Toolbar. 

• By clicking on Property Maintenance on the WinGAP Menu Bar, then Real, then View Current Index. 

• By keying the "hot-key" combination of Ctrl+V. 

 

 

 

Parcel Order: When checked, the results of the Real Index search are sorted by the Parcel Number. 

Name Order: This is the default search order. When checked, the results of the Real Index search are sorted by the 
Owner Name. A secondary search order of Parcel Number is applied so that the records for owners with more than 
one parcel will be in parcel number order. 

Subdivisions: When checked, the results of the Real Index search are sorted by Subdivision Name. A secondary 
search order of Parcel Number is applied so that the records inside the same Subdivision will be in parcel number 
order. 

 

The Real Index form displays the following parcel information when Parcel Order or Name Order are selected: 

• Name: The Owner name. 

• Parcel_No: The Parcel Number. 

• Hs: The Homestead Exemption Code. 
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• Situs: The Situs or location address of the parcel. 

• Acres: The Parcel Acreage. 

• Cs: The Digest Classification and Stratification of the parcel. 

• Covyr: If there is a covenant on the parcel, the year will display in the Covyr column. 

• I_V: The Improved/Vacant column, where an "I" will display if the parcel has an improvement on it (it will 
also be highlighted in yellow), and a "V" will display if the parcel is vacant. The "V" is also highlighted in 
blue for Vacant parcels. 

• Legal_desc: The Legal Description. 

• Total_Val: The total Current Value of the parcel. 

• Imps_Val: The total value of all improvements on the parcel. 

• Land_Val: The total land value of the parcel. 

• No_Release: A Y in this column indicates a Non-Disclosure Owner. 

• Realkey: The Realkey (real property key or account number). 

• Ownkey: The Ownkey (the owner key for the parcel). 

 

These additional fields will display when Subdivision sort order is selected: 

• Subd_Name: The Subdivision Name. 

• Subd_Phase: The Subdivision Phase. 

• Subd_Sec: The Subdivision Section. 

• Subd_Blk: The Subdivision Block. 

• Subd_Lot: The Subdivision Lot. 

 

The default search number can be temporarily changed to any number of records the user wants to display by 
keying a different number in the field then clicking the Search button. This change is temporary; when the user 
leaves the Real Index form and returns, the default 200 records will display in the field. 
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Colour Homesteads: All parcels that are not assigned a Homestead Exemption of S0 are highlighted in yellow on 
the Real Index Form when this is checked. Unchecking this box will turn off the yellow highlighting and instead, all 
parcels that are Vacant will be colored blue. 
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Prev Button: The Real Property parcels for the previous 200 owners, in ascending order, can be displayed by 
clicking this button. 

Next Button: The Real Property parcels for the next 200 owners, in descending order, can be displayed by clicking 
this button. 

Print PRC Button: A Property Record Card can be printed for any record in the View Current Index by selecting the 
desired record in the results box and clicking the Print PRC button. A Reporting Services print preview will display 
first and the PRC can be printed and/or exported from the preview window. 

Open Button: A Real Property record is opened on the Real Index Form by clicking on the desired record and 
clicking the Open Button (or pressing Alt+O), double clicking on the desired record, or by selecting the desired 
record and hitting Enter on the keyboard. 
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REAL PROPERTY SEARCH FORM 

The Real Property Search Form is used to locate Real Property records. The Form can be reached by any one of 
several methods: 

• By clicking on the Real Button on the WinGAP Toolbar. 

• By clicking on Property Maintenance on the WinGAP Menu Bar, then Real, then Parcel Information. 

• By keying the "hot-key" combination of Ctrl+R. 

 

 

The Real Property Search Form is divided into several sections. At the top of the Form is the Search Field, where, 
depending upon the Search Order, the Real Property owner's name, parcel number, or other criteria is keyed. 
Beneath the Search field is the Real Property Information box where Real Property records whose parcel numbers, 
owner's names, or other criteria that most closely match that keyed into the Search Field will be displayed. On the 
upper right of the Form is the Search Order section, where the default Search Order (Parcel Number) can be 
changed by clicking any of the other Radio Buttons. 

 

Beneath the Search Order section is the Number of Hits to Display field which contains the default number of Real 
Property records that will be displayed in the Real Property Information box. This default value can be temporarily 
changed, if necessary (and if Logins are enabled, set as a default for that user). 

 

The top blue panel beneath the Real Property Information box is the Multiple Owners memo field where the 
names of Multiple Owners of a parcel will be displayed if the Name Search Order is used. 
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Beneath this panel is another memo field where information about the selected parcel will display. 
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A Property Record Card can be printed for any record in the Real Property Information box by selecting the desired 
record then clicking the Print PRC button. A Reporting Services print preview will display first and the PRC can be 
printed and/or exported from the preview window. 

NOTE: The Print PRC button is not available when using the Name order on the Real Property Search form. 

 

The Help Button can be clicked to display Help Information about the Owner Search Form. The Open and Cancel 
Buttons allow the user to Open the desired Owner record or Cancel the search procedure. 

NOTE: Before keying any search information in the Search Field, the user should be sure that the Cursor is at the 
far left of the field. Not doing this will in most cases produce incorrect information. 

 

Parcel Number Search: What the user keys into the Search field is first determined by the Search Order. The 
default is Parcel Number Order. If Parcel Number is selected as the Search Order, the Search Field will not be 
blank. Instead, it will contain "dashes" near the beginning of the field that represent the "breaks" in the Parcel 
Number between the Map Number and other segments of the Parcel Number. The number of "dashes" will 
depend upon the structure of the County's Parcel Number, as set up in the Parcel Number Template Field in Tools 
> Preferences. The default WinGAP Parcel Number structure is XXXX-XXX-XXXX-XXX, with a "dash" between the 
Map, Block, Parcel, and Sub-Parcel numbers, for a total of three "dashes". These three "dashes" would appear 
toward the left end of the Search Field. The Parcel Number can be customized depending upon how a County 
wants to structure its Parcel Number. 
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To locate a Real Property parcel by a specific Parcel Number, for instance “G01 -00 -010 –“, the entire Parcel 
Number can be keyed into the Search field. The user must be careful while keying the Parcel Number that the 
dashes and any spaces in the Search Field are the same as in the Parcel Number. If the Parcel Number has letters in 
it, the letter can be keyed in either upper or lower case; as in Name Search Order, the case does not matter. After 
clicking the Search Button, the desired record should appear at the top of the Real Property Search box followed 
by other Real Property records in ascending Parcel Number order. 

 

 

Various short-cuts with Parcel Numbers can be used to find Real Property records. For example, if the user wishes 
to see all records on Map “G05”, then “G05” can be keyed in the proper place in the Search Field. Clicking the 
Search Button will display all Real Property records with that Map Number in the County, up to the default 
Number of Hits to Display value. If there are more records on Map "G05" than those displayed in the Real Property 
Search box and the user wishes to see all of them, the default Number of Hits to Display value can be increased to 
a number suitable to display all of the Real Property records (the Search Button must be clicked again after 
changing the value). 
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Finally, when in Parcel Number Search Order, the user can search from the beginning of all Map/Parcel Numbers 
by clicking Search with a blank Search Field. 

 

The information that is displayed in the Real Property Search box varies depending upon which Search Order is 
used. When the Parcel Number search order is used, the following displays: 

• Parcel Number. 

• Real Property Account Number (the Realkey). 

• Total Acres. 

• Owner’s Name. 

• Legal Description. 

• Homestead Exemption Code. 

• House Number, Extension, Street Direction, Street Name, and Street Type (the Situs Address of the 
Parcel). 

• Owner Account Number (the Ownkey). 

 

Additional information about a Real Property record can be viewed by clicking on the record. This information is 
displayed in the text box on the bottom of the Real Property Search form. The information that is displayed will 
depend upon the search order used. The information that displays in the blue box at the bottom of the Real 
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Property Search Form will also display in a "tool tip", which can be seen by clicking on any record in the Search 
Results box. 

 

Lucky Button: The Lucky Button, located to the right of the Search Button, allows the user to perform both a 
search and open the first record that meets the criteria keyed in the Search field. If the user places the mouse 
cursor on the Lucky Button, a "tool tip" will appear. 

 

 

For example, the user wants to look at the Real Property record for Ann Arnold. After changing the Search Order to 
Name and keying the name in the Search field, the user can click the Lucky Button and be taken directly to the Real 
Property record for that property owner. 
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When using the Lucky Button, the criteria keyed into the search field must exactly match that of the desired 
record. Otherwise, the user will be taken to the record that is closest to matching the criteria keyed into the Search 
field. 

 

Name Search: The Search Order for Real Property records can be changed to Name Order by clicking on the Name 
Radio Button in the Search Order section of the Real Property Search Form. How the Name is keyed into the Search 
field will depend upon how the County manages the Name information in the Owner's database. Names in 
WinGAP can be keyed on the Owner Information Form in either the Last Name-First Name-Middle Initial fields, or 
in the Corporate Name field; an owner cannot have names in both places. One County may prefer to reserve the 
Corporate Name field for Businesses and Corporations and use the Last Name-First Name-Middle Initial fields for 
all other owners, another County may prefer to use the Corporate Name field for all owners, and a third may 
prefer to use the Last Name-First Name-Middle Initial fields for all owners. It is entirely a local matter. Most 
WinGAP counties use the Corporate Name field for all owners. 

 

If the user is looking for a Real Property owner's name that is in the Last Name-First Name-Middle Initial fields, the 
name MUST be keyed as follows: “Abbott, Ronald”. The comma is mandatory if the Last Name-First Name-Middle 
Initial fields are used. 
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If the Real Property owner's name is found in the Corporate Name field, the name is keyed as it was entered in 
that field: “able patti”. No comma is used in the Search field for a Corporate Name. 
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Case does not matter in WinGAP. Information on the Owner Information Form can be entered in "proper" case, 
such as “Abbott, Ronald”, or in all capital letters, such as “ABBOTT, RONALD”. It is entirely a local matter. When 
searching for Real Property owner information, case also does not matter as far as how the Real Property owner's 
name is keyed in the Search Field: proper, upper, or lower case will all yield the same result. 

 

Once a Real Property owner's name is keyed in the Search Field, the user should click on the Search Button to the 
right of the field. If an entire name was keyed and found, the Real Property record(s) for that owner will display at 
the top of the Real Property Search box, along with other Real Property records in descending alphabetical name 
order. If the keyed name is not found, Real Property records with the owner's name nearest to the name keyed 
will display in descending alphabetical order. The number of records that display will depend upon the Number of 
Hits to Display value. 

 

Various short-cuts with the names of Real Property owners can be used to find owners of Real Property. For 
example, if the user wishes to see all owners with the Last Name of Smith that own Real Property, the name 
“Smith” can be keyed in the Search Field. Clicking the Search Button will display the Real Property records with 
owners of the Last Name or Corporate Name of Smith in the County. Names keyed in the Last Name-First Name-
Middle Initial fields will display ahead of names keyed in the Corporate Name field. 
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Another short-cut with Name Order searches is to key the beginning part of a Real Property owner's name in the 
Search Field to find matching owners of Real Property records. For example, the letters “Bar” can be keyed to 
display all Real Property records whose owner's Last Name or Corporate Name begins with those letters. 
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Finally, when in Name Search Order, the user can search from the beginning of the alphabet by clicking the Search 
button with a blank Search Field. 

 

The information that is displayed in the Real Property Search box varies depending upon which Search Order is 
used. When the Name search order is used, the following displays: 

• Owner’s Name. 

• Types of property for this owner, identified by the letters R (Real Property), P (Personal Property), or M 
(Prebilled Manufactured Home). 

• Parcel Number. 

• Total Property Value. 

• Homestead Exemption Code. 

• Owner Account Number (the Ownkey). 

• Real Property Account Number (the Realkey). 

 

Additional information about a Real Property record can be viewed by clicking on the record. This information is 
displayed in the text box on the bottom of the Real Property Search form. The information that is displayed will 
depend upon the search order used. The information that displays in the blue box at the bottom of the Real 
Property Search Form will also display in a "tool tip", which can be seen by clicking on any record in the Search 
Results box. 
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Street Search: The Search Order for Real Property records can be changed to Street Name and Number Order by 
clicking on the Street radio button in the Search Order section of the Real Property Search Form. The House #, 
Street Name, and Street Number, also known as the Situs (or Parcel) Address, must be keyed in the appropriate 
fields on the Real Property General Information form for the Street search to be successful. The House Number, 
such as “258”, should be keyed in the House # field; the Street Name, such as "LUKE", should be keyed in the 
Street Name field; and the Street Type, such as "RD" for "Road", keyed into the Type field on the Real Property 
General Information Form. 

 

 

Various types of searches can be performed in the Street Search field. The beginning part or all of the Street Name, 
without the Street Number if desired, can be keyed in the Search Field to locate Real Property records. For 
example, the letters “luke” can be keyed to display all Real Property records that have Street Names beginning 
with those letters. 
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If a specific Street Name and Number is desired, this is keyed into the Search field by keying the Street Name first, 
followed by a comma, then the Street Number. 
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Finally, when in Street Search Order, the user can also search from the beginning of the alphabet for Street Names 
by clicking Search with a blank Search Field. 

 

The information that is displayed in the Real Property Search box varies depending upon which Search Order is 
used. When the Street Name Search Order is used, the following displays: 

• Street Name, Street Type, Street Direction, House Number, Street Extension, Street Quad, Street Unit, and 
Unit Type (the Situs Address for this parcel). 

• Parcel Number. 

• Homestead Exemption Code. 

• Total Acres. 

• Owner’s Name. 

• Legal Description. 

• Owner Account Number (the Ownkey). 

• Real Property Account Number (the Realkey). 

 

Additional information about a Real Property record can be viewed by clicking on the record. This information is 
displayed in the text box on the bottom of the Real Property Search form. The information that is displayed will 
depend upon the search order used. The information that displays in the blue box at the bottom of the Real 



 
567 

Property Search Form will also display in a "tool tip", which can be seen by clicking on any record in the Search 
Results box. 

 

Account Number Search: The Search Order for Real Property records can be changed to Account Number Order by 
clicking on the Account # radio button in the Search Order section of the Real Property Search Form. The Account 
Number for Real Property records is the same as the WinGAP assigned Realkey number. To locate Real Property by 
a specific Account Number, for example "1515", the entire Account Number should be keyed into the Search field. 
After clicking the Search Button, the desired record should appear at the top of the Real Property Search box 
followed by other Real Property records in ascending Account Number order. 

 

 

When in Account Number Search Order, the user can search from the beginning of all Account Numbers by clicking 
on the blank Search Field. 

 

The information that is displayed in the Real Property Search box varies depending upon which Search Order is 
used. When the Account Number Search Order is used, the following displays: 

• Real Property Account Number (the Realkey). 

• Parcel Number. 

• Digest Class. 

• Homestead Exemption Code. 

• Total Acres. 
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• Legal Description. 

• Owner’s Name. 

• Owner Account Number (the Ownkey). 

 

Additional information about a Real Property record can be viewed by clicking on the record. This information is 
displayed in the text box on the bottom of the Real Property Search form. The information that is displayed will 
depend upon the search order used. The information that displays in the blue box at the bottom of the Real 
Property Search Form will also display in a "tool tip", which can be seen by clicking on any record in the Search 
Results box. 

 

Number of Hits to Display: If Logins are enabled in Tools > Preferences, the Default Number of Hits to Display can 
be changed for each user in two different places. The first location where the default Number of Hits to Display can 
be changed for any user is in Tools > Password Administration, and the second is on any of the Search Forms. 
When the user clicks Cancel to leave one of the Search Forms after changing the Default Number of Hits to Display 
value and performing a search using this new value, WinGAP will display a message asking the user if they would 
like to replace their default Number of Hits to Display. 

 

 

If the new number is to be the new default, the user should click the Yes Button and the Number of Hits to Display 
for this user will be set as the default for that user. Clicking No will leave the defaults to what it was set at 
previously. 

 

 

If logins are not enabled, the default Number of Hits to Display on any Search Form in WinGAP is 200. If Logins are 
not enabled, each user in WinGAP can temporarily change the number of Owner records that will be displayed 
when searching on that Form, if desired, by clicking in the Number of Hits to Display field and keying the new 
number. When the user leaves that Form, the default number will revert to 200. 
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Multiple Owners: At the bottom of the Real Property Search Form is the Multiple Owners memo field. If a Real 
Property parcel has any Multiple Owners keyed on the Owner Information Form, they will be listed here. 

 

 

 

 

PERSONAL PROPERTY SEARCH FORM 

The Personal Property Search Form is used to locate Personal Property accounts. The Form can be reached by one 
of three methods: 

• By clicking on the Personal Button on the WinGAP Toolbar. 

• By clicking on Property Maintenance on the WinGAP Menu Bar, then Personal, then Search. 

• By keying the "hot-key" combination of Ctrl + Shift + P. 
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The Personal Property Search Form is divided into several sections. At the top of the Form is the Search Field, 
where, depending upon the Search Order, the Personal Property account owner's name, parcel number, or other 
criteria is keyed. Beneath the Search field is the Personal Property Information box where Personal Property 
records whose owner's names, account numbers, or other criteria that most closely match that keyed into the 
Search Field will be displayed. On the upper right of the Form is the Search Order section, where the default Search 
Order (Name) can be changed by clicking any of the other Radio Buttons. 

 

Beneath the Search Order section is the Number of Hits to Display field which contains the default number of Real 
Property records that will be displayed in the Real Property Information box. This default value can be temporarily 
changed, if necessary (and if Logins are enabled, set as a default for that user). 

 

The blue panel beneath the Personal Property Information box is a memo field where information about the 
selected account will display. That same information will display in a tool tip if the user hovers their mouse over an 
account in the Search Results. The information displayed changes based on what Sort Order is selected. 
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The Help Button can be clicked to display Help Information about the Personal Property Search Form. The Open 
and Cancel Buttons allow the user to Open the desired Owner record or Cancel the search procedure. 

NOTE: Before keying any search information in the Search Field, the user should be sure that the Cursor is at the 
far left of the field. Not doing this will in most cases produce incorrect information. 

 

Name Search: What the user keys into the Search field is first determined by the Search Order. The default Search 
Order for Personal Property records is Name Order. How the Name is keyed into the Search field will depend upon 
how the County manages the Name information in the Owner's database. Names in WinGAP can be keyed on the 
Owner Information Form in either the Last Name-First Name-Middle Initial fields, or in the Corporate Name field; 
an owner cannot have names in both places. One County may prefer to reserve the Corporate Name field for 
Businesses and Corporations and use the Last Name-First Name-Middle Initial fields for all other owners, another 
County may prefer to use the Corporate Name field for all owners, and a third may prefer to use the Last Name-
First Name-Middle Initial fields for all owners. It is entirely a local matter. Most WinGAP counties use the 
Corporate Name field for all owners. 

 

If the user is looking for a Personal Property owner's name that is in the Last Name-First Name-Middle Initial fields, 
the name MUST be keyed as follows: “Abernathy, Cole”. The comma is mandatory if the Last Name-First Name-
Middle Initial fields are used. 
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If the Personal Property owner's name is found in the Corporate Name field, the name is keyed as it was entered in 
that field: “able patricia”. No comma is used in the Search field for a Corporate Name. 
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Case does not matter in WinGAP. Information on the Owner Information Form can be entered in "proper" case, 
such as “Abernathy, Cole”, or in all capital letters, such as “ABERNATHY, COLE”. It is entirely a local matter. When 
searching for Personal Property owner information, case also does not matter as far as how the Personal Property 
owner's name is keyed in the Search Field: proper, upper, or lower case will all yield the same result. 

 

Once a Personal Property owner's name is keyed in the Search Field, the user should click on the Search Button to 
the right of the field. If an entire name was keyed and found, the Personal Property record(s) for that owner will 
display at the top of the Personal Property Search box, along with other Personal Property records in descending 
alphabetical name order. If the keyed name is not found, Personal Property records with the owner's name 
nearest to the name keyed will display in descending alphabetical order. The number of records that display will 
depend upon the Number of Hits to Display value. 

 

Various short-cuts with the names of Personal Property owners can be used to find owners of Personal Property. 
For example, if the user wishes to see all owners with the Last Name of Smith that have Personal Property 
accounts, the name “Smith” can be keyed in the Search Field. Clicking the Search Button will display the Personal 
Property records with owners of the Last Name or Corporate Name of Smith in the County. Names keyed in the 
Last Name-First Name-Middle Initial fields will display ahead of names keyed in the Corporate Name field. 
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Another short-cut with Name Order searches is to key the beginning part of a Personal Property owner's name in 
the Search Field to find matching owners of Personal Property records. For example, the letters “Bar” can be keyed 
to display all Personal Property records whose owner's Last Name or Corporate Name begins with those letters. 
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Finally, when in Name Search Order, the user can search from the beginning of the alphabet by clicking the Search 
button with a blank Search Field. 

 

The information that is displayed in the Personal Property Search box varies depending upon which Search Order is 
used. When the Name search order is used, the following displays: 

• Owner’s Name. 

• Types of property for this owner, identified by the letters R (Real Property), P (Personal Property), or M 
(Prebilled Manufactured Home). 

• Total Property Value. 

• Owner Account Number (the Ownkey). 

• Personal Property Account Number (the Perskey). 

 

Additional information about a Personal Property record can be viewed by clicking on the record. This information 
is displayed in the text box on the bottom of the Personal Property Search form. The information that is displayed 
will depend upon the search order used. The information that displays in the blue box at the bottom of the 
Personal Property Search Form will also display in a "tool tip", which can be seen by clicking on any record in the 
Search Results box. 
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Lucky Button: The Lucky Button, located to the right of the Search Button, allows the user to perform both a 
search and open the first record that meets the criteria keyed in the Search field. If the user places the mouse 
cursor on the Lucky Button, a "tool tip" will appear. 

 

 

For example, the user wants to look at the Personal Property record for Marcus Arnold. After changing the Search 
Order to Name and keying the name in the Search field, the user can click the Lucky Button and be taken directly 
to the Personal Property General Information form for that property owner. 
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When using the Lucky Button, the criteria keyed into the search field must exactly match that of the desired 
record. Otherwise, the user will be taken to the record that is closest to matching the criteria keyed into the Search 
field. 

 

Parcel Number Search: What the user keys into the Search field is first determined by the Search Order. If Parcel 
Number is selected as the Search Order, the Search Field will not be blank. Instead, it will contain "dashes" near 
the beginning of the field that represent the "breaks" in the Parcel Number between the Map Number and other 
segments of the Parcel Number. The number of "dashes" will depend upon the structure of the County's Parcel 
Number, as set up in the Parcel Number Template Field in Tools > Preferences. The default WinGAP Parcel Number 
structure is XXXX-XXX-XXXX-XXX, with a "dash" between the Map, Block, Parcel, and Sub-Parcel numbers, for a 
total of three "dashes". These three "dashes" would appear toward the left end of the Search Field. The Parcel 
Number can be customized depending upon how a County wants to structure its Parcel Number. 

 

To locate a Personal Property account by a specific Parcel Number, for instance “001-3-2-003-0000”, the entire 
Parcel Number can be keyed into the Search field. The user must be careful while keying the Parcel Number that 
the dashes and any spaces in the Search Field are the same as in the Parcel Number. If the Parcel Number has 
letters in it, the letter can be keyed in either upper or lower case; as in Name Search Order, the case does not 
matter. After clicking the Search Button, the desired record should appear at the top of the Personal Property 
Search box followed by other Personal Property records in ascending Parcel Number order. 



 
578 

 

 

Various short-cuts with Parcel Numbers can be used to find Personal Property records. For example, if the user 
wishes to see all records on Map “007”, then “007” can be keyed in the proper place in the Search Field. Clicking 
the Search Button will display all Personal Property records with that Map Number in the County, up to the default 
Number of Hits to Display value. If there are more records on Map "007" than those displayed in the Personal 
Property Search box and the user wishes to see all of them, the default Number of Hits to Display value can be 
increased to a number suitable to display all the Personal Property records (the Search Button must be clicked 
again after changing the value). 
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Finally, when in Parcel Number Search Order, the user can search from the beginning of all Map/Parcel Numbers 
by clicking Search with a blank Search Field. 

 

The information that is displayed in the Personal Property Search box varies depending upon which Search Order is 
used. When the Parcel Number search order is used, the following displays: 

• Parcel Number. 

• Owner’s Name. 

• Personal Property Account Number (the Perskey). 

• Owner Account Number (the Ownkey). 

 

Additional information about a Personal Property record can be viewed by clicking on the record. This information 
is displayed in the text box on the bottom of the Personal Property Search form. The information that is displayed 
will depend upon the search order used. The information that displays in the blue box at the bottom of the 
Personal Property Search Form will also display in a "tool tip", which can be seen by clicking on any record in the 
Search Results box. 
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Street Search: The Search Order for Personal Property records can be changed to Street Name and Number Order 
by clicking on the Street radio button in the Search Order section of the Personal Property Search Form. The Street 
#, Street Name, and Street Type, also known as the Situs (or Account) Address, must be keyed in the appropriate 
fields on the Personal Property General Information form for the Street search to be successful. The Street 
Number, such as “78”, should be keyed in the House # field; the Street Name, such as "ANTHONY", should be 
selected using the Street Name combo box field; and the Street Type, such as "RD" for "Road", keyed into the Type 
field on the Personal Property General Information Form. 

 

 

 

Various types of searches can be performed in the Street Search field. The beginning part or all of the Street Name, 
without the Street Number if desired, can be keyed in the Search Field to locate Personal Property records. For 
example, the letters “anthony” can be keyed to display all Personal Property records that have Street Names 
beginning with those letters. 
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If a specific Street Name and Number is desired, this is keyed into the Search field by keying the Street Name first, 
followed by a comma, then the Street Number. 
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Finally, when in Street Search Order, the user can also search from the beginning of the alphabet for Street Names 
by clicking Search with a blank Search Field. 

 

The information that is displayed in the Personal Property Search box varies depending upon which Search Order is 
used. When the Street Name Search Order is used, the following displays: 

• Street Name, Street Type, Street Direction, Street Number, Street Extension, Street Quad, Street Unit, and 
Unit Type (the Situs Address for this parcel). 

• Parcel Number. 

• Owner’s Name. 

• Doing Business As (Business ID). 

• County ID Number. 

• Owner Account Number (the Ownkey). 

• Personal Property Account Number (the Perskey). 

 

Additional information about a Personal Property record can be viewed by clicking on the record. This information 
is displayed in the text box on the bottom of the Personal Property Search form. The information that is displayed 
will depend upon the search order used. The information that displays in the blue box at the bottom of the 
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Personal Property Search Form will also display in a "tool tip", which can be seen by clicking on any record in the 
Search Results box. 

 

Account Number Search: The Search Order for Personal Property records can be changed to Account Number 
Order by clicking on the Account # radio button in the Search Order section of the Personal Property Search Form. 
The Account Number for Personal Property records is the same as the WinGAP assigned Perskey number. To locate 
Personal Property by a specific Account Number, for example "467", the entire Account Number should be keyed 
into the Search field. After clicking the Search Button, the desired record should appear at the top of the Personal 
Property Search box followed by other Personal Property records in ascending Account Number order. 

 

 

When in Account Number Search Order, the user can search from the beginning of all Account Numbers by clicking 
on the blank Search Field. 

 

The information that is displayed in the Personal Property Search box varies depending upon which Search Order is 
used. When the Account Number Search Order is used, the following displays: 

• Personal Property Account Number (the Perskey). 

• Digest Class. 

• Street Name, Street Type, Street Direction, Street Number, Street Extension, Street Quad, Street Unit, and 
Unit Type (the Situs Address for this parcel). 
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• Doing Business As (Business ID). 

• Tax District. 

• Current Value. 

• Owner Account Number (the Ownkey). 

 

Additional information about a Personal Property record can be viewed by clicking on the record. This information 
is displayed in the text box on the bottom of the Personal Property Search form. The information that is displayed 
will depend upon the search order used. The information that displays in the blue box at the bottom of the 
Personal Property Search Form will also display in a "tool tip", which can be seen by clicking on any record in the 
Search Results box. 

 

Co ID Number: A quasi account number provided for legacy backward compatibility and/or for allowing counties to 
assign their own identification numbers rather than the WinGAP controlled and assigned Perskey. 

 

DBA: The Search Order for Personal Property records can be changed to Business Name Order (“DBA, or Doing 
Business As”, used to indicate the public trade name of a business) by clicking on the DBA radio button in the 
Search Order section of the Personal Property Search Form. To locate Personal Property by a specific Business 
Name, for example "Additech Inc", the entire Business Name should be keyed into the Search field. After clicking 
the Search Button, the desired record should appear at the top of the Personal Property Search box followed by 
other Personal Property records in alphabetical Business Name order. 
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Various short-cuts with Business Names can be used to find businesses. For example, if the user wishes to see all of 
the Taco Bells, then “Taco Bell” can be keyed in the Search Field. Clicking the Search Button will display the 
Personal Property records with Business Names of Taco Bell in the County. 
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Another short-cut with DBA searches is to key the beginning part of a business’s name in the Search Field to find 
matching Personal Property records. For example, the letters “hom” can be keyed to display all Personal Property 
records where the Business Name begins with those letters. 
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Finally, when in DBA Search Order, the user can search from the beginning of the alphabet by clicking the Search 
button with a blank Search Field. 

 

The information that is displayed in the Personal Property Search box varies depending upon which Search Order is 
used. When the DBA search order is used, the following displays: 

• Doing Business As (Business ID). 

• Personal Property Account Number (the Perskey). 

• Property Class. 

• County ID Number. 

• Tax District. 

• Total Property Value. 

• Owner Account Number (the Ownkey). 

 

Additional information about a Personal Property record can be viewed by clicking on the record. This information 
is displayed in the text box on the bottom of the Real Property Search form. The information that is displayed will 
depend upon the search order used. The information that displays in the blue box at the bottom of the Personal 
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Property Search Form will also display in a "tool tip", which can be seen by clicking on any record in the Search 
Results box. 

 

 

PREBILLED MANUFACTURED HOUSING SEARCH FORM 

The Prebilled Manufactured Housing Search Form is used to locate prebilled manufactured housing records. The 
Search Form can be reached by either of two methods: 

• By clicking on the Prebill MH Button on the WinGAP Toolbar. 

• By clicking on Property Maintenance > Manufactured Housing > Prebill. 

 

 

The Prebilled Manufactured Housing Search Form is divided into several sections. At the top of the Form is the 
Search Field, where, depending upon the Search Order, the Prebilled Manufactured Housing owner's name, parcel 
number, or other criteria is keyed. Beneath the Search field is the Prebilled Manufactured Housing Information box 
where Prebilled Manufactured Housing records whose parcel numbers, owner's names, or other criteria that most 
closely match that keyed into the Search Field will be displayed. On the upper right of the Form is the Search Order 
section, where the default Search Order (Parcel Number) can be changed by clicking any of the other Radio 
Buttons. 
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Beneath the Search Order section is the Number of Hits to Display field which contains the default number of 
Prebilled Manufactured Housing records that will be displayed in the Prebilled Manufactured Housing Information 
box. This default value can be temporarily changed, if necessary (and if Logins are enabled, set as a default for that 
user). 

 

The top blue panel beneath the Prebilled Manufactured Housing Information box is the Multiple Owners memo 
field where the names of Multiple Owners of a parcel will be displayed if the Name Search Order is used. 

 

 

Beneath this panel is another memo field where information about the each of the Prebilled Manufactured Houses 
this Owner has will display. 
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The Help Button can be clicked to display Help Information about the Prebilled Manufactured Housing Search 
Form. The Open and Cancel Buttons allow the user to Open the desired Prebilled Manufactured Housing record or 
Cancel the search procedure. 

NOTE: Before keying any search information in the Search Field, the user should be sure that the Cursor is at the 
far left of the field. Not doing this will in most cases produce incorrect information. 

 

Name Search: What the user keys into the Search field is first determined by the Search Order. The default for the 
Prebilled Manufactured Housing Search Form is Name Order. How the Name is keyed into the Search field will 
depend upon how the County manages the Name information in the Owner's database. Names in WinGAP can be 
keyed on the Owner Information Form in either the Last Name-First Name-Middle Initial fields, or in the Corporate 
Name field. An owner of a Prebilled Manufactured Home cannot have names in both places. One County may 
prefer to reserve the Corporate Name field for Businesses and Corporations and use the Last Name-First Name-
Middle Initial fields for all other owners. Another County may prefer to use the Corporate Name field for all 
owners. A third County may prefer to use the Last Name-First Name-Middle Initial fields for all owners. It is entirely 
a local matter. 

 

If the user is looking for a Prebilled Manufactured Home owner’s name that is located in the Last Name-First 
Name-Middle Initial fields, the name MUST be keyed as follows in this example: “addison, john”. The comma is 
mandatory if the Last Name-First Name-Middle Initial fields are used. 
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If the Prebilled Manufactured Home owner's name is found in the Corporate Name field, the name is keyed as it 
was entered in that field, such as “anderson joe”. No comma is used in the Search field for a Corporate Name, 
unless the comma was keyed as part of the name, and it is strongly recommended that commas are not used in 
the Corporate Name field. 



 
592 

 

 

Case does not matter in WinGAP. Information on the Owner Information Form can be entered in "proper" case, 
such as “Abernathy, Cole”, or in all capital letters, such as “ABERNATHY, COLE”. It is entirely a local matter. When 
searching for Prebilled Manufactured Housing owner information, case also does not matter as far as how the 
Prebilled Manufactured Housing owner's name is keyed in the Search Field: proper, upper, or lower case will all 
yield the same result. 

 

Once an owner's name is keyed in the Search Field, the user should click on the Search Button to the right of the 
field (or use the "hot-key" combination of Alt-S). If an entire name was keyed and found, the Prebilled 
Manufactured Home record(s) for that owner will display at the top of the Prebilled Manufactured Housing Search 
box, along with other Prebilled Manufactured Housing records in descending alphabetical name order. 

 

If the keyed name is not found, Prebilled Manufactured Housing records with the owner's name nearest to the 
name keyed will display in descending alphabetical order. The number of records that display will depend upon the 
Number of Hits to Display value. 

 

Various short-cuts with the names of Prebilled Manufactured Home owners can be used to find owners of 
Prebilled Manufactured Homes. For example, if the user wishes to see all owners with the Last Name of “Smith” 
that own Prebilled Manufactured Homes, the name “smith” can be keyed in the Search Field. Clicking the Search 
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Button will display the Prebilled Manufactured Home records with owners of the Last Name or Corporate Name of 
“Smith” in the County. 

 

 

Names keyed in the Last Name-First Name-Middle Initial fields will display ahead of names keyed in the Corporate 
Name field. The number of records that display will depend upon the Number of Hits to Display value. If there are 
more Smiths than those displayed in the Prebilled Manufactured Housing Search box and the user wishes to view 
all of the Smiths, the default Number of Hits to Display value can be increased to a number suitable to display all of 
the Smiths (the Search Button must be clicked again after changing the value). 

 

Another short-cut with Name Order searches is to key the beginning part of a Prebilled Manufactured Home 
owner's name in the Search Field to find matching owners of Prebilled Manufactured Home records. For example, 
the letters “Bar” can be keyed to display all Prebilled Manufactured Home records whose owner's Last Name or 
Corporate Name begins with the letters "Bar". 
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Finally, when in Name Search Order, the user can search from the beginning of the alphabet by clicking Search with 
a blank Search Field. 

 

The information that is displayed in the Prebilled Manufactured Housing Search box varies depending upon which 
Search Order is used. When the Name search order is used, the following displays: 

• Owner’s Name. 

• Types of property for this owner, identified by the letters R (Real Property), P (Prebilled Manufactured 
Home), or M (Prebilled Manufactured Home). 

• Total Property Value. 

• Owner Account Number (the Ownkey). 

• Prebilled Account Number (the Mobilekey). 

 

Additional information about a Prebilled Manufactured Housing record can be viewed by clicking on the record. 
This information is displayed in the text box on the bottom of the Prebilled Manufactured Housing Search form. 
The information that is displayed will depend upon the search order used. The information that displays in the blue 
box at the bottom of the Prebilled Manufactured Home Search Form will also display in a "tool tip", which can be 
seen by clicking on any record in the Search Results box. 
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Lucky Button: The Lucky Button, located to the right of the Search Button, allows the user to perform both a 
search and open the first record that meets the criteria keyed in the Search field. If the user places the mouse 
cursor on the Lucky Button, a "tool tip" will appear. 

 

 

For example, the user wants to look at the Prebilled Manufactured Housing record for Carol Turner. After changing 
the Search Order to Name and keying the name in the Search field, the user can click the Lucky Button and be 
taken directly to the Prebilled Manufactured Housing property record for that property owner. 
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When using the Lucky Button, the criteria keyed into the search field must exactly match that of the desired 
record. Otherwise, the user will be taken to the record that is closest to matching the criteria keyed into the Search 
field. 

 

Parcel Number Search: The Search Order for Prebilled Manufactured Home records can be changed to Parcel 
Number Order by clicking on the Parcel # radio button in the Search Order section of the Prebilled Manufactured 
Housing Search Form. If Parcel Number is selected as the Search Order, the Search field will contain "dashes" near 
the beginning of the field that represent the "breaks" in the Parcel Number between the Map Number and other 
segments of the Parcel Number. The number of "dashes" will depend upon the structure of the County's Parcel 
Number, as set up in the Parcel Number Template Field in Tools > Preferences. 

 

To locate Prebilled Manufactured Housing records by a specific Parcel Number, for instance " 034-1-2-006-0000", 
the entire Parcel Number can be keyed into the Search field. The user must be careful while keying the Parcel 
Number that the dashes and any spaces in the Search Field are the same as in the Parcel Number. If the Parcel 
Number has letters in it, the letter can be keyed in either upper or lower case, as case does not matter in WinGAP. 

 

After clicking the Search button, the desired record should appear at the top of the Prebilled Manufactured 
Housing Search box, followed by other Prebilled Manufactured Home records in ascending Parcel Number order. 
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Various short-cuts with Parcel Numbers can be used to find Prebilled Manufactured Housing records. For example, 
if the user wishes to see all records on Map “149”, the number “149” can be entered in the Search Field. Clicking 
the Search button will display all Prebilled Manufactured Housing records with that Map Number in the County, up 
to the default Number of Hits to Display value. 
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If there are more records on Map "149" than those displayed in the Prebilled Manufactured Housing Search box 
and the user wishes to see all of them, the default Number of Hits to Display value can be increased to a number 
suitable to display all of the Prebilled Manufactured Housing records (the Search Button must be clicked again 
after changing the value). 

 

Finally, when in Parcel Number Search Order, the user can search from the beginning of Map/Parcel Numbers by 
clicking on the blank Search Field. 

 

The information that is displayed in the Prebilled Manufactured Housing Search box varies depending upon which 
Search Order is used. When the Parcel Number search order is used, the following displays: 

• Parcel Number (prebill map id). 

• Lot number. 

• Owner name. 

• Decal number and year issued. 

• Prebilled Account Number (the Mobilekey). 

• Manufactured Home physical information including length, width, manufacturer, model, and year built. 

• Tax district. 
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• Serial number of the Manufactured Home. 

• Owner Account Number (the Ownkey). 

 

Additional information about a Prebilled Manufactured Housing record can be viewed by clicking on the record. 
This information is displayed in the text box on the bottom of the Prebilled Manufactured Housing Search form. 
The information that is displayed will depend upon the search order used. The information that displays in the blue 
box at the bottom of the Prebilled Manufactured Home Search Form will also display in a "tool tip", which can be 
seen by clicking on any record in the Search Results box. 

 

Street Search: The Search Order for Prebilled Manufactured Housing records can be changed to Street Name and 
Number Order by clicking on the Street radio button in the Search Order section of the Prebilled Manufactured 
Housing Search Form. The beginning part or all of the Street Name, without the Street Number if desired, can be 
keyed in the Search Field to locate Prebilled Manufactured Housing records. For example, the letters “sunny” can 
be keyed to display all of the Prebilled Manufactured Housing records that have Street Names beginning with the 
letters “sunny”. 

 

 

If a specific Street Name and Number is desired, for example “80 Sunnyside Path”, this is keyed into the Search 
field by keying the Street Name first, followed by a comma, then the Street Number. 
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Finally, when in Street Name Search, the user can also search from the beginning of the alphabet for Street Names 
by clicking on the blank Search Field. 

 

The information that is displayed in the Prebilled Manufactured Housing Search box varies depending upon which 
Search Order is used. When the Street search order is used, the following displays: 

• Street Name, Street Type, Street Direction, Street Number, Street Extension, Street Quad, Street Unit, and 
Unit Type (the Situs Address for this parcel). 

• Lot number. 

• Manufactured Home physical information including length, width, manufacturer, model, and year built. 

• Parcel Number (prebill map id). 

• Owner’s Name. 

• Owner Account Number (the Ownkey). 

• Prebilled Account Number (the Mobilekey). 

 

Additional information about a Prebilled Manufactured Housing record can be viewed by clicking on the record. 
This information is displayed in the text box on the bottom of the Prebilled Manufactured Housing Search form. 
The information that is displayed will depend upon the search order used. The information that displays in the blue 
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box at the bottom of the Prebilled Manufactured Home Search Form will also display in a "tool tip", which can be 
seen by clicking on any record in the Search Results box. 

 

Account Number Search: The Search Order for Prebilled Manufactured Housing records can be changed to 
Account Number Order by clicking on the Account # radio button in the Search Order section of the Prebilled 
Manufactured Housing Search Form. The Account Number for Prebilled Manufactured Homes is the same as the 
WinGAP Mobilekey Number for Manufactured Homes. To locate Prebilled Manufactured Homes by a specific 
Account Number, for instance "21080", the entire Account Number should be keyed into the Search field. After 
clicking the Search button, the desired record should appear at the top of the Prebilled Manufactured Housing 
Search box followed by other Prebilled Manufactured Housing records in ascending Account Number order. 

 

 

Finally, when in Account Number Search Order, the user can search from the beginning of all Account Numbers by 
clicking on the blank Search Field. 

 

The information that is displayed in the Prebilled Manufactured Housing Search box varies depending upon which 
Search Order is used. When the Street search order is used, the following displays: 

• Prebilled Account Number (the Mobilekey). 

• Manufactured Home physical information including length, width, manufacturer, model, and year built. 

• Decal number and year issued. 
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• Parcel Number (prebill map id). 

• Tax district. 

• Serial number of the Manufactured Home. 

• Owner Account Number (the Ownkey). 

 

Additional information about a Prebilled Manufactured Housing record can be viewed by clicking on the record. 
This information is displayed in the text box on the bottom of the Prebilled Manufactured Housing Search form. 
The information that is displayed will depend upon the search order used. The information that displays in the blue 
box at the bottom of the Prebilled Manufactured Home Search Form will also display in a "tool tip", which can be 
seen by clicking on any record in the Search Results box. 

 

Co ID # Search: The Search Order for Prebilled Manufactured Housing records can be changed to Location Order by 
clicking on the Co ID # radio button in the Search Order section of the Prebilled Manufactured Housing Search 
form. The Co ID # for Prebilled Manufactured Homes is the Location field on the Manufactured Housing form, 
located just below the PIN field.  

 

Title Number Search: The Search Order for Prebilled Manufactured Housing records can be changed to Mobile 
Home Title Number search order by clicking on the Title Num radio button in the Search Order section of the 
Prebilled Manufactured Housing Search form. 

 

Decal Number Search: The Search Order for Prebilled Manufactured Housing records can be changed to Decal 
Number Order by clicking on the Decal Num radio button in the Search Order section of the Prebilled 
Manufactured Housing Search Form. To locate Prebilled Manufactured Homes by a specific Decal Number, for 
instance “000020”, the entire Decal Number should be keyed into the Search field. After clicking the Search 
Button, the desired record should appear at the top of the Prebilled Manufactured Housing Search box, followed 
by other Prebilled Manufactured Housing records in ascending Decal Number order. 
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The beginning part of the Decal Number, if desired, can be keyed in the Search Field to locate Prebilled 
Manufactured Housing records. For example, the number “10” can be keyed to display all Prebilled Manufactured 
Housing records that have Decal Numbers beginning with “10”. 
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Finally, when in Decal Number Search Order, the user can search from the beginning of all Decal Numbers by 
clicking Search with a blank Search Field. 

 

The information that is displayed in the Prebilled Manufactured Housing Search box varies depending upon which 
Search Order is used. When the Decal Number search order is used, the following displays: 

• Decal number and year issued. 

• Manufactured Home physical information including length, width, manufacturer, model, and year built. 

• Parcel Number (prebill map id). 

• Tax district. 

• Serial number of the Manufactured Home. 

• Owner Account Number (the Ownkey). 

 

Additional information about a Prebilled Manufactured Housing record can be viewed by clicking on the record. 
This information is displayed in the text box on the bottom of the Prebilled Manufactured Housing Search form. 
The information that is displayed will depend upon the search order used. The information that displays in the blue 
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box at the bottom of the Prebilled Manufactured Home Search Form will also display in a "tool tip", which can be 
seen by clicking on any record in the Search Results box. 

 

Serial Number Search: The Search Order for Prebilled Manufactured Housing records can be changed to Serial 
Number Order by clicking on the Serial Num radio button in the Search Order section of the Prebilled 
Manufactured Housing Search Form. To locate Prebilled Manufactured Homes by a specific Serial Number, for 
instance “011878”, the entire Serial Number should be keyed into the Search field. After clicking the Search 
Button, the desired record should appear at the top of the Prebilled Manufactured Housing Search box followed by 
other Prebilled Manufactured Home records in ascending Serial Number order. 

 

 

The beginning part of the Serial Number can be keyed in the Search Field to locate Prebilled Manufactured Housing 
records. For example, the letter “B” can be keyed to display all Prebilled Manufactured Home records that have 
Serial Numbers beginning with that letter. 
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Finally, when in Serial Number Search Order, the user can search from the beginning of all Serial Numbers by 
clicking on the blank Search Field. 

 

The information that is displayed in the Prebilled Manufactured Housing Search box varies depending upon which 
Search Order is used. When the Serial Number search order is used, the following displays: 

• Serial number of the Manufactured Home. 

• Prebilled Account Number (the Mobilekey). 

• Manufactured Home physical information including length, width, manufacturer, model, and year built. 

• Decal number and year issued. 

• Parcel Number (prebill map id). 

• Tax district. 

• Owner Account Number (the Ownkey). 

 

Additional information about a Prebilled Manufactured Housing record can be viewed by clicking on the record. 
This information is displayed in the text box on the bottom of the Prebilled Manufactured Housing Search form. 
The information that is displayed will depend upon the search order used. The information that displays in the blue 
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box at the bottom of the Prebilled Manufactured Home Search Form will also display in a "tool tip", which can be 
seen by clicking on any record in the Search Results box. 

 

 

 

PROPERTY TRANSFER FORM 

The Property Transfer Form is used to transfer property from one owner to another. The Form can be reached by 
any one of several methods: 

• By clicking on the Transfer Button on the WinGAP Toolbar. 

• On the Menu Bar, clicking Property Maintenance > Owner > Property Transfer. 

• By keying the "hot-key" combination of Ctrl-T. 

• By going to any Owner Information form and clicking the Transfer Button. 

• By going to any Real or Personal Property Information forms and clicking the Transfer Button. 

• By going to any Prebilled Manufactured Housing Information form and clicking the Transfer Button. 

The Property Transfer Buttons that are located on the Owner Information and Real and Personal Property General 
Information Forms eliminate the need to select the Current Owner when transferring property. 
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The Property Transfer Form is divided into several sections. At the top of the Form is the Current Owner field and 
Select Button. The Select Button is clicked to produce the Owner Search Form and begin the transfer process. After 
the Current Owner is selected and the user returns to the Property Transfer Form, the Current Owner's name will 
display in the Current Owner Field. Beneath this field and button is the Current Owner Property List Box, where all 
property belonging to the Current Owner will display. 

 

Beneath the Current Owner Property List Box is the New Owner field and Select Button. The Select Button is 
clicked here to again produce the Owner Search Form and select the owner to which the property is to be 
transferred. If the property is to be transferred to an owner not in the system, the Add New Owner Button is 
clicked to add the new owner. After the New Owner is selected (or added) and the user returns to the Property 
Transfer Form, the New Owner's name will display in the New Owner Field. Beneath the New Owner field is the 
New Owner Property List Box, where all property that will be transferred to the New Owner will display after it has 
been received by the New Owner. Finally, the Cancel, Apply and OK Buttons allow the user to cancel the Property 
Transfer, apply the changes and stay on the Form, or save the changes and leave the Form. 

 

Current Owner Field/Select Button: The first step in the Property Transfer process when opening the Property 
Transfer form from a menu item rather than a record is to click the Select Button to the right of the Current Owner 
Field (the user cannot key a name into this field), which will produce the Owner Search Form. 

 

 

The Owner of the property which is to be transferred is located by keying the Owner's name and clicking the 
Search button (or pressing Alt+S). 

NOTE: when using Property Transfer from an owner property record the current owner’s property is already listed 
in this part of the Transfer form. 
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To place the selected Owner’s name on the Property Transfer Form, the user should click the Open Button on the 
Owner Search Form (or press Enter after the desired owner record is selected, double-click on the record, or press 
Alt+O). When the user returns to the Property Transfer Form, the Current Owner's name will display in the Current 
Owner field, and all the Real Property Parcels, Personal Property Accounts, or Prebilled Manufactured Homes that 
belong to that owner will be listed in the Property List Box for the Current Owner. 

 

Current Owner Property List Box: The information that is displayed in the Current Owner Property List Box will 
vary depending on the type of property (Real, Personal, or Prebilled Manufactured Home). Real Property will 
display the description "REAL", followed by the Parcel Number, Legal Description, Total Acres, and Street Address. 
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Personal Property will display the description "PERS", followed by the Account Number, Digest Classification, 
Street Address, and Business ID. 
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A Prebilled Manufactured Home will display the Mobilekey, followed by the Decal Year, Decal Number, Year Built, 
Size, Manufacturer, and Model. 
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If an owner has multiple types of property, all of these will display in the Current Owner Property List Box. 

 

 

New Owner Field/Select Button: Once the Current Owner's property is found and displayed, the next step in the 
Property Transfer process is to select the Owner to which this property is to be transferred. This is done by clicking 
the Select Button to the right of the New Owner field (as with the Current Owner field, the user cannot key a name 
into the New Owner field). This will produce the Owner Search Form, where the same rules and procedures used 
to select the Current Owner can be used to select the New Owner. Once a New Owner record is located in the 
Owner Information List Box and highlighted, the user can return to the Property Transfer Form by clicking the 
Open Button on the Owner Search Form, pressing Enter after the desired owner record is selected, double-clicking 
on the record, or pressing Alt+O. When the user returns to the Property Transfer Form, the New Owner's name will 
display in the Current Owner field. 
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New Owner Property List Box: The New Owner Property List Box will remain blank until the property is selected in 
the Current Owner Property List Box and sent to the New Owner Property List box by clicking either the Include 
Button or the Include All Button. 

 

Add New Owner Button: If the property is to be transferred to an Owner that is at present not in the County's 
Owner database, the user should click the Add New Owner Button. This will produce the Owner Information Form 
where the New Owner can be added. 
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After adding the New Owner and clicking the OK Button on the Owner Information Form, the user will be returned 
to the Property Transfer Form and the New Owner's name will display in the New Owner field. The New Owner 
Property List Box will be blank. 

 

Include and Include All Buttons: Once an existing owner is selected or a new owner is added and the user returns 
to the Property Transfer Form, the Include and Include All buttons will be enabled. 
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To transfer the property, the user should click on the desired property record in the Current Owner Property List 
Box, which will highlight that record. NOTE: If for some reason the Include and Include All buttons are not selected 
(enabled) at this point, all the user has to do is select the property item to be transferred in the Current Owner’s 
list box and the buttons will become enabled. 
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The Include All or Include Buttons are used to perform the actual transfer of property from one owner to the 
other. If only one property record is to be transferred, the user should click the Include Button; if all property 
records belonging to the Current Owner are to be transferred to the New Owner, the user should click the Include 
All Button. The property record(s) will move from the Current Property Owner List Box to the New Property Owner 
List Box. 
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Either the Apply or OK Button should now be clicked to save the Property Transfer, which will prompt the message 
"Are you certain you wish to save these changes?". 

 

 

Clicking "Yes" will transfer the property, "No" will cancel the transfer process. If the user clicks "Yes", other 
messages may appear depending on the characteristics of the property, such as whether certain types of 
Homestead Exemptions should be retained under the New Owner. Also, if all the property from the Current Owner 
was transferred to the New Owner, the user will receive the message "You have removed all property from this 
owner. Would you like to delete this owner record?". 
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If this is the case, "Yes" should be selected to delete the owner from which the property was transferred; "No" will 
preserve the owner record. 

NOTE: In most cases, the owner should be deleted if all property has been removed. However, it is the county’s 
preference as far as how owners without property are maintained. 

NOTE: All of the deleted primary and child records for owner, real, personal, and manufactured housing in WinGAP 
are sent to a deleted records table in case the County wishes to recover any records that have been deleted by 
mistake. Deleted schedule records are not preserved, however. 

 

If the Apply Button was clicked to save the changes, the user will remain on the Property Transfer Form and other 
Property Transfers for these two selected owners can be performed if needed. If the OK Button was clicked, the 
user will return to the main WinGAP window. If the user clicked the Cancel Button before clicking Apply or OK, the 
Property Transfer process was aborted, and the user will be returned to the main WinGAP window. 

 

The steps for transferring property from the Owner, Real Property, Personal Property, and Prebilled Manufactured 
Home Forms are similar to the steps described above, with the exception that the current owner is already 
selected and that owner’s property is already listed in the current property owner’s list box. 

 

 

 

OWNER INFORMATION FORM 

The WinGAP Owner Information Form contains relevant information about each owner of property. The Form can 
be reached for existing property owners from several places: 

• The Owner Search Button on the WinGAP Tool Bar. 

• The Multiple Owners Search Button. 

• The WinGAP Menu Bar by clicking Property Maintenance > Owner > Search. 

• The Real and Personal Property General Information Forms by clicking the Owner Button on those Forms. 

• The Prebilled Manufactured Housing Form by clicking the Owner Button on that Form. 

• The Wild Search form when the Owners checkbox is selected. Changes to the Owner information cannot 
be made in View mode when using Wild Search; if in Edit mode, changes can be made. 
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NOTE: Owner Names in WinGAP can be keyed on the Owner Information Form in either the Last Name-First Name-
Middle Initial fields, or in the Corporate Name field. The way Owner Names are keyed into these two types of 
Name fields depends upon how the County desires to manage the Name information in the database. An Owner 
cannot have names in both places. One County may prefer to reserve the Corporate Name field for Businesses and 
Corporations and use the Last Name-First Name-Middle Initial fields for all other owners while another County 
may prefer to use the Corporate Name field for ALL owners. It is entirely a local matter. 

 

Last Name: This field is 40 characters wide and, if used, should contain the Last Name of the Owner. A comma 
should not be placed after the name in this field. 

First Name: This field is also 20 characters wide and should contain the First Name of the Owner, but only if there 
is a Last name entered. 

Mid Init: The Owner's middle initial, if any, is keyed here. 

Corporate Name: The Corporate Name field, which is 40 characters wide, can be used if a Corporation owns the 
property, or for the names of all Owners, if desired by the County. 
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NOTE: To prevent the unexpected loss of desired ownership data, one of the two available "Name" field sets (Last-
First-Mid Init or Corporate Name) will be disabled when data entry takes place. If the user enters information into 
the Last field on the Owner Information form and tabs/clicks out of the field, the Corporate Name field will be 
disabled. If data entry takes place in the Corporate Name field and a field exit is performed, the Last, First and Mid 
Init fields are disabled. If data entry needs to be made in the disabled name field set, the user must remove all 
information from the other name field set. 

 

Edit Button: This button to the right of the Name fields is used to edit the Owner's Name after the record has been 
saved. Until the record is saved, the Edit button is disabled. The editing of the Name fields can be done with 
certain restrictions: if the Last, First, and Middle Initial Name fields are used for this Owner, access will be allowed 
to these fields by clicking the Edit button, but access to the Corporate Name field will not be allowed. If the 
Corporate Name field is used for this Owner, access will be allowed to this field by clicking the Edit button, but 
access to the Last, First, and Middle Initial name fields will not be allowed. 

 

In addition, if the user attempts to edit the name fields of an Owner who has multiple types of property, the user 
will receive a warning. 

 

 

The user must make sure when changing an Owner's name that the change applies to all the properties of that 
Owner. If this is the case, the user should select the "Yes" option and continue with the change of the Owner 
Name. Selecting the "No" option will return the user to the Owner Information Form. If the Owner's name for only 
one type of property is to be changed, then the user should answer "No" to the above question and instead, the 
property in question that is changing ownership must be transferred to that Owner by clicking the Transfer button 
at the lower right of the Owner Information form (or the Transfer button on the Real, Personal, or Prebilled 
Manufactured Home that is to be transferred). 

 

If any of the parcels of an Owner are under a Preferential, Conservation Use, Historical, Enterprise Zone, or Forest 
Land Protection Act Covenant, clicking the Edit button will produce a warning message. 
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The user should make sure that changing the Owner's name does not violate the provisions of the Covenant. 

 

Address: There are three fields where address information can be entered. Each field is 40 characters wide. The 
first line of the address or additional Owners may be keyed in the first address field, although it is recommended 
that the Multiple Owners field at the bottom of the Owner Information Form be used for additional owners unless 
they are a critical element in the mailing address. Any mailing addresses that were not keyed on the first address 
line can be entered in the second and third Address field. 

City/State: The Property Owner's City and State can be keyed here; however, data entry is faster if the user will 
Tab to the Zip field, where the Zip code, if known, can be used to insert the proper City and State information in 
these fields. 

Zip: The Zip Code of the Property Owner, if known, can be keyed in this field. The Tab key can be pressed to exit 
the field. The system will identify the City and State and ask the user if it is to be inserted in the City and State 
fields. If the City and State match the Zip Code, "Yes" should be clicked; otherwise "No" can be clicked to leave the 
City and State as entered by the user. 

Country: The Owner’s country, if other than the US, is keyed in this field. 

Email: The Owner’s email address, if provided, is keyed in this field. This information is not visible to the Guest 
login and is not printed on PRCs. 

Home/Work/Fax/Cell Numbers: Various methods of contacting the Owner can be keyed in these fields, if 
provided. These fields are pre-formatted for the phone number, and only numbers, beginning with the Area Code. 
This information is not visible to the Guest login and is not printed on PRCs. 

Entity Type: If the Owner is a legal entity, this field can be used to select the entity type. 

FEI: The Owner’s Federal Employer Identification number, if provided, can be keyed here. This information is not 
visible to the Guest login and is not printed on PRCs. 

SSN: The Social Security Number of the Owner, if provided, can be keyed here. This information is not visible to the 
Guest login and is not printed on PRCs. 

SSN 2: The Social Security Number of the Owner’s Spouse, if provided, can be keyed here. This information is not 
visible to the Guest login and is not printed on PRC’s. 

Owner Key: This is a unique, primary key assigned by WinGAP to this Owner record. Until a new Owner record is 
saved, the number will show 0. After the record is saved, the new Owner Key will display. 

Assessment Information: This section displays the total number of Real, Personal, and Prebill accounts that belong 
to this Owner, as well as the Total Acreage of those accounts. 

Value: This section displays the total value of the Land, Improvements, Personal Property, and Mobile Homes that 
belong to this Owner. 

Owner BD: The Birthday of the Owner, if provided, can be keyed here. This information is not visible to the Guest 
login and is not printed on PRCs. 
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Spouse BD: The Birthday of the Owner’s Spouse, if provided, can be keyed here. This information is not visible to 
the Guest login and is not printed on PRCs. 

Non-Disclosure: The purpose of the Non-Disclosure checkbox is to prevent the viewing and release of Ownership 
information for qualifying individuals. If the user places the mouse pointer in the Non-Disclosure checkbox, a "tool 
tip" will appear informing the user of the purpose of the checkbox. 

 

 

According to the Georgia Open Records Act, these individuals include Judges, Law Enforcement Officials, etc. If the 
box is checked, Ownership information will be masked as follows: 

• The address and phone numbers for this Owner will not be visible to guest logins. 

• The address and phone numbers for this owner will not print on a property record card that is initiated 
under a guest login. 

• Guest logins will not be able to see the tool tips for any parcel under the ownership of the owner record 
with a Non-Disclosure flag. 

• Any parcels owned by the individual will not appear in the search box on the Real Property Search Form. 

 

The address and phone numbers for Non-Disclosure Owners will be included with the digest export and sent to the 
digest vendor. It will be the responsibility of the County to coordinate with the digest vendor and define how this 
will be handled on the digest. 

 

Multiple Owners List: The first memo field near the bottom of the Owner Information Form is where Multiple 
Property Owners are keyed. It is recommended to key the Multiple Owners the same way the county would search 
for the owner in the Real Property Search Form: last name then first name if the County uses Corp Name for 
everyone, or last name-comma-first name if the County uses the Last/First/Middle fields. There is no limit to the 
number of Multiple Owners that can be entered. 

Property Items List: The memo field at the bottom of the Owner Information Form will list the Property Items 
belonging to this owner. When an Owner is first added, the field will be blank, but once the Owner has Property, 
the field will populate with account numbers. If the Owner has Real Property, the Parcel Number(s) will display; if 
the Owner has Personal Property, the Account Number(s) will display; if the Owner has Prebilled Manufactured 
Housing, the Manufactured Home Account Number(s) will display. 

Comments: This field is used to add any comments to the Owner record. 

Comment Flag: The Comment Flag checkbox provides a means whereby users can create a visual flag to capture 
the user’s attention. Turning the Comment Flag on turns the background color of the Comments field red. It only 
serves to catch the user’s attention when opening the Owner form. Counties can make their own policies for what 
this visual alert represents. 

Real Button: This button will open any Real Property accounts this Owner has to view or edit and allows the user 
to add new Real Property accounts. 

Personal Button: This button will open any Personal Property accounts this Owner has to view or edit and allows 
the user to add new Personal Property accounts. 
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Prebill MH Button: This button will open any Prebill Manufactured Housing Property accounts for this Owner to 
view or edit and allows the user to add new Prebill MH accounts. 

Documents: Right clicking this button opens a contextual menu that allows you to “Load Digital Documents”. 
Clicking the “Load Digital Documents” option will open a window where the user can navigate to any file, such as a 
PDF of a sales record, and load it to the WinGAPSQL folder on the server. A new folder will be created in the 
WinGAP documents folder on the server with the prefix “o” for Owner followed by the Ownkey assigned by 
Wingap. 

Transfer: This button is used to Transfer one or all the parcels, personal property accounts, or Prebilled 
Manufactured Homes of this property Owner to another Owner. Clicking the Transfer Button will take the user to 
the Property Transfer Form. 

Appointment: This button will open a new blank calendar appointment in Outlook. 

Agent: This button opens the Agent Bridge Form. If the Owner uses a Tax Agent for correspondence on any of their 
properties, they can be viewed with this button. Adding or removing an Agent from an account must be done 
through that property rather than the Owner form. 

 

 

Edit History: This button is used to view the Edit History of this Owner. The Edit Log keeps a record of virtually 
every user-initiated operation that changes a record in WinGAP. Any time a user accesses WinGAP and adds a 
record or makes a change to an existing record it is recorded in the Edit Log database. Each record on the Edit Log 
Form lists the File Name, PKey, ChgAppr ID (if no logins are used, it will say "Nologin"), Edit Date, Edit Time, After 
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Edit (value after edit), Value Time (the time the value was changed), Before Edit (value before edit), and the Owner 
key for the record that was edited. Items in the Edit Log are listed in Date and Time order. 

 

 

Clicking the Field Edits button will reveal the specific changes that were made to the record. 
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BAC: The Bulk Owner Address Changer finds all owners who match exactly across all address lines and allow a bulk 
change to all matches. This tool is accessible from both the Tools > File Maintenance > Bulk Owner Address 
Changer menu option as well as the BAC button on the Owner Information screen. 

 

When opened from an Owner record, the BAC automatically searches for all Owners that have the identical 
information as that owner but that have different ownkeys. The Owner records will display on the form along with 
the current Owner mailing address. 
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All the listed Owner records will have their information updated simultaneously when the new mailing address 
information is keyed on the right side of the screen. Checking the Include checkbox will also allow keying a new 
Owner name in the Last Name, First Name, and Middle fields. 
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Adding a New Owner: A new Property Owner in WinGAP can be added in a variety of ways: 

• By keying the hot key combination of Ctrl+N when on the Main WinGAP screen. 

• By selecting the File Menu on the WinGAP Menu Bar, then New Owner. 

• From the WinGAP Menu Bar by selecting Property Maintenance > Owner > New. 

• By clicking the New Owner button on the Property Transfer Form. 

• By adding a New Owner during the Duplicate Parcel process. 

• By clicking the New Owner button on the Real Property General Information Form. 

• After adding a New Owner on the Owner Information Form and clicking Apply, another New Owner can 
be added at the same time. 

 

When adding a New Owner, the Owner Information Form will always appear with all data entry fields "grayed 
out”. The New Button must be clicked at this point to place the fields "in focus", and the user will be taken to the 
Last Name field where data entry can begin. 
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Clicking the Apply button after adding the new Owner information places the Edit Names, Transfer Property, and 
Edit History buttons “in focus”. Clicking Apply also places the Real, Prebill MH, and Personal Buttons "in focus". The 
appropriate button can be clicked to begin adding property information for this Owner. 

 

Deleting an Owner: Before deleting an owner, the user should confirm that the proper owner is being deleted. 
One step in this process is to check the number of properties that are associated with the owner. Property count 
information is available on the right side of the Owner screen in the Assessment Information section. Deleting an 
owner will remove all properties associated with the owner from the current WinGAP year. The records will be 
saved to tables where they can be recovered if necessary. 

 

An Owner is deleted by clicking the Delete Button at the bottom of the Owner Information Form. This will produce 
the "Deleting this owner…" message. 

 

 

Clicking No will return the user to the Owner Information Form. If the user is certain that this Owner is to be 
deleted, the Yes Button should be clicked, which will produce the Password Entry Form. 

 

 

The WinGAP Password to delete an Owner is the word delete in lower case letters. As the user keys each of the 
letters in the word delete, an asterisk for each letter will appear in the single line edit field. 

 

 

After keying the password, and the user is certain that this Owner should be deleted, the OK Button should be 
clicked to delete this Owner. ALL property belonging to this Owner, including any Real Property Parcels, Personal 
Property Accounts, and Prebilled Manufactured Homes, will be deleted as well. The user will be informed that the 
Owner has been deleted, as seen below. Clicking the OK Button on this message will return the user to the Owner 
Search Form. The Owner that was deleted will no longer be listed in the Owner Search results. 
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NOTE: An Owner can be deleted only when the Owner Information Form is accessed from the Owner Search Form. 
The user cannot delete an Owner when reaching the Owner Information Form from the Real Property, Personal 
Property, or Prebilled Manufactured Homes General Information Forms. 

NOTE: If the user deletes an Owner by mistake, the user can go to the Recall Deleted Property Module (located in 
Tools > File Maintenance > Recall Deleted Property) to restore the deleted records, or get on Online Support and 
one of the DOR Support Agents can restore the records that have been deleted. 

 

 

 

REAL PROPERTY GENERAL INFORMATION FORM 

The WinGAP Real Property General Information Form contains general information about each Real Property 
parcel for an Owner. This Form can be reached in one of four ways: 

• From the Owner Information Form by clicking on the Real Property Button. 

• From the Real Property Search Form. 

• From the View Current Index Search Form. 

• From the Wild Search Form. 
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When the user is on a Real Property Parcel, the Owner's Name is shown in the Title Bar at the top center of the 
form. The data for this parcel will be displayed in the fields for editing purposes. If adding a New Real Property 
parcel, many of the fields on the Form will be "grayed out". The New Button must be clicked at this point to begin 
keying the data. 
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GENERAL INFORMATION 

 

Top/Prev/Next/End Buttons: These four buttons allow the user to navigate through parcels without leaving the 
Real Property General Information Form. The movement is in Parcel Number order beginning from the parcel that 
the user is currently sitting on. The Prev and Next Buttons take the user to the Real Property record immediately 
preceding and following, respectively, the parcel the user is sitting on. The Top Button takes the user to the first 
parcel record in the database while the End Button takes the user to the last parcel record in the database.  

Account Number: The WinGAP assigned Account Number (also known as the Realkey) for the Real Property record 
is displayed in this field. When adding a New Real Property record, the Account Number is displayed after the user 
clicks the Apply Button. When editing the parcel record, the Account Number is disabled. It cannot be edited by 
the user. 

Duplicate Button: The Duplicate Button is used to make a copy, or duplicate, of this Parcel without having to re-
key all the data. This is particularly useful when adding Parcels in a Subdivision where many of the Parcels are 
similar. A different Parcel Number is assigned to the Duplicate Parcel and any editing of the Duplicate Parcel's 
property information can be performed at this time. Clicking the Duplicate Button will produce the message 
"Would you like to duplicate this property?”. 
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Clicking the default "No" or pressing Enter will return the user to the Real Property General Information Form. A 
"Yes" selection will take the user to the Owner Search Form. 

 

 

If the owner of the Duplicate Parcel already exists, the Owner can be located by keying the Owner's name in the 
Search field and clicking the Search Button. When the desired owner is located in the search box, the name can be 
selected on this Form and the Open Button clicked to select this owner. 
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Clicking the Open Button will take the user back to the Real Property General Information Form for the originating 
parcel and produce, superimposed over the Real Property Form, the New Parcel Number Form where the Parcel 
Number of the Duplicate Parcel is keyed. (The Cancel Button can be clicked at this point to abort the Duplicate 
Parcel process if desired). 

 

 

If the user is adding a Duplicate Parcel for an Owner that does not currently exist, an additional step is added to 
the Duplicate Parcel process. Once on the Owner Search Form, the user should click the Cancel Button. This will 
take the user back to the originating parcel, with a message asking the user if they would like to add a new Owner 
superimposed over the Form. 
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If a new owner is to be added, the user should select the "Yes" option which will produce the Owner Information 
Form where the New Button should be clicked to add the New Owner. 

 

 

After adding the New Owner, the OK Button should be clicked to take the user back to the Real Property General 
Information Form for the originating parcel and again produce the New Parcel Number Form, superimposed over 
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the Real Property Form. The Cancel Button can be clicked at this point to abort the Duplicate Parcel process if 
desired. The New Owner record that was added, however, will remain in the system unless manually deleted. 

 

 

After keying the new parcel number, the user should click the OK Button, which will produce a message asking the 
user if they would like to change the previous value of the new account to zero. 

 

 

If the previous value on the duplicated parcel (the new parcel) is to be set to zero, the "Yes" option should be 
selected; selecting the "No" option will keep the previous value of the parcel that was duplicated on the new 
parcel. The user will be taken to the new Real Property General Information Form for the Duplicate Parcel. The 
new Parcel Number is displayed in the Parcel Number field and the appropriate edits to the Duplicate Parcel can be 
made at this point, such as changing the Street, Property, and Exemption Information, or adding an Assessment 
Reason. The appropriate edits, additions, and deletions should also be made to the Land and/or Improvements 
that are on the originating Parcel. Clicking the Apply or OK Button will save the Duplicate Parcel Information. 

 

Notice Checkbox: This is checked if an Assessment Notice is to be printed for this Parcel. If the Parcel Value 
changes due to an addition or deletion, and the user attempts to leave the Real Property General Information 
Form, the user will receive the following message. 
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If the Parcel should receive an Assessment Notice, the "Yes" option should be selected and a checkmark will be 
placed in the Notice checkbox. If Auto-Reasons are enabled in Tools > Preferences, the appropriate Assessment 
Notice for the change(s) to the Parcel will be added to the list of Assessment Reasons for the Parcel as well. 

 

NOTE: All real property parcels should receive a notice during the 45-day printing period. The above checkbox can 
be used if the 45-day notices are to be printed in batches. The Notice checkbox has significant use for the printing 
of second notices and the notices printed for the 30-day appeals. 

 

Special District Checkbox: This description defaults to the Special District Description as defined in Tools > 
Preferences. Placing a "check mark" in this checkbox will group this record with similarly designated Real Property 
records for a specific purpose, such as Garbage Collection, Street Improvements, Property Review, etc. 

PIN Button: The PIN Button allows the user to view all of the parcels for an Owner without leaving the Real 
Property General Information Form. The number of parcels in this Owner's name will be displayed within the 
parentheses. Clicking the PIN Button will produce the Select Parcel to View Form. 

 

 

If more than one parcel exists for the Owner, they will display in Parcel Number order in the list box on the Form. A 
different parcel for this Owner can be selected for viewing/editing by selecting an item in the list box and clicking 
OK, which will take the user to the Real Property General Information Form for that parcel. 

 

Parcel Number: The County Parcel Number assigned to this Parcel is keyed in this field. The "dashes" in the field 
default to the Parcel Number Template as set up in Tools > Preferences. Extreme caution should be used in 
entering the Parcel Number since it is one of the primary property identifiers. If the user enters a parcel number 
that already exists in the County’s database, the user will be informed that they need to select a different parcel 
number: 
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Clicking OK on the message will return the user to the Parcel Number field where another, unique parcel number 
can be entered. 

 

If the user places the mouse pointer in the Parcel Number field, a "Tool Tip" will display showing the Owner's 
Name and the Owner's Address information. 

 

 

NOTE: If the Non-Disclosure field on the Owner Information form for the Owner of this parcel is checked, the tool 
tip containing the Owner Name and Address information will not display. 

 

If a Parcel Number is entered incorrectly, the Parcel Number can be changed by right-clicking on either the PIN 
button or on the Parcel Number field itself. This will produce the Edit Parcel Number menu option. 

 

 

When the Edit Parcel Number option is clicked, the Parcel Number field becomes editable. 

 

 

Alt PIN: The Alt PIN field is used to display the parcel number value that is found in the field parcel_no2 in the 
Realprop.dbf table. This will usually be an "old" PIN Number. The field will not be assigned a template for the PIN 
display since this data may not be formatted in the same manner as a WinGAP PIN Number. 
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The Alt Pin data can be edited by right clicking in the field and selecting the Edit Alt PIN option. 

 

 

When the Edit Alt PIN option is clicked, the Alt PIN field becomes editable. 

 

 

Parent Pin: When a split is performed, the Parent Parcel’s PIN can be entered here. 

Tax District: The County Tax District in which this Parcel is located is selected using this combo box. The combo box 
arrow can be clicked to display a list of all County Tax Districts as set up in Tools > Schedules/Tables > Tax 
Calculation Tables >Tax Districts. 

Assessment Reason: Assessment Reasons can be assigned to a Parcel in one of two ways. WinGAP will 
automatically assign Assessment Reasons to a Parcel if a checkmark has been placed in the Auto-Reasons (Real) 
checkbox in Tools > Preferences. 

 

With Auto-Reasons enabled, there are several events that trigger specific Assessment Reasons to be added. 

• Change of Ownership: Ownership Changed (New Owner) 

• New Parcel Added: New Parcel and New Property (real parcel) added 

• Land added or Modified: Parcel Acreage Changed and Land Split Into Two or More Parcels (Parcel Acreage 
Changed) 

• New Residential Improvement Added: New Residential Improvement Added 

• Residential Improvement Changed: Residential Improvement Characteristics Modified 

• Residential Improvement Deleted: Residential Improvement Deleted 

• New Commercial Improvement Added: New Commercial Improvement Added 

• Commercial Improvement Changed: Commercial Improvement Characteristics Modified 

• Commercial Improvement Deleted: Commercial Improvement Deleted 

• Accessory Improvement Added: New Accessory Improvement Added 

• Accessory Improvement Changed: Accessory Improvement Characteristics Modified 

• Accessory Improvement Deleted: New Accessory Improvement Deleted 

• Manufactured Housing Improvement Added: New Manufactured Housing Improvement Added 

• Manufactured Housing Improvement Changed: Manufactured Housing Improvement Characteristics 
Modified 

• Manufactured Housing Improvement Deleted: Manufactured Housing Improvement Deleted 

• SB346 Sale added to Parcel: Value Adj for 1-Year Arm’s Length Transaction Cap 
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The second method of assigning Assessment Reasons is manually. This can be done even if Auto-Reasons is turned 
on, and the user wishes to assign a different Assessment Reason or a Custom Assessment Reason to the Parcel. To 
assign a new Assessment Reason, remove an existing Reason, or create a Custom Reason, the user should click the 
Asmt Reason button next to the Assessment Reason field. 

 

 

The list of all Assessment Reasons as set up in Tools > Schedules/Tables > Assessment Reasons is displayed in the 
list box on the top half of the Form. If one of these reasons is the correct Assessment Reason for this Parcel, that 
Reason should be selected by clicking on the Reason to highlight it and then clicking the Include Button, which will 
place the Reason in the bottom list box on the Form. The user can also double click the desired reason (s) to move 
it to the bottom list box. More Assessment Reasons, if necessary, can be selected by clicking on another Reason to 
highlight it and then clicking the Include Button again. 
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By default, all Reasons added to the Assessment Reason list are shown on the Notice of Assessment when printed. 
If a reason is to be excluded from the NOA, the user can highlight a Reason in the lower list box and uncheck the 
Show on NOA checkbox. In the lower list box, Reasons that are to be shown on the NOA will display a Y under the 
Show column while excluded reasons will show an N. 

 

 

If this Parcel needs an Assessment Reason that does not currently exist in the Assessment reason schedule, a 
Custom Reason can be created by keying the reason in the Custom Rsn single line edit field. The Add Custom 
Button should then be clicked, which will produce the COA Type form, where one of the 3 available options, 
depending upon the circumstances, must be selected by clicking in the appropriate box. 
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Clicking OK on the COA Type form will place the Custom Reason in the panel at the bottom list box of the Select 
Assessment Reasons Form. There is no limit to the number of Reasons and Custom Reasons that may be added to 
a parcel. The OK Button can be clicked to return to the Real Property General Information Form. 

 

Web URL: Allows users to capture a website that might be associated with the property 

Field Check: This checkbox flags the parcel for a field check and is useful in reporting or locating parcels that 
someone flagged as needing a field review. 

Returned Mail: The Returned Mail checkbox is used to note when the USPS has returned correspondence as 
undeliverable for the parcel. 

Abatement: If “Enable Abatement Calcs” is enabled on the Preferences menu, this checkbox will appear on the 
Real Property General Information form and provide the County with the capability of entering an exemption 
percentage, and WinGAP will calculate the taxable value based on this exemption percentage. When checked, the 
Abatement Ex % field will appear beneath this checkbox. Any Overrides are excluded from the exemption 
percentage process and will remain exactly as they were before any abatement percentage is applied. When first 
applying an abatement percentage to a parcel or account and then saving it (by the Apply or OK button), that 
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percentage will be applied to all child items, and those items will be repriced (if not on Override) and the parcel’s 
Current Value will reflect the % added. 

 

 

STREET INFORMATION 

 

House No: This field is where the House Number that has been assigned to the property for location and address 
purposes is keyed. 

Ext: If the street address contains an extension such as A, 1/2, etc., it should be keyed here. 

Dir: The direction (North, Southeast, etc.) of the street. 

Street Name: The name of the Street or Road where the Parcel is located is selected from the streets listed in this 
combo box. The field defaults to a "blank" when adding a new Parcel. The combo box arrow can be clicked to 
display a list of all Street Name as set up in Tools > Schedules/Tables > Street Directory. 

Type: The Type of Street, such as Road, Drive, Hwy, Lane, etc., is keyed here. 

Post: The post-direction used in addressing, such as 4888 Peachtree St. NW. The NW is the post-direction. 

Units: The Unit Number of the property, sometimes used by Apartments and Condominiums. Examples would be 
Unit 5, Apartment A, etc. 

U-Type: The type of Unit for this property, such as Apartment, Condominium, etc. is keyed in this 10-character 
wide field. 

Latitude: The GPS (Global Positioning System) Latitude of this Parcel, if available, can be keyed into this field. The 
field is 13 characters wide. 

Longitude: The GPS Longitude of this Parcel, if available, can be keyed into this field. The field is 13 characters 
wide. 

Zip Code: The Zip Code where this Parcel is located. The Zip Code will assist in location efforts and with the use of 
the Map It button (discussed later). The Zip Code field will adhere to all rules regarding non-disclosure owners for 
exporting and guest viewing. Keying a Zip Code and pressing the Tab Key takes the user to the Property 
Information Fields section on the Real Property General Information Form. 

 

PROPERTY INFORMATION 

 

LL: This is where the primary Land Lot that the Parcel is located in is keyed. At this time, only one Land Lot may be 
entered. Additional Land Lots maybe keyed in Comments. 

LD: The Land District where the Parcel is located is keyed in this field. Only one Land District may be entered. 
Additional Land Districts may be keyed in Comments. 

GMD: The Georgia Militia District where the Parcel is located is keyed in this field. Only one GMD may be entered. 
Additional GMD’s may be keyed in Comments. 

Zoning: The County Zoning designation for the Parcel. 
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Legal: The Parcel's Legal Description is entered in this 45-character wide field. This information is printed on the 
Assessment Notice. 

Neighborhood: Parcels can be assigned to Neighborhoods for the purposes of adjusting property values in a similar 
manner. The specific Neighborhood where this Parcel is located is selected here using the combo box. The field 
defaults to a "blank" and can be left blank if no Neighborhood is to be assigned. The combo box arrow can be 
clicked to display a list of all Neighborhoods as set up in Tools > Schedules/Tables > Neighborhoods. The entire 
Neighborhood Description can be displayed by placing the mouse pointer over the Neighborhood Field. A "tool tip" 
will display the entire Description. 

 

 

NOTE: when first assigning a Neighborhood to a parcel, or changing a Neighborhood, the user may receive a 
message notifying the user if any of the factors for the new Neighborhood will cause a change in value for the 
parcel. 

 

 

Lender: The Lender field is used to enter a unique identifier for grouping tax bills that are escrowed to a particular 
lending institution. The label can be customized in Tools > Preferences to suit the needs of the county. If the label 
is changed, the new text will be displayed instead of “Lender”. 

Total Acres: Not accessible to the user, the Total Acres field is used to display the Total Acres of the Parcel as 
calculated or entered on the Land Information Form. 

Subdivision: The Subdivision, if applicable, where this Parcel is located is selected here. The field defaults to a 
"blank" and can be left blank if no Subdivision is to be assigned. The combo box arrow can be clicked to display a 
list of all Subdivisions as set up in Tools > Schedules/Tables > Subdivisions List. 

Lot: Used with Subdivisions, the Lot of the Subdivision where the Parcel is located is keyed in this field. 

Blk: Used with Subdivisions, the Block of the Subdivision where the Parcel is located is keyed in this field. 

Sec: Used with Subdivisions, the Section of the Subdivision where the Parcel is located is keyed in this field. 

Phse: Used with Subdivisions, the Phase of the Subdivision where the Parcel is located is keyed in this field.  
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EXEMPTION INFORMATION 

 

Homestead: This is where the Homestead Exemption Code for the Parcel is selected. The default Exemption Code 
is S0. The combo box arrow can be clicked to display a list of all Exemption Codes as set up in Tools > 
Schedules/Tables > Tax Calculation Tables > Exemption Codes. If the property owner has applied for homestead 
exemption on this parcel, the user may select a Homestead Exemption code from the list. WinGAP will not allow 
the user to save any Exemption Code other than S0 until an applicable improvement has been added to the parcel. 
If the user changes the Homestead Exemption from the default of S0 and clicks Apply on the Real Property General 
Information Form before adding the Improvement, a message will display. 

 

 

HS App Date: The Application Date for the Homestead Exemption. The field should be left blank if there is no 
Homestead Exemption. 

The four Float fields below are intended to be used with county LOCAL exemptions that require tracking base 
values and current values  

Float Base1: The first of two Floating Homestead Exemption Base Value fields is where the total 100% Parcel value 
for the year preceding application for Floating Homestead Exemption is keyed. 

Float Curr1: The first of two Current value fields is where 100% of the value of the Parcel in the current digest year 
is keyed. 

Float Base2: The second of two Floating Homestead Exemption Base Value fields is where the total 100% Parcel 
value for the year preceding application for Floating Homestead Exemption is keyed. 

Float Curr2: The second of two Current value fields is where 100% of the value of the Parcel in the previous digest 
year is keyed. 

 

State HS Val: The Total Value of land (up to 10 acres) and improvements that are flagged for the State Homestead 
exemption. WinGAP will place the value in this field; it is not accessible to the user. 

299(c) Value: The 299(c) Value field will contain the value assigned to the Parcel through any appeal decision made 
under the 299(c) statute such as a Board of Equalization decision, Arbitration, County Hearing Officer, etc. 

299(c) Year: The 299(c) Year field will contain the year in which the decision was made. The 299(c) Value and Year 
fields will NOT be passed to the digest but will provide information regarding appeal decisions. 

Covenant Button: The Covenant Button, located in the Exemption Information section of the Real Property 
General Information Form, is used to add all Real Property covenants in WinGAP. Complete procedures for adding 
all types of Covenants are discussed in the Covenant Information Form section. 
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VALUES 

 

Previous: This is the Parcel's Previous Year 100% value. During Year End Cleanup, WinGAP will place the parcel’s 
current year value in this field. This field can be manually keyed by clicking on the Edit Button. 

Current: The Parcel's Current Year 100% value is displayed in the Current field. The value in this field is calculated 
by WinGAP and cannot be directly accessed by the user. 

Return: The value returned by the Owner on the Property Tax Return is keyed in this field. When Assessment 
Notices are run, Parcels with a Return Value can be flagged and Assessment Notices for these Parcels printed, 
regardless of the Assessment Reason for the Parcel. The Return Value is printed on the Assessment Notice. 

Curr-MAV: The Parcel’s Current Year Moratorium Appraised Value (MAV). 

Prev-MAV: The Parcel’s Previous Year Moratorium Appraised Value (MAV). The value can be entered or edited by 
clicking on the Edit Button. 

 

HISTORY 

 

There are three History Year Value Fields for the display of Parcel values for prior years. When a NEW Real 
Property parcel record is added, the dates and value fields are blank. 

 

When a parcel has previous year values, the dates to the left of the field correspond to the three prior years of 
Parcel value history, if available. For instance, if the Current Digest Year is 2021, the Previous Year (2020) value is 
shown in the Previous Year field under the Values section of the Form, and the prior 2019, 2018, and 2017 Parcel 
values are displayed in these 3 History Year fields if that History is available in the Realprop.dbf database for this 
parcel. 

 

If the Current Digest Year is 2021 and Year End Clean Up is run, the years and values will roll forward one year: the 
Current Digest Year would become 2022, Previous Year would be 2021, and Parcel values for 2020, 2019, and 2018 
would display in the History Fields.  

 

Should the Parcel value in any of the History Year fields on a Parcel's Real Property General Information Form need 
to be changed, that can be accomplished by right-clicking on any of the History Year value fields. The Menu item 
"Edit History Values" will appear and the user can click on this item to gain access to the fields, where any of the 
History Values can be changed. 

 

 

Estimated Tax Button: The Estimated Tax Button is used to gain access to the Estimated Tax Details Form. 
Estimated Taxes for the parcel being added will not be available until the Real Property Parcel is added and 
property components (Land, etc) are added to the Parcel. The Estimated Taxes schedules in Tools > 
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Schedules/Tables > Tax Calculation Tables must also be built before Estimated Taxes can be viewed on this form. 
See the Estimated Taxes section for a discussion of the Estimated Tax Details form. 

 

 

PIN History Button: The PIN History button provides access to a parcel's data in previous years. If a Parcel has 
history for more than the Current Year, the user can click the Pin History button which will produce the Select 
Appraisal Year form. 

 

 

The user can select one of the prior appraisal years by selecting that item then clicking the Open button to produce 
the Real Property General Information form for that year for this parcel. The historical record displays a dull yellow 
color. 
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Whether or not changes can be made to a parcel in previous years depends on the rights assigned to the user in 
Tools > Password Administration. A user may have full Edit rights, meaning changes can be made to a prior year, or 
the prior year Real Property General Information form may be in read-only mode, meaning that the user has no 
Edit rights to a parcel and no changes can be made to this data. 

 

The Appraisal Year for the prior year is displayed in the caption bar. PRCs and other reports, except for Assessment 
Notices, can be printed by right-clicking on the printer button. The Cancel button can be clicked to return to the 
Current Year Real Property General Information Form. 

 

PROPERTY TYPE FIELDS 

 

The second section of Value fields will display the Fair Market Values (FMV) and Moratorium Appraised Values 
(MAV, which are no longer used in WinGAP) for the various types of property that are found on the Parcel. 
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Land FMV: The Parcel's Current Year Fair Market Value (FMV) of Land is displayed in this field. The Land Button is 
clicked to Add, Edit or Delete the Land Information for this Parcel. The user cannot directly key a value into this 
field. 

Res Imp FMV: The Parcel's Current Year FMV of all Residential Improvements is displayed in this field. The Res Imp 
Button is clicked to Add, Edit or Delete Residential Improvement records for this Parcel. The user cannot directly 
key a value into this field. 

Com Imp FMV: The Parcel's Current Year FMV of all Commercial Improvements is displayed in this field. The Com 
Imp Button is clicked to Add, Edit or Delete Commercial Improvement records for this Parcel. The user cannot 
directly key a value into this field. 

Acc Imp FMV: The Parcel's Current Year FMV of all Accessory Buildings is displayed in this field. The Acc Imp Button 
is clicked to Add, Edit or Delete Accessory records for this Parcel. The user cannot directly key a value into this 
field.  

 

In addition to each of the Property Type values displaying in their respective fields, the total current year parcel 
value will display to the left of the FMV column heading. 

 

 

Once any type of property item has been added to the parcel, numbers in parentheses indicating the count of each 
property type will display to the right of the item text on the Property Type Button. 

 

 

A star (or asterisk) will appear on a Property Type button when at least one picture has been added to the property 
type form. 
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If Land or any Improvements have an Override Value, a red block will appear to the left of the Property Item 
button. If there are multiple items of a particular property type, for example Accessory Improvements, and only 
one of them has an Override Value, the red block will display indicating that a least one of that particular property 
type has an Override Value. 

 

 

EDIT INFORMATION 

 

Data Entry: The Login ID of the person that adds or edits this Real Property Record is displayed in this field. If 
Logins are not used with WinGAP, "NoLogin" will display in this field. If Logins are used, WinGAP will insert the 
Login ID in this field. While the field is accessible to the user, anything the user keys in this field will not be saved; it 
will be replaced by either the Login ID or “NoLogin”. The field is 10 characters wide. 

Review: The last date that this Parcel was reviewed or the date the Parcel is scheduled to be reviewed is keyed in 
the Review field. The date can either be keyed or the Calendar Button to the right of the field can be clicked to 
select and insert the date. The user can also right click in the Review field and select Today from the menu to insert 
the current date or press the Space Bar on the keyboard to insert today’s date. 

Appraiser: The Appraiser combo box is where the Parcel's primary review appraiser's name can be selected if 
WinGAP users are set up in Tools > Password Administration. The user can also key the Appraiser's name, initials, 
or code if desired. The field is 30 characters wide. The name that appears in the Appraiser field will be printed on 
the Change of Assessment Notice as the primary contact. 

Alternate: The Alternate combo box is where the Parcel's Alternate Appraiser's name can be selected if WinGAP 
users are set up in Tools > Password Administration. The user can also key the Alternate Appraiser's name, initials, 
or code if desired. The field is 30 characters wide. The name that appears in the Alternate field will be printed on 
the Change of Assessment Notice as the alternate contact. 

Edit History Button: This button is used to view the Edit History of this parcel. The Edit Log keeps a record of 
virtually every user-initiated operation that changes a record in WinGAP. Any time a user accesses WinGAP and 
adds a record or makes a change to an existing record it is recorded in the Edit Log database. Each record on the 
Edit Log Form lists the File Name, PKey, ChgAppr ID (if no logins are used, it will say "Nologin"), Edit Date, Edit 
Time, After Edit (value after edit), Value Time (the time the value was changed), Before Edit (value before edit), 
and the Owner key for the record that was edited. Items in the Edit Log are listed in Date and Time order. 
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Clicking the Field Edits button will reveal the specific changes that were made to the record. 
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COA History: The Change of Assessment Notice History for this Parcel can be viewed by clicking the COA History 
Button. This will produce the COA Viewer Form. The Form shows information on all Assessment Notices that have 
been printed for this parcel for the Current Year, assuming that the Notices were appended to the Notices table at 
the conclusion of Assessment Notice Printing. 



 
653 

 

 

COMMENTS 

 

Comments: Any comments about the Parcel can be entered in this field. 

Comment Flag: The Comment Flag checkbox provides a means whereby users can create a visual flag to capture 
the user’s attention. Turning the Comment Flag on turns the background color of the Comments field red. It only 
serves to catch the user’s attention when opening the Real Property General Information form. Counties can make 
their own policies for what this visual alert represents. 

Mask Photo Export: A flag the users can place on a parcel to allow their website vendors to read and know the 
county wishes to suppress the display of photos on the public-facing website. 

 

 

 

PROPERTY ACTIVITIES BUTTONS 

 

On the right side of the Real Property General Information Form are several parcel-specific buttons where 
additional information about this parcel can be added, edited, deleted, or viewed. 
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Prebill: This button is enabled if this parcel has a Prebilled Manufactured Home on it, AND the Parcel Number for 
this parcel has been keyed in the PIN Number field on the Prebilled Manufactured Home Form. Otherwise, the 
button is greyed out. If the above criteria are met, a number in parenthesis will show how many Prebilled 
Manufactured Homes are associated with this parcel. Clicking the button will open a menu that shows the 
associated Manufactured Homes. Selecting one from the list and clicking the OK button will open the Prebill record 
for viewing or editing. 

 

 

Future: This button takes the user to the Future Year Module for this parcel, where information that will apply to 
next year's tax digest can be entered. If there is no Future year record for this parcel, clicking the Future button will 
open a message asking the user if they would like to create a future year record for the parcel. 
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If a future year record already exists for the parcel, there will be asterisks beside the word future and a yellow 
marker with a flashing asterisk beside this button. Clicking on the Future button will take the user to the existing 
Future year record for this parcel. 

 

 

Personal: This button is enabled if this parcel has a Personal Property account where the parcel number has been 
keyed in the Parcel_no field on the Personal Property Form. Otherwise, the button is greyed out. If the above 
criteria are met, a number in parenthesis will show how many Personal Property accounts are associated with this 
parcel. Clicking the button will open a menu that shows the associated Personal Property accounts. Selecting one 
from the list and clicking the OK button will open the record for viewing or editing. 
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Transfer Items: This button takes the user to the Transfer Items Form where any Improvements, Sales, or Permits 
on the parcel can be transferred to another parcel. This button will be "grayed out" (not in use) if there are no 
improvements, sales, or permits on the parcel. 
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Transfer: This button takes the user to the Property Transfer Form, where the entire parcel can be transferred to 
another Owner. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 
658 

Sales: This button takes the user to the Sales Information Form where Sales for this parcel can be entered. 
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Permits: The Permits button takes the user to the Building Permits Form where building permits for this parcel can 
be entered. 
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Appeals: The Appeals button takes the user to the Appeals Form where Appeals for this parcel can be entered. 
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Dup Items: The Dup Items (Duplicate Items) Button takes the user to the Duplicate Items Form, where any 
Improvements, sales, or permits on the parcel can be duplicated. This button will be "grayed out" (not in use) if 
there are no improvements, sales, or permits on the parcel. 
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Bus Lic: The Bus Lic (Business License) Button takes the user to the Business License Form, where Business Licenses 
for this parcel can be entered. 

 

 

Income: This button takes the user to the Income Details Form where income valuation information for the parcel 
may be entered. 
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ACO: The ACO (Account Corrections) Button takes the user to the Account Corrections Form, where Account 
Corrections, Errors & Releases, and Not on Digest situations for this parcel can be entered. 

 

 

Third Party: This button takes the user to the Third Party Menu, where a variety of task-specific buttons will access 
such tools as Google Maps, Bing Maps, and selected County websites, depending on what the Assessors' Office 
uses. Depending upon what is used, the user can view an aerial photo and other information about the property. 

 

 

Documents: Right clicking this button opens a contextual menu that allows you to “Load Digital Documents”. 
Clicking the “Load Digital Documents” option will open a window where the user can navigate to any file, such as a 
PDF of a sales record, and load it to the WinGAPSQL folder on the server. A new folder will be created in the 
WinGAP documents folder on the server with the prefix “r” for Realprop followed by the Realkey assigned by 
Wingap. 
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Timber: The Timber button accesses the Timber Harvest module. 

 

 

A new Timber Sale can be added by clicking the New Button. This will produce a Form with the Land Owner 
information, Tax District, and Realkey already filled in. The user can select the Sale Type and Quarter by clicking on 
the appropriate Radio Button, then key the Sale Year, Form Number, Tracking Number, and dates of sale 
information. Once that is keyed, the Purchaser information can be entered. Clicking the Buyer List button will show 
purchasers that have already been entered on a prior Timber Sale / Harvest form 283T, and clicking their name 
from the Buyer List will automatically populate the Purchaser information. The rest of the form can be filled out 
with the appropriate location, price, and volume information, and when completed, the Apply button should be 
clicked. 

 

At the lower left of the Timber form is the 283T button. This button can be clicked to produce the Report of Timber 
Sale of Harvest. The report lists all the information about the Timber Sale / Harvest. 
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Once entered, the timber sale can be viewed and modified both from the Realprop parcel as well as the Timber 
Tracking module, accessible from the WinGAP Toolbar. 
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Agent: The Agent button opens the Agent Bridge Form. Here, a Tax Agent can be assigned to a parcel. Tax Agents 
will receive any Notice of Assessments in addition to the Owner receiving a copy. Agents are also listed on any 
Appeal filed. 

 

 

The top left box on the Agent Bridge form lists all currently entered Agents. If the property is to be represented by 
an Agent that is already in the database, selecting that agent from this list will complete the first step in assigning 
the Agent to the parcel. If the Agent is not on the list or if the Agent has new contact information, clicking the Edit 
Agent button will open the Agents form. It will initially populate with the information of whichever Agent was 
highlighted in the list box, but clicking New will clear the form and allow the user to enter a new Agent’s 
information. Clicking OK will save the data entry and return the user to the Agent Bridge form. 
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Once the Agent has been selected or a new one entered and highlighted in the Available Agent list, the property to 
be represented by that Agent should be selected in the first (top) green box. Beneath that, selecting Multi-Year will 
keep this Agent linked to the property until manually removed, while selecting Single-Year will disassociate this 
Agent from the property when Year End Cleanup is performed. 
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Once the Agent and Property are both selected and either Multi-Year or Single-Year is checked, clicking the Include 
button beneath the property list will link the Agent and the Property, and the property will be listed in the blue 
Properties Assigned to Agent box on the top right of the form, along with any other properties that Agent is 
representing, and the Agent will be listed in the green Assigned Agent box beneath the property list. To 
disassociate an Agent and a property, highlight the property in the list and click the Remove button. 

 

Appointment: This button will open a new blank calendar appointment in Outlook. 

Growth: This button opens the Growth Overrides form. The Form displays the calculated Real and Inflationary 
Growth for the parcel based on the Assessment Reason codes entered as changes are made to the parcel’s value. If 
the Override checkbox is checked, the user can manually key the Real and Inflationary Growth numbers and any 
value changes to the parcel will not affect the Growth numbers for the parcel. If the Override button is checked, 
WinGAP will display the username that checked the Override box as well as the date and time the box was 
checked. As noted on the Form, all Override Flags are removed when Year End Cleanup is performed. 

 

 

Custom Flags: This button opens the Custom Flags Form, which is a list of Flags that can be queried, but that have 
no impact on value or report results. The list of all Custom Flags as set up in Tools > Schedules/Tables > Custom 
Flags is displayed in the list box on the top half of the Form. If one of these reasons is the correct Custom Flag for 
this Parcel, that Flag should be selected by clicking on the Flag to highlight it and then clicking the Include Button, 
which will place the Flag in the bottom list box on the Form. The user can also double click the desired Flag(s) to 
move them to the bottom list box. More Custom Flags, if necessary, can be selected by clicking on another Flag to 
highlight it and then clicking the Include Button again. 
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If this Parcel needs a Custom Flag that does not currently exist in the Custom Flag schedule, a Custom Reason can 
be created by keying the reason in the Custom Rsn single line edit field. The Add Custom Button should then be 
clicked, and the Flag will be included in the bottom list. 
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Stats: This button opens the Ratio Analysis Criteria Form. This is the same form that opens when navigating to 
Statistics > Basic Selection on the WinGAP Menu Bar. Please see that section for more information on how to 
conduct a Ratio Study. 
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BPC: This button opens the Bulk Parcel Creator, which was designed as a fast and efficient tool to produce a large 
number of parcels with a basic framework of information. This tool is also accessible from the Tools > File 
Maintenance > Bulk Parcel/Subdivision Creator menu option. Please see that section for more information on how 
to use the Bulk Parcel Creator. 

 

 

Schedules: This menu must be right clicked to produce a sub-menu. If using a standard left click, the user is asked 
to right click the button. 
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Right clicking the button produces a sub-menu with three options. These options act as shortcuts to open certain 
relevant schedules for Real Property, which are Assessment Reasons (Tools > Schedules/Tables > Assessment 
Reasons), Neighborhoods (Tools > Schedules/Tables > Neighborhoods), and Street Directory (Tools > 
Schedules/Tables > Street Directory). Please see those sections for more information on those schedules. 

 

 

 

 

REAL PROPERTY PRINTER BUTTON 

 

At the lower left of the Real Property General Information Form is the Printer Button. As on other forms in 
WinGAP, this Printer button can be left clicked to print an image of the entire Real Property General Information 
form. However, the Printer Button on the Real Property Form can also be right-clicked and doing so will produce a 
Print Options Menu. 
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PRC: This option previews a Property Record Card with photo and sketch, which can be printed or exported. 

 

 

PRC Direct to Printer: Instead of creating a preview of the PRC, this option directly prints the PRC without the need 
to generate the preview or click the printer icon. 

PRC Bin: This option sends the Property Record Card to the PRC Holding Bin where it can be printed. See Reports > 
PRC Bin – Real for more information on the PRC Bin. 



 
674 

 

 

 

PRC Large Sketch: This previews a Property Record Card with photo and a large sketch, which can be printed or 
exported. This is the same as the standard PRC except that instead of a sketch thumbnail, the sketch fills an entire 
third page on a PRC. 
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Real Property Return Form: This option will preview the Taxpayer's Return of Real Property, prepopulated with 
the parcel and owner information. The preview can be printed or exported. 
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Homestead Application: This option previews the Application for Homestead Tax Exemption, which can be printed 
or exported. 

 

 

Current Use: This menu item produces the Current Use Menu where nine different Conservation Use Forms can be 
previewed / printed by clicking on the desired option. 
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Conservation Use Application: This option previews a Conservation Use Application form that is pre-filled with the 
parcel and owner information, which can be printed or exported. 
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Conservation Use Application – Blank: This option previews a blank Conservation Use Application form which can 
be printed and filled out by the Property Owner. 
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CU Approval Letter: This option previews a notice informing the taxpayer of Current Use covenant approval which 
can be printed or exported. 
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Environmentally Sensitive – Blank: This option previews a blank Current Use Assessment Application for 
Environmentally Sensitive property form which can be printed and filled out by the taxpayer. 
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Residential Transitional – Blank: This option previews a blank Current Use Assessment Application for Residential 
Transitional property form which can be printed and filled out by the taxpayer. 
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Storm Water – Blank: This option previews a blank Current Use Assessment Application for Storm-Water Wetlands 
property form which can be printed and filled out by the taxpayer. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 
683 

History: This option previews the Conservation Use History for the CUV covenant on this parcel which can be 
printed or exported. 

 

Notice of Intent to Breach: This option previews the Notice of Intent to Assess Penalty for Breach of a 
Conservation Use Covenant form which is sent to a property owner who has breached the terms of the covenant. 
The penalty amount and the reason for the breach are keyed on the report menu bar, then the View Report button 
can be clicked to view the report which can be printed or exported. 
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Breach Calculation: The Breach Calculation button opens a form where the historic millage rates for the County 
can be entered. The View Report button is then clicked to estimate a Breach of Conservation Use penalty.  

 

 

Preferential: This printer icon menu item produces the Preferential Menu where Preferential Assessment Forms 
can be printed by clicking on the desired option. 
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Preferential Application: This option previews the Preferential Use Application that is pre-filled with the parcel 
and owner information, which can be printed or exported. 

 

Preferential Application – Blank: This option previews a blank Preferential Use Application which can be printed 
and filled out by the taxpayer. 
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Notice of Assessment – Change: This menu item produces the Change of Assessment form, which can be used to 
send NOA’s to individual properties that have had assessment value changes due to appeal. 

 

 

The form will fill in today’s date as the Mailing Date by default and will also fill in the Primary and Alternate contact 
as the Appraiser and Alternate from the Realprop screen. The mailing date should be set to the date the NOA will 
be mailed if it will be mailed on a day besides today. Then, the appraiser should select if this is a 30- or 45-day 
appeal window, at which point the Last Day for Appeal field will automatically populate. 

 

If the contacts to be placed on the NOA are other than the ones listed on the form, their names can be entered 
and the “Use this contact information” checkbox should be checked. From here, the appraiser can select from the 
Print Preview, which is the default and loads the report where it can be printed or exported. Clicking in the PDF 
checkbox will also load the report where a PDF can be selected from the drop down option in the report tool bar. 
The XML and Create Scripts checkbox options are not used for printing individual NOA’s. For either the Print 
Preview or PDF options, clicking Print Notices will open the NOA. 
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The taxpayer's name, address, and property information print at the top of the Assessment Notice, with the 
required legal information in the middle of the Notice. A list of Assessment Reasons prints below the value section 
of the notices. This is followed by the Estimated Tax section which is printed at the bottom of the Notice. 

 

Notice of Assessment – No Change: This menu item produces a Notice of Assessment that is used to notify 
Appellants that their value has not been changed due to the appeal and that their appeal is being forwarded to the 
Board of Equalization or that they have 30 days to appeal to the BOE if they had initially appealed to a Hearing 
Officer. 
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The form will fill in today’s date as the Mailing Date by default and will also fill in the Primary and Alternate contact 
as the Appraiser and Alternate from the Realprop screen. The taxpayer's name, address, and property information 
print at the top of the Assessment Notice, with the required legal information in the middle of the Notice. A list of 
Assessment Reasons prints below the value section of the notices. Note: The parcel’s Assessment Reasons are 
used as the “Assessor’s Grounds for Rejection of Taxpayer Position”, and appropriate Assessment Reasons should 
be used accordingly. 
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Appeal Form: This menu item produces a preview of the Appeal of Assessment form that is pre-filled with the 
parcel and owner information, which can be printed or exported. 
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Appeal Waiver and Release Form: This menu item produces the Appeal Waiver and Release form, which can be 
printed and filled out by the taxpayer. 

 

 

FLPA: This menu item produces the FLPA Menu where seven different Forest Land Protection Act forms can be 
produced. 

 

 



 
691 

Application – Pre-Loaded: This menu item previews the Pre-Loaded FLPA Application form that is pre-filled with 
the parcel and owner information, which can be printed or exported. 

 

 

When opening this menu item, WinGAP will remind the user that FLPA requires tracts have at least 50% of the 
parcel coded as woodland acres to qualify. 
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Application – BLANK: This menu item produces a blank FLPA Application form which can be printed and filled out 
by the taxpayer. 

 

 

When opening this menu item, WinGAP will remind the user that FLPA requires tracts have at least 50% of the 
parcel coded as woodland acres to qualify. 
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Approval Letter: This menu item previews a FLPA Approval Letter that is pre-filled with the parcel and owner 
information, which can be printed or exported. 
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Release: This menu item previews the FLPA Application For Release Of Covenant Form, pre-filled with the parcel 
and owner information which can be printed or exported. 
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Notice of Intent to Breach: This menu item previews the Notice of Intent to Assess Penalty for Breach of a FLPA 
Covenant form, which is sent to a property owner who has breached the terms of the covenant. The penalty 
amount and the reason for the breach are keyed on the report menu bar, then the View Report button can be 
clicked to view the report which can be printed or exported. 
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Notice of Assessment: This menu item produces the FLPA Assessment Notice screen, from which the FLPA Change 
of Assessment Notice for this parcel can be printed or exported. 

 

 

NOTE: the above FLPA Change of Assessment notice is one of two Assessment Notices that must be sent to 
Owners of FLPA parcels. This Assessment Notice informs the taxpayer of the FLPA FMV, which is the 2008 Base 
Value that has been indexed. The other Change of Assessment Notice is printed using either the batch printing of 
Assessment Notices (Reports > Assessment Notices Reports > FLPA Assessment Notices) or by right clicking on the 
Printer Menu on any parcel and selecting Change of Assessment Notice. A portion of this second Assessment 
Notice for a FLPA parcel is shown below. This notice will be printed along with all other real property notices. You 
should print this notice for re-prints or a 30-day notice 
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Breach Calculations: The Breach Calculations menu item opens a form where the historic millage rate can be 
entered, then the View Report button clicked to estimate the penalty for a Breach of Forest Land Protection Act 
Covenant property. 
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OWNER INFORMATION BUTTON 

 
 

The Owner Information Button (also called the "People" Button) is located on the lower left of the Real Property 
General Information Form and can be clicked to go to the Owner Information Form for that Parcel to view and/or 
modify the owner information. When the Owner Information Form is reached from the Real Property General 
Information Form, changes can be made to the owner information, but a New Owner cannot be added at this 
point, nor can the Owner be deleted, nor can any of the Owner's other Real or Personal Property, or Prebilled 
Manufactured Homes, if applicable to this Owner, be accessed at this point. 
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REAL PROPERTY GENERAL INFORMATION FORM MESSAGES 

 

Various messages may appear as the user enters and exits the Real Property General Information Form. The 
messages provide the user with basic information concerning covenants and other situations that may need to be 
monitored.  

 

Expired Preferential Agricultural Covenant: 

 

 

Expired Current Use Assessment Covenant: 

 

 

Historical Assessment Covenant That Is Entering Its 9th Year: 
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Historical Assessment Covenant That Has Expired: 

 

 

Homestead Exemption applied with No Residential (or Commercial) Improvement: 

 

 

Homestead Exemption applied without a Homestead Application Date: 
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Appeal Current Value not the same as Parcel Current Value: 

 

 

 

DELETING A PARCEL 

 

A Parcel is deleted by clicking the Delete Button on the Real Property General Information Form. ALL Land 
Information, Improvements, Sales, Permits, etc. that are attached to this Parcel are deleted as well. 

Note: If Documents and Photos are attached to the Parcel, the user will be asked if these items are to be deleted 
as well. If the answer is “Yes”, an attempt will be made to delete the document and picture file(s) and folder(s). If 
this attempt fails, the user will be provided with a dialog box where the documents and photos can be located and 
deleted manually. 

 

When the Delete button is clicked, the user will be asked to confirm they intend to delete the parcel. 

 

 

If the user clicks Yes, the Confirm Delete dialogue will pop up and ask for the confirmation password. If the user is 
absolutely certain this parcel and all associated property items are to be deleted, entering “delete” (without the 
quotation marks) in the password box, then clicking OK. Clicking Cancel will return the user to the Realprop screen 
without deleting any parcel data. 
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LAND INFORMATION FORM 

Land characteristics and subrecord information in WinGAP is added to a Parcel by clicking on the Land Button to 
the left of the Land value field on the Real Property General Information Form. This takes the user to the Land 
Information Form. Both Urban and Rural Land subrecords are added, edited, or deleted on this Form. 

 

 

NOTE: Conservation Use land is added, edited, or deleted by clicking the Covenant Button on the Real Property 
General Information Form, or the Goto CUV Button on the Land Information Form (if the Covenant already exists). 
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Conservation Use land procedures are discussed in the Covenant Information Form section. Forest Land Protection 
Act (FLPA) land is added, edited, or deleted by clicking the Covenants Button on the Real Property General 
Information Form, or the Goto FLPA Button on the Land Information Form (if the Covenant already exists). FLPA 
land procedures are discussed in this manual in the FLPA part of the Covenant Information Form section. 

 

Urban Land: 
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Rural Land: 

 

 

 

GENERAL LAND INFO 

 

Parcel No: The property’s Parcel Number is displayed in this field. It cannot be edited by the user on this Form. 

Class: The Digest Class for the Land, such as Residential, Preferential, Conservation Use, etc. The user can key the 
first letter of the Class, such as "R" in Residential", click on the combo box, or press the Down Arrow to select the 
Class. NOTE: If a beginning Preferential Covenant Year is entered in the Preferential Start Yr field on the Real 
Property Covenant Information Form, a Digest Class of Preferential will be automatically selected in the Class field 
on the Land Information Form. If a beginning Conservation Use Covenant Year is entered in the Conservation Use 
start Year field on the Real Property Covenant Information Form, a Digest Class of Conservation Use will be 
automatically selected in the Class field on the Land Information Form. If a beginning year is entered in the Start 
Year of the FLPA section of the Covenant Information Form, the digest class is automatically set to Forest Land 
Protection. 

Strat: The Digest Stratification for the Land, such as Lots, Large Tracts, etc. The user can key the first letter of the 
Strat, such as "L" in “Lots", click on the combo box, or press the Down Arrow to select the Strat. NOTE: If a Digest 
Strat of "No Land" is selected all fields and controls except the Cancel, Apply, OK, Edit Subs, Comments, Help, 
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Photo, and Edit History Buttons on the Land Information Form will be disabled. An Accessibility/Desirability Code 
of 0A will be automatically assigned to the Parcel. 

Urban/Rural Land Use: This selection controls access to the Urban or Rural Land subrecord fields. The Land Use for 
the Parcel is defined by clicking on either the Urban or Rural radio button. The default selection is Rural. 

Ovr Checkbox: If the entire Land Value of the parcel is to have either a Non-Covenant or Covenant Override Value, 
the user should click in this checkbox. This will open the Override Value fields for data entry. 

QTP Checkbox: A flag to designate the parcel is part of the DOR Qualified Timberland Program for the current tax 
year. 

Non-COV OVR: If the parcel does not have a Covenant but is to have an Override Value, that value should be keyed 
in this field. If an override value is entered, the user should also key an Override Date and select an appropriate 
Override Reason in those fields. NOTE: Per Acre Override Values for individual subrecords for Rural Land are 
entered in the appropriate field in the Rural Subrecords section of this Form. 

COV OVR: If the parcel has a Covenant but is to have an Override Value, that value should be keyed in this field. If 
an override value is entered, the user should also key an Override Date and select an appropriate Override Reason 
in those fields. NOTE: If a COV OVR is entered, the user will receive a message that the Covenant Exemption Screen 
will need to be opened and the Exemption information updated to reflect the Override. 

Total OVR Value: This field combines the values keyed in the Non-COV OVR and the COV OVR fields, and is the 
total override value for the parcel. The user does not have access to this field. 

Land Value: The calculated Land Value will display in this field. The user does not have access to this field.  

Last Calc: If a change is made to any of the Land Information that affects Land Value, the Last Calc field will display 
the previous calculated Land Value, and the Land Value field will display the new calculated value when the Apply 
Button is clicked. Once the OK Button is clicked, the new Land Value will display on both the Last Calc and Land 
Value fields on the Land Information Form. 

Total Acres: The Total Acres for the Parcel should be keyed here. The value in this field must be greater than zero 
and agree with the total calculated acres for the Parcel before the user can save the Land Information data and 
leave the Form. Otherwise, the user will receive a message that the Total Acres do not match the Calculated Acres 
and adjustments will have to be made to either the land subrecord acres or to the user keyed Total Acres. 

Calculated Acres: The Total Acres as Calculated by WinGAP based upon subrecord entry is displayed in this field. 
Calculated Acres must agree with the user-keyed Total Acres. 

Override Acres: The Override Acres field provides the appraiser with a means of capturing the total acreage that 
was used to calculate an Accessibility/Desirability factor when a rural land tract is divided into multiple parcels. The 
field would only be used in situations where a rural land tract is divided by city limits, county lines, or some other 
division that requires the tract to be segregated into multiple parcels. The Accessibility/Desirability factor will be 
determined based on the acreage keyed in this field and the Accessibility/Desirability code that is assigned to the 
parcel. 

Ovr Date: If an Override Value is keyed in the Override Value field, the date the override is entered should be 
keyed in the Ovr Date field. 

Ovr Reason: If an Override Value is keyed in the Override Value field, a Reason for this Override Value should be 
selected from one of the Reasons in this combo box. The list of Override Reasons is based upon those entered in 
Tools > Schedules/Tables > Override Reasons. 

Acc/Des: If Rural Land is the Land Use and the County utilizes an Accessibility and Desirability table to adjust the 
value of Rural Land for location and size, the Acc/Des classification selection is made in these two fields. One 
Acc/Des classification can be used per parcel. If not used, the Acc/Des class fields button should be left at the 
defaults of 0 and A. The factor that is calculated based upon the Accessibility/Desirability selection will display to 
the right of the Acc/Des combo boxes. NOTE: The Acc/Des combo boxes are not available for adding/editing until 
the Edit Subs and Add subrec buttons has been clicked, and then only if Rural Land is the Land Use. 
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Appraiser: The Appraiser combo box on the upper right of the Land Information Form is where the Land 
Appraiser's name can be selected if WinGAP users are set up in Tools > Password Administration. The user can also 
key the Appraiser's name if desired. The field is 45 characters wide. 

Land Influences: Land Influences affect the land value of the entire Parcel and can be either additive or 
multiplicative (also called Compound) depending upon the choice made in the Land Influences field found in Tools 
> Preferences. All values represent percent good. The influences that display are based upon those set up in Tools 
> Schedules/Tables > Land Influences. After selecting the Influence Type, the adjustment factor can be keyed. The 
adjustment factor can range from .01 to 9.99. 

Neighborhood: The Neighborhood Factor that displays in this field is determined by the Land Use (Urban or Rural) 
for the Parcel, the Neighborhood for the Parcel as selected on the Real Property General Information Form, and 
the factor for that type of Land Use as defined in the Neighborhood Schedule, as set up in Tools > 
Schedules/Tables > Neighborhoods. The factor value represents percent good and is multiplicative. The 
Neighborhood Factor can range from .01 to 9.99. If no Neighborhood is defined for the parcel, a 1.00 will display as 
the Factor. 

Land Characteristics: The Land Characteristics section of the Land Information Form allows the user to select the 
Land Characteristics of the Parcel. Land Characteristics are descriptive only and do not affect the value of the 
Parcel. The Land Characteristics that display are based upon those set up in Tools > Schedules/Tables > Land 
Characteristics. 

 

LAND USE 

 

Edit Subs: This button must be clicked to enable adding, deleting, and editing subrecords. To edit an existing 
subrecord, the user may select that subrecord from the list after clicking this button and making any adjustments 
to it as necessary. After completing any edits to the subrecord, the user must click the Apply Subs button. 

Add Subrec: Clicking this button will add a new subrecord to the property. The Apply Subs button must be clicked 
after each new subrecord is added or a subrecord is edited. Adding a new subrecord or editing another subrecord 
without clicking Apply Subs will result in a loss of data. If Urban Land has been selected in the Land Use radio 
button section, the fields in the Urban Subrecords section of the Form will open up for data entry. If Rural Land is 
selected, the fields in the Rural Subrecords section of the Form will open up. 

Delete Subrec: To remove a subrecord, the user must select the subrecord to be deleted in the Subrecord box and 
click the Delete Subrec button. Clicking Complete Edits will notify the user that total acres no longer match 
calculated acres and ask if WinGAP should update the total acres field. Clicking Yes will automatically match the 
two fields while No will leave it to the user to correct. 
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Delete All: If the user wishes to delete all the subrecords on a parcel, this button will perform that task quickly. 
Once this button is clicked, the Land Use radio button is available for toggling between Urban and Rural, and new 
subrecords can be added and applied to the parcel. NOTE: If all Land Subrecords on a Parcel are deleted, the user 
will have to add other Land Subrecords, enter an Override Value, or change the Digest Strat to “No Land” in order 
to continue with saving the Land Information by clicking the Complete Edits Button and/or the OK Button. 

Apply Subs: This button must be clicked after any subrecord is added or edited to save the data. 

Complete Edits: This button will close the Subrecord list for editing and allow the user to edit the general land 
information or click Apply or OK to save the land data and exit the land screen. 

 

ADDING URBAN LAND 

 

 

Subdivision: The first field the user is taken to when adding Urban Land is the Subdivision field. At times, the 
selection in this field will be not a true subdivision but an entry in the Urban Land valuation schedules that 
represents an area of homogeneous pricing. A Subdivision must be selected to add Urban Land subrecords. The 
Subdivisions that display in the list are based upon those set up in the Urban Land Schedule found in Tools > 
Schedules/Tables > Urban Land. 

Front Lot/Back Lot: A Back Lot is a lot or segment of a lot that has no road frontage. The default selection is Front 
Lot. One of these types should be selected, usually Front Lot, regardless of the type of calculation method (Front 
Foot, Acre, Lot, or Square Foot) used for that Subdivision. If adding a Back Lot subrecord, that radio button should 
be selected. 
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NOTE: depending upon the calculation method used by the Subdivision, at least one of the data entry fields in the 
Urban Subrecords section of the Form will be highlighted in yellow. An entry MUST be made in that highlighted 
field for the subrecord; data entry is optional in fields that are not highlighted. 

 

Frontage: The road frontage in feet for the subrecord is keyed here. This field will be highlighted in yellow for a 
subdivision valued by the Front Foot. 

Eff Frontage: The actual road frontage adjusted for a non-uniform subrecord as determined by the appraiser. Data 
entry in this field is optional. However, if an entry is made in this field and the subrecord is valued by the Front 
Foot Method, the Effective Frontage will be used instead of the Frontage to value the subrecord. 

Depth: The lot depth in feet for the subrecord is keyed here. This field will be highlighted in yellow for a 
subdivision valued by the Front Foot. 

Depth Table: The Depth Table field will be visible only when the subrecord uses the Front Foot calculation method. 
The field is used to assign the Depth Table, as determined by the appraiser for that Subdivision. The field will be 
highlighted in yellow and will default to the assigned Depth Table for that Subdivision.  

Feet from St: Used in calculating a Back Lot subrecord, the distance from the street to the front of the Back Lot in 
feet is keyed here. 

Acres - Calc: The acres as calculated by WinGAP for the subrecord. This field cannot be accessed by the user. 

Acres - Actual: Any value entered by the user and greater than zero in the Acres – Actual field will be placed in the 
Calculated Acres field at the top of the Land Information Form and will be used to update Total Acres. The field will 
be highlighted in yellow if the subdivision is valued by the Acres calculation method and an entry will be required. 
NOTE: If the user wishes to use the Acres – Calc field value to update the Calculated Acres at the top of the Land 
Information Form, the Acres – Actual field should be “zeroed out”. 

Lots/Units: The number of Lots occupied by this Subrecord. This field will be highlighted in yellow for a Subdivision 
valued by the Lot calculation method, and data entry will be required for WinGAP to calculate a subrecord value. 
Otherwise, data entry is optional. 

Preferential Subrecord: If the subrecord is under Preferential Assessment, this box should be checked. 

Sq Feet: The field will be highlighted in yellow if the subdivision is valued by the Square Feet calculation method 
and an entry is required. If the subrecord Frontage and Depth are keyed in those respective fields, or the number 
of Acres is keyed in the Acres – Actual field, WinGAP will calculate the square footage. Otherwise, the square 
footage for a Square Footage type subrecord must be keyed in the field to calculate a subrecord value. The 
Calculator to the right of the field can also be used to calculate the square footage and insert the value in the field. 

Subrec Infl: This field is used to enter a percentage adjustment for the subrecord, usually for shape. The default for 
this field is 1.00. Values are always expressed as percent good. Example: a triangular shaped lot with the base of 
the triangle on the street would have a .65 value, while the appraiser would use a .35 if the tip of the triangle is 
towards the street. 

Subrec Value: Not accessible to the user, the value of the subrecord, as calculated by WinGAP, displays in this field. 

Depth Factor: The calculated Depth Factor for the subrecord based on the parcel depth and the depth table 
assigned to the subrecord if the Subdivision used by this subrecord uses the Front Foot calculation method. 

Unit Value: Displays the Unit Value for this subrecord based on the calculation method for this Subdivision. 

Excessive Units: Displays the Excessive Units Value for this subrecord if used by this Subdivision. 

Excessive Factor: Displays the Excessive Units Factor adjustment for this subrecord if used by this Subdivision. 
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Apply Subs: Once the user has finished adding or editing the Urban Land subrecord data, the Apply Subs button 
should be clicked. The Subrecord list box in the left center of the Form will display the Urban Land subrecord that 
was added. The Apply Subs button must be clicked after each new subrecord is added or a subrecord is edited. 
Adding a new subrecord or editing another subrecord without clicking Apply Subs will result in a loss of data. 

 

 

The column headings refer to the Subrecord # (controlled by WinGAP), FF (frontage), SF (square footage), Acres, 
Depth, and Subdivision Name. More Urban Land subrecords can be added at this point, if needed, by again clicking 
the Add subrec button and keying the appropriate data for the new Subrecord. 

 

Complete Edits: When all Subrecord data entry has been completed, the Complete Edits button should be clicked 
to save the information. If the user did not key the Total Acres for the entire parcel near the top of the Land 
Information Form or keyed a number that does not match the Calculated Acres, an alert will display. 

 

 

If Yes if clicked, WinGAP will modify the value in the Total Acres field to match the value in the Calculated Acres 
field. The Apply and OK buttons on the Land Information Form will now be in focus. If the user clicks No on the 
message, WinGAP will not update the Total Acres, the user will have to change the value in the Total Acres field 
manually, and then click the Complete Edits button again. 

 

If the user is not sure that the Calculated Acres is correct, No should be clicked on the message and adjustments 
can be made to the land subrecords if necessary. Once the edits to the subrecords are complete and the Total 
Acres match Calculated Acres, the user should click the Complete Edits button. No message should be received at 
this point, and the Apply and OK buttons on the Land Information form will now be in focus. 
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ADDING RURAL LAND 

 

 

Acc/Des: If the County utilizes an Accessibility and Desirability table to adjust the value of Rural Land for location 
and size, the Acc/Des classification selection is made in these two fields. One Acc/Des classification can be used per 
parcel. If not used, the Acc/Des class fields should be left at the defaults of 0 and A. Also, the Acc/Des should be set 
to 0 and A if the Override Acres field is used. 

Land Type: The first field the user is taken to when adding Rural Land is the Land Type field. The Land Types that 
display are based upon those set up in the Rural Land Schedules found in Tools > Schedules/Tables > Rural Land. 

Productivity: The Productivity Class for the subrecord is selected in this field. A numerical entry of 1 through 9 is 
required for all Land Types. 

Acres: The Acres field requires a number ranging from .01 to 99999.99. 

$/Acre Ovr: If desired, a per acre override value for this subrecord can be entered in this field. If no override value 
is needed, the field should be left at zero. 

Unit Value: This field shows the Base Land Value associated with the Land Type and Productivity Class for this 
Rural Land subrecord as pulled from the Rural Land Schedule. This value does not include any adjustments. 

Preferential Subrecord: If the subrecord is under Preferential Assessment, this box should be checked. 

Subrec Value: Not accessible to the user, the value of the subrecord, as calculated by WinGAP, displays in this field. 

 

Apply Subs: Once the user has finished adding the Rural Land subrecord data, the Apply Subs Button should be 
clicked. The Subrecord list box in the left center of the Form will display the Rural Land subrecord that was added. 
The Apply Subs button must be clicked after each new subrecord is added or a subrecord is edited. Adding a new 
subrecord or editing another subrecord without clicking Apply Subs will result in a loss of data. 

 

 

The column headings in the Subrecord list box refer to the Land Use, Productivity Class, Acres, and Assessment 
type (Ag or Pref). If an Accessibility/Desirability combination for this parcel has been previously selected, that 
factor (or whole tract value) will now display to the right of the Acc/Des selection. More Rural Land subrecords can 
be added at this point, if needed, by again clicking the Add subrec button and keying the appropriate data for the 
new subrecord. 
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Complete Edits: When all Subrecord data entry has been completed, the Complete Edits button should be clicked 
to save the information. If the user did not key the Total Acres for the entire parcel near the top of the Land 
Information Form or keyed a number that does not match the Calculated Acres, an alert will display. 

 

 

If Yes if clicked, WinGAP will modify the value in the Total Acres field to match the value in the Calculated Acres 
field. The Apply and OK buttons on the Land Information Form will now be in focus. If the user clicks No on the 
message, WinGAP will not update the Total Acres, the user will have to change the value in the Total Acres field 
manually, and then click the Complete Edits button again. 

 

If the user is not sure that the Calculated Acres is correct, No should be clicked on the message and adjustments 
can be made to the land subrecords if necessary. Once the edits to the subrecords are complete and the Total 
Acres match Calculated Acres, the user should click the Complete Edits button. No message should be received at 
this point, and the Apply and OK buttons on the Land Information form will now be in focus. 

 

OTHER LAND SCREEN BUTTONS 

 

Comments: Comments about any of the Land information can be entered by clicking the Comments Button, which 
will produce the Land Comments Form. Unlimited Comments about the Land information can be entered here. 
These Comments do not print on the Property Record Card. The Comments can be saved by clicking the OK Button; 
the Cancel Button will not save the Comments. If Comments are entered, an asterisk (*), in parentheses, will show 
on the Comments Button when the user returns to the Land Information Form. 

Goto CUV: The Go to Conservation Use Valuation Land button at the bottom of the Land Information Form is 
"grayed out" unless the user has entered a beginning Conservation Use Year in the Start Year field of the 
Conservation Use section on the Real Property Covenant Information Form. Clicking on the Go to CUV Button takes 
the user to the Conservation Use Form where Conservation Use information can be entered or edited. 
Conservation Use information can also be entered and edited from the Covenant Information Form. The Digest 
Class of Conservation Use will automatically be selected on the Land Information Form when a beginning Covenant 
Year is entered in the Start Year field of the Conservation Use section on the Real Property Covenant Information 
Form. Procedures for adding and editing Conservation Use Land are discussed under the Conservation Use section 
of the Covenant Information Form. 

Goto FLPA: The Go to Forest Land Protection Act Land button is "grayed out" unless the user has entered a 
beginning FLPA Year in the Start Year field of the FLPA section on the Real Property Covenant Information Form. 
Clicking on the Go to FLPA Button takes the user to the FLPA Main Form where FLPA information can be entered or 
edited. FLPA information can also be entered and edited from the Covenant Information Form. The Digest Class of 



 
712 

Forest Land Protection will automatically be selected on the Land Information Form when a beginning Covenant 
Year is entered in the Start Year field of the FLPA section on the Real Property Covenant Information Form. 
Procedures for adding and editing FLPA land are discussed under the FLPA section of the Covenant Information 
Form. 

Photo: Right clicking this button opens a contextual menu that allows you to select from several options. 

 

Clicking the “Load Digital Photo” option will open a dialog box where the user can navigate to a picture and load it 
to the WinGAPSQL folder on the server. A new folder will be created in the WinGAP photo folder on the server 
with the prefix “real” for real property followed by the realkey assigned by Wingap, and the photo will be named 
the same. This is the primary photo for the property. 

 

Selecting the Load Additional Photos option will open a new form, above, that will append more information to the 
photo. Typing in the field to the right of the Photo Name will add that information to the picture name, for 
instance “timber” would name the photo for a property with the realkey 6561 “real6561_timber”. Selecting one of 
the checkboxes will quickly append that information to the photo so the user does not have to type it themselves. 
The user will then navigate to where the picture is on their computer and WinGAP will copy it to the server and 
name it according to the above naming convention. 

 

Selecting “Delete Current Photo” on the Photo button right-click menu will delete the primary photo, while 
selecting “Delete Additional Photos” will open the pictures folder for this record where the user can manually 
select which photos to delete.  

 

Edit History: This button is used to view the Edit History of this land record. The Edit Log keeps a record of virtually 
every user-initiated operation that changes a record in WinGAP. Any time a user accesses WinGAP and adds a 
record or makes a change to an existing record it is recorded in the Edit Log database. Each record on the Edit Log 
Form lists the File Name, PKey, ChgAppr ID (if no logins are used, it will say "Nologin"), Edit Date, Edit Time, After 
Edit (value after edit), Value Time (the time the value was changed), and Before Edit (value before edit) for the 
record that was edited. Items in the Edit Log are listed in Date and Time order. 
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Clicking the Field Edits button will reveal the specific changes that were made to the record. 
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When Land Information data entry is completed, the user leaves the Form by clicking the OK Button, returning to 
the Real Property General Information Form. The current Fair Market Value (FMV) for Land will now display in the 
field underneath the column headed FMV. The Land Button to the left of the value field can be clicked to return to 
the Land Information Form if further changes are needed. 

 

LAND INFORMATION MESSAGES 

 

Various messages may appear as the user enters and exits the Land Information Form. The messages provide the 
user with basic information concerning various situations that may need to be monitored.  

 

Total Acres/Calculated Acres Mismatch: When entering or editing land information and the total acres as entered 
by the user in the Total Acres field do not match the Calculated Acres from subrecord entry, the user will be 
prompted that the acres are not equal. 
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The user can click the "Yes" button to update the Total Acres field with the Calculated Acres and exit the Land 
Information Form. If the user clicks the "No" button, the acres value in the Total Acres field or the land subrecord 
acres will have to be manually adjusted so the Calculated Acres and the Total Acres will match, or edits will have to 
be made to the land subrecords to match Total Acres. The user will not be allowed to exit the Land Information 
Form via the OK button until these two acres fields match. 

 

Calculation Suspended Message 

 



 
716 

A Calculation Suspended message will display when the following occurs: 

• The keyed Total Acres is less than the Acre Break and the sum of the land subrecord acres is greater than 
the Acre Break. 

• The keyed Total Acres is greater than the Acre Break and the sum of the land subrecord acres is less than 
the Acre Break. 

 

If the Acre Break in Preferences is set to 0.00, this mismatch will never happen. The Calculation Suspended 
message is necessary since transitioning from a parcel acreage that is greater than or equal to the acre break can 
result in some extraordinarily large values which should not be calculated until the total acres and the sum of the 
subrecord acres are equal. A calculation will take place when the OK button is clicked. 

 

NOTE: The Calculation Suspended message will not appear when an override value is entered on the Land 
Information Form. 

 

 

COVENANT INFORMATION FORM 

All Real Property Covenants are added on the Covenant Information Form, which is reached by clicking the 
Covenants Button on the Real Property Information Form. 
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ADDING A PREFERENTIAL USE COVENANT 

NOTE: Before adding a Preferential Use Covenant to a Parcel, the user must make sure that there are no other 
Covenants on the Parcel. If another one exists, it must be removed.  

 

The process of adding Preferential land to a Parcel begins with the user keying a value in the Start Year field of the 
Preferential section of the Covenant Information Form. WinGAP will calculate the End Year of the Covenant; this 
field is not accessible to the user. WinGAP will also fill in the Land Val, Exemption, and Accy Val fields once data 
entry on the Preferential Land and Accessory Improvements (if any) is completed. 

 

 

The user should now click the OK Button at the bottom of the Covenant Information Form. The Beginning 
Preferential Year will now display in the Pref YR field directly below the Covenant Button in the Exemption 
Information section on the Real Property Information Form. If Land Subrecords already exist for this Parcel, the 
appraised (market) value of the land will appear in the Ag Land field below the Pref YR field as well. If Land has not 
yet been added, the Ag Land Value will be 0 (zero). 

 

 

The user should now proceed to the Land Information Form and either add the Land Information OR edit each 
Land Subrecord that is under the Preferential Covenant and place a checkmark in the PREF checkbox. Procedures 
for adding and editing Land Subrecords are covered in the Land Information Form section. 
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If any Accessories are under the Covenant, their digest class should be updated as well. 

 

 

Once this is done and the user returns to the Real Property General Information Form, the value of land and the 
total acres under the Preferential Covenant will appear in the Pref Land field in the Covenant section of the Form. 

 

 

If the user clicks on the Covenant Button, the Land Value, Exemption Value, and any Preferential Accessory 
Improvement Values will now display in the Preferential section of the Covenant Information Form. 

 

 

The appraised (A Value) and Preferential (P Value) land values can also be displayed by placing the mouse pointer 
in the Land value field on the Real Property General Information Form, where a “tool tip” will appear displaying 
those values. 
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REMOVING A PREFERENTIAL USE COVENANT PRIOR TO CHANGING TO A CONSERVATION USE 

COVENANT OR A FOREST LAND PROTECTION ACT COVENANT 

If a property owner wishes to change a parcel's covenant from Preferential to either a Conservation Use Covenant 
or a Forest Land Protection Act Covenant, the user should open the Real Property General Information Form for 
the parcel, click on the Covenant button, then click on the Remove Button in the Preferential section of the 
Covenant Information Form. 

 

 

The user will receive a message about the removal process. 

 

 

Clicking the Yes button will remove all information from Covenant form, the Preferential Flags on all land 
subrecords, and the land and accessory Digest Class will be changed from Preferential to Agricultural. 
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ADDING A CONSERVATION USE COVENANT 

NOTE: Before adding a Conservation Use Covenant to a Parcel, the user must make sure that there are no other 
Covenants on the Parcel. If another one exists, it must be removed. Also, the Conservation Use land schedule 
values must be entered prior to adding the Conservation Use Covenant. The Conservation Use schedule values are 
located at Tools > Schedules/Tables > Conservation Use Schedules. 

 

The process of adding a Conservation Use Covenant to a Parcel begins with the user keying a value in the Start Year 
field of the Conservation Use section of the Form. WinGAP will calculate the End Year of the Covenant; this field is 
not accessible to the user. WinGAP will also fill in the Value and Exemption fields once data entry on the 
Conservation Use land is completed. 

 

 

Before leaving the Covenant Information Form, the user must categorize the Conservation Use land as either a 
Residential Transitional Covenant (Res Trans) or a Conservation Use Covenant (CUV) by clicking in one of the two 
checkboxes in this section of the Form. If the Res Trans box is checked, the Edit Button will be disabled and the Res 
Trans Val field will open for data entry, where the Residential Transitional value is entered. If the Res Trans box is 
checked, the user should check the Digest Class on the Land and Improvements to ensure accuracy. If the CUV box 
is checked, the Edit Button will be placed in focus for the entry of Conservation Use Land. 

 

NOTE: Conservation Use Land can be added and/or edited from either the Covenant Information Form or the Land 
Information Form. If the land information has not yet been added on the Parcel, this must be done on the Land 
Information Form before the Conservation Use land is added. Market land subrecord(s) for the land must exist 
prior to adding the Conservation Use Land; these subrecords calculate the market value of the land and will have 
"matching" subrecords on the Conservation Use Form to calculate the Conservation Use value for the Parcel. 
WinGAP will automatically choose Conservation Use as the Digest Class on the Land Information Form after the 
Start Year of the Conservation Use Covenant has been entered and saved, but the user must key the other data on 
the Land Information Form, if the land has not yet been added. The user should consult the Land Information Form 
section for those procedures. 

 

ADDING CONSERVATION USE SUBRECORDS 

Conservation Use land can be added from either of two places in WinGAP: 

• From the Covenant Information Form by clicking the Edit button in the Conservation Use section. This 
method assumes the market Land Information and Subrecords already exist. 
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• From the Land Information Form by clicking the Goto CUV Button. The Goto CUV Button will not be 
available unless the Start Year of the CUV Covenant has been entered and saved. 

 

 

Either method will take the user to the Conservation Use Form. 

 

 

The Conservation Use Form is divided into three sections: Information, Historical Data, and Land Subrecords. Most 
of the fields on the Form will be "grayed out" when adding subrecords for the first time. The New Button at the 
bottom of the Form should be clicked with the mouse to open the fields on the Form, and the user will be taken to 
the Parent Parcel field to begin data entry. 

 

Parent Parcel: The Parcel Number that displays in this field is the current Parcel Number for the Conservation Use 
land that is about to be added. If this Parcel was split from another Parcel that is currently under the Conservation 
Use covenant, then the Parcel Number of the Parent Parcel (where the split came from) should be keyed here. 
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Original CU Value: The Conservation Use value in the Original (beginning) year of the Conservation Use covenant. 
WinGAP will calculate this value based upon subrecord entry. The user has access to this field should the Original 
Conservation Use Value ever need to be changed. 

Original CU Year: The Beginning Year of the Conservation Use covenant, as entered on the Real Property General 
Information Form. 

Base CU Year: The Base Year of the Conservation Use is usually the same as the Original CU Year. There are 
instances, however, where the Base Year will be different. Such instances would be splits, changes in use, etc. 

Total CU Acres: The Total Acres under Conservation Use, which WinGAP will calculate based upon the total acres 
of the Conservation Use subrecords. The user cannot key any data into this field. The number of acres displayed 
here must match the FMV acres. 

Total FMV Acres: The Total Acres of the market value subrecords on the Land Information Form. These acres 
should match the total acres under Conservation Use. WinGAP will place this value in the field, and the user cannot 
key any data into this field. 

 

After reviewing/changing any of the information in the Parent Parcel field or the Information Section of the Form, 
the user should click the Apply Button at the bottom of the Form. This will apply any changes made so far, begin 
filling in the Historical Data in that section of the Form, and place the New Subs Button "in focus" so that the 
Conservation Use subrecords can be added in the Land Subrecords part of the Form. 
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The New Subs Button MUST Be clicked to begin adding a Conservation Use subrecord. There are four fields for 
each Conservation Use Land subrecord. 

 

Land Use: Current Conservation Use law provides two Land Use choices: Agland and Timberland. The proper 
selection is made by clicking on the combo box. 

Productivity: The Productivity Class for the subrecord is selected in this field by clicking on the arrow to the right of 
the combo box and selecting the correct Productivity Class. A numerical entry of 1 through 9 is required for all 
Land Types. 

Acres: The Acres field for this subrecord requires a number ranging from .01 to 99999.99 and is entered by keying 
the value. 

Subrec Value: After keying a value in the Acres field and pressing Tab, the value of the subrecord displays in this 
field. This field is not accessible to the user. 

 

After keying the data for the first Conservation Use subrecord, the user must click the Apply Subs Button to add 
the subrecord, as subrecords can only be added one at a time. The acres of the first subrecord will now display in 
the Total CU Acres field (in the Information section). Other subrecords can now be added in the same manner. 
NOTE: The user MUST remember to click the New Subs Button prior to beginning data entry for each subrecord. 
After all subrecords have been added, the Total CU Acres should agree with the Total FMV acres. At this point the 
Apply Button at the bottom of the Conservation Use Form should be clicked to place the total Conservation Use 
Value of the subrecords in the Original CU Value field. The Conservation Use Years and Values fields in the 
Historical Data section of the Form are filled in as well at this time. 
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This Historical Data section of the Conservation Use Form displays the Conservation Use Years, Conservation Use 
Values, and Exemption Amounts associated with the years that the Parcel was under Conservation Use. WinGAP 
will fill in these fields with the appropriate data as subrecord (s) are added, edited, or deleted and track the data 
across the 10-year covenant period.  

 

Year: The beginning year that the Parcel was under Conservation Use will appear in the first (top left) Year field, 
with subsequent years displayed in the rest of the Year fields in ascending year order. 

Value: The final regulated value of land and accessories under Conservation Use will appear in this field for each of 
the years that the Parcel was under Conservation Use. 

Exemption Amt: The Exemption Amt field displays the SV exemption for the parcel for each year of the Covenant. 
Only the current year is calculated. Previous year exemptions can be keyed and saved with the Apply History 
button. 

Show Percent Change Prompt: In previous versions of WinGAP, users would be prompted when opening the 
Conservation Use Form when CUV values had exceeded the allowable percent change. That is no longer the case. 
The only time the prompt will appear now is when the maximum allowable percentage of change has been 
exceeded and the unadjusted value of the Covenant is not equal to the unadjusted value before the Conservation 
Use Form was opened. This will prevent the continuous prompting for the overwriting of the value once the 
decision has been made about the overwrite. To facilitate the correction of an error in this process, a checkbox, 
“Show Percent Change Overwrite”, as shown above, has been added to the Conservation Use Form. If the box is 
checked, the “Overwrite” prompt will appear, allowing the user to change his/her decision and generate the 
desired results. 

 

Should the Historical Data for a covenant require modification, the user may make such changes by clicking in the 
appropriate field, updating the data, and clicking the Apply History button. 

 

When the user exits the Conservation Use Form by clicking OK and returns to the Covenant Information Form, the 
CUV Value and CUV Exemption amounts will now display in the Conservation Use section of the Covenant 
Information Form. 
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The user can click OK on this form and return to the Real Property General Information Form. The CUV Val and CUV 
Exempt fields will now display the appropriate Conservation Use Value and Exemption Amounts. 
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Subrecords on the Conservation Use Form can be edited by clicking on the appropriate subrecord in the Land 
Subrecords list box. The correction can then be made in the desired field for that subrecord. The Apply Subs Button 
should then be clicked to save the changes to the subrecord. The Apply Button on the bottom of the Form must be 
clicked to update the value in the Original CU Value field. 

 

Subrecords on the Conservation Use Form are deleted, one at a time, by first clicking on the subrecord in the Land 
Subrecords list box and then clicking the Del Subs Button. The message "Do you want to delete this subrecord?" 
will appear. Pressing Enter or clicking on the default "No" will cancel the deletion of the subrecord and return the 
user to the Land Information Form. If the subrecord is to be deleted, the "Yes" Button can be clicked to delete the 
subrecord and return the user to the Conservation Use Form. If the subrecord was deleted, the Apply Button on 
the bottom of the Form must be clicked to update the value in the Original CU Value field. 

 

RENEWING A CONSERVATION USE COVENANT 

A Conservation Use covenant is normally renewed in the January 1 through April 1 period of the first year after the 
expiration of the 10-year covenant. In WinGAP, the user will be informed of the expiration of the Conservation Use 
Covenant when opening a Parcel on which the Covenant has expired. 

 

 

The first step in renewing a Conservation Use Covenant is to click the Covenant Button on the lower left of the Real 
Property General Information Form, proceed to the Conservation Use section of the Covenant Information Form, 
and click the Edit button. 
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WinGAP will produce a covenant expiration message. 

 

 

This message reminds the user that the Conservation Use covenant has expired as determined by comparing the 
CUV Year to the Digest Year. In such cases, the owner may opt to renew the covenant. If the covenant is being 
renewed the user should click No as stated in the message associated with the prompt, and proceed to the 
Conservation Use Form. 
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The Renewal button is used when a Conservation Use covenant has expired and the owner’s new Conservation 
Use application has been approved for another ten year period. The Renewal button will allow the user to retain 
the Conservation Use land subrecord information and begin a new set of Historical Data. 

 

The Renewal button can be clicked to produce the CUV Renewal prompt. The user should click Yes to continue the 
Renewal or No to cancel it. 

 

 

If Yes is selected, the user will be informed that the history information has been cleared and the base year 
updated. 

 

 

The user should now edit each Conservation Use land subrecord to produce a current Conservation Use value. This 
assumes the Conservation Use Schedule in Tools > Schedules/Tables Conservation Use Land has been updated for 
the current year. 
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Clicking OK on the Conservation Use Form returns the user to the Covenant Information Form, where the Start and 
End Years of the Covenant are updated by WinGAP. When the user returns to the Real Property General 
Information Form, the CUV information in the Covenant section of the Form is also updated. 
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REMOVING A CONSERVATION USE COVENANT 

In WinGAP, the user will be informed of the expiration of the Conservation Use Covenant when opening a Parcel 
on which the Covenant has expired. 

 

 

Conservation Use Land subrecords and all other references to Conservation Use, such as CUV Year and V digest 
class (changed to Ag), are removed by first clicking the Covenant Button on the Real Property General Information 
Form then clicking the Remove Button in the Conservation Use section of the Covenant Information Form. 
Conservation Use Land is removed when the covenant expires and is not renewed, or when a covenant is 
breached. 

 

 

WinGAP will produce a covenant removal message. 
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As the message indicates, the removal process performs the following: 

• Deletes the Conservation Use master record and all Conservation Use history for this parcel. 

• Deletes all Conservation Use land subrecords for this parcel. 

• The Digest Class of any Conservation Use accessories are changed from Conservation Use to Agricultural. 

• The Conservation Use Covenant year is removed on the Real Property General Information Form. 

• The land digest class is changed from Conservation Use to Agricultural. 

 

Clicking the Yes button will perform the above processes and leave the user on the Real Property Covenant 
Information Form, and the CUV Value will now be zero. A print preview of the Conservation Use History 
Information for this parcel will display. 

 

 

After printing this report, the user can click the OK Button on the Covenant Information Form to return to the Real 
Property General Information Form. There will no longer be any Covenant information displaying in the Exemption 
Information section of the form. 
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HISTORICAL COVENANTS 

NOTE: Before adding a Historical Covenant to a Parcel, the user must make sure that there are no other Covenants 
on the Parcel. If another one exists, it must be removed. 

 

The process of adding a Historical Covenant to a Parcel begins with the user keying a value in the Start Year field of 
the Historical section of the Covenant Information Form. WinGAP will calculate the End Year of the Covenant; this 
field is not accessible to the user. The user should also key the Historical Value of the property in the Value field in 
this section of the Form. 

 

 

After keying the Value, the user should click the OK Button at the bottom of the Covenant Information Form. The 
Beginning Historical Year and the Historical Value will now display in their respective fields directly below the 
Covenant Button in the Exemption Information section on the Real Property Information Form. 

 

 

WinGAP will also change the Digest Class of the parcel to Historical. The Apply or OK Button on the Real Property 
General Information Form should be clicked to ensure that the Historical Covenant is saved. Removing a Historical 
covenant only requires clicking the Remove button in the Historical section on the Covenant Information Form. 

 

BROWNFIELD COVENANTS 

NOTE: Before adding a Brownfield Covenant to a Parcel, the user must make sure that there are no other 
Covenants on the Parcel. If another one exists, it must be removed. 

 

The process of adding a Brownfield Covenant to a Parcel begins with the user keying a value in the Start Year field 
of the Brownfield section of the Covenant Information Form. WinGAP will calculate the End Year of the Covenant; 
this field is not accessible to the user. The user should also key the Brownfield Value of the property in the Value 
field in this section of the Form. 
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After keying the Value, the user should click the OK Button at the bottom of the Covenant Information Form. The 
Beginning Covenant Year and the Covenant Value will now display in their respective fields directly below the 
Covenant Button in the Exemption Information section on the Real Property Information Form. 

 

 

WinGAP will also change the Digest Class of the parcel to Brownfield. The Apply or OK Button on the Real Property 
General Information Form should be clicked to ensure that the Brownfield Covenant is saved. Removing a 
Brownfield covenant only requires clicking the Remove button in the Brownfield section on the Covenant 
Information Form. 

 

ENTERPRISE ZONE COVENANTS 

NOTE: Before adding an Enterprise Zone Covenant to a Parcel, the user must make sure that there are no other 
Covenants on the Parcel. If another one exists, it must be removed. 

 

The process of adding an Enterprise Zone Covenant to a Parcel begins with the user keying a value in the Start Year 
field of the Enterprise Zone section of the Covenant Information Form. WinGAP will calculate the End Year of the 
Covenant and the Covenant Value; these fields are not accessible to the user.  

 

 

The user should now click the OK Button at the bottom of the Covenant Information Form. The Beginning 
Enterprise Zone Year and the Enterprise Zone Value will now display in their respective fields directly below the 
Covenant Button in the Exemption Information section on the Real Property Information Form. 
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The Apply or OK Button on the Real Property General Information Form should be clicked to ensure that the 
Enterprise Zone Covenant is saved. Removing an Enterprise Zone covenant only requires clicking the Remove 
button in the Enterprise Zone section on the Covenant Information Form. 

 

ADDING A FOREST LAND PROTECTION ACT COVENANT 

NOTE: Before adding a Forest Land Protection Act (hereafter called FLPA) Covenant to a Parcel, the user must 
make sure that there are no other Covenants on the Parcel. If another one exists, it must be removed. Also, the 
FLPA land schedule values must be entered prior to adding the FLPA Covenant, and the FLPA Index must also be 
set up. Both the schedule values and the index are located at Tools > Schedules/Tables > FLPA Schedules. 

  

The process of adding a FLPA Covenant to a Parcel begins with the user keying a value in the Start Year field of the 
FLPA section of the Form, as seen below. WinGAP will calculate the End Year of the Covenant; this field is not 
accessible to the user. WinGAP will also fill in the Value and Exemption fields once data entry on the FLPA land is 
completed. The Start Year value must be 2009 or later for the program to calculate the FLPA values properly and 
track them throughout the fifteen years of the covenant. 

 

 

NOTE: FLPA Land can be added and/or edited from either the Covenant Information Form or the Land Information 
Form. If the land information has not yet been added on the Parcel, this must be done on the Land Information 
Form before the FLPA land is added. Market land subrecord(s) for the land must exist prior to adding the FLPA 
Land; these subrecords calculate the market value of the land and will have "matching" subrecords on the FLPA 
Main Form to calculate the FLPA value for the Parcel. WinGAP will automatically choose Forest Land Protection as 
the Digest Class on the Land Information Form after the Start Year of the FLPA Covenant has been entered and 
saved, but the user must key the other data on the Land Information Form, if the land has not yet been added. The 
user should consult the Land Information Form section for those procedures. 

 

ADDING FLPA SUBRECORDS 

FLPA land can be added from either of two places in WinGAP: 

• From the Covenant Information Form by clicking the Edit button in the FLPA section, as seen below. This 
method assumes the market Land Information and Subrecords already exist. 
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• From the Land Information Form by clicking the Goto FLPA Button. The Goto FLPA Button will not be 
available unless the Start Year of the FLPA Covenant has been entered and saved. 

 

 

Either method will take the user to the FLPA Main Form. 

 

 

The FLPA Main Form is divided into four sections: general information, parcels under the covenant, historical data, 
and land subrecords. All the fields on the Form will be "grayed out" and empty when adding the FLPA information 
for the first time. The New Button at the bottom of the Form must be clicked with the mouse to begin the process 
of adding the FLPA land. This will produce the FLPA Application Menu form. 
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This Menu has two options. If this is a new FLPA Covenant/Application, the user should select the New Covenant – 
New FLPA App Num menu item. If the Parcel is being adding to an existing Covenant, the user should select the 
Add this Parcel to existing FLPA Application item. 

 

NEW FLPA COVENANT/APPLICATION 

Selecting the New Covenant – New FLPA App Num menu option opens the fields in the General Information 
section of the FLPA Main Form and takes the user to the FLPA App Num (Application Number) field.  

 

FLPA App Num: The FLPA Application Number for this Covenant. The first part of the FLPA App Num field, which 
contains the Application Year and the County Number, is not accessible to the user. The second part of the field is 
accessible to the user and contains the sequential number assigned to each Application. 

Deed Bk/Pg: A data entry field used to track the book and page of the recorded covenant. 

FLPA Schedules: Clicking this button opens a submenu with two options, which is identical to the one found at 
Tools > Schedules/Tables > FLPA Schedules. See that section for more information. 

Cov Acres: This Parcel’s Acres under this Covenant. 

Total Cov Acres: Total Acres for all Parcels under this Covenant 

Total Incl Acres: This acreage is calculated from the subrecords entered on the FLPA Form. 

Tot Actual Acres: The Total Acres of this Parcel. 

Original Year: The Beginning Year of the FLPA covenant, as entered on the Real Property General Information 
Form. 

Base Year: The Base Year of the FLPA Covenant is usually the same as the Original FLPA Year. There are instances, 
however, where the Base Year will be different. Such instances would be splits, changes in use, etc. 

True FMV: The Fair Market Value of the land for this Parcel. 

Base Value: The Base Value field is automatically filled by WinGAP with the 2008 land fair market value. If the 2009 
acres do not equal the 2008 acres, the Base Value will be the 2008 per acre value times 2009 acres. 

FL 2019 Value: The FL (FLPA) 2019 Value field is automatically filled by WinGAP with the 2019 land fair market 
value. This value field will be updated every 3 years as required by law. 

2019 Per Acre: The 2019 Per Acre field is automatically filled by WinGAP with the 2019 land fair market value 
divided by the total acres of the land. This value field will be updated every 3 years as required by law. 

Current Year – COV Val: The current year’s FLPA Covenant Value. 

Current Year – Exemption: The current year’s FLPA exemption (FMV – CUV). 

Current Year – FL FMV: The current year’s FLPA Fair Market Value. 
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After reviewing and changing any of the information in the General Information Section of the Form, the user 
should click the Apply Button at the bottom of the Form, which will save any changes made to the information, 
and the Land Subrecords part of the Form will be opened for editing. 

 

 

Clicking the Import Soils From FMV button will add the Landsubs that are entered on the Land Information screen 
for real property to the FLPA Subrecords section automatically. Alternatively, the user can click the New Sub 
button to manually add records to the section. 

NOTE: there is no Land Type field for FLPA subrecords. All land under the FLPA is Woodland. 



 
738 

 

 

Productivity: The Productivity Class for the subrecord is selected in this field by clicking on the arrow to the right of 
the combo box and selecting the correct Productivity Class. A numerical entry of 1 through 9 is required. This 
shows under the “Lclass” column heading in the subrecord list box. 

Acres: The Acres field for this subrecord requires a number ranging from .01 to 99999.99, and is entered by keying 
the value. 

Value: After entering the Productivity and Acres, the value of the subrecord will display in this field. This field is 
automatically calculated by WinGAP and is not accessible to the user. 

 

If manually keying the subrecords, after keying the data for the first FLPA subrecord, the user must click the Save 
Sub Button to add the subrecord, as subrecords can only be added one at a time. The first subrecord will now 
appear in the Land Subrecords list box and the acres of the first subrecord will also display in the Cov Acres field in 
the general information section of the Form. The Current Year COV Val, Exemption, and FL FMV fields will be filled 
as well. After importing or entering all subrecords, the Complete Edits button should be clicked followed by the 
Apply button to save the record. NOTE: The Cov Acres must agree with the Total Actual Acres in the General 
Information section of the Form. 

 

Should any subrecords need to be edited, the Edit Subrecords button should be clicked, the subrecord selected, 
and the data updated, after which the Save Sub button must be clicked. Deleting a subrecord follows the same 
steps except instead of updating the data, the Delete Sub button should be clicked. Once all edits are done, the 
Complete Edits button must be clicked followed by the Apply button. 
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NOTE: The Landsubs section on the upper right side of the FLPA Main form will only display when the Import Soils 
button has been clicked and will not show again once the FLPA Main record has been saved and the form exited. 

 

WinGAP will fill in the History fields with the appropriate data as subrecord(s) are added, edited, or deleted and 
track the data across the covenant period. This section of the FLPA Main Use Form displays the following 
information. 

 

Year: The beginning year that the Parcel was under the FLPA Covenant will appear in the first (top left) Year field, 
with subsequent years displayed in the rest of the Year fields in ascending year order. 

Value: The final regulated value of land under the FLPA Covenant will appear in this field for each of the years that 
the Parcel was under the Covenant. 

Exemption: The Exemption Amt field displays the exemption for the parcel for each year of the Covenant. Only the 
current year is calculated. Previous year exemptions can be keyed and saved with the Apply History button. 

FL FMV: The FLPA Fair Market Value for each of the covenant years. 

Show Percent Change Prompt: In previous versions of WinGAP, users would be prompted when opening the FLPA 
Form when FLPA values had exceeded the allowable percent change. That is no longer the case. The only time the 
prompt will appear now is when the maximum allowable percentage of change has been exceeded and the 
unadjusted value of the Covenant is not equal to the unadjusted value before the FLPA Main form was opened. 
This will prevent the continuous prompting for the overwriting of the value once the decision has been made 
about the overwrite. To facilitate the correction of an error in this process, a checkbox, “Show Percent Change 
Prompt”, as shown above, has been added to the FLPA Main form. If the box is checked, the “Change Prompt” will 
appear, allowing the user to change his/her decision and generate the desired results. 



 
740 

Should the Historical Data for a covenant require modification, the user may make such changes by clicking the 
Edit History button at the bottom of the Historical Data section on the FLPA Main form. After making any changes, 
the Apply History button must be clicked to save the changes. When the user exits the FLPA Main Form and 
returns to the Covenant Information Form, the CU Value and Exemption amount now appear on the FLPA part of 
the Form. 

 

 

When the user returns to the Real Property General Information Form, the FLPA YR, the FLPA CU Val, and the FLPA 
Exempt fields will now display the appropriate FLPA Value and Exemption Amounts. 

 

 

 

 

ADDING OTHER PARCELS TO A FLPA COVENANT 

To add other contiguous Parcels to an existing FLPA Covenant, first the Parcel to be added is located by one of the 
Real Property Search Methods. Once the record is opened, the Covenant Button on this Parcel should be clicked. 
The Starting Year of the Covenant is keyed in the Start Year field on the Covenant Information Form and the Edit 
Button is clicked to reach the FLPA Main Form. The New Button is clicked to bring up the FLPA Covenant Menu 
where the user should select the “Add this Parcel to existing FLPA Application”. 
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The list of Existing Covenants will appear, and the user should click on the Parcel/Covenant that the Parcel is to be 
added to. The Existing Covenants list will default to display covenants created in the current year digest, but older 
existing covenants may be selected by picking the Covenant Year from the combo box. 

 

 

After selecting the correct Parcel/Covenant, the user should click on the Pick This One Button, after which the FLPA 
Main Form will appear. 
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The user should now click the Apply Button, and all Parcels assigned to the Covenant Application Number will 
appear in the Existing Covenant list box. 
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The FLPA subrecords for this Parcel should now be added to this Covenant by either clicking the Import Soils From 
FMV or the New Sub button in the Subrecords section of the Form and following the steps as detailed in the 
Adding a FLPA Covenant section. Once subrecords are added and the Apply button is clicked, the Covenant Acres 
under the new parcel will be added to those of the existing Covenant and displayed in the Total Cov Acres field. 
The Current Year COV, Exemption, and FL FMV are displayed for the Parcel as well, and these values now display in 
the Historical Data section of the FLPA Main Form. 
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The user can now click the OK Button and return to the Covenant Information Form, where the CU Value and 
Exemption amount are displayed. 

 

 

The OK key can be clicked to return to the Real Property General Information Form, where the FLPA YR, CU VAL, 
and Exemption amount will also display. The number beside the Covenant button indicates how many parcels are 
under this Covenant. 
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If the ownership for a parcel being added to an existing FLPA Covenant does not match the Covenant ownership, 
WinGAP will notify the user there’s a discrepancy. 

 

 

After clicking OK on the notification, a “Do not validate Owner Name” checkbox will appear. Checking this will 
allow the parcel to be added to the Covenant even if the ownership does not match in WinGAP.  
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REMOVING A FLPA COVENANT 

In WinGAP, the user will be informed of the expiration of the FLPA Covenant when opening a Parcel on which the 
Covenant has expired. FLPA Land subrecords and all other references to FLPA, such as FLPA Year and J digest class 
(changed to Ag), are removed by first clicking the Covenant Button on the Real Property General Information Form 
then clicking the Remove Button in the FLPA section of the Covenant Information Form. FLPA Land is removed 
when the covenant expires and is not renewed, or when a covenant is breached. 
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WinGAP will produce a covenant removal message. 

 

 

As the message indicates, the removal process performs the following: 

• Deletes the FLPA master record and all FLPA history for this parcel. 

• Deletes all FLPA land subrecords for this parcel. 

• The FLPA Covenant year is removed on the Real Property General Information Form. 

• The land digest class is changed from FLPA to Agricultural. 

 

Clicking the Yes button will perform the above processes and leave the user on the Real Property Covenant 
Information Form, and the FLPA Value will now be zero. A print preview of the FLPA History Information for this 
parcel will display. 

 

After printing this report, the user can click the OK Button on the Covenant Information Form to return to the Real 
Property General Information Form. There will no longer be any Covenant information displaying in the Exemption 
Information section of the form. 
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RESIDENTIAL IMPROVEMENTS FORM 

The Residential Improvements Form is used to add, edit, or delete any Residential Improvements on the Parcel. 
The Res Imp Button on the Real Property General Information Form is used to access this Form. 

 

 

If one or more Improvements exist on the Parcel, the Res Imp button on the Real Property General Information 
Form will have a number on it in parentheses, such as (1) in the example above, and clicking this button takes the 
user to the first Residential Improvement on the Parcel. There is no limit to the number of Residential 
Improvements that a Parcel can have. 
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If no Residential Improvements exist on the Parcel, no number will display in parentheses on the Res Imp button. 
Clicking on the Res Imp button takes the user to a "grayed out" Residential Improvements Form where the New 
button must be clicked to add the first Residential Improvement to the Parcel. 
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GENERAL RESIDENCE INFO 

 

Improvement: When no Improvements exist on the Parcel, this field is blank. When editing Residential 
Improvements, the field will display important identifying information about the first Improvement on the Parcel. 
From left to right, these are the WinGAP assigned Residential Improvement Key (called the Reprop Key), the 
Improvement Square Footage, the Exterior Wall type, and the Year Built of the property. 

 

If there is more than one Improvement on the Parcel, the user can click on the Improvement combo box to directly 
access any of the other Improvements without leaving this Form. This field cannot be directly edited by the user. 

 



 
751 

Parcel Number: The Parcel Number for the Parcel is displayed in this field. It cannot be edited by the user. 

Class: The Digest Class for the improvement, such as Residential. The Class field for a new Residential 
Improvement will default to "A" if the Land Digest Class is "A", "V", "P" or "W"; it will default to "R" if the Land 
Digest Class is "R"; it will default to "C" if the Land Digest Class is "C"; it will default to "I" if the Land Digest Class is 
"I"; and it will default to "E" if the Land Digest Class is "E". The user can change from the default Class, if necessary, 
and select from the possible Class choices by clicking on the combo box and selecting the Class. 

Strat: The Digest Stratification for the Improvement, such as Improvement. The Strat field for a new Residential 
Improvement will default to 1, unless the Land Digest Class is "E", in which case the Strat will default to the Land 
Digest Strat. As in Class, the user can change from the default Strat, if necessary, and select from the possible Strat 
choices by clicking on the combo box and selecting the Strat. 

Occupancy: Occupancy refers to the use of the Improvement structure or the type of structure as it relates to the 
tenants as set up in Tools > Schedules/Tables > Residential Improvements > Occupancy. NOTE: A special 
Occupancy of Mobile Homes is included to assist in identifying this type of structure. If Mobile Homes is selected as 
the Occupancy type, the user MUST click on the MH Info Button on the upper right of the Form and add Mfg 
Housing data to generate the value of the improvement. As much of the data on the Residential Improvement 
form as desired may be added but the MH Info button can be clicked immediately after defining the Occupancy as 
Mobile Home. The MH Info Button will not be enabled unless Mobile Homes is selected as the Occupancy type. 

Bedrooms: Data entry for Bedrooms is optional, but if used, the number of bedrooms in the structure is keyed 
here. 

Rooms: Data entry for Rooms is optional, but if used, the number of Rooms in the structure is keyed here. 

Foundation: The supporting Foundation of the structure, such as Masonry, as set up in Tools > Schedules/Tables > 
Residential Improvements > Foundation.  

Ext Walls: Ext Walls refers to the type of Exterior Wall of the structure, such as Vinyl Siding, as set up in Tools > 
Schedules/Tables > Residential Improvements > Exterior Walls. 

Roofing: The type of Roofing of the structure, such as Architectural Shingles, as set up in Tools > Schedules/Tables 
> Residential Improvements > Roofing. 

Roof Shape: The type of Roof Shape, such as Gable, as set up in Tools > Schedules/Tables > Residential 
Improvements > Roof Shape. 

Floor Cons: The type of Floor Construction, such as Wood Joist, as set up in Tools > Schedules/Tables > Residential 
Improvements > Floor Construction. 

Floor Fin: The type of Floor Finish, such as Carpet, as set up in Tools > Schedules/Tables > Residential 
Improvements > Floor Finish. If a structure has several combinations of Floor Finish, and the combinations are not 
listed, they should either be added to the Floor Finish schedule or the Item chosen should be based on the 
predominant type of Floor Finish. 

Interior Wall: The type of Interior Wall, such as Sheetrock, as set up in Tools > Schedules/Tables > Residential 
Improvements > Interior Walls. 

Interior Ceiling: The type of Interior Ceiling, such as Sheetrock, as set up in Tools > Schedules/Tables > Residential 
Improvements > Interior Ceiling. 

Heat: The type of Heat used in the Improvement, such as Heat Pump, as set up in Tools > Schedules/Tables > 
Residential Improvements > Heat. 

Story Height: Refers to the Story Height of the Improvement, as set up in Tools > Schedules/Tables > Residential 
Improvements > Story Height. The Story Height items found in this combo box are for descriptive purposes only 
and are not used in calculating the value of the Improvement. 
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GRADE/AGE INFO 

 

Grade: The Grade is a numerical assignment representing the quality of the Improvement. The appraiser is 
responsible for assigning the Grade, and the range can be from 1 to 999. No decimal is used in data entry. The 
Grade is used in calculating the Adjusted Points and Physical Depreciation Factor of the Improvement. 

Year Built: The Year Built represents the actual year the Improvement was constructed. The Year Built is used in 
calculating the Physical Depreciation Factor and determining the Fair Market Value for the Improvement. The field 
will default to the Digest Year (Appraisal Year) minus one when adding a new Improvement record. 

Eff Year Built: The Effective Year Built is used only when the condition of the Improvement reflects something 
different than should be present based on the original year of construction. The Eff Year Built field can be used to 
effectively increase or decrease the age of an Improvement. It is not the year the structure was remodeled. When 
present, the Effective Year Built is used in calculating the Physical Depreciation Factor and determining the Fair 
Market Value for the Improvement. 

Obsv Cond: The Observed Condition represents the appraiser's judgment call in determining the condition of the 
Improvement. The Observed Condition is used in calculating the Physical Depreciation Factor for the Improvement. 

Neighborhood: This is used in the calculation of the Fair Market Value of the Residential Improvement. The 
Neighborhood Factor that displays in this field is determined by two items: 1) the Neighborhood for the Parcel, as 
selected on the Real Property General Information Form; and 2) the Factor for the Residential Improvement for 
this Neighborhood as defined in the Neighborhood Schedule (Tools > Schedules/Tables > Neighborhoods). If no 
Neighborhood is defined, a 1.00 will display as the Factor. Factors can be applied against Residential 
Improvements, Urban Land, Rural Land, Commercial Improvements, and Accessory Buildings. The value represents 
percent good and is multiplicative. 

 

DEPR/FACTORS INFO 

 

Functional: The first of the fields in the Depr/Factors section of the Form is Functional Depreciation. Functional 
Depreciation is a numerical assignment representing the appraiser's judgment of the % good with regards to 
functional obsolescence. For example, an Improvement determined by the appraiser to have functionally 
depreciated by 20% would be 80% good, and .80 would be keyed in the Functional Depreciation field. The range 
can be from .01 to 9.99. The default is 1.00. There must be an entry in the Functional Depreciation field. An entry 
of 0.00 will result in an Improvement Value of zero. 

Economic: Economic Depreciation is a numerical assignment representing the appraiser's judgment of how the 
economic area that the Improvement is located in has affected the value of the Improvement. The range can be 
from .01 to 9.99. The default is 1.00. There must be an entry in the Economic Depreciation field. An entry of 0.00 
will result in an Improvement Value of zero. 

Physical Ovr: The Physical Ovr field is used to override the calculated Physical Depreciation performed by WinGAP. 
The field defaults to 0.00 (zero) and should remain at this value unless the appraiser wishes to apply a set Physical 
Depreciation for the Improvement. 

Complete: The Complete field represents the % completed status of the improvement. If construction on the 
Improvement is finished, it is 100% complete. If is not 100% completed, the value keyed in this field is the 
appraiser's determination of how complete the Improvement's structure is. An entry of 0.00 will result in an 
Improvement Value of zero, while an entry greater than 1.00 will be converted to 1.00. 

Physical: The WinGAP calculated Physical Depreciation displays in this field. It is based upon the Grade, the Year 
Built (or Effective Year Built), and the Observed Condition of the Improvement. The Physical depreciation will 
display even if there is an entry in the Physical Ovr field. This field is not accessible to the user. 
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CD: The CD, or Cost and Design factor, is an appraiser determined factor appropriate for the Cost and Design of the 
Residential Improvement. An entry of 0.00 will result in an Improvement Value of zero. 

 

PLUMBING INFO 

 

Full Baths: The number of Full Baths in the Improvement can either be keyed in this field, or WinGAP will calculate 
the value based upon data entry in the Standard Complement and Extra Fixtures fields. The user can override the 
WinGAP calculated values if desired. A Full Bath has a sink, toilet, and bathtub or shower. The value in this field is 
descriptive and is not used in calculating the value of the Improvement. 

Half Baths: The number of Half Baths in the Improvement can either be keyed in this field, or WinGAP will 
calculate the value based upon data entry in the Standard Complement and Extra Fixtures fields. The user can 
override the WinGAP calculated values if desired. A Half Bath has a sink and toilet. The value in this field is 
descriptive and is not used in calculating the value of the Improvement. 

Standard Complement: When plumbing is present in the Improvement, one or both of the Standard Complement 
and Extra Fixtures fields should have an entry. One Standard Complement consists of one 3-fixture bath and three 
kitchen fixtures (sink, hot water heater, and laundry hookup). Most Residential Improvements will have one 
Standard Complement. Duplexes may have two Standard Complements. Multi-family Residential Improvements 
may have several Standard Complements. The number of Standard Complements is used in calculating the Total 
Points for the Improvement. WinGAP will attempt to calculate the values of the Standard Complements and Extra 
Fixtures based on the entries in Full Baths and Half Baths. If the calculation produces errant results, the user can 
modify the numbers accordingly. 

Extra Fixtures: All plumbing fixtures above a Standard Complement are counted individually and keyed in the Extra 
Fixtures field. For example, an Improvement with a second Full Bath would have three Extra Fixtures along with 
the one Standard Complement. The number of Extra Fixtures is used in calculating the Total Points for the 
Improvement. 

 

NOTE: If the user changes the number of full or half baths but does not change the number of Standard 
Complements or Extra Features to match this change, and then clicks Apply or OK, WinGAP will produce a message 
informing the user of this: 

 

 

If the user responds with "Yes", WinGAP will update the number of Standard Complements or Extra Features, 
depending upon the change. If the updated numbers are not correct, the user may change them as needed. 
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FIREPLACE/MISC 

 

From the Extra Fixtures field the tab key will take the user to the Edit FP button. This button provides access to the 
Fireplace/Misc section of the Form. Fireplaces and any other Miscellaneous items, such as Hot Tubs, Spas, etc., 
that are calculated by the Lump Sum method are entered here. The process begins with the user clicking the Edit 
FP Button, and the Fireplaces Form will appear. The user should click the New Button to add a Fireplace/Misc Item. 

 

 

Desc: The Description of the Item to be added as set up in Tools > Schedules/Tables > Residential Improvements > 
Fireplaces. The user should click on the combo box field to select an item from the list. 

Number: The number of the selected Fireplace/Misc items. 

 

After keying an entry in the Number field, the user should click the Apply Button at the bottom of the Fireplaces 
Form, and the Fireplace/ Misc item will appear in the Form list box. 

 

 

More Fireplace/Misc items can be added, or the user can click the OK Button to exit this Form and return to the 
Residential Improvements Form. The Fireplace/Misc item(s) will now display in the Fireplace/Misc section of the 
Residential Improvements Form. 

 

 

 



 
755 

STRUCTURE AREAS 

 

If the structural areas of the Improvement are to be sketched, no entries are necessary in this part of the Form. 
However, if sketches are to be drawn at a later date or not at all, at least one structural area of the improvement 
that will produce heated square feet must be entered in this part of the form in order for WinGAP to perform the 
value calculations and save the data entered on the Residential Improvements Form. The manual process of 
adding Structure Areas begins with the user clicking the Edit Areas Button, and the Appendages Form will appear. 
The user should click the New Button to add an Area Item. 

 

 

Desc: The Description of the Item to be added, as set up in Tools > Schedules/Tables > Residential Improvements > 
Improvement Labels. 

Area: The square footage of the selected Structure Area item. 

 

After keying an entry in the Area field, the user should click the Apply Button at the bottom of the form and the 
Structure Area item will appear in the Form list box. More Structure Area items can be added, or the user can click 
the OK Button to exit this form and return to the Residential Improvements Form. The Structure Area item(s) will 
now display in the Structure Areas section of the Form, and any Heated Area will display in the field directly to the 
left of the Structure Areas list box. 

 

NOTE: The Edit Areas Button can also be used to change existing labels without entering the sketch. New Labels 
cannot be added if any portion of the improvement has been sketched, and areas of existing labels cannot be 
changed. Labels can be deleted, however. 

 

NOTE: Any improvement areas manually entered in the Structure Areas section, in lieu of sketching, will be deleted 
if the user later clicks the No Sketch Button and proceeds to draw sketches for the improvement areas. The user 
will receive a message immediately after clicking the No Sketch button. 
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A “Yes” reply will take the user into the Sketching Module where the sketches can be drawn; a “No” reply will keep 
the user on the Residential Improvement Form and the manually entered Improvement Areas will not be deleted. 

 

BASEMENT/ATTIC OPTION 

 

There are two options for entering Basement and Attic information. The Square Foot option is the default. If a 
Residential Improvement does not have a basement or attic, the Bsmt/Attic Area and % Fin fields should remain at 
zero. If the Residential Improvement has a Basement and Attic, the choice of which method to use, Descriptive or 
Square Foot, is up to the appraiser, although it is recommended that the Square Foot option be used. The Square 
Foot method provides for more detailed entry for Basement and Attic area, finish, and quality. The type of method 
can be changed by clicking the appropriate Radio Button for either type. The fields under the Descriptive method 
will be discussed first, followed by the Square Foot method. 

 

DESCRIPTIVE METHOD 

 

 

Bsmt Desc: The Description of the coverage of the Basement, such as None, Full, etc., is selected in this field, as set 
up in Tools > Schedules/Tables > Residential Improvements > Basement Coverage. 

Bsmt Finish: The amount of Finish for the Basement, such as None, Unfinished, etc., is selected in this field, as set 
up in Tools > Schedules/Tables >Residential Improvements > Basement Finish. 

Attic: The Description of the type of Attic, such as No Attic, Finished, etc., is selected in this field, as set up in Tools 
> Schedules/Tables > Residential Improvements > Attic Type. 
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SQUARE FOOT METHOD 

 

 

Bsmt Area: The first of the Square Foot method fields is where the Basement Area is keyed. The range is from 1 to 
99999 square feet, without decimals. If the “Sum Bmt to Screen” box is checked in the Other Options section of 
the Tools > Preferences screen, then this field will automatically populate with the square footage of any sketch 
polygons labeled as Basement, and this field will be inaccessible to the user. 

Bsmt % Fin: The amount of Finish for the Basement is keyed here. The range is from 0.00 to 9.99. A Basement that 
is fully finished should have a value of 1.00 entered. If there is no finish, the value should be zero. 

Bsmt Qual: The Quality or condition of the Basement, such as Poor, Average, etc., as set up in Tools > 
Schedules/Tables > Residential Improvements > Basement Quality, is selected in this field. 

Attic Area: The square footage of the Attic is keyed in this field. The range is from 1 to 99999 square feet, without 
decimals. 

Attic % Fin: The amount of Finish for the Attic is keyed here. The range is from 0.00 to 9.99. An Attic that is fully 
finished should have a value of 1.00 entered. If there is no finish, the value should be zero. 

Attic Qual: The Quality or condition of the Attic, such as Poor, Average, etc., as set up in Tools > Schedules/Tables 
> Residential Improvements > Attic Quality, is selected in this field.  

 

VALUES 

 

Override: The Override Value represents an assigned value for the Residential Improvement. An entry in this field 
overrides all Residential Improvement calculations. 

MAV: The MAV field holds the WinGAP generated Moratorium Appraised Value for the Residential Improvement. 
The MAV value will appear in the field after the Apply button is clicked. Should this value need to be changed by 
the user, the MAV Button should be clicked to manually edit this value. The following should be noted when 
entering a value in this field: values keyed via the MAV Buttons are not monitored, keyed MAV values are 
permanent only for that screen session, any future changes to the property could modify MAV. 

Ovr Checkbox: To the right of the MAV Button is the MAV Ovr Checkbox. When a check is placed in this box, the 
value in the MAV field will be treated as an override for the Residential Improvement Value. All calculations for this 
Improvement Value will be suspended until the check is removed.  

Override Date: If an Override Value is entered, the Date of the Override entry is keyed in this field. The calendar to 
the right of the field can also be used to insert the date or the user can right click in the field and select Today to 
insert the current date. 

Override Reason: If an Override Value is entered, a reason for the Override must also be selected from the reasons 
set up in Tools > Schedules/Tables > Override Reasons. 
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Improvement: The Improvement field in the Values section displays the calculated Fair Market Value of the 
improvement. This field is not accessible to the user. 

Last Calc: If a change is made to any of the Residential Improvement information that affects the Improvement 
Value, the Last Calc field will display the previous calculated Improvement Value, and the Improvement field will 
display the new calculated value. However, once the Apply Button is clicked and the user remains on the 
Residential Improvements Form, or clicks the OK Button and leaves the Form, the new Improvement value will 
display in both the Last Calc and Improvement fields on the Residential Improvements Form. 

 

HOMESTEAD 

 

State Homestead: If the Residential Improvement qualifies for the State Homestead Exemption, a checkmark 
should be placed in this checkbox. The checkbox will not be enabled unless the Homestead Code assigned to this 
parcel has been designated as a State Homestead. The value of all Residential Improvements on the parcel 
designated for the State Homestead will be summed and placed in the field in Realprop called statehsval. If the 
parcel is less than or equal to 10 acres, the value of the land will be added to the homestead improvement total 
and placed in the statehsval field. If the parcel is greater than 10 acres, a per acre value will be obtained (land 
value divided by total acres) and multiplied by 10 to obtain the land value eligible for the new State Homestead. 
The flags and values will be passed to the digest vendors for processing the exemption. Procedures are in place to 
remove flags and value when the homestead is changed to a code that is not designated as a 65 and Older State 
Homestead Code. 

Local Homestead: If the Residential Improvement qualifies for a Local Homestead Exemption, a checkmark should 
be placed in this checkbox. The checkbox will not be enabled unless the Homestead Code assigned to this parcel 
has been designated as a Local Homestead. 

 

COMMENTS/APPRAISER 

 

Comments: The Comments field can be used to enter any comments about the Residential Improvement. 

Appraiser: The Appraiser field is used to select the Residential Improvement field appraiser from the Appraiser 
combo box, or the Appraiser's name can be keyed into the combo box field. 

 

STREET INFO 

 

House No: The House No field is where the House Number of the Residential Improvement is keyed. 

Ext: If the street address contains an extension such as A, 1/2, etc., it should be keyed here. 

Dir: The direction (North, Southeast, etc.) of the street. 

Units: The Unit Number of the property, sometimes used by Apartments and Condominiums. Examples would be 
Unit 5, Apartment A, etc. 

Street Name: The name of the Street or Road where the Residential Improvement is located. 25 characters of 
information can be keyed into the field. 

Type: The Type of Street, such as Road, Drive, Hwy, Lane, etc., is keyed here. 

Quad: The post-direction used in addressing, such as 4888 Peachtree St. NW. The NW is the post-direction.  
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RESIDENTIAL IMPROVEMENTS FORM ACCESS BUTTONS 

 

No Sketch/Sketch Button: The No Sketch/Sketch Button takes the user to the WinGAP Sketching Module, where 
heated areas, appendages, and site improvements can be sketched and labeled. Sketching and labeling procedures 
are covered in the Sketching Module section. If structure areas are keyed by using the Structure Areas button, the 
Sketch/No Sketch button will read No Sketch. Once the Sketching Module has been used to draw sketches, and 
sketch data exists for the Residential Improvement, the No Sketch/Sketch button will read Sketch.  

 

NOTE: If structure areas are keyed by using the Structure Areas button, and the user clicks the No Sketch button to 
draw sketches, the user will be informed that the manually entered Structure Areas will be deleted. 

 

 

If the user clicks “Yes” the manually entered areas will be deleted and the user will proceed to the Sketching 
Module. A “No” response will preserve the manually entered areas and keep the user on the Residential 
Improvements Form. 

 

Photo Button: Right clicking this button opens a contextual menu that allows you to select from several options. 

 

Clicking the “Load Digital Photo” option will open a window where the user can navigate to a picture and load it to 
the WinGAPSQL folder on the server. A new folder will be created in the WinGAP photo folder on the server with 
the prefix “r” for residence followed by the repropkey assigned by Wingap, and the photo will be named the same. 
This is the primary photo for the property. 
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Selecting the Load Additional Photos option will open a new form that will append more information to the photo. 
Typing in the field to the right of the Photo Name will add that information to the picture name, for instance 
“basement” would name the photo for a property with the repropkey 11885 “r11885_basement”. Selecting one of 
the checkboxes will quickly append that information to the photo so the user does not have to type it themselves. 
The user will then navigate to where the picture is on their computer and WinGAP will copy it to the server and 
name it according to the above naming convention. 

 

Selecting “Delete Current Photo” will delete the primary digital photo, while selecting “Delete Additional Photos” 
will open the pictures folder for this record where the user can manually select which photos to delete.  

 

MH Info Button: The MH Info Button takes the user to the Non-Prebilled Mobile Home Form, where detailed 
information about the Mobile Home, such as year built, manufacturer, model, size, etc. can be entered. The MH 
Info Button will be accessible only if Mobile Home is selected as the Occupancy of the Residential Improvement. 
The procedures for entering Non-Prebilled Mobile Home information are covered in the Non-Prebilled Mobile 
Homes section. 

Pricing Button: Detailed information about points and value calculations for the Residential Improvement can be 
accessed by clicking on the Pricing Button. A detailed explanation of how these points and values were calculated 
is covered in the Residential Improvements Calculation Summary section. 

Schedules Button: This opens the Residential Improvements schedule form. More information on these schedules 
is covered in the Tools > Schedules/Tables > Residential Improvements section. 

 

If entering a new Residential Improvement, after the Apply Button is clicked WinGAP assigns a Residential 
Improvement Number to this record and displays the Square Footage, the type of Exterior Wall, and the Year Built 
of the improvement in the improvement drop down box. 

 

RESIDENTIAL IMPROVEMENTS CALCULATION SUMMARY FORM  

The Residential Improvements Calculation Summary Form (hereafter called the Points Form) is reached by clicking 
on the Points Button on the upper right of the Residential Improvements Form. The Points Form displays 
important summary Points and Value information for each Improvement on the Parcel. The Form is divided into 
two sections: 

• Points/Values, the top half of the Form, where the Points and Values for each of the basic structural 
components of the Improvement are listed, producing the RCN (Replacement Cost New) for the 
Improvement. 

• Depreciation/Factors, the bottom half of the Form, where the various Depreciation Factors that 
determine the FMV (Fair Market Value) of the Improvement are listed. 
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NOTE: If a Parcel has multiple Improvements, you must click the Apply Button after selecting each Improvement 
before you click the Points Button for the Points and Values information for that Improvement to display. 

 

 

WinGAP uses a variety of calculation formulas to arrive at the Points, Values, Replacement Cost New, and Fair 
Market Value of the Improvement. These formulas will be explained below. As an example, the following type of 
Residential Improvement will be used: 

• 1 Story, 2056 Square Feet 

• Hardboard Siding 

• Poured Concrete Foundation 

• Heat Pump 

• 2 Full Baths, 1 Half Bath 

• 1 One Story Prefabricated Fireplace 

• 110 Grade 
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• 2002 Year Built 

• Average Condition 

• Carpet/Hardwood Flooring 

• Basement, Full, Part Finished (Descriptive Method) 

• Basement, 2030 Square Feet, .50 Finished, Average Quality (Square Foot Method) 

• Garage, 396 Square Feet 

• Wood Deck, 491 Square Feet 

• Porch, 168 Square Feet 

 

The example property will use the following WinGAP factors: 

• Base Area of 1800 

• Increment Base of 10 

• Increment Factor over 1800 sqft of 0.0013 

• Base Dollars/Square Feet at $95 

• Hardboard Siding at 1.05 

• Flooring at $1.06 

• Heat Dollars/Square Feet at $1.00 

• Heat Multiplier at 3.50 

• Basement Coverage Full at $4.00 

• Basement Finish Part Finished multiplier at 2.00 

• Basement Quality multiplier of Average at 1.00 

• Basement Finish Adjustment of $16.00 

• the Residential Point Cost is 100 

• the Residential Depreciation Year is 2021 

• the Appraisal Year is 2021 

 

Certain other WinGAP factors from their respective schedules are also used and are mentioned during the 
discussion for that calculation. For an explanation of all of these factors, see their respective Help Forms located in 
Tools > Schedules/Tables and Tools > Preferences. 

 

BASE AREA 

 

Total Base Area: At the top of the Points Form the Total Base Area of the Improvement is listed. The Total Base 
Area is the ground floor area of the house. For this example, the Total Base Area is 2056 Square Feet. If a house 
has two stories, only the first story heated area is used. If a house is part one story and part two story, the sum of 
the ground floor heated areas from each part is used as the Total Base Area. Determining the Total Base Area, 
which WinGAP will calculate and place in the Total Base Area field if the house is either Sketched or the ground 
floor areas entered in the Edit Areas section of the Residential Improvement Form, is the first step in the process of 
calculating the value of a Residential Improvement. 
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AM: To the right of the Base Area is the Area Multiplier (AM) factor. The AM adjusts the base area according to the 
following formula: 

 

Area Multiplier 

((([Base Area] – [Total Base Area]) / [Increment Base]) x [Increment Factor]) + 1.00 

*Round to 3 decimals* 

 

Example: ((( 1800 - 2056 ) / 10 ) x 0.0013 ) + 1.00 = 0.966720 

 

Rounded to two decimal places yields an Area Multiplier of 0.967. If the county desires, in Tools > Preferences, 
there is an option to leave the Area Multiplier rounded to the full 6 decimal places. 

 

POINTS/VALUES SECTION 

 

Total Base: The Total Base Points are the first item in the Points/Values Section that is displayed. The process of 
calculating Total Base Points contains several steps within itself.  

 

The first step to calculate the Total Base Points is to calculate the Adjusted Points/Square Foot. The Area Multiplier 
is used to determine the Adjusted Points/Square Foot: 

 

Adjusted Points/Square Foot1 

([Area Multiplier] x [Base Dollars/Square Foot]) / 100 

*Round to 6 decimals* 

 

Example: ( 0.967 x 95 ) / 100 = 0.918650 

 

This yields an Adjusted Points/Square Foot1 of 0.918650.  

 

The Adjusted Points/Square Foot are then used to calculate the Adjusted Points/Square Foot2: 

 

Adjusted Points/Square Foot2 

[Adjusted Points/Square Foot1] x [Exterior Walls Factor] x [Occupancy Factor] 

*Round to 6 decimals* 

 

Example: 0.918650 x 1.05 x 1.00 = 0.964583 

 

The next step is to calculate the sum of the Additions. In the schedules, these are all priced with a $/SF value. 
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Sum of Additions 

( [Foundation] + [Roof] + [Roof Shape] + [Floor Construction] + [Floor Finish] + [Interior Wall] + [Ceiling] ) / 100 

*Round to 6 decimals* 

 

Example: ( 0 + 0 + 0 + 0 + 1.06 + 0 + 0 ) / 100 = 0.010600 

 

Now, add the Adjusted Points/Square Foot2 to the Sum of Additions to get the Total Points. 

 

Total Adjusted Points 

[Adjusted Points/Square Foot2] + [Sum of Additions] 

*Round to 6 decimals* 

 

Example: 0.964583 + 0.010600 = 0.975183 

 

Finally, the Total Base Points are found by multiplying the Total Adjusted Points by the Base Area. 

 

Total Base Points 

[Total Adjusted Points] x [Base Area] x [Story Adjustment] 

*Truncate to the whole number* 

 

Example: 0.975183 x 2056 x 1.00 = 2004.976248 

 

If the Improvement has more than one story, the Base Points for each story are calculated using the above 
formula, then the Base Points for each story are added together to determine the Total Base Points. For our 
example, truncating the calculated number leaves us with 2004 Total Base Points. Once the Total Base Points are 
calculated, multiplying that by the Point Cost as set up in Tools > Preferences will yield the Base Value. Using the 
standard 100.00 points, our example property’s Base Value is $200,400. 

 

Heat: The calculation of Heat Points is a two-step process. The initial step in this process is to determine the Heat 
Points/Square Foot. The Area Multiplier calculated above is also used to determine Heat Points using the following 
calculation: 

 

Heat Points 

([Heat Dollars/Square Foot] x [Area Multiplier] x [Heating Adjustment] x [Story Adjustment] x [Base Area]) / 100 

*Round to the nearest whole number* 

 

Example: (1.00 x 0.967 x 3.50 x 1.00 x 2056 ) / 100= 69.58532 

 



 
765 

If the Improvement has more than one story, the Heat Points for each story are calculated using the above 
formula, then the Base Points for each story are added together to determine the Total Base Points. For our 
example, rounding the calculated number leaves us with 70 Total Heat Points. Once the Total Heat Points are 
calculated, multiplying that by the Point Cost as set up in Tools > Preferences will yield the Base Value. Using the 
standard 100.00 points, our example property’s Base Value is $200,400. 

 

Basement: The Basement points, if utilized, show what a finished basement is worth. It is possible to value finished 
basement on the sketch itself with appropriate Sketch Labels, but utilizing the Basement Options portion of the 
Residential Improvement form is more flexible, easier to manage, and allows for simpler auditing and valuation.  

 

Basement Points are calculated by two different methods. One is by Descriptive terms, the other is by using Square 
Feet and Percent Finish information. The Descriptive method is less precise yet also simpler for the field appraiser 
to use when they are unable to acquire detailed information about a finished basement while the Square Foot 
method is more precise but requires the appraiser to have very accurate information about the basement and its 
finished area. The Descriptive method can be used to completely value basements without assigning any value to 
sketched basement polygons while the Square Foot method does still require any unfinished basement to be 
sketched and valued based on the polygon area. 

 

Descriptive Method 

The initial step in the Descriptive method is to select the Basement Description and Finish on the Descriptive 
section of the Basement Options on the Residential Improvements form. The options available for the user are 
established in the Tools > Schedules/Tables > Residential Improvements > Basement Coverage and Basement 
Finish menus. Typical options might include None, Part, Half, and Full for coverage (Bsmt Desc) and None, 
Unfinished, Part Finished, and Full Finished for Basement Finish (Bsmt Finish). 

 

Once that data is filled in, the first calculation is to determine the Basement Points/Square Foot by multiplying the 
Area Multiplier by the Basement Dollars per Square Foot, then dividing that by the Residential Points. That figure is 
then multiplied by the Total Base Area and then the Basement Finish Adjustment to yield the Total Adjusted 
Basement Points. 

 

Total Adjusted Basement Points 

(([Area Multiplier] x [Basement Dollars/Square Foot]) / 100 ) x [Total Base Area] x [Basement Finish Adjustment] 

*Round to whole number* 

 

Example: (( 0.967 x 8.0 ) / 100 ) x 2056 x 2.00 = 318.10432 

 

The Basement Dollars/Square Foot adjustment for Full Basement Coverage (in this example it is $8.00/Square 
Foot) is found in Tools > Schedules/Tables > Residential Improvements > Basement Coverage, and the Basement 
Finish Adjustment (in this example it is 2.00) is found in Tools > Schedules/Tables > Residential Improvements > 
Basement Finish Adjustment. 

 

In this example, using the Descriptive method, the Total Adjusted Basement Points are 318, which are then 
multiplied by the Point Cost, which is 100, to give a Total Basement Value of $31,800. 

 



 
766 

Square Foot Method 

The Square Foot method only values the finished basement on the Basement section of the Points form. The 
unfinished basement is valued as a Structure Area with the value being derived from the sketch. If a house has a 
basement with no finished area, the Basement section of the Points form will show $0 despite the basement 
contributing value to the property under a different portion of the Points form. 

 

The initial step in the Square Foot method is to fill in the total basement square footage in the Bsmt Area portion 
of the Square Foot options on the Residential Improvement form. There is an option in Tools > Preferences to 
“Sum Bsmt to Screen”, which will automatically fill this box in from the sketch based on any Improvement Labels 
that have the “Basement Area” box checked. Once this is done, the next step is to fill in the Basement % Finish and 
Quality fields. 

 

Once that data is filled in, the first calculation is to determine the Adjusted Basement Finish Points by multiplying 
the Basement Percent Finish by the Basement Finish Adjustment, then dividing that by the Residential Points.  

 

Adjusted Basement Finish Points 

([Basement Percent Finish] x [Basement Finish Adjustment]) / 100 

*Round to 6 decimals* 

 

Example: ( 0.50 x 16.00 ) / 100 = 0.080000 

 

That figure is then multiplied by the Total Base Area and then the Basement Finish Adjustment to yield the Total 
Adjusted Basement Points. 

 

Total Adjusted Basement Points 

[Adjusted Basement Finish Points] x [Total Basement Area] x [Basement Quality Factor] 

*Round to whole number* 

 

Example: 0.080000 x 2030 x 1.00 = 162.400000 

 

In this example using the Square Foot method, the Total Adjusted Basement Points are 162, which are then 
multiplied by the Point Cost of 100 to give a Total Basement Value of $16,200. With this method, this is just the 
value of the finish in the basement; the basement value for the entire square footage without a finish is calculated 
from the sketch as an appendage and shows in the Structure Areas of the Points form. 

 

Attic: The attic calculations are identical to the Basement calculations. See that section for more information on 
how to calculate Attic Points and Values. 

 

Structure Areas: The Points and Values for the Structure Areas of any Appendages to the Improvement, such as 
Garages, Decks, and Porches, display in these fields. The Improvement in this example has a 491 ft2 Wood Deck, a 
168 ft2 Porch, and a 396 ft2 Garage. Appendage Points are calculated with the following formula: 
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Total Appendage Points 

([Appendage Dollars/Square Foot] x [Appendage Area]) / 100 

*Round to whole number* 

 

Once the Points are calculated, multiplying that by the Point Cost will yield the Structure Area Value. The Wood 
Deck is valued at $4.00 a Square Foot (see Tools > Schedules/Tables > Improvement Labels), which with a Point 
Cost of 100 gives it a Point total of 20 and a Value of $2,000. The Open Porch is valued at $8.00 a Square Foot, 
yielding a Point total of 13 and a Value of $1,300. The Garage is valued at $14.00 a Square Foot, yielding a Point 
total of 55 and a Value of $5,500. Finally, if using the Square Foot method to value the finished basement and the 
unfinished basement carrying a value of $8.00 a Square Foot, the Basement comes in at 162 Points and a value of 
$16,200. Adding these items together produces Total Structure Area Points of 250 and a Total Structure Area Value 
of $25,000. 

 

The user can click the right-pointing Arrow to the right of the Structure Values field to see a list of all Areas and 
Values for all parts of the Improvement. No value is listed for the Heated Area (Primary Label Types) because that 
value is listed under the Total Base Value for the Improvement. 

 

Using the finished basement examples from before, that would yield a total basement value of $16,200 + $16,200 
= $32,400 with the Square Foot method, which is extremely close to the $31,800 from the Descriptive method. 
Since the option for the Descriptive method of Partial was developed with the same schedule as a 50% finish, that 
is the expected result. As the appraiser uses percentages for finished basement that are more granular than the 
Descriptive method allows for, there could be a several thousand-dollar difference in the two methods as the % 
finished gets further away from the ranges covered by the Descriptive method. For example, with Unfished, 
Partial, and Full representing 0%, 50%, and 100% respectively, the Square Foot method using 25% and 75% 
finished would be between the respective options. Depending on the County needs, it could be prudent to add 
more Descriptive finishes than the stock options if there are many finished basements that are carrying substantial 
value and the county is using this method to value finished basements. 

 

Fireplace/Misc: Fireplaces and other Miscellaneous Items, such as Spas, Hot Tubs, etc., are typically calculated by 
the Lump Sum Method. A One Story, One Box Constructed Fireplace is valued in this example at $1000 and would 
have 10 points ($1000 divided by the Point Cost of 100) entered in the schedule located in Tools > 
Schedules/Tables > Residential Improvements > Fireplace. The example has 1 One Story Prefabricated Fireplace, so 
that means the Total Fireplace/Misc Points is 10. 10 Points multiplied by the Point Cost, which is 100, gives a Total 
Fireplace Value of $1,000. 

 

The user can click the right-pointing Arrow to the right of the Fireplace/Misc Value field to see a list of all 
Fireplaces and Fireplace Values for the Improvement. 

 

Plumbing: The calculation of Points for Plumbing is based upon two items: 1) the Number of Standard 
Complements; and 2) the number of Extra Fixtures beyond the Standard Complement. One Standard Complement 
consists of one three fixture bath and three kitchen fixtures (sink, hot water heater, and laundry hookup). The 
Improvement in the example has two full baths and one half bath, which means that it has one Standard 
Complement and five Extra Fixtures. A Standard Complement is valued in this example at 40 points and each extra 
fixture worth 8 points for a total of 80 Plumbing Points, multiplied by the Point Cost of 100 gives a Total Plumbing 
Value of $8,000. 
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Total: All the Points under Total Base, Heat, Basement, Attic, Fireplace/Misc, and Plumbing are added together to 
give the Total Points. If the Descriptive method for calculating the Basement and Attic is used, the Total Points in 
this example are 2576. The Total Points multiplied by the Point Cost of 100 gives a Total Value of $257,600. If the 
Square Foot Method for calculating the Basement and Attic is used, the Total Points in this example are 2582. The 
Total Points multiplied by the Point Cost of 100 gives a Total Value of $258,200. 

 

Adjusted: The Total Points are multiplied by the Grade of the Improvement to give the Adjusted Points. In this 
example the Grade is 110 (or 1.10). Using the Square Foot method for the rest of the example, the Total Points of 
2582 are multiplied by the Grade to produce an Adjusted Points total of 2840. The Adjusted Points multiplied by 
the Point Cost of 100 gives a Total Value of $284,000. 

 

RCN: The Adjusted Value is also called the RCN, or Replacement Cost New. 

 

DEPRECIATION/FACTORS SECTION 

 

Functional: Functional Depreciation is a numerical assignment representing the appraiser's judgment of the % 
good with regards to functional obsolescence. For example, an Improvement determined by the appraiser to have 
functionally depreciated by 20% would be 80% good, and .80 would display in the Functional Depreciation field. 
The range can be from .01 to 9.99.  

 

Economic: Economic Depreciation is a numerical assignment representing the appraiser's judgment of how the 
economic area that the Improvement is located in has affected the value of the Improvement. The range can be 
from .01 to 9.99.  

 

Override: The Override field displays an appraiser determined Physical Depreciation Override factor that is used to 
override the calculated Physical Depreciation performed by WinGAP.  

 

% Complete: The % Complete field displays the percent completed status of the improvement. If construction on 
the Improvement is finished, it is 100% complete. If is not 100% completed, the factor that displays in this field is 
the appraiser's determination of how complete the Improvement's structure is.  

 

Calculated: The WinGAP Calculated Physical Depreciation factor displays in this field. It is based upon the Grade, 
the Frame, the Age, and the Observed Condition of the Improvement. The user can look up this factor in Tools > 
Depreciation > Residential Tables. See that section for more information on how depreciation tables are set up and 
how they function. For this example, the calculated Physical Depreciation is 0.81. 

 

CD: CD is the Cost and Design factor, an appraiser determined numerical adjustment for the Improvement based 
upon its Cost and Design. The range can be from .01 to 9.99.  

 

Neighborhood: The Neighborhood factor is a numerical assignment used to adjust the value of the Residential 
Improvement due to location in a County. In this example, the Neighborhood factor is 1.05. 
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FMV: The FMV, or Fair Market Value, field displays the RCN Value multiplied times the Functional, Economic, % 
Complete, Calculated Physical Depreciation, Cost Design, and Neighborhood Factors. These factors are 
multiplicative, and the formula looks like this: 

 

Fair Market Value 

[RCN] x [Economic] x [Functional] x [% Complete] x [Calculated or Override Depreciation] x [CD] x [Neighborhood] 

*Truncate to the nearest 100* 

 

Example: 284,000 x 1.00 x 1.00 x 1.00 x 0.81 x 1.00 x 1.05 = 241,542 

 

NOTE: In Tools > Preferences, there is an option to Truncate Values. If a checkmark is placed in the Truncate Values 
checkbox and the Replacement Cost New – (minus) Depreciation (or RCN – Dep) is greater than 1000, all values will 
be truncated to the nearest $100. In this example, the value of $241,542 will be truncated to $241,500. If the 
Replacement Cost New – Depreciation is less than 1000, all values will be truncated to the nearest $10, meaning 
$98 truncates to $90. Truncation is accomplished by dividing the RCN-Dep value by 100 and not rounding the 
result. The resulting quotient is then multiplied by 100. 

 

Override: The Override Value represents an appraiser assigned value for the Residential Improvement, which 
overrides all Residential Improvement calculations. 

 

 

 

NON-PREBILLED MOBILE HOMES FORM  

The Non-Prebilled Mobile Homes Form is used to add, edit, or delete any Mobile Homes that are considered to be 
Residential Improvements on the Parcel. The Mobile Home must first be added as a Residential Improvement by 
clicking the New Button on the Residential Improvements Form. If the Mobile Home is to be priced using the 
information on the Mobile Homes Form, only the Class, Strat, and Occupancy fields on the Residential 
Improvement Form need to be selected. Mobile Home must be selected as the Occupancy type. 
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Once Mobile Homes has been selected as the Occupancy for the Residential Improvement, it is not necessary to 
enter the rest of the Residential Improvement information. Also, do not click the Apply Button at this point. 
Instead, the user should click the MH Info Button on the upper right of the Residential Improvements Form to 
access the Mobile Homes Form. The MH Info Button will be "grayed out" and not accessible to the user until 
Mobile Home is selected in the Occupancy field on the Residential Improvement Form. 

Clicking the MH Info button produces the Manufactured Housing form. The New button must be clicked at the 
bottom of the form to open up the fields for data entry. 
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GENERAL MH INFO 

 

MH: When no Mobile Homes exist on the Improvement, this field is blank. When editing Mobile Homes, the field 
will display important identifying information about the first Mobile Home on the Improvement, including the Year 
Built, Size, Manufacturer, and Model. If there is more than one Mobile Home on the Improvement, the user can 
click on the field combo box to directly access any of the other Mobile Homes on the Improvement without leaving 
this Form. This field cannot be directly edited by the user. 

PIN: The Parcel Number where the Non-Prebilled Mobile Home is located is displayed in this field. The Parcel 
Number can be changed by the user if necessary. 

Location: The location of the Mobile Home. 

Key: The Key field contains the WinGAP Account Number, called Mobilekey, for this Mobile Home. It cannot be 
changed by the user. 

Review Date: The last date that this Mobile Home was reviewed or the date the Mobile Home is scheduled to be 
reviewed is keyed in the Review Date field. The date can either be keyed or the Calendar Button to the right of the 
field can be clicked to select and insert the date.  

Returned Mail: The Returned Mail checkbox is used to note when the USPS has returned correspondence as 
undeliverable for the Mobile Home. 

Future Field Check: This checkbox flags the Mobile Home for a field check sometime in the future and is useful in 
reporting or locating Mobile Homes that someone flagged as needing a field review. 
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House Pricing: A checkmark placed in this checkbox will instruct WinGAP to price the Mobile Home using the 
information on the Residential Improvement Form instead of using the information on the Mobile Home Form. If 
this is done, all the Residential Improvement information must be entered on the Residential Improvement form. 
The user must also either sketch the Mobile Home or enter the square footage using the Edit Areas button to 
attain a value for the Non-Prebilled Mobile Home. The House Pricing field is "grayed out" and not available to the 
user until the Mobile Home record is saved. 

Exempt: This checkbox, if checked, will flag the Mobile Home as exempt from taxation. 

COPL: A checkmark in this box will flag the Mobile Home as having a Certificate of Permanent Location (de-titled). 

 

IMPROVEMENT INFORMATION 

 

Mfg: The Manufacturer of the Mobile Home, such as Fleetwood or Redman. The user can produce a listing of all 
Mobile Home Manufacturers by clicking on the combo box, and quickly move through the list by keying the first 
letter of the name of the Manufacturer. WinGAP has a pre-built schedule of all Mobile Home manufacturers and 
the Mobile Home models associated with these Manufacturers located in Tools > Schedules/Tables > 
Manufactured Housing > Mfg/Model Listing. Items in this schedule can be added, edited, or deleted to suit the 
local County situation. 

Model: The Model of the Mobile Home, based upon the Manufacturer that was selected. The user can produce a 
listing of all Mobile Home Manufacturers by clicking on the combo box, and quickly move through the list by keying 
the first letter of the name of the Model. As with the Manufacturer, Mobile Home models can be added, edited, or 
deleted to suit the local County situation by going to Tools > Schedules/Tables > Manufactured Housing > 
Mfg/Model Listing. 

Class: The Class for the Mobile Home is assigned by WinGAP based upon how it is set up for that Manufacturer and 
Model in the schedule located in Tools > Schedules/Tables > Manufactured Housing > Mfg/Model Listing. The Class 
is used in calculating the Replacement Cost New for the Mobile Home. If needed, the user can select from other 
available Class choices from this combo box. NOTE: Changing the Class is not advised. The Class has been set in the 
schedules and should not be modified for an individual home. The Class is open to change so the appraiser may 
observe the effect of the varying classes on value to determine what Class is appropriate for the schedule entry. 
The Class should always be changed back to the Class that was brought forward from the schedule. 

Year Model: The Year Model represents the actual year the Mobile Home was constructed. The Year Model is used 
in calculating the Physical Depreciation Factor and determining both the Mobile Home Calculated Value and the 
Total Value of the Mobile Home. 

Eff Year Built: The Effective Year Built is used only when the condition of the Mobile Home reflects something 
different than should be present based on the original year of construction. The Eff Year Built field can be used to 
effectively increase or decrease the age of a Mobile Home. It is not the year the Mobile Home was remodeled. 
When present, the Effective Year Built is used in calculating the Physical Depreciation Factor and determining the 
Mobile Home Calculated Value and the Total Value of the Mobile Home. 

Size: Size refers to the Width and Length of the Mobile Home, in feet. The Width of the home must be keyed in the 
first Size box. 

Tip Out: Tip outs are room extension built at factory, shipped inside the home, and tipped or slid into place once 
the home was sited. If the Mobile Home has heated area that projects out from the basic rectangle of the Mobile 
Home, the user should click in the Tip Out checkbox to produce the Size and Adjustment fields where this 
additional area can be entered. WinGAP will calculate the additional "Tip Out" area. The Adj field is used to enter 
an adjusting factor for the Tip Out area. The default Adjustment value is 0.83 and can be changed by the user. 

Tag-a-long: A checkmark in this box will allow the valuation of the tag section of the Mobile Home. 

 



 
773 

Story Height: The story height of the Mobile Home is selected in this field. 

Decal Yr: The issue year, if known, of the Decal for the Mobile Home is keyed in this field. 

Decal No: The Decal Number, if known, of the Mobile Home is keyed in this field. The letters DMVS can be entered 
in the Decal Number field to identify the Non-Prebilled Mobile Home as having a Certificate of Permanency as 
determined by the Georgia Department of Motor Vehicle Services. 

Serial No: The Serial Number, if known, of the Mobile Home is keyed in this field. 

Title: The Title Number of the Mobile Home. 

Title Name: The Name listed on the Title for the Mobile Home. 

Purch Price: The Purchase Price of the Mobile Home, if known, is keyed in this field. 

Yr Purchased: The Year the Mobile Home was purchased, if known, is keyed in this field. 

 

CHARACTERISTICS 

 

Ext Wall: Ext Wall refers to the type of Exterior Wall of the Mobile Home, such as Vinyl, as set up in Tools > 
Schedules/Tables > Manufactured Housing > Exterior Walls. 

Roofing: The type of Roofing on the Mobile Home, such as Asphalt Shingles, as set up in Tools > Schedules/Tables > 
Manufactured Housing > Roofing. 

Foundation: Foundation refers to the supporting Foundation of the Mobile Home, such as Masonry, as set up in 
Tools > Schedules/Tables > Manufactured Housing >Foundation. 

Heat/Air: Heat/Air refers to the type of Heating and/or Air Conditioning used in the Mobile Home, as set up in 
Tools > Schedules/Tables >Manufactured Housing > Heating/Air. 

Fireplace: The type of Fireplace(s) in the Mobile Home, if any, as set up in Tools > Schedules/Tables > 
Manufactured Housing > Fireplace. 

Bedrooms: Data entry for Bedrooms is optional, but if used, the number of Bedrooms in the Mobile Home is keyed 
here. 

Full Baths: The number of Full Baths in the Mobile Home is keyed in this field. A Full Bath has a sink, toilet, and 
bathtub or shower. Lump Sum values can be applied to the value of Plumbing in the Mobile Home if desired by the 
appraiser. 

Half Baths: The number of Half Baths in the Mobile Home is keyed in this field. A Half Bath has a sink and toilet. 
Lump Sum values can be applied to the value of Plumbing in the Mobile Home if desired by the appraiser. 

Single Fixt: The number of Bathrooms with only one Fixture is keyed in this field. Lump Sum values can be applied 
to the value of Plumbing in the Mobile Home if desired by the appraiser. 

 

PREVIOUS VALUES 

 

When adding a new Mobile Home, the values in the Previous Values section will be zero. After the MH Yearend 
Cleanup process has been run, Previous Values will display in these fields and represent the respective values of 
the manufactured home on the last submitted digest. These fields are not accessible to the user. 
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LOCATION INFO 

 

House No: The House Number that has been assigned to the Mobile Home for location and address purposes. 

Ext: If the street address contains an extension such as A, 1/2, etc., it should be keyed here. 

Direction: The direction (North, Southeast, etc.) of the street. 

Street: The name of the Street or Road where the Mobile Home is located. 25 characters of street information can 
be keyed into this field. 

St Type: The Type of Street, such as Road, Drive, Hwy, Lane, etc., is keyed here. 

Post: The post-direction used in the Street Address, such as 123 Smith St NW. The NW is the Post. 

Unit: The Unit Number of the property. Examples would be Unit 5, Apartment A, etc. 

Park: If the Mobile Home is in a Mobile Home Park, the name of the Park is keyed into this field. 

Lot: If the Mobile Home is in a Mobile Home Park, the Lot Number in the Park is keyed into this field. 

Tax District: This field is not available for a Non-Prebilled Mobile Home. 

 

DEPRECIATION 

 

Condition: The Condition represents the appraiser's judgment call in determining the physical condition of the 
Mobile Home. The Condition is used in calculating the Physical Depreciation Factor for the Improvement. 
Condition types are set up in Tools > Schedules/Tables > Manufactured Housing > Condition. 

Calc Dep: The WinGAP Calculated Depreciation displays in this field. It is based upon the Life Expectancy of the 
Mobile Home (as set up in the Manufacturer/Model Table), the Year Built (or Effective Year Built), and the 
Condition of the Mobile Home. The Calculated Depreciation will display even if there is an entry in the Override 
Depreciation field. 

Ovr Dep: The Override Depreciation field is used to override the Calculated Depreciation performed by WinGAP. 
The field defaults to 0.00 (zero) and should remain at this value unless the appraiser wishes to apply a set Override 
Depreciation for the Mobile Home. 

Func Obs: Functional Obsolescence is a numerical assignment representing the appraiser's judgment of the % good 
with regards to functional obsolescence. For example, a Mobile Home determined by the appraiser to have 
functionally depreciated by 20% would be 80% good, and .80 would be keyed in the Functional Obsolescence field. 
The range can be from .01 to 9.99. The default is 1.00. There must be an entry in the Functional Obsolescence 
field. A value of 0.00 will result in a zero value for the structure. 

Econ Obs: Economic Obsolescence is a numerical assignment representing the appraiser's judgment of how the 
economic area that the Mobile Home is located in has affected the value of the Mobile Home. For example, a 
Mobile Home located near a trash dump or chicken rendering plant and determined by the appraiser to have 
economically depreciated by 30% would be 70% good, and .70 would be keyed in the Economic Obsolescence 
field. The range can be from .01 to 9.99. The default is 1.00. There must be an entry in the Economic Obsolescence 
field. A value of 0.00 will result in a zero value for the structure. 

 

VALUES 

 

RCN: The RCN, or Replacement Cost New, field in the Values section displays the calculated Mobile Home Value 
before Depreciation is applied. This field is not accessible to the user. 
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NADA: The NADA button allows the user to set and use a NADA (market) value for the Mobile Home instead of the 
WinGAP calculated replacement cost value. Procedures for using the NADA Button are discussed in the NADA 
section. 

MH Calc: The Calculated Mobile Home Value field displays the calculated Mobile Home Value after Depreciation is 
applied. This field is not accessible to the user. A checkmark will appear in the checkbox to the right of the MH Calc 
field, the default value, signifying that the MH Calc value will be used as the digest value for the Mobile Home 
unless the NADA value is selected instead. 

MH Ovr: The Mobile Home Override Value represents a manually assigned value for the Mobile Home. This value 
does not include additions. Any value assigned to additions will be added to the MH Ovr value. An entry in this field 
overrides all Mobile Home calculations. 

Add-Ons: The total value of any Add-Ons, or appendages, to the Mobile Home will display in this field. Add-Ons are 
added, edited, and deleted by clicking on the Add-Ons Button to the left of the Add-Ons value field. 

Total: The Total value of the Mobile Home is the sum of the Mobile Home Calculated Value or the MH Ovr value, if 
present, plus the Add-Ons Value. 

Last Calc: If a change is made to any of the Mobile Home information that affects the Value, the Last Calc field will 
display the previous calculated Mobile Home Value, and the Total field will display the new calculated value. 
However, once the Apply Button is clicked and the user remains on the Mobile Homes Form, or clicks the OK 
Button and leaves the Form, the new Mobile Home value will display in both the Last Calc and Total fields on the 
Mobile Homes Form. 

Ovr Date: If an Override Value is keyed in the Override Value field, the date the override is entered should be 
keyed in the Ovr Date field. 

Ovr Reason: If an Override Value is keyed in the Override Value field, a Reason for this Override Value should be 
selected from one of the Reasons in this combo box. The list of Override Reasons is based upon those entered in 
Tools > Schedules/Tables > Override Reasons. 

MAV: Below the MAV button are three fields that hold the WinGAP generated Moratorium Appraised Value for 
the following: 

• The MAV for the Mobile Home itself. A value will appear in the Mobile Home MAV field after the Apply 
button on the Mobile Homes Form is clicked. 

• The Total MAV for Add-Ons to the Mobile Home. A value will appear in the Total Add-On MAV field after 
Add-Ons are added on the Add-On Form and the user returns to the Mobile Homes Form. 

• The Total MAV for the Mobile Home and any Add-Ons. A value will appear in the Total MAV field after the 
Apply button on the Mobile Homes Form is clicked. 

Should the MAV for the Mobile Home need to be changed by the user, the MAV Button should be clicked to 
manually edit this value. The following should be noted when entering a value in this field: Values keyed via the 
MAV Buttons are not monitored, keyed MAV values are permanent only for that screen session, and any future 
changes to the property could modify MAV. 

MAV Ovr Checkbox: To the right of the MAV Button is the MAV Ovr Checkbox. When a check is placed in this box, 
the value in the MAV field will be treated as an override for the Mobile Home “box” Value. All calculations for this 
Value will be suspended until the check is removed. 
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COMMENTS 

 

Comments: The Comments field can be used to enter any comments about the property. 

Comment Flag: The Comment Flag checkbox provides a means whereby users can create a visual flag to capture 
the user’s attention. Turning the Comment Flag on turns the background color of the Comments field red. It only 
serves to catch the user’s attention when opening the Non-Prebilled Mobile Home form. Counties can make their 
own policies for what this visual alert represents. 

 

 

MANUFACTURED HOME FORM ACCESS BUTTONS 

 

Photo Button: Right clicking this button opens a contextual menu that allows you to select from several options. 

 

Clicking the “Load Digital Photo” option will open a window where the user can navigate to a picture and load it to 
the WinGAPSQL folder on the server. A new folder will be created in the WinGAP photo folder on the server with 
the prefix “m” for mobile followed by the mobilekey assigned by Wingap, and the photo will be named the same. 
This is the primary photo for the Manufacture Home. 

 

 

Selecting the Load Additional Photos option will open a new form that will append more information to the photo. 
Typing in the field to the right of the Photo Name will add that information to the picture name, for instance 
“addition” would name the photo for a Manufactured Home with the mobilekey 82565 “m82565_addition”. 
Selecting one of the checkboxes will quickly append that information to the photo so the user does not have to 
type it themselves. The user will then navigate to where the picture is on their computer and WinGAP will copy it 
to the server and name it according to the above naming convention. 

 

Selecting “Delete Current Photo” will delete the primary digital photo, while selecting “Delete Additional Photos” 
will open the pictures folder for this record where the user can manually select which photos to delete.  
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No Sketch/Sketch Button: The No Sketch/Sketch Button takes the user to the WinGAP Sketching Module, where 
heated areas, appendages, and site improvements can be sketched and labeled. Sketching and labeling procedures 
are covered in the Sketching Module section. If structure areas are keyed by using the Structure Areas button, the 
Sketch/No Sketch button will read No Sketch. Once the Sketching Module has been used to draw sketches, and 
sketch data exists for the Manufactured Home, the No Sketch/Sketch button will read Sketch.  

 

Note: Sketches for a Manufactured Home are purely descriptive, and do not contribute any value to the 
Manufactured Home. 

 

Documents: Right clicking this button opens a contextual menu that allows you to “Load Digital Documents”. 
Clicking the “Load Digital Documents” option will open a window where the user can navigate to any file, such as a 
PDF of a sales record, and load it to the WinGAPSQL folder on the server. A new folder will be created in the 
WinGAP documents folder on the server with the prefix “m” for mobile followed by the mobilekey assigned by 
Wingap. 

 

Edit History: This button is used to view the Edit History of this manufactured home record. The Edit Log keeps a 
record of virtually every user-initiated operation that changes a record in WinGAP. Any time a user accesses 
WinGAP and adds a record or makes a change to an existing record it is recorded in the Edit Log database. Each 
record on the Edit Log Form lists the File Name, PKey, ChgAppr ID (if no logins are used, it will say "Nologin"), Edit 
Date, Edit Time, After Edit (value after edit), Value Time (the time the value was changed), and Before Edit (value 
before edit) for the record that was edited. Items in the Edit Log are listed in Date and Time order. 
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Clicking the Field Edits button will reveal the specific changes that were made to the record. 
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Agent: Allows tracking of tax agents authorized by the owner to be involved in tax matters. Agents that are added 
to a parcel, account, or prebilled mobile home will automatically be included on official tax notifications generated 
by WinGAP. 

Appointment: This button will open a new blank calendar appointment in Outlook. 

Schedules Button: This opens the Manufactured Housing Improvements schedule. More information on these 
schedules is covered in the Tools > Schedules/Tables > Manufactured Housing Improvements section. 
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Permits: This button takes the user to the Building Permits Form where building permits for this Manufactured 
Home can be entered. 
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NADA 

If the County prefers to price a Mobile Home by the Market approach to value instead of the Cost approach to 
value, the nationally recognized NADA Pricing Guide market values can be used. This is done by clicking the NADA 
Button, located in the Values section of the Mobile Homes Form. Clicking the NADA Button takes the user to the 
NADA Mfg Housing Pricing Guide Form, which will default to the Manufacturer, Model, and Condition of the 
Mobile Home. If an exact match is not found, the user may scroll through the selections to make the proper 
choice. 

 

 

If these are the correct choices for this Mobile Home, the user should then select the proper Condition by clicking 
the box to the left of one of the five options. Average is the default selection. After the Condition is selected, the 
user can click the OK Button on the Pricing Guide Form, and the NADA Market Value will appear in the NADA Value 
field on the Mobile Homes Form. The number in parentheses on the NADA button that appears after the NADA 
button is clicked and the NADA choice made for the Mobile Home refers to the NADA Valid Width for that Mobile 
Home. 
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A choice can now be made as to whether the NADA market value or the WinGAP calculated value of the Mobile 
Home is to be used for the digest. If the NADA value is the choice, the user should click in the checkbox to the right 
of the NADA value field to make that selection. If the WinGAP calculated value is to be used, the checkmark should 
be retained in the field to the right of the MH Calc value. 

 

NOTE: If the NADA market value is selected, a statewide adjustment as indicated by NADA will be applied to the 
NADA values. The values in the NADA schedule tables are not adjusted; instead, the adjustment is applied as the 
value for the Mobile Home is calculated. 

 

ADD NADA MANUFACTURER/MODEL 

 

Occasionally, when the NADA schedules are used to value a Mobile Home, WinGAP cannot find in the NADA 
schedules the Manufacturer/Model selected by the user on the Manufactured Housing Form. When the user clicks 
the NADA button to value the Mobile Home, WinGAP will display the closest NADA match to that 
Manufacturer/Model. If these are the correct choices for this Mobile Home, the user should then select the proper 
Condition by clicking the box to the left of one of the five options. Average is the default selection. After the 
Condition is selected, the user can click the OK Button on the NADA Pricing Guide Form, and the user is returned to 
the Manufactured Housing Form. 

 

If the home is categorized as an SVS valuation home, a window will appear in the upper left of the Manufactured 
Housing Form, and the user should select the correct NADA SVS Quality Class for this Mobile Home by clicking in 
the appropriate Quality Class checkbox and then clicking the OK button. 
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Quality classes will display a summary of what qualifies for each class as you click on the check box. 

• Economy: This is the lowest priced manufactured home in production. This home has no special features 
and few, if any, upgraded components. The quality of all interior and exterior finishes is plain and 
inexpensive with little or no attention given to detail. Walls are typically 2” to 4” thick with 7’ to 7’6” 
ceiling height. Wide use of plastic for plumbing, trim, and fixtures. This class will include the cheapest 
construction standards (June 15, 1976). 

• Standard: The standard quality manufactured home will typically meet or exceed all minimum 
construction requirements, state mobile home, or Federal Ttitel6 HUD codes. This home contains few 
special features. The exterior siding is usually prefinished aluminum with the fasteners concealed; some 
exterior trim and detail may be found at the front. The interior contains standard grade cabinets, doors, 
hardware, and plumbing. Walls are typically 3” or 4” and some are 6” in thickness. This category is 
generally the most common found and is manufactured in the majority of states and would include 
upgraded or multi-wide Mobile Office units.  

• Deluxe: This above average manufactured home generally exceeds all HUD building standards and will 
include Modular (SFR)/Commercial Buildings. The exterior will include an attractive architectural design 
utilizing aluminum, plywood, hardwood, and/or a combination of the three. The interiors are well finished 
and will include many special features such as full picture windows, ¼” plywood paneling, and above 
standard fixtures. The walls are 4” to 6” thick with 8’ ceiling heights. This home is considered the highest 
priced manufactured home in mass production, excluding the luxury category or homes with individually 
designed floor plans. 

• Luxury: This manufactured home always exceeds all construction standards and requirements of the 
minimum HUD construction codes. This home contains many special features. Interiors designed for the 
individual home include simulated brick or stone paneling, ¼” top grade plywood, conventional home 
type doors, and picture or bay windows in many or all of the living areas. Exterior finishes emulate that of 
conventional housing. This home contains the best designs, workmanship, and construction materials 
available. Roof details, such as mansard or single hip, are often standard features. This category will also 
include individually designed commercial buildings and modular construction or HUD Code homes that 
are individually designed in total. 

 

The user will be returned to the Manufactured Housing Form, and the Mobile Home Manufacturer/Model the user 
selected from the NADA Schedule will now appear in the Manufacturer/Model fields on the Form. When the user 
clicks the OK button on the Manufactured Housing Form and attempts to exit, another screen will appear 



 
784 

prompting the user to add the NADA Manufacturer/Model schedule item that was just selected to the WinGAP 
Mobile Home Manufacturer/Model schedule (mobmfgta.dbf). 

 

 

The user should assign a Quality Class for this new Manufacturer/Model schedule item, click the OK button, and 
the schedule item will be added. If the user does not want to add the schedule item, the Cancel button should be 
clicked and the item will not be added. 

 

 

ADD-ONS 

Add-Ons are appendages to the Mobile Home such as Porches, Decks, and Patios. The Add-Ons Button is where 
Add-Ons are added, edited, or deleted. The New button on the Mobile Homes Add-On form should be clicked to 
begin adding a new Add-On. 
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Description: Clicking on the combo box in the Description field produces the list of available Add-Ons. An item 
from this list must be selected to add an Add-On. The Add-On items that display in the list are based upon those 
set up in the Add-Ons Schedule found in Tools >Schedules/Tables > Manufactured Housing > Add-Ons or Tools > 
Schedules/Tables > Manufactured Housing > Lump Sum Add-Ons. 

Width: In most cases, the width of the Add-On in feet is entered in this field. When the Add-On is valued by the 
lump sum or unit method, the number entered in the Width field will depend on the way the Lump Sum Add-On 
Schedule is set up. For example, the number can represent the height of skirting around the base of the Mobile 
Home. 

Length: The length of the Add-On in feet is entered in this field. When the Add-On is valued by the lump sum or 
unit method, the number entered in the Length field will again depend on the way the Add-On Schedule is set up. 

Calc Area: If the length and width of the Add-On are entered and the user Tabs to the OVR Area/Units field, 
WinGAP will calculate the area and place the value in this field. The Calculated Area field is not accessible to the 
user.  

OVR Area/Units: If the Add-On is valued by the square foot but is not square or rectangular, the appraiser-
calculated area would be keyed here. When the Add-On is valued by the lump sum or unit method, the number 
entered in this field will again depend on how the Lump Sum Add-On Schedule is set up. 

Identical Units: The number of Identical Units of an Add-On is keyed here. If other Add-Ons to this Mobile Home 
are identical to the one now being added, than the total number of Identical Units can be keyed here instead of 
adding another Add-On of the same exact type. For example, if there are 2 Open Porches of identical size, year 
built, and grade attached to the Mobile Home, then 2 would be keyed in the Identical Units field. 
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Year Built: If known, the year the Add-On was built is entered in this field. The Year Built field defaults to the 
system year minus one year. 

EFYR: The Effective Year Built is used only when the condition of the Add-On reflects something different than 
should be present based on the original year of construction. The Eff Year Built field can be used to effectively 
increase or decrease the age of an Add-On. When present, the Effective Year Built is used in calculating the 
Physical Depreciation Factor and determining the Add-On’s Calculated Value. 

Grade: The Grade is a numerical assignment representing the quality of materials and workmanship for the Add-
On. The Grade field defaults to 100 (Average). The appraiser is responsible for assigning the Grade, and the range 
can be from 1 to 999. No decimal is used in data entry. The Grade is also used in calculating the Physical 
Depreciation Factor of the Add-On.  

Phy Depr Ovr: The Physical Depreciation Override field is used to override the calculated Physical Depreciation 
performed by WinGAP. The field defaults to 0.00 (zero) and should remain at this value unless the appraiser wishes 
to apply a set Physical Depreciation Override factor for this Add-On. 

Func Obsl: The Functional Obsolescence is a numerical assignment representing the appraiser's judgment of the % 
good with regards to functional depreciation. For example, a Mobile Home determined by the appraiser to have 
functionally depreciated by 20% would be 80% good, and .80 would be keyed in the Functional Depreciation field. 
The range can be from .01 to 9.99. The default is 1.00. There must be an entry in the Functional Obsolescence 
field. A value of 0.00 will result in a zero value for the Add-On. 

Other: Any other appraiser determined factor that should be applied to the Add-On can be keyed in this field. The 
range can be from .01 to 9.99. The default is 1.00. There must be an entry in the Other Factors field. A value of 
0.00 will result in a zero value for the Improvement/Section. 

Calc Depr: The WinGAP Calculated Physical Depreciation displays in this field. The Calculated Physical Depreciation 
will display even if there is an entry in the Phy Depr Ovr field. The Calc Depr field is not accessible to the user. 

Perc Comp: The Percent Complete field represents the % completed status of the Add-On. If construction is 
finished, it is 100% complete. If it is not 100% completed, the value keyed in this field is the appraiser's 
determination of how complete the Add-On is. The range can be from .01 to 1.00. The default is 1.00. There must 
be an entry in the Percent Complete field. 

Neighborhood: Neighborhood factors are not used to adjust the value of Add-Ons. The Neighborhood Factor will 
display as 1.00 for Add-Ons. 

Calculated: The WinGAP calculated value of this Add-On will display in this field. 

Override: The Override Value represents an assigned value for the Add-On. An entry in this field overrides all 
WinGAP calculations for this Add-On. 

MAV: The MAV field holds the WinGAP generated Moratorium Appraised Value for the Add-On. The MAV value 
will appear in the field after the Apply button is clicked. Should this value need to be changed by the user, the MAV 
Button should be clicked to manually edit this value. The following should be noted when entering a value in this 
field: values keyed via the MAV Buttons are not monitored, keyed MAV values are permanent only for that screen 
session, any future changes to the property could modify MAV. 

MAV Ovr Checkbox: To the right of the MAV Button is the MAV Ovr Checkbox. When a check is placed in this box, 
the value in the MAV field will be treated as an override for the Add-On Value. All calculations for the Add-On 
Value will be suspended until the check is removed.  

Last Calc: If a change is made to any of the Add-On information that affects the Value, the Last Calc field will 
display the previous calculated Add-On Value and the Calculated field will display the new calculated value. 
However, once the Apply Button is clicked and the user remains on the Add-Ons Form, or clicks the OK Button and 
leaves the Form, the new Add-On value will display in both the Last Calc and Total fields on the Add-Ons Form. 
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At the conclusion of entering information about each Add-On, the user should click the Apply Button at the bottom 
of the Mobile Home Add-Ons Form to make sure that all data entry for the new Add-On is saved, as seen on the 
next page. The Add-On that was added will appear in the window at the upper left of the Form. If the data entry 
for Add-Ons is completed, the user may click the Ok Button in lieu of clicking Apply and exit the screen with the 
data being saved. 

 

 

An Add-On can be edited by clicking on the desired item in the list box on the Add-Ons Form, clicking on the 
appropriate field and changing the data, then clicking the Apply Button. If the data entry for Add-Ons is completed, 
the user may click the Ok Button in lieu of clicking Apply and exit the screen with the data being saved. 

 

An Add-On can be deleted by clicking on the desired item in the list box on the Add-Ons Form, then clicking the 
Delete Button at the bottom of the Form. The message "Are you sure you want to delete this record?" will appear. 
Clicking the Yes Button will delete the record; clicking on the No Button will cancel the deletion of the record. 
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TRANSFER TO PREBILL  

A Non-Prebilled Mobile Home can be transferred to a Prebilled Mobile Home by clicking on the Transfer to Prebill 
Button on the Mobile Homes Form. 

 

 

The first step in the Transfer process is to select a Tax District for the Prebilled Mobile Home. 
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After selecting the Tax District, clicking OK on the Select Tax District Form will produce the Owner Search Form 
where the owner of the Prebilled Mobile Home can be located. 

 

 

After selecting the owner, the Open Button should be clicked, and the Non-Prebilled Mobile Home will be 
transferred to the new owner. The user will be returned to the Real Property General Information Form of the 
owner that used to own the Non-Prebilled Mobile Home. 

 

 

DELETING A NON-PREBILLED MOBILE HOME  

If necessary, a Non-Prebilled Mobile Home can be deleted, but it must be deleted on the Residential Improvement 
Form that the Mobile Home is attached to, not on the Manufactured Housing Information Form. If the Delete 
Button on the Manufactured Housing Information Form record is clicked, the user will receive a message: 
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The user should click OK on this message and then OK on the Manufactured Housing Information Form to return to 
the Residential Improvement Information Form, where the Delete Button can be clicked to delete both the 
Residential Improvement record and the Mobile Home record. The message "Are you sure you want to delete this 
improvement?" will appear. Clicking the Yes Button will delete both the Residential Improvement record and the 
Mobile Home record; clicking on the No Button will cancel the deletion of the two records. 
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SKETCHING MODULE 

The WinGAP Sketching Module is a separate program called Rapid Sketch that allows the County to add, edit, or 
delete drawings, or Sketches, of Residential and Commercial Improvements, and Manufactured Housing. The user 
can also create Labels with which to Label Sketches or other areas on the screen, such as Site Improvements (wells 
or outbuildings), and place them on the Sketch screen. The Sketching Module is reached from the Residential 
Improvements, Commercial Improvements, or Prebilled or Non-Prebilled Mobile Homes Form by clicking on the 
Sketch/No Sketch Button on any of these Forms. 

 

 

The Sketch screen is divided into three sections:  

• The Sidebar, on the left side of the Sketch screen, where tools that are used to create and interact with 
the sketches, also called polygons (and sometimes objects) are selected.  

• The Toolbar, at the top of the Sketch screen, where various buttons that control features are located. 

• The Grid, which is the large white area of the Sketch screen, where the actual sketching is performed.  
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GETTING STARTED 

 

  - The Wall Tool draws walls with mouse or keyboard input. 

 - The Pointer Tool will move any object at any time. 

 - The Undo Command can usually fix most drawing mistakes. 

 

A typical drawing is usually started by selecting the Wall Tool, clicking your cursor down on the grid, then using 
keyboard or mouse input to draw connected walls, the ends of each wall are called vertices, until an area is 
completed, which is called a polygon, and given a label (such as First Floor). Before drawing, the user might want to 
consider adjusting some of the grid options to ensure speed and accuracy. These settings are found at the bottom 
of the screen. 

 

 

Measurement: This option is fixed and is not changeable by the user. 

Precision: This function lets the user decide exactly what increments the lines will be drawn in. The precision 
options are whole feet, ½ feet, ¼ feet, and 1/10 feet, and inches. If walls will only be drawn in increments of whole 
feet, the user would select whole feet. However, if walls will be drawn as precise as 1/10th of a foot, then selecting 
1/10 feet would cause all lines to be drawn in increments of 1/10th of a foot (ex. 12.3 ft.). 

Angle Snap: This function is designed to help the user keep walls at proper angles. The default angle snap is set to 
5 degrees, as most houses will not have walls at an angle other than a multiple of 5. This feature can be adjusted 
between 45, 15, 5 and 1 degrees, or shut off completely. 

Grid: This option will hide or show the grid lines from the sketch pad. 

 

Zooming: In RapidSketch the scale of the grid is always 1:1. Each little square at this default scale is one square 
foot. If zoomed out far enough, the Grid will show a heavier grid line that is 10x10. You never have to scale the grid 
to make your drawing fit; instead, you zoom in and out as necessary to draw your sketch on an “infinite” sketch 
pad.  
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Zooming can be accomplished with the scroll wheel when you do not have an active line attached to the cursor by 
scrolling in/out to zoom in and out of your drawing. To zoom in on a particular area simply place your cursor in the 
center of that area and scroll forward. RapidSketch will automatically center your screen on your cursor and 
enlarge the area as you scroll. To zoom out, simply scroll backwards. As you zoom out RapidSketch automatically 
centers the sketch around the cursor, allowing you to zoom out over a particular area or the whole drawing. 

 

RapidSketch also has a Zoom Tool  on the Sidebar. When selected, it allows you to zoom in by dragging a box 
over the area you would like to zoom in on or by single-clicking. To zoom out with the zoom tool, simply right-click. 
Just like the scroll wheel, RapidSketch centers your sketch about the cursor when you zoom. 

 

Center and Fit: After zooming in and out repeatedly on different areas of your sketch you may want to quickly 
view your entire sketch in the center of the screen, at an appropriate zoom level. This can be done by: 

• Hitting “C” on your keyboard 

• Using the Center and Fit  button on the toolbar. 

 

DRAWING WITH THE KEYBOARD 

To begin drawing your first polygon, click the brick wall icon on the Sidebar to activate the Wall Tool. Place the 
cursor in the desired start location on the sketch pad and hit enter to start the first wall. A green circle will 
illuminate under the starting point. Type in a length with the number pad, then key a direction with the arrows. An 
active line will launch the length and direction you have entered. Repeat this until you are satisfied with your wall’s 
placement and hit the Enter key once to anchor this wall. You are now ready to begin drawing your next line. The 
wall’s dimension label will be automatically centered on the line. When drawing with the keyboard, you can hold 
down Shift and use the arrow keys to draw lines in 1-foot increments. 

 

After you have drawn a few walls of your Area, you can often use the arrow keys to continue and even close the 
Area. In RapidSketch the arrow keys don’t move you 1 space at a time while drawing; instead they snap you into 
alignment with the next point in the direction you pressed. Using the arrow keys to draw extends an active wall 
until its end point lines up with existing horizontal or vertical points or other or the same area you are on. This is 
noted by flashing red lineup dots (visual cues) at each common point. 

 

When you are ready to complete your area by drawing your final wall, you can hit and RapidSketch will 
automatically draw a wall to close your area. Upon closing your area, you will be prompted to “Select an Area 
Type”. 

 

Example: Start a new sketch, choose the wall tool, place your mouse cursor over the sketch pad where you would 
like to start your diagram, press enter to anchor your cursor. 
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To draw a 40.5 x 20 rectangle type in 40.5, hit the right arrow, hit enter. 
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Type in 20, hit the down arrow, hit enter. 

 

 

To finish the rectangle hit your left arrow key (which will jump the wall in-line with the nearest vertex in that 
direction), then enter. 
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And finally, hitting the A key to close the polygon which will cause a prompt will appear for you to select the label 
for the area just sketched. 

 

 

After selecting the label, the polygon will appear in its completed form with wall colors that match the label type. 
Primary labels are solid red, Upper labels are dashed violet, Appendage labels are solid blue, Addition labels are 
dashed double black, and Interior labels are dashed green. 
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INPUTTING ANGLES  

There are two methods for inputting angles with your keyboard. 

 

Direct Length and Angle input: When a precise angle and length for a polygon are needed, and the keyboard is 
being used, RapidSketch supports using the “R” and “L” keys to draw specific angles. The way a user chooses 
whether to use the “R” or “L” key is based on the angle relative to the last line that was drawn – it is not 
determined by the direction on the screen (up/down/left/right) that you would like the wall to be drawn. 

 

Example: “6, R, 4, 5, Enter” = 6 ft line to the right at 45*. 

 

 

If you do not put in an angle, the program will default to 90 degrees. You can draw walls at a 90 degree angle off of 
other walls simply by typing in the length and hitting the “R” or “L” key. 

 

Example: “25, R, Enter” = 25ft line to the right at 90*. 
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Rise over Run input: Some users prefer to measure the rise and run of an angled wall instead of measuring the 
degree of angle and exact length. RapidSketch supports this kind of input by allowing the user to move an active 
line “up and over”, then anchoring the line with the Enter key. 

 

Example: “20, ↑, 25, →, Enter” = Angled line with 20ft. / 25ft. rise over run. 
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Bay Windows: This feature automatically draws a wall that is the same length and opposite angle as the 2nd last 
wall drawn when you hit the “B” button on your keyboard. To use this feature, draw the first angled wall, then the 
center section, then hit “B” on your keyboard. This will draw the 3rd section of the bay window opposite to the 
first. Hit your enter key to anchor this line and continue sketching. 

 

 

SIMPLE SHAPES 

There are two methods for inputting simple shapes with your keyboard. 

 

Sides @ Length: To quickly draw a shape that has the same length for every wall, type in the number of sides, hit 
“@” on the keyboard, type in the length of the sides, then hit Enter. 

 

Example: “6, @, 20, Enter” = 6-sided shape with 20ft walls. 
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Width X Length: To quickly draw a square or rectangular shape with the keyboard, type in the width, hit “X” on the 
keyboard, type in the length of the sides, then hit Enter. 

 

Example: “40, X, 20, Enter” = 40ft by 20ft rectangle. 
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DRAWING WITH THE MOUSE 

There are two basic techniques to sketching with a mouse. Both start by selecting the brick wall icon on the 
Sidebar to activate the Wall Tool.  

 

Click-Click: The first method is the “Click-Click” technique. Place the cursor in the area you would like to start your 
sketch and click once to start your first wall. Move the cursor to the desired end location and click to anchor the 
active wall. An active wall will automatically connect from the last point anchored to your cursor. To deactivate 
click-click mode, hit escape on the keyboard or click on the same point you last anchored a wall. 

 

Click and Hold: The second method is the “Click and Hold” technique. Place the cursor in the area you would like 
to start your sketch and click and hold the mouse button down as you drag cursor to the desired length. Release 
the button to anchor the active wall. There will not be another active wall until the next time you hold down the 
mouse button. 

 

With either method, a polygon will close when you click on or drag a wall to the first vertex of the shape. 

 

Shape Tools: The Sidebar has Circle  , Rectangle  , and Pentagon  tools. Clicking on these tools 
will allow you to click a point and drag the selected shape to the appropriate dimensions. Of note, when selecting 
the Pentagon tool, a secondary menu will appear on the Sidebar allowing the user to select a multi-sided shape 
from 5 to 12 sides.  

 

DRAWING A SECOND AREA 

To begin a second area, select a point anywhere on the drawing area and begin drawing as usual. Having drawn 

the first area, there are many reference points available to help draw another area without having to type in as 

many dimensions. With the wall tool selected and your cursor on the sketch pad, use the Tab key to jump your 

cursor to different points on your first area. Another tool is the Arrow keys, which also take advantage of the 

reference points plotted by the first area. When drawing a line parallel to the first area, hitting an Arrow key draws 

an active line with an endpoint parallel to the first corner or intersection of lines on your first area. Hitting the 

same Arrow again extends that line to the distance of the next corner until you reach the end of the original area. 

Upon anchoring such a line, you can hit another arrow in the direction of the original area to draw an active line 

perpendicular to the first. This line will follow the original area line and have the same characteristic, extending 

closer until it reaches the first area. 

 

Auto Complete: Auto Complete  is a feature that con be turned on/off from the tool bar which will 
automatically trace shared walls and automatically split an area without having to retrace walls. Using the exterior 
wall tool and auto-complete turned on, when you draw lines that attach to common walls, the program will 
automatically trace over the remaining lines to form an area. Similarly, if you split an existing area in 2 using 
exterior walls, it will automatically segment that area into 2 sections. 
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Example: With auto-complete turned on, to add this porch only 3 lines need to be drawn, the fourth and fifth lines 
will automatically be drawn in. Draw the First 3 Lines as You Normally Would: 

 

 

Upon connecting the third line back to the first floor, auto-complete will automatically draw in the remaining lines. 
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Showing the completed area after area label was selected. 

 

There are times when it will be helpful to trace over an area to create a similar duplicate area, such as a second 
floor that is much like the first floor but is not identical. To do this, first toggle off the Auto Complete/Auto Split 
feature, then trace over the original area to create a similar copy.  

 

Example: Begin by selecting the Wall tool, then using the mouse or keyboard input to trace over the sections of 
the original area that are similar to the second. 
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Once the second area has been completed, you will be prompted to select a label. Select a label, such as Second 
Floor, then use the Pointer tool to drag the second area next to the original if needed. 

 

 

To “cut out” part of a polygon, for instance turning part of a first floor that was measured as a perimeter into a 
garage, turn the Auto Complete/Auto Split feature on and connect wall lines to the first area. 

 

Example: To draw in the attached garage that is already part of the perimeter that was already drawn, just connect 
lines inside the first area. 
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Once the wall line clearly marks where the polygons are to be split, the initial area will be split automatically. 
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To change the new area’s label, use the pointer tool to double click inside the polygon, which will open the select 
area label menu. 

 

 

Once selected, the sketch will update to show the new label, and your polygon split is complete. 
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USING THE POINTER TOOL 

Once you have drawn a wall, polygon, or any other object, you can select the pointer tool to begin modifying the 
object’s properties. To select an object, select the pointer tool from the Sidebar, then click on the object you wish 
to interact with. You will know the object is selected by the “handles” that appear on it. When selected, objects 
appear with a slightly different look, generally signified by highlighted lines or handles. 

 

Areas: 

 

Labels: 

 

Walls: 

 

 

To select a polygon, click the pointer tool inside any open part of it (open meaning not a line, label, or symbol, 
instead click inside the area where it is blank). Now you can click and hold to move it around the sketch, or choose 
to rotate it by clicking, holding, and dragging the green rotator handle. You can delete any selected object by 
pressing the “delete” key on your keyboard or using the red “X” button on the toolbar. 
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To select multiple objects, you can “drag a box” around them. If you have not selected the correct objects and 
would like to try again, click outside of your currently selected objects and they will be deselected. 

 

 

To select specific objects that are not necessarily grouped together, hold down the “Ctrl” key while you click on 
each object. Each object you click on will be selected. 
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Arcing a Line: You can draw an arc by moving your scroll wheel on your mouse forward or backward while the line 
is still active. Another method is to draw a straight line and use the pointer tool to arc it. Start by drawing a straight 
line with the mouse or keyboard commands. Once that line is anchored use the pointer tool to click on the center 
point of the line and drag it out to the appropriate height, or use the arrow keys to move it out. 

 

 

EDITING AN EXISTING POLYGON 

Sometimes a house will have an addition built to it where re-sketching the entire polygon is unnecessary, but the 
existing one needs to be modified. The basic method to accomplish this is to “split” the existing wall by adding 
vertices, then moving them into the shape and location you want them. 

 

The first step is to split the existing wall. Right clicking the line to be modified will produce a contextual menu with 
a few options. Hovering over the wall you are looking to edit will produce a submenu that has a “split here” option. 
Selecting this will add a vertex where you right-clicked the wall at. 
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Oddly, RapidSketch does not follow the precision measurements defined on the bottom of the screen and will 
place the new vertex literally where you clicked, down to the 1/100th precision, so it is necessary to massage the 
vertices in place. In the following example, it split the wall at 6.35 ft and 15.65 ft instead of an even 6 and 16 as 
would be indicated by the precision. To correct this, select the newly created vertex by clicking on it. 

 

 

Then use your arrow keys to move it. It will “jump” to be in-line with the next vertex on the sketch in the direction 
of the arrow you select. In the above example, clicking ↓ will line up the selected vertex with the vertex at the end 
of the 12 ft long wall running parallel to it on the right. The vertex it has lined up with will glow red. 
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The vertex is now spaced on the whole number increment of 10 ft and 12 ft. To move the vertex and retain that 
precision, hold the Shift key while using the arrow keys to move it 1 foot at a time until it is where it needs to be. 
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Once this is done, split the wall again and place the next vertex where it belongs using the same method. 

 

 

To add the addition to the house, we will now place two vertices in between the ones we’ve just added. Don’t 
worry about the precision at this moment. 
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Select the very centermost wall that formed between the last two vertices that were added. 

 

 

Using your Shift and arrow keys, move the wall out however many feet the addition is. We will move it 8 feet in 
this example by holding Shift and pressing ← 8 times. 
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Now pick the top vertex and press ↑ to line it up. 

 

 

Then select the bottom vertex and press ↓ to line it up. 
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And now the addition is complete without the need to re-sketch the entire polygon. 

 

A similar method can be used to join two separate polygons. This is useful if the addition is a more complicated 
shape that is easier to draw separately, but without having to re-sketch the entire first polygon as well. On the wall 
where the two polygons are to be joined, follow the first steps outlined above to place vertices where the new 
polygon will join the existing one. 

 

Sketch the new addition out to the side. 
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Then delete the wall on the original polygon where the two will join. This will turn the polygon grey and the area 
label will disappear. 

 

 

Move the new polygon to the existing polygon. 
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Then delete the wall where the polygons joined on it as well. 

 

 

To get the two polygons to join, grab the corner of one of the polygons and move it up/down to get the program to 
recognize the vertices as overlapping. 
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When done correctly, the program will ask if you would like to combine these areas. Answer Yes to do so. 

 

 

Repeat again at the other vertex. 
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When both vertices have been joined, the sketch label will reappear, the area will turn white, and the new 
combined square footage will display along with the sketch label. 

 

 

OTHER TOOLS 

CUSTOM LABELS 

Click on the note tool  at the top of the screen and your cursor is ready to be placed anywhere you would like 
to start typing a custom label or note. Another way to execute the note command is to hit “T” on your keyboard. 
Wherever your cursor happens to be it will be ready for you to type in a new label. When editing or placing a label, 
you can hold the key down and press “Ctrl + Enter” to add additional lines to the label. 

 

Example: Click on the add label button in the tool bar, place your cursor over the sketch where you would like the 
label to be placed, left click to start adding the label, type in “test line 1” then hold “Ctrl” and press “Enter” to add 
a new line and type “test line 2”. Pressing enter by itself or clicking anywhere else will finalize the label. 
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You can edit labels by double clicking on them with the pointer tool. You can also change the font, color, and size 
of labels by selecting them with the pointer tool and using the formatting drop downs on the toolbar for font, size, 
and color. Also note that selected labels can be sized up or down by using the “+” and “-” keys on the keyboard. 
Labels can also be rotated using the green rotator handle that appears once they have been selected. 
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TAPE MEASURE TOOL 

 

The Tape Measure Tool  allows you to show a “dimension only” line with arrow heads and rise / run 
measurements on the sketch that can be used for showing distances to outbuildings, roads, etc. To use the tape 
measure tool, select it from the Sidebar, then use the same techniques as drawing a line (with either the mouse or 
keyboard) to draw the tape measure line on your sketch. 

 

 

COPYING, PASTING, AND DELETING AN OBJECT 

Any object on the sketch can be selected with the pointer tool then copied to your clipboard using the  icon 
on the toolbar or using the “Ctrl + C” command on the keyboard. 

 

The object that was copied can be pasted using the  icon on the toolbar or using the “Ctrl + V” command on 
the keyboard. 

 

Any object can be deleted by selecting it with the pointer tool then using the  icon on the toolbar or using the 
“Delete” button on the keyboard. 
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PHOTOMETRICS 

Photometrics is an advanced feature that allows the user to import a floor plan image, then trace over it to 
produce a diagram that is of the same scale as the original. This is a useful for tracing over a complex blueprint to 
get a simpler diagram with area and perimeter automatically calculated. To use this feature, all you need is a floor 
plan image with at least one line that you know the length of. 

 

To begin you will either hit the Photometrics icon  from the Toolbar or right click on the sketch pad and 
choose Photometrics > Add Image.  

 

 

This will prompt you to locate the image you would like to trace over. 
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Once the image to be traced is selected, RapidSketch will prompt you to trace over a line in the image that you 
know the length of. 
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Draw a line using the wall tool over a line on the floor plan that you know the length of.  

 

 

 

Enter the length of the line when prompted. 
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The image will automatically rescale so that it matches the scale of the grid, and you can trace over the floorplan 
to recreate the sketch inside WinGAP. 
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COMMERCIAL IMPROVEMENTS FORM 

The Commercial Improvements Form is used to add, edit, or delete any Commercial Improvements on the Parcel. 
The Com Imp Button on the Real Property General Information Form is used to access this Form. 

 

 

If one or more Improvements exist on the Parcel, the Com Imp button on the Real Property General Information 
Form will have a number on it in parentheses, such as (4) in the example above, and clicking this button takes the 
user to the first Commercial Improvement on the Parcel. There is no limit to the number of Commercial 
Improvements that a Parcel can have. 
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If no Commercial Improvements exist on the Parcel, no number will display in parentheses on the Com Imp button. 
Clicking on the Com Imp button takes the user to a "grayed out" Commercial Improvements Form where the New 
button must be clicked to add the first Commercial Improvement to the Parcel. 



 
828 

 

 

GENERAL IMPROVEMENT INFO 

 

Improv No: Each Commercial Improvement is assigned an Improvement Number by WinGAP. When adding the 
first Commercial Improvement, the number will be 1. Subsequent Commercial Improvements, if any, on this Parcel 
will be assigned the numbers 2, 3, etc. There is a limit of 999 Commercial Improvements per parcel. After clicking 
Apply, the Improvement Number can be edited, if necessary, by clicking on the Improv No button. 

Section No: Each Commercial Improvement is assigned a Section Number by WinGAP. A Commercial Improvement 
must have at least one Section that is associated with a certain use. Another part of the Improvement which has a 
different use which would require a different pricing schedule would be assigned to a separate Section. For 
example, a building that is primarily a warehouse may have some office space that would dictate using a different 
pricing schedule. In this case, the warehouse might be Section Number 1 of Improvement 1 and the office might be 
Section Number 2 of Improvement 1. When adding the first Section to the Commercial Improvement, the number 
will be 1. Subsequent Sections of the Commercial Improvement would be assigned 2, 3 etc. There is a limit of 99 
Sections that can be added to the Commercial Improvement. After clicking Apply, the Section Number field can be 
edited, if necessary, by clicking on the Section No button. 

Improvement: Directly to the right of the Section Number field is a field, not labeled, where important identifying 
information about the first Improvement on the Parcel will display. This combo box field is blank when adding the 
first Commercial Improvement/Section. When editing Commercial Improvements/Sections, the field will display 
the WinGAP assigned Commercial Improvement Key number, the Improvement and Section Numbers, and the 
Used As Code and Description. 
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If there is more than one Commercial Improvement/Section or multiple Sections on one Improvement, the user 
can click on the field combo box to directly access any of the other Improvements or Sections without leaving this 
Form. This field cannot be directly edited by the user. 

 

 

Parcel No: The Parcel Number of the parcel that the Commercial Improvement is located on, pulled from the Real 
Property General Information Form. This field cannot be directly edited by the user. 

Class: The Digest Classification for the Improvement, such as Commercial. The Class field for a new improvement 
will default to "A" if the Land Digest Class is "A", "V", "P", or "W"; it will default to "R" if the Land Digest Class is 
"R"; it will default to "C" if the Land Digest Class is "C"; it will default to "I" if the Land Digest Class is "I"; and it will 
default to the Land Digest Class if the Land Digest Class is "E". The user can change from the default Class, if 
necessary, by selecting the appropriate digest class from the combo box. 

Strat: The Digest Stratification for the Improvement, such as Improvement. The Strat field for a new improvement 
will default to 1, unless the Land Class is "E", in which case the Strat will default to the Land Digest Strat. The user 
can change from the default Strat, if necessary, by selecting the appropriate digest class from the combo box. 

Used As: Used As refers to the current use of the Commercial Improvement structure or the type of structure as it 
relates to its use. Used As types are set up in Tools > Schedules/Tables > Commercial Improvements > Base 
Schedule. 

Built As: Built As refers to the original use of the Commercial Improvement structure and is used for determining 
an Improvement's life expectancy and in calculating the depreciation of the Improvement. Built As types use the 
same schedule as the Used As types and are set up in Tools > Schedules/Tables > Commercial Improvements > 
Base Schedule. 

Const Type: Construction Type refers to the general method of construction for Commercial Improvements. There 
are five Construction Types: 

• Heavy Structural Steel 

• Reinforced Concrete 

• Masonry Load Bearing 

• Wood/Steel Combination 

• Prefab Structural Steel 

All Commercial Improvements can be applied to one of these Construction Types. The Construction Type schedule 
is hard-coded and not accessible to the user in WinGAP. 

Life Exp: The Life Expectancy of the improvement in years, based upon the Built As and Construction Type. This 
field is not directly accessible to the user. The Life Expectancy value is pulled from the Commercial Base Schedule 
and will be displayed on the LE button to the right of the field. 

Sch LE: The Sch LE button can be clicked to change the value in the Life Exp field. The Life Expectancy as pulled 
from the Commercial Base Schedule should normally NOT be changed by the user.  
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Wall Hght: The average Wall Height of the Improvement/Section is keyed in this field. If the Improvement/Section 
is more than one story, the total height of the building is divided by the number of stories to determine the Wall 
Height. A Wall Height MUST be keyed in this field for the Commercial Improvement value to calculate. 

Year Built: The Year Built represents the actual year the Improvement/Section was constructed. The Year Built is 
used in calculating the Physical Depreciation Factor and determining the Structure Value for the Improvement. The 
Year Built field defaults to the current Digest Year (Appraisal Year) minus one. 

Eff YR Built: The Effective Year Built is used only when the condition of the Improvement/ Section reflects 
something different than should be present based on the original year of construction. The Effective Year Built field 
can be used to effectively increase or decrease the age of an Improvement/Section. It is not the year it was 
remodeled. When present, the Effective Year Built is used in calculating the Physical Depreciation Factor and 
determining the Structure Value for the Improvement. The field should be left blank if no Effective Year Built is to 
be used. 

Area: The square foot heated area of the Improvement/Section is entered in this field. The field can be left at zero 
and WinGAP will calculate the Area if the Sketch Module is used to draw the Improvement/Section. 

Perimeter: The distance around the sides of the heated area of the Improvement/Section is entered in this field. 
The field can be left at zero and WinGAP will calculate the Perimeter distance if the Sketch Module is used to draw 
the Improvement/ Section. 

Story Height: The story height of the Improvement/Section is selected in this field. If the Commercial Improvement 
is to be sketched, it is not necessary to select the Story Height. The Story Height field will be filled in by WinGAP 
based on the Commercial Improvement Label that was selected for the sketch. If the Area and Perimeter are 
entered manually and the Commercial Improvement/Section is not sketched, the user should select from the 
possible Story Height choices from this combo box. 

Common Wall: The total length of any Common/Party Wall(s) between two separate Commercial 
Improvements/Sections is entered in this field. If a length is entered, the following adjustment will be made by 
WinGAP to the Perimeter of the Commercial Improvement: 

([Perimeter] – [Common Wall]) + ([Common Wall] x .50) 

Essentially, half the keyed distance of the Common Wall is removed from the Total Perimeter. 

Section Area: The value in this field will represent the total square footage of this Section of the Commercial 
Improvement, adjusted by the Identical Units and the sketch label's area factor. This field is not accessible to the 
user. 

Total Bldg Area: The value in this field will represent the sum of the Section Areas, with their adjustments, of this 
Commercial Improvement. This field is not accessible to the user. 

 

VALUE ADJUSTMENTS 

 

Grade: The Grade is a numerical assignment representing the quality of materials and workmanship for the 
Improvement/Section. The appraiser is responsible for assigning the Grade, and the range can be from 1 to 999. 
No decimal is used in data entry. The Grade is used in calculating the Physical Depreciation Factor of the 
Improvement/Section. 

Phy Dep: The WinGAP calculated Physical Depreciation displays in this field. It is based upon the Grade and the 
Year Built (or Effective Year Built). The Physical Depreciation will display even if there is an entry in the Phy Dep Ovr 
field. The value in it cannot be changed by the user. 

Phy Dep Ovr: The Physical Depreciation Override field is used to override the calculated Physical Depreciation 
performed by WinGAP. The field defaults to 0.00 (zero) and should remain at this value unless the appraiser wishes 
to apply a set Physical Depreciation for the Improvement/Section. 
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Econ Obsl: Economic Obsolescence is a numerical assignment representing the appraiser's judgment of how the 
economic area that the Improvement/Section is in has affected the value of the Improvement/Section. The range 
can be from .01 to 9.99. The default is 1.00. There must be an entry in the Economic Obsolescence field. A value of 
0.00 will result in a zero value for the Improvement/Section. 

Func Obsl: Functional Obsolescence is a numerical assignment representing the appraiser's judgment of the % 
good with regards to functional obsolescence. For example, an Improvement/Section determined by the appraiser 
to have functionally depreciated by 20% would be 80% good, and .80 would be keyed in the Functional 
Obsolescence field. The range can be from .01 to 9.99. The default is 1.00. There must be an entry in the 
Functional Obsolescence field.  A value of 0.00 will result in a zero value for the Improvement/Section. 

Other Fact: Any other appraiser determined factor that should be applied to the Improvement/ Section can be 
keyed in this field. The range can be from .01 to 9.99. The default is 1.00. There must be an entry in the Other 
Factors field. A value of 0.00 will result in a zero value for the Improvement/Section. 

Pct Comp: The Percent Complete field represents the % completed status of the Improvement/Section. If 
construction on the Improvement/Section is finished, it is 100% complete. If it is not 100% completed, the value 
keyed in this field is the appraiser's determination of how complete the Improvement/Section's structure is. The 
range can be from .01 to 1.00. The default is 1.00. There must be an entry in the Percent Complete field. A value of 
0.00 will result in a zero value for the Improvement/Section; a value greater than 1.00 will be converted to 1.00. 

Neighborhood: The Neighborhood Factor is used to calculate the Structure Value of the Commercial Improvement. 
The Neighborhood Factor that displays in this field is determined by the Neighborhood for the Parcel as selected 
on the Real Property General Information Form and the Factor for the Commercial Improvement for this 
Neighborhood as defined in the Neighborhood Schedule (Tools > Schedules/Tables > Neighborhoods). If no 
Neighborhood is defined, a 1.00 will display as the Factor. Neighborhood Factors can be applied against 
Commercial Improvements, Urban Land, Rural Land, Commercial Improvements, and Accessory Buildings. The 
value represents percent good and is multiplicative. Example: if the Neighborhood Factor for Commercial 
Improvements for this Parcel's Neighborhood is 1.10, the Section Value will be ((1.10 x [Structure Value]) + [Extra 
Features Value]) x [Identical Units]). The Neighborhood Factor can range from .01 to 9.99. 

 

VALUE INFORMATION 

 

The Values section is divided into two columns: the Fair Market Values column, and the MAV Button/Fields 
column.  

 

Fair Market Values 
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Structure: The WinGAP calculated value of this Improvement/Section will display in this field. The Structure value 
may be different from the Section value, and it may also be different from the Improvement Value. 

Extra Features: The WinGAP calculated value of any Extra Features, or appendages, for the Improvement/Section 
will display in this field. Extra Features are added by clicking on the Extra Features Button on the upper right of the 
Form. 

Identical Units: The number of Identical Units of this Improvement/Section. If other Sections of the Improvement 
are identical to this one, than the total number of Identical Units is keyed here, rather than adding another 
Improvement/Section. The default is 1, and the field only accepts values of 1 or greater. 

Section: The WinGAP calculated value of the Section, based upon the Structure Value, the Extra Features value, 
and the number of Identical Units. 

Override: The Override Value represents an assigned value for both the Commercial Improvement/Section and any 
Extra Features attached to the Improvement/Section. An entry in this field overrides all Commercial Improvement 
calculations for this Improvement/Section. 

Imp Value: The WinGAP calculated total Improvement Value of this Commercial Improvement, which includes all 
Sections, Extra Features, and Identical Units of the Improvement. 

 

MAV Button/Fields  

 

 

MAV Button and Fields: Below the MAV button are three fields that hold the WinGAP generated Moratorium 
Appraised Value for the following: 

• The MAV for the Commercial Improvement/Section. A value will display in the Commercial Improvement 
MAV field after the Apply button on the Commercial Improvements Form is clicked. The Structure MAV 
may be different from the Section MAV (discussed below). 

• The Extra Features MAV. A value will appear in this field after the Extra Features are added on the Extra 
Features Form and the user returns to the Commercial Improvements Form. 

• The Section MAV for this Section of the Commercial Improvement. A value will appear in the Section MAV 
field after the Apply button on the Commercial Improvements Form is clicked. 

 

Should the MAV for the Commercial Improvement need to be changed by the user, the MAV Button should be 
clicked to manually edit this value. The following should be noted when entering a value in this field: values keyed 
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via the MAV Buttons are not monitored, keyed MAV values are permanent only for that screen session, and any 
future changes to the property could modify MAV. 

 

MAV Ovr Checkbox: To the right of the MAV Button is the MAV Ovr Checkbox. When a check is placed in this box, 
the value in the MAV Structure field will be treated as an override for the Commercial Improvement Structure 
Value. All calculations for the Structure Value will be suspended until the check is removed.  

 

Other Value Fields/Pricing Button 

 

Pricing Button: To the right of the Improvement Value field is the Pricing Button. This Button can be clicked to 
display the Commercial Improvements calculations summary for this Improvement/Section. This information is 
discussed in the Commercial Improvements Calculations Summary section. 

Ovr Rsn: If an Override Value is entered, a reason for the Override must also be selected. Override Reasons are set 
up in Tools > Schedules/Tables > Override Reasons. 

Ovr Date: If an Override Value is assigned to this Improvement/Section, the date the override was applied should 
be keyed in this field. 

Last Calc: If a change is made to any of the Improvement/Section information that affects the value, the Last Calc 
field will display the previous calculated Improvement/Section value, and the Imp Value field will display the new 
calculated value. However, once the Apply Button is clicked and the user remains on the Commercial 
Improvements Form, or clicks the OK Button and leaves the Form, the new Improvement/Section value will display 
in both the Last Calc and Imp Value fields on the Commercial Improvements Form. 

 

PLUMBING (DESCRIPTIVE ONLY) 

 

Plumbing entries in these six fields have no effect on value. Plumbing must be entered as an Extra Feature to have 
an impact on value. 

 

One Fixture: The number of Bathrooms with one Plumbing Fixture is keyed in this field. The range is 0 to 999. 

Two Fixture: The number of Bathrooms with two Plumbing Fixtures is keyed in this field. The range is 0 to 999. 

Three Fixture: The number of Bathrooms with three Plumbing Fixtures is keyed in this field. The range is 0 to 999. 

Bath/Kitchen: The number of Bathroom/Kitchen combinations is keyed in this field. The range is 0 to 999. 

1.5 Bath/Kitchen: The number of 1.5 Bathroom/Kitchen combinations is keyed in this field. The range is 0 to 999. 

2.0 Bath/Kitchen: The number of 2.0 Bathroom/Kitchen combinations is keyed in this field. The range is 0 to 999. 

 

HOMESTEAD 

 

State Homestead: If the Commercial Improvement qualifies for the State Homestead Exemption, a checkmark 
should be placed in this checkbox. The checkbox will not be enabled unless the Homestead Code assigned to this 
parcel has been designated as a State Homestead. The value of all Commercial Improvements on the parcel 
designated for the State Homestead will be summed and placed in the field in Realprop called statehsval. If the 
parcel is less than or equal to 10 acres, the value of the land will be added to the homestead improvement total 
and placed in the statehsval field. If the parcel is greater than 10 acres, a per acre value will be obtained (land 
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value divided by total acres) and multiplied by 10 to obtain the land value eligible for the new State Homestead. 
The flags and values will be passed to the digest vendors for processing the exemption. Procedures are in place to 
remove flags and value when the homestead is changed to a code that is not designated as 65 and Older State 
Homestead Code. 

Local Homestead: If the Commercial Improvement qualifies for the Local Homestead Exemption, a checkmark 
should be placed in this checkbox. The checkbox will not be enabled unless the Homestead Code assigned to this 
parcel has been designated as a Local Homestead. 

 

COMMENTS/APPRAISER 

 

In the Comments section, unlimited comments about the Commercial Improvement can be entered. The Appraiser 
field is where the Commercial Improvement field appraiser can be selected from the Appraiser combo box, or the 
Appraiser's name can be keyed into the combo box field. 

 

STREET INFO 

 

House No: The House No field is where the street number of the Commercial Improvement is keyed. 

Ext: If the street address contains an extension such as A, 1/2, etc., it should be keyed here. 

Dir: The direction (North, Southeast, etc.) of the street. 

Units: The Unit Number of the property, sometimes used by Apartments and Condominiums. Examples would be 
Unit 5, Apartment A, etc. 

Street Name: The name of the Street or Road where the improvement is located. 25 characters of information can 
be keyed into the field. 

Type: The Type of Street, such as Road, Drive, Hwy, Lane, etc., is keyed here. 

Quad: The post-direction used in addressing, such as 4888 Peachtree St. NW. The NW is the post-direction. 

 

COMMERCIAL IMPROVEMENTS FORM ACCESS BUTTONS 

 

Structure Details: The Structure Details Button takes the user to the Commercial Improvement Details Form, 
where detailed information about the construction of the Improvement/Section, such as foundation, roof cover, 
and wiring can be entered. The procedures for entering Structural Detail information are discussed in the 
Commercial Improvement Details Form section of this manual. 

Extra Features Button: The Extra features Button takes the user to the Commercial Extra Features Form, where 
detailed information about the Extra Features of the Improvement/Section, such as loading docks, canopies, and 
sprinklers can be entered. The procedures for entering Extra Features information are covered in the Commercial 
Extra Features Form section. 

No Sketch/Sketch Button: The No Sketch/Sketch Button takes the user to the WinGAP Sketching Module, where 
heated areas, appendages, and site improvements can be sketched and labeled. Sketching and labeling procedures 
are covered in the Sketching Module section. If the Area and Perimeter are keyed, and the Story Height selected 
using its combo box, and the Commercial Improvement/Section saved by clicking Apply, the Sketch/No Sketch 
button will read No Sketch. Once the Sketching Module has been used to draw sketches, and sketch data exists for 
the Commercial Improvement, the No Sketch/Sketch button will read Sketch. 
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If the Improvement/Section Area and Perimeter values were not entered in their respective fields on the 
Commercial Improvements Form, the No Sketch Button MUST be clicked to access the Sketching Module and draw 
the Improvement/Section. Otherwise, the Improvement/Section will not have any Structure or Section Values 
because the necessary square footage and perimeter values needed to perform value calculations are non-
existent. Sketching Procedures are covered in the Sketching Module section of this manual. 

 

Photo Button: Right clicking this button opens a contextual menu that allows you to select from several options. 

 

Clicking the “Load Digital Photo” option will open a window where the user can navigate to a picture and load it to 
the WinGAPSQL folder on the server. A new folder will be created in the WinGAP photo folder on the server with 
the prefix “c” for commercial followed by the commkey assigned by Wingap, and the photo will be named the 
same. This is the primary photo for the property. 

 

 

Selecting the Load Additional Photos option will open a new menu that will append more information to the 
photo. Typing in the Data box will add that information to the picture name, for instance “loadingdock” would 
name the photo for a property with the commkey 3 “c3_loadingdock”. Selecting one of the checkboxes will quickly 
append that information to the photo so the user does not have to type it themselves. The user will then navigate 
to where the picture is on their computer and WinGAP will copy it to the server and name it according to the 
above naming convention. 

 

Selecting “Delete Current Photo” will delete the main appeal photo, while selecting “Delete Additional Photos” will 
open the pictures folder for this record where the user can manually select which photos to delete.  

 

New Section: The New Section Button will produce another Commercial Improvements Form where a new Section 
can be added to this Improvement. WinGAP will sequence the Section numbers and display the new number in the 
Section field at the top of the Form. The Improvement Number will remain the same (additional Commercial 
Improvements on the same Parcel are added by clicking the New Button at the bottom of the Commercial 
Improvements Form). The Construction Type and Life Expectancy fields will default to those of the last Section 
added to the Improvement. All other data entry fields will require new information about the new Section that is 
being added. At the conclusion of entering information about the new Section, the user should click the Apply 
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Button at the bottom of the Commercial Improvements Form to make sure that all data entry for the new Section 
is saved before proceeding to other tasks, such as sketching or adding structural information for this Section. If no 
other tasks are to be performed on this Section, the OK Button may be clicked in lieu of the Apply Button to save 
the information and close the screen. 

Schedules Button: This opens the Commercial Improvements Schedule form. More information on these schedules 
is covered in the Tools > Schedules/Tables > Commercial Improvements section. 

 

COMMERCIAL IMPROVEMENT DETAILS FORM 

 

The Commercial Improvement Details Form is used to add, edit, or remove the structural details of any 
Commercial Improvements on the Parcel. The Structure Details Button on the top right of the Commercial 
Improvements Form is used to access this Form. Depending on the setup of the Commercial Schedules, the 
Commercial Improvements Details Form can be used to add just descriptive information about the Commercial 
Improvement, or to add or deduct value for the Details. 

 

 

Up to twelve different Structural Details, such as Foundation, Wall Frame, and Exterior Walls, etc. can be identified 
for each Improvement/Section. Each Detail has a certain number of default Descriptions: Foundation, for example, 
has Descriptions such as Concrete Column Footing, Concrete Wall, Piers, and Slab Perimeter Footing. 

 

By using the combo boxes and fields in the three sections of the Form, called Structural Info 1, Structural Info 2, 
and Structural Info 3, a Structural Detail can be assigned up to three different Descriptions with an accompanying 
percent of the Improvement/Section covered by that Description, as well as the Quality Class of that Description. 
Regardless of whether a Detail has one, two, or three Descriptions, the total for all must equal 100%. 

 

The Descriptions for each Commercial Improvement Detail are setup in Tools > Schedules/Tables > Commercial 
Improvements > Structural Elements. Additions, changes, or deletions can be made to these Descriptions in this 
schedule.  
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Description: Every Structural Detail has a set of Descriptions unique to that Detail. At least one Description for 
every Detail must be selected unless the Structural Detail does not exist in the Improvement/Section, in which case 
the default blank Description can be selected. 

%: The percent of the Improvement/Section covered by the Detail and associated Description is keyed in this field. 
For example, an Improvement/Section has an area of 2000 square feet. If the entire area is supported by Concrete 
Wall, the user should key 100 for 100 percent coverage. However, if only 1000 square feet of the 
Improvement/Section is supported by Concrete Wall, the percent should be entered as 50 (1000/2000 = .50) with 
no decimal point. If the percent entered in the % field in the Structural Info 1 is less than 100, the user will be 
forced to select a second Description for the Detail and accompanying percent and Quality Class in the Structural 
Info 2 section of the Form. The % field in the Structural Info 2 section will display the difference between 100 and 
the percent entered in the Structural Info 1 section of the Form. If the total percent of the Improvement/Section 
covered by the Detail is still not 100 percent after the Structural Info 2 section of the form is completed, WinGAP 
will calculate the remaining percentage, place it in the % field in Structural Info 3 section of the Form, and take the 
user to the Structural Info 3 Description field, where the correct Description can be selected along with its Quality 
Class. The total of all Descriptions for a Detail must equal 100%. The % field in the Structural Info 3 section of the 
Form cannot be accessed by the user. 

QC: QC refers to the Quality Class of the Detail/Description. Quality Classes can be used to add or subtract value 
for a particular Commercial Structural Component and are set up in Tools > Schedules/Tables > Commercial 
Improvements > Structural Elements.  

 

Once the Description, %, and Quality Class for all applicable Structural Details have been selected, the user can 
click the Apply Button at the bottom of the Commercial Improvement Details Form to make sure that all data entry 
for the Improvement/Section is saved. Clicking OK will return the user to the Commercial Improvements form. 

 

 

COMMERCIAL EXTRA FEATURES FORM 

 

The Commercial Extra Features Form is used to add, edit, or delete any Commercial Extra Features. Extra Features 
are items that are attached to or are part of a Commercial Improvement but are not considered in the Base Cost of 
the Improvement. For example, a Canopy, Sprinkler System, Overhead Door, or Loading Dock would all be 
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considered Extra Features. The Extra Features Button on the upper right of the Commercial Improvements Form is 
used to access the Extra Features Form. The Commercial Improvement must first be added before the Extra 
Features Button will be enabled. 

 

 

NOTE: The Commercial Improvement should either be sketched, or an Area, Perimeter, and Story Height entered 
manually, before Commercial Extra Features are added to the Improvement. If this is not done, and the 
Commercial Improvement does not have a Calculated Physical Depreciation, the user will receive a message when 
clicking the Extra Features button that the "Parent Section does not have a Calculated Depreciation. Extra Features 
will not calculate". 

 

Description: Clicking on the combo box in the Description field produces a listing of Commercial Extra Features. An 
item from this list MUST be selected to add an Extra Feature. The Extra Feature items that display in the list are 
based upon those set up in the Commercial Extra Features Schedule found in Tools > Schedules/Tables > 
Commercial Improvements > Extra Features. 

Width: In most cases, particularly when the Extra Feature is valued by the square foot, the width of the Extra 
Feature in feet is entered in this field. When the Extra Feature is valued by the unit method, the number entered in 
the Width field will depend on how the Extra Feature is set up in the Extra Features Schedule. For example, the 
number could represent the fire rating, in hours, of a Bank Vault Door. 

Length: As in the Width field, particularly when the Extra Feature is valued by the square foot, the length of the 
Extra Feature in feet is entered in this field. When the Extra Feature is valued by the unit method, the number 
entered in the Width field will again depend on how the Extra Feature is set up in the Extra Features Schedule. For 
the example of the Bank Vault Door, the number would be 0. 
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Calc Area: If the length and width of the Extra Feature are entered and the user Tabs to the Ovr Area/Units field, 
WinGAP will calculate the area and place the value in this field. The Calculated Area field is not accessible to the 
user. 

OVR Area/Units: If the Extra Feature is valued by the square foot but is not square or rectangular, the appraiser 
calculated square footage can be entered here. When the Extra Feature is valued by the unit method, the number 
entered in the OVR Area/Units field will depend on how the Extra Feature is set up in the Extra Features Schedule. 
For the example of the Bank Vault Door, the number would be 1 (one) for the Number of Units, in this case one 
Bank Vault Door. 

Identical Units: The number of Identical Units of this Extra Feature is keyed here. If other Extra Features attached 
to this Commercial Improvement are identical to the one being added, than the total number of Identical Units is 
keyed here rather than adding another Extra Feature. For example, if there are 2 Loading Docks of identical size, 
year built, and rank, then 2 would be keyed in the Identical Units field. The default is 0 and should remain that for 
only 1 Extra Feature. 

Year Built: If known, the year the Extra Feature was built is entered in this field. The Year Built field defaults to the 
system year minus one year. 

Rank: Rank represents the quality of the Extra Feature when compared to the primary structure, or Commercial 
Improvement. Ranks for Extra Features are set up in Tools > Schedules/Tables > Commercial Improvements > Rank. 
The range is normally from Poor to Excellent. A Rank must be selected to calculate the Value of the Extra Feature. 
If desired, a Rank of “No Value” can be added to the Commercial Rank schedule, and that item selected from the 
Rank list. 

Phy Depr Ovr: The Physical Depreciation Override field is used to override the calculated Physical Depreciation 
performed by WinGAP. The field defaults to 0.00 (zero) and should remain at this value unless the appraiser wishes 
to apply a set Physical Depreciation for the Extra Feature. 

Func Obsl: Functional Obsolescence is a numerical assignment representing the appraiser's judgment of the % 
good with regards to Functional Obsolescence. For example, an Extra Feature determined by the appraiser to have 
functionally depreciated by 20% would be 80% good, and .80 would be keyed in the Func Obsl field. The range can 
be from .01 to 9.99. The default is 1.00. There must be an entry in the Functional Obsolescence field. A value of 
0.00 will result in a zero value for the Extra Feature. 

Other: The Other Factor that is assigned to the Commercial Improvement/Section that this Extra Feature is 
attached to is brought forward and placed in this field. This field is not accessible to the user. 

Calc Depr: The WinGAP calculated Physical Depreciation displays in this field. The Physical Depreciation will display 
even if there is an entry in the Phy Depr Ovr field. The Calc Depr field is not accessible to the user. 

Econ Obsl: Economic Obsolescence is a numerical assignment representing the appraiser's judgment of how the 
economic area that the Commercial Improvement/Extra Feature is in has affected the value of the Extra Feature. 
The range can be from .01 to 9.99. The default is 1.00. There must be an entry in the Economic Obsolescence field. 
A value of 0.00 will result in a zero value for the Extra Feature. If the Improvement/Section has been assigned an 
Econ Obsl factor, the Extra Feature will inherit the same factor. 

Perc Comp: The Percent Complete field represents the % completed status of the Extra Feature. If construction on 
the Extra Feature is finished, it is 100% complete. If it is not 100% completed, the value keyed in this field is the 
appraiser's determination of how complete the Extra Feature's structure is. The range can be from .01 to 1.00. The 
default is 1.00. There must be an entry in the Percent Complete field. 

Neighborhood: The Neighborhood factor is used to produce the Calculated value of the Extra Feature. The 
Neighborhood factor that displays in this field is determined by the Neighborhood for the Parcel as selected on the 
Real Property General Information Form and the factor for the Commercial Improvement for this Neighborhood as 
defined in the Neighborhood Schedule (Tools > Schedules/Tables > Neighborhoods). If no Neighborhood is defined, 
a 1.00 will display as the factor. Neighborhood factors can be applied against Residential Improvements, Urban 
Land, Rural Land, Commercial Improvements, and Accessory Improvements. The value represents percent good 
and is multiplicative. Example: if the Neighborhood factor for Commercial Improvements for this Parcel's 



 
840 

Neighborhood is 1.10, the calculated value of any Extra Features will be 110% of the WinGAP calculated value prior 
to applying the Neighborhood factor. The Neighborhood factor can range from .01 to 9.99. 

Calculated: The WinGAP calculated value of this Extra Feature will display in this field. 

Override: The Override Value represents an assigned value for the Extra Feature. An entry in this field overrides all 
WinGAP calculations for this Extra Feature. 

MAV: The MAV field holds the WinGAP generated Moratorium Appraised Value for the Extra Feature. The MAV 
value will appear in the field after the Apply button is clicked. Should this value need to be changed by the user, 
the MAV Button should be clicked to manually edit this value. The following should be noted when entering a 
value in this field: values keyed via the MAV Buttons are not monitored, keyed MAV values are permanent only for 
that screen session, and any future changes to the property could modify MAV. 

MAV Ovr Checkbox: To the right of the MAV Button is the MAV Ovr Checkbox. When a check is placed in this box, 
the value in the MAV field will be treated as an override for the Extra Feature Value. All calculations for the Extra 
Feature Value will be suspended until the check is removed. 

Last Calc: If a change is made to any of the Extra Feature information that affects the value, the Last Calc field will 
display the previous calculated Extra Feature value, and the Calculated value field will display the new calculated 
value. However, once the Apply Button is clicked and the user remains on the Extra Features Form, or clicks the OK 
Button and leaves the Form, the new Extra Feature value will display in both the Last Calc and Calculated value 
fields on the Extra Features Form. 

Photo Button: Digital photos of this Extra Feature can be attached by right-clicking on the Photo Button. These 
procedures are discussed in the Commercial Improvement section. 

Edit History: This button is used to view the Edit History of this Extra Feature record. The Edit Log keeps a record of 
virtually every user-initiated operation that changes a record in WinGAP. Information about this feature is 
discussed in the Real Property General Information form section. 

Comments: In the Comments section, unlimited comments about the Commercial Improvement can be entered. 

Appraiser: The Appraiser field is where the Commercial Extra Feature field appraiser can be selected from the 
Appraiser combo box, or the Appraiser's name can be keyed into the combo box field. 

 

An Extra Feature can be edited by clicking on the desired item in the list box on the Extra Features Form, clicking 
on the appropriate field and changing the data, then clicking the Apply Button. An Extra Feature can be deleted by 
clicking on the desired item in the list box on the Extra Feature Form, then clicking the Delete Button at the bottom 
of the Form. The message "Are you sure you want to delete this record?" will appear. Clicking the Yes Button will 
delete the record; clicking on the No Button will cancel the deletion of the record. 

 

 

COMMERCIAL IMPROVEMENTS CALCULATION SUMMARY FORM  

The Commercial Improvements Calculation Summary Form, also called the Commercial Pricing Form, is reached by 
clicking on the Pricing Button located in the center of the Commercial Improvements Form, in the Values section 
next to the Improvement Value field. The Pricing Form displays important summary Points and Value information 
for each Improvement/Section on the Parcel. If a Parcel has multiple Improvements/Sections, you must click the 
Apply Button after selecting each Improvement/Section before you click the Points Button for the Points and 
Values information for that Improvement/Section to display. 
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ACCESSORIES FORM 

The Accessories Form is used to add, edit, or delete any Accessory Improvements on the Parcel. The Acc Imp 
Button to the left of the Acc Imp FMV and MAV fields on the Real Property General Information Form is used to 
access this Form. 

 

 

If one or more Accessory Improvements exist on the Parcel, the Acc Imp button on the Real Property General 
Information Form will have a number on it in parentheses, such as (5) in the example above, and clicking this 
button takes the user to the first Accessory Improvement on the Parcel. If no Accessory Improvements exist on the 
Parcel, no number will display in parentheses on the Acc Imp button. Clicking on the Acc Imp button takes the user 
to a "grayed out" Accessory Improvements Form where the New button must be clicked to add the first Accessory 
Improvement to the Parcel. There is no limit to the number of Accessory Improvements that a Parcel can have. 
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AccKey: The AccKey, or Accessory Key, is created by WinGAP for each new Accessory Improvement that is added. 
This field is not accessible to the user. 

Class: The Digest Classification for the Accessory Improvement, such as Agricultural. The Class field for a new 
Accessory Improvement will default to Agricultural ("A") if the Land Digest Class is "A", "V", "P" or "W"; it will 
default to Residential ("R") if the Land Digest Class is "R"; it will default to Commercial ("C") if the Land Digest Class 
is "C"; it will default to "I" if the Land Digest Class is "I"; and it will default to the Land Digest Class if the Land Digest 
Class is "E". The user can change from the default Class if necessary. NOTE: If an Accessory Improvement is added 
or edited and assigned a Digest Class of Conservation Use a message will appear reminding the user to proceed to 
the Conservation Use form where the new accessory value can be included in the total CU value and all value 
change limits can be monitored. 
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Strat: The Digest Stratification for the Accessory Improvement, such as Production/Storage. The Strat field for a 
new Accessory Improvement will default to 6, unless the Land Class is "R", "C". or "I", in which case the Strat will 
default to "1", or unless the Land Digest Class is "E", in which case the Strat will default to the Land Digest Strat. As 
in Class, the user can change from the default Strat, if necessary. 

Description: Clicking on the combo box in the Description field produces a list of items from the Accessory Building 
Schedule. An item from this schedule must be selected to add an Accessory Improvement. The Accessory items 
that display in the list are based upon those set up in the Accessory Building Schedule found in Tools > 
Schedules/Tables > Accessories > Building Schedule. 

Width: In most cases, especially when the Accessory Improvement is valued by the square foot, the width of the 
Accessory Improvement in feet is entered in this field. When the Accessory is valued by the unit or lump sum 
method, the number entered in the Width field will depend on how the Accessory Schedules are set up. For 
example, the number can represent the height, such as a Grain Storage Bin. 

Length: As in the Width field, especially when the Accessory Improvement is valued by the square foot, the length 
of the Accessory Improvement in feet is entered in this field. When the Accessory is valued by the unit method, the 
number entered in the Width field will depend on how the Accessory Schedules are set up. For example, the 
number can represent the diameter, the height, or the thickness of an accessory. 

Calc Area: If the length and width of the Accessory Improvement are entered, WinGAP will calculate the area and 
place the value in this field. The Calculated Area field is not accessible to the user. 

OVR Area/Units: If the Accessory Improvement is an odd-shaped structure, not square or rectangular, the 
appraiser calculated area can be keyed in this field. When the Accessory Improvement is valued by the lump sum 
method, the number entered in this field will depend on the way the Accessory Lump Sum Schedules are set up. 
The field will accept two decimal places. 

Identical Units: The number of Identical Units of this Accessory Improvement. If other Accessory Improvements on 
the Parcel are identical to the one being added, the total number of Identical Units is keyed here rather than 
adding another Improvement. For example, if there are 3 Barns of identical size, year built, and grade on the 
Parcel, then 3 would be keyed in the Identical Units field. The default is 0, and should remain that for a single 
Accessory Improvement. 

Year Built: If known, the year the Accessory Improvement was built is entered in this field. The Year Built field 
defaults to the system year minus one year. 

EFYR: The Effective Year Built is used only when the condition of the Accessory Improvement reflects something 
different than should be present based on the original year of construction. The Eff Year Built field can be used to 
effectively increase or decrease the age of the Accessory. When present, the Effective Year Built is used in 
calculating the Physical Depreciation Factor and determining the Accessory’s Calculated Value. 

Grade: The Grade is a numerical assignment representing the quality of materials and workmanship for the 
Accessory Improvement. The appraiser is responsible for assigning the Grade, and the range can be from 1 to 999. 
No decimal is used in data entry. The Grade is used in calculating the Physical Depreciation Factor of the 
Improvement. 

Phy Depr Ovr: The Physical Depreciation Override field is used to override the calculated Physical Depreciation 
performed by WinGAP. The field defaults to 0.00 (zero) and should remain at this value unless the appraiser wishes 
to apply a set Physical Depreciation for the Accessory Improvement. 

Func Obsl: Functional Obsolescence is a numerical assignment representing the appraiser's judgment of the % 
good with regards to Functional Obsolescence. For example, an Accessory Improvement determined by the 
appraiser to have functionally depreciated by 20% would be 80% good, and .80 would be keyed in the Func Obsl 
field. The range can be from .01 to 9.99. The default is 1.00. There must be an entry in the Functional 
Obsolescence field. A value of 0.00 will result in a $0 improvement value. 

Calc Depr: The WinGAP calculated Physical Depreciation for the Accessory Improvement displays in this field. It is 
based upon the Grade and the Year Built. The Physical Depreciation will display even if there is an entry in the Phy 
Depr Ovr field. The Calc Depr field is not accessible to the user. 
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Perc Comp: The Percent Complete field represents the % completed status of the Accessory Improvement. If 
construction on the Accessory Improvement is finished, it is 100% complete. If it is not 100% completed, the value 
keyed in this field is the appraiser's determination of how complete the structure of the Accessory Improvement is. 
The range can be from .01 to 1.00. The default is 1.00. There must be an entry in the Percent Complete field. A 
value of 0.00 will result in a $0 improvement value. 

Neighborhood: The Neighborhood factor is used to produce the Calculated Value of the Accessory Improvement. 
The Neighborhood factor that displays in this field is determined by the Neighborhood for the Parcel as selected on 
the Real Property General Information Form and the factor for the Accessory Improvement for the Neighborhood, 
as defined in the Neighborhood Schedule (Tools > Schedules/Tables > Neighborhoods). If no Neighborhood is 
defined, a 1.00 will display as the factor. Neighborhood factors can be applied against Commercial Improvements, 
Urban Land, Rural Land, Commercial Improvements, and Accessory Improvements. The value represents percent 
good and is multiplicative. Example: if the Neighborhood factor for Accessory Improvements for this Parcel's 
Neighborhood is 1.10, the Calculated Value of any Accessory Improvements will be 110% of the WinGAP calculated 
value prior to applying the Neighborhood factor. The Neighborhood factor can range from .01 to 9.99. 

Calculated: The WinGAP calculated value of this Accessory Improvement will display in this field. 

Override: The Override Value represents an assigned value for the Accessory Improvement. An entry in this field 
overrides all WinGAP calculations for this Accessory. 

MAV: The MAV field holds the WinGAP generated Moratorium Appraised Value for the Accessory Improvement. 
The MAV value will appear in the field after the Apply button is clicked. Should this value need to be changed by 
the user, the MAV Button should be clicked to manually edit this value. The following should be noted when 
entering a value in this field: values keyed via the MAV Buttons are not monitored, keyed MAV values are 
permanent only for that screen session, any future changes to the property could modify MAV. 

MAV Ovr Checkbox: To the right of the MAV Button is the MAV Ovr Checkbox. When a check is placed in this box, 
the value in the MAV field will be treated as an override for the Accessory Improvement Value. All calculations for 
this Accessory Improvement Value will be suspended until the check is removed. 

Last Calc: If a change is made to any of the Accessory Improvement information that affects the value, the Last 
Calc field will display the previous calculated Accessory value, and the Calculated value field will display the new 
calculated value. However, once the Apply Button is clicked and the user remains on the Accessories Form, or 
clicks the OK Button and leaves the Form, the new Accessory Improvement value will display in both the Last Calc 
and Calculated value fields on the Accessories Form. 

Comments: Unlimited comments about the Accessory Improvement can be entered in this field. 

Appraiser: The Accessory Improvement field appraiser can be selected from the Appraiser combo box, or the 
Appraiser's name can be keyed into the combo box field. 

State Homestead: If the Accessory Improvement qualifies for the State Homestead Exemption, a checkmark 
should be placed in this checkbox, located on the lower left of the Accessory Improvements form. The checkbox 
will not be enabled unless the Homestead Code assigned to this parcel has been designated as a State Homestead. 
The value of all Accessory Improvements on the parcel designated for the State Homestead will be summed and 
placed in the field in Realprop called statehsval. If the parcel is less than or equal to 10 acres, the value of the land 
will be added to the homestead improvement total and placed in the statehsval field. If the parcel is greater than 
10 acres, a per acre value will be obtained (land value divided by total acres) and multiplied by 10 to obtain the 
land value eligible for the new State Homestead. The flags and values will be passed to the digest vendors for 
processing the exemption. Procedures are in place to remove flags and value when the homestead is changed to a 
code that is not designated as a 65 and Older State Homestead Code. 

Local Homestead: If the Accessory Improvement qualifies for the Local Homestead Exemption, a checkmark should 
be placed in this checkbox, located on the lower left of the Accessory Improvements form. The checkbox will not 
be enabled unless the Homestead Code assigned to this parcel has been designated as a Local Homestead. The 
flags and values will be passed to the digest vendors for processing the exemption.  
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Photo Button: Digital photos of this Accessory Improvement can be attached by right-clicking on the Photo Button. 
These procedures are discussed in the Real Property General Information form section. 

Edit History: This button is used to view the Edit History of this Accessory Improvement record. The Edit Log keeps 
a record of virtually every user-initiated operation that changes a record in WinGAP. Information about this 
feature is discussed in the Real Property General Information form section. 

 

An Accessory Improvement can be edited by clicking on the desired item in the list box on the Accessories Form, 
clicking on the appropriate field and changing the data, then clicking the Apply Button. An Accessory Improvement 
can be deleted by clicking on the desired item in the list box on the Accessories Form, then clicking the Delete 
Button at the bottom of the Form. The message "Are you sure you want to delete this record?" will appear. 
Clicking the Yes Button will delete the record; clicking on the No Button will cancel the deletion of the record. 

 

 

 

SALES INFORMATION FORM 

The WinGAP Sales Information Form is used to add, edit, or delete any Sales for the Parcel. The Form is accessed 
by clicking the Sales Button located on the right side of the Real Property General Information Form. Clicking on 
the Sales button will produce the Sales Information form, which will be "grayed out" if this is the first Sale on the 
Parcel. If Sales exist on the Parcel, the Sales Button will display the number of Sales to the right of the word 
"Sales". Clicking on the Sales button will display the existing Sales, with the most recent Sale at the top of the list 
box. 
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The Title Bar at the top of the Form displays the Parcel Number. The Parcel Owner's Name, Parcel #, and Sales Key 
are also displayed in fields below the Title Bar. These fields are not accessible to the user. The Load Image Button 
to the right of the Sales Key field allows the user to load and view an image of the deed associated with this sale. 
The list box in the top center of the Form will display any Sales already entered for this Parcel. 

 

Sales Information is usually entered directly from a copy of the property deed associated with the sale obtained 
from the office of the Clerk of Superior Court. As Sales are added, they will be displayed in the list box in 
descending date order (most recent sale at the top). There is no limit to the number of Sales that can be added to a 
Parcel, and all sales are eligible to be used in any Ratio Studies that may be run. 

 

Buyer: The Buyer, also known as the Grantee, is the individual that purchased the property. The current Owner's 
name will appear in this field. 

Seller: The Seller, also known as the Grantor, is the party that sells the property. If this is the first sale added to this 
property, the field will be blank. If prior sales exist on this Parcel, the Buyer's name from the prior sale will appear 
in this field. If the name is to be changed, or keyed into the blank field, it should be entered in the following 
format: Lastname Firstname. 

PT -61 #: The PT-61 # is a unique identifier that will be assigned to each PT61 that is recorded. The last 6 digits of 
the number can be entered by the user, but it will also be passed into the field when processing an e-filed PT61. 
The format of the PT61 number is as follows: 

 

|PT-61 |000-|2021-|000001 

 

The first 6 positions will always be PT-61 followed by a space. Following the space within the next 4 positions will 
be the county number and a dash. The next 5 positions will contain the year in which the PT61 was filed and a 
dash. The final 6 positions hold a sequential number that is assigned to each PT61 filed within the year within the 
county. 

 

NOTE: The year portion of the PT-61 number can be changed by right clicking on the “grayed out” portion of the 
PT-61 number (first 11 positions) and selecting the option “Edit PT-61 Control Number”. If errors have been made 
and the user wishes to reset the PT-61 number back to the default settings, the user should select the option 
“Reset PT-61 Control Number to Default Template Value” from the right-click menu. 

 

Sale Date: The Sale Date is the date that the property was sold to the Buyer. The date can be keyed directly into 
the field, or the calendar to the right of the field can be used to insert the date.  

RETT: The amount listed on the PT-61 as the Real Estate Transfer Tax for this Sale. 

Deed Book/Page: The Deed Book and Page number that contains the deed for the Parcel, located in the office of 
the Clerk of Superior Court. 

Plat Book/Page: The plat book and page number that contains the original plat for the Parcel, located in the office 
of the Clerk of Superior Court. 

Sale Price: The price that the Buyer paid to the Seller for the property. The Sale Price is entered in dollars (no 
cents, commas, or decimals). WinGAP will insert the comma if the amount is $1,000 or more. The maximum sales 
price allowed is $99,999,999,999. 

Adjustment: This is the total value of items to be subtracted from the sales price to yield the Net Sales Price. It is 
the sum of the four adjustment fields below it and is not directly editable by the user. 
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Timber Adj: An appraiser-assigned Adjustment value for a timber value associated with the Sale. 

Multi Pin Adj: An appraiser-assigned Adjustment value for the value of all other parcels associated with a multi-
parcel Sale. 

Pers Adj: An appraiser-assigned Adjustment value for any personal property associated with the Sale. 

Other Adj: An appraiser-assigned Adjustment value for anything besides timber, personal property, or multi-parcel 
adjustments associated with the Sale. The user should place a note in the Comments field for this Sale, referencing 
what the Adjustment is for. 

State (Y/N): The State field is used to designate if a Sale will be included in the State Audit Department ratio study. 
An entry of "Y" (Yes) indicates that the sale will be included; an entry of "N" excludes the sale.  

FMV: The Fair Market Value of the Parcel at the time of the Sale, or as determined by the appraiser. The FMV is 
entered in dollars (no cents, commas, or decimals). WinGAP will insert the comma if the amount is $1,000 or more. 
An amount would be entered here if the property was modified after the sale and the user desired to maintain the 
sale as a “good” sale. If a value is placed in Fair Market Value, it may be used in a Sales Ratio Analysis at the 
discretion of the user. 

MAVVAL: The Moratorium Appraised Value at the time of the Sale, or as determined by the appraiser. The MAV is 
entered in dollars (no cents, commas, or decimals). WinGAP will insert the comma if the amount is $1,000 or more. 
An amount would be entered here if the property was modified after the sale and the user desired to maintain the 
sale in the bank of “good” sales. If a value is placed in the MAV field, it may be used in a Sales Ratio Analysis at the 
discretion of the user. 

Qualifier: The Sales Qualifier, usually the initials of the appraiser who has qualified the sale. 

Instrument: The type of Instrument, usually the Deed, certifying the sale. Common Instruments would be WD 
(Warranty Deed), LWD (Limited Warranty Deed), QC (Quit Claim Deed), SWD (Special Warranty Deed), COR 
(Corrective Deed), etc. 

Acres: The Deeded acreage recorded for the sale. 

Net Sale Price: The Sale Price minus all Adjustments. 

Class: The Sales Classification (the Digest Class) of the property at the time of Sale. The field will default to the 
Digest Class of the Land of the Parcel. 

Strat: The Sales Stratification of the property at the time of Sale. The field will default to Improved if a Residential 
or Commercial Improvement is present on the Parcel. The field will default to a blank Strat if no Improvements or 
only Accessory Improvements are present on the Parcel. 

• 1 = Improved 

• 2 = Public Utility 

• 3 = Vacant Lot 

• 4 = Vacant Small Tract 

• 5 = Large Parcel 

Vacant Land Sale: This box should be checked if the sale was for vacant land only. 

Real Estate Listing: Allows entry of real estate listings for additional analysis and insight while tracking and 
predicting the market. Real estate listings will be ignored when entering new sales and when WinGAP attempts to 
preload Grantor information. 

Reason: The Sales Reason that classifies the Sale as either qualified or non-qualified. The field defaults to a blank 
Reason. Two Reasons, Fair Market (qualified and improved) and Land Market (qualified and vacant) are used to 
indicate a good Sale. Any Reason other than Fair Market or Land Market may result in the Sale being excluded 
from a ratio study that is being run. The Reason combo box field can be clicked to display a list of all Sales Reasons 
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as set up in Tools > Schedules/Tables > Sales Reasons. NOTE: A valid Sales Reason must be selected before a Sales 
record can be saved. 

Assessment Reason: This box can be used to add Assessment Reasons to the parcel. See the Reap Property 
General Information Form for more information about Assessment Reasons. 

Comments: Unlimited comments or notes about the Sale can be entered here. 

Edit History: This button is used to view the Edit History of this sale record. The Edit Log keeps a record of virtually 
every user-initiated operation that changes a record in WinGAP. Information about this feature is discussed in the 
Real Property form section. 

 

Existing Sales are edited by clicking on the appropriate Sale in the list box and changing the desired information in 
the field(s) below the window. The user should click the Apply or OK Button to be sure that any changes are saved 
before editing another Sale or leaving the Sales Information Form. 

 

The Delete Button at the bottom of the Sales Information Form is used to delete a Sale. The Sale to be deleted 
should first be selected in the list box by clicking on that item. After clicking the Delete Button the message "Are 
you sure you want to delete this sale?" will appear, where the Yes Button can be clicked to delete the Sale; clicking 
on the No Button will cancel the deletion and return the user to the Sales Information Form. 

 

PROCESSING SB 346 SALES 

 

With the passage of Senate Bill 346 in 2010, when certain conditions are met, the value of a parcel cannot exceed 
the net sales price of the property. To comply with the law, WinGAP provides a means of handling the valuation 
process when a parcel’s condition matched the details of SB346. For a parcel to fall under the rules of SB 346, all of 
the following rules must be satisfied: 

• The sale must be an Arm’s Length Transaction. 

• The sale must occur one year prior to the digest/appraisal year. 

• The sale’s net sales price must be less than the appraised value of the property. 

 

When the sale of a parcel meets the above criteria, the value of the property can be no more than the net sales 
price for the year immediately following the sale. The full value of any new improvements will be added to the net 
sales price. When adding a sale that meets these criteria, WinGAP will notify the user that the parcel’s value will 
reflect the Net Sale Price. 
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Clicking OK on this message will return the user to the Real Property General Information form where the Sale 
Price will now be the value of the parcel. The Sale Price will appear in the Current Value field and a green “Sale” 
label will appear to the right of the field, showing that a SB346 sale exists on this parcel. 
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If the user places the mouse point over the green Sale label, a “tool tip” will appear that reflects the allocation of 
the Sales Price to the property components found on the parcel. The allocation percentage is based upon the 
following formulas: 

([Net Sales Price] / [Total Value]) x [Land] 

([Net Sales Price] / [Total Value]) x [Total Improvement] 
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When an improvement or a change in the land value occurs on a parcel, the display of the current parcel value and 
the Tool Tip values will change. In the example below, an Accessory Improvement valued at $23,900 is added to 
the parcel after the sale. The value of the new Accessory Improvement is added to the Sale Price value in the 
Current Value field, and the additional improvement value is allocated to the Imp2 portion of the Tool Tip. 

 

 

If the user returns to the Sales Information form on any parcel that has a SB 346 sale, views the SB 346 sale, and 
then tries to leave by clicking OK, a new message appears asking if the appraiser would like to reallocate the SB346 
sales price. 

 

 

The message is informing the user and giving them a choice: a No response keeps the existing SB 346 allocation as 
they were while a Yes response will change the SB 346 allocation when corrections to property characteristics 
which have resulted in value changes on property items that existed prior to the sale. 

 

Any time that a SB 346 sale is processed on a parcel, WinGAP will automatically add an Assessment Reason to the 
list of Assessment Reasons on the parcel. The new Assessment Reason will appear in the list as “Value adj for 1-
year Arms Length Transaction cap”. The list can be viewed by clicking the Asmt Reason button on the Real Property 
General Information form. This Assessment Reason is hard coded into WinGAP and will only be applied to a parcel 
when a SB 346 eligible sale is added to the parcel. The user does not have to set up this Assessment Reason in the 
Assessment Reasons schedule. 
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Editing SB346 Land Values: SB 346 Sale Values can be edited on the Real Property General Information form if 
necessary. The user should right click on the green Sale label to produce a context menu with a single item, Edit 
SB346 Values. 
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Clicking on this item will produce the Edit SB346 Values form. 

 

 

Only the SB346 Values for the Land on this parcel can be edited from this form. 

 

Editing SB346 Improvement Values: SB 346 Sale Values can be edited on the Residential Improvements form if 
necessary. The user should right click on the Improvement value field to produce a context menu with a single 
item, Edit SB346 Values. 

 

 

Clicking on this item will produce the Edit SB346 Values form. 

 

 

Only the SB346 Values for this Residential Improvement can be edited on this form.  

 

Editing SB 346 Sales Values on Commercial Improvements, Accessory Improvements, and Non-Prebilled 
Manufactured Housing Forms: The same capability for editing SB346 values exists on these forms, and the 
procedures are the same as described for the Residential Improvement form. 
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MULTI-PARCEL ADJUSTMENT 

Sales involving more than one parcel are used by the Department of Audits for their sales studies. Questions 
concerning these types of transactions and how to administer the sales price over the involved parcels are asked 
quite frequently, so the following is a recommendation on how to distribute the sales price in an Arm’s Length 
Transaction where multiple parcels are involved. 

 

1) Contact the buyer for information concerning his/her idea of what the sales price distribution should be. If 
that does not produce reliable information, proceed with Step #2. 

2) Sum the value of all parcels involved in the sale. It is recommended that the FMV be used. 

3) Determine the pro rata share of value for each parcel by dividing the parcel’s value by the sum of the values. 

4) Apply the pro rata percentage to the sales price to determine the per-parcel sales price. 

5) When entering the sale on each parcel, key the total sales price and enter an adjustment that would produce 
the pro rata sales amount. Any other adjustments for timber, personal property, etc., must also be made. 

6) Also, adequate notes should be made in the sales comments field explaining what has taken place. 

 

The following is an example of the process described above. An arm’s length transaction is recorded which involves 
2 sales. The total sales price was 500,000. The Assessors’ value of parcel A is 600,000 and the value of parcel B is 
100,000 for a sum of 700,000. The pro rata share of the value for each parcel would be calculated as: 

 

Parcel A: 600,000/700,000 = .86 

Parcel B: 100,000/700,000 = .14 

 

The pro rata sales price for each parcel would be: 

 

Parcel A: 500,000 * .86 = 430,000 

Parcel B: 500,000 * .14 = 70,000 

 

The data entry of the sale for parcel A would show 500,000 as the sales price with an adjustment of 70,000. Parcel 
B’s data entry would have 500,000 entered as the sales price with the adjustment being 430,000. The user would 
receive the SB346 prompt after each sale is entered if the sales reason has been properly set to denote an arm’s 
length transaction. The value for each parcel will then reflect their respective net sales price. 

 

 

BUILDING PERMITS FORM 

Building Permits allow the Assessors Office to keep track of new construction in the County and make sure that 
this new property is added to the tax digest. Building Permit Information is usually entered directly from a copy of 
the Building Permit application issued by the appropriate County or City office. As Building Permits are added to 
the Parcel, they will be displayed in the list box in ascending Permit Number order (lowest Permit Number at the 
top). There is no limit to the number of Building Permits that can be added to a Parcel. 
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The Building Permits Form is used to add, edit, or delete any building permits for construction occurring on the 
Parcel. The Form is accessed by clicking the Permits Button located on the right side of the Real Property General 
Information Form. When the Building Permits Form is first accessed, and no permits have yet been added for the 
Parcel, the data entry fields on the Building Permits Form are "grayed out". To add a new Building Permit, the user 
must click the New Button on the Building Permits Form to gain access to these fields. If permits exist on the 
parcel, the list box in the top left of the Building Permits Form will display any existing Building Permits. 

 

 

Parcel Number: The Map and Parcel number field for this parcel is automatically pulled from the Real Property 
record for this permit. This field is editable by the user. 

Account Number: The Account Number is the realkey for this parcel and is automatically pulled from the Real 
Property record for this permit. This field is not accessible by the user. 

Permit Key: This is a WinGAP assigned number for the building permit and is not accessible by the user. 

Permit Year: The year the Building Permit was issued.  

Permit Number: The Building Permit Number. A Permit Number of up to 10 numbers/characters can be keyed in 
the field. 

Code: A county-define code for this type of Building Permit. 

Permit Owner: The owner of the property for which the Building Permit has been issued. 

Contact: A person that can be contacted about the work on the property. 

Phone: A phone number where the Contact or Permit Owner can be reached. 
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Date Issued: The Date the Building Permit was issued. The date can be keyed directly into the field, or the calendar 
button to the right of the field can be used to insert the date. 

Inspection Date: The Date the new construction was first inspected. The date can be keyed directly into the field, 
or the calendar button to the right of the field can be used to insert the date. 

Type: The Type of Construction as authorized by the Building Permit. The user can click on the combo box to view 
a list of available Construction Types. This list can be added to, or Permit Types can be edited or deleted, by 
clicking on the Type button to the left of the combo box. This will produce the Permit Type Schedule. 

 

 

Permit Amount: The cost for the Building Permit. 

Issued By: The individual that issued the Building Permit. The user can click on the combo box to view the list of 
names, based upon the WinGAP users that are set up in Tools > Password Administration. This list can be added to, 
or users can be edited or deleted, by going to the User Administration Form located in Tools > Password 
Administration. 

Approved By: The individual that approved the Building Permit. The user can click on the combo box to view the 
list of names, based upon the WinGAP users that are set up in Tools > Password Administration. This list can be 
added to, or users can be edited or deleted, by going to the User Administration Form located in Tools > Password 
Administration. 

Scheduled Completion: The Scheduled Completion Date of the construction for which the Building Permit was 
issued. The date can be keyed directly into the field, or the calendar button to the right of the field can be used to 
insert the date. 

Actual Completion: The Actual Completion Date of the construction for which the Building Permit was issued. The 
date can be keyed directly into the field, or the calendar button to the right of the field can be used to insert the 
date. 

Job Address: The street, or Job Address, of the property where the construction is taking place. The Job Address 
information is pulled from the Street Information fields on the Real Property General Information Form. 
Information in this field can be changed by clicking the Edit Button to the right of the Job Address field. 
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Legal Description: The Legal Description of the property where the construction is taking place. The Legal 
Description information is pulled from the Legal Description field on the Real Property General Information Form. 
Information in this field can be changed by clicking on the Edit Button to the right of the Legal Description field. 

Square Footage: The Square Footage of the construction authorized by the Building Permit is keyed in this field. 

Number of Fireplaces: The number of Fireplaces, if any, in the construction authorized by the Building Permit is 
keyed in this field. 

Comments: Unlimited comments about the Building Permit can be entered in this field.  

 

Existing Building Permits are edited by clicking on the appropriate Building Permit in the list box and changing the 
desired information in the field(s) below the window. The user should click the Apply Button to be sure that any 
changes are saved before editing another Building Permit or leaving the Form. The Delete Button at the bottom of 
the Building Permits Form is used to delete a Building Permit. The Building Permit to be deleted should first be 
selected in the list box by clicking on that item. After clicking the Delete Button the message "Do you Want to 
delete this permit?" will appear, where the Yes Button can be clicked to delete the Building Permit; clicking on the 
No Button will cancel the deletion and return the user to the Building Permits Form. 

 

 

 

APPEALS FORM 

The Appeals Form is used to add, edit, or delete Real Property, Personal Property, and Manufactured Housing 
Appeals. It can also be used to Search for Appeals. The Form is accessed by clicking the Appeals button located on 
the right of the Real Property General Information Form, on the right of the Personal Property General Information 
Form, or on the right of the Prebill Manufactured Housing Form. 
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When the Appeals form is first accessed, and no Appeals have yet been added for the Parcel, the data entry fields 
on the Appeals form are "grayed out". To add a new Appeal, the user must click the New Button on the bottom of 
the Appeals form to gain access to these fields. If Appeals exist on the parcel, the most recent Appeal will display, 
and other Appeals, if any, can be looked at by clicking the Search for Other Appeals button in the top left of the 
Appeals form. 

 

GENERAL INFORMATION 

 

 

Appeal Key: The Appeal Key is a unique number assigned by WinGAP when each appeal is added. This field is not 
accessible to the user. 

Appeal Year: The digest (appraisal) year the Appeal was filed for. The field defaults to the current appraisal year, 
which can be changed by the user. 

Status: The current Status of the Appeal, such as Active. When first adding an appeal, the combo box selection 
defaults to Active; if it is necessary to change the Status at this point, the user can click on the combo box to 
display a list of the valid Status types, a seen below, or key the first letter of the Status description to select the 
Status. A Status must be selected initially and then maintained as the appeal progresses through the appeals 
process.  
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Listed below are the current Appeal Status options and the WinGAP codes associated with them: 

• 30 Day   - 2 

• Active   - A 

• Arb No Change  - O 

• Arbitration  - T 

• BOE   - B 

• BOE Expired  - E 

• BOE Final  - F 

• BOE No Change  - N 

• CHO   - H 

• CHO No Change  - P 

• Inactive   - I 

• Late Filed – Denied - L 

• Resolved  - R 

• Superior Court  - S 

• Waived   - D 

• Withdrawn  - W 

 

Type: The Type of Appeal, which defaults to the type of property based on the form from which the Appeals form 
was opened: Real, Personal, or Manufactured Housing. This field can be changed by the user. 

P.I.N.: The Map and Parcel number field of the account the appeal is for. This field is not accessible by the user. 

Appraiser: The Appraiser responsible for handling the Appeal. The user can click on the combo box to display a list 
of the Appraisers that have Appeal edit rights. 

Acct #: The account number of the property being appealed, either realkey (Real Property), perskey (Personal 
Property), or mobilekey (Manufactured Housing). 

Acres: Total parcel acres for a Real Property appeal. 

COID#: The COID# field is disabled for Appeals and is not used. 

Batch: If desired, a County defined number can be keyed in the Batch field that will allow the County to print 
Appeals for a specific grouping of Appeals. 

NOTE: The BOE, ARB, CHO, SUP checkboxes shown in the above image are discussed below. 
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OWNER INFORMATION 

This information will automatically populate with data from the corresponding fields on the property’s Owner 
record. It can be edited by the user if necessary. 

 

 

Last: The Last name field is the first of the Owner Information fields on the Appeal Form. This field is 20 characters 
wide and should contain the Last name of the Owner of the property under Appeal, unless the County chooses to 
place its Owner names in the Corporate name field, in which case the Owner's name should be keyed in the 
Corporate name field and the Last name field left blank. If the Last name field is used, a comma should NOT be 
placed after the name. 

First: This field is also 20 characters wide and should contain the First name of the Owner, but only if there is a Last 
name entered. 

MI: The Owner's middle initial, if any, is keyed here if the Last and First name fields are used. 

CorpName: If the County uses the Corporate Name field for Owner's names, then the name of the Owner of the 
property under Appeal should be keyed here in the following format: Last Name followed by a space then the First 
Name followed by a space then the Middle Initial. 

Agent: The individual or company designated by the property Owner to handle the Appeal. 

Address Fields: There are three fields where address information can be entered. Each field is 40 characters wide. 
The property location address is usually keyed in the first Address field. Additional Owners can also be keyed in this 
field. 

City: The property Owner's City is keyed here. 

State: The Owner's State is keyed here. 

Zip: The Zip Code of the Owner is keyed in this field. 

Legal Description: The Legal Description of the property is keyed in this field. 

Home Phone: The Home Phone number of the property Owner is keyed in this field. 

Work Phone: The Work Phone of the Owner is keyed in this field. 

Comments: Any Comments about the Appeal are keyed in this field. 
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MANUFACTURED HOUSING INFORMATION 

If the appeal is for a Manufactured Home, this section of the form will be available to edit. This information will 
automatically populate with data from the corresponding fields on the Manufactured Housing record. If it is for 
Real or Personal property, this portion of the form will be “grayed out”. 

 

 

Mfg: The Manufacturer of the Manufactured Home. 

Model: The Model of the Manufactured Home. 

Width: The width of the Manufactured Home is keyed in this field. 

Length: The length of the Manufactured Home is keyed in this field. 

Decal Yr: The Decal Year for the Manufactured Home for the Appeal Year in question is keyed in this field. 

Decal: The Decal Number that was on the Manufactured Home for the Appeal Year in question is keyed in this 
field. 

Year Built: The Year the Manufactured Home was manufactured. 

Account #: This is the mobilekey for the property. 

 

VALUES INFORMATION 

 

BOA FMV: The Board of Assessors Fair Market Value for the Property. 

30-Day: The value of the Property that the Board of Assessors sets after a review of the property when the appeal 
is initially filed. 
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BOE: The value of the Property as determined by the Board of Equalization after they hear the Appeal. 

Arbitration: The Property Owner may opt to appeal to an arbitration board instead of the Board of Equalization. If 
that is true, the value resulting from the Arbitrator’s decision would be entered in the Arbitration field. NOTE: You 
cannot have both a BOE Value on the Appeals Form AND an Arbitration Value; it must be one or the other. 

Hearing Officer: The value assigned by the Hearing Officer assigned to hear the Appeal. The property must be over 
$1,000,000 in value. 

Superior Court: The value of the Property as determined by the Superior Court after the Appeal is heard in Court. 

Resolved: The value of the Property that is signed off on by the Owner. “Signed off on” also could be when the 
Owner no longer appeals. An example might be if the 21-day notice is mailed and the Owner does not appeal to 
the BOE, then the 21-day value should then be moved to resolved and the appeal status changed to resolved. 

Current: The Current Value of the Property based upon whatever stage the Appeal is in. For example, if the BOE 
decision has been made, the value handed down from the BOE should appear in Current and also in the BOE Value 
field. 

Return: The Return Value of the Property, as entered on the Appeal Form by the Owner of the Property. 

Asserted: The value of the Property as asserted by the Appellant. 

Appraised: The value of the Property as declared on a Certified Appraisal. 

VID: The Value In Dispute, which is the difference between the Current Value and the Return Value. 

 

CHECKBOXES AND LETTERS 

 

BOE, ARB, CHO, and SUP checkboxes: These checkboxes are used to designate if the Appellant requests Board of 
Equalization, Arbitration, County Hearing Office review, or wants to appeal directly to the Superior Court.  
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No Show Checkboxes: Indicates if the Appellant failed to show for either the BOE, ARB, CHO, or Superior Court 
hearings of the Appeal. Each checkbox is to the right of the Value field for that applicable Appeal Status. 

Grounds for Appeal: These six checkboxes are used to select the reason(s) for the Appeal. 

10 Day ARB Receipt: Prints a letter showing that the request for Arbitration Appeal was received. 

10 Day ARB Appr’l Reject: Prints a letter showing the Certified Appraisal submitted for the Arbitration Appeal was 
rejected. 

Appraisal Acceptance Ltr: Prints a letter showing that the Appellant’s Appraisal Value was accepted. 

Appraisal Rejection Letter: Prints a letter showing that the Appellant’s Appraisal Value was rejected. 

SC Settlement Letter: Prints a letter notifying the Appellant of the date and time of the upcoming Superior Court 
Settlement conference. 

SC No Settlement: Prints a letter indicating that No Settlement could be reached during the Superior Court 
conference. 

 

DATES INFORMATION 

 

 

Notice: The date of the Assessment Notice for the Property. 

Appealed: The date the Owner of the Property appealed the Property value. 

30 Day Notice: The date the 30 Day Notice was mailed. 

BOE: The date of the BOE hearing. 

Arbitration: The date of the Arbitration hearing. 

Hearing Officer: The date of the Hearing Officer hearing. 

Sup Court: The date of the Superior Court hearing. 

Resolved: The date the appeal was resolved. 

Decision: The decision date is a tracking mechanism that allows the County to track any ‘decision’ they see fit. 
There are no validation rules here. For example, the County might enter a court date in the Sup Court date field, 
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and then enter the date they receive the judge’s decision in the Decision date field. This allows the tracking of 
more details in the Appeal process. 

Fwd/Cert Date: The date the county appeal administrator forwarded the appeal to the BOE for scheduling. 

Postmark: The date an appeal received by mail was postmarked. The law allows for mailed appeals to be received 
after the deadline so long as they were postmarked inside of that deadline. 

NOA Info Provided: The date the county provided information requested by the taxpayer under 45-5-306, such as 
a description of the methodology used by the board of tax assessors in setting the property's fair market value, all 
documents reviewed in making the assessment, the address and parcel identification number of all real property 
utilized as qualified comparable properties, and all factors considered in establishing the new assessment.  

BOE Info Provided: The date the county provided information requested by the taxpayer under 48-5-311, such as a 
list of witnesses, documents, or other written evidence to be presented at the hearing. 

Apr Recd: The Appraisal received date. The law stipulates that the Assessor’s Office only has a certain amount of 
time to respond once an appraisal is submitted by the appellant. 

Apr Decide: The date that the Assessor’s Office decided to either accept or reject the appellant’s submitted 
appraisal. 

No Chg Ltr: The No Change Letter date fields to the right of the BOE, Arbitration, and Hearing Officer date fields 
allows the Assessor’s Office to track the dates they send the Appellant a notice that they are not changing the 
value from the originally appealed value. 

Conference: The date of the Superior Court Settlement conference. 

Conf Time: The time of the Superior Court Settlement conference. 

Temp Bill Amt: The Temporary Billing Amt field and Temp Bill Options button are used to create a Temporary Bill 
and Amount for an Appeal under certain circumstances such as Value, Improvements on the property, and 
Homestead status. Clicking the Temp Bill Options button produces the form below. 

 

 

The property owner has an option to elect how they want their tax bill to calculate while it is under appeal. The 
options available to the property owner are determined by the physical characteristics of the parcel as shown on 
the form above. The form changes and helps lead the WinGAP user and the property owner into selecting the 
correct options. These options were established by Georgia Law. The WinGAP form and interactivity merely do 
what the law defines. 
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OTHER CHECKBOXES 

 

 

 

No SC Conf Agreement: A check in this box indicates that no agreement was reached at the Settlement Conference 
prior to a Superior Court appeal hearing. 

Evidence Presented: This checkbox allows the tracking of when Evidence was presented during the Appeal 
process, as it triggers events and rights regarding the Appeal. 

Interview Requested: This checkbox allows the tracking of when the Appellant requests an interview with the 
Assessor’s Office and the date of the request. There are time requirements for the Assessor’s Office in granting this 
interview. 

299C Event: This box should be checked if the final Decision locks the property’s value in accordance with O.C.G.A 
48-5-299(c). 

NOA Info Requested: A check in this box indicates that additional information about the Notice of Assessment has 
been requested from the taxpayer. 

BOE Info Requested: A check in this box indicates whether the Board of Equalization has requested additional 
information from the taxpayer. 

 

SEARCH FOR OTHER APPEALS FOR THIS PARCEL/ACCOUNT  

This button, located at the top left of the appeal form, will open a historical record of all appeals for a parcel. 

 

Clicking this button will transform the Owner Information box into a complete historical record of the appeals for 
this parcel. 
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The records can be viewed inside the list by scrolling left-to-right inside the box, while any of the appeals can be 
opened to view on the appeal form by clicking on that item, and the complete appeal form will display including 
decision values and dates. 

 

 

 

 

 

 

 

 

DUPLICATE ITEMS FORM 

Real Property Items such as Improvements, Sales, and Permits can be duplicated, or copied from one parcel to 
another, by clicking the Dup Items (Duplicate Items) Button on the Real Property General Information Form. This is 
useful when a Subdivision is being built and many of the houses are similar in structure and other construction 
characteristics. 
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A list of the Property Items currently on this parcel will appear in the list box at the top of the form. The user 
should first key in the parcel number of the property that will receive the duplicated item in the yellow parcel 
number field and click the Search Button. A list of parcels beginning with the keyed parcel number will display in 
the list box beneath the parcel number field.  
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The user can click in the list box on the parcel that is to receive the duplicated item to verify that this is the correct 
parcel. The next step in the Duplicate Items process is to select the item to be transferred. This is done by clicking 
on the appropriate item in the list box at the top of the Form. 
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The Apply Button can be clicked to duplicate the item on the selected parcel and remain on the Duplicate Items 
Form, or the OK Button can be clicked to duplicate the item and return to the Real Property General Information 
Form. Only one Property Item at a time can be duplicated using the Duplicate Items Form. 

 

 

 

BUSINESS LICENSE FORM 

The Business License Form is used to add, edit, or delete Business Licenses for Real and Personal Property. 
Business Licenses allow the Assessor’s Office to keep track of new and existing businesses in the County and make 
sure that all Real and Personal property is placed on the tax digest. Business License Information is usually entered 
directly from a copy of the Business License application issued by the appropriate County or City office. 

 

The Form is accessed by clicking the Bus Lic Button located on the right side of the Real and Personal Property 
General Information forms. When the Business License Form is first accessed and no licenses have yet been added 
for the Parcel, the data entry fields on the Business Licenses Form are "grayed out”. To add a new Business License, 
the user must click the New Button on the Business Licenses Form to gain access to these fields. If any Business 
Licenses exist on the Parcel, the Bus Lic Button will display the number of Licenses to the right of the word "Bus 
Lic”, and clicking on the Bus Lic button will display the existing Business Licenses. 
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Busikey: The Business Key, which is assigned by WinGAP to this Business License record. The user does not have 
access to this field. 

Realkey: The Real Property Key, which is pulled from the Parcel record this Business License is attached to. The 
user does not have access to this field. 

Perskey: The Personal Property Key, which is pulled from the Personal Property Account record this Business 
License is attached to. The user does not have access to this field. 

Parcel Number: The Parcel Number, which is pulled from the Parcel record this Business License is attached to. The 
user does have access to this field. 

CO-ID-NUM: The County Identification Number, which can be entered by the user when a Business License is 
added to a Real Property parcel. When a Business License is added to a Personal Property Account, the County 
Identification Number is pulled from the Account record this Business License is being added to. The user has 
access to this field. 

Business: The Business Name for this Business License. 

Address: There are three address fields where the Business address information can be entered. Each field is 40 
characters wide. The first line of the address may be keyed in the first address field. Any mailing addresses that 
were not keyed on the first address line can be entered in the second and third Address fields. The fourth address 
line contains fields where the City, State, and Zip Code are keyed. 

Phone: The Business phone number, if known, is keyed in this field. If a Business or Corporation, the main phone 
number of the business. The field is pre-formatted for the phone number, and only numbers, beginning with the 
Area Code, can be keyed in the field. 

SST: The State Sales Tax Number of the Business, if known, is keyed here. 
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Owner: The Owner of the Business. The Owner’s name is pulled from the Owner Information record for the parcel 
the Business License is attached to. If the Business has a different owner name, that name can be keyed here. The 
two fields below the Owner name are for first name and middle initial. 

Address: There are four lines for the address information for the Business Owner. Like the Owner’s name, the 
address information is also pulled from the Owner Information record for the parcel the Business License is 
attached to. If the Owner’s address is different, that change can be made here. 

Phone: The Owner’s phone number is also pulled from the Owner Information record for the parcel the Business 
License is attached to. If the Owner has a different phone number, the number can be keyed here. The field is pre-
formatted for the phone number, and only numbers, beginning with the Area Code, can be keyed in the field. 

SSN: The Owner’s Social Security Number is also pulled from the Owner Information record for the parcel the 
Business License is attached to. If the Owner has a different SSN, the number can be keyed here. The field is pre-
formatted for the number, and only numbers can be keyed in the field. 

St Num: All the Street Information is pulled from the Parcel or Account record for the Business. If any of this 
information is missing, such as the Street Number, it can be keyed in the respective fields. 

St Ext: The Street Extension, such as A, 1/2, etc. 

St Dir: The Street Direction (North, Southeast, etc.) of the street. 

St Name: The name of the Street or Road where the Parcel is located. Up to 25 characters of information can be 
placed in this field. 

St Type: The Type of Street, such as Road, Drive, Hwy, Lane, etc. 

St Unit: The Unit Number of the property, sometimes used by Apartments and Condominiums. Examples would be 
Unit 5, Apartment A, etc. 

Quad: The post-direction used in addressing, such as 4888 Peachtree St. NW. The NW is the post-direction. 

Accountant: The Name of the Accountant for the Business, if known is keyed in this field. 

Contact: The name of the Contact person for this Business. 

Address: There are four lines for the address information for the Business Owner. Like the Owner’s name, the 
address information is also pulled from the Owner Information record for the parcel the Business License is 
attached to. If the Owner’s address is different, that change can be made here. 

Email: The Email address for the Business, if known. 

Renewal Y/N: If this is a new Business License for an existing or new Business, a N should be keyed in this field. If 
an existing Business License is being renewed, a Y should be keyed in the field. 

Type: The Type of Business. Business Types are set up in Tools > Schedules/Tables > Business License Types. The 
user can click on the Type combo box to select a Business Type. Pressing the Tab key will take the user to the next 
field. 

Busi Type: Additional information about the Type of Business can be keyed in this field. 

Naics: The Naics (North American Industry Classification System) is the standard used by Federal statistical 
agencies in classifying business establishments for the purpose of collecting, analyzing, and publishing statistical 
data related to the U.S. business economy. The 5-digit code, if known for this type of business, is keyed here. 

Status: The county can use this field to specify if the business is Active/Inactive or for other purposes, if needed. 

Employees: The number of Employees, if known, is keyed in this field. Many Business License systems use the 
number of employees as the basis for the Business License Fee. 

Fee: The Business License Fee is keyed in this field. 

Late Fee: The Late Fee that is assessed to the Business if the Business License application or renewal is filed after 
the expiration date. 
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Issued By: The name or initials of the person that issued the Business License Types. 

Create Date: The date that the Business License is added to WinGAP. This date is system generated and placed in 
the field, but it can be changed by the user. 

Issue Date: The date that the Business License was issued. 

Paid Date: The date that the Business License fee was paid. 

Expire Date: The date that the Business License expires. 

Bus License #: The License number that is on the Business License that is issued to the business. 

Comments: The large field at the bottom of the Business License form is where an unlimited amount of Comments 
about the Business License can be entered. 

 

Existing Business Licenses are edited by clicking on the appropriate Business License in the list box and changing 
the desired information in the field(s) below the window. The user should click the Apply Button to be sure that 
any changes are saved before editing another Business License or clicking OK to leave the Form. 

 

The Delete Button at the bottom of the Business License Form is used to delete a Business License. The Business 
License to be deleted should first be selected in the list box by clicking on that item. After clicking the Delete 
Button the message "Do you wish to delete this item?" will appear, where the Yes Button can be clicked to delete 
the Business License; clicking on the No Button will cancel the deletion and return the user to the Business License 
Form. 

 

 

INCOME FORM 

The Income Form is used to add, edit, or delete information used to value property by the Income Approach. The 
Form is accessed by clicking the Income Button located on the bottom right of the Real Property General 
Information Form. If the parcel has an existing Income Detail record, an asterisk will appear on the Income Button. 
Clicking this button opens the Income Parcel Summary form, which displays a summary of the Income Details 
records for this parcel. If there are no Income Details records for this parcel, this form will say “there are no 
records to view”. 
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To update an existing Income Details record, select it from the list and click Edit. The Edit button is also used to add 
a new Income Details record to a parcel. Clicking this button will take the user to the Income Details Form. The 
existing Income Models display in the list box at the top of the Form. If no Income information has been added for 
the Parcel, the data entry fields on the Income Details Form are "grayed out". To add new Income information, the 
user must click the New Button on the Income Form to gain access to these fields. 
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After clicking the New Button, the user must first select the correct Model Type in the list box at the top of the 
Income Details Form. Selecting the Model Type will fill in the appropriate fields on the Income Details Form for 
that Model Type. Only fields that are required for the selected Income Model are enabled and available for data 
entry. The user then adds the remaining data and/or adjustments required to generate an Income Value for the 
property. 
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Unit Description/Base Rate: Directly beneath the Valuation Details heading on the Income Details Form are the 
Unit Descriptions and Base rates. This information is taken from the Income Schedule for that Income Model Type 
and includes all room descriptions, $/SF rates, $/Room rates, GRM rates, Vacancy %, Expenses %, and the Cap 
Rate. These items are not accessible on the Income Details Form. Depending on the Model Type, the appropriate 
field(s) will be completed from schedule information. 

 

$/Bedroom 

 

 

$/SF 
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$/Room 

 

 

Gross Rent Multiplier 

 

 

Adj: An appraiser determined adjustment for this property can be keyed here. The expression should be expressed 
as a percentage with no decimal places. 

Final: The Base Rate multiplied times any adjustment will produce the Final value for that individual type. 

Units: The number of Units in the property that are of that type. 
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Income: The total Income from that type. The Income is generated by WinGAP using the following formula: Base x 
Adj x Units. 

Misc. Income: Any miscellaneous income derived from the property. 

PGI: The Potential Gross Income is calculated by WinGAP based on the Model Type and data provided. 

EGI: The Effective Gross Income, which is the PGI (Potential Gross Income) less (Vacancy and Collection Loss + 
Miscellaneous Income). 

NOI: The Net Operating Income is calculated by WinGAP based on the Model Type and data provided. 

Total Value: The Total Value represents the value of land and improvements based on the Model Type and data 
provided. 

Personal Value: Any personal property value that should be deducted from the Total Value should be entered in 
this field. 

Real Value: The Real Value is calculated by subtracting Personal Value from Total Value. 

Land Value: The value of the land that the Income property resides on. The Land Value is taken from the Fair 
Market Value of the land which is generated from the land schedules and land characteristics. 

Imp Value: The Real Value minus the Land Value. The Land Value and Imp Value are separated to conform with 
Georgia Code which requires that land and improvement values be separated for digest purposes. 

Income as Parcel Current Value: This box should be checked if the Income Value is to be placed on the digest. If 
the box is checked, the user will see the text Income highlighted in red to the right of the Current Value field on the 
Real Property General Information Form. 

 

Reset Buttons: The Reset Buttons beneath the Adj and Units fields can be clicked to reset the values in those fields 
to zero and quickly restart the Income valuation process. 

Dig Class Checkboxes: The appropriate Digest Class for the Income property can be selected by clicking in one of 
the Dig Class checkboxes. 

Comments: Any comments about this Income property can be entered in this field. 

Model Term (Annual/Monthly): The Income Model Term displays on the lower left of the Income Details Form. If 
the Monthly Rate option is checked on the Income Model Form for that Model, the Model Term will be Monthly; 
otherwise, it will display as Annual. 
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$/SF Income Model Type 

After all the information is added and the user clicks apply, the Income Details Form for the $/SF Income Model 
Type, Model Type 1, appears as shown below. 
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$/Room Income Model Type 

The Income Details Form for a $/Room Income Model Type, Model Type 2, would appear similar to the one below. 
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$/Bedroom Income Model Type 

The Income Details Form for a $/Bedroom Income Model Type, Model Type 3, would appear similar to the one 
below. 

 

 
  



 
882 

GRM Income Model Type 

Finally, the Income Details Form for a GRM Income Model Type, Model Type 4, would appear similar to the one 
shown below. 
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ACO FORM 

The ACO Form is used to add, edit, or delete Account Corrections, Errors and Releases, and Not on Digest 
information for Real Property, Personal Property, and Prebilled Manufactured Housing. The ACO Form is accessed 
by clicking the ACO Button located on the right of the respective forms. 

 

When the ACO Form is first accessed, and no Account Corrections have been added for the Parcel, the data entry 
fields on the ACO Form are "grayed out”. To add a new ACO, the user must click the New Button on the ACO Form 
to gain access to these fields. If any ACOs exist on the Parcel, the ACO Button will display the number of ACOs to 
the right of the word "ACO". When opening the ACO Form for an account, the list box at the top left of the ACO 
Form will display any existing ACOs for the parcel.  

 

 

Account Number: The Realkey, Mobilekey, or Perskey for the account, which is assigned by WinGAP to the account 
when it is created and is automatically filled in for this ACO item. 

Digest Year: The Digest Year this ACO is to be applied to. When creating a new ACO, this defaults to the current 
appraisal year. The year in this field can be changed by the user if necessary. 

Parcel Number: The Parcel Number that this ACO item is associated with. The Parcel Number is pulled from the 
parcel information but can be changed by the user. 

Tax District: The Tax District for the account that this ACO item is associated with. The Tax District is pulled from 
the account information but can be changed by the user. 

Legal Description: The Legal Description for the account that is ACO is associated with. The Legal Description is 
pulled from the parcel information but can be changed by the user. 
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Property Owner Name: The Owner of the Property, which is pulled from the Owner record for the account this 
ACO record is attached to. This information can be changed by the user. 

Address: Three fields of Address information are pulled from the Owner record for the account this ACO record is 
attached to. This information can be changed by the user. 

City, State, Zip: The City, State, and Zip information is pulled from the Owner record for the account this ACO 
record is attached to. This information can be changed by the user. 

Property Address: The Property Address information is pulled from the account record that this ACO record is 
attached to. This information can be changed by the user. 

Reason for Correction: The Reasons for why the Account Value or Homestead information is being corrected. An 
unlimited amount of information can be keyed in this field. 

Other Comments: Other comments about this ACO can be keyed into this field. An unlimited amount of 
information can be keyed in this field. 

Agrees: A checkmark is placed in this box if the Board of Assessors agrees with the appraiser’s decision to make 
changes to the values or exemption amounts for this property. 

Disagrees: A checkmark is placed in this box if the Board of Assessors disagrees with the appraiser’s decision to 
make changes to the values or exemption amounts for this property. 

Date: The Date of the Board of Assessors decision on the ACO is entered into this field. 

Date Change Made in Computer: The date the ACO was first entered or later edited is placed in this field. 

Initial: The initials of the person entering the data or approving the entry of the ACO. 

Date Notice Mailed: The date the Assessment Notice was mailed to the property owner reflecting the change 
made by the ACO is placed in this field. 

Initial: The initials of the person mailing the notice or on the notice as a contact person. 

Class/Strata: The first column contains the Digest Class and Stratification for the property on this parcel. For 
example, a residential lot (R3), a commercial improvement (C1), accessory improvement (R1), etc. 

Original FMV: The FMV for each type of property is shown in this column. A Total Original FMV for all types of 
property on this parcel will automatically calculate and display at the bottom of this column. 

Increase/Decrease: The values in this column will be calculated by WinGAP based upon what is keyed in the fourth 
column as a revision. The fields in the Increase/Decrease column are not accessible to the user. Both positive and 
negative values are allowed in this field. A Total Increase/Decrease value for all types of property on this parcel will 
display at the bottom of this column. 

Revised FMV: The new value for any or all of the types of property is keyed in the appropriate fields in this column. 
WinGAP will calculate the difference between the Revised FMV and the Original FMV and place it in the 
Increase/Decrease field for each of the types of property. A Total Revised FMV for all types of property will display 
at the bottom of this column. 

Exemptions: Any Exemptions that are revised are keyed into these two rows and four columns. The first field on 
each row is for the Exemption Code, the second field for the original Exemption amount, and the fourth field for 
the revised Exemption Amount. WinGAP will calculate the difference and place the value(s) in the third column. 
The values in the third column are not accessible to the user. 

Control No: The Control Number is a county-defined code, six characters in length, for this ACO. Both letters and 
numbers can be keyed in the field. 

ACONumber: The ACONumber is generated by WinGAP for each ACO. This field is not accessible to the user. 

Ownkey: A WinGAP assigned number for the account Owner. 

CO ID NUM: The CO ID NUM is disabled on the ACO form and not used. 
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Printing an ACO: Right clicking the printer on the ACO Form will open a contextual menu with a single option. 

 

 

Clicking the Print Form menu item will produce a print preview of the ACO form. The print preview gives the user 
the option to toggle between showing Estimated Taxes for this account change by clicking one of the options in the 
True / False radio button section, then clicking the View Report button on the upper right of the form. A true 
selection will display the Estimated Taxes at the bottom of the form; a False selection will not. 

 

 

Existing ACOs are edited by clicking on the appropriate ACO in the list box in the upper left of the ACO form and 
changing the desired information in the field(s) below the window. The user should click the Apply Button to be 
sure that any changes are saved before editing another ACO or clicking OK to leave the Form. 
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The Delete Button at the bottom of the ACO Form is used to delete an ACO. The ACO to be deleted should first be 
selected in the list box by clicking on that item. After clicking the Delete Button the message "Are you sure you 
want to deleted this record?" will appear, where the Yes Button can be clicked to delete the ACO; clicking on the 
No Button will cancel the deletion and return the user to the ACO Form. 

 

 

ESTIMATED TAXES FORM 

With the passage of Senate Bill 346 in 2010, all property in the County must receive an Assessment Notice each 
year, and every Assessment Notice must include the Estimated Taxes for each of the Tax Types for that property. 
Note: for WinGAP to calculated Estimated Taxes. The Tax Calculation schedules, located at Tools > 
Schedules/Tables > Tax Calculation Tables, MUST be set up first. Once the schedules are set up, clicking the 
Estimated Tax button produces the Estimated Tax Details form.  

 

 

The Estimated Tax information is displayed in a series of columns on the form. The information is for viewing 
purposes only, and no changes can be made on this form. Each row represents one Tax Type item that will appear 
on the Tax Bill for this property. 

 

The columns, from left to right, display the following: 

• The Realkey, or Real Property key for this parcel. 

• The Perskey, or Personal Property key for an account. 

• The Tax Type Code. 

• The Tax Type Description. 

• The Assessment Percentage. 

• Covenant Exemptions, such as Preferential, Conservation Use, FLPA, Historic, and Enterprise Zone. 

• Homestead Exemptions, both State and Local. 

• The Millage Rate for this Tax Type. 

• The Estimated Taxes for this Tax Type. 

• The Acckey, or Accessory Key for Fees. 
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At the lower left of the Estimated Tax Details form is the Gross Assessment value, in this example, $58,980. The 
Current value for the parcel represented by the Estimated Taxes shown above is $147,450. The 147,450 is 
multiplied by the Assessment Percentage, as shown in the AsmtPct column, to produce the Gross Asmt value, 
$58,980. 

 

The Total Estimated Tax is displayed in red in the lower middle of form, in the example above, $2,350.36. This 
amount is the sum of the Estimated Tax amounts for each of the Tax Type items on the form. 

 

At the lower right of the form are three buttons. The Printer Button can be clicked to produce a printout of the 
Estimated Tax Details form. 

 

The Tables Button can be clicked to gain immediate access to the Tax Calculation Tables if a mistake is noticed on 
the form. The user can make changes to the schedules without leaving the Real Property General Information 
form. Once the change is made to a schedule, the Close Button on the Tables form should be clicked to return to 
the Estimated Tax Details form. NOTE: Only users that have been assigned rights to Tables/Schedule will have 
access to the Tables button. NOTE: If any changes are made to the Tax Calculation Tables by using the Tables 
Button, the user must close the Estimated Taxes form and again click he Estimated Tax button so that the 
Estimated Taxes are re-calculated using the change to the schedules. 

 

To exit the Estimated Tax Details form, the user should click the Close button to return to the Real Property 
General Information form. 

Below are some examples of Estimated Taxes for parcels with different type of Tax Districts, Exemptions, and 
Covenants. 

Unincorporated Parcel with an S0 Homestead Exemption 
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Unincorporated Parcel with an S1 Homestead Exemption 

 

 

Unincorporated Parcel with an S4 Homestead Exemption 

 

 

Unincorporated Parcel with an SC Homestead Exemption 
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Unincorporated Parcel with a Conservation Use Covenant 

 

 

Unincorporated Parcel with a Conservation Use Covenant and an S1 Homestead Exemption 

 

 

Unincorporated Parcel with a Conservation Use Covenant and an S4 Homestead Exemption 
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Incorporated Parcel with an S0 Homestead Exemption 

 

 

 

 

PREBILLED MOBILE HOMES FORM 

The Prebilled Mobile Homes Form is used to add, edit, or delete Prebilled Mobile Homes. The Form can be reached 
by any one of several methods:  

• Clicking on the Prebill MH button on the WinGAP Toolbar, which will produce the Prebill Mobile Home 
Search Form. A Prebilled Owner can then be located, which will produce the Prebilled Mobile Homes 
form. 

• Selecting a Prebilled Mobile Home Owner through the Owner Search screen and clicking on the Prebill MH 
button in the upper right hand corner of the screen, which will produce the Prebilled Mobile Homes form. 

• Clicking on the Property Maintenance option on the WinGAP Menu Bar, then on Manufactured Housing, 
then Prebill, which will also produce the Prebilled Mobile Home Search Form, where a Prebilled Owner 
can then be located, which will produce the Prebilled Mobile Homes form. 
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Once on the Prebilled Mobile Homes Form, the Owner's Name is shown in the Title Bar at the top of the form. The 
data for an Existing Real Property parcel will be displayed in the fields for editing purposes. The fields on the Form 
will be "grayed out" if adding a New Prebilled Mobile Home, and New Button must be clicked at this point to begin 
keying the data. 

 

MH: When no Mobile Homes exist on the Improvement, this field is blank. When editing Mobile Homes, the field 
will display important identifying information about the first Mobile Home on the Improvement, including the Year 
Built, Size, Manufacturer, and Model. If there is more than one Mobile Home on the Improvement, the user can 
click on the field combo box to directly access any of the other Mobile Homes on the Improvement without leaving 
this Form. This field cannot be directly edited by the user. 

PIN: The Parcel Number where the Non-Prebilled Mobile Home is located is displayed in this field. The Parcel 
Number can be changed by the user if necessary. 

Location: The location of the Prebilled Mobile Home. 

Key: The Key field contains the WinGAP Account Number, called Mobilekey, for this Mobile Home. It cannot be 
changed by the user. 

Review Date: The last date that this Mobile Home was reviewed or the date the Mobile Home is scheduled to be 
reviewed is keyed in the Review Date field. The date can either be keyed or the Calendar Button to the right of the 
field can be clicked to select and insert the date.  

Returned Mail: The Returned Mail checkbox is used to note when the USPS has returned correspondence as 
undeliverable for the Mobile Home. 
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Future Field Check: 

House Pricing: A checkmark placed in this checkbox will instruct WinGAP to price the Mobile Home using the 
information on the Residential Improvement Form instead of using the information on the Mobile Home Form. If 
this is done, all the Residential Improvement information must be entered on the Residential Improvement form. 
The user must also either sketch the Mobile Home or enter the square footage using the Edit Areas button to 
attain a value for the Non-Prebilled Mobile Home. The House Pricing field is "grayed out" and not available to the 
user until the Mobile Home record is saved. 

Exempt: This checkbox, if checked, will flag the Prebilled Mobile Home as exempt from taxation. 

COPL: A checkmark in this box will flag the Prebilled Mobile Home as having a Certificate of Permanent Location 
(de-titled). 

 

IMPROVEMENT INFORMATION 

 

Mfg: The Manufacturer of the Mobile Home, such as Fleetwood or Redman. The user can produce a listing of all 
Mobile Home Manufacturers by clicking on the combo box, and quickly move through the list by keying the first 
letter of the name of the Manufacturer. WinGAP has a pre-built schedule of all Mobile Home manufacturers and 
the Mobile Home models associated with these Manufacturers located in Tools > Schedules/Tables > 
Manufactured Housing > Mfg/Model Listing. Items in this schedule can be added, edited, or deleted to suit the 
local County situation. 

Model: The Model of the Mobile Home, based upon the Manufacturer that was selected. The user can produce a 
listing of all Mobile Home Manufacturers by clicking on the combo box, and quickly move through the list by keying 
the first letter of the name of the Model. As with the Manufacturer, Mobile Home models can be added, edited, or 
deleted to suit the local County situation by going to Tools > Schedules/Tables > Manufactured Housing > 
Mfg/Model Listing. 

Class: The Class for the Mobile Home is assigned by WinGAP based upon how it is set up for that Manufacturer and 
Model in the schedule located in Tools > Schedules/Tables > Manufactured Housing > Mfg/Model Listing. The Class 
is used in calculating the Replacement Cost New for the Mobile Home. If needed, the user can select from other 
available Class choices from this combo box. NOTE: Changing the Class is not advised. The Class has been set in the 
schedules and should not be modified for an individual home. The Class is open to change so the appraiser may 
observe the effect of the varying classes on value to determine what Class is appropriate for the schedule entry. 
The Class should always be changed back to the Class that was brought forward from the schedule. 

Year Model: The Year Model represents the actual year the Mobile Home was constructed. The Year Model is used 
in calculating the Physical Depreciation Factor and determining both the Mobile Home Calculated Value and the 
Total Value of the Mobile Home. 

Eff Year Built: The Effective Year Built is used only when the condition of the Mobile Home reflects something 
different than should be present based on the original year of construction. The Eff Year Built field can be used to 
effectively increase or decrease the age of a Mobile Home. It is not the year the Mobile Home was remodeled. 
When present, the Effective Year Built is used in calculating the Physical Depreciation Factor and determining the 
Mobile Home Calculated Value and the Total Value of the Mobile Home. 

Size: Size refers to the Width and Length of the Mobile Home, in feet. The Width of the home must be keyed in the 
first Size box. 

Tip Out: A Tip Out is a room extension built at the factory, shipped inside the home, and tipped or slid into place 
once the home is sited. If the Mobile Home has heated area that projects out from the basic rectangle of the 
Mobile Home, the user should click in the Tip Out checkbox to produce the Size and Adjustment fields where this 
additional area can be entered. WinGAP will calculate the additional "Tip Out" area. The Adj field is used to enter 
an adjusting factor for the Tip Out area. The default Adjustment value is 0.83 and can be changed by the user. 
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Tag-a-long: A checkmark in this box will allow the valuation of the tag section of the Mobile Home. 

Story Height: The story height of the Prebilled Mobile Home is selected in this field. 

Decal Yr: The issue year, if known, of the Decal for the Prebilled Mobile Home is keyed in this field. 

Decal No: The Decal Number, if known, of the Prebilled Mobile Home is keyed in this field. 

Serial No: The Serial Number, if known, of the Prebilled Mobile Home is keyed in this field. 

Title: The Title Number of the Prebilled Mobile Home. 

Title Name: The Name listed on the Title for the Prebilled Mobile Home. 

Purch Price: The Purchase Price of the Prebilled Mobile Home, if known, is keyed in this field. 

Yr Purchased: The Year the Prebilled Mobile Home was purchased, if known, is keyed in this field. 

 

CHARACTERISTICS 

 

Ext Wall: Ext Wall refers to the type of Exterior Wall of the Mobile Home, such as Vinyl, as set up in Tools > 
Schedules/Tables > Manufactured Housing > Exterior Walls. 

Roofing: The type of Roofing on the Mobile Home, such as Asphalt Shingles, as set up in Tools > Schedules/Tables > 
Manufactured Housing > Roofing. 

Foundation: Foundation refers to the supporting Foundation of the Mobile Home, such as Masonry, as set up in 
Tools > Schedules/Tables > Manufactured Housing >Foundation. 

Heat/Air: Heat/Air refers to the type of Heating and/or Air Conditioning used in the Mobile Home, as set up in 
Tools > Schedules/Tables >Manufactured Housing > Heating/Air. 

Fireplace: The type of Fireplace(s) in the Mobile Home, if any, as set up in Tools > Schedules/Tables > 
Manufactured Housing > Fireplace. 

Bedrooms: Data entry for Bedrooms is optional, but if used, the number of Bedrooms in the Mobile Home is keyed 
here. 

Full Baths: The number of Full Baths in the Mobile Home is keyed in this field. A Full Bath has a sink, toilet, and 
bathtub or shower. Lump Sum values can be applied to the value of Plumbing in the Mobile Home if desired by the 
appraiser. 

Half Baths: The number of Half Baths in the Mobile Home is keyed in this field. A Half Bath has a sink and toilet. 
Lump Sum values can be applied to the value of Plumbing in the Mobile Home if desired by the appraiser. 

Single Fixt: The number of Bathrooms with only one Fixture is keyed in this field. Lump Sum values can be applied 
to the value of Plumbing in the Mobile Home if desired by the appraiser. 

 

PREVIOUS VALUES 

 

When adding a new Mobile Home, the values in the Previous Values section will be zero. After the MH Yearend 
Cleanup process has been run, Previous Values will display in these fields and represent the respective values of 
the manufactured home on the last submitted digest. These fields are not accessible to the user. 
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LOCATION INFO 

 

House No: The House Number that has been assigned to the Mobile Home for location and address purposes. 

Ext: If the street address contains an extension such as A, 1/2, etc., it should be keyed here. 

Direction: The direction (North, Southeast, etc.) of the street. 

Street: The name of the Street or Road where the Mobile Home is located is chosen from the list of County Streets 
using this combo box. The list is set up in Tools > Schedules/Tables > Street Directory. 

St Type: The Type of Street, such as Road, Drive, Hwy, Lane, etc., is keyed here. 

Post: The post-direction used in the Street Address, such as 123 Smith St NW. The NW is the Post. 

Unit: The Unit Number of the property. Examples would be Unit 5, Apartment A, etc. 

Park: If the Mobile Home is located in a Mobile Home Park, the name of the Park is keyed into this field. 

Lot: If the Mobile Home is located in a Mobile Home Park, the Lot Number in the Park is keyed into this field. 

Tax District: This field is not available for a Non-Prebilled Mobile Home. 

 

DEPRECIATION 

 

Condition: The Condition represents the appraiser's judgment call in determining the physical condition of the 
Mobile Home. The Condition is used in calculating the Physical Depreciation Factor for the Improvement. 
Condition types that are set up in Tools > Schedules/Tables > Manufactured Housing > Condition. 

Calc Dep: The WinGAP Calculated Depreciation displays in this field. It is based upon the Life Expectancy of the 
Mobile Home (as set up in the Manufacturer/Model Table), the Year Built (or Effective Year Built), and the 
Condition of the Mobile Home. The Calculated Depreciation will display even if there is an entry in the Override 
Depreciation field. 

Ovr Dep: The Override Depreciation field is used to override the Calculated Depreciation performed by WinGAP. 
The field defaults to 0.00 (zero) and should remain at this value unless the appraiser wishes to apply a set Override 
Depreciation for the Mobile Home. 

Func Obs: Functional Obsolescence is a numerical assignment representing the appraiser's judgment of the % good 
with regards to functional obsolescence. For example, a Mobile Home determined by the appraiser to have 
functionally depreciated by 20% would be 80% good, and .80 would be keyed in the Functional Obsolescence field. 
The range can be from .01 to 9.99. The default is 1.00. There must be an entry in the Functional Obsolescence 
field. A value of 0.00 will result in a zero value for the structure. 

Econ Obs: Economic Obsolescence is a numerical assignment representing the appraiser's judgment of how the 
economic area that the Mobile Home is located in has affected the value of the Mobile Home. For example, a 
Mobile Home located near a trash dump or chicken rendering plant and determined by the appraiser to have 
economically depreciated by 30% would be 70% good, and .70 would be keyed in the Economic Obsolescence 
field. The range can be from .01 to 9.99. The default is 1.00. There must be an entry in the Economic Obsolescence 
field. A value of 0.00 will result in a zero value for the structure. 

 

VALUES 

 

RCN: The RCN, or Replacement Cost New, field in the Values section displays the calculated Mobile Home Value 
before Depreciation is applied. This field is not accessible to the user. 
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NADA: The NADA button allows the user to set and use a NADA (market) value for the Mobile Home instead of the 
WinGAP calculated replacement cost value. Procedures for using the NADA Button are discussed in the NADA 
section. 

MH Calc: The Calculated Mobile Home Value field displays the calculated Mobile Home Value after Depreciation is 
applied. This field is not accessible to the user. A checkmark will appear in the checkbox to the right of the MH Calc 
field, the default value, signifying that the MH Calc value will be used as the digest value for the Mobile Home 
unless the NADA value is selected instead. 

MH Ovr: The Mobile Home Override Value represents a manually assigned value for the Mobile Home. This value 
does not include additions. Any value assigned to additions will be added to the MH Ovr value. An entry in this field 
overrides all Mobile Home calculations. 

Add-Ons: The total value of any Add-Ons, or appendages, to the Mobile Home will display in this field. Add-Ons are 
added, edited, and deleted by clicking on the Add-Ons Button on the top right of the Mobile Homes Form. 

Total: The Total value of the Mobile Home is the sum of the Mobile Home Calculated Value or the MH Ovr value, if 
present, plus the Add-Ons Value. 

Last Calc: If a change is made to any of the Mobile Home information that affects the Value, the Last Calc field will 
display the previous calculated Mobile Home Value, and the Total field will display the new calculated value. 
However, once the Apply Button is clicked and the user remains on the Mobile Homes Form, or clicks the OK 
Button and leaves the Form, the new Mobile Home value will display in both the Last Calc and Total fields on the 
Mobile Homes Form. 

Ovr Date: If an Override Value is keyed in the Override Value field, the date the override is entered should be 
keyed in the Ovr Date field. 

Ovr Reason: If an Override Value is keyed in the Override Value field, a Reason for this Override Value should be 
selected from one of the Reasons in this combo box. The list of Override Reasons is based upon those entered in 
Tools > Schedules/Tables > Override Reasons. 

MAV: Below the MAV button are three fields that hold the WinGAP generated Moratorium Appraised Value for 
the following: 

• The MAV for the Mobile Home itself. A value will appear in the Mobile Home MAV field after the Apply 
button on the Mobile Homes Form is clicked. 

• The Total MAV for Add-Ons to the Mobile Home. A value will appear in the Total Add-On MAV field after 
Add-Ons are added on the Add-On Form and the user returns to the Mobile Homes Form. 

• The Total MAV for the Mobile Home and any Add-Ons. A value will appear in the Total MAV field after the 
Apply button on the Mobile Homes Form is clicked. 

Should the MAV for the Mobile Home need to be changed by the user, the MAV Button should be clicked to 
manually edit this value. The following should be noted when entering a value in this field: Values keyed via the 
MAV Buttons are not monitored, keyed MAV values are permanent only for that screen session, and any future 
changes to the property could modify MAV. 

MAV Ovr Checkbox: To the right of the MAV Button is the MAV Ovr Checkbox. When a check is placed in this box, 
the value in the MAV field will be treated as an override for the Mobile Home “box” Value. All calculations for this 
Value will be suspended until the check is removed. 

 

COMMENTS AND OTHER BUTTONS 

 

Comments: The Comments field can be used to enter any comments about the property. 

Comment Flag: The Comment Flag checkbox provides a means whereby users can create a visual flag to capture 
the user’s attention. Turning the Comment Flag on turns the background color of the Comments field red. It only 
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serves to catch the user’s attention when opening the Prebilled Mobile Home form. Counties can make their own 
policies for what this visual alert represents. 

Printer Button: At the bottom left of the Prebilled Mobile Homes Form is the Printer Button. Right clicking this 
button will produce a sub menu with two options. 

 

 

The PRC option will create a print preview of the Prebill Manufactured Housing Property Record Card, where it can 
then be printed. 

 

 

The Appeal Form option will create a print preview of an Appeal Form for this Prebilled Mobile Home with much of 
the form pre-filled. 
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Owner Information Button: The Owner Information Button (also called the "People" Button) is located on the 
lower left of the Prebilled Mobile Homes Form and can be clicked to view the Owner Information Form for the 
Prebilled Mobile Home that was just added/edited/viewed. 

PRC Bin Checkbox: Checking this box will send the PRC for this Prebilled Mobile Home to the PRC Bin – MH for bulk 
printing later. 
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MANUFACTURED HOME FORM ACCESS BUTTONS 

 

Appeals: This button takes the user to the Appeals Form where Appeals for this parcel can be entered. 

 

 

Photo Button: Right clicking this button opens a contextual menu that allows you to select from several options. 

 

Clicking the “Load Digital Photo” option will open a dialog box window where the user can navigate to a picture 
and load it to the WinGAPSQL folder on the server. A new folder will be created in the WinGAP photo folder on the 
server with the prefix “m” for mobile followed by the mobilekey assigned by Wingap, and the photo will be named 
the same. This is the primary digital photo for the Prebilled Mobile Home. 
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Selecting the Load Additional Photos option will open a new form that will append more information to other 
photos. Typing in the field to the right of the Photo Name will add that information to the picture name, for 
instance “addition” would name the photo for a property with the mobilekey 82565 “m82565_addition”. Selecting 
one of the checkboxes will quickly append that information to the photo so the user does not have to type it 
themselves. The user will then navigate to where the picture is on their computer and WinGAP will copy it to the 
server and name it according to the above naming convention. 

 

Selecting “Delete Current Photo” will delete the primary digital photo, while selecting “Delete Additional Photos” 
will open the pictures folder for this record where the user can manually select which additional photos to delete.  

 

No Sketch/Sketch Button: The No Sketch/Sketch Button takes the user to the WinGAP Sketching Module, where 
heated areas, appendages, and site improvements can be sketched and labeled. Sketching and labeling procedures 
are covered in the Sketching Module section. If structure areas are keyed by using the Structure Areas button, the 
Sketch/No Sketch button will read No Sketch. Once the Sketching Module has been used to draw sketches, and 
sketch data exists for the Manufactured Home, the No Sketch/Sketch button will read Sketch.  

Note: Sketches for Prebilled Mobile Homes are descriptive only, and do not add value to the Mobile Home. 

Documents: Right clicking this button opens a contextual menu that allows you to “Load Digital Documents”. 
Clicking the “Load Digital Documents” option will open a window where the user can navigate to any file, such as a 
PDF of a sales record, and load it to the WinGAPSQL folder on the server. A new folder will be created in the 
WinGAP documents folder on the server with the prefix “m” for mobile followed by the mobilekey assigned by 
Wingap. 

Edit History: This button is used to view the Edit History of this manufactured home record. The Edit Log keeps a 
record of virtually every user-initiated operation that changes a record in WinGAP. Any time a user accesses 
WinGAP and adds a record or makes a change to an existing record it is recorded in the Edit Log database. Each 
record on the Edit Log Form lists the File Name, PKey, ChgAppr ID (if no logins are used, it will say "Nologin"), Edit 
Date, Edit Time, After Edit (value after edit), Value Time (the time the value was changed), and Before Edit (value 
before edit) for the record that was edited. Items in the Edit Log are listed in Date and Time order. 
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Clicking the Field Edits button will reveal the specific changes that were made to the record. 
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ACO: (Account Corrections) Button takes the user to the Account Corrections Form, where Account Corrections, 
Errors & Releases, and Not on Digest situations for this Prebilled Mobile Home can be entered. 
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Agent: The Agent button opens the Agent Bridge Form. Here, a Tax Agent can be assigned to this Prebilled Mobile 
Home. Tax Agents will receive any Notice of Assessments in addition to the Owner receiving a copy. Agents are 
also listed on any Appeal filed. 
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The first box in the Agent Bridge lists all currently entered Agents. If the property is to be represented by an Agent 
that is already in the database, selecting that agent from the list will complete the first step for assigning the Agent 
to the Prebilled Mobile Home. If the Agent is not on the list or if the Agent has new contact information, clicking 
the Edit Agent button will open the Agents form. It will initially populate with the information of whichever Agent 
was highlighted in the list box, but clicking New will clear the form and allow the user to enter a new Agent’s 
information. Clicking OK will save the data entry and return the user to the Agent Bridge. 
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Once the Agent has been selected or a new one entered and highlighted in the Available Agent list, the Prebilled 
Mobile Home to be represented by that Agent should be selected in the first green box. Beneath that, selecting 
Multi-Year will keep this Agent linked to the property until manually removed, while selecting Single-Year will 
disassociate this Agent from the property when Year End Cleanup is performed. 
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Once the Agent and Property are both selected and either Multi-Year or Single-Year is checked, clicking the Include 
button beneath the property list will link the Agent and the Property. From here, the property will be listed in the 
blue Properties Assigned to Agent box along with any other properties that Agent is representing, and the Agent 
will be listed in the green Assigned Agent box beneath the property list. To disassociate an Agent and a property, 
highlight the property in the list and click the Remove button. 

Appointment: This button will open a new blank calendar appointment in Outlook. 

Schedules Button: This opens the Manufactured Housing Improvements schedule. More information on these 
schedules is covered in the Tools > Schedules/Tables > Manufactured Housing Improvements section. 

 

 

Permits: This button takes the user to the Building Permits Form where building permits for this Prebilled Mobile 
Home can be entered. 
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907 

TRANSFER 

This button, located in the middle of the Prebilled Mobile Home form, takes the user to the Property Transfer 
Form, where the Mobile Home can be transferred to another Owner. 
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The process of transferring a Prebilled Mobile Home to another owner is the same as that covered earlier in this 
manual with the Transfer of Real or Personal property. 
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TRANSFER TO HOMESTEAD 

A Prebilled Mobile Home can be transferred to a Homesteaded Mobile Home by clicking on the Transfer to 
Homestead Button on the Mobile Homes Form. 
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The Transfer Improvements Form will appear. 

 

 

The Prebilled Mobile Home that is about to be transferred to Homestead will appear in the list box at the top of 
the Form. The user should select the parcel to which the Mobile Home is to be transferred by keying in the parcel 
number in the yellow parcel number field and clicking the Search Button. A list of parcels beginning with the keyed 
parcel number will display and the user can click on the parcel that is to receive the Mobile Home to verify that this 
is the correct parcel. 
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If this is the correct parcel, the next step in the Transfer to Homestead process is to select the Mobile Home to be 
transferred. This is done by clicking on the Mobile Home item in the list box at the top of the Form. The Apply 
Button can be clicked to transfer the Mobile Home to the new parcel and remain on the Transfer Improvements 
Form or the OK Button can be clicked to transfer the Mobile Home and return to either the Prebill Mobile Homes 
Search Form or the Owner Form, whichever was used to reach the original Prebilled Mobile Homes Form. Before 
leaving the Transfer Improvements Form, the user will receive a message that appropriate edits should be made to 
effect the change in status of the Prebilled Mobile Home. 
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NADA 

If the County prefers to price a Mobile Home by the Market approach to value instead of the Cost approach to 
value, the nationally recognized NADA Pricing Guide market values can be used. This is done by clicking the NADA 
Button, located in the Values section of the Mobile Homes Form. Clicking the NADA Button takes the user to the 
NADA Mfg Housing Pricing Guide Form, which will default to the Manufacturer, Model, and Condition of the 
Mobile Home. If an exact match is not found, the user may scroll through the selections to make the proper 
choice. 

 

 

If these are the correct choices for this Mobile Home, the user should then select the proper Condition by clicking 
the box to the left of one of the five options. Average is the default selection. After the Condition is selected, the 
user can click the OK Button on the Pricing Guide Form, and the NADA Market Value will appear in the NADA Value 
field on the Mobile Homes Form. The number in parentheses on the NADA button that appears after the NADA 
button is clicked and the NADA choice made for the Mobile Home refers to the NADA Valid Width for that Mobile 
Home. 
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A choice can now be made as to whether the NADA market value or the WinGAP calculated value of the Mobile 
Home is to be used for the digest. If the NADA value is the choice, the user should click in the checkbox to the right 
of the NADA value field to make that selection. If the WinGAP calculated value is to be used, the checkmark should 
be retained in the field to the right of the MH Calc value. 

 

NOTE: If the NADA market value is selected, a statewide adjustment as indicated by NADA will be applied to the 
NADA values. The values in the NADA schedule tables are not adjusted; instead, the adjustment is applied as the 
value for the Mobile Home is calculated. 

 

ADD NADA MANUFACTURER/MODEL 

 

Occasionally, when the NADA schedules are used to value a Mobile Home, WinGAP cannot find in the NADA 
schedules the Manufacturer/Model selected by the user on the Manufactured Housing Form. When the user clicks 
the NADA button to value the Mobile Home, WinGAP will display the closest NADA match to that 
Manufacturer/Model. If these are the correct choices for this Mobile Home, the user should then select the proper 
Condition by clicking the box to the left of one of the five options. Average is the default selection. After the 
Condition is selected, the user can click the OK Button on the NADA Pricing Guide Form, and the user is returned to 
the Manufactured Housing Form. 

 

If the home is categorized as an SVS valuation home, a window will appear in the upper left of the Manufactured 
Housing Form, and the user should select the correct NADA SVS Quality Class for this Mobile Home by clicking in 
the appropriate Quality Class checkbox and then clicking the OK button. 
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Quality classes will display a summary of what qualifies for each class as you click on the check box. 

• Economy: This is the lowest priced manufactured home in production. This home has no special features 
and few, if any, upgraded components. The quality of all interior and exterior finishes is plain and 
inexpensive with little or no attention given to detail. Walls are typically 2” to 4” thick with 7’ to 7’6” 
ceiling height. Wide use of plastic for plumbing, trim, and fixtures. This class will include the cheapest 
construction standards (June 15, 1976). 

• Standard: The standard quality manufactured home will typically meet or exceed all minimum 
construction requirements, state mobile home or Federal Title 6 HUD codes. This home contains few 
special features. The exterior siding is usually prefinished aluminum with the fasteners concealed; some 
exterior trim and detail may be found at the front. The interior contains standard grade cabinets, doors, 
hardware, and plumbing. Walls are typically 3” or 4” and some are 6” in thickness. This category is 
generally the most common found and is manufactured in the majority of states and would include 
upgraded or multi-wide Mobile Office units.  

• Deluxe: This above average manufactured home generally exceeds all HUD building standards and will 
include Modular (SFR)/Commercial Buildings. The exterior will include an attractive architectural design 
utilizing aluminum, plywood, hardwood, and/or a combination of the three. The interiors are well finished 
and will include many special features such as full picture windows, ¼” plywood paneling, and above 
standard fixtures. The walls are 4” to 6” thick with 8’ ceiling heights. This home is considered the highest 
priced manufactured home in mass production, excluding the luxury category or homes with individually 
designed floor plans. 

• Luxury: This manufactured home always exceeds all construction standards and requirements of the 
minimum HUD construction codes. This home contains many special features. Interiors designed for the 
individual home include simulated brick or stone paneling, ¼” top grade plywood, conventional home 
type doors, and picture or bay windows in many or all of the living areas. Exterior finishes emulate that of 
conventional housing. This home contains the best designs, workmanship, and construction materials 
available. Roof details, such as mansard or single hip, are often standard features. This category will also 
include individually designed commercial buildings and modular construction or HUD Code homes that 
are individually designed in total. 

 

The user will be returned to the Manufactured Housing Form, and the Mobile Home Manufacturer/Model the user 
selected from the NADA Schedule will now appear in the Manufacturer/Model fields on the Form. When the user 
clicks the OK button on the Manufactured Housing Form and attempts to exit, another screen will appear 
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prompting the user to add the NADA Manufacturer/Model schedule item that was just selected to the WinGAP 
Mobile Home Manufacturer/Model schedule (mobmfgta.dbf). 

 

 

The user should assign a Quality Class for this new Manufacturer/Model schedule item, click the OK button, and 
the schedule item will be added. If the user does not want to add the schedule item, the Cancel button should be 
clicked and the item will not be added. 
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ADD-ONS 

Add-Ons are appendages to the Mobile Home such as Porches, Decks, and Patios. The Add-Ons Button is where 
Add-Ons are added, edited, or deleted. 

 

 

Description: Clicking on the combo box in the Description field produces the list of available Add-Ons. An item 
from this list must be selected to add an Add-On. The Add-On items that display in the list are based upon those 
set up in the Add-Ons Schedule found in Tools >Schedules/Tables > Manufactured Housing > Add-Ons or Tools > 
Schedules/Tables > Manufactured Housing > Lump Sum Add-Ons. 

Width: In most cases, the width of the Add-On in feet is entered in this field. When the Add-On is valued by the 
lump sum or unit method, the number entered in the Width field will depend on the way the Lump Sum Add-On 
Schedule is set up. For example, the number can represent the height of skirting around the base of the Mobile 
Home. 

Length: The length of the Add-On in feet is entered in this field. When the Add-On is valued by the lump sum or 
unit method, the number entered in the Length field will again depend on the way the Add-On Schedule is set up. 

Calc Area: If the length and width of the Add-On are entered and the user Tabs to the OVR Area/Units field, 
WinGAP will calculate the area and place the value in this field. The Calculated Area field is not accessible to the 
user.  

OVR Area/Units: If the Add-On is valued by the square foot but is not square or rectangular, the appraiser-
calculated area would be keyed here. When the Add-On is valued by the lump sum or unit method, the number 
entered in this field will again depend on how the Lump Sum Add-On Schedule is set up. 
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Identical Units: The number of Identical Units of an Add-On is keyed here. If other Add-Ons to this Mobile Home 
are identical to the one now being added, than the total number of Identical Units can be keyed here instead of 
adding another Add-On of the same exact type. For example, if there are 2 Open Porches of identical size, year 
built, and grade attached to the Mobile Home, then 2 would be keyed in the Identical Units field. 

Year Built: If known, the year the Add-On was built is entered in this field. The Year Built field defaults to the 
system year minus one year. 

EFYR: The Effective Year Built is used only when the condition of the Add-On reflects something different than 
should be present based on the original year of construction. The Eff Year Built field can be used to effectively 
increase or decrease the age of an Add-On. When present, the Effective Year Built is used in calculating the 
Physical Depreciation Factor and determining the Add-On’s Calculated Value. 

Grade: The Grade is a numerical assignment representing the quality of materials and workmanship for the Add-
On. The Grade field defaults to 100 (Average). The appraiser is responsible for assigning the Grade, and the range 
can be from 1 to 999. No decimal is used in data entry. The Grade is also used in calculating the Physical 
Depreciation Factor of the Add-On.  

Phy Depr Ovr: The Physical Depreciation Override field is used to override the calculated Physical Depreciation 
performed by WinGAP. The field defaults to 0.00 (zero) and should remain at this value unless the appraiser wishes 
to apply a set Physical Depreciation Override factor for this Add-On. 

Func Obsl: The Functional Obsolescence is a numerical assignment representing the appraiser's judgment of the % 
good with regards to functional depreciation. For example, a Mobile Home determined by the appraiser to have 
functionally depreciated by 20% would be 80% good, and .80 would be keyed in the Functional Depreciation field. 
The range can be from .01 to 9.99. The default is 1.00. There must be an entry in the Functional Obsolescence 
field. A value of 0.00 will result in a zero value for the Add-On. 

Other: Any other appraiser determined factor that should be applied to the Add-On can be keyed in this field. The 
range can be from .01 to 9.99. The default is 1.00. There must be an entry in the Other Factors field. A value of 
0.00 will result in a zero value for the Add-On. 

Calc Depr: The WinGAP Calculated Physical Depreciation displays in this field. The Calculated Physical Depreciation 
will display even if there is an entry in the Phy Depr Ovr field. The Calc Depr field is not accessible to the user. 

Perc Comp: The Percent Complete field represents the % completed status of the Add-On. If construction is 
finished, it is 100% complete. If it is not 100% completed, the value keyed in this field is the appraiser's 
determination of how complete the Add-On is. The range can be from .01 to 1.00. The default is 1.00. There must 
be an entry in the Percent Complete field. 

Neighborhood: Neighborhood Factors are not used in calculating the value of a Prebilled Mobile Home or its Add-
Ons. A value of 1.00 will always show in the Neighborhood Factor field. This field is not accessible to the user. 

Calculated: The WinGAP calculated value of this Add-On will display in this field. 

Override: The Override Value represents an assigned value for the Add-On. An entry in this field overrides all 
WinGAP calculations for this Add-On. 

MAV: The MAV field holds the WinGAP generated Moratorium Appraised Value for the Add-On. The MAV value 
will appear in the field after the Apply button is clicked. Should this value need to be changed by the user, the MAV 
Button should be clicked to manually edit this value. The following should be noted when entering a value in this 
field: values keyed via the MAV Buttons are not monitored, keyed MAV values are permanent only for that screen 
session, any future changes to the property could modify MAV. 

MAV Ovr Checkbox: To the right of the MAV Button is the MAV Ovr Checkbox. When a check is placed in this box, 
the value in the MAV field will be treated as an override for the Add-On Value. All calculations for the Add-On 
Value will be suspended until the check is removed.  

Last Calc: If a change is made to any of the Add-On information that affects the Value, the Last Calc field will 
display the previous calculated Add-On Value and the Calculated field will display the new calculated value. 
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However, once the Apply Button is clicked and the user remains on the Add-Ons Form, or clicks the OK Button and 
leaves the Form, the new Add-On value will display in both the Last Calc and Total fields on the Add-Ons Form. 

 

At the conclusion of entering information about each Add-On, the user should click the Apply Button at the bottom 
of the Mobile Home Add-Ons Form to make sure that all data entry for the new Add-On is saved, as seen on the 
next page. The Add-On that was added will appear in the window at the upper left of the Form. If the data entry 
for Add-Ons is completed, the user may click the Ok Button in lieu of clicking Apply and exit the screen with the 
data being saved. 

 

 

An Add-On can be edited by clicking on the desired item in the list box on the Add-Ons Form, clicking on the 
appropriate field and changing the data, then clicking the Apply Button. Once the editing of Add-Ons is completed, 
the user may click the OK Button in lieu of clicking Apply and exit the screen with the data being saved. 

 

An Add-On can be deleted by clicking on the desired item in the list box on the Add-Ons Form, then clicking the 
Delete Button at the bottom of the Form. The message "Are you sure you want to delete this record?" will appear. 
Clicking the Yes Button will delete the record; clicking on the No Button will cancel the deletion of the record. 
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APPENDIX 

 

GLOSSARY OF SHORT CUTS 

 

Main WinGAP Windows Screen 

 

Ctrl + N – Add New Owner 

Ctrl + Y – Select Appraisal Year 

Ctrl + L – Login as Different User 

Ctrl + F – Future Year 

Ctrl + O – Owner Search 

Ctrl + M – Multi Owner Search 

Ctrl + V – Real Index Search 

Ctrl + R – Real Property Search 

Ctrl + Shift + P – Personal Property Search 

Ctrl + T– Property Transfer 

 

Alt + F – File Menu  

Alt + P – Property Maintenance Menu 

Alt + A – Appeals Menu  

Alt + R – Reports Menu  

Alt + S – Statistics Menu  

Alt + T – Tools Menu 

Alt + O – Add-Ons Menu 

Alt + H – Help Menu 

 

Owner Search Form 

 

Alt + S – Search Button  

Alt + C – Cancel Button 

Alt + O – Open Button 

Alt + N – Selects Name Search Order  

Alt + P – Selects Parcel # Search Order 

Alt + A – Selects Owner Account # Search Order 
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Multiple Owner Search Form 

 

Alt + S – Search Button  

Alt + C – Cancel Button 

Alt + O – Open Button 

 

Real Index Search Form 

 

Alt + S – Search Button  

Alt + C – Cancel Button 

Alt + O – Open Button 

 

Real Property Search Form 

 

Alt + S – Search Button  

Alt + C – Cancel Button 

Alt + O – Open Button 

Alt + N – Selects Name Search Order  

Alt + P – Selects Parcel # Search Order 

Alt + T – Selects Street Name/Number Search Order 

Alt + A – Selects Real Property Account # Search Order 

 

Personal Property Search Form 

 

Alt + S – Search Button  

Alt + C – Cancel Button 

Alt + O – Open Button 

Alt + N – Selects Name Search Order  

Alt + P – Selects Parcel # Search Order 

Alt + T – Selects Street Name/Number Search Order 

Alt + A – Selects Personal Property Account # Search Order 

Alt + O – Selects County ID # Search Order 

Alt + D – Selects DBA (Doing Business As) Search Order 
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Prebilled Mobile Homes Property Search Form 

 

Alt + S – Search Button  

Alt + C – Cancel Button 

Alt + O – Open Button 

Alt + N – Selects Name Search Order  

Alt + P – Selects Parcel # Search Order 

Alt + T – Selects Street Name/Number Search Order 

Alt + A – Selects Mobile Home Account # Search Order 

Alt + D – Selects Decal # Search Order 

 

Property Transfer Form 

 

Alt + C – Cancel Button 

Alt + A – Apply Button 

Alt + O – OK Button 

 

All Data Entry Forms 

 

Alt + H – Help Button 

Alt + C – Cancel Button 

Alt + D – Delete Button 

Alt + N– New Button 

Alt + A – Apply Button 

Alt + O – OK Button 

Alt + E – Edit History Button 

 

Various Data Entry Forms 

 

Alt + S – Add/Edit Sales Button on Real Property General Information Screen, Sketch Button on Residential 
Improvement/Commercial Improvement Screen 

 

Alt + L – Add/Edit Land Button on Real Property General Information Screen, Add/Edit Leased Equipment on 
Personal Property General Information Screen 

 

Alt + R – Add/Edit Real Property on Owner Screen, Add/Edit Residential Improvement Button on Real Property 
General Information Screen, Add/Edit Other Button on Personal Property General Information Screen 
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Alt + I – Add/Edit Commercial Imp Button on Real Property General Information Screen, Add/Edit Inventory on 
Personal Property General Information Screen 

 

Alt +M – Add/Edit Accessory Imp Button on Real Property General Information Screen 

 

Alt + P – Add/Edit Personal Property on Owner Screen, Add/Edit Permits Button on Real Property General 
Information Screen 

 

Alt + E– Add/Edit Appeals Button on Real Property General Information Screen 

 

Alt +M – Add/Edit Prebilled Mobile Homes on Owner Screen, Add/Edit Accessory Improvement Button on Real 
Property General Information Screen, Add/Edit MEFF on Personal Prop General Information Screen 

 

Alt + F – Add/Edit Freeport Inventory Button on Personal Property General Information Screen 

 

Alt + B – Add/Edit B oats Button on Personal Property General Information Screen 

 

Alt + T– Add/Edit Aircraft Button on Personal Property General Information Screen, Transfer Prebilled Mobile 
Home on Manufactured Housing Screen 

 

Miscellaneous Windows shortcuts 

 

Windows logo key - Open or close the Start Menu 

 

Windows logo key + Break - Display the System Properties dialog box 

 

Windows logo key + D - Display the Desktop 

 

Windows logo key + M - Minimize all windows 

 

Windows logo key + Shift + M - Restore minimized windows to the Desktop 

 

Windows logo key + E - Open Windows Explorer to "My Computer" 

 

Windows logo key + F - Search for a file or folder 

 

Ctrl + Windows logo key + F - Search for computers (if you are on a network) 
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Windows logo key + L - Lock your computer (if you are connected to a network domain), or switch users (if you are 
not connected to a network domain) 

 

Windows logo key + R - Open the Run dialog box 


